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Thank you for purchasing the GP Screen Editor Software, "GP-PRO/PB III
for Windows Ver. 7.2" for use with Pro-face’s GP series programmable
operator interfaces.

Please read this manual carefully in order to use this software properly, and
be sure to keep this manual handy for future reference.

NOTES
(1) The copyrights to all programs and manuals included in the GP-PRO/

PB III for Windows Ver. 7.2 (hereinafter referred to as "this product")
are reserved by the Digital Electronics Corporation. Digital  grants the
use of this product to its users as described in the "Software Operating
License Conditions" documentation, included with this product's CD-
ROM. Any actions violating the above-mentioned conditions are
prohibited by both Japanese and foreign regulations.

(2) The contents of this manual have been thoroughly inspected. How-
ever, if you should find any errors or omissions in this manual, please
inform your local GP representative of your findings.

(3) Regardless of article (2), the Digital Electronics Corporation shall not
be held responsible for any damages or third party claims resulting
from the use of this product.

(4) Differences may occur between the descriptions found in this manual
and the actual functioning of this product. Therefore, the latest infor-
mation on this product is provided in data files (i.e. Readme.txt files,
etc. ) and in separate documents. Please consult these sources as well
as this manual prior to using the product.

(5) Even though the information contained in and displayed by this prod-
uct may be related to intangible or intellectual properties of the Digital
Electronics Corporation or third parties, the Digital Electronics Corpo-
ration shall not warrant or grant the use of said properties to any users
and/or other third parties.

(6) The specifications set out in this manual are for overseas products
only. As a result, some differences may exist between the specifica-
tions given here and for those of the identical Japanese product.
Digital Electronics Corporation accepts no liability for issues related
to the intellectual property rights of third parties or any issues related
to the use of the information contained in or displayed by this product.

PREFACE

For the rights to trademarks and trade names, see “TRADEMARK RIGHTS”.

© Copyright 2005 Digital Electronics Corporation. All rights reserved.
Digital Electronics Corporation,  February 2005

PREFACE
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All company or product names used in this manual are the trade names,
trademarks (including registered trademarks), or service marks of their
respective companies.

This product omits individual descriptions of each of these rights.

The following terms differ from the above mentioned formal trade names
and trademarks.

TRADEMARK RIGHTS

Trademark / Trade Name Right Holder
Microsoft, MS, MS-DOS, Windows,
Windows 95, Windows 98, Windows
Me, Windows NT, Windows 2000,
Windows XP,  Windows Explorer,
Microsoft Excel

Microsoft Corporation, USA

Intel, Pentium Intel Corporation, USA

Pro-face Digital Electronics Corporation
(in Japan and other countries)

Ethernet Western Digital Electric Corporation,
USA

IBM, VGA, IBM Compatible
International Business Machines
Corporation (IBM), USA

TRADEMARK RIGHTS

Term used in this manual Formal Trade Name or Trademark
Windows 95 Microsoft® Windows®95 Operating System
Windows 98 Microsoft® Windows®98 Operating System
Windows Me Microsoft® Windows®Me Operating System
Windows NT Microsoft® Windows NT® Operating System
Windows 2000 Microsoft® Windows® 2000 Operating System
Windows XP Microsoft® Windows®XP Operating System
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LIST OF SUPPORTED MODELS
The GP-PRO/PBIII for Windows Ver. 7.2 functions and settings available
will vary, depending on the model of GP used. Use the following table to
identify your GP.

 ����� List of GP Series Products

LIST OF SUPPORTED MODELS

Product
Name Model GP Type

GPH70-LG11-24V
GPH70-LG41-24VP
GPH70-SC11-24V
GPH70-SC41-24VP
GP270-LG11-24V
GP270-LG21-24VP
GP270-LG31-24V
GP270-SC11-24V
GP270-SC21-24VP
GP270-SC31-24V
GP370-LG11-24V
GP370-LG21-24VP
GP370-LG31-24V
GP370-LG41-24VP
GP370-SC11-24V
GP370-SC21-24VP
GP370-SC31-24V
GP370-SC41-24VP
GP470-EG11
GP470-EG21-24VP
GP470-EG31-24V
GP570-LG11-24V
GP570-LG21-24V
GP570-SC11
GP570-SC21-24VP
GP570-SC31-24V
GP570-TC11
GP570-TC21-24VP
GP570-TC31-24V

GP-57JS GP57J-SC11
GP-570VM GP570-TV11 GP570VM

GP-571 series GP-571T GP571-TC11 GP571T
GP-675S GP675-SC11

GP675-TC11
GP675-TC41-24VP

GP-870 series GP-870VM GP870-PV11 GP870VM
GP-37W2 series GP-37W2B GP37W2-BG41-24V GP37W2

GP377-LG11-24V
GP377-LG41-24V
GP377-SC11-24V
GP377-SC41-24V
GP377R-TC11-24V
GP377R-TC41-24V
GP477R-EG11
GP477R-EG41-24VP
GP577R-SC11
GP577R-SC41-24VP
GP577R-TC11
GP577R-TC41-24VP

GP370L

GP-370S

GP470

GP570

GP570L

GPH70L

GPH70S

GP270L

GP270S

GP577RGP-577R series

GP-477RE

GP-577RS

GP-577RT

GP477R

GP377R

GP675

GP377L

GP377S

GP77R series
GP-477R series

GP-377S

GP-377L
GP-377 series

GP-377R series GP-377RT

GP70 series

GP-570S

GP-570T

Series

GP-370L

GP-370S

GP-470 series GP-470E

GP-370 series

GP-H70 series

GP-270 series
GP-270L

GP-270S

GP-675T

GP-H70L

GP-H70S

GP-675 series

GP-570L

GP-570 series
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LIST OF SUPPORTED MODELS

����� List of GLC Series Products

Product
Name Model GP Type

GP-2301H series GP-2301HL GP2301H-LG41-24V GP2301HL
GP-2301HS GP2301H-SC41-24V GP2301HS

GP-2401H series GP-2401HT GP2401H-TC41-24V GP2401H
GP-2300L GP2300-LG41-24V GP2300L
GP-2300S GP2300-SC41-24V GP2300S
GP-2300T GP2300-TC41-24V GP2300
GP-2301L GP2301-LG41-24V GP2301L
GP-2301S GP2301-SC41-24V GP2301S
GP-2301T GP2301-TC41-24V GP2301

GP-2400 series GP-2400T GP2400-TC41-24V GP2400
GP-2401 series GP-2401T GP2401-TC41-24V GP2401

GP-2500L GP2500-LG41-24V GP2500L
GP-2500S GP2500-SC41-24V GP2500S

GP2500-TC11
GP2500-TC41-24V

GP-2501L GP2501-LG41-24V GP2501L
GP-2501S GP2501-SC11 GP2501S
GP-2501T GP2501-TC11 GP2501

GP2600-TC11
GP2600-TC41-24V

GP-2601 series GP-2601T GP2601-TC11 GP2601

GP2000
series

Series

GP-2501 series

GP-2600 series

GP2000H
series

GP-2300 series

GP-2500 series

GP-2301 series

GP-2600T GP2600

GP2500GP-2500T

����� List of Supported STs

Product
Name Model GP Type

GLC100L GLC100-LG41-24V GLC100L
GLC100S GLC100-SC41-24V GLC100S

GLC300 series GLC300 series GLC300T GLC300-TC41-24V GLC300T
GLC2300L GLC2300-LG41-24V GLC2300L
GLS2300T GLC2300-TC41-24V GLC2300

GLC2400 series GLC2400T GLC2400-TC41-24V GLC2400*1

GLC2500-TC41-24V
GLC2500-TC41-200V
GLC2600-TC41-24V
GLC2500-TC41-200V

GLC2500T

GLC2600T

GLC2500

GLC2600*1

GLC2000 series

GLC2300 series

Series

GLC100 series GLC100 series

GLC2500 series

GLC2600 series

*1 When selecting the GP Type from the Project Manager, be sure to check the Revision
Seal on the back of your GLC unit for the Revision Code. If there is no code or the code
is "1", select "Rev.* None, 1". If your revision code is 2 or higher, select "Rev.* Above
2". For details, refer to your GLC Series User Manual.

Series Product name Model GP Type
ST400 ST400-AG41-24V ST400
ST401 ST401-AG41-24V ST401
ST402 ST402-AG41-24V ST402
ST403 ST403-AG41-24V ST403

ST series
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����� List of Supported Factory Gateway
Product name Model GP Type

Factory Gateway FGW-SE41-24V Factory Gateway FGW-SE

To use the GPWeb and GPViewer functions with the Factory Gateway, you
must have GPPRO/PB III C-Package02 or later installed.

�����List of Supported LTs
Type Model GP Type

LT series LT Type A series LT Type A1 GLC150-BG41-XY32SK-24V LT TypeA
LTC Type A1 GLC150-SC41-XY32SK-24V LTC TypeA

LT Type A2 GLC150-BG41-XY32SC-24V LT TypeA

LT Type B/B+ series LT Type B GLC150-BG41-FLEX-24V
LT Type B+ GLC150-BG41-XY32KF-24V
LTC Type B+ GLC150-SC41-XY32KF-24V LTC TypeB+

LT Type C series LT Type C GLC150-BG41-RSFL-24V LT TypeC

LT Type H series LT Type H1 GLC150-BG41-ADK-24V
GLC150-BG41-ADPK-24V
GLC150-BG41-ADTK-24V

LTC Type H1 GLC150-SC41-ADK-24V
GLC150-SC41-ADPK-24V
GLC150-SC41-ADTK-24V

LT Type H2 GLC150-BG41-ADC-24V
GLC150-BG41-ADPC-24V
GLC150-BG41-ADTC-24V

LT TypeH

Series

LT TypeB/B+

LT TypeH

LTC TypeH

LIST OF SUPPORTED MODELS
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NEW FEATURES OF VERSION 7.0

NEW FEATURES OF VERSION 7.0

The upgrade from GP-PRO/PB III for Windows Ver. 6.3 to Ver. 7.0 adds the
following new features. These include new functions Q-tag Alarm and
Keypad Input Display, Text Screens using Multi-Language Displays and
others. The following explanation gives a brief overview of these features.

<For all models>
�����Transparent Text Background

The background color of the text can be set to "Transparent".

 2.2.9 Text

�����Adjustment of Touch Panel Scan Sensitivity

The GP unit's touch panel scan sensitivity can be set to any of three levels -
[High], [Medium], or [Low].
This can be set only via the GP unit's OFFLINE screens ([GP SETUP] 
[EXTENDED FEATURES]  [TOUCH PANEL FEATURES]).

 6 .1 Registering GP Initial Settings  -  GP System Set-
tings

����� Import/Export of Text (X) Screen

Data in a Text (X) Screen can be exported to an external file (*.csv, *.txt), or
an external file can be imported to a Text (X) Screen.

• The Import/Export function of Text Screens for Multi-Language Displays
is supported only by GP-377, GP77R and GP2000 Series units.

 3.4.3 Text Screens Importing/Exporting

<For GP-377, GP77R/GP2000 Series units only>
� Selection and transfer of System Screen

When sending data to the GP unit (Numeric Input Popup Keypad, CSV
Display, File Manager Display - Explorer Screen), this feature can select and
send only the minimum number of required items. The result is a reduction
of unnecessary data and a reduction of file transfer time. For System Screen
settings,  7.2.1 Transfer Settings - Setup Method

�Text Table Converter

When text table character strings used in a screen or Part's label, or in an
alarm character string are designated directly, they can all be converted at
once for use in a string table by assigning index numbers and registering
them.
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NEW FEATURES OF VERSION 7.0

All of a project file's screen and Part labels, as well as alarm character
strings can be converted at once with this feature. Also, only the desired
portion of Direct Text strings can be converted by specifying the screen to
be converted.

 4.6.4 Text Table Converter

�Display of Participatory Node Name for Transfer via Ethernet

When transferring data using the "Ethernet" option, the IP Address and
participatory Node name (the name of the GP to which the network project
file is transferred using the Pro-Server with Pro-Studio) are displayed.

• Ethernet I/F units are required for the GP77R, GP-2501, and GP-2601 se-
ries units.

 Pro-Server with Pro-Studio for Windows Operation
Manual  7.4 Setting up the GP via an Ethernet Network

<GP-2000 Series Units Only>
�New Security and Time Schedule Features

Security and Time Schedule features previously available only in ST units
are now available in all GP2000 Series units.

Security Feature:  4.7 Security Feature

Time Schedules:  4.8 Time Schedules

�Additional Q-tag Alarm Features (Increased number of blocks, Alarm
Occurrence Number Count Display, Alarm Occurrence Time's Accu-
mulated Time Display, Alarm Message Level Settings and Level Identi-
fication Colors, Alarm Sort Display, Alarm Display Cursor Position/
Cursor Movement ID Information Settings, External Operation Alarm
Occurrence Frequency/Accumulated Time Clear)

The Q-tag alarm feature has been expanded to include the following:

• Up to 8 blocks can be used for alarms.
• Can display accumulated count data for Q-tag alarm occurrences, as well

as occurrence times.
• Colors and levels (0 to 7 - total of 8) can now be set for alarm messages.
• Alarm contents can now be sorted.

Ex.Order can be set for Occurrence Time, Occurrence Frequency, Levels
or Dates.

 Tag Reference Manual 2.23.3 Setting Items ����� Opera-
tion Mode/Special
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NEW FEATURES OF VERSION 7.0

• When a Q-tag Alarm's cursor position (address) is designated, touching the
[Alarm Acknowledge Key (use T-tag)] will write to the designated ad-
dress, using the alarm's registration code. (Set via the Alarm Editor)
Also, if the [Notify ID at each cursor movement.] is enabled, the currently
selected Alarm's registration number will be written to the designated
address, without pressing the Alarm Acknowledge key.
For Alarm Acknowledge Key details,  Tag Reference
Manual 2.23.3 Setting Items ����� Operation Mode/Special

• The Q-tag Alarm Occurrence Frequency and Accumulated Time data is
cleared from via either the Device PLC's control command or a D-Script
command.

For Additional Q-tag Alarm Features, Tag Reference
Manual 2.20 Alarm Summary bit log/word log Display Extended Fea-
ture <Q-tag>, Operation Manual 5.1 Alarm Creation and Editing

�Keypad Input Display Extended Features (Keyboard Selection for
Touch Input, Specify entering order and Group No, Specify arrange-
ment position, Input Completed Alert Bit)

The following features have been added to the Keypad Input Display feature.

• Instead of the previous style of data entry where a [Bit] turning ON would
trigger the Keypad to wait for input, a new feature [Touch] can be used to
activate the Keypad for touch input. This feature can also be used to select
if the Popup Keypad is used or not. Selecting [Exists] allows you to
designate the position of the Popup Keypad. Selecting [None] allows you
to use a standard PC keyboard.

• The Touch area's [Use Keypad] can be used normally with GP-377,
GP77R, and GP2000 Series units, however the Popup Keypad's [Specify
arrangement position] feature can only be used with GP2000 Series
units.

• The [Touch] area's [None] feature is available only on GP2000 Series units.

• When using [Touch] to start data entry, you can also specify the entering
order and the Group No. After entry is completed in one area, this feature
moves the keypad's data entry cursor in the designated order to the next
area. Also, you can designate the desired group number. Thus, when
multiple Keypads are used, the cursor will move in the order designated
for each individual Group No.

• You can designate the position the Popup Keypad appears in.

• You can use either the [Touch] or the [Bit] commands' [Input Completion]
feature to inform the Device/PLC that entry is finished.

For Keypad Input Display details,  2.1.14 Keypad Input
Display
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NEW FEATURES OF VERSION 7.0

�Text Display screens can now use the Multi-Language Display feature.

Text for the Multi-Language Display function can be entered and saved on
the Text (X) Screen as separate tables. Up to 16 tables can be entered and
saved per Text Screen.

For details concerning Text Screen Multi-language Features,
 3.4.2 Editing MultiLanguage Text Screens

� Selectable Character Type for the N/E/P/d/S-tags

The style of characters for the N, E, P, d, and S-tags can be selected from the
"Normal", "Bold" and "Raised" options.
When "Raised" is selected, the color for shading can also be specified.

 Tag Reference Manual  Settings Parameters section of
each Tag ����� Size/Style

�����L-tag image screen (*.bin) file name display

Only when the L-tag's [Screen Designation] is set to [Indirect] and [Data
Type] is set to [Text] will the file names of the CF Card's output folder files
or the CF Card's internal image (*.bin) files be displayed. The filenames can
be changed to make them descriptive and easy to understand.

Tag Reference Manual 2.14.3 (L-tag) Setting Items -
Screen Designation/Indirect

����� D-Script/Extend SIO Script Function Additions

The following D-Script/Extend SIO Script Memory Operation Command
and CF File Operation Command functions have been added.

Command Added Function
Memory Shift
Memory Link
Memory Search
Memory Compare

CF File
Operation CSV File Read

Memory
Operation

For details, Tag Reference Manual 3.1 D-Script/Global
D-Script, 3.2 Extended SIO Script
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����� New Device/PLC Protocols
• Hitachi Industrial Equipment Systems SJ300/L300P Series Inverters

• Hitachi Industrial Equipment Systems EH-150 Unit 1:1/1:n Device Addi-
tions

• SIEMENS SIMATIC S7 Ethernet

• Schneider Modbus TCP Ethernet

• Schneider Modbus RTU 1:n

• Schneider UniTelWay Modbus RTU

• Rockwell (Allen Bradley) Compact Logix Ethernet

• FATEK FACON Device Addition

 Device/PLC Connection Manual

NEW FEATURES OF VERSION 7.0
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NEW FEATURES OF VERSION 7.1

����� New Device/PLC Protocols
• Toshiba Schneider Inverter  VF-S9,VF-nC1,VF-S11,VF-A7 Series Invert-

ers

• HITACHI  S10V Series Ethernet

• FUJI  MICREX-SX Series

• YOKOGAWA  FCN/FCJ Series

• Ubon  UPZ Series

 Device/PLC Connection Manual

NEW FEATURES OF VERSION 7.1

The upgrade from GP-PRO/PB III for Windows Ver. 7.0 to Ver. 7.1 adds the
following new features.

<For all models>
����� Information Data Color Selection

Screen information character colors can be used to designate Tag Names, Parts
ID numbers and Device Addresses.

 2.10.2 Screen Property Settings

<For GP2000 Series units only> (Not including GP2000H units)

�Time-Base Function

The new Time-Base function can be used for Keypad Input Displays and
Numeric Displays. The “Time-Base” function is built into Siemens Co. PLC
units. This function displays the top four bits of hex data, with the number
indicated by the remaining 12 bits being displayed using 3 digits of BCD
data. Four Time-Base modes are available: 0.01s, 0.1s, 1s and 10s. The 3
places of BCD data are the decimal point data, followed by a space or a “0”,
for a total of 4 digits. Seconds units are always displayed.

  2.1.14 Keypad Displays, 2.1.21 Numeric Displays

�CF Write Mode Function

Using the CSV Data Transfer Function, you can select the method used
when writing data to a CF Card. Selections include either writing all of a
file’s contents, or only overwriting data. Only overwriting data allows the
accumulation of title data (ITEM NAME).

 Tag Reference Manual 4.4.3 List of Condition Settings
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NEW FEATURES OF VERSION 7.2
The upgrade from GP-PRO/PB III for Windows Ver. 7.1 to Ver. 7.2 adds the
following new features.

 New model supported
ST403 Units

• Featuring RS-232C/RS-422 selectable serial interface

• Featuring Ethernet interface

• Featuring two colors (amber and red) for the backlight

 New functions
<For all models>

Support of Function Switch for Q-tag Selection Key

The Q-tag Selection keys that have been created using T-tag can be created
using Function switches.

 2.1.3 Function Switches

Equal Layout of Multiple Copies

When making multiple copies of an object, the duplicated objects are
automatically aligned with equal spacing in the area selected with the
mouse.

  2.4.7 Duplicate

Centering of Part Labels

A repositioned label can be returned to the center with one-button operation.

 2.1 Parts  Creating Labels

<For GP2000 Series and ST Series units only>
Global Interlock

Touch panel or function keys become enabled only when the condition (ON
or OFF) of the specific bit address is being satisfied. When the condition is
not satisfied, entries from the touch panel and function keys are disabled.

  2.9 Global Interlock

NEW FEATURES OF VERSION 7.2
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<For GP2000 Series (except for GP-2000H Series) and ST Se-
ries units only>

Supporting Models and Protocols for Time-Base Function

The Time-Base function can be used with ST Series units.
The function can also be used with the PROFIBUS-DP protocol.
The Time-Base function is featured in SIEMENS PLCs (S5 and S7 Series).

  2.1.14 Keypad Display, 2.1.21 Numeric Displays

<For ST403 only>
Backlight Color Change

The backlight of the ST403 features two colors: amber and red. By switch-
ing the colors of the backlight, alarms and other information can be ex-
pressed without using the buzzer, sound outputs, or screen displays.

  2.12.2 Backlight Color Change

 New Device/PLC Protocols

• HIOKI E.E. Smart Site Series Ethernet

• GE Fanuc Automation Series 90-30/90-70 Ethernet

• Mitsubishi MELSEC-QUTE Series Direct-coupled protocol

  Device/PLC Connection Manual

NEW FEATURES OF VERSION 7.2
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�����Structure of the Manual CD-ROM
The "Operation Manual" is the first of four manuals for this product and
explains how to use the "GP-PRO/PB III for Windows Ver. 7.2" software
(hereinafter referred to as "this product"). Please refer to all of the manuals
named below when using this product.These manuals can be found as PDF
files in your “Manual CD-ROM” (CD #2).
In addition to these manuals, data files containing supplemental information
on updated functions are also provided.To read these additional data files,
click on the [Start] button in your Windows OS main screen and select the
[Programs]→[Pro-face]→[ProPB3 C-Package] menu. Then, click on the
[Read Me] selection.
For detailed information about GP series products, please refer to each GP's
"User Manual". (Optionally available)

Screen Data Layout Sheets are useful for designing tag address settings, etc.
and example sheets are installed as part of the GP-PRO/PBIII for Windows
standard installation.
The following two layout sheets, "Device Allocation Table" and "Tag Lay-
out Sheet", are in Microsoft Excel format and are located in the PDF Manual
CD-ROM.
The following folder and file names are used.

HOW TO USE THIS MANUAL

For information on the use of Microsoft Excel, please refer to the Excel
software's User Manual.
����� Designation of Supported Models

The functions and settings supported by each model may vary depending on
the supported models. In this manual, explanations given are based on the
variation of the “Series” and “Product name” described in the “List of
Supported Models”.

Folder Name File Name Contents
Pro-face\ Device1E.xls Device Allocation Table
propbwin\sheet TAG1E.xls

TAG2E.xls
TAG3E.xls
TAG4E.xls

Tag Layout Sheet

HOW TO USE THIS MANUAL

vol. 1 Operation Manual
(this manual)

Describes this product's operation procedures and all
standard functions. (provided as PDF data)

Vol. 2 Tag Reference
Manual

Describes the function of and detailed settings for all
GP-PRO/PBIII Tags. (provided as PDF data)

Vol. 3 Parts List
Describes this product's pre-made Parts and symbols.
(provided as PDF data)

Vol. 4
Device/PLC
Connection
Manual

Describes the methods for connecting the GP to
supported devices from other manufacturers.
(provided as PDF data)
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HOW TO USE THIS MANUAL

����� Chapter Breakdown
This manual contains 12 chapters and an appendix.
The following is a general description of each chapter:

�����CHAPTER 1: FUNDAMENTALS OF GP-PRO/PB III FOR WINDOWS
This chapter describes GP-PRO/PBIII usage from start to finish. Also
explains the overall structure of the GP-PRO/PBIII Project Manager and
Screen Editor areas.

�����CHAPTER 2: CREATING BASE SCREENS
This chapter describes the basic operations and terminology used for draw-
ing functions, such as “Part”, “Tag”, “Library”, and “D-Script”.

�����CHAPTER 3: DRAWING APPLICATIONS: CREATING and USING
SCREENS
This chapter describes the procedures for creating and using various screens,
such as the M, T, K, X, I and V screens, which enable you to create high-
quality images and provide advanced-level functionality.

�����CHAPTER 4: SCREEN AND PROJECT MANAGEMENT
This chapter describes the procedures for editing and saving created screens
and project files, and information management procedure.

�����CHAPTER 5: CREATING AND EDITING ALARMS
This chapter describes the alarm creating and editing procedures.

�����CHAPTER 6: GP INITIAL AND SYSTEM SETTINGS
This chapter describes the initial setup procedure required to use a GP series
display unit.

�����CHAPTER 7: TRANSFERRING DATA
This chapter describes the procedure for sending created screens to a GP
series display unit.

�����CHAPTER 8: SIMULATION
This chapter describes the procedures for simulating the operation between a
GP series panel and a PLC.

�����CHAPTER 9: PRINTING
This chapter describes the procedure for printing created screens.

�����CHAPTER 10: ADVANCED FEATURES
This chapter describes the procedures for using GP-PRO/PBIII’s advanced
functions such as sound output, filing data (recipe), CSV data transfer
function, logging functions, and CF Card usage. For the detailed informa-
tion, refer to Volume 3, Tag Reference Manual.

�����CHAPTER 11: PROJECT MANAGER HIERARCHICAL DISPLAY
This chapter describes the procedures for using the Project Manager in
hierarchical display mode.

�����CHAPTER 12: DATA COMPATIBILITY
This chapter describes the procedure for converting existing screens created
with older generation screen editor software (e.g. GP-PRO, GP-PRO II, GP-
PRO III, Parts Box) with GP-PRO/PB III for Windows.
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�����APPENDIX
• Error Messages
Lists the error messages that will be displayed during operation of this
product.

• Troubleshooting
Provides problem diagnosis and suggests solutions for errors and software
operation problems.

• Address Conversion Tables
Lists the addresses available for each manufacturer’s supported models.

• Software Trouble Report
If a software problem persists, even after using the Troubleshooting section,
write down information about the problem using this sheet and send it by
fax to your local Pro-face support center.

HOW TO USE THIS MANUAL
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This manual uses the following symbols and terminology.

If you have any questions about the contents of this manual, please contact
your local GP distributor.

Also, If you have any question about your personal computer or Windows,
please contact your PC distributor or manufacturer.

����� Safety Symbols and Terms
This manual uses the following symbols and terms to identify important
information related to the correct and safe operation of this product.

MANUAL SYMBOLS AND TERMINOLOGY

Symbol Description 
 Indicates a potentially hazardous situation that could result in serious injury 

or death. 
 

 Indicates a potentially hazardous situation that could result in minor injury or 
equipment damage. 
 

 Indicates a potentially damaging action or dangerous situation that could 
result in abnormal equipment operation or data loss. 
 

 Indicates instructions or procedures that must be performed to ensure 
correct product use. 
 

 Indicates instructions or procedures that must not be performed. 
 
 

MANUAL SYMBOLS AND TERMINOLOGY



18 GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

����� General Information Symbols and Terms
This manual uses the following symbols and terms for general information.

Symbol Description

Provides hints on correct product use, or supplementary
information.

Indicates an item's related information (manual name, chapter,
section, sub-section).
Refers to keys on the computer keyboard.
                               � Keyboard Compatibility List

IBM Compatible Indicates a PC that can run the Windows® operating system.

Device
A device connected to the GP, such as a programmable logic
controller, sequencer, thermoregulator or inverter.
Generic name for the "GP Series" of programmable operator
interface made by the Digital Electronics Corporation.   For a
list of compatible GP products please see "Compatible
Products and Environmental Specifications".
                             LIST OF SUPPORTED MODELS � List of
Supported GPs
Generic name for the GLC Series of Graphic Logic Controllers
made by Digital Electronics Corporation.
                                LIST OF SUPPORTED MODELS � List of
Supported GLCs
Generic name for the ST Series of Programmable Operator
Interfaces by Digital Electronics Corporation.
                                LIST OF SUPPORTED MODELS  � List of
Supported STs
Generic name for the LT Series of Graphic Logic Controllers by
Digital Electronics Corporation.
                                LIST OF SUPPORTED MODELS  � List of
Supported LTs

GP

LT

GLC

ST

Esc Ctrl

MANUAL SYMBOLS AND TERMINOLOGY
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            Type
 Symbol

PS/2 Compatible
101 Keyboard

Esc

Tab

Ctrl

-Shift

Alt

Delete

Backspace

����� Keyboard Compatibility List
This manual uses the following symbols to indicate computer keyboard
keys.

The key names used by your computer keyboard may differ. Please use the
chart below for reference.

����� Typical User Configuration
This manual's description of this software's operating procedures and fea-
tures is based on the PC system configuration shown below.

If you use a different configuration, the PC and GP screens, as well as the
names used for pre-made Parts may differ. In this case, please substitute the
equivalent screen and part names of your system for those given in this
manual.

Esc

Tab

Ctrl

Shift

Alt

Delete

Back
space

MANUAL SYMBOLS AND TERMINOLOGY

Hardware/Software Specification Remarks
OS  Windows 98

Device Mitsubishi MELSEC AnA series (Link)
GP GP-2600T

Connection between
the GP and PC

RS-232C

Recommended Cable:
GPW-CB02

Made by Digital Electronics
Corporation
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����� CD-ROM Usage Precautions
To prevent CD-ROM damage or malfunctions, please observe the following
instructions:

• Do not remove the CD-ROM from the CD-ROM drive while the drive’s
operation lamp is lit.

• Do not touch the CD-ROM recording surface.
• Do not place CD-ROMs in a place where they may be exposed to extremely

high or low temperatures, high humidity, or dust.

� � � � � Product Usage Precautions
To prevent program malfunction or accidents, be sure to observe the follow-
ing instructions:

• Touch panel switches should NOT be used for a
device’s Emergency Stop Switch. Minister of
Health, Labour and Welfare speaking, all indus-
trial machinery/systems must be equipped with a
mechanical, manually operated emergency stop
switch. Also, for other kinds of systems, similar
mechanical switches must be provided to ensure
safe operation of those systems.

• Do not turn off your personal computer’s power switch during the execu-
tion of a program.

• After you create a screen with this product and transfer it to the GP unit, do
not send the same screen from the GP to a DOS version  of this screen
editor software (e.g. GP-PRO/PB III, GP-PRO III).

• Do not change the contents of this product’s project files using the Text
Editor software.

• Do not send a screen to a GP unit if that GP does not support the functions
provided by your screen editor software.

PRECAUTIONS

!!!!!
Warning

PRECAUTIONS



21GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

GENERAL GP RESTRICTIONS

GENERAL GP RESTRICTIONS
����� Drawing

• The GP-PRO/PB III for Windows software displays screen data using
your personal computer’s fonts and graphic functions. Therefore, there
may be a slight difference between the data displayed on your personal
computer and the data displayed on the GP unit after that screen data is
sent to the GP.

• When characters are positioned on a tiling pattern, they may not be
displayed properly on the GP unit if the dot pattern of the characters
matches that of the tiling pattern and the characters are positioned on the
same color. To solve the problem, shift the characters by one dot.

• When a GP unit is vertically installed, the panel’s coordinates will differ
from those used on the screen editor software. Therefore, when you enter
screen coordinates using tags or D-Script, please consider the GP’s
orientation. (0. 0) on the screen editor software

(0. 0) on the GP series’ panel
• Double-byte characters used in a project (including filenames and titles)

may not display correctly when displayed in a single-byte drawing envi-
ronment. If you intend to use your screen data in a single-byte environ-
ment, be sure to use only single-byte characters for screen text.

• Data should be edited using the same environment (OS) it was created
with.If a different OS is used, characters may change or be unreadable.

�����  Functions and Settings
• Certain  functions and setting supported by the GP unit are not supported

by the GP-PRO/PB III for Windows program, and vice versa.
[Setting and functions items set via the GP unit (Not by GP-PRO/PB
III for Windows) ]

- Language Font selection
- GP Date/Time
- GP Self-Diagnosis Function
- Functions for adjusting the Video Display

[Functions and setting items supported by GP-PRO/PB III for Win-
dows only (Not by the GP unit)]
The following settings are included in the “GP System Settings” area:

- “Checksum Verification”
- “Buzzer Output”
- Screen Change Order in hierarchical display mode
- Turning the "Common Password" On/Off
- Screen Change according to standby mode time
- Shift to OFFLINE mode
- “K-tag” processing
- GP unit’s internal memory (LS area) backup function
- “Error Display Reset”
- “Watchdog” (Monitoring the communication status between the GP

and the device)
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GENERAL GP RESTRICTIONS

- Address setting for "CF Card Control Setting" (Data Storage/Space
Storage Address/SRAM Auto Backup)

- “Q-tag” settings (Display format, Print Settings, and Alarm Trigger
Count Write’s Start Address/Processing Performed at GP power-ON/
Perform External Operations/Q-tag: Time Character addition (format)

- Communication Monitoring Period settings (Designate transmission wait
time)

- Data Backup
- Display Colors
- FEP Setting
- Serial code reader (LS storage start address/Read complete bit

address/Data storage setting)
- The Control Word Address setting for the "Screen Capture" func-

tion
- "Print Type" (Setting the print function with the tool connector)

This feature is only available with GLC2300 Series units.
- The following GP-PRO/PB III for Windows features, even though they

can be set using the GP-PRO/PBIII software, are currently not sup-
ported for the following PLCs.  Tag Reference Manual
Be sure to check that your type of PLC supports the features you
wish to use on the GP prior to creating your GP-PRO/PBIII for
Windows project data.

- Adjustment of Touch Panel Scan Sensitivity

<Functions of GP-PRO/PB III for Windows Ver. 7.0>
O : Supported   zzzzz: Depends on the unit   X: Not supported:

• When a device/PLC shown in the table below is connected, some GP
settings and software features may be limited.
Before creatingnew  screens, see the table below.

Device/PLC Connection Manual

Rockwell (Allen-Bradley) Modicon Specified 
in: Item SLC500/PLC-5 

DataHighway+ 
PLC-5 

Remote I/O 
SLC500 
DH485 

Modbus 
Slave 

Modbus 
Plus 

Communication setting X*1 X*1 X*1 O X*1 GP Operating environment X*1 X*1 z*2 O X*1 
Use System Area O X O O O 
Use Read Area O X O O O 
E-tag, K-tag: Indirect setting X X X O X 
H-tag: Read after startup X X O O X 
S-tag: Read after startup X X O O X 
Trend graph "block display" X*4 X O O X*4 
D-script: Memory Copy X X O O X 
D-script: Address Offset 
Designation X X O O X 
Filing data function X X O O X 
CSV data transfer function X X O O X 
Logging function X X O O X 
GP resetting due to write error X X O X X 
Data backup X X O O X 

Software 

2-Way driver z*3 z*3 z*3 O z*3 
 *1 These items can be set using [GP Setup] of GP-PRO/PB III for Windows.

*2 "maximum id" can be set using [GP Setup] of GP-PRO/PB III for Windows.
*3 Only the LS area can be used.
*4 Displays support available when Device/PLC Device Addresses are used. Use

of the GP LS Area’s Read Area is supported (“O”).
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GENERAL GP RESTRICTIONS

<Functions of GP-PRO/PB III for Windows Ver. 6.3>
O : Supported   zzzzz: Depends on the unit   X: Not supported

GP 70 Series

Items
GP-H70
GP-370

GP-57JS

GP-
270

GP-
470

GP-
570

GP-
571

GP-
675

GP-
570VM

GP-
870VM

GP-
377L

GP-
377S

GP
37W2B

Full color (64-color) display X X X X O O X X X O X
3-speed blinking X X X X O O X X X O X
Data sampling O X O O O O O O O O O
LS area backup X X z z O O X X O O O
Trend graph (tag) backup X X z z O O X X O O O
Trend graph (tag)
“block display” O X O O O O O O O O O

Trend graph (tag)
lower-section fill O X O O O O O O O O O

Changing color using
K-tag bit O X O O O O O O O O O

E-tag, g-tag, K-tag: Indirect
color setting O X O O O O O O O O O

E-tag, g-tags: Indirect
designation of relative
value range

O X O O O O O O O O O

C-tag, E-tag, S-tag: Tiling
background colors (Bg) O X O O O O O O O O O

g-tag: Color differentiation
in graph display O X O O O O O O O O O

D-script Additions
(Drawing, Math Functions) O X O O O O O O O O O

Drawing function (H-tag) O X O O O O O O O O O
T-tag: Radio switch
function

O X O O O O O O O O O

Inching output switch
(Tih-tag and Tiw-tag)

X X O O O O O O X X X

Q-tag: Backup X X z z O O X X O O O
Q-tag: Setting display
format

O X O O O O O O O O O

Q-tag: Display by
second

O X O O O O O O O O O

Q-tag: Setting print
color

X X X O O O O O X X X

Tank graph
 (pre-made parts)

O X O O O O O O O O O

Meter graph
(pre-made parts)

O X O O O O O O O O O

Video window display
(V-tag)

X X X X X X O O X X X

Setting Direction of
Screen Printout

X X X X X O X X X X X

Interrupt/cancel hard-
copy printout

X X O O O O O O X X X

Set “OFFLINE” mode
switch feature off

O O O O O O O X O O O

Q-tag: Sub-display O X O O O O O O O O O
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GENERAL GP RESTRICTIONS

<Functions of GP-PRO/PB III for Windows Ver. 6.3>
O : Supported   zzzzz: Depends on the unit   X: Not supported

GP 70 Series

Items
GP-H70
GP-370

GP-57JS

GP-
270

GP-
470

GP-
570

GP-
571

GP-
675

GP-
570VM

GP-
870VM

GP-
377L

GP-
377S

GP
37W2B

Q-tag: Grouping of
alarms into a block

X X X X X X X X O O O

A-tag: Indirect
designation of text
screen or sub-display
screen

X X X X X X X X O O O

Filing data function X X X X X X X X O O O
Data logging function X X X X X X X X O O O
Sound output function X X X X X X X X X X X
CF Card compatibility X X X X X X X X X X X
Global D-script X X X X X X X X O O O
Compatible with
Pro-Server

X X X X X X X X X X X

Compatible with LS area
for simulation

X X X X X X X X O O O

GP resetting due to write
error

X X X X X X X X O O O

Compatible with transfer
speed of 115.2Kbps

X X X X X X X X O O O

Creation of composite
parts for Filing Data

X X X X X X X X O O O

D-script: Bit dual state
trigger

X X X X X X X X O O O

D-script: Memory Copy X X X X X X X X O O O
D-script: Memory block
initialization

X X X X X X X X O O O

D-script: Loop function X X X X X X X X O O O
D-script: Address offset
designation

X X X X X X X X O O O

D-script:Temporary
address (can be used up
to 90 addresses)

X X X X X X X X O O O

Filing function:Can be
designated up to 10,000
pieces of data

X X X X X X X X O O O

Filing function: Multiple
folders

X X X X X X X X O O O

Filing function: Stores
the cursor position.

X X X X X X X X O O O

Filing function: PLC data
transfer completion Bit
Address

X X X X X X X X O O O

Logging function: Loop
function

X X X X X X X X O O O

Logging function: Total
LS data write

X X X X X X X X O O O

CF Card free capacity
storage

X X X X X X X X X X X
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GENERAL GP RESTRICTIONS

<Functions of GP-PRO/PB III for Windows Ver. 6.3>
O : Supported   zzzzz: Depends on the unit   X: Not supported

GP 70 Series

Items
GP-H70
GP-370

GP-57JS

GP-
270

GP-
470

GP-
570

GP-
571

GP-
675

GP-
570VM

GP-
870VM

GP-
377L

GP-
377S

GP
37W2B

4-state lamp
(pre-made parts)

X X X X X X X X O O O

T-tag: Grouping with auto
OFF

X X X X X X X X O O O

T-tag: Interlock Touch
Available Conditions
(bit OFF)

X X X X X X X X O O O

Offline shift
 (pre-made parts)

X X X X X X X X O O O

Q-tag block printing X X X X X X X X X X X
Q-tag external operation X X X X X X X X O O O
A-tag blank line display X X X X X X X X O O O
Alarm message: Can be
used up to 512 messages

X X X X X X X X O O O

Backlight burnout
detector

X X X X X X X X O O X

Internal 2-Port function X X X X X X X X O O O
GB-WEB compatibility X X X X X X X X X X X
PLC Simulation via Ethernet X X X X X X X X X X X
Factory-Set IP address
settings for data transfer

X X X X X X X X X X X

General SIO Protocol X X X X X X X X X X X
Serial 2-D reader
compatibility

X X X X X X X X X X X

Serial bar-code reader
compatibility

X X X X X X X X X X X

256-color display X X X X X X X X X X X
Q-tag: up to 2048 messages X X X X X X X X X X X
Q-tag: Expansion of time
format digits

X X X X X X X X O O O

T-tag: momentary (one-shot
buzzer)

X X X X X X X X O O O

Number of logging words:
255

X X X X X X X X X X X

Image Fonts X X X X X X X X X X X
Multi Language Display
Function

X X X X X X X X O O O

Screen Snapshot
Function for Simulation

X X X X X X X X X X X

I /O Setting (Monitor
function for touch panel
input time)

X X X X X X X X X X X

Image Parts X X X X X X X X X X X
Screen Capture Function X X X X X X X X X X X
Compatible with v-tag X X X X X X X X X X X
Pop-up Keyboard
Function

X X X X X X X X O O O

Global Vibration Function X X X X X X X X X X X
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GENERAL GP RESTRICTIONS

GP70 Series

<New Functions of GP-PRO/PB III for Windows Ver. 6.3>
O : Supported   zzzzz: Depends on the unit   X: Not supported

*1 Supported only by GLC-2400/2500/2600 Series units.

Items
GP-H70
GP-370

GP-57JS

GP-
270

GP-
470

GP-
570

GP-
571

GP-
675

GP-
570VM

GP-
870VM

GP-
377L

GP-
377S

GP-
37W2

B
CSV Data Transfer
Function

x x x x x x x x x x x

CSV File Display
Function

x x x x x x x x x x x

CF Card File Manager
Function

x x x x x x x x x x x

Extended SIO Script x x x x x x x x x x x
Trend Graph: Data
Record Display

x x x x x x x x x x x

Trend Graph/Data
Sampling: Up to 40 trend
lines

x x x x x x x x x x x

Backup Function for
Trend Graph parts

x x x x x x x x x x x

Q-tag Log Alarm: Date
display for all alarms

x x x x x x x x x x x

SRAM Auto Backup
Function

x x x x x x x x x x x

Filing Function: Block
No./Block Name Transfer

x x x x x x x x x x x

Text Size: Added Control
for size adjustments
(integers from 1 to 8)

x x x x x x x x x x x

Loop Function with
Screen Capture

x x x x x x x x x x x

Screen Capture
Completed Bit Setting

x x x x x x x x x x x

On/Off of Common
Password for Offline
mode

x x x x x x x x x x x

GLC Ladder Monitor
Function *1 x x x x x x x x x x x

Support for Index Text in
Message Display

x x x x x x x x O O O
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GENERAL GP RESTRICTIONS

GP70 Series

<New Functions of GP-PRO/PB III for Windows Ver. 6.3>
O : Supported   zzzzz: Depends on the unit   X: Not supported

I tems
GP-H70
GP-370

GP-57JS

GP-
270

GP-
470

GP-
570

GP-
571

GP-
675

GP-
570
VM

GP-
870
VM

GP-
377L

GP-
377S

GP-
37W
2B

8-level monochrome
display x x x x x x x x x x x

Trend graph (Block
Display)
Dot display

x x x x x x x x x x x

Trend graph (Block
Display)
Assistant line display

x x x x x x x x x x x

Trend graph (Block
Display)Display range
designation

x x x x x x x x x x x

CSV data transfer:
Condition name
search/auto-transfer

x x x x x x x x x x x

D-Script
CF file operation
function

x x x x x x x x x x x

D-Script
Printer port operation
function

x x x x x x x x x x x

Serial interface selection x x x x x x x x x x x
Background color for G-
tags and bar/pie/half pie
graph parts

x x x x x x x x x O O

CF Memory Loader Tool:
Conversion from MEM
file to PRW file

x x x x x x x x x x x

CF Memory Loader Tool:
Multiple projects x x x x x x x x x x x

7-segment display of
parts x x x x x x x x x x x

Multiple Copies -Copy
Direction Selection O O O O O O O O O O O

Index Text Center
Positioning x x x x x x x x O O O

Extended Font Char.
Size O O O O O O O O O O O

Security Levels x x x x x x x x x x x
Time Schedule x x x x x x x x x x x
OFFLINE Language
Switching x x x x x x x x x x x

Half-2 Byte Character O x O O O O O O O O O
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GP77R/GP2000 Series

Items
GP-

377R
GP-

477R
GP -
577R

GP-
2301H

GP-
2401H

GP-
2300

GP-
2301

GP-
2400

GP-
2401

GP-
2500

GP-
2501

GP-
2600

GP-
2601

Full support  (64-color)
display O x O z O z

*1
z

*1 O O z
*1
z

*1 O O

3-speed blinking O x O z O z
*1
z

*1 O O z
*1
z

*1 O O
Data sampling O O O O O O O O O O O O O
LS area backup O O O O O O O O O O O O O
Trend graph (tag) backup O O O O O O O O O O O O O
Trend graph (tag) “block
display” O O O O O O O O O O O O O
Trend graph (tag) lower-
section fill O O O O O O O O O O O O O
Changing color using K-tag
bit O O O O O O O O O O O O O
E-tag, g-tag, K-tag: Indirect
color setting O O O O O O O O O O O O O
E-tag, g-tags: Indirect
designation of relative value
range

O O O O O O O O O O O O O

C-tag, E-tag, S-tag: Tiling
background colors (Bg) O O O O O O O O O O O O O
g-tag: Color differentiation in
graph display O O O O O O O O O O O O O
D-script Additions (Drawing,
Math Functions) O O O O O O O O O O O O O
Drawing function (H-tag) O O O O O O O O O O O O O
T-tag: Radio switch function O O O O O O O O O O O O O
Inching output switch (Tih-
tag and Tiw-tag) x O O x x x x x x x x x x
Q-tag: Backup O O O O O O O O O O O O O
Q-tag: Setting display format O O O O O O O O O O O O O

*1 GP-2300L, GP-2301L, GP-2500L and GP-2501L units do not support this feature.

<Functions of GP-PRO/PB III for Windows Ver. 6.3>
O : Supported   zzzzz: Depends on the unit   X: Not supported
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GENERAL GP RESTRICTIONS

*1 A large-size multi-unit E is necessary to enable this function.

*2 A middle-size multi-unit E is necessary to enable this function.

*3 A large-size multi-unit E or GP Ethernet I/F unit is necessary to enable this function.

*4 To utilize this feature, the optional VM unit is required.

*5 A bus conversion unit and a sound output unit (a large-size multi-unit S or a large-size
multi-unit E) are required to use this  function.

Items
GP-

377R
GP-

477R
GP-

577R
GP-

2301H
GP-

2401H
GP-
2300

GP-
2301

GP-
2400

GP-
2401

GP-
2500

GP-
2501

GP-
2600

GP-
2601

Q-tag: Display by second O O O O O O O O O O O O O
Q-tag: Setting print color O X O X X z X O O O O O O
Tank graph (pre-made parts) O O O O O O O O O O O O O
Meter graph (pre-made parts) O O O O O O O O O O O O O
Video window display
(V-tag) X X X X X X X X X O*4 X O*4 X
Setting Direction of Screen
Printout X X X X X X X X O X X O O
Interrupt/cancel hard-copy
printout O*2 O O X X O X O O O O O O
Set “OFFLINE” mode switch
feature off O O O O O O O O O O O O O
Q-tag: Sub-display O O O O O O O O O O O O O
Q-tag: Grouping of alarms
into a block O O O O O O O O O O O O O
A-tag: Indirect designation of
text screen or sub-display
screen

O O O O O O O O O O O O O

Filing data function O O O O O O O O O O O O O
Data logging function O O O O O O O O O O O O O
Sound output function X O*1 O*1 X X X X O X O O*5 O O*5

CF Card compatibility O*2 O*1 O*1 O O O O O O O O O O
Global D-script O O O O O O O O O O O O O
Compatible with Pro-Server O*2 O*3 O*3 X X O X O X O O*3 O O*3

Compatible with LS area for
simulation O O O O O O O O O O O O O
GP resetting due to write
error O O O O O O O O O O O O O
Compatible with transfer
speed of 115.2Kbps O O O O O O O O O O O O O
Creation of composite parts
for Filing Data O O O O O O O O O O O O O

GP77R/GP2000 Series

<Functions of GP-PRO/PB III for Windows Ver. 6.3>
O : Supported   zzzzz: Depends on the unit   X: Not supported
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GENERAL GP RESTRICTIONS

*1 A large-size multi-unit E is necessary to enable this function.

*2 A middle-size multi-unit E is necessary to enable this function.

I tems GP -
377R

GP-
477R

GP-
577R

GP-
2301

H

GP-
2401

H

GP-
2300

GP-
2301

GP-
2400

GP-
2401

GP-
2500

GP-
2501

GP-
2600

GP-
2601

D-Script: Bit dual state
trigger O O O O O O O O O O O O O

D-Script: Memory Copy O O O O O O O O O O O O O
D-Script: Memory block
initialization O O O O O O O O O O O O O

D-Script: Loop function O O O O O O O O O O O O O

D-Script: Address offset
designation O O O O O O O O O O O O O

D-Script:Temporary
address (can be used up
to 90 addresses)

O O O O O O O O O O O O O

Filing function:Can be
designated up to 10,000
pieces of data

O O O O O O O O O O O O O

Filing function: Multiple
folders O O O O O O O O O O O O O

Filing function: Stores
the cursor position. O O O O O O O O O O O O O

Filing function: Device
data transfer completion
Bit Address

O O O O O O O O O O O O O

Logging function: Loop
function O O O O O O O O O O O O O

Logging function: Total
LS data write O O O O O O O O O O O O O

CF Card free capacity
storage O*2 O*1 O*1 O O O O O O O O O O

4-state lamp (pre-made
parts) O O O O O O O O O O O O O

T-tag: Grouping with auto
OFF O O O O O O O O O O O O O

T-tag: Interlock Touch
Available Conditions (bit
OFF)

O O O O O O O O O O O O O

Offline shift (pre-made
parts) O O O O O O O O O O O O O

Q-tag block printing O*2 O O X X O X O O O O O O

Q-tag external operation O O O O O O O O O O O O O

A-tag blank line display O O O O O O O O O O O O O
Alarm message: Can be
used up to 512 messages O O O O O O O O O O O O O

Backlight burnout
detector O X X O O O O O O O O O O

Internal 2-Port function O O O O O O O O O O O O O

GP77R/GP2000 Series

<Functions of GP-PRO/PB III for Windows Ver. 6.3>
O : Supported   zzzzz: Depends on the unit   X: Not supported
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GENERAL GP RESTRICTIONS

*1 A middle-size multi-unit E is necessary to enable this function.

*2 A large-size multi-unit E or GP Ethernet I/F unit is necessary to enable this function.

*3 To utilize this feature, the optional VM unit is required.

*4 A bus conversion unit and a large-size multi-unit E or a GP Ethernet Interface unit are
required to enable this function.

*5 GP-2300L/S, GP-2301L/S, GP-2500L/S and GP-2501L/S do not support this feature.

Items GP -
377R

GP-
477R

GP-
577R

GP-
2301

H

GP-
2401

H

GP-
2300

GP-
2301

GP -
2400

GP -
2401

GP-
2500

GP-
2501

GP-
2600

GP-
2601

GB-WEB compatibility O*1 O*2 O*2 X X O X O X O O*4 O O*4

PLC Simulation via
Ethernet X X X X X O X O X O O*4 O O*4

Factory-Set IP address
settings for data transfer X X X X X O X O X O X O X
General SIO Protocol X X X X X O X O X O X O X
Serial 2-D reader
compatibility X X X X X O X O X O X O X
Serial bar-code reader
compatibility X X X X X O X O X O X O X

256-color display X X X X O z
*5
z

*5 O O z
*5
z

*5 O O
Q-tag: up to 2048
messages X X X O O O O O O O O O O
Q-tag: Expansion of time
format digits O O O O O O O O O O O O O
T-tag: momentary (one-
shot buzzer) O O O O O O O O O O O O O
Number of logging
words: 255 X X X O O O O O O O O O O
Image Fonts X X X O O O O O O O O O O
Multi Language Display
Function O O O O O O O O O O O O O
Screen Snapshot
Function for Simulation X X X O O O O O O O O O O
I /O Setting (Monitor
function for touch panel
input time)

O O O O O O O O O O O O O

Image Parts X X X O O O O O O O O O O
Screen Capture Function X X X O O O O O O O O O O
Compatible with v-tag X X X X X X X X X O*3 X O*3 X
Pop-up Keyboard
Function O O O O O O O O O O O O O
Global Vibration Function X X X O O X X X X X X X X

GP77R/GP2000 Series

<Functions of GP-PRO/PB III for Windows Ver. 6.3>
O : Supported   zzzzz: Depends on the unit   X: Not supported
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GENERAL GP RESTRICTIONS

GP77R/GP2000 Series

*1 Supported only by GLC-2400/2500/2600 Series units.

*2 To enable this function, first install GP-PRO/PBIII version 6.2 or later to enable the
serial interface selection feature.

*3 Depending on the GP revision, it may sometimes not be possible to change the “Serial I/
F Switch” setting to “Yes”. For details regarding GP revisions,                        

 4.2.8 Changing Extended SIO Type

I tems GP-
377R

GP-
477R

GP-
577R

GP-
2301

H

GP-
2401

H

GP-
2300

GP-
2301

GP-
2400

GP-
2401

GP-
2500

GP-
2501

GP-
2600

GP-
2601

CSV Data Transfer
Function

x x x O O O O O O O O O O

CSV File Display
Function

x x x O O O O O O O O O O

CF Card File Manager
Function

x x x O O O O O O O O O O

Extended SIO Script x x x O*2 O*2 O O*2 O*3 O*2 O*3 O*2*3 O*3 O*2

Trend Graph: Data
Record Display

x x x O O O O O O O O O O

Trend Graph/Data
Sampling: Up to 40 trend
lines

x x x O O O O O O O O O O

Backup Function for
Trend Graph parts

x x x O O O O O O O O O O

Q-tag Log Alarm: Date
display for all alarms

x x x O O O O O O O O O O

SRAM Auto Backup
Function

x x x O O O O O O O O O O

Filing Function: Block
No./Block Name Transfer

x x x O O O O O O O O O O

Text Size: Extended
options for text size
(integers from 1 to 8)

x x x O O O O O O O O O O

Loop Function with
Screen Capture

x x x O O O O O O O O O O

Screen Capture
Completed Bit Setting

x x x O O O O O O O O O O

On/Off of Common
Password for Offline
mode

x x x O O O O O O O O O O

GLC Ladder Monitor
Function *1 x x x x x x x x x x x x x

Support for Index Text in
Message Display

O O O O O O O O O O O O O

<New Functions of GP-PRO/PB III for Windows Ver. 6.3>
O : Supported   zzzzz: Depends on the unit   X: Not supported
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GENERAL GP RESTRICTIONS

GP77R/GP2000 Series

*1 Depending on the GP revision, it may sometimes not be possible to change the “Serial I/
F Switch” setting to “Yes”. For details regarding GP revisions,                        

 4.2.8 Changing Extended SIO Type

*2 This function can be used for the D-Script or Global D-Script. For the extended SIO
Script, the serial interface selection must be designated in advance for the extended SIO
Script protocol.

*3 The GP-2501T and GP-2501S do not support this function.

<New Functions of GP-PRO/PB III for Windows Ver. 6.3>
O : Supported   zzzzz: Depends on the unit   X: Not supported

Items GP-
377R

GP-
477R

GP-
577R

GP-
2301

H

GP-
2401

H

GP-
2300

GP-
2301

GP-
2400

GP-
2401

GP-
2500

GP-
2501

GP-
2600

GP-
2601

8-level monochrome
display

X X X z X z z X X z z*3 X X

Trend graph (Block
Display)Dot display

X X X O O O O O O O O O O

Trend graph (Block
Display)Assistant line
display

X X X O O O O O O O O O O

Trend graph (Block
Display)Display range
designation

X X X O O O O O O O O O O

CSV data transfer:
Condition name
search/auto-transfer

X X X O O O O O O O O O O

D-Script
CF file operation
function

X X X O*2 O*2 O O*2 O O*2 O O*2 O O*2

D-Script
Printer port operation
function

X X X X X O X O O O O O O

Serial interface
selection

X X X O O O O O*1 O O*1 O*1 O*1 O

Background color for
G-tags and bar/pie/half
pie graph parts

O O O O O O O O O O O O O

CF Memory Loader
Tool:
Conversion from MEM
file to PRW file

X X X O O O O O O O O O O

CF Memory Loader
Tool:
Multiple projects

X X X O O O O O O O O O O

7-segment display of
parts

X X X O O O O O O O O O O

Multiple Copies -Copy
Direction Selection

O O O O O O O O O O O O O

Index Text Center
Positioning

O O O O O O O O O O O O O

Extended Font Char.
Size

O O O O O O O O O O O O O

Security Levels X X X X X X X X X X X X X
Time Schedule X X X X X X X X X X X X X
OFFLINE Language
Switching

X X X X X X X X X X X X X

Half-2 Byte Character O O O O O O O O O O O O O
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GENERAL GP RESTRICTIONS

ST Series

<Functions of GP-PRO/PB III for Windows Ver. 6.3>
O : Supported   zzzzz: Depends on the unit   X: Not supported

Items ST Items ST Items ST

Full support  (64-color) display X
A-tag: Indirect designation of text
screen or sub-display screen

O Q-tag block printing X

3-speed blinking X Filing data function O Q-tag external operation O
Data sampling O Data logging function O A-tag blank line display O

LS area backup O Sound output function X
Alarm message: Can be used up to
512 messages

O

Trend graph (tag) backup O CF Card compatibility X Backlight burnout detector X
Trend graph (tag) “block display” O Global D-script O Internal 2-Port function O
Trend graph (tag) lower-section fill O Compatible with Pro-Server ● *1 GB-WEB compatibility ● *1

Changing color using K-tag bit O
Compatible with LS area for
simulation

O PLC Simulation via Ethernet ● *1

E-tag, g-tag, K-tag: Indirect color
setting

O GP resetting due to write error O
Factory-Set IP address settings for
data transfer ● *1

E-tag, g-tags: Indirect designation of
relative value range

O
Compatible with transfer speed of
115.2Kbps

O General SIO Protocol X

C-tag, E-tag, S-tag: Tiling
background colors (Bg)

O
Creation of composite parts for
Filing Data

O Serial 2-D reader compatibility X

g-tag: Color differentiation in graph
display

O D-Script: Bit dual state trigger O Serial bar-code reader compatibility X

D-script Additions (Drawing, Math
Functions)

O D-Script: Memory Copy O 256-color display X

Drawing function (H-tag) O D-Script: Memory block initialization O Q-tag: up to 2048 messages O

T-tag: Radio switch function O D-Script: Loop function O
Q-tag: Expansion of time format
digits

O

Inching output switch (Tih-tag and
Tiw-tag)

x D-Script: Address offset designation O T-tag: momentary (one-shot buzzer) O

Q-tag: Backup O
D-Script:Temporary address (can be
used up to 90 addresses)

O Number of logging words: 255 O

Q-tag: Setting display format O
Filing function:Can be designated
up to 10,000 pieces of data

O Image Fonts O

Q-tag: Display by second O Filing function: Multiple folders O Multi Language Display Function O

Q-tag: Setting print color x
Filing function: Stores the cursor
position.

O
Screen Snapshot Function for
Simulation

X

Tank graph (pre-made parts) O
Filing function: Device data transfer
completion Bit Address

O
I/O Setting (Monitor function for
touch panel input time)

O

Meter graph (pre-made parts) O Logging function: Loop function O Image Parts O

Video window display (V-tag) X
Logging function: Total LS data
write

O Screen Capture Function X

Setting Direction of Screen Printout X CF Card free capacity storage X Compatible with v-tag X
Interrupt/cancel hard-copy printout X 4-state lamp (pre-made parts) O Pop-up Keyboard Function O
Set “OFFLINE” mode switch feature
off

O T-tag: Grouping with auto OFF O Global Vibration Function X

Q-tag: Sub-display O
T-tag: Interlock Touch Available
Conditions (bit OFF)

O

Q-tag: Grouping of alarms into a
block

O Offline shift (pre-made parts) O

*1 Supported only by ST403 units from Ver. 7.2.
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GENERAL GP RESTRICTIONS

ST Series

<New Functions of GP-PRO/PB III for Windows Ver. 6.3>
O : Supported   zzzzz: Depends on the unit   X: Not supported

*1 To enable this function with the ST400/ST401/ST403 units, the serial I/F switching func-
tion must be configured in advance.

*2 Supported by all ST Series units from Ver. 7.2.

I tems ST Items ST

CSV Data Transfer Function x Trend graph (Block Display)
Assistant line display

O

CSV File Display Function x Trend graph (Block Display)
Display range designation

O

CF Card File Manager Function x
CSV data transfer:
Condition name search/auto-
transfer

X

Extended SIO Script O*1 D-Script
CF file operation function

X

Trend Graph: Data Record Display O D-Script
Printer port operation function

X

Trend Graph/Data Sampling: Up to
40 trend lines

O Serial interface selection O*2

Backup Function for Trend Graph
parts

O Background color for G-tags and
bar/pie/half pie graph parts

O

Q-tag Log Alarm: Date display for
all alarms O

CF Memory Loader Tool:
Conversion from MEM file to PRW
file

X

SRAM Auto Backup Function x CF Memory Loader Tool:
Multiple projects

X

Filing Function: Block No./Block
Name Transfer

O 7-segment display of parts O

Text Size: Extended options for
text size (integers from 1 to 8)

O Multiple Copies -Copy Direction
Selection

O

Loop Function with Screen
Capture

x Index Text Center Positioning O

Screen Capture Completed Bit
Setting

x Extended Font Char. Size O

On/Off of Common Password for
Offline mode

O Security Levels O

GLC Ladder Monitor Function x Time Schedule O
Support for Index Text in Message
Display

O OFFLINE Language Switching O

8-level monochrome display O Half-2 Byte Character O
Trend graph (Block Display) Dot
display

O
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GENERAL GP RESTRICTIONS

LT Series

<Functions of GP-PRO/PB III for Windows Ver. 6.3>
O : Supported   zzzzz: Depends on the unit   X: Not supported

Items LT Items LT Items LT

Full support  (64-color) display z
*1

A-tag: Indirect designation of text
screen or sub-display screen

O Q-tag block printing X

3-speed blinking z
*1 Filing data function O Q-tag external operation O

Data sampling O Data logging function O A-tag blank line display O

LS area backup O Sound output function X
Alarm message: Can be used up to
512 messages

O

Trend graph (tag) backup O CF Card compatibility X Backlight burnout detector O
Trend graph (tag) “block display” O Global D-script O Internal 2-Port function O
Trend graph (tag) lower-section fill O Compatible with Pro-Server X GB-WEB compatibility X

Changing color using K-tag bit O
Compatible with LS area for
simulation

z
*2 PLC Simulation via Ethernet X

E-tag, g-tag, K-tag: Indirect color
setting

O GP resetting due to write error O
Factory-Set IP address settings for
data transfer

X

E-tag, g-tags: Indirect designation of
relative value range

O
Compatible with transfer speed of
115.2Kbps

O General SIO Protocol X

C-tag, E-tag, S-tag: Tiling
background colors (Bg)

O
Creation of composite parts for
Filing Data

O Serial 2-D reader compatibility X

g-tag: Color differentiation in graph
display

O D-Script: Bit dual state trigger O Serial bar-code reader compatibility X

D-script Additions (Drawing, Math
Functions)

O D-Script: Memory Copy O 256-color display X

Drawing function (H-tag) O D-Script: Memory block initialization O Q-tag: up to 2048 messages O

T-tag: Radio switch function O D-Script: Loop function O
Q-tag: Expansion of time format
digits

O

Inching output switch (Tih-tag and
Tiw-tag)

x D-Script: Address offset designation O T-tag: momentary (one-shot buzzer) O

Q-tag: Backup O
D-Script:Temporary address (can be
used up to 90 addresses)

O Number of logging words: 255 X

Q-tag: Setting display format O
Filing function:Can be designated
up to 10,000 pieces of data

O Image Fonts X

Q-tag: Display by second O Filing function: Multiple folders O Multi Language Display Function O

Q-tag: Setting print color x
Filing function: Stores the cursor
position.

O
Screen Snapshot Function for
Simulation

X

Tank graph (pre-made parts) O
Filing function: Device data transfer
completion Bit Address

O
I/O Setting (Monitor function for
touch panel input time)

X

Meter graph (pre-made parts) O Logging function: Loop function O Image Parts X

Video window display (V-tag) X
Logging function: Total LS data
write

O Screen Capture Function X

Setting Direction of Screen Printout X CF Card free capacity storage X Compatible with v-tag X
Interrupt/cancel hard-copy printout X 4-state lamp (pre-made parts) O Pop-up Keyboard Function O
Set “OFFLINE” mode switch feature
off

O T-tag: Grouping with auto OFF O Global Vibration Function X

Q-tag: Sub-display O
T-tag: Interlock Touch Available
Conditions (bit OFF)

O

Q-tag: Grouping of alarms into a
block

O Offline shift (pre-made parts) O

*1 Supported only by Color-type LT Series units.

*2 Supported only by LT Series Type-C units.
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GENERAL GP RESTRICTIONS

LT Series

<New Functions of GP-PRO/PB III for Windows Ver. 6.3>
O : Supported   zzzzz: Depends on the unit   X: Not supported

I tems LT Items LT

CSV Data Transfer Function x Trend graph (Block
Display)Assistant line display

x

CSV File Display Function x Trend graph (Block
Display)Display range designation

x

CF Card File Manager Function x
CSV data transfer:
Condition name search/auto-
transfer

x

Extended SIO Script x D-Script
CF file operation function

x

Trend Graph: Data Record Display x D-Script
Printer port operation function

x

Trend Graph/Data Sampling: Up to
40 trend lines

x Serial interface selection x

Backup Function for Trend Graph
parts

x Background color for G-tags and
bar/pie/half pie graph parts

O

Q-tag Log Alarm: Date display for
all alarms x

CF Memory Loader Tool:
Conversion from MEM file to PRW
file

x

SRAM Auto Backup Function x CF Memory Loader Tool:
Multiple projects

x

Filing Function: Block No./Block
Name Transfer

x 7-segment display of parts x

Text Size: Extended options for
text size (integers from 1 to 8)

x Multiple Copies -Copy Direction
Selection

O

Loop Function with Screen
Capture

x Index Text Center Positioning O

Screen Capture Completed Bit
Setting

x Extended Font Char. Size O

On/Off of Common Password for
Offline mode

x Security Levels x

GLC Ladder Monitor Function O*1 Time Schedule x
Support for Index Text in Message
Display

O OFFLINE Language Switching x

8-level monochrome display x Half-2 Byte Character O
Trend graph (Block Display) Dot
display

x



GP-PRO/PB III  for Windows Ver. 7.2  Operation Manual38

GENERAL GP RESTRICTIONS

GP70 Series

<New Functions of GP-PRO/PB III for Windows Ver. 7.0>
O : Supported   zzzzz: Depends on the unit   X: Not supported

*1 This feature is valid only for the Import/Export function with the "Do Not Use Table"
option enabled.

I tem
GP-H70
GP-370

GP-57JS
GP-270 GP-470 GP-570 GP-571 GP-675 GP-

570VM
GP-

870VM
GP-

377L
GP-

377S
GP-

37W2B

Q-tag Increased max.
no. of blocks to 8. x x x x x x x x x x x

Q-tag Alarm event
count display x x x x x x x x x x x

Q-tag Alarm event
accumulated time
display

x x x x x x x x x x x

Q-tag External clear of
accumulated Alarm
event count/
accumulated time

x x x x x x x x x x x

Q-tag Alarm message
level settings x x x x x x x x x x x

Q-tag Alarm message
level ID color x x x x x x x x x x x

Q-tag Alarm sort x x x x x x x x x x x
Q-tag Alarm cursor
position/ID alert x x x x x x x x x x x

Keypad Input
DisplayTouch input (No
Popup keypad)

x x x x x x x x x x x

Keypad Input Display
Popup keypad specify
arrangement position

x x x x x x x x x x x

Keypad Input Display
Specify entering order
and Group No.

x x x x x x x x x x x

Keypad Input Display
Input complete alert bit x x x x x x x x x x x

Text screen multi-
language display x x x x x x x x x x x

Text screen
Import/Export O*1 O*1 O*1 O*1 O*1 O*1 O*1 O*1 O O O

Search for IP Address
via Ethernet Network x x x x x x x x x x x

Set string color
background to
transparent

O O O O O O O O O O O

Touch panel scan
sensitivity adjustments O O O O O O O O O O O

System screen transfer
settings x x x x x x x x O O O

Selection of the text
style for N/E/P/d/S-tags x x x x x x x x x x x

L-tag
Image Filename Display x x x x x x x x x x x

D-Script
Memory Operation/CF
File Operation Function
Additions

x x x x x x x x x x x
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GENERAL GP RESTRICTIONS

<New Functions of GP-PRO/PB III for Windows Ver. 7.0>
O : Supported   zzzzz: Depends on the unit   X: Not supported

*1 Use the Pro-Server with Pro-Studio for Windows to register the GP as a participatory
node beforehand.

GP77R/GP2000 Series

I tem GP-
377R

GP-
477R

GP-
577R

GP-
2301H

GP-
2401H

GP-
2300

GP-
2301

GP-
2400

GP-
2401

GP-
2500

GP-
2501

GP-
2600

GP-
2601

Q-tag Increased max.
no. of blocks to 8. x x x O O O O O O O O O O

Q-tag Alarm event
count display x x x O O O O O O O O O O

Q-tag Alarm event
accumulated time
display

x x x O O O O O O O O O O

Q-tag External clear of
accumulated Alarm
event count/
accumulated time

x x x O O O O O O O O O O

Q-tag Alarm message
level settings x x x O O O O O O O O O O

Q-tag Alarm message
level ID color x x x O O O O O O O O O O

Q-tag Alarm sort x x x O O O O O O O O O O
Q-tag Alarm cursor
position/ID alert x x x O O O O O O O O O O

Keypad Input
DisplayTouch input (No
Popup keypad)

x x x O O O O O O O O O O

Keypad Input Display
Popup keypad specify
arrangement position

x x x O O O O O O O O O O

Keypad Input Display
Specify entering order
and Group No.

x x x O O O O O O O O O O

Keypad Input Display
Input complete alert bit x x x O O O O O O O O O O

Text screen multi-
language display x x x O O O O O O O O O O

Text screen
Import/Export O O O O O O O O O O O O O

Search for IP Address
via Ethernet Network O*1 O*1 O*1 x x O x O x O O*1 O O*1

Set string color
background to
transparent

O O O O O O O O O O O O O

Touch panel scan
sensitivity adjustments O O O O O O O O O O O O O

System screen transfer
settings O O O O O O O O O O O O O

Selection of the text
style for N/E/P/d/S-tags x x x O O O O O O O O O O

L-tag
Image Filename Display x x x O O O O O O O O O O

D-Script
Memory Operation/CF
File Operation Function
Additions

x x x O O O O O O O O O O
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GENERAL GP RESTRICTIONS

ST Series

<New Functions of GP-PRO/PB III for Windows Ver. 7.0>
O : Supported   zzzzz: Depends on the unit   X: Not supported

Item ST
Q-tag Increased max. no. of
blocks to 8. O

Q-tag Alarm event count
display O

Q-tag Alarm event
accumulated time display O

Q-tag External clear of
accumulated Alarm event
count/ accumulated time

O

Q-tag Alarm message level
settings O

Q-tag Alarm message level ID
color O

Q-tag Alarm sort O
Q-tag Alarm cursor position/ID
alert O

Keypad Input DisplayTouch
input (No Popup keypad) O

Keypad Input Display Popup
keypad specify arrangement
position

O

Keypad Input Display Specify
entering order and Group No. O

Keypad Input Display Input
complete alert bit O

Text screen multi-language
display O

Text screen Import/Export O
Search for IP Address via
Ethernet Network ●

*1

Set string color background
to transparent O

Touch panel scan sensitivity
adjustments O

System screen transfer
settings O

Selection of the text style for
N/E/P/d/S-tags O

L-tag
Image Filename Display O

D-Script
Memory Operation/CF File
Operation Function Additions

O*2

*1 Supported only by ST403 units from Ver. 7.2.

*2 If the unit used is not equipped with a CF Card interface, the CF File operation feature
cannot be used.
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GENERAL GP RESTRICTIONS

LT Series

<New Functions of GP-PRO/PB III for Windows Ver. 7.0>
O : Supported   zzzzz: Depends on the unit   X: Not supported

I tem LT
Q-tag Increased max.
no. of blocks to 8. x

Q-tag Alarm event
count display x

Q-tag Alarm event
accumulated time
display

x

Q-tag External clear of
accumulated Alarm
event count/
accumulated time

x

Q-tag Alarm message
level settings x

Q-tag Alarm message
level ID color x

Q-tag Alarm sort x
Q-tag Alarm cursor
position/ID alert x

Keypad Input
DisplayTouch input (No
Popup keypad)

x

Keypad Input Display
Popup keypad specify
arrangement position

x

Keypad Input Display
Specify entering order
and Group No.

x

Keypad Input Display
Input complete alert bit x

Text screen multi-
language display x

Text screen
Import/Export O

Search for IP Address
via Ethernet Network x

Set string color
background to
transparent

O

Touch panel scan
sensitivity adjustments O

System screen transfer
settings O

Selection of the text
style for N/E/P/d/S-tags x

L-tag
Image Filename Display x

D-Script
Memory Operation/CF
File Operation Function
Additions

x
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GENERAL GP RESTRICTIONS

<New Functions of GP-PRO/PB III for Windows Ver. 7.1>
O : Supported   zzzzz: Depends on the unit   X: Not supported

GP77R/GP2000 Series

GP70 Series

ST Series LT Series

I tem GP-
377R

GP-
477R

GP-
577R

GP-
2301H

GP-
2401H

GP-
2300

GP-
2301

GP-
2400

GP-
2401

GP-
2500

GP-
2501

GP-
2600

GP-
2601

Keypad Input Display
Time-Base Function x x x x x O O O O O O O O

Numeric Display
Time-Base Function x x x x x O O O O O O O O

CSV Data Transfer
CF Write Mode Function x x x O O O O O O O O O O

Information Data Color
Selection O O O O O O O O O O O O O

I tem
GP-H70
GP-370

GP-57JS

GP-
270

GP-
470

GP-
570

GP-
571

GP-
675

GP-
570VM

GP-
870VM

GP-
377L

GP-
377S

GP-
37W2B

Keypad Input Display
Time-Base Function x x x x x x x x x x x

Numeric Display
Time-Base Function x x x x x x x x x x x

CSV Data Transfer
CF Write Mode Function x x x x x x x x x x x

Information Data Color
Selection O O O O O O O O O O O

I tems LT

Keypad Input Display
Time-Base Function

x

Numeric Display
Time-Base Function

x

CSV Data Transfer
CF Write Mode Function x

Information Data Color
Selection O

I tems ST

Keypad Input Display
Time-Base Function O*1

Numeric Display
Time-Base Function O*1

CSV Data Transfer
CF Write Mode Function x

Information Data Color
Selection O

*1 Supported starting from Ver. 7.2.
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<New Functions of GP-PRO/PB III for Windows Ver. 7.2>
O : Supported   : Depends on the unit   X: Not supported

GP77R/GP2000 Series

GP70 Series

ST Series LT Series

I tems ST

Global Interlock O

Backlight Color Change *1

Function: Switch Q-tag
Selection Key

O

Duplicate: Equal Layout
in Specified Area

O

Centering of Part Label O

I tems LT

Global Interlock

Backlight Color Change

Function: Switch Q-tag
Selection Key

O

Duplicate: Equal Layout
in Specified Area

O

Centering of Part Label O

*1 Supported only by the ST403 units.

I tems GP-
377R

GP-
477R

GP-
577R

GP-
2301H

GP-
2401H

GP-
2300

GP-
2301

GP-
2400

GP-
2401

GP-
2500

GP-
2501

GP-
2600

GP-
2601

Global
Interlock

x x x O O O O O O O O O O

Backlight
Color Change

x x x x x x x x x x x x x

Function:
Switch Q-tag
Selection Key

O O O O O O O O O O O O O

Duplicate:
Equal Layout
in Specified
Area

O O O O O O O O O O O O O

Centering of
Part Label

O O O O O O O O O O O O O

I tems
GP-H70

GP-H370
GP-57JS

GP-270 GP-470 GP-570 GP-571 GP-675 GP-
570VM

GP-
870VM

GP-
377L

GP-
377S

Global Interlock x x x x x x x x x x
Backlight Color
Change

x x x x x x x x x x

Function:
Switch Q-tag
Selection Key

O O O O O O O O O O

Duplicate:
Equal Layout in
Specified Area

O O O O O O O O O O

Centering of
Part Label

O O O O O O O O O O
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GP SERIES COMPATIBILITY

Converting GP-PRO/PB III for Windows File Data
A project file from earlier GP-PRO/PB III for Windows versions can be easily
opened with this software.

1.1.2  Selecting an Existing Project

• When the following Project files are opened with GP-PRO/PB III for
Windows Ver. 7.2, the time stamps of the selected Project files are updated
as a result of file data conversion.

• Project files created with GP-PRO/PB III for Windows (Version 6.0 or
earlier)
Once the time stamp has updated, opening the same Project file using
version 7.2 will not update the time stamp.

• When the following Project files are opened with GP-PRO/PB III for Win-
dows Ver.7.2 and the [Transfer Settings] dialog box is activated, the time
stamps of the selected Project files are updated due to the file data conversion.

• Project files created with GP-PRO/PB III for Windows Ver. 6.3 or earlier
Once the time stamp is updated, opening the same Project file using
version 7.2 will not update the time stamp.

Files created with prior versions of the software can be converted to GP-
PRO/PB III for Windows Ver. 7.2 project files.

• Ver. 7.2  data cannot be converted to the following data types.

Original Data Type Converted Data Type
GP-PRO
GP-PROII
GP-PROIII
GP-PRO/PBIII (DOS Version)
GP-PRO/PBIII (Prior to Ver. 7.2)
Parts Box
LT Editor

GP-PRO/PBIII for
Windows Ver.7.2

(This product)

Converting Data from GP-PRO/PB III (DOS version)
Screen data from GP-PRO/PB III (DOS version) can be opened with the GP-
PRO/PB III for Windows Ver. 7.2 software. To do so, specify the "File Type" as
a DOS project file (*.PRO) in the [Files of type:] area, when selecting a project.

1.1.2  Selecting an Existing Project

• Pro-face strongly recommends that you do NOT try to open a
project file made using GP-PRO/PBIII for Windows Ver. 7.2 with
a prior version of the GP-PRO/PBIII for Windows software.
Doing so may delete important setting data.
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Created with GP-PRO II(Example)
Filled tiling pattern

Power GP series
(GP70/GP77R/
GP2000 series)
unit display

Displayed on a GP-*30
or GP-*50 series unit

Transferred from GP-
PRO II to GP-*30 or
GP-*50 series units

When the above screen is
converted with the file con-
verter of GP-PRO/PBIII for
Windows (Ver.4.0 or later), and
sent to the POWER GP (GP70/
GP77R/GP2000) series unit:

����� Converting Data from GP-PRO, GP-PRO II, or GP-PRO/PB III
GP-PRO II or GP-PRO III Screen data can be converted to 7.2 data for use
on GP70/GP77R/GP2000 series units using the GP-PRO/PB III for Win-
dows Ver. 7.2 file converter utility. However, after the GP-PRO II or GP-
PRO III S0 (System) screen data is converted and sent to a GP70/GP77R/
GP2000 series unit, you must then review all GP settings in OFFLINE
mode.  12.1 File Converter

�����Cautions when converting GP-PRO II Data

If a GP-PRO II screen contains "filled" data, filled tiling patterns may be
shifted when displayed on Power GP series (GP70/GP77R/GP2000 series)
units. On GP-*30 and GP-*50 series units, color is filled on the screen based
on the drawing's starting point. However, Power GP series (GP70/GP77R/
GP2000 series) units fill color from the upper-left corner (0,0) of the screen,
and only show the drawing area. Please be aware of this difference when
you call up a filled drawing using L-tags, or when placing filled objects on
top of one another.
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����� Fill-in areas
When painted objects drawn with the GP-PRO, GP-PRO II, GP-PRO III, or
GP-PRO/PB III (DOS Version) are converted into data for GP-PRO/PB III
for Windows, the object may appear to be incompletely painted. Modify the
converted objects as necessary with GP-PRO/PB III for Windows.

����� Converting"Parts Box" Data
The GP-PRO/PB III for Windows file converter can convert Parts Box
screen data for use as GP70/GP77R/GP2000 series unit data.

   12.1 File Converter

����� Data Conversion from LT Editor

This function is available only when GP-PRO/PB III C-Package is installed.

GP-PRO/PB III for Windows Ver.7.2 can open screen data from LT Editor.

Select the LT Project File (*.LTE) in the "Files of type" field in the "Select"
dialog box.

 1.1.2  ����� Selecting an Existing Project
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WHEN USING GLC 2000 SERIES UNITS
• GLC2000 Series units are equipped with the same features as GP2000

units, with the addition of control-related features. As a result, please
change the word “GP” to “GLC” when reading this manual. However,
please remember that GLC Series units cannot use AUX output or Sound
output.
Be sure to understand this manual thoroughly before using your GLC unit.

• For information concerning Logic Program creation and editing, refer to
Pro-Control editor's manuals and online help.

WHEN USING GLC 2000 SERIES UNITS/WHEN USING ST SERIES UNITS /WHEN USING LT SERIES
UNITS

ST Series units are functionally equivalent to GP2301L Series units.
In this manual, you can use the terms “ST” and “GP” interchangeably. When
GP2000 Series usage restrictions are noted, change the term “GP2000
Series” to “ST” series. When detailed GP-2301L restrictions are noted,
change the term “GP-2301L” to “ST”. Note that the ST403 units support the
Ethernet interface. However, ST units have certain restrictions owing to
hardware specification differences with GP-2301L units. Be sure to under-
stand this manual thoroughly before using your ST unit.  Functions incom-
patible with your ST unit,  [GENERAL GP RESTRIC-
TIONS] section, 2.12.2 Restrictions

WHEN USING ST SERIES UNITS

• 64-color-type LT Series units are functionally equivalent to GP70 Series
GP-377S Series units, and Monochrome-type LT Series units are function-
ally equivalent to GP-377L Series units. When GP70 Series usage restric-
tions are noted, interchange the term “GP70 Series” with “LT”. When
detailed GP-377S/GP-377L restrictions are noted, 64-color-type LT Series
units can be read as GP70 Series GP-377S Series units and Monochrome-
type LT Series units can be read as GP-377L Series units.

• Only LT Type C Series units can be connected to a Temperature Controller,
Servo, Inverter or Analyzer. (Using the serial-type interface. See LT Series
Unit User Manual.)
For a complete list of all connectable Devices (Temperature Controllers,
Servos, Inverters or Analyzers)  Device/PLC Connection
Manual.

• For information concerning Logic Program creation and editing, refer to Pro-
Control editor's manuals and online help.

WHEN USING LT SERIES UNITS
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Memo



his chapter describes GP-PRO/PB III for Windows’ basic operations
such as how to start and quit the software. It also explains the Project

Manager and Screen Editor areas, which are used for the majority of screen
creation work. Also, a number of tools are introduced here, such as online
help, which provide explanations of GP-PRO/PB III for Windows’ functions
and operations.

T

  1 FUNDAMENTALS OF GP-PRO/PB III for WINDOWS

1.1 ...................................................... From Start to Finish

1.2 ............................................................ Project Manager

1.3 ................................................................. Screen Editor

1.4 ............................. GP-PRO/PB III Manuals and Help
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����� Starting GP-PRO/PB III for Windows
The following explanation assumes your PC is turned on and the Windows
desktop has appeared.

PROCEDURE R E M A R K S

1.1 From Start to Finish

Create/Select a
project file with the
Project Manager.

1.1.1 Getting Started

Usage Pattern

Start
Save the project,
and quit the
Project Manager.

Save the screen,
and quit the
Screen Editor.

Create/Edit a
screen with the
Screen Editor.

→→→→→→→→→→ →→→→→ →→→→→

(2) The Project Manager screen appears.

This section describes the GP-PRO/PB III for Windows program’s operation
flow from start to finish.

If you double-click directly on a
previously made project file
(*.PRW file)  via the Explorer soft-
ware, GP-PRO/PB III for Windows
will automatically start.

(1) Click on the [Start] button, and point to the [Pro-
grams] - [Pro-face] - [ProPB3 C-Package] menu.
Then, click on the [1. Project Manager] command.
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1.1.2 Creating/Selecting/Saving a Project

A project file (PRW file) normally contains multiple screens intended for the
operation of a certain system. GP-PRO/PB III for Windows creates one
project file for the operation of one system, enabling system management by
project file units.
You can send the screen data of one project file or individual screens of the
same project file to the GP unit. Screens of different project files cannot be
used simultaneously on the GP unit.

����� Creating a New Project
Before creating a new project, designate the GP type, serial interface selection,
Device and Extend SIO information according to your current application.

�����GP Type

Select your Device/PLC Type accordinig to the series of the Device/PL Type
 LIST OF SUPPORTED MODELS

�����Serial interface selection

Specify whether to change the destination of the serial interface and the
Extend Serial Interface before selecting/changing the device or the extended
SIO. This feature is available only with the GP-2000 Series.

 4.2.7 Changing Your Project's Device/PLC Type and
Addresses, 4.2.8 Changing Extended SIO Type

                          Page 27 General GP Restrictions ����� Extended SIO Script

�����Device/PLC Type

Select the type of Device/PLC to be connected to your GP unit.

  Device/PLC Connection Manual

�����Extend SIO Settings

Select the type of Extend SIO.
This feature can be selected only when the GP-2000 series is selected as the
GP Type.

• Serial Code Reader (LS)

Select this option when connecting a Two-Dimensional Code Reader to the
extended serial interface.

 Tag Reference Manual, 4.8.2 Compatible Serial-code
readers
• General SIO Protocol

Select this option when using extended SIO functions with D-script.
 Tag Reference Manual, 3.1.11 Example Communication

Using Extended SIO



1-4

Chapter  1 - Fundamentals1.1 From Start to Finish

GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

• Serial Code Reader (K-tag)
Select this option when connecting a One-Dimensional Code Reader to the
extended serial interface.

 Tag Reference Manual,  4.9 Bar-Code Reader Compatibility

• Extended SIO Script Protocol

Select this option when using the Extended SIO Functions with the Ex-
tended SIO Script.

 2.7 Extended SIO Script, Tag Reference Manual 3.2
Extended SIO Script
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PROCEDURE R E M A R K S

D e v i c e / P L C
Connection Manual

When entering a description, you
can use up to 60 single-byte char-
acters.

(3) Click the  button to enable [Mode Settings],
[System Area Settings] and [Communication Set-
tings] for the PLC Type selected in step (2). When all
settings are completed, press the  button.

(2) Enter a description and select a GP Type, serial in-
terface and Device/PLC Type from the pull-down
menu. Make the settings for Extended SIO Settings
as necessary.

(1) Select the Project Manger's [Project] menu - [New]

command, or click on .

(4) The GP-PRO/PBIII for Windows system will then
ask you if you wish to create a screen. If you click
on the   button, the Screen Editor will start
and you can begin laying out your screen.

     Click the [OK] button in step (2) to skip step (3) and
jump to step (4).

The settings on the left can also be
made by clicking  in
t h e  P r o j e c t  M a n a g e r .
When setting the “Serial I/F
Switch” feature to “Yes” in a
GP2000 Series unit that does not
have Extend Serial I/F,you cannot
use the                     button.

1.1.3 Opening/
Closing/Saving a Screen
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Used to select the
folder containing the
target project file

Used to select the
project file type desired

Displays the project file’s
comment and the selected
GP unit, Device/PLC Type
and Extend SIO Setting

Displays the
project file
name selected
from the list
You can
specify the
project file by
typing the file
name

Used to display
a detailed file
list

Used to display
a file list

Used to create
a new folder

Used to display
the folder of the
preceding level

Lists the current
folder and existing
project files

�����File Types

You can select either a project file created with the DOS version of GP-
PRO/PB III (DOS project file: *.PRO), a project file created with GP-PRO/
PB III for Windows (project file: *.PRW),  or a project file created with LT
Editor (project file:*.LTE).

If you specify the GP type as “GP570VM” in a DOS project file,
and the GP type is not recognized as “GP570VM” in GP-PRO/PB
III for Windows, then re-register the GP type as “GP570VM” in
the Windows version.
• Double-clicking on the file (project file: *.PRW) itself in Explorer auto-

matically starts GP-PRO/PB III for Windows and opens the file.
• Dragging and dropping an *.lte file in the Project Manager will not   auto-

matically open it.

�����Selecting an Existing Project
Select the Project Manger's [Project] menu - [Select] command, or click on

 . When you select a project, the following setting screen appears:

!!!!!
Important

If you attempt to create another project file without saving a newly created
project file, the system asks if you wish to save the current file. If you click on

the  button, the [Save As] dialog box appears. If you click on the
 button, the system opens a new screen without saving the current

project file.
 1.1.2 ����� Saving a Project File under a Different Name

Note:

Note:
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PROCEDURE R E M A R K S

Select “Factory A”

When you double-click on the file
name selected in step (2), you can
skip the  command.

To create a screen,
refer to 1.1.3 Opening/Closing/
Saving a Screen.

To select a project file located in
another folder, find a desired file
from the “Look in: (File location)”.

To select a file created with the
DOS version of GP-PRO/PB III, se-
lect “DOS Project File (*.pro)” in
“File Type:”.

(3) Click on the  button to open the selected
file.

(2) Select a project file from the list that appears, or
type the project file name.

(1) Select the Project Manger [Project] menu’s [Select]

command, or click on .

To type a
file name
via the
keyboard,
type the
file name
here.

����� Saving a Project
When the data of an existing project file is changed, the changes will be automati-
cally saved.
However, if you attempt to create a another new project file without first saving your
current project file, the GP-PRO/PBIII will ask if you wish to save the current file. If
you click on the  button, the [Save As] dialog box will appear.

1.1.2  Saving a Project File under a  Different Name
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PROCEDURE R E M A R K S

The file name can contain up to 255
characters (including the path-name
and extension.)

Before changing the GP
type, check the preset data,
since the drawing area and
functions vary depending on
the type of the GP unit.

4.2.6 Changing a
Project’s GP Type

Once the Device/PLC type is
changed, you must change
the addresses of the Parts,
Tags, D-Scripts and alarms,
and perform the GP system
setup again.

4.2.7 Changing
Your Project’s Device/PLC type
and Addresses

(2) The comment, GP type, Device/PLC type and Ex-
tend SIO of the currently opened project file are dis-
played.

Enter the desired file name, and enter the items to be
changed.

(1) Select the [Project ] menu - [Save As ] command in
the Project Manager.

 To open another
project file, see 1.1.2 �����Creating a
New Project or �����Selecting an Ex-
isting Project.

 To  c lose  GP-
PRO/PBIII for Windows, see 1.1.4
Quitting GP-PRO/PBIII for Win-
dows.

(3) Click on the  button to save the file.

If a project file with the same name exists, GP-PRO/
PBIII will ask if you want to replace (overwrite) the ex-
isting project file with the project file you are attempt-
ing to save.

If so, click on the  button. If you do not wish to
overwrite the existing project file, click on the 
button.

����� Saving a Project File under a Different Name
You can save an existing project file under a different name or with different GP
type, Device/PLC type and Exend SIO settings.
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Horizontal type

ABC

AB
C

Vertical type

• When a high-resolution type GP unit is replaced with a low-reso-
lution type, high-resolution data can no longer be displayed. If the
low-resolution type GP unit is again replaced with a high-resolu-
tion type and the same project file is used, the data will once
again be displayed.
Before changing the [GP Type] setting, be sure to use the
Screen Editor to check the changed display.
Select [Option], [Screen Settings] and the [Display Area] tab.
Then, select the resolution of the new GP Type, and click [OK].
A frame will appear on the Screen Editor to show the display
range at the specified resolution. You can then move your data
into the frame.

• The maximum number of characters used for an alarm summary
in  the low-resolution type is different from that of the high-reso-
lution type. When an alarm message created with the high-resolu-
tion type is used in a low-resolution type, data extending beyond
the message area will not be displayed.

• When a Vertical GP unit is replaced with the horizontal type, or
vice-versa, the displayed screen will rotate 90° relative to the
original data. In this case, you must edit the displayed data
using the [Rotate] command. After editing, be sure to check
the displayed data.
Example)
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After selecting a project file, you can create a screen. First, you must move
from the Project Manager to the Screen Editor, and open a screen. This
section describes the procedures for opening, closing, and saving a screen.

�����Opening a New Screen

1.1.3 Opening/Closing/Saving a Screen

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

Selecting the [Screen] menu’s -
[Open] command or clicking on

 and entering an unregistered
screen number can also be used to
open a new screen.

When the Screen Editor has already
been started, skip step (1).

(2) Select the Screen Editor [Screen] menu’s - [New]
command, or click on  .

(1) Select the Project Manger's [Screen/Setup] menu -

[Editor] command, or click on .
The Screen Editor’s opening screen will appear.

Enter the screen number and title
when saving the screen.

      1.1.3 �����Saving a
Screen under a Different Name

(3) Select the screen type.

Up to twenty screens can be simul-
taneously opened.

Multiple types of windows can be
opened on any one screen at the
same time.

(4)Click on the  button to create the desired
type of screen.
The designated GP type’s drawing screen will appear.
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����� Opening a Previously Saved Screen

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

When you double-click on the de-
sired screen number in step (3), you
can skip the operation of the

 button.

If you enter a screen number that
has not been registered in the list, a
new screen will be opened and that
number will be assigned to it.

When selecting multiple screens, a
screen with the smallest screen
number of them will be displayed.

When the Screen Editor has already
been started, skip step (1).

(1) Select the [Screen/Setup] menu’s - [Editor] com-
mand, or click on  in the Project Man-
ager.

The Screen Editor’s opening screen will appear.

(2) Select the [Screen] menu’s - [Open] command or
click on .

(3) Use this screen to select a screen name from the list,
or select the screen type and enter the screen number.

When checking the [Preview] check box, the selected
screen image can be viewed in the dialog box.

Preview Check Box

Place a check mark in
the [Preview] box.
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(4) Click on the  button to open the screen.

The selected screen will be opened.

Up to twenty screens can be open at the same time.
To select several screens simultaneously, while pressing the              key, click on a
screen and drag the mouse over desired  adjacent screens; or, you can select
screens individually by clicking on them while pressing the            key.

Note: Shift

Ctrl

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S
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�����Saving a Screen

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

After the screen is saved, it will re-
main open.

 To open another
screen, see 1.1.3  ����� Opening a New
Screen.

 To quit GP-PRO/
PBIII for Windows, see 1.1.4 Quit-
ting GP-PRO/PBIII for Windows.

When you attempt to save a new
screen, the [Save As] dialog box
will appear.

 1.1.3 ����� Saving a
Screen under a Different Name

(2) The current screen will be saved overwriting the pre-
vious one.

(1) Select the [Screen] menu- [Save] command, or click
on  in the Screen Editor.

�����Saving a Screen under a Different Name

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

A “,” (comma) cannot be used in a
description.

When using the Security feature:

Click on . For informa-
tion about setting security levels,

 2.12.3 Security
Feature
After the screen is saved, it will
remain open.
If the screen is saved as a different
screen number, the screen of the
updated number will be displayed.

To open another
screen, see 1.1.3  �����Opening a
New Screen or �����Opening a Pre-
viously Saved Screen.

To quit GP-PRO/
PBIII for Windows, see 1.1.4
Quitting GP-PRO/PBIII for
Windows.

(2) The type, number, and title of the current screen is
displayed.

You can change the setting of a desired item; however,
the screen’s type cannot be changed.

(1) Select the [Screen] menu -  [Save As] command in
the Screen Editor.
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PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(3) Click on the  button to register the above
settings.

If a screen with the same number exists, the system asks
if you want to replace the existing screen with the screen
you are attempting to save.
If so, click on the  button. If you do not wish to
overwrite the existing screen, click on the  but-
ton.

�����Closing a Screen

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

When you attempt to save a new
screen, the [Save As] dialog box ap-
pears.

 1.1.3 �����Saving a
Screen under a Different Name

 To open another
screen, see 1.1.3 ����� Opening a New
Screen  or  ����� Opening a Previously
saved Screen.

 To quit GP-PRO/
PBIII for Windows, see 1.1.4 Quit-
ting GP-PRO/PBIII for Windows.

You can also close the screen by
clicking on the  button at the up-
per right corner of the window
(drawing area).(2) The screen will close.

If you attempt to close an updated screen without saving
it, the system asks if you wish to save the current screen.
If you click on the  button, the system saves
the updated data. If you click on the  button,
the system closes the screen without saving the updated
data.

(1) Select the [Screen] menu -  [Close] command in the
Screen Editor.
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Once you have opened the Screen
Editor, you must either quit it, or
go to the Project Manager.

1.1.4  Quiting
the Screen Editor

�����Quitting GP-PRO/PBIII for Windows

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(2) The Project Manger will quit.

If you attempt to close the Project Manager without sav-
ing the currently opened screen’s updated data, GP-PRO/
PBIII asks if you wish to save your project’s data. If you
click on the  button, GP-PRO/PBIII saves the
updated data. If you click on the  button, GP-
PRO/PBIII quits (closes) without saving the updated
data.

(1) Select the [Project] menu - [Exit] command, or click

on  in the Project Manager.

�����Quitting the Screen Editor

1.1.4 Quitting GP-PRO/PBIII for Windows

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

When you save a new screen, the
[Save As] dialog box appears.

1.1.3  Saving a
Screen under a Different Name

(2) The Screen Editor will close.

If you attempt to close the Screen Editor without first
saving the currently edited screen, GP-PRO/PBIII asks
if you wish to save the updated screen. If you click on
the  button, GP-PRO/PBIII saves the updated
data. If you click on the  button, GP-PRO/PBIII
quits the Screen Editor without saving the updated data.

(1) Select the [Screen] menu - [Exit] command, or click
on  in the Screen Editor.
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1.2 Project Manager

All GP-PRO/PB III for Windows system level settings and functions are
controlled via the Project Manager.

1.2      Project Manager

1.2.1 Project Manager Areas and Functions

c. Pull-Down menu

e. Function buttons

d. Status bar

a. Title bar

b. Menu bar

a. Title Bar:

Displays the current project’s file name and title.

b. Menu Bar:

Displays the menus used for the operation of GP-PRO/PBIII for Windows.
When you select a desired menu using the mouse or keyboard, one of the
pull-down menus described below will appear.

c. Pull-Down Menu:

When you select a desired item on the menu bar, its pull-down menu ap-
pears. These menus includes a variety of commands.

d. Status Bar:

Displays GP and Device/PLC Types as well as GP-PRO/PBIII operation
related messages.

Here, each of the Project Manager’s features is explained.  To begin working
with GP-PRO/PBIII for Windows, simply click on the desired button.

GP Setup information
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Selects an existing
project

Creates a new project

Creates Alarm
Editor alarms

Switches the Project Manager
to  Hierarchical (Explorer-like)
Display mode

Chapter 11
PROJECT MANAGER HIERAR-
CHICAL DISPLAY

Performs GP Initial
Settings

Creates or modifies screen
data via the Screen Editor

Quits the GP-PRO/
PBIII for Windows
program

Prints out Screen
Editor screens

e. Function Buttons

These buttons indicate the GP-PRO/PB III for Windows program’s main
functions (e.g. Creating Screens/alarm, Printing). You can start each func-
tion by simply clicking on that function’s button. You can also start these
functions by selecting the corresponding command from the Project
Manager’s pull-down menu.

Performs Simula-
tion with the GP
unit

Switches to the Pro-
Control Editor software
when the GLC series or
LT series is selected for
the "GP Type" option.

Pro-Control
Editor Operation Manual

Transmits screen
and GP system
setting data to the
GP unit
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1.3 Screen Editor

1.3      Screen Editor

1.3.1  Screen Editor Item Names and Functions

g. Status Bar

a. Title Bar

c. Pull-down
Menu

j. Selection Tool Box

i. Zoom Box

k. Screen
Data List

d. Drawing
Area

e. Screen
 Center Mark

f. Grid Points

a. Title Bar

Displays the project file name, screen number and title.

b. Menu Bar

Displays the menus used to operate GP-PRO/PBIII for Windows. When you
select a desired menu using the mouse or keypad, the pull-down menu (c)
appears.

c. Pull-down Menu

When you select a desired menu from the menu bar, the pull-down menu
appears. This menu includes various commands.

d. Drawing Area
Here, you can create a screen for your GP unit. The size of the screen you
see here is designated via the “GP Type” setting you entered when you first
created the project file.
Depending on the size of your PC’s display, the screen’s entire display area
may not be displayed. In this case, simply scroll up or down to view the
entire screen.

The names and functions of the GP-PRO/PBIII for Windows editor’s screen
items are as follows:

GP operation and display screens are created in the Screen Editor.

b. Menu Bar

h. Tool Bar

h. Tool Bar

h. Tool Bar

l. Parts Palette
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Amount of Screen
memory currently
used (Ratio of used
screen area to entire
screen)

Coordinates
of current
mouse
position

Description of the
currently selected
command

Project’s
Device/
PLC Type

Display area’s
magnification/
reduction ratio

e. Screen Center Mark
Indicates the center of the screen. This mark is not displayed when the data
is sent to the GP unit.

f. Grid Points
Used as reference points when you draw or paste an object in the drawing
mode. Grid points will not be displayed on the GP unit’s screen. The Option
area’s “Snap” function allows you to position your screen objects using a
pre-made grid. You can also set the interval and display ON/OFF status of
the grid points.

  2.10.1 Grid/Snap
g. Status Bar

Displays information related to the current screen and provides messages
explaining the screen operation you are currently performing.

h. Tool Bar

The Tool Bar provides easy to use icons for drawing and editing. Clicking
on one of these icons performs that command. The Tool Bar can either be
hidden or displayed, and individual Tool Bar areas can be moved freely
around the Screen Editor screen, i.e. top, bottom, left, or right.
The following Tool Bar areas are available:

Main Tool Bar
Edit Tool Bar
Draw Tool Bar
Option Tool Bar
Grid/Snap Tool Bar
Tag Tool Bar
Parts Tool Bar
Parts State Change Tool Bar
Text Table Tool Bar

i. Zoom Box

Shows the cursor’s current position at three times magnification.

j. Selection Tool Box

Used to select objects to be edited (Parts, Tags and figures). Using the
commands included in this tool box, you can select objects using a variety of
methods.
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1.3 Screen Editor

k. Screen Data List
Lists the settings and layout conditions of the objects (Parts, Tags and
figures) that have been arranged on the screen. You can select a desired
object from the list.

 2.10.4 Screen Data List
l. Parts Palette

Parts such as switches, lamps and graphs are placed on a tabbed palette
(except for the keyboard, alarms, File Name Display, Logging Display, Data
Transfer Display, CSV Display, File Manager Display, Picture Display, and
Window parts).
To place parts on the drawing screen, simply select the desired part from the
palette and place it on the screen with drag & drop operation. Only one part
can be selected per operation.
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Zoom out: Used to reduce the current display area to 50%.

Zoom in: Used to enlarge the current display area to 200%.
In the [50%] display mode, the created screen data is reduced. In this case,
the displayed screen data may be different from the actual data. We recom-
mend you to use a [100%] or larger display area.

1.3.2 Display Area (50%, 100%, 200%)

Zoom out Zoom in

Note:

You can enlarge or reduce the drawing area by selecting a magnification/
reduction ratio.
To change the display area, select the  or  icon on the tool bar, or
select the [50%], [100%], or [200%] command from the [View] menu.

1.3.3 Tool/Icon Display
The Tag tool box, Parts tool box, tool bar, status bar and parts palette can be
designated as either shown (displayed) or not shown (not displayed). Each
time you select the [View] menu's [Screen Data List], [Status Bar], [Zoom
Box],  or [Parts Palette] as well as the [Tool Bar] command's [Main], [Edit],
[Draw], [Option], [Grid/Snap], [Tag], [Parts], [Parts State Change] or [String
Table] sub-commands, these View/Hide settings will  toggle ON or OFF.
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Chapter  1 - Fundamentals1.4 GP-PRO/PBIII Manuals and Help

�����Using the Help Feature
If you have any problems or questions during GP-PRO/PB III for Windows
operation, you can view the explanations for each feature and setting via
each window’s Help button, or from the main menu’s Help feature.

�����Using the Home Page
Users can obtain the latest GP-PRO/PBIII for Windows information by
accessing the Digital Electronics Corporation Home Page.

While you are learning how to use the GP-PRO/PBIII for Windows soft-
ware, please refer to the following learning aids:

· Related User Manuals
· On-line Help Topics
· Digital’s Home Page

For the help concerning the operation of the Windows operating system, see
the Windows software’s manuals and help screens.

�����Using GP-PRO/PBIII for Windows Manuals
The following manuals have been created for the GP-PRO/PB III for Win-
dows software.

1.4 GP-PRO/PB III Manuals and Help

Setup Guide
Describes the system requirements, installation procedures
for GP-PRO/PB III C-Package03 and the method for
reading the manuals in PDF format.

Operation Manual
(This manual) Provides detailed program operation information.

Tag Reference Manual Provides detailed descriptions of this software's special and
advanced functions.

Parts List Lists all the pre-made Parts included in the GP-PRO/PB III
for Windows software.

Device/PLC Connection
Manual

Describes connection methods used between the GP and
the device, as well as the necessary operating environment
settings.
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To display the help screen, select the [Help] menu or click on the 
button in the dialog box.

· When multiple screens are loaded or many Tags and Parts have
been registered on the screens, the PC’s system memory may
not be sufficient to display the help screen.

· If you jump from one topic to another on the help screen, an
error message may be displayed. When this happens, simply
quit and then re-start help.

����� Searching for a Topic and then Display Help
Select the [Help Topics] command from the [Help] menu, or press the [F1]
key. A list of help topics will be displayed.

You can search for a topic by either trying to find it from the table of con-
tents, or entering a keyword for that topic.

����� Searching for a Topic from the Contents Menu

To select a topic from the contents menu, double-click on the [Contents] tab.
Follow the screen instructions to search for a desired topic.

1.4.1 Browsing Help Topics
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�����Calling up Help from a Dialog Box
When you click on the  button in the dialog box or press the [F1]
key during execution of a command, a description of the currently-executed
command will be displayed.

�����Searching for a Topic by a Keyword

To enter a keyword, click on the [Index] tab.
Search for a desired topic according to the instruction indicated on the
screen.
(When you enter initial characters of the keyword, the topics specified with
these initial characters are also automatically listed)
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Use this feature to call up the [GP-PRO/PBIII for Windows] or [Pro-Control
Editor] PDF manuals.

1.4.2 PDF Manuals

[Help]

Usage Pattern

Click on the desired
manual name

Screen creation guide
or Logic programing
guide

[Manual]→ → →

The following manuals explain the features of the Screen Editor and Logic
Program software.

PDF manuals can be viewed using Adobe® Acrobat® Reader. For Reader
installation instructions,  Setup Guide.

Note:

Operation Manual
Tag Reference Manual
Device/PLC Connection Manual
Parts List
Screen Layout Sheets
User Manual
Operation Manual
LT Type H I/O Setting User Manual

Screen creation guide GP-PRO/PBIII for Windows
(GPWMNL.pdf)

Logic programing guide Pro-Control Editor
(PCEMNL.pdf)

[Help] Click on the desired manual name[Manual]→ →

[Help] Click on the desired manual name[Manual]→ →

· Project Manager

· Screen Editor

· Pro-Control Editor
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The procedure to connect to Pro-face's home page is described here.

· To view Pro-face’s home page, you must have the hardware
necessary to access the Internet. You also must have a browser
to view the home page, and subscribe to an Internet provider.

· Please understand that Pro-face cannot respond to any questions
about your Internet connection.

����� Registering a Home Page Address
The address of Pro-face’s Web Page has been preregistered in your GP-
PRO/PBIII for Windows software. When you click on the  button,
the address setting dialog box appears.

� How To Register a Home Page Address

����� Deleting a Home Page Address
Any registered home page address can be deleted. When you select the
home page address to be deleted and click on the  button, the
confirmation dialog box appears. If you click on the  button, the
selected home page address will be deleted. If you click on the 
button, the deleting operation will be canceled.

1.4.3 Connecting to the Home Page

Used to delete a
registered home
page address

Used to edit a regis-
tered home page
address and title

Used to add a home
page address

Used to connect
to the specified
home page

Displays all regis-
tered home page
addresses (titles)

[Help]

Operating procedures
Click on the

button.

Add/Edit/Delete[Connect to
Home Page]

→ → →
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�����Editing a Home Page Address
The registered home page address or title can be changed. When you select the home
page address to be edited and click on the  button, the address setting dialog
box appears (same as for the home page addition procedure), enabling you to change
the title and address of the home page. If Digital Electronics Corporation’s home
page address is changed in the future, please edit the currently registered address.

�����Connecting to the Home Page

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1) Select the [Help] menu - [Connect to Home Page]
command in the Project Manager.

(3) Click on the  button to connect to Pro-
face’s home page.
The browser is started, and you will be connected to the
home page.

(2) Select the target home page address.
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(3) Enter a home page title and address to be registered
and click on .

The specified home page address will be registered.

�����How To Register a Home Page Address

(2) Click on the  button.

(1) Select the [Help] menu - [Connect to Home Page]
command in the Project Manager.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S
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“Otasuke Pro!” is the Pro-face’s support-dial site designed especially to
meet customer support needs.
You can easily connect to the “Otasuke Pro!” site via the C-Package03
menu.

· To view Pro-face’s home page, you must have the hardware
necessary to access the Internet. You also must have a browser
to view the home page, and subscribe to an Internet provider.

· Please understand that Pro-face cannot respond to any questions
about your Internet connection.

1.4.4 Using “ Otasuke Pro! “

[Help]

Usage Pattern

Otasuke Pro! (O)→
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Memo



o create Base screens, the Editor area’s Part, Draw, Tag, and Menu Bar
commands can all be used.  Also, Edit commands can be used to
modify any Parts, objects or Tags that you have created. In addition to

editing these screen objects, the procedures for registering Library Items and
Windows are also explained.

T

  2      CREATING BASE SCREENS

2.1 ................................................................................ Parts

2.2 .......................................................................... Drawing

2.3 ................................................................................. Tags

2.4 ................................................................ Object Editing

2.5 ......................................................................... Libraries

2.6 .............................................. D-Script/Global D-Script

2.7 ..................................................... Extended SIO Script

2.8 ............................................................... Data Sampling

2.9 .............................................................Global Interlock

2.10 ...................................... Efficient Drawing Techniques

2.11 .................................. Creating Handy-type GP Screen

2.12 ............................................ Creating ST Series Screen

2.13 ............................................................ DXF Conversion



2.1 Parts Chapter 2 - Base Screens

2-2 GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

Icon Name Function Reference

Bit Switch
Used to change a device’s Bit Address
data.

2.1.1 Bit Switches

Word
Switch Changes a device’s Word Address data. 2.1.2 Word Switches

Function
Switch

Used to go back to the previous screen, to
switch screens, and to reset the GP.

2.1.3 Function  Switches

Toggle
Switch

Turns the device’s Bit Address ON or
OFF.

2.1.4 Toggle  Switches

Lamp
Turns ON or OFF according to the device’
s Monitor Bit.

2.1.5 Lamps

4-State
Lamp

Switches the 4 states of the lamp,
according to whether the device’s two
Monitor Bits are ON or OFF.

2.1.6 4-State Lamp

Bar Graph
Displays the device’s Word Address data
in a bar graph.

2.1.7 Bar Graphs

Pie Graph
Displays the device’s Word Address data
in a pie graph.

2.1.8 Pie Graphs

Half Pie
Graph

Displays the device’s Word Address data
in a Half-Pie graph.

2.1.9 Half Pie Graphs

Tank
Graph

Displays the device’s Word Address data
as absolute values in a Tank graph.

2.1.10 Tank Graphs

2.1      Parts

�����GP-PRO/PBIII for Windows Part Type List

Each Part’s attributes such as setting Addresses and colors will be desig-
nated via the dialog box.  After designating all the necessary Part attributes,
decide their position and size on the object drawing area.

Parts can be placed on the drawing screen simply by selecting the desired
part from the palette and placing it on the screen with drag & drop opera-
tion.

The [Parts] command is enabled only on the Base screens.

    Usage Pattern
Place it
on the
Screen

Specify its
Attributes

Select the specific
Part from the
Browser

Decide on
a type of
Part

y[Parts] →→→→→ →→→→→ →→→→→ →→→→→

→→→→→ Select a desired icon from the Parts Tool Bar.or

Specify the
Attributes

Place the part on the
Screen with drag &
drop operation

Select the
desired partyParts Palette →→→→→ →→→→→ →→→→→
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Icon Name Function Reference

Meter
Displays the device’s Word Address data
a Meter.

2.1.11 Meter Graphs

Trend
Graph

Displays the device’s Word Address data
as absolute values in a trend graph.

2.1.12 Trend Graphs

Keypad
Used to enter a device’s Word Address
data.

2.1.13 Keypads

Keypad
Input

Display
Displays data input via the keypad. 2.1.14 Keypad Display

Alarm
Display

When monitored Bits are turned ON, a list
of “Basic” Alarm summary messages
appear that have been previously
registered in the Alarm Editor.

2.1.15 Alarm Display

Filing Data
Display

Displays data registered in the Filing Data
list by specifying the corresponding file
number.

2.1.16 File Name
Display

Logging
Display

Displays device data loaded in the data
logging settings by specifying the address
for the corresponding block number.

2.1.17 Data Logging
Display

Data Transfer
Display

Enables manual transfer of the data-
transferring CSV data (ZR*****. CSV) from
the CF Card to the device, or from the PLC
to the CF Card.

2.1.18 Data Transfer
Display

CSV Display

Enables the display, editing and printing of
the CSV file on the CF Card. Place and
use this Display together with the Data
Transfer Display or File Manager Display.

2.1.19 CSV Display

File Manager
Display

Displays the folders/files of the CSV files
on the CF Card.

2.1.20 File Manager
Display

Numeric
Display

Displays the device’s Word Address
numeric data as an absolute value.

2.1.21 Numeric Displays

Message
Display

Displays a previously registered message,
according to device Word Address data
changes. A maximum of 16 messages
can be displayed in a single Message
Display.

2.1.22 Message Display

Date Display
Displays the current date, using the GP’s
internal calendar.

2.1.23 Date Displays

Time Display
Displays the current time, using the GP’s
internal clock.

2.1.24 T ime Displays
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����� Reflection of a Device Comment

If you click on the  [Apply Device Comment] button after entering an
address, the device comment entered using the Symbol Editor is automati-
cally searched for, and the comment corresponding to the entered device
appears in the Description field.

4.9 Symbol Editor

Up to 20
alphanumeric
(single-byte)
characters or
10 Chinese
(double-byte)
characters can
be entered

�����Entering a Comment
If desired, a comment can be entered for a Part.

Applies the
device
comment

Icon Name Function Reference

Picture
Display

Displays a single registered Library image
(only graphic data), according to device
Word Address data changes.

2.1.25 Picture Displays

Window
Parts

Windows created on the Window Screen
(U) can be called up on the Base Screen
(B).

2.1.26 Window Parts
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Enter the address data
here

����� Entering Addresses
Here, Addresses that are operated for Parts’ functions and that are monitored
are designated. A variable to be used in a logic program (GLC symbol) can
be designated as a Part's address.  4.2.6 Symbol Editor

When a variable (GLC symbol) is used as an address, an integer
array must be designated. For an integer array, the size used for
consecutive addresses needs to be allocated. If the space (ad-
dresses) needed for the continuous addresses' array is not re-
served/set up, the Part/feature will not operate correctly.
Also, be aware that during Online Edit, the addition and deletion
of variables may not operate correctly.

The address to be entered varies depending on your GP and
external device types. Please understand that the sample con-
figuration in this manual is only an example.

����� Entering from a  keyboard

Click on the address entering field, and the cursor will appear there, which
indicates data entry is now effective. Then, enter device and address data via
the  keyboard.
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Activates the
address keypad.

To move the address
keypad to the desired
position, drag its title bar.

To display the device
names in a list, click here.

Backspace key
Hexadecimal
number entry key

Enter key

Clear key

Display

To close the address
keypad, click here.

{

Note: yyyyy To prevent mistakes, be sure to double-check the address you are entering
in the address keypad.

yyyyy When using a GLC/LT Series unit, you can designate logic program vari-
ables (GLC symbols) using bits. Click on the Address Keypad (shown
above) and then on the [GLC] key to display the GLC Symbol Keypad to
enter Address data.

�����  Entering from an address keypad

Click on the address keypad icon, and the address keypad will appear,
allowing you to enter numeric data and addresses on the screen via the
mouse.

A pull down list
shows GLC
symbols.

The GLC symbol will
be accepted with a
click on the Enter
key.

[GLC Symbol Keypad]

Designates GLC
symbols by using
bits

Returns to the
Address Keypad
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����� Selecting a Part Shape

Click on the General Settings Area’s   button in the dialog box,
and the Shape Browser (hereafter called “Browser”) will be displayed.
The Browser’s Part Shapes are stored in a Part File (PDB file or BPD file),
separate from the main Project File (PRW file).  Searching through different pre-
made Part files allows you to easily find useful Part Shapes for almost any
application.
Parts (image parts) stored in BPD file is corresponding to GP2000 series only.

Click on a Part number and then the  button, or double-click
directly on the Part number to select a Part Shape. (Browser disappears)

Part File and Part Shape lists for each file are included in the GP-PRO/PBIII
for Windows Parts List Manual.

Note:

Calls up a list
of the other
Part files

Shows the
Part name of
the currently
open Part
Palette

Note:

The ID number
of the Part
Shape is dis-
played here.
Reverse video
(highlighting)
indicates it is
selected

Clicking here
scrolls
through the
Part Palette
in this file

Shows the ID number of the
currently selected Part Shape

Click here to
register cus-
tom image
parts.

Deletes custom
image parts
created by the
user.

�����  Entering from a pull-down list

Click on the  box next to the Address entering field, and a pull-down list
appears including symbols selected via the Symbol Editor and device com-
ments together with corresponding Addresses. Selecting a symbol or device
comment from the list designates an Address.

   4.7  Symbol Editor

A Part’s specified address can be entered so that it is displayed during Base
screen creation.

   2.9.2 Screen    2.10.2  Screen Property Settings
Regardless of whether addresses are designated as either displayed or not
displayed during Base screen creation, they will not be displayed on the GP
panel after screen transfer.

Note:
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����� Browse

Allows you to view and select the Parts files.
Two types of part files can be used: PDB files and BPD files.
Select the parts best suited to your application from the applicable files.

yyyyy Use the parts included in BPD files (image parts) for switches and lamps.
However, these parts cannot be used for Toggle Switches or 4-State Lamp
settings.

yyyyy The Image Parts feature is supported only by the GP2000 Series.

Click on the  button and a list of the Part files will appear.
After clicking on a Part File, the information displayed will change to reflect
that file.  Next, click on the  button and the selected Part file’s Part
Shape will appear in the Browser.

Note:

Displays file
names and details

Shows the
currently
open folder

Moves to the next higher
file directory level

Shows the
currently
selected
Part file’s
comment

Lists the
names of all
the Part
files in this
folder

<Differences between the PDB File and BPD File>

yyyyy The BPD file is located in the [PDB] folder.

yyyyy Part files (PDB File/BPD File) are automatically installed in a folder named
"PDB" when GP-PRO/PB III is first installed. If desired, these files can be
installed in other folders instead. To display part shapes located in other
folders, use the [Look in:] area to switch to the applicable folder.

Note:

*1: A preprogrammed BPD File cannot be registered or deleted.

Shows the name of the currently
selected Part file.  A name can also
be entered here to select a file.

Preprogrammed
File

Registration/
Deletion by Users

Color Setting
Adjustment

PDB O X O

BPD O O*1 X

Creates a
new folder
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����� Registering Image Parts

Image files in bitmap file format and JPEG file format can be registered in
the BPD File as Image Parts for switches and lamps (except for Toggle
Switches and 4-State Lamps). Image files can be specified separately as
either ON and OFF.

Click the  button in the Shape Browser dialog box. The dialog
box for registering Image Parts will appear.

Select the BPD File in which to
register the Image Part.

Create a new
BPD File in
which to register
the Image Part.

Select an image
for the ON state.

Specify the
number of colors
for the Image
Part.

Enter the title
(name of the
Image Part).

Select an
image for the
OFF state.

Register the part
to the specified
BPD File as a
new Image Part.

The following table shows the types of image files that can be registered.

1 bit
2 colors
(black &

white)
16 colors

16-level
gray
scale

256 color
256-level

gray
scale

Windows BMP/DIB O O O O O O O O
Windows

BMP/DIB(RLE4)
- O O - - - - -

Windows BMP/DIB
(RLE8)

- - - O O - - -

JPEG *.JPG - - - - O - O -

*.BMP

16-bit
color

24-bit
color

32-bit
color

4 bits 8 bits

Number of colors
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y Image Parts can be registered to a maximum size of 160 x 160 (dots).

y Image Parts will increase the size of the Project file. We recommend
enabling the "Compress" setting in "Color" settings.

y Up to 200 Image Parts can be registered in a single BPD File.

y Before registering the Image Part, select image files for both ON and OFF
states.

yWhen the sizes of the images for the ON and OFF states differ, the smaller
  image is magnified to equal the size of the larger image.

y Image Parts that are zoomed in or zoomed out may appear slightly differ-
ent on the GP screen than from the PC screen.

Note:

R E M A R K SPPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE

This section describes the procedure for registering
Image Parts in the BPD File.

(1)Click the  button in the Shape
Browser dialog box.

(2)Specify the location for registering the Image Part.

[Register the Image Part in an existing BPD File.]

a) Click the [Browz] button and select the BPD File
     in which to register the Image Part.

b) Press the  button to confirm the
    destination file for registering the Image Part.

[Register the Image Part to a new BPD File.]
a) Click the   button.
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R E M A R K SPPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE

b) Specify the file name of the new file.
In the "File Name" area, enter the file name of the
destination BPD File.

In the "Description" area, enter the category name of
the BPD File as well as any remarks that may be use-
ful as notes.

c) Press the   button to confirm the
destination file for registering the Image Part.

(3) Select an Image Part for the OFF state. Click the
  button and specify the desired bitmap

image.

(4) Select an Image Part for the ON state using the
procedure described in step (2).

(5) In the "Title" area, enter the name of the Image
Part.

(6) In the "Color" area, specify the display color for
the Image Part.

(7) Click the  button.

(8) Click  to complete the registration.

Image Parts can be registered to a
maximum size of 160 x 160 (dots).

Before registering the Image Part,
select image files for both ON and
OFF states.

Image Parts will increase the size of
the Project file. We recommend
enabling the "Compress"  in "Color".
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����� Colors
Color setting methods will differ for each model, i.e. monochrome, mono-
chrome LCD (eight levels of gray), 8-color, 64-color and 256-color settings.

64-color model : GP-571T, GP-675S, GP-675T, GP-377S, GP-377RT,
GP-577RS, GP-577RT, GP2000 series (except GP-
2301HL, GP-2300L, GP-2301L, GP-2500L and GP-
2501L)

256-color model : GP2000 series (except GP-2301HL, GP-2301HS, GP-
2300L, GP-2300S, GP-2301L, GP-2301S, GP-2500S and
GP-2501S)

8-level gray-scale model: monochrome LCD GP2000 Series (GP-2301HL,
GP-2300L, GP-2301L, GP-2500L and GP-2501L)

· Do not transfer a Project File created using 64-color (256-
color) data to a 64-color (256-color) incompatible GP panel.
The 64-color (256-color) data may be automatically changed to
monochrome data and some object elements, such as fills or
patterns, may not be displayed as they were originally drawn.

· Pro-face recommends of using the basic 8 colors (on the color
bar).  Objects and image data created using colors (on the
color palette) other than the basic 8 colors may flicker.

����� Selecting Colors
Specify Part colors using the Shape/Color setting screen.  The setting items
will differ depending on the Part, i.e. the border type, ON/OFF states,
graphs, and label colors.
Tiling patterns can be selected for some of the Parts, Lamps, and Graphs.

Note: Specific colors are pre-assigned to each Image Part (BPD File) when it is
selected from the browser. Color settings cannot be modified.
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<When using an 8-color or monochrome GP unit (incompatible with 64-
color screens)>

There are 8 colors available in the color bar.  Use this bar to select the
foreground (Fg), background (Bg) and other colors.  When the [Reverse
Display] option in the [GP Setup | I/O Settings] has not been checked, on a
monochrome GP screen, black, blue, green, and cyan will be displayed as
white (same as background); red, magenta, yellow, and white will be dis-
played as black.

Color palette
(other than basic 8
colors)Color palette

(basic 8 colors)

<When using Monochrome LCD (eight levels of gray) GP unit >
When the [Reverse Display] option in the [GP Setup | I/O Settings] has not been
checked,

Black (dis-
played)

White (not
displayed)

Color GP unit

Monochrome GP unit

BK BL GR CY RD MG YL WH

Color GP unit

Monochrome LCD
GP unit

BK BL GR CY RD MG YL WH

Light Dark
Colors are displayed in
eight levels of gray.

Depending on the color used, selecting MONOCHROME 8 HUES may cause
the GP unit’s screen to flicker. Confirm the color before using this mode.Note:

If the screen editor's [GP Setup] screen's [Initial Screen Settings] [Mono-
chrome - 8 hues] is selected (enabled), the color can be set via the 8-color
color bar. However, on the GP unit the display will be converted back to
monochrome.
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After converting 64 color data to
8 color data, each color will be
displayed like this:

After converting 64 color data to
monochrome data, each color
will be displayed like this:

Color bar

Color palette

Color bar

Color palette

<When using a 64-color GP unit>
There are 64 colors available via the color palette.  Use the palette bar to
select the foreground (Fg), background (Bg) and other colors.

Color palette

Color bar
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<When using a 256-color GP2000 series unit>

Color palette
Color bar

The following tables describe the changes in the display when the GP type is
changed from a 64-color model to a 256-color model.

0 1 2 3 4 5 6 7
8 9 10 11 12 13 14 15
16 17 18 19 20 21 22 23
24 25 26 27 28 29 30 31
32 33 34 35 36 37 38 39
40 41 42 43 44 45 46 47
48 49 50 51 52 53 54 55
56 57 58 59 60 61 62 63

0 1 2 3 4 5 6 7
8 9 10 11 12 13 14 15
16 17 18 19 20 21 22 23
24 25 26 27 28 29 30 31
32 33 34 35 36 37 38 39
40 41 42 43 44 45 46 47
48 49 50 51 52 53 54 55
56 57 58 59 60 61 62 63

0 1 2 3 4 5 6 7
8 9 10 11 12 13 14 15
16 17 18 19 20 21 22 23
24 25 26 27 28 29 30 31
32 33 34 35 36 37 38 39
40 41 42 43 44 45 46 47
48 49 50 51 52 53 54 55
56 57 58 59 60 61 62 63

255 250 72 75 140 143 100 103
248 249 160 161 162 163 192 193
194 195 73 74 120 121 122 123
168 169 170 171 200 201 202 203
80 81 82 83 132 133 134 135

180 181 182 183 212 213 214 215
92 93 94 95 141 142 188 189

190 191 220 221 222 223 101 102

0 1 2 3 4 5 6 7
8 9 10 11 12 13 14 15
16 17 18 19 20 21 22 23
24 25 26 27 28 29 30 31
32 33 34 35 36 37 38 39
40 41 42 43 44 45 46 47
48 49 50 51 52 53 54 55
56 57 58 59 60 61 62 63

232 235 104 107 244 247 116 119
233 234 144 145 146 147 224 225
226 227 105 106 236 237 238 239
148 149 150 151 228 229 230 231
108 109 110 111 240 241 242 243
152 153 154 155 64 65 66 67
112 113 114 115 245 246 156 157
158 159 68 69 70 71 117 118

0 1 2 3 4 5 6 7
8 9 10 11 12 13 14 15
16 17 18 19 20 21 22 23
24 25 26 27 28 29 30 31
32 33 34 35 36 37 38 39
40 41 42 43 44 45 46 47
48 49 50 51 52 53 54 55
56 57 58 59 60 61 62 63

251 254 76 79 136 139 96 99
252 253 164 165 166 167 196 197
198 199 77 78 124 125 126 127
172 173 174 175 204 205 206 207
84 85 86 87 128 129 130 131

176 177 178 179 208 209 210 211
88 89 90 91 137 138 184 185

186 187 216 217 218 219 97 98

64-color No blink 64-color Blink

64-color Fast 64-color Slow
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Note:
Transparent mode can be selected as the background color (Bg) text and
Mark objects.  This function is useful when overlaying text on Switches,
Lamps, and other objects.

For example:  Change the background color of the label from "Black" to
"Transparent".

����� Blink

Blink settings will also differ slightly depending on whether a single speed
Blink GP model or a three speed Blink GP model is used.  Digital’s three
speed blink models are the GP-571T, GP-675S, GP-675T, GP-377S, GP-
377RT, GP-577RS, GP-577RT and GP2000 series units (except GP-
2301HL, GP-2300L,  GP-2301L, GP-2500L and GP-2501L). Other GP
models have only one blinking speed. When 256-colors are selected in a
project, the “Blink” feature cannot be used for any of that project’s screens.

<Using a three speed Blink type GP>

Next to the Check Box, there is a Button that will display a range of 3
speeds and “No Blk” (indicates no blinking). When one of the blink speeds
is selected, the color bar is displayed in a darker color and the specified Part
will blink on the GP screen.

When the GP model is changed from a three speed Blink type to a single
speed type, the “Mid” and “Slow” speeds will be changed to the single
speed GP’s “Blink” speed, and “No Blk” and “Fast” will be changed to “No
Blk”.  The blinking rate for a single speed GP model is equal to the “Mid”
setting of the three speed type.

<Using a single speed Blink type GP>

When the Blink (Blk) Check Box is checked  , the color bar is displayed
in a darker color and the specified Part will blink on the GP’s screen. With
monochrome (eight layers of gray), the color bar on the GP-PRO/PBIII
screen will be displayed in dark blue color. (black color blink is excluded)

Blink Check Box

The normal blink speed is “Mid.”
“Fast” is twice as fast as “Mid”
and “Slow” is half as fast as
“Mid”.  When “No Blk” is se-
lected, the Part will not blink.

Blink speed settings

No Blk No blink
Mid Blink
Fast No blink
Slow Blink
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Sets the minimum
and maximum
Alarm values

Sets the Alarm
value’s Format
to fixed or
variable

Sets the Alarm
colors used

����� States

Only Parts which can have two states are displayed with this feature.  Dis-
play colors for Parts can be specified separately for each state; for example,
a Bit Switch can be displayed as red in the OFF state and green in the ON
state.  Click on either state button to select it, and specify that state’s color
using the color bar.

����� Alarm Settings
In both graph and numeric value displays, Alarms can be set up.
First, click on the [Alarm Settings] tab at the top of the Dialog box.  When
checking the Alarm Display box (Check mark  appears), the Alarm setting
items will appear.

����� Alarm Type

The Alarm value can be specified as either direct (fixed value) or indirect
(variable value) by simply clicking on the appropriate circle.

<256-color models>
Specify the background color of the
labels as "Clr".

The background color of the
label becomes transparent.

The background color of
the label is black.

<All models>

Specify the background
color of the label as
"Black" only.

Specify the background color of
the labels as "Black and Blk
(Blink)".
*On 64-color models, this feature
is enabled only when the "Mid"
blink speed is selected.

<Non-256-color models>
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<Relationship between display data’s storage address and Alarm register
address>

Word Addresses are automatically
allocated in sequence, starting
from the Address designated

With 16 Bit data

n Display Data
n+1 Data value - Max.
n+2 Data value - Min.

With 32 Bit data

Display Data

Data value - Max.

Data value - Min.

n
n+1
n+2
n+3
n+4
n+5

����� Alarm Range

Here, you can specify the maximum and minimum Alarm values.
When the Alarm value has been specified as indirect, the maximum and
minimum values can also be specified as indirect.  In this case, the Word
Address number used to store these values will be automatically assigned
continuously from the Word Address currently specified.
The following example uses “n” to denote where the Word Address’ display
data is stored:

When a variable (GLC symbol) is used as an address, an integer
array must be designated. For an integer array, the space re-
quired for consecutive addresses must be allocated. If the
space (addresses) needed for the continuous addresses' array
is not reserved/set up, the Part/feature will not operate cor-
rectly.
Also, be aware that during Online Edit, the addition and deletion
of variables may not operate correctly.

����� Alarm Color

Here, you can select the colors used for an Alarm display.
 2.1 Parts ����� Selecting Colors
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����� Direct Text

The text entered in the text entry field is placed directly as a fixed text string.

����� Browse Text Table

You can select or add strings previously registered via the Text Table Editor.
 4.6.3 �����Selecting the text table character string ����� Enter-

ing the text table character string

����� Image fonts

Windows fonts are displayed in bitmap format.
This feature is enabled only when the "direct text" mode is selected.

 2.2.9  Text  ����� Image Font

If using the
direct text as
Image Font,
place a check
mark in the
check box.

Select the text type. Enter characters to be
displayed as direct text.

Select the
character’s
size.

Select the
character’s
type.

Copies the charac-
ters to the label for
the Off state.

Copies the characters
from the Description
field to the label of the
current state.

Select the label’s
color here.

<OFF state>

When a lamp’s Text Display changes
(This Switch’s ON/OFF colors are also se-
lected)

<ON state>

The Part must be large enough to display the entire Label.

As with Parts, Label display colors can be created for each of a 2-state Part’s
states; up to 4 lines of text can be used for each state.

Note:

����� Creating Labels
Here, a Label means the text characters shown on the faces of the Switch
and Lamp button Parts.  Labels can be registered via the Part’s Setting
dialog box.

Moves the label
back to the center
that has been
repositioned after
placing the part.
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����� Alignment (Justification)
When the text input for a Label exceeds one line, the Alignment icons will
appear.  Select Left, or Right justification, or Centering.

The Image Font is supported only by the GP2000 series.

����� Label
Here, you can type in the text displayed on a button.  When typing in text,
press the  key to move to a new line.  When the [Tracking] check box is
checked  (enabled), after the Part has been placed on the screen, if the
Label’s size or position is changed, for either state, the alternate state’s Label
size and position will be also automatically changed.  If, however, the
Label’s size and position need to be specified independently for each state,
DO NOT check  this box.    2.4.3 Scaling Up/Down

����� Copy from Description
The characters entered in the Description filed are copied to the label in the
selected state.

����� Copy to Off (On) state
When the state is On, the characters entered in the label are copied to the
label in the Off state. When Off, the characters are copied to the label in the
On state.

����� State
States are displayed only for Lamps, and for those switches with two states
(ON and OFF).  The text displayed for each state can be specified indepen-
dently.  Simply click on either state button to specify its text and colors.

�����Centering
Moves the label to the center of the part when the label has been reposi-
tioned after placing the part.

����� Character Size
Specifies the size of character.

2.2.9 Text

����� Style (Font)
Specifies the type of character (Normal, Bold, Raised) used in each Label.

2.2.9 Text

����� Text Color
Specifies Label colors.
The default settings are Fg: White, and Bg: Transparent mode (Black + Blk).

Note:

Right-justifiedLeft-justified Centered
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����� ID Numbers
When creating a Part, an ID number is automatically assigned to the Part
before it is placed on the screen. This number shows how many of that kind
of Part were previously placed on the current screen. When a Part is deleted
from a screen, all following Part numbers will be adjusted downwards.

Example of an ID number

Indicates that this Part is a Bit
Switch
(Varies according to the Part)

BS _ 010

Indicates the placement/
creation order of the Part; in
this case, it is the 10th.

The ID number is displayed in the title bar at the top of the Setting dialog
box.

The ID number can be entered so that it is displayed during Base screen
drawing.   2.10.2 Screen Property Settings

Even if the ID number is entered to be displayed during Base screen draw-
ing, it will not be displayed on the GP panel after screen data transfer.

  <ID Number List>

Note:

Part Name ID Number Part Name ID Number
Bit Switch BS-** Alarm Display AL-***
Word Switch WS-*** File Name Display FD-***
Function Switch FS-*** Data Logging Display LG-***
Toggle Switch TS-*** Data T ransfer Display DT-***
Lamp LA-*** CSV Display CS-***
4-state Lamp LF-*** File Manager Display FM-***
Bar Graph BA-*** Numeric Display ND-***

Pie Graph PI-***
Message Display
(Operation Mode: Bit)

MB-***

Half-Pie Graph HP-***
Message Display
(Operation Mode: Word)

MW-***

Tank Graph SG-*** Date Display DD-***
Meter MT-*** T ime Display TD-***

Trend Graph TR-***
Picture Display
(Motion mode: Bit)

LB-***

Keypad KE-***
Picture Display
(Motion mode: Word)

LW-***

Keypad Input Display KD-*** Window Parts WI-***
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����� Maximum Number of Automatically Created Part Libraries
When a Part is used in a project, a Part Library will be automatically created
in preparation for data transfer.  The number of Part Library items are
limited to 6000 per project.  If this number exceeds 6000, all Parts in excess
of 6000 cannot be transferred to the GP.  To avoid this, please remember the
following:

1. Automatic Library creation will be performed follows: (per screen)
Switches: 2 (only switches with the Monitor function selected)
Lamps: 2
Messages: 2 to 16 (depending on the number of states used)
Picture Displays : 2 to 16 (depending on the number of states used)
Trends: 1 to 20 (depending on the number of channels)

However,  Part Libraries  using the same Parts (i.e. Part’s that are the
same size, same attributes, and without labels or other items) will be used
commonly.

For example:
When 30 Switches (Monitor function is selected) and 20 Lamps are
placed on a single Base screen, (30 × 2) + (20 × 2) = 100 Part Library
items will be automatically created.  Therefore, 60 of these size
screens can be used in one project('s data).

2. When using the same Parts for multiple Base screens, register the Part on
one Base screen and then place it other Base screens using the Load
Screen function.  Thus, when multiple Base screens use those Parts, only
one Part Library will be used, thereby reducing the Project File’s size.

����� Placing a Part in Position
After all of a Part’s attributes have been entered or selected, click on the
desired position on the screen to place the Part.

R E M A R K SPPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE

(1)After all of a Part’s attributes have been entered or
selected, click on the  button.
The Part’s outline will appear on the Base screen, next
to your cursor.
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Depending on the Part, when scaling up or down, a one dot error may occur
in the  frame width.

E.g.)

2.4.3  Scaling Up/
Down

After placing the Part, double-
clicking on it automatically brings
up its Attribute Setting dialog box.

2.4.14 Changing
Attributes

(3)Adjust the Part’s size, if desired.
Click on the Part to select it, and drag any one of the
handles to change the size of the Part.
To change the size of a  Part, move the cursor to a Part
“handle” and click, then drag the “handle” to re-size the
Part, and click again.

 (2)Click on the point where the Part’s top left corner is
to be placed.
The selected Part will then appear on the screen.

Note:

9 10

����� Touch Panel Grid
When placing Switch Parts and Keypad Input Display Parts (when the pop-
up keypad is used), be sure to place them so they align with the Touch
Panel’s 20 x 20 dot grids. (See figure below.)

These 20 x 20 dot grids are the smallest units available for placing items on
the Touch Panel. Be sure not to place 2 switches on a single grid, as pressing
the point could activate both switches.
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Here, the creation of a touch panel switch, used for turning a specified Bit
ON or OFF, is explained.

If the GP unit has not been connected to the device, Bit
Switches with the Monitor function selected will not be dis-
played on the GP unit after the Project File transferred.

����� Bit Switch  [General Settings] Attributes

2.1.1 Bit Switches

Enter comment
data here

Select the
switch’s function

When creating
a Bit Switch
with two states,
check this box
and enter the
alternate Bit
Switch Address
below

Enter the Bit
Switch Address

Calls up the Part
Shape Browser
where a different
Part Shape can
be selected

Image of the
currently se-
lected Part Shape

����� Operation Bit Address

Here, the Bit Address data controlled by the Switch is input.

����� Monitor Bit Address

Only after the Monitor check box is checked can the Monitor Bit Address
used to change the Switch’s display setting be entered.  The Switch’s state
(ON/OFF) display can be specified so that it will change according to
changes in this Bit Address.  Addresses input in the Bit Address area can
also be done here.

Appears only
when creating a
Bit Switch with
two states.
Toggles the
switch’s state
either ON or OFF,
allowing you to
set the attributes
of each state
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����� Function

The Bit Switch functions are as follows.

Bit Set: When the Bit Switch is pressed, the device’s designated
Bit Address is turned ON.  This state continues (i.e.
remains ON) even after the switch is released.

Bit Reset: When the Bit Switch is pressed, the device’s designated
Bit Address is turned OFF.  This state continues (i.e.
remains OFF) even after the switch is released.

Momentary: Only while the Bit Switch is pressed and held is the
specified device Bit Address turned ON.  Thus, when the
switch is released, the specified Bit Address is turned OFF.

Bit Invert: Every time the Bit Switch is pressed, the device’s desig-
nated Bit Address state is changed (from ON to OFF, or
from OFF to ON).

After entering the Bit Address, if you attempt to perform another area’s
operation before entering the Monitor Bit’s address data, the dialog box
shown below will appear.  Clicking on the  button automatically
inputs the Bit Address’s data into the Monitor Bit Address.  To enter a
different address, click on the  button and input the desired ad-
dress.

����� Bit Switch [Shape/Color] Attributes
Here, the Switch’s border color (Frame), ON/OFF state colors (On Color,
Off Color), and pattern can be selected.

  2.1 Parts ����� Selecting Colors
The color and pattern settings available will differ depending on the switch’s
settings.

����� Bit Switch [Label] Attributes
Here, the text of the Label to be displayed on the Switch button is entered.

  2.1 Parts  ����� Creating Labels
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����� Bit Switch [Extend] Attributes
Set up the Interlock and Buzzer functions.

The “Bit Off” feature is available only with the GP-377, GP77R and GP2000
series.

����� Interlock

Only when a bit designated via Interlock Address is in a state that has been
selected via [Touch available condition], the switch becomes effective.
Whether the switch is effective in ON state or in OFF state is selectable
here.

����� Buzzer

Select ON or OFF for the buzzer sound.

When buzzer setting is enabled, the buzzer sounds while the touch switch is
being pressed.

����� One-Shot

Enable/disable the "One-Shot" feature.

This setting can be enabled only when "Momentary" mode is selected in the
"Function" area in the "General Settings" tab. When the "One-Shot" feature
is enabled, the buzzer will sound briefly only at the moment the touch
switch is pressed.

  Tag Reference Manual, 2.23.4 One-Shot Buzzer for T-tag
momentary

The "One-Shot" feature is available only with the GP-377, GP77R and
GP2000 series.

Can be set at the
momentary

Selects the Inter-
lock function

Touch Available
 Condition

Interlock Address
Status

Touch Available/
Not Available

ON Touch Available
OFF Touch Not Available
ON Touch Not Available

OFF Touch Available

Bit ON

Bit OFF
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Enter M0016

Select the Bit
Invert function

When the switch’s
state can change,
click here

2.1 Parts � Select-
ing a Part Shape

When the Change State function se-
lected, after entering the Bit Ad-
dress, if you attempt to perform
another area’s operation before en-
tering the Monitor Bit Address, the
dialog box shown below will ap-
pear. Click on the  button
to input the same address as used
for the Bit Address.  To enter a dif-
ferent address,  click on the

 button and input the de-
sired address.

(3)Select a Part Shape from the Browser.
Specify settings for Shape/Color, Label and Extension
Settings if necessary.

(2)In the [General Settings] screen, input the Bit Ad-
dress and select the Bit’s Function.

(1)Select the [Parts] menu - [Bit Switch] command, or
click on the  icon.

����� Placing a Bit Switch
An example of how to place a Reverse Switch is shown below.

First press of the Switch
sets M0016

The next press resets M0016

(4)After all of a Part’s attributes have been entered or
selected, click on the  button.

The Switch’s outline will appear on the Base screen, next
to your cursor.

Image Parts can be used with the
GP2000 series.
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To cancel the placement, click on
the   icon.

To  change  the
Part’s size, refer to 2.4.3 Scaling
Up/Down.

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s Attribute Setting dialog
box.

2.4.14 Changing
Attributes

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(5)Click on the point where the Switch’s top left corner
is to be placed.

If desired, use the Switch’s handles to alter its size.
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2.1.2 Word Switches

Enter comment
data here Enter the Word

Address you
wish to use

Enter the data
for the Switch
to send to the
Word Address

Select the
Switch’s func-
tion

Calls up the Part
Shape Browser
where a different
Part Shape can
be selected

Image of the
currently se-
lected Word
Switch

����� Word Address

Here, the desired Word Address is entered.

����� Constant

Here, number registered to the Word Address is input.  The data format is
Decimal (Base 10), and the input range is from -32768 to 32767.

����� Function

The Word Switch’s functions are as follows:

Word Set: When the Word Switch is pressed, constant data is written
to the device’s designated Word Address.  Fixed or default
values will be written to the timer, counter, etc.

Add/Sub: Every time the Word Switch is pressed, the Data value is
added to the data currently in the device’s designated Word
Address, and the result is then written to the Device’s
address.  If a Data value is positive, the function will
increment, and if it is negative, it will decrement.

Digit (ADD): Every time the Word Switch is pressed, the designated
decimal place’s data will be added by the Constant’s value.
The result will not be carried up to the next digit, so “9”
simply rolls around to “0”.  Select the data format from Bin
and BCD.

Digit (SUB): Every time the Word Switch is pressed, the designated
decimal place’s data will be subtracted by the Constant’s
value.  The result will not be carried down to the lower
digit, so “9” simply rolls around “0”.  Select the data
format from Bin and BCD.

Here, a touch panel switch for setting data to a specified Word Address can
be created.

����� Word Switch [General Settings] Attributes
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����� Word Switch [Shape/Color] Attributes
Here, a Word Switch’s color, and pattern can be selected.

  2.1 Parts ����� Selecting Colors
The color and pattern settings available will differ depending on the
Switch’s settings, such as its shape and Change State condition.

����� Word Switch [Label] Attributes
Here, the text characters shown (engraved) on the Switch button face are
input.

  2.1 Parts ����� Creating Labels

�����Word Switch [Extend] Attributes
Here, the interlock and the buzzer can be set as shown below.

����� Interlock

Only when a bit designated via Interlock Address is in a state that has been
selected via [Touch available condition], the switch becomes effective.
Whether the switch is effective in ON state or in OFF sate is selectable here.

Touch Available  
Condition 

Interlock Address  
Status 

Touch Available/ 
Not Available 

ON Touch Available Bit ON OFF Touch Not Available 
ON Touch Not Available Bit OFF OFF Touch Available 

The “Bit Off” feature is available only with the GP-377, GP77R and GP2000
series.

����� Buzzer

Sets the buzzer to ON/OFF

Select the Interlock
function state
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(1)Select the [Parts] menu - [Word Switch] command,
or click on the  icon.

����� Placing a Word Switch
An example of how to place a Data Set Switch is shown below.

(2)In the [General Settings] area, input the Word Ad-
dress and Constant data, and select a function.

Enter D0001

Select Word Set

Enter 34

2.1 Parts � Select-
ing a Part Shape

(3)Select a Part Shape from the Browser.
Specify settings for Shape/Color, Label and Extension
Settings if necessary.

(4)After all of the Part’s attributes have been entered
or selected, click on the  button.

The Switch’s outline will appear on the Base screen, next
to your cursor.

Image Parts can be used with the
GP2000 series.

When the button is pressed, 34 is sent to D00001.
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(5)Click on the point where the Switch’s top left corner
is to be placed.

If desired, use the Switch’s handles to alter its size.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

To cancel the placement, click on
the  icon.

To  change  the
Part’s size, refer to 2.4.3 Scaling
Up/Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes
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2.1.3 Function Switches

Enter comment
data here Select the

Switch’s
operation

When “Go
To Screen”
is selected,
the (Go To)
screen’s
number and
data format
must be
entered

Calls up the
Part Shape
Browser where
a different Part
Shape can be
selected

Image of the
currently
selected
Function Switch

Here, a touch panel with special functions can be created.

����� Function Switch [General Settings] Attributes

����� Function (Switch Operation)

The Function Switch’s attributes are as follows:

Previous Screen: When the Switch is pressed, the currently
displayed screen on the GP will change to
the previously displayed one.

Go To Screen: When the Switch is pressed, the currently
displayed screen on the GP will change to
the specified screen.  Input the screen
number to be changed (jumped) to.  The
Data Format can be either Bin or BCD.
The display screen’s data type (BIN or
BCD) is shown. The data type can be
changed via the [GP Setup], [GP Settings]
screen’s [Screen Number Data Type].

If a screen number is specified in the BCD data format to place the corre-
sponding screen, it is still displayed in the BIN data format when the screen is
closed and then opened.

Reset GP: When the Switch is pressed, the GP will be
reset to the save status as when the GP’s
power was turned ON.

Shows the
display
screen’s
data type.

Note:

Resetting the GP/LT turns the I/O signal off. Be sure to consider
this when designing your system.
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File Name Key: This is a function switch corresponding to
the File Name Display and is the same as
the one that is automatically placed together
with the File Name Display.
Designate the same ID number as the one of
the File Name Display and select a opera-
tion mode.

2.1.16 File Name Display

Data Logging Key: This is a function switch corresponding to
the Data Logging Display and is the same
as the one that is automatically placed
together with the Data Logging Display.
Designate the scroll direction and the
number of lines being rolled up or down.

   2.1.17 Data Logging Display

CSV Display Key: This function switch corresponds to the
CSV Display and is the same as the one
automatically placed together with the CSV
Display. This switch can be used only with
GP2000 Series units. Designate the scroll
direction, number of lines to be scrolled up
or down, and the print area.

2.1.19 CSV Display

File Manager Display Key: This function switch corresponds to the File
Manager Display and is the same as the one
automatically placed together with the File
Manager Display. This switch can be used
only with GP2000 Series units. Designate
the switch on which the File manager
Display is to be displayed.

2.1.20 File Manager Dis-
play
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Data Transfer Key: This function switch corresponds to the
Data Transfer Display and is the same as
the one automatically placed together with
the Data Transfer Display. This switch can
be used only with GP2000 Series units.
Designate the direction of the transmission,
scroll direction, number of lines to be
scrolled up or down, and the touch key on
which the Data Transfer Display is to be
displayed.

2.1.18 Data Transfer
Display

OFFLINE: When this switch is pressed, the GP enters
the OFFLINE mode.

Trend Key: This function switch corresponds to the
Data Record Display of the Trend Graph
and is the same as the one that is automati-
cally placed together with the Trend Graph.
This switch can be used only with GP2000
Series units. Designate the touch key used
to execute the ON/OFF status of the Data
Record Display mode, scroll direction of
the displayed data, and number of lines
being rolled up or down.

2.1.12 Trend Graphs

Q-tag Selection Key:

This function switch corresponds to the
Alarm Summary Display of Q-tag and is the
same as the Q-tag Selection key set up
using T-tag. Used as the Alarm Operation
Key in the Q-tag display area.

Tag Reference Manual 2.23
Touch Panel Input <T-tag>

 Function Switch [Shape/Color] Attributes
The Switch’s color, and pattern are selected here.

2.1 Parts  Selecting Colors

The color and pattern settings available will differ depending on the switch
shape.
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Touch Available
Condition

Interlock Address
Status

Touch Available/
Not Available

ON Touch Available
OFF Touch Not Available
ON Touch Not Available
OFF Touch Available

Bit ON

Bit OFF

The “Bit Off” is available only with the GP-377, GP77R and GP2000 series.

����� Interlock

Only when a bit designated via Interlock Address is in a state that has been
selected via [Touch available condition], the switch becomes effective.
Whether the switch is effective in ON state or in OFF sate is selectable here.

����� Buzzer

Sets the buzzer to ON/OFF.

Select the Inter-
lock function
state

����� Function Switch [Label] Attributes
Here, the characters shown (drawn) on the Switch button face are entered.

2.1 Parts ����� Creating Labels

����� Function Switch [Extend] Attributes
Here, the interlock and the buzzer are set.
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Select Go
To Screen

Enter 10

2.1 Part � Select-
ing a Part Shape

(3)Select a Part Shape from the Browser.
Specify settings for Shape/Color, Label and Extension
Settings if necessary.

(1)Select the [Parts] menu - [Function Switch] command,
or click on the  icon.

(2)Designate the [Function] on the [General Settings]
tab.

����� Placing a Function Switch
The Screen Switching (Function) Switch’s placement procedure is shown
below.

Pressing this button, shifts to screen B10.

Image Parts can be used with the
GP2000 series.
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To cancel the placement, click on
the  icon.

To  change  the
Part’s size, refer to 2.4.3 Scaling
Up/Down

Double-clicking on any Part placed
on the screen calls up that Part’s At-
tribute Setting dialog box.

2.4.14 Changing
Attributes

(4)After all of Part’s attributes have been entered or
selected, click on the  button.

The Switch’s outline will appear in the Base screen, next
to the cursor.

(5)Click on the point where the Switch’s top left corner
is to be placed.

If necessary, use the Switch’s handles to alter its size.
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2.1.4 Toggle Switches

Enter comment
data here

Enter the
desired Monitor
Bit Address
here

Calls up the Part
Shape Browser
where a different
Part Shape can be
selected

Displays the
currently se-
lected Part

Changes the
state of the
dialog box’s
switch display to
either ON or OFF

����� Operation Bit Address

The number of the Bit Address to be operated via the Switch is entered here.

����� Monitor Bit Address

Here, the Monitor Bit Address used to change the Switch’s display is en-
tered.  The Switch’s ON/OFF state can made to change according to changes
in the Monitor Bit Address data.  The same address as the Bit Address’s can
be used here.
After entering the Bit Address, if you attempt to perform another area’s
operation before entering the Monitor Bit Address’s data, the dialog box
shown below will appear.  Clicking on the  button automatically
enters the Bit Address data.  To input an address different from the Bit
Address, click on the  button and input the desired Monitor Bit
Address.

Here a toggle type touch panel switch, used to turn a specified Bit ON or
OFF is created.
A Toggle Switch will not be displayed on the GP when transferred, if the GP
has not yet been connected to the device.

����� Toggle Switch [General Settings] Attributes

Note:

Enter the Bit
Address to be
operated via
the Switch
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����� Toggle Switch [Shape/Color] Attributes
The Switch’s frame colors (Frame) for the ON and OFF states can be selected.

2.1 Parts ����� Setting Colors
The color and pattern settings available will differ depending on each
switch’s settings, such as its shape and state change conditions.

����� Toggle Switch [Label] Attributes
Here, the text characters shown (Raised) on the Switch button face are
entered.

2.1 Parts ����� Setting Labels

Select the Interlock function state

����� Toggle Switch [Extend] Attributes
Here, the interlock and the buzzer are set.

Touch Available
Condition

Interlock Address
Status

Touch Available/
Not Available

ON Touch Available
OFF Touch Not Available
ON Touch Available
OFF Touch Not Available

Bit ON

Bit OFF

����� Interlock Address

Only when a bit designated via Interlock Address is in a state that has been
selected via [Touch available condition], the switch becomes effective.
Whether the switch is effective in ON state or in OFF sate is selectable here.

This “Bit Off” feature is available only with the GP-377, GP77R and GP2000
series.

����� Buzzer

Sets the buzzer to ON/OFF.



2.1 PartsChapter 2 - Base Screens

2-41GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

Enter M0016

2.1 Parts � Select-
ing a Part Shape

(3)Select a Part Shape from the Browser.
Specify settings for Shape/Color, Label and Extension
Settings if necessary.

(2)In the [General Settings] area, input the Operation
Bit Address.

Clicking on the  button
automatically inputs the Operation
Bit Address into the Monitor Bit
Address area.  To input an address
different from the Bit Address,
click on the   button.

After entering the Operation Bit
Address, if you attempt to perform
another area’s operation before en-
tering the Monitor Bit Address
data, the dialog box shown below
will appear.

(4)After all of a Part’s attributes have been entered or
selected, click on the  button.

The Switch’s outline will appear in the Base screen, next
to your cursor.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Select the [Parts] menu - [Toggle Switch] command,
or click on the   icon.

����� Placing a Toggle Switch
The Toggle Switch placement procedure is shown below.
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To cancel the placement, click on
the  icon.

To change a Part’s
size, refer to 2.4.3 Scaling Up/
Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(5) Click on the point where the Switch’s top left corner
  is to be placed.

If desired, use the Switch’s handles to alter its size.
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2.1.5 Lamps

Enter comment
data here Enter the

desired Bit
Address here

Changes the
state of the
dialog box’s
switch display
to either ON or
OFF

Calls up the Part
Shape Browser.
Part Shapes can
be selected
directly from here

Displays the cur-
rently selected Part

����� Bit Address

The Bit Address to be monitored is entered here.

����� Lamp [Shape/Color] Attributes
Here, border colors for both ON and OFF states, and Lamp’s colors and
tiling pattern in each state can be selected.

2.1 Parts ����� Selecting Colors
The color and pattern settings available will differ depending on each lamp
shape.

����� Lamp [Label] Attributes
Here, the text characters shown on a Lamp button’s face are entered.

2.1 Parts ����� Creating Labels

Here a lamp is created, which turns ON or OFF according to the device’s
Monitor Bit Address state.

· Lamps will not display on the GP unless the GP has been
connected to the device.

· When placing a Lamp, DO NOT overlap it with other objects. If
you do so, it may not be displayed correctly.

����� Lamp [General Setting] Attributes
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Enter X0017 here

With the Blink check box checked
, and if the Bit is turned ON, the

Lamp will blink.  Lamp blinking
can also be seen via the pull down
menu [View]’s [Preview] com-
mand.

 2.10.3 Preview
Screen

2.1 Parts � Select-
ing a Part Shape

(3)Select a Part Shape from the Browser.
Select Colors and input a Label, if desired.

(1)Select the [Parts] menu - [Lamp] command, or click
on the  icon.

(2)In the [General Settings] area, enter a Bit Address.

����� Placing a Lamp
The procedures for creating and placing a Lamp are shown below.

When X0017
is ON...

the Lamp
lights up.

When X0017
is OFF...

the Lamp
turns off.

(4)Switch the state of the lamp with the On/Off but-
tons, and then select Colors and input a Label.

(5)After all of the Lamp’s attributes have been entered
or selected, click on the  button.

The Lamp’s outline will appear in the Base screen, next
to your cursor.

Image Parts can be used with the
GP2000 series.
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To cancel the placement, click on
the  icon.

To change the Part’s
size, refer to 2.4.3 Scaling Up/
Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

 2.4.14 Changing
Attributes

(6)Click on the point where the Lamp’s top left corner
is to be placed.

If necessary, use the Lamp’s handles to alter its size.
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2.1.6 4-State Lamp

Here, a 4-State Lamp, which changes its state according to whether the
device’s two Monitor Bits are ON or OFF, are created.

· Even when a 4-State Lamp data is transferred to the GP, if the
GP and device have not communicated, the 4-State Lamp will
not be displayed on the GP.

· When placing a 4-State Lamp, DO NOT overlap it with other
objects. If you do so, it may not be displayed correctly.

����� Features of 4-State Lamp

Enter a
desired Bit
Address to
be moni-
tored.

Enter comment
data here, if
necessary.

Changes the
state of the Lamp
currently dis-
played on the
dialog box to
either ON or OFF.

Displays the
currently selected
Part’s image.

Calls up the Part
Shape Browser. A
Part Shape can be
selected directly
from here.

����� Lamp Address

Enter the two Bit Addresses (Lamp Addresses 1 and 2) to be monitored.

����� Lamp Address 

Changes the Lamp state by changing the combination of the two Bit’s ON/
OFF state.

When the two Bits that have been assigned to the Lamp Addresses are
changed simultaneously, the Lamp state change is recognized as follows
according to the Bit read timing, which makes the Lamp display flicker.

e.g.) When Lamp Addresses 1 and 2 are changed from OFF to ON
simultaneously:

Note:

Lamp Address 1 0 → 0 → 1
Lamp Address 2 0 → 1 → 1

Or
Lamp Address 1 0 → 1 → 1
Lamp Address 2 0 → 0 → 1
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����� Features of 4-State Lamp [Shape/Color]
Here, a 4-State Lamp’s border colors for both ON and OFF states and
Lamp’s colors and tiling pattern in each state can be selected.

2.1 Parts ����� Selecting Colors
The color and pattern settings available (effective) will differ depending on
each Lamp shape.

����� Features of 4-State Lamp [Label]
Here, the text characters shown on a Lamp button’s face are entered.

2.1 Parts ����� Creating Labels

����� Positioning a Lamp
The procedure for creating and placing a 4-State Lamp are shown below.

The Lamp state will be switched according to the Lamp Addresses X0017’s
and X0018’s ON/OFF states.

When X0017 is
OFF and
X0018 is OFF

When X0017 is
ON and X0018
is OFF

When X0017 is
ON and X0018
is ON

When X0017 is
OFF and
X0018 is ON

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Select the [Parts] menu - [4-State Lamp] command,
or click on the  icon.

(2)Enter Lamp Addresses 1 and 2 in the [General Set-
tings] tab.

Enter “X0017”.

Enter “X0018”.
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(3) Select a Part Shape from the Browser.

Select Colors and set up a Label, if desired.

(4) User either  or  button to change the Lamp
Address states and select Colors and Pattern for each
state.

Set up a Label for each state, if desired.

(5) After all of a Part’s attributes have been entered or
selected, click on the  button.

The 4-State Lamp’s outline will appear on the Base
screen, next to your cursor.

(6) Click on the point where the 4-State Lamp’s top cor-
ner is to be placed.

Use the 4-State Lamp’s handles to alter its size, if nec-
essary.

    2.1 Parts � Select-
ing a Part Shape

To cancel the placement, click on
the  icon.

To change the
Part’s size, refer to 2.4.3 Scaling
Up/Down.
Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes
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Here the setup (creation and placement) of a bar graph is explained.  Bar
Graphs are used to display device Word Address numeric data in absolute or
relative values.  This graph’s display will change according to Word Address
data changes.

����� Bar Graph [General Settings] Attributes
<When displaying Word Address numeric data in absolute values>

2.1.7 Bar Graphs

Enter the
desired Word
Address to
store graph
data here

Select the
display data’s
data format

����� Absolute

Data stored in the Word Address is displayed in absolute values from 0 to
100 (with Display Mode +/- selected, -100 to 100).

����� Word Address

Here, enter the Word Address used for storing the Bar Graph’s data.

����� Data Format

The display data’s format can be either Bin or BCD.
When Bin is selected, negative numeric data can also be displayed.  In that
case, check  the Display Mode +/- check box.

Calls up the
Part Shape
Browser.  Part
Shapes can be
selected di-
rectly from here

Select absolute or relative
value display

Displays the
currently se-
lected Part

Enter comment
data here
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Enter comment
data here

Select the Relative value display
Used to store the
graph’s data.
Enter the desired
Word Address

Select the
display data’s
format

Select the data’s
Input Code

Specifies data
Input Range

Specifies data’s Bit
Length

Displays the
currently se-
lected Part

����� Relative

The data stored in the Word Address are converted to a value between 0 and
100 according to the designated Input Range and displayed as relative
values.

����� Word Address

Here, enter the Word Address used for storing the Bar Graph’s data.

����� Display  Mode+/-

When this check box  is checked, negative numeric data can also be
displayed.

����� Bit Length

Specifies the Bit Length of data stored in the Word Address.

����� Input Range

Specifies the data’s Input Range.

����� Input Code

When No Code is selected, only positive data can be entered.  To enter
negative number data, select +/-2’s Complement or +/-MSB.

<When displaying  Word Address numeric data in relative values>

Calls up the Part
Shape Browser.
Part Shapes can be
selected directly
from here
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����� Direction

The graph’s display direction can be specified as either Up, Left, Down, or
Right.

If [Display Direction] is changed for a 3D part, its shade is rotated along with
that part. To let the shade displayed properly, click on the  button,
and select the part again from [Shape Browser].

����� Axis Divisions

For a graph which has graduations, the number of divisions are entered here.
If the number of the divisions is specified to 10, then 11 division lines are
used.  When graduations are not necessary, specify the number of the divi-
sions as 0.

Whether the graduations are necessary or not will differ depending on the
Part’s shape.

����� Bar Graph [Shape/Color] Attributes
The graph's border color, division color (Axis Color), display data color
(Graph Color), display data patterns, and background color are selected here.

2.1 Parts ����� Selecting Colors

����� Bar Graph [Alarm Settings] Attribute
If desired, an Alarm can be setup here by toggling the Alarm check box.

2.1 Parts ����� Setting Alarms

Select the
graph’s display
direction

Only when a
graph with
graduations
has been
selected will
this box
appear.
Enter the
number of
divisions
desired here

����� Bar Graph [Graph Settings] Attributes

Note:

Note:
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Enter D00102
here

Select BCD

Level pointer

 2.1 Parts �  Se-
lecting a Part Shape
If the Bar Graph’s Alarm value is
specified as Variable, a pointer
showing levels will be displayed.
This pointer’s position will move
according to the specified Alarm
value.

(3)Select a Part Shape that has graduations from the
Browser.
Here, you can enter Alarm settings and select Colors, if
desired.

(1)Select the [Parts] menu - [Bar Graph] command, or
click on the  icon.

(2)In the [General Settings] tab, input a Word Address
and select a Data Format.

����� Placing a Bar Graph
An example of the Bar Graph’s creation and placement procedures are
shown below.

When the value 34 is stored in D00102,
the graph will look like this:

Data stored in D00102 displays on the Bar
Graph

BG_3D002U
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Enter 10 here

Select Up

To cancel the placement, click on
the   icon.

To  change  the
Part’s size, refer to 2.4.3 Scaling
Up/Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes

The Bar Graph’s sizing handles are
located inside the graph.

The area to enter the number of the
divisions will appear only for a graph
type which has axis divisions.

(5)After all of the graph’s attributes have been entered
or selected, click on the  button.

The Bar Graph’s outline will appear on the Base screen,
next to your cursor.

(6)Click on the point where the Bar Graph’s top left
corner is to be placed.

If necessary, use the Bar Graph’s handles to adjust its
size.

(4)In the [Graph Settings] tab, select the graph’s dis-
play direction and input the number of Axis Divi-
sions.
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2.1.8 Pie Graphs

Enter comment
data here

Select Absolute or Relative
display

Enter the
Word
Address
used to
store graph
data

Select the
desired
Data Format

Calls up the Part
Shape Browser.
Parts can be
selected directly
from the Browser

The currently
selected Pie
Graph’s image
appears here

����� Absolute

Data stored in the designated Word Address is displayed in absolute values,
from 0 to 100 (with Display Mode +/- selected, -100 to 100).

����� Word Address

Here, the Word Address’ location data is entered to show where the desired
data is stored.

����� Data Format

Select either the Bin and BCD display formats.

����� Display Mode +/-

With this check box  checked and the Bin data format is selected, a
negative numeric data can also be displayed.

Pie Graphs create an area where a device’s Word Address data is displayed
as absolute values.  The graph’s display will change to reflect changes in the
designated Word Address data.

����� Pie Graph [General Settings] Attributes
<When displaying the data using absolute values>
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Enter comment
data here

Select Absolute or Relative
display

Enter the
Word Ad-
dress to
store graph
data
Select the
desired Data
Format

Specifies the
data Input
Code

Specifies the data
Input Range

Specifies the data’s
effective Bit Length

Calls up the Part
Shape Browser.
Parts can be
selected directly
from the
Browser

The currently
selected Pie
Graph’s image
appears here

����� Relative

The data stored in the Word Address are converted to a value between 0 and
100 according to the designated Input Range and displayed as relative
values.

����� Word Address

Here, enter the Word Address used to store Pie Graph data.

����� Display Mode +/-

When this check box  checked, negative numeric data can also be dis-
played.

����� Bit Length

Specifies the Bit Length of all data stored in the Word Address.

����� Input Range

Specifies the data’s Input Range.

����� Input Code

With No Code selected, only positive numeric data can be entered.  To enter
negative numeric data, select either +/-2’s Complement or +/-MSB.

<When displaying the data using relative values>
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����� Display

Here, the graph’s data display start point, either Clkws. From Top or Clkws.
From Bottom, can be selected.

If [Display Direction] is changed for a 3D part, its shade is rotated along with
that part. To let the shade displayed properly, click on the  button,
and select the part again from [Shape Browser].

����� Axis Divisions

The number of segments the Pie Graph will be divided into is entered here.
If the number of Axis Divisions is specified as 10, 10 division lines will be
displayed.  When no divisions are necessary, simply enter 0.

����� Pie Graph [Shape/Color] Attributes
A Pie Graph’s border color, division line color (Axis Color), data display
color (Graph Color - Fg and Bg), data display pattern and background color
are selected here.

 2.1 Parts ����� Selecting Colors

����� Pie Graph [Alarm Settings] Attributes
Clicking on the Alarm Display check box will call up the Alarm Settings.

 2.1 Parts ����� Alarm Settings

Select the Pie
Graph’s (data
display)
Direction

Enter the
graph’s
number of
divisions

����� Pie Graph [Graph Settings] Attributes

Note:
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Enter D00102
here

Select BCD

2.1  Parts �  Se-
lecting a Part Shape

(3)Select a Part Shape from the Browser.
You can also use the Alarm Settings area to choose an
Alarm and select Colors, if desired.

(1)Select the [Parts] menu - [Pie Graph] command, or
click on the  icon.

(2)In the [General Settings] area, input a Word Address
and select a Data Format.

����� Placing a Pie Graph
The procedure for placing a Pie Graph is shown below.

PieData stored in D0102 displays on the Pie
Graph

When the value 34 is stored in D0102,
the graph appears like this:
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Enter 10

Select Clkws.
From Top

To cancel the placement, click on
the    icon.

To  change  the
Part’s size, refer to 2.4.3 Scaling
Up/Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes

The area to enter the number of the
divisions will appear only for a graph
type which has axis divisions.

(5)After all of the Graph’s attributes have been entered
or selected, click on the  button.

A Pie Graph’s outline will appear on the Base screen,
next to the cursor.

(6)Click on the point where the Pie Graph’s top left cor-
ner is to be placed.

If desired, use the Pie Graph’s handles to alter its size.

(4)In the [Graph Settings] tab, select the display direc-
tion and input the number of Axis Divisions.
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This graph displays a Word Address’ numeric data (received from a device)
as absolute or relative values in a Half-Pie graph.  The graph’s display will
also change to reflect Word Address data changes.

����� Half Pie Graph [General Settings] Attributes
<When displaying the data in absolute values>

2.1.9 Half Pie Graphs

Enter comment
data here

Select Absolute or
Relative display

Enter the
Word Ad-
dress to
store graph
data

Select the
desired Data
Format

Calls up the Part
Shape Browser.
Parts can be
selected directly
from the Browser

The currently
selected Half Pie
Graph’s image
appears here

����� Absolute

Data stored in the designated Word Address is displayed as absolute values,
from 0 to 100 (with Display Mode +/- selected, -100 to 100).

����� Word Address

Enter the Word Address where the data will be stored.

����� Data Format

Select the display data format from Bin and BCD.

����� Display Mode +/-

When this check box  is checked and Bin data format is selected, nega-
tive numeric data can be displayed.
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Enter comment
data here

Select Absolute or
Relative display Enter the

Word Ad-
dress used to
store graph
data

Selects the
desired Data
Format

Specifies the
data’s Input
Code

Specifies the data’s
Input Range

Specifies the data’s
effective Bit Length

Calls up the Part
Shape Browser.
Parts can be
selected directly
from the Browser

The currently
selected Half Pie
Graph’s image
appears here

����� Relative

The data stored in the Word Address are converted to a value between 0 and
100 according to the designated Input Range and displayed as relative
values.

����� Word Address

Here, enter the Word Address used to store Half Pie Graph data.

����� Display Mode +/-

When this check box  checked, negative number data can be displayed.

����� Bit Length

Specifies the Bit Length of all data stored in the Word Address.

����� Input Range

Specifies the data’s Input Range.

����� Input Code

With No Code selected, only positive numeric data can be entered.  To enter
negative numeric data, select either +/-2’s Complement or +/-MSB.

<When displaying the data in relative values>
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����� Display Direction

Here, the Half Pie graph’s display direction is fixed to clockwise.

����� Axis Divisions

The data entered here determines how many pieces a Half Pie Graph is
divided into.  If the number of Axis Divisions is specified as 10, 11 division
lines are displayed.  When no divisions are necessary, specify the number of
divisions as 0.

����� Half Pie Graph [Shape/Color] Attributes
Here, a Half Pie graph’s border color, division color (Axis Color), display
data color (Graph Color - Fg & Bg), display data pattern and background
color are selected here.

  2.1 Parts ����� Selecting Colors

����� Half Pie Graph [Alarm Settings] Attributes
If desired, Alarm settings can be set here.

  2.1 Parts ����� Alarm Settings

Select the Half
Pie Graph’s (data
display) Direc-
tion

Enter the
graph’s
number of
divisions

����� Half Pie Graph [Graph Settings] Attributes
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Enter D00102

Select BCD

 2.1 Parts �  Se-
lecting a Part Shape

(3)Select a Part Shape from the Browser.
You can also use the Alarm Settings area to enter Alarm
settings and select Colors, if desired.

(1)Select the [Parts] menu - [Half Pie Graph] command,
or click on the  icon.

(2)In the [General Settings] area, input the Word Ad-
dress and Data Format.

����� Placing a Half Pie Graph
The procedure for placing a Half Pie Graph is as shown below.

Semicircle Graph

When data 34 is stored in D0102, the
Half Pie graph will appear as follows:

Data stored in D0102 displays on the Semicircle Graph

HG_3D001
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To cancel the placement, click on
the  icon.

To  change  the
Part’s size, refer to 2.4.3 Scaling
Up/Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes

The area to enter the number of the
divisions will appear only for a
graph type which has axis divi-
sions.

(5)After all of a Part’s attributes have been entered or
selected, click on the  button.

The Half Pie graph’s outline will appear on the Base
screen, next to your cursor.

(6)Click on the point where the Half Pie Graph’s top
left corner is to be placed.

If desired, use the Half Pie graph’s handles to alter its
size.

(4)In the [Graph Settings] tab, input the number of axis
divisions.

Enter 10
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2.1.10  Tank Graphs

Enter comment
data here

Select Absolute or
Relative display

Enter the
Word Address
to store graph
data

Select the
desired Data
FormatCalls up the Part

Shape Browser.
Parts Shapes can
be selected
directly from the
Browser

The currently
selected Tank
Graph’s image
appears here

����� Absolute

Data stored in the designated Word Address is displayed as absolute values,
from 0 to 100 (with Display Mode +/- selected, -100 to 100).

����� Word Address

Enter the Word Address where the data will be stored.

����� Display Mode

Select the display data format from Bin and BCD.

����� Display Mode +/-

When this check box  is checked and Bin data format is selected, nega-
tive numeric data can be displayed.

This Part creates an area where a Word Address’ numeric data received from
the Host (device) is displayed as absolute or relative values in a special
“Tank” shaped graph.  The graph’s display will change to reflect changes in
Word Address data.

Regarding the following parts, if the value of 100 on the scale is displayed, the
graph area may not be filled completely depending on display magnification.
In this case, the graph can be displayed properly by enlarging or reducing the
part by one dot.

· Part file name: op4-3d01.pdb
GR_3D007, GR_3D008, GR_3D010, GR_3D015, GR_3D017

· Part file name: op4-p101.pdb
GR_PL007, GR_PL008, GR_PL010, GR_PL015, GR_PL017

����� Tank Graph [General Settings] Attributes
<When displaying data in absolute values>

Note:
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Enter comment
data here

Select Absolute or
Relative display Enter the Word

Address used
to store graph
data

Select the
desired Data
Format

Specifies the
data’s Input
Code

Specifies the data’s
Input Range

Specifies the data’s
effective Bit Length

Calls up the Part
Shape Browser;
Part Shapes can
be selected di-
rectly from here.

The currently
selected Tank
Graph’s image
appears here

����� Relative

The data stored in the Word Address are converted to a value between 0 and
100 according to the designated Input Range and displayed as relative
values.

����� Word Address

Here, enter the Word Address used to store Tank Graph data.

����� Display Mode +/-

When this check box  checked, negative number data can be displayed.

����� Bit Length

Specifies the Bit Length of all data stored in the Word Address.

����� Input Data Length

Specifies the data’s Input Range.

����� Input Code

With No Code selected, only positive numeric data can be entered.  To enter
negative numeric data, select either +/-2’s Complement or +/-MSB.

<When displaying data in relative values>
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����� Display Direction

Here, Up, Left, Down, or Right can be selected for the Tank graph’s display
direction.
The display direction varies depending on the part types.

If [Display Direction] is changed for a 3D part, its shade is rotated along with
that part. To let the shade displayed properly, click on the  button,
and select the part again from [Shape Browser].

����� Axis Divisions

Here, the Tank Graph’s divisions are entered if the graph is a division type.
When no divisions are necessary, specify the number of divisions as 0.
Whether a Tank graph has divisions or not will vary depending on the Part
Shape selected.

����� Tank Graph [Shape/Color] Attributes
Here, a Tank graph’s border color, division color (Axis Color), data display
color (Graph Color - Fg & Bg), as well as the data display pattern can all be
selected.

  2.1 Parts ����� Selecting Colors

����� Tank Graph [Alarm Settings] Attribute
If desired, Alarm Settings can be set here.

  2.1 Parts ����� Alarm Settings

Select the
Tank Graph’s
display
Direction

Only when a
graph type
which has axis
divisions is
selected, will
this appear.
Enter the
graph’s num-
ber of divi-
sions

����� Tank Graph [Graph Settings] Attributes

Note:
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Data stored in D0102 displays on the Tank Graph

When data 34 is stored in D0102, the Tank
Graph will appear as follows:

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

Enter D00102

Select BCD

 2.1 Parts �  Se-
lecting a Part Shape

(3)Select a Part Shape from the Browser.
You can also use the Alarm Settings area to enter Alarm
settings and select Colors, if desired.

(1)Select the [Parts] menu - [Tank Graph] command,
or click on the  icon.

(2)In the [General Settings] area, input the Word Ad-
dress and Data Format.

����� Placing a Tank Graph
The procedure for placing a Tank Graph is as shown below.
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Enter 10

Select Up

To cancel the placement, click on
the  icon.

To  change  the
Part’s size, refer to 2.4.3 Scaling
Up/Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s Attribute Settings dialog
box.

2.4.14 Changing
Attributes

The Axis Divisions area will appear
only for a graph type which has axis
divisions.

(5)After all of a Part’s attributes have been entered or
selected, click on the  button.

The Tank graph’s outline will appear on the Base screen,
next to your cursor.

(6)Click on the point where the Tank Graph’s top left
corner is to be placed.

If desired, use the handles to alter its size.

(4)In the [Graph Settings] tab, input the number of axis
divisions and graph data display derection.
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This Part creates an area where a device’s Word Address’ numeric data is
displayed as absolute or relative values on a Meter Graph (i.e. a needle
moves to show the value).  The graph’s display will change to reflect PLC
Word Address data changes.

����� Meter Graph [General Settings] Attributes
<When displaying data in absolute values>

Enter the
desired Word
Address data

Select the
desired Data
Format

����� Absolute

Data stored in the designated Word Address is displayed as absolute values,
from 0 to 100 (with Display Mode +/- selected, -100 to 100).

����� Word Address

Enter the Word Address where the data will be stored.

����� Data Format

Select the display data format from Bin and BCD.

����� Display Mode +/-

When this check box  is checked and Bin data format is selected, nega-
tive numeric data can be displayed.

Enter comment
data here

Select Absolute or
Relative display

Calls up the Part
Shape Browser;
Parts Shapes can
be selected
directly from the
Browser.

The currently
selected Meter
Graph’s image
appears here

2.1.11  Meter Graphs
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Enter comment
data here

Select Absolute or
Relative display

Enter the
Word Address
used to store
display data

Select the
desired Data
Format

Specifies the
data’s Input
Code

Specifies the
data’s Input
Range

Specifies the data’s
effective Bit Length

Calls up the Part
Shape Browser.
Parts Shapes
can be selected
directly from the
Browser

The currently
selected Meter’s
image appears
here

����� Relative

The data stored in the Word Address are converted to a value between 0 and
100 according to the designated Input Range and displayed as relative
values.

����� Word Address

Here, enter the Word Address used to store Meter Graph data.

����� Display Mode +/-

When this check box  checked, negative numeric data can also be dis-
played.

����� Bit Length

Specifies the Bit Length of all data stored in the Word Address.

����� Input Range

Specifies the data’s Input Range.

����� Input Code

With No Code selected, only positive numeric data can be entered.  To enter
negative numeric data, select either +/-2’s Complement or +/-MSB.

<When displaying data in relative values>
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Select the
Meter’s (data
display)
Direction

Only when a
graph type
which has
divisions is
selected, will
this selection
appear

����� Display Direction

Here, the Meter’s display direction, either Clockwise or Counterclockwise
can be selected.

����� Axis Divisions

Here, the  Meter increments are entered.  If the number of Divisions is
specified as 10, 11 division lines are displayed.  When no divisions are
necessary, simply enter “0”.

����� Meter Graph [Shape/Color] Attributes
Here, a Meter’s border color, division color (Axis Color), and needle color
(Meter Color) can be selected.

  2.1 Parts ����� Selecting Colors

����� Meter Graph [Alarm Settings] Attributes
If desired, an Alarm’s settings can be set here.

 2.1 Parts ����� Alarm Settings

����� Meter Graph [Graph Settings] Attributes
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Data stored in D0102 displays on the Meter Graph

When data 34 is stored in D0102, the
Meter will appear as follows:

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

Enter
D00102

Select Bin

2.1 Parts � Select-
ing a Part Shape

(3)Select a Part Shape from the Browser.
You can also use the Alarm Settings area to enter Alarm
settings and select Colors, if desired.

(1)Select the [Parts] menu - [Meter Graph] command,
or click on the  icon.

(2)In the [General Settings] area, input the Word Ad-
dress and Data Format.

����� Placing a Meter Graph
The procedure for placing a Meter Graph is as shown below.
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To cancel the placement, click on
the  icon.

To  change  the
Part’s size, refer to 2.4.3 Scaling
Up/Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

Enter 10

Select Clockwise

The Axis Divisions will appear for
a Meter Graph type which has axis
divisions.

(5)After all of a Part’s attributes have been entered or
selected, click on the  button.

The Meter Graph’s outline will appear on the Base
screen, next to your cursor.

(6)Click on the point where the Meter Graph’s top left
corner is to be placed.

If desired, use the Meter Graph’s handle to alter its size.

(4)In the [Graph Settings] area, input the number of
divisions and data display direction.
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2.1.12  Trend Graphs

Select a graph type

Enter the number
of X and Y divi-
sions

Select the data
display direction

����� Trend Graph [Graph Settings] Attributes

This Part displays Word Address numeric data as absolute values on a Trend
(line) graph.  The graph’s display will then change to reflect Word Address
data changes.

����� Trend Graph [General Settings] Attributes

Enter comment
data here

Select the
desired Data
Format

Calls up the Part
Shape Browser,
displaying a list of
pre-made Trend
Graph Shapes. Part
Shapes can be
selected directly from
the Browser.

The currently selected
Trend Graph Shape
appears here

����� Data Format

Here, the display data format is specified as either Bin or BCD.  With the
Display Mode +/- check box  checked, and Bin data format selected,
negative numeric data can also be displayed.

Displays the
previous data.

Saves the previ-
ous data of the
graph to the
backup SRAM.

When "Scale" is
checked, you can
specify the range
of data displayed
with the trend
graph (display
range).

Enter the No. of Samples, Scroll
value, and Sampling Time
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Using “Pen-Recorder”:
A specified Word Address’s data changes are displayed
over time in a Trend Graph.  The data’s display always
begins with “0”.  As each sampling period elapses, the
graph’s poly(gonal) line is shifted one division opposite
the specified display Direction.  The latest data is
always displayed at the very limit (in this example, the
right side) of the Trend Graph’s display area.

E.g.) Display Direction:  Right

E.g.) Display Direction:  Right, Scroll Count: 4
Enter screen scrolls
at this point

Begin Display

Begin Display

����� Graph Settings

Using “Normal”: The specified Word Address’s data changes are dis-
played over time in a Trend Graph.  Display data
always starts at the “0” point.  As each (time) sampling
period elapses, the latest data is added in the specified
display Direction.  When the graph’s poly (gonal) line
reaches the limit of the Trend Graph, the graph is
shifted in the display Direction for the number units
specified in “Scroll”.
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Status 1
displays
the graph.

Status 2
deletes
the graph.

Data
Change

Status 1
displays
the graph.

Status 3
clears old
graph and
displays
new one.

*1
*2

����� Block (Display Mode)
All the data in consecutive word addresses are sampled at the designated
time, then graphed as a single trend line. Data changes in multiple word
addresses can be monitored as a single block by the graph. Enter address
numbers to control the ON/OFF display of the graph.

*1  Control Status  (address for controlling display)
*2  Number of address data to display

For details of each graph type, refer to Tag Reference
Manual, 2.31 Trend Graph Display.

����� Data Samples

Data Samples: The number of data “units” to be displayed in a single
Trend Graph.  Up to 638 can be used.

Scroll: The number of data units to be scrolled when the
polygonal line reaches the limit of the Trend Graph’s
display area.

Sampling Time: The data read interval (from the device) is input in
seconds. The field is enabled when the graph type is
designated as "Normal" of "Pen-Recorder". This option
cannot be specified when the graph type is designated
as "Block".

����� Display Direction

Select the Trend Graph’s display direction, either Up, Left, Down, or Right.

If [Display Direction] is changed for a 3D part, its shade is rotated along
with that part. To let the shade displayed properly, click on the
button, and select the part again from [Shape Browser].

Note:
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����� Axis Scale

Enter the number of units that the X and Y axes are to be divided into.
When no divisions are necessary, input “0”.

����� Backup

Graph Backup: Trend graph data displayed for each trend graph screen
is backed up in the GP.  The graph types that can be
backed up are “Normal” and “Pen Recorder”.  When
backing up only trend graphs in 32K bytes of backup
SRAM, approximately 12 trend graphs of 639 pieces of
display data each can be saved.

This function is valid only for the GP models with back up SRAM.  GP
models with back up SRAM can be recognized by the label attached to the
GP’s rear face.  When the GP70 series unit’s label color is copper brown,
the unit has back up SRAM.  GP-377, GP-77R and GP2000 series units all
have backup SRAM.

Note:

SRAM Seal

����� Synchronous Mode
When the power is turned back ON by selecting the Synchronous Mode, you
can start drawing trend graph at the point where you stopped. If this mode is
not selected, the trend graph data starts from the beginning.

����� Previous Data Display
The previous data record of the trend graph can be displayed. This function
is supported only by GP2000 Series units and is available when the graph
type is designated as "Normal" of "Pen-Recorder". Enabling "Data Record
Display" automatically enables the "Backup" option. The previous data
record is saved in the GP's backup SRAM.

 Tag Reference Manual, 2.31 Trend Graph Display

Sampling Count
Designate the quantity of sampling data to be stored in each channel. Enter
the total value of the quantity of sampling data being displayed on the trend
graph (current) and the cumulative quantity of sampling data (previous).
Confirm that the Sampling Count is greater than the value of the Display
Data Amount. The display can be made to return further than the trend graph
data that are being displayed on the GP. Select "Bin" as the Display Format
and enter a value between 1 and 65,238.
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Automatically Placed Switches

These are function switches automatically placed on the right of the Trend
graph parts for display of Previous Data. When using these switches, be sure
to enable all switches. All switches are enabled with the initial settings.

When placing the switches

Trend Graph

Display switch

Previous switch

Forward switch

Display (Disp) Switches to the trend graph to the Data Record Display
mode.
Touching the  key switches to the Data Record
Display mode and displays the switch in inverse video.
When the switch is touched again, the inverse video is
reset, and the Data Record Display mode is canceled.

Previous (Prev) This switch is enabled only while the Data Record
Display mode is ON (when the  switch is displayed

in inverse video). (The  switch will not function

even if it is touched while the  switch is not shown
in inverse video.)
Touching the  switch displays the previous data by
scrolling (backward) the data by a predetermined
number of data items.
The number of data items to be scrolled can be desig-
nated between 1 and 65,238.
If the switch is touched while the last (oldest) data are
displayed, the buzzer sounds three times. The display
cannot be scrolled further.

Forward (Fwd) This switch is enabled only while the Data Record
Display mode is ON (while the  switch is displayed

in reverse video). (The  switch will not function

even if it is touched while the  switch is not shown
in reverse video.)
Touching the  switch displays the data by scrolling
the previous data up to the end point, which is the most
recent data at the moment the display mode is switched
to the Data Record Display. The number of data items
to be scrolled can be designated between 1 and 65238.
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When the switch is touched while the most recent data
(at the moment the display mode is switched to Data
Record Display) are displayed, the buzzer sounds three
times. The display cannot be scrolled further.

Browser Displays the browser. The Part shape can be selected on
the browser.  2.1 Parts �Selecting a
Part Shape

Border Color/Color/Pattern
Select the border color of the switch (Border color),
color of the switch (Color), and the pattern of the
switch (Pattern).  2.1 Parts �Selecting
Colors

����� Display range

When "Scale" is checked, you can specify the range of data displayed with
the trend graph (display range).

Enter the upper and lower limit values of the data using direct/indirect
addressing.

This function is effective only with the GP2000 Series when the graph type
is designated as "Block Display".

When "Scale" is checked, specify the type and line type of the assistant line
in the [Assist Line] tab.

 Tag Reference Manual 2.31 Trend Graph Display

Scale : Enables the settings for designating the display range of
the data in a "Block Display" type trend graph or for speci-
fying the details of the assistant line.

Upper/Lower : Designate the upper and lower limit values directly or
indirectly.

Direct : Designate the range directly. Values can range between 0
and 65535 or, when a negative value is used, between
-32768 and 32767.

Indirect : Designate the range with word addresses.

• Data exceeding the designated display range is not displayed.

• When the display range setting is changed, the updated trend graph is
displayed only after the graph display has been cleared or the screen has
been switched.

Note:
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Enters the
Word Address
used to store
the current
channel’s
display data

Selects the
color and
type of line
used for the
current
channel

Designates or
enters the
number of data
lines (channels)
to be displayed
on the Trend
Graph

Designates the
channel being
currently se-
lected

Can be
enabled when
"Block" is
selected.

Designates the
type and color
of dots when
"Block Display"
is selected.

����� Number of Channels

Enter the number of channels used in the Trend Graph.  Use the “Current
Channel” area to select which channel is being specified.  The maximum
number of channels that can be set up for the entire Project file (PRW file) is
40 with GP2000 series units and 20 with other models. (When Data Sam-
pling is designated, the quantity of data sampling is included.)

����� Word Address

Enter the Word Address used to indicate where the Trend graph’s data is
stored.

For details of the Word Address for block display when the
graph type is designated as "Block" in the [Graph Settings] area, refer to Tag
Reference Manual, 2.31.5 Block Display Mode (for Device Direct Access).

����� Offset

This function can be selected when "Block" is selected as the graph type on
the Graph Settings tab. The address in which graph data are stored can be
designated as Offset. The Offset setting becomes valid when the device
Word Address is used as the Word Address.  Tag Reference
Manual, 2.31.5 Block Display Mode (for Device Direct Access).

�����Line

Specify the type and color of the line in the trend graph.

�����Dot

Specify the type and color of the dots when the data is displayed in dots.
This function is available only with the GP2000 Series units.This option is
active only when the graph type is set to "Block Display". This option
cannot be used together with the "Fill Below Line" option of the trend
graph.

����� Trend Graph [Channel Setting] Attributes
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����� Trend Graph [Shape/Color] Attributes
The Trend Graph’s border color, division color (Axis Color), and Trend
Graph’s display area color (Graph Area Color) can be selected.

 2.1 Parts ����� Selecting Colors

����� Trend Graph [Alarm Settings] Attributes
If desired, an alarm’s settings can be set here.

 2.1 Parts ����� Alarm Settings

����� Trend Graph [Assist Line] Attributes
• Options for the assistant line can be set only when "Block Display" and

"Scale" are selected in the [Graph Settings] tab.

Designate
the assistant
line for the
X-axis.

Enable the
settings
for each
assistant
line.

Designate
the assistant
line for the
Y-axis.

Designate
the type and
color of each
assistant
line.

����� Draw Line

Click the desired assistant line button - ,  or  - and check
"Line". You can now specify the position (direct/indirect addressing), type
and color of the selected assistant line.

 Tag Reference Manual 2.31 Trend Graph Display

Note:
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 2.1 Parts � Select-
ing a Part Shape

(3)Select a Part Shape from the Browser.
You can also use the Alarm Settings area to enter Alarm
settings and select Colors, if desired.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

Select Bin

Data in the range of 0 to 100 can
be displayed on the Trend Graph.
When the data range is from -100
to 100, check the Display Mode
+/- check box.

(1)Select the [Parts] menu - [Trend Graph] command,
or click on the  icon.

(2)After clicking on the [General Settings] tab, select
the data format.

Data stored in D0102 is displayed on the Trend Graph

When 34 is stored in D0102
the graph will look like this:
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(4)In the [Graph Settings] area, select the Graph Type
and Direction, and enter the number of Data Samples
and Axis Divisions.

When "Block" is selected as the
graph type, the "Data Record Dis-
play" setting is disabled.

The "Display range" settings can be
designated when the graph type is set
to "Block Display".

Select Normal

Enter 20

Enter 19

Enter 10

Enter 10
Enter 10

Select Right

[When Data Record Display Setting is Disabled]

(5)In the Channel Setting area, enter the Number of
Channels, then enter each channel’s Word Address
and select the desired colors.
In this example, since the Number of the Channels is
“1”, you only need to enter one Word Address.

If the more than one channel is used,
be sure to enter the Word Address
and select the Color for each chan-
nel before placement.

For parts using two or more word
addresses and trend graph channels,
confirm that the word addresses will
not overlap; otherwise, an error may
occur in the GP.

Enter D00102
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(6)After all of Part’s attributes have been entered or
selected, click on the  button.

The Trend Graph’s outline will appear in the Base screen,
next to your cursor.

(7)Click on the point where the Trend Graph’s top left
corner is to be placed.

If desired, use the Trend Graph’s handles to alter its size,
after placement.

Up to 20 channels can be designated
for a Project file (including the Data
Sampling frequency number) is 40
with the GP2000 series units, and 20
with the other models.

Up to 8 Trend Graph display areas
can be placed on a single screen.
Data Record Display can be set up
to only one of those trend graphs.

To cancel the placement, click on the
 icon.

To change a Part’s size, refer to
2.4.3 Scaling Up/

Down
Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes

[When Data Record Display Setting is Enabled]

(5)Put a check mark in the Data Record Display
checkbox.
In this example, since the Number of the Channels is
“1”, you only need to enter one Word Address.

Checking the Historical checkbox
automatically calls up the Backup
settings.

For details on His-
torical Display and Backup func-
tions, refer to Tag Reference
Manual, 2.31 Trend Graph Display.

In the initial settings for the default
switches (automatically placed
switches), Historical Display, Previ-
ous and Forward are all enabled.
When using switches, place a check
mark in every checkbox.
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(7)After all of Part’s attributes have been entered or
selected, click on the  button.

The Trend Graph’s outline will appear in the Base screen,
next to your cursor.

(8)Click on the point where the Trend Graph’s top left
corner is to be placed.

If desired, use the Trend Graph’s handles to alter its size,
after placement.

If the more than one channel is used,
be sure to enter the Word Address
and select the Color for each chan-
nel before placement.

For parts using two or more word
addresses and trend graph channels,
confirm that the word addresses will
not overlap; otherwise, an error may
occur in the GP.

Up to 20 channels can be designated
for a Project file (including the Data
Sampling frequency number) is 40
with the GP2000 series units, and 20
with the other models.

Up to 8 Trend Graph display areas
can be placed on a single screen.
Data Record Display can be set up
to only one of those trend graphs.

To cancel the placement, click on the
 icon.

Enter
D00102

(6)In the Channel Setting area, enter the Number of
Channels, then enter each channel’s Word Address
and select the desired colors.
In this example, since the Number of the Channels is
“1”, you only need to enter one Word Address.

Only one trend graph part with the
Data Record Display setting can be
placed on each screen. Do not place
a function switch designated with the
"Trend Key" setting in the same
screen on which a function switch
has been automatically placed on the
screen.

The trend graph with the default
switches (automatically placed
switches) has been grouped. To
change its size or attributes, ungroup
it first by clicking on the  icon.

2 . 4 . 1 2  G r o u p /
Ungroup, 2.4.3 Scaling Up/Down,
2.4.14 Changing Attributes
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Here, pre-made keypads are used to enter data to a designated Word Ad-
dress.  In order to input data via the keypad, it is necessary to first create a
Keypad Input display.

 2.1.14 Keypad Display

����� Keypad [Description] Attributes

2.1.13  Keypads

Select the
Keypad’s data
format

����� Keypad Type

First, a Keypad type needs to be selected that will be suitable for the data
format specified.  To select a Keypad type, simply click on the Browser and
the selection of  available Keypads will be displayed.

����� Pad Color

The Keypad’s border color (Pad Color) can be selected here.

Displays the
currently selected
Keypad’s image

Calls up the Part
Shape Browser.
Parts can be
selected directly
from the Browser

Select the
Keypad’s
border color
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����� Keypad Key Functions
The various Keypad Key functions are shown in the table below.

 

K
ey

pa
d 

Sp
ec

s

Negative key
Only available for
Dec(imal) and +/-
format.

Decimal Point key
Valid when Decimal
Places have been
entered for Decimal
and BCD numbers.

Cancels the set
value.  When
using Keypad
Display's Pop-up
Keypad, the Pop-
up Keypad closes
without
registering the
input value.

Cancels the set value.
When using Keypad
Display's Pop-up
Keypad, the Pop-up
Keypad closes without
registering the input
value.

  

 

 

  

 Jump keys
Moves to the next Key Display without entering the
set value. You can use these keys to jump to the
area where you wish to enter data.

Dec. Only keys Dec. / Text Only keys

C
om

m
on

 K
ey

s

-
Numeric value keys (for Hex, the keys are 0 to F).
Inputs the corresponding value in the display.

 

 Enter key
Registers the set value and writes it to the Device
Storage Address.  Then, the cursor moves to the next
display and awaits next input.

 Cursor keys
Moves the cursor right and left within the display.

Delete key
Deletes the character above the cursor.

 Clear key
Clears the entire display. If the is pressed after
clearing, 0 is stored in the Device Word Address.

Decimal Hexadecimal
  



2.1 Parts Chapter 2 - Base Screens

2-88 GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

2.1 Parts � Select-
ing a Part Shape

(3)Select a Keypad Shape from the Browser.
If desired, select a color from the Shape/Color area.

  For how to create the display area for the keypad shown
here, refer to 2.1.14 Keypad Display.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

Select Decimal

(1)Select the [Parts] menu - [Keypad] command, or click
on the  icon.

(2)Select a Keypad Data Format Type.

����� Placing a Keypad
The procedure for creating and placing a keypad is shown below.

When the Trigger
Bit M0080 turns
ON, ...

KD_1 to 3
(Word Address D0050
to D0052) can receive...

Input data
from the
Keypad
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Note: • Regular Keypad parts have all been previously grouped.  Therefore, to
create a new keypad, simply un-group the Keypad and arrange the pieces as
you like.

 2.4.12 Group/Ungroup
• The pre-made Keypad Input Displays that support the User-assignable

input order feature are KP_3D005D, KP_3D006D, KP_PL004D,
KP_3D004H, KP_3D005H, and KP_PL003H.

 2.1.14 Keypad Display

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes

To cancel the placement, click on
the  icon.

(4)After all of the Keypad’s attributes have been en-
tered or selected, click on the  button.
The Keypad’s outline will then appear in the Base screen,
next to your cursor.

(5)Click on the point where the Keypad’s top left cor-
ner is to be placed.
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Enter comment
data here

2.1.14  Keypad Display

Enter the Word Address
used to store display data

When "Bit" is
selected for
the "Start
Input" option,
enter the
trigger bit for
making the
Keypad enter
the waiting
mode for key
input.
Use a key-
board for key
entry, and
enter the data.

Calls up the Part
Shape Browser.
Parts can be
selected directly
from the Browser

The currently
selected Part’s
image will appear
here

����� Keypad Display [General Settings] Attributes

The pop-up keypad is available only with GP-377, GP77R and
GP2000 Series units.

If [Exists] is
selected, touch-
ing the Keypad
will automati-
cally display a
data entry
keypad.

• A pop-up keypad is automatically set when the Keypad Input Display
[Popup] selection is set to [Exists]. Setting up an additional keypad is not
required.

• K-tag functions can be set up (except for the operation function). Also see
"2.12 K Tag (Key Input)" in the Tag Reference Manual.

• The Keypad Input Display cannot be set up simultaneously with the CSV
Display, Logging Display or N699-tag.

This section describes the procedure for creating an area for displaying the
data input from the keypad.

Touching the Keypad Input Display can automatically call up a pop-up
keypad. When not using the pop-up keypad, place an additional keypad
separately from the Keypad Input Display.

These items trigger the Keypad
Input Display to accept input.

When this is enabled/
selected, the input
cursor will move in the
designated order and
then wait in the next
field. If the same Group
number is entered, the
cursor will move as
designated in the
Group.  Available only
with GP2000 Series
units.

When this is
selected/enabled,
you can designate
the location
(coordinates)
where the Popup
Keypad will
appear.  Available
only with GP2000
Series units.

If [None] is
selected, touch-
ing the Keypad
Input Display
waits for input.
Use a numeric
input keypad
part. Available
only with
GP2000 Series
units.
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����� Word Address

The Word Address is used to store the keypad display’s data.

����� Start

[Bit]

When the designated Start Bit turns ON, the cursor moves to the designated
input area and waits for input.
For the setting example:  � Using a Keypad to Input Values
����� When using [Bit] method for data input
[Touch]

When the Keypad Input Display is touched, the input field's color will
reverse and wait for input. The Start Bit Address is disabled.

����� Popup [Exists]

When the Keypad Input Display is touched, the data entry Keypad will
appear.

If [Exists] is selected, after the Input Display is placed on the screen, the
popup keypad's position can be designated. If this feature is not selected
(disabled), touching the Keypad Input Display automatically displays the
popup keypad.
For a setting example:  � Using a Keypad to Input Values
����� Keypad Input Display’s [Touch] feature is Selected/Enabled ([Specify
Entering Order] is disabled)

• The popup keypad is available only on GP-377, GP77R and GP2000 Series
units.

• The popup keypad designation feature is only available if the Popup item
[Exists] is selected.

����� Popup [None]

When the Keypad Input Display is touched, the Keypad Input Display
automatically enters a "wait" condition for input. If a numeric data entry
keypad is placed on the screen, data entry is possible. For keypad creation
examples,  2.1.13 Keypads
For a setting example:  � Using a Keypad to Input Values
����� When using [Touch] method for data input (Popup Keypad is disabled)
([Specify Entering Order] is selected)

• The popup [None] feature is available only on GP2000 Series units.
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The decimal point
is not included in
the display digits.
Enter the No. of
Display Digits

Enter the No. of
Digits after the
decimal point

Character size can
be selected here

����� Keypad Display [Display Format] Attributes

Select the Data
Length and Data
Format here.

Select the data to be
displayed.

  Tag
Reference Manual,
2.12 K-tag (Key
Input)

When selected, the
address storing the
data to be dis-
played is specified
indirectly.

�����Absolute

Handles 16-bit or 32-bit data. Tag Reference Manual, 2.12
K-tag (Key Input)
Also designate the Data Format, Code, and Data Length of the data to be
displayed.

When "Dec" is selected, put a check mark in the "Code +/-" checkbox to
enable display of negative data values.

����� No. of Display Digits

Here, the number of digits displayed, to the right of the decimal point, is
input.

����� Decimal Places

Here, the number of digits to the right of the decimal point is input.

When using 32 bit data, the relationship between the top and bottom of the
Word Address will differ depending on the device used.

 Device (PLC Connection) Manual

����� Specify Entering Order

When this feature is selected/enabled, the input order of the cursor follows
the order selected here and waits in the designated place for data entry.
[Entering Order] can be from 1 to 255. If [Group No] is selected and a group
number is entered, the data entry cursor's movement order will follow that of
the other Keypad Input Displays registered to that group. Group No can be
any number from 1 to 10.

• The [Specify Entering Order] feature is available only on GP2000 Series
units.

• When only the data input order is designated, Group No "0" is recognized.
Any Input Displays set for "0" will operate normally on the GP.
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When the No. of Display Digits is set to 5 and the Decimal Places is set to 2, a
value appears on the Keypad Input Display as shown below.

Note:

The Keypad Display’s border color, data display color (Text), and interior
color (Plate) are selected here.

� Color Type

Direct Directly designates the color settings.

Indirect This option is enabled when the Data Format is set to "Absolute"
and the Alarm is set to "OFF". The Text color and Plate color
settings can be designated indirectly. Designate the color at-
tributes to the address displayed right under the "Text color" and
"Plate color". Note that this setting is not available with the
GP270.  Tag Reference Manual, 2.10.4 H-tag/
Object Drawing Data/Color attributes

� Keypad Input Display [Alarm Settings] Attributes
Set up alarms if necessary.

 Tag Reference Manual, 2.12 K-tag (Key Input)

Specify the color
directly or indirectly.

The browser is
displayed. The
Part shape can
be selected
here.

� Character Size

The label’s character size is selected here.

  2.2.9 Text

� Keypad Display [Color/Shape] Attributes
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� Input Style

• Auto Clear OFF

The previous input is not cleared and displayed in the input area. The new
input is appended to existing data. To clear the existing values, enter "CLR"
from the Touch Keypad.

• Auto Clear ON

The previous input is cleared when the first character (except the cursor
keys, ENT, DEL and BS keys) is entered.

• Auto Clear & Input Digit Monitor

When barcode input is performed in this mode, the Auto Clear function is
enabled and the input data are monitored so that it matches the No. Display
Digit. If the data length is inappropriate, it is not written into the word
address. When data is input from the Touch Keypad, only the Auto Clear
function is enabled.

• Barcode Input

Selecting this feature enables input from the Touch Keypad and barcode
readers.

� Display Style

• Shift Left
• Shift Right

Select the display style from the Shift Left and Shift Right. The data will
appear, starting from the side designated here. The Shift Right is selected by
default.

� Keypad Display [Extend] Attributes
Use this tab to designate the Input Style, Display Style, and Interlock func-
tion.

Specify the ON/
OFF status of the
Interlock function.
(This function can
be set up only
when the pop-up
keypad is used.)

Specify the
Display Style.

Supported by
the GP2000
Series only

This item designates the address used to store
the Input status when Keypad Input Display data
entry is completed.  Available only on GP2000
Series units.
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• Zero Suppress

Select this option to omit the leading zeros of display data. E.g. When the
Display Length is 4 and the Zero Suppress is NOT selected, 25 appears as
0025.

• Zero Display

When this option is clicked, and the Device data is 0, the value 0 will not
display.

• 7 Segment Display

When this option is selected, numerical values are shown on a 7-segment
display. Only the GP2000 Series supports the 7 Segment Display.

Touch Available
 Condition

Interlock Address
Status

Touch Available/
Not Available

ON Touch Available
OFF Touch Not Available
ON Touch Not Available

OFF Touch Available

Bit ON

Bit OFF

When a GP type other than the GP2000 Series is selected and the "7 Segment
Display" option is enabled, the following alarm appears.

To clear the alarm, disable the "7 Segment Display" option.

����� Interlock

Only when a bit designated via Interlock Address is in a state that has been
selected via [Touch available condition], the pop-up keypad becomes effec-
tive. Whether the touch is effective in ON state or in OFF state is selectable
here.

This function is available only with the GP-377, GP77R and GP2000 series.

• If the [Interlock] feature's [Touch available condition] is deselected (dis-
abled) while data is being input, data entry can still continue. However, the
interlock feature will not operate.

• If, during data input the Interlock feature all the Input displays are acti-
vated, the data entry cursor will disappear and data cannot be input.
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����� Placing a Keypad Display
The Keypad Display’s placement procedures are shown below.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Select the [Parts] menu - [Keypad Input Display]
command, or click on the  icon.

(2)Enter the following settings in the [General Settings]
tab.
Select to method used trigger the Keypad Input Dis-
play to accept input, i.e. either [Touch] or [Bit].
[If Touch is selected]
• When using a Popup Keypad:

Select the Popup area's [Exists].
If you wish to position the Popup Keypad in a spe-
cific location, select [Specify Arrangement Position].

When Start is set to [Touch], the
Trigger Bit Address will be grayed
out (disabled).

The [Specify Arrangement Position]
feature is only available on GP2000
Series units.

• When not using the Popup Keypad:
Select the Popup Area's [None].

To set the Keypad Input Display's data entry cursor
to move in the desired order, select [Specify Entering
Order], and select the [Entering Order] and enter a
value in the  [Group No].

����� Input Completion

This item designates the address used to store the Input status when Keypad
Input Display data entry is completed.

When input is completed, the bit turns ON. In this case Numeric Input
display input can continue, however be sure to use PLC-side control to turn
the bit(s) that has/have turned ON back to OFF.

This feature is available only on GP2000 Series units.

The [Specify Entering Order] fea-
ture is only available on GP2000
Series units. It is only available if
the Start area's [Touch] is selected.
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Enter 4
Do not enter anything
here (i.e. “0”)

(4)In the [Display & Write Data Format] area, specify
the Data Display Format, No. of Display Digits, and
Decimal Places (i.e. number of the digits after the
decimal point) to be used. If desired, select the Char-
acter Size.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

2.1 Parts � Select-
ing a Part Shape

(3)Select a Part Shape from the Browser.
If desired, select colors from the [Shape/Color] area and
input the extension settings.

Enter D00050

Enter M0080

[If Bit is selected]
Enter the Word Address and the Trigger Bit Address.
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To cancel the placement, click on
the  icon.

To  change  the
Part’s size, refer to 2.4.3 Scaling
Up/Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(7)Repeat from step (1) to create Keypad Displays with
Word Addresses “D00051” and “D00052”.
Except for the addresses, all settings should be the same.

(6)Click on the point where the Keypad Display’s top
left corner is to be placed.
If desired, use the Keypad Display’s handles to alter its
size.
Even though the set value display area is scaled up or
down, the character size will not change.  To change
the character size or position, directly select the charac-
ters inside the border.

(5)After all of the Keypad Display’s attributes have been
entered and selected, click on the  button.

The Keypad Display’s outline will appear on the Base
screen, next to your cursor.

When placing the Keypad Input
Display, do not rotate it. Doing so
will cause the Pop-up keypad to dis-
play in the incorrect orientation.

If a Keypad-type Input Display's [Specify Arrangement
Position] is selected, after you click on the Keypad In-
put Display icon and select [Place], a Popup Keypad
size border will appear. Simply click on the desired po-
sition on the screen and the keypad will be placed there.
Click again to display the keypad's handles.

If the  Ctrl  key is pressed when the
display area’s border is scaled up
or down, its interior characters are
also scaled.
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ID No.
KD _1

KD _2

KD _3

Device

For how to create
a Keypad, refer to 2.1.13 Keypads

For how to create
a Keypad Display, refer to 2.1.14
Keypad Display � Placing a Key-
pad Display

(3)First, the Keypad Display KD_1’s display reverses
(highlights) and waits for input.
The square box shown below represents the cursor’s po-
sition.

(2)Then, when the Device internal Trigger Bit M0080
turns ON,

(1)Here, three Direct Call-Ups have been set to share a
common start bit.

����� Using a Keypad to Input Values
The following explanation shows how to use the Keypad Input Display's
[Touch] and [Bit] selections.

�When using [Bit] method for data input

The procedures for entering setting values via a Keypad on the GP screen
are shown below.

When the Trigger
Bit M0080 turns
ON...

KD_1 to 3
(Word Address
D0050 to D0052)
can receive...

Input data
from the
Keypad
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KD_1

Word
address
D0050

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

Set value display areas having a
common Trigger Bit will enter a
wait state in order, from the lowest
ID number upwards.  After the first
value has been registered, the next
value’s display area will automati-
cally be ready to receive input.

(6)The registered value will then be stored in Word Ad-
dress D0050, which was designated in KD_1.  Next,
KD_2 will be highlighted and be ready to receive in-
put.

(5)Press the [ENT] key to register the value.

(4)Press the Keypad’s keys to input the desired value.

Keypad Input Display data entry
is completed.
(When designating a Bit Address)

After completing Keypad Display
data entry, be sure to use the De-
vice/PLC's control command to
change the Input Completed bit
from ON to OFF.

KD_1

KD_2

KD_3
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�When using [Touch] method for data input (Popup Keypad is disabled)

([Specify Entering Order] is selected)

The following explanation describes how to enter data via the Keypad.

When the [Touch] feature is selected and the Popup Keypad is disabled,
touching the on-screen Input Display will cause that input area to change to
reverse video. This indicates that cell/area of the keypad can accept input.

In the following example 6 Input displays are used, and all have [Specifying
Input Order] selected. The settings for these 6 displays are as follows.

Word Address Input Order Group No
KD_1 D00050 1
KD_2 D00051 2
KD_3 D00052 3
KD_4 D00053 1
KD_5 D00054 2
KD_6 D00055 3

 

1

2

The [Specify Entering Order] feature is available only on GP2000 Series
units.

Enter the desired
data from the key-
board (for specifying
entering order), and
confirm the entry by
pressing the [ENT]
key.

When the KD_1
Keypad Input
Display is
touched. . .

The KD_1 Keypad
Input Display accepts
waits for input.

Word
address
D0050

Next, in accordance
with the data input
order, the data entry
field KD_2 (Word
Address D00051) will
become active and
ready to accept input.

7  2  5  4

KD_2

KD_3

KD_1 KD_4

KD_5

KD_6

KD_2

KD_3

KD_1 KD_4

KD_5

KD_6

KD_1

7  2  5  4
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(1) The following 6 input areas (KD_1 to KD_6) have been
placed on the GP screen.

(2) When the KD_1 Keypad Input Display is touched. . .

ID Number

KD_1

(3) The  touched KD_1 Keypad Input Display waits for
input.
 The square box shown below represents the cursor’s
 position.

(4) Touch the appropriate key on the Keypad to enter
the value.

If while entering data you change
the Input Display's Interlock touch
status (Enabled to disabled, or vice-
versa), the Keypad will become ac-
tive. Continue to enter data normally
and touch the Enter key to register
the data, or touch  [Cancel] / [ESC]
to ignore the data. However, Key-
pad Input Displays have no built-in
input cancel feature to delete entered
data.

Be sure to select only Input Dis-
plays that use the [Specify Enter-
ing Order] feature.

For how to create a
Keypad Display, refer to 2.1.14
Keypad Display � Placing a Key-
pad Display

KD_1

KD_2

KD_3

KD_4

KD_5

KD_6

KD_1

KD_2

KD_3

KD_4

KD_5

KD_6

5  5  2
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(5) Press the ENT key to register the value.
The Keypad will then close.

(6) The data entered in display KD_1 is saved to Word
Address D00050. The cursor then moves to KD_2,
the display changes to reverse video and waits for
input.

Among multiple displays belong-
ing to the same Group, the display
with the lowest ID No will be the
first to accept input.

Since displays KD_1 to KD_3 are designated as
Group 1, after KD_3 input is finished, the cursor
will return to KD_1 and wait for input. If KD_4 is
touched, the cursor will jump to that display and
entry is possible. Once entry is finished, the cursor
will jump to the next display in Group 2.

5  5  2KD_1

KD_2

KD_3

When this is selected/enabled, you
can designate the location (coordi-
nates) where the Popup Keypad will
appear.  Available only with
GP2000 Series units.

In the following cases, the cursor
will not automatically jump to the
next display.

x Displays with Interlock enabled.

x Displays where [Specify Entering
Order] is disabled, or when Ver-
sion 6.3 or earlier GP-PRO/PBII
is being used.
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�Keypad Input Display's [Touch] feature is Selected/Enabled ([Specify En-
tering Order] is disabled)

The procedure for positioning the Keypad Input Display featuring the Pop-
up Keypad is shown below.

xxxxx The Pop-up Keypad feature is available only with the GP-377, GP77R, and
GP2000 series.

xxxxx The [Specify Entering Order] feature is available only on GP2000 Series
units.

When the KD_1
Keypad Input
Display is
touched. . .

The Pop-up Keypad
appears, and the
touched display waits
for input.

Input data
using the
Pop-up
Keypad.

KD_1KD_1 7 2 5 4

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1) The Keypad Input Display "KD_1" is displayed on
the GP screen.

(2) When the KD_1 Keypad Input Display is touched. . .

KD_1
ID Number

KD_1

(3) The Pop-up Keypad appears, and the touched
 display waits for input.
 The square box shown below represents the cursor’s
 position.

For how to create a
Keypad Display, refer to 2.1.14
Keypad Display � Placing a Key-
pad Display

When [Specify Arrangement Posi-
tion] is not selected/disabled, the
Popup Keypad will be automatically
placed on the screen.

When [Specify Arrangement Posi-
tion] is selected/enabled, the Popup
Keypad will appear in the designated
position.

Word
address
D0050

Note:
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   5  5  2

(4) Touch the appropriate key on the Pop-up Keypad to
enter the value.

In the following two cases, the pop-
up keypad will disappear with no
confirmation of the input during
data input:
xWhen the active Keypad Input
Display is touched
xxxxxWhen another Keypad Input
Display is touched during data
input (only when the [Use Pop-
up keypad] feature is enabled for
Keypad Input Display)

The Keypad Input Display that has
been touched becomes active and
is displayed in reverse video, call-
ing up the pop-up keypad for dis-
play on the screen.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(5) Press the ENT key to register the value.
The Pop-up Keypad will then close.

(6) The registered value will then be stored in Word Ad-
dress D0050, which was designated in KD_1.

When [Cancel] / [ESC] is touched,
the Pop-up Keypad closes without
registering the input value.

Keypad Input Display data entry
is completed.
(When designating a Bit Address)

After completing Keypad Display
data entry, be sure to use the De-
vice/PLC's control command to
change the Input Completed bit
from ON to OFF.

����� Notes for using Pop-up Keypad
• Do not specify [High Speed] from [Designated Window] of a U-tag when using

Pop-up Keypad with the Keypad Input Display.
• Do not rotate the Keypad Input Display when you position it. Otherwise, the

Pop-up Keypad will not appear in the proper orientation.

KD_1
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����� Restrictions for using Pop-up Keypad
• If the Keypad Input Display selected does not use the Pop-up Keypad feature or

if the trigger bit in the K-tag is set to ON, the Pop-up Keypad will not appear.
• If the Pop-up Keypad’s [Specify Arrangement Position] is not selected/dis-

abled, the Pop-up Keypad will appear to the right of the Keypad Input Display.
If there is insufficient space to the right of the Keypad Input Display to display
the Pop-up Keypad, the Keypad automatically appears in a position either
above, below, or to the left of the Keypad Input Display.

• If the Pop-up Keypad’s [Specify Arrangement Position] is not selected/dis-
abled, and there is insufficient space in each of these positions, the Keypad will
appear in the lower right corner of the screen. In this case, the Pop-up Keypad
and the Keypad Input Display may overlap so that you cannot see the input
value.

• The Pop-up Keypad is displayed as a local window. When two local windows
are already displayed on the screen, the Pop-up Keypad does not appear even if
the Keypad Input Display is touched. In this case, the Keypad Input Display
will not wait for input.
Also, if during numeric display data input two or more Local Windows are
opened, input will stop and the currently input value will be deleted.

• When the pop-up keypad and other windows overlap, touch the desired window
 to bring it to the front.

• The tag size of the Keypad Input Display that uses the Pop-up Keypad is
greater than those without the Pop-up Keypad by 60 bytes. (When the Pop-up
Keypad is used with the initial setting, the Keypad Input Display capacity is
276 bytes, and 216 bytes when the Pop-up Keypad is not used.)

• When the Touch Available Condition of the Interlock function is disabled, the
Pop-up Keypad is not displayed.

• When the Touch Available Condition is switched to OFF while input is being
made on the Keypad Input Display, the Pop-up Keypad continues to function.
Continue the input, and confirm the entry with the Enter key as usual, or press
the Cancel key to cancel the input. However, note that touching the Keypad
Input Display will not cancel the input.

• When the [Enter Specifying Order] feature is selected/enabled on an Input
Display that uses the Pop-up Keypad feature, the Pop-up Keypad will be
automatically selected, depending on the [Display/Write Data Format] feature’s
setting.  If you wish to modify or change this Pop-up Keypad,

 �Editing the Pop-up Keypad (next page)
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����� Editing the Pop-up Keypad
When the Start area’s [Touch] and the Popup area’s [Exists] features are selected,
the [General Settings] tab  of the [Keypad Input Display], a keypad is displayed
that is preset with the [Display Data Format] settings in [Display Format]. How-
ever, the keypad settings can be edited to your preference.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1) Select the [Screen] menu - [Popup Keypad Edit] com-
mand.

(2) Select the type of Pop-up Keypad to use: [Dec Land-
scape], [Dec (Entering Order) Landscape], [Dec Por-
trait], [Dec (Entering Order) Portrait], [Hex Land-
scape], [Hex (Entering Order) Landscape],  [Hex
Portrait], [Hex (Entering Order)Portrait], [Text
Landscape], [Text (Entering Order) Landscape],
[Text Portrait], [Text (Entering Order) Portrait].
The editing screen for the Pop-up Keypad appears.

When "GP***** Vertical Type" is
selected as the GP Type, a pop-up
keypad for the vertical type is dis-
played. When editing the pop-up
keypad, select a keypad designed
for the vertical type.

The Popup Keypad displayed via
the [Specify Entering Order] fea-
ture should only be used when the
Keypad Input Settings screen’s
[Specify Entering Order] feature
has been enabled.

The library browser automatically
opens. You can select a keypad
from the library.

The CPK file displayed here can-
not be edited.

You can also create a keypad as de-
sired.

  3.3 Creating a
Keypad: the Keypad Screen �
Creating a Keypad (3)

Do not use the  keys. They
are disabled on a pop-up keypad that
is not used for the [Specify Entering
Order] feature.

For ST series units, the Pop-up Key-
pad library's 20-dot unit Keypad will
not operate even when selected / set.

For ST Unit usage restrictions,
2.12.2 Restrictions



2.1 Parts Chapter 2 - Base Screens

2-108 GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(3)Edit the Pop-up keypad.
When changing the size and place of the Pop-up
Keypad, a clear area must be changed.  Specify a
clear area to surround the entire pop-up keypad.

When the range of the clear area is
specified, the X-axis can be speci-
fied in units of eight dots.Fractions
will be automatically translated into
eight-dot units. The Y-axis can be
specified   arbitrarily.

Clear Area is reset using the [Tag] -
> [Clear Area] selection. Selecting
Clear Area allows the clearing of
sections that will not be displayed
when switching between different
size keyboards.

(4)Select [Save] from the [Screen] menu or click the
  icon to save the pop-up keypad you have

edited.
This will be used as the Pop-up keypad within the
project.

When saving the edited Pop-up
keypad, select [Save as default
Keypad] from the [Screen] menu.
The pop-up keypad will be used as
the default keypad for all future
projects.
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����� Using the Time-Base function
• The Time-Base function is featured in PLCs manufactured by Siemens Corpo-

ration (S5 and S7 Series), and cannot be used with other devices.
The following table lists the supported protocols:

0 (0.01s) 0.00s to 9.99s
1 ( 0.1s)  0.0s to 99.9s
2 (  1 s)   0 s to 999 s

3 (  10s)    0s to 9990s

Display Range
Time-Base Mode BCD (3 digits)

0 to 9 0 to 9 0 to 9

Upper 4 bits Remaining (Lower) 12 bits

If the digit entered for the Time-Base mode is not 0, 1, 2, or 3, it is treated
as “3”.

• This function is supported only by GP2000 Series (except for the GP2000H
Series) and ST Series.

• A total of 16 bits of data are used, with the upper four bits showing the Time-
Base mode, and the remaining 12 bits showing the display data. These 12 bits
are processed using 3 digits of BCD data.

• Time-Base data can have decimal points, spaces or zeroes (“0”), with the
character “s” always included on the right. (See table below)

Siemens AG SIEMENS S5 90-115 Series
SIEMENS S5 135-155 Series
SIEMENS S5 3964 (R) Protocol
SIEMENS S7-200 PPI
SIEMENS S7-200 via MPI
SIEMENS S7-300/400 (ETHER)
SIEMENS S7-300/400 via MPI
SIMATIC S7 via 3964/RK512

PROFIBUS PROFIBUS-DP
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� When “Fixed” is selected
This function retains/keeps the number of decimal points set in the Time-Base
function selection during input. (Upper 4 bit values designate the Time-Base mode.)

(A) Since Time-Base mode selections 2 and 3 have no decimal places, decimal
point input is not accepted. If decimal point values have been entered,
please press the Pop-up Keypad’s [Cancel] button, or enter a value with no
decimal points.

(B) To ensure the cursor does not move below the decimal point, the “1” digit
of the data entered is deleted.

(C) Since only 1 digit is allowed to the right of the decimal point, the first
character to the right of the decimal point, “2”, is deleted.

(D) To ensure the cursor does not move below the decimal point, the “1” and
“2” digits entered are deleted.

0 (0.01s) 1 (0.1s) 2 (1s) 3 (10s)
0 0.00s _0.0s __0_s ___0s
2 2.00s _2.0s __2_s __20s
1.2 1.20s _1.2s Input not accepted (A) Input not accepted (A)

12 2.00s 12.0s _12_s _120s
1.23 1.23s _1.3s (C) Input not accepted (A) Input not accepted (A)

12.3 2.30s (B) 12.3s Input not accepted (A) Input not accepted (A)

123 3.00s (D) 23.0s (B) 123_s 1230s

Input
Value

Value shown in Keypad Input Display

Clicking the “Time-Base” selection in the Keypad Input Display Part’s Display
Format tab, enables the Time-Base function.

When the Keypad Input Display Part’s Time-Base feature is enabled, the “Fixed”
function becomes available.
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� When “Fixed” is not selected
This setting is used to improve the accuracy of the values displayed, without
selecting the Time-Base mode.

(A) Can be displayed using any type of Time-Base mode, however it will be
displayed using the highest-precision Time Base mode [0].

(B) Values can be displayed using Time-Base modes [0], [1], or [2], however it
will be displayed using the highest-precision Time Base mode [0].

(C ) Values can be displayed using Time-Base modes [0], [1], or [2], however it
will be displayed using the highest-precision Time Base mode [0].

(D) Values can be displayed using Time-Base modes [1], or [2], however it will
be displayed using the higher-precision Time Base mode [1].

(E) Value cannot be displayed using any of the Time-Base modes and cannot
be entered. Either press the Pop-up Keypad’s [Cancel] button, or enter a
value that can be displayed.

        ← ….. Indicates that display is possible, but will be displayed using
the highest-precision possible.

Cannot display ….. The entered value cannot be displayed in the selected Time-
Base mode.

0 (0.01s) 1 (0.1s) 2 (1s) 3 (10s)
0 (A) 0.00s
0.0 0.00s Cannot display Cannot display
2 (B) 2.00s Cannot display
1.2 (C) 1.20s Cannot display Cannot display
12 (D) Cannot display 12.0s Cannot display
1.23 1.23s Cannot display Cannot display Cannot display
12.3 Cannot display 12.3s Cannot display Cannot display
123 Cannot display Cannot display 123_s Cannot display
1230 Cannot display Cannot display Cannot display 1230s
1234 (E) Cannot display Cannot display Cannot display Cannot display

Input Value
Value shown in Keypad Input Display
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When the device Monitor Bit has been turned ON, messages registered in
the Alarm Summary by the Alarm Editor, can be displayed in a list.

Chapter 5 CREATING AND EDITING ALARMS

Message display order is decided according to which Monitor Bit is in the
lowest position in the Alarm Summary display area.  It is recommended that
Monitor Bit assignment begins from the message with the highest priority.
Be sure to input only one message per line.  The characters of a message that
exceed one line will be truncated.
The number of the characters that can be displayed in one line will vary
depending on the character size and GP type.  When the size is 1 x 1, the
maximum number of characters that can be displayed per line for each GP
model is:

2.1.15  Alarm Display

Enter Comment
data here

Enter the start
address for
each
message’s
Monitor Bit

Enter the
number of
Words allo-
cated for a
Monitor Bit

Select the display
area border
(frame)

����� Border Type

The display area frame types are No Border, Outside, and Outside + Inside.

Maximum Number of
Characters GP Type

40 GP-H70,  GP-270, GP-370,  GP-377, GP-377R, GP-2301H,  GP-
2300, GP-2301

80 GP-470, GP-570, GP-571, GP-870, GP-477R, GP-577R, GP-
2401H, GP-2400, GP-2401, GP-2500, GP-2501

100 GP-675, GP-2600, GP-2601

����� Alarm Summary [Description] Attributes
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Designates from
which existing
error message
will the display
begin

Designates the No.
of Lines of a
message that can
be displayed on
one screen

Designates the
maximum No. of
Characters per
line

����� Word Address

The Monitor Bit’s first address for the messages specified by the Alarm
Editor is input.  Input this address in word units.

E.g.) How to designate a Word Address (MELSEC-A Series - Mitsubishi):
When designating the Word Address for the input/output or internal
relay, the Word Address is designated from the Least Significant Bit.

In this case, Y010 is
designated

In this case, M0144 is
designated

← High   Low→   LSB ← High   Low→   LSB

When a variable (GLC symbol) is used as an address, an integer
array must be designated. For an integer array, the space re-
quired for consecutive addresses needs to be allocated. If the
space (addresses) needed for the continuous addresses' array
is not reserved/set up, the Part/feature will not operate cor-
rectly.
Also, be aware that during Online Edit, the addition and deletion
of variables may not operate correctly.

����� No. of Monitor Words

Here, the number of words a Monitor Bit is assigned and entered.  Up to
100 words can be monitored.

����� Alarm Summary [Display Format] Attributes
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����� Display Start Line

Among the messages whose Monitor Bit is turned ON, the Start Line desig-
nates from which message the display starts.
When the Alarm Summary display cannot fit in a single screen:

Only one Alarm Summary display can be placed on a screen.  When the number of
messages to be displayed does not fit on one screen, create Alarm Summary
displays on multiple screens, so that the screens will switch to display all the
messages.  To display all error messages continuously, specify each screen’s Start
Line as follows:

The first screen: ........... The starting line
The second screen: ...... The number of display lines on the first screen + 1

·
·
·

The nth screen: ............ The number of display lines on any screen x (n-1) + 1

����� No. of Display Lines

Designates the maximum number of alarm message lines that can be dis-
played on one screen.  Up to 50 lines can be displayed.

����� No. of Display Char.

Designates the maximum number of characters that can be displayed on a
line.  The screen’s limit is 100 characters per line.  However, the maximum
number of characters for each GP unit will vary depending the model.

����� Alarm Summary [Style/Color] Attributes
The display area color when a message is cleared (Clear Color) is selected.

2.1 Parts ����� Selecting Colors
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Enter 1

Enter 30

Enter 10

(3)In the [Display Format] tab, input the Display Start
Line, No. of Display Lines, and No. of Characters.
In the [Style/Color] tab, select the Clear(ing of Data)
Color, if desired.

100 Alarm Messages, have
been assigned to bits M0800 ~
M0899 in the Alarm Editor

Appear on the screen in a
Summary Display, at 10 lines
by 30 characters per display.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

ErrorCode030 Unit 0D5
ErrorCode040 Unit 0D5
ErrorCode041 Unit 0D6

·
·
·

Enter M0800

Select Border type

Enter 7

2.1.15 Alarm Dis-
play � Alarm Summary [Descrip-
tion] Attributes � Word Address

(1)Select the [Parts] menu - [Alarm Display] command,
or click on the  icon.

(2)In the [General Settings] tab, input the Word Ad-
dress, No. of Monitor Words, and select one of the
Show Border options.
Here, since the Word Address range is from M0800 to
M0899, enter “7” for the number of Monitor Words.

����� Placing an Alarm Summary Display Area
The Alarm Summary Display Area’s setting procedure is shown below.
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To cancel placement, click on the
 icon.

To change the Part
size, refer to refer to 2.4.3 Scaling
Up/Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s Attribute Settings dialog
box.

2.4.14 Changing
Attributes

Be sure to use the Alarm
Summary’s display area only
for displaying Alarm Mes-
sages, i.e. never place, over-
lap, or overlay another Part or
object in this area.

(4)After all of the Part’s attributes have been entered
and selected, click on the  button.
The Alarm Summary display area’s border will appear
in the Base screen, next to your cursor.

(5)Click on the point where the Alarm Summary dis-
play area’s top left corner is to be placed.
If desired, use the Alarm Summary display handles to
alter its size.  When the Alarm Summary display is scaled
up or down, the displayed character size will also change,
according to the border’s size.
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Data registered in the Filing Data settings is displayed.

Set up the Filing Data Settings before placing the File Name
Display. For information on registering the Filing Data:

����� File Name Display [General Settings] Attributes

2.1.16  File Name Display

Enter a descrip-
tion if desired

Specify
whether or not
to use the LS
area

Enter the start
word address
of the LS area

Enter the ID
number for the
File Name
Display and its
function switch

����� Description

Enter a description using a maximum of 20 single-byte characters.

����� ID No.

The File Name Display is linked to its function switch (File Name Key).
Specify the number to identify this link is here. This number is available up
to 255.

����� File No.

Enter the file number registered in the Filing Data list (1 to 2047). The
names under this number are displayed when the file is opened.

  Tag Reference Manual, 4.2 Filing Data (Recipe) Function

����� By Way of LS

When Filing Data is transferred between backup SRAM and the PLC, it can
be modified on the GP screen by routing it via the LS area (the data is stored
temporarily in the LS area). If data transfer via the LS area is used, specify
the LS area’s start-word address where Filing Data will be stored from. The
address where the data can be stored is from LS0020 to LS2031, and
LS2096 to LS4095 (LS2096 to LS8191 for GP2000 series).

����� PLC Transfer

This Bit is turned ON when filing data transfer to the PLC is completed.
Since this Bit does not turned OFF automatically, to use the PLC Transfer
Completed Bit again, turn it OFF beforehand.

When the PLC Transfer Completed Bit Address has been entered, in the case
where filing data cannot be transferred to the PLC, the GP’s special relay
LS2032 Bit 10 will be turned ON.

Enter the File
No. of filing data
to be displayed.

Set up the
PLC Transfer
Completed Bit
Address.

   Tag Reference Manual, 4.2 Filing Data (Recipe) Function
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����� File Name Display [Display] Attributes

Specify the name
selection method

Enter the
number of
names being
displayed

Enter the
number of
characters
used for the
names being
displayed

Specify the
cursor position
retention

����� No. of Display

Specify the number of Filing Data rows displayed on the GP. A maximum of
50 rows may be specified.

����� No. of Display Characters

Specify the number of Filing Data characters used on each row. A maximum
of 100 characters may be specified.

����� Direct Selection

Select a File Name Display being placed on the GP by directly touching its
border. If [Direct Selection] is not used, select the file name using the data
scroll switches [Roll Up/Roll Down].

 � � � � � File Name Display [Switch Settings] Attributes

����� Cursor Position Control

Even when the screens are changed on the GP , the current screen’s cursor
position can be retained. When turning the GP’s main power switch ON or
resetting the GP, however, the cursor will appear in the first line.

The cursor position will be stored for each ID No. To retain the cursor posi-
tion, be sure that the File Name Display ID Nos. will not be overlapped
through all the screens.

����� File Name Display [Style/Color] Attributes
Specify a color [display color (Fg)] for characters in the Filing Data display
area, and a color [display color (Bg)] of the Filing Data display area.

   2.1  Parts ����� Selecting Colors
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����� File Name Display [Switch Settings] Attributes
Set the function switches that are placed automatically.

2.1.3 Function Switches

Switches to
transfer Filing
Data between the
backup SRAM
and the PLC

Switches to
transfer data
via the LS
area. These
switches are
valid when By
Way Of LS is
selected in
[General
Settings]

Switches to
scroll names and
select one

����� Automatic Switch Placement Method

Automatically places the function switches for the selected names.

����� Send To PLC From SRAM

Places the switch used to transfer Filing Data from the backup SRAM to the
PLC.

����� Send To SRAM From PLC

Places the switch used to transfer Filing Data from the PLC to the backup
SRAM.

����� Roll Up

Places the Roll Up key used to scroll names and select one. Touching the
Roll Up key once will roll up names by the number specified here.

����� Roll Down

Places the Roll Down key used to scroll names and select one. Touching the
Roll Down key once will roll down names by the number specified here.

����� Send To LS From SRAM

Places the switch used to transfer Filing Data from the backup SRAM to the
LS area.

����� Send To SRAM From LS

Places the switch used to transfer Filing Data from the LS area to the backup
SRAM.

����� Send To LS From PLC

Places the switch used to transfer Filing Data from the PLC to the LS area.

����� Send To PLC From LS

Places the switch used to transfer Filing Data from the LS area to the PLC.
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����� File Name Display [Switch Type/Color] Attributes
Specify colors (border colors) for the function switches which are placed
automatically.

2.1.3 Function Switches

����� Place File Name Display
Shows how to call up the File Name Display.

Registered File No. 1’s filing data is dis-
played on the File Name Display with 3
display lines and 10 display characters.
By pressing a function key (File Name Key),
filing data can be transferred from the
SRAM to the PLC, or from the PLC to the
SRAM.

For filing data list and reg-
istering filing data, refer to Tag Reference
Manual, 4.2 Filing Data (Recipe) Function.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

Enter 1

� File Name Dis-
play [General Settings] Attributes

To transfer Filing Data via the LS
area, mark the check box for [Use
LS Area] in the [Use LS Area].

(1)Select the [Parts] menu - [File Name Display] com-
mand, or click on the  icon.

(2)In the [General Settings] tab, enter the File No. of
filing data to be transferred and the File Name
Display’s ID No.
Here, since File No. 1’s data is transferred, enter “1” for
the file number. The File Name Display’s ID No. is “0”.
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(4)In the [Switch Settings] tab, select the function
switches which are being placed automatically, and
specify the number of lines being rolled up or down.

(3)In the [Display] tab, specify the No. of Display Lines,
Display Characters, Direct Selection, and Cursor
Position Control.
If necessary, specify the display color in the [Style/Color]
tab.

Enter 3

Enter 10

(5)Specify the border colors for the function switches
in the [Switch Type/Color] tab.

(6)After setting all the attributes, click on .
The frame of the File Name Display size will be dis-
played in the drawing area.

Select
these two
switches
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To cancel the placement, click on
the  icon.

(7)Click the mouse button where you want to place each
attribute.

(8) Select the placed File Name Display. Then, select the
[Edit] menu - [Ungroup] command, or click on the

 icon to ungroup the File Name Display and alter
each item’s position and size.

The File Name Displays are
grouped. To change any attribute,
first ungroup the File Name Dis-
plays, and then change the attribute.

2 .4 .12  Group/
Ungroup

2.4.14 Changing
Attributes
If the By Way Of LS area is se-
lected, the address for the LS area
can be changed after ungrouping
the File Name Displays.
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Data created in the data logging settings can be displayed and edited on the
GP unit.

· After the data logging settings, place the Data Logging Dis-
play.

 For registering logged data, refer to Tag Reference Manual;
    4.3 Logging Function
· The Data Logging Display does not operate in a window.

· Only one Data Logging Display can be placed on each screen.

· The Logging Display cannot be set up simultaneously with the K-tag, N699
tag, Keypad Input Display or CSV Display.

· Data that could not be logged due to a read error is identified with “***” in
a cell.

· Data that is not logged is not displayed.

����� Data Logging Display [General Settings] Attributes

����� Block Number Address

On a block basis, specify the data being displayed. The logged data for the
block number stored at the word address specified here will be displayed.

The block numbers that can be entered are between 0 and 2047, but the
maximum of the effective range is [Number of Blocks] specified in [Trigger
Settings] in the data logging settings. If [Number of Blocks] specified in
[Trigger Settings] is 4, the block numbers are 0 to 3 (BIN values only).

· If any block number that does not exist is specified, no data will be dis-
played.

· When the loop function has been designated via [Trigger Settings] of the
data logging settings, the Block Number Address will become ineffective.

Using a word
address,
specify the
block number
of data being
displayed

Using a bit
address,
specify the
interlock
address

2.1.17 Data Logging Display

Enter a comment,
if necessary

Specify whether
the data edit
function is
enabled or
disabled

Specify whether
the interlock
function is
enabled or
disabled
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����� Data Edit

The logged data can be modified by directly touching the frame of each item
in the Data Logging Display placed on the GP. If Data Edit is enabled,
touching the cell of data that can be modified in the table will cause the
buzzer to sound and allow you to enter data. If Data Edit is disabled, this
touching will be invalid and the buzzer will not sound.

· The data that can be modified is only [Date] and [Value] that have been
logged.

· If a block or logged data is selected by changing the block number during
on-screen modification of data, the data edit mode is canceled.

· If the cell is moved beyond the display area, using the scroll keys during the
data edit mode, the data edit mode is canceled.

����� Interlock

The interlock can only be activated when the data edit capability is enabled.
If the interlock is enabled, data can be modified only when the bit address
for the interlock is ON. If the interlock is disabled, data can always be
modified by touching it.

If the bit address for the interlock is turned OFF during on-screen modifica-
tion of data, the data edit mode is canceled.

����� Data Logging Display [Data Type] Attributes

Select a Border
Type of the
display area

Enter the
number of
rows for the
items dis-
played (0 to 40)

Specify whether
the scrolling of
the totaling
section is en-
abled or disabled

Enter the
number of
columns for
the items
displayed (0 to
25)Enter a display interval

(the number of dots) (0 to 10)
����� Border Type

Select a border type of the display area from among three types, No Border,
outer border  (1-dot lines), and outer border plus inner border  (the
outer border and item use 2-dot lines, while the inner border uses 1-dot
lines).

����� Row

Specify the number of rows used to display logged data on the GP. A maxi-
mum of 40 rows may be specified.
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Border (the gap between the
border and the cell is not filled
with the clear color)

Cell

Draw the border so
that it does not
overlap any cell.

If the scroll data area is enabled, the totaling section is scrolled together with
the data section. If the totaling section scroll is disabled, the totaling section
always appears on the screen.

����� Data Logging Display [Color] Attributes
Select a color (clear color) displayed when the border of each item is
cleared.    2.1  Parts �����  Selecting Colors

����� Column

Specify the number of columns used to display logged data on the GP. A
maximum of 25 columns may be specified.

�����  Spacing

Specify spacing at which to display logged data on the GP. A maximum of
10 dots may be specified. This entry is only valid when the display area
border type is specified as No. Border. Draw the border line using the
drawing tool.

The gap equivalent to the specified display spacing is provided between the
cell and the border line. The entire cell is filled with the clear color specified
in the Data Logging Display [Color] Attributes. However, the gap is not
displayed in the clear color, but its background is displayed. If No Border is
selected to draw an arbitrary border, ensure that the border is drawn using
the same width as the specified display interval without overlapping the cell.

<Display Spacing>

����� Scroll data area
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����� Data Logging Display [Switch Type/Color] Attributes
Specify a color (border color) of each function switch.

  2.1  Parts �����  Selecting Colors

Select the
function
switch type to
be placed

Enter the
number of
rows/columns
scrolled

����� Data Logging Display [Switch Settings] Attributes
The number of rows and that of columns specified in [Data type] are dis-
played on the Data Logging Display. If any data exceeding these numbers
exists in the GP, use the function switches to scroll the data.

   2.1.3 Function Switches
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PROCEDURE R E M A R K S

Enter D0100

(2)In the [General Settings] tab, specify the block num-
ber designated address, data edit, and whether the
interlock is enabled or disabled.
Specify D0100 for the block number designated address.

  2.1.17  Data
Logging Display [General Set-
tings] Attributes Block Number
Address

(3)In the [Data Type] tab, specify the display settings.
If necessary, select a clear color in the [Color] tab.

Enter 7

Enter 4

(1)Select the [Parts] menu - [Data Logging Display] com-
mand, or click on the  icon.

The logged data for the block number stored at the block number desig-
nated address is displayed.

015

The logged data in block No. 3
will be displayed.

Placing the Data Logging Display
The procedure for setting the Data Logging Display is described below:

Date Time Data1
LP

1st 98/10/16 09:14:00 144
2nd 98/10/16 09:14:00 145 EM
3rd 98/10/16 09:14:01 146
4th 98/10/16 09:14:01 147 R
5th 98/10/16 09:14:01 148

730 LTOTALIf 3 is stored at D0100.
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PROCEDURE R E M A R K S

(5)After entering and selecting all the attributes, click
on the  button.
The border of the Data Logging Display size will be dis-
played in the drawing area.

To cancel the placement, click on
the  icon.

The Data Logging Displays are
grouped. To change any attribute,
ungroup the Data Logging Displays
by clicking on the   icon before-
hand.

2 .4 .12  Group/
Ungroup

If you double-click on the function
switch placed on the screen, the
address confirmation screen for
parts will appear, enabling you to
change the address.

 2.4.14 Changing
Attributes

(4)In the [Switch Settings] tab, select the function switch
type that is to be placed automatically, and specify
the number of rows, columns scrolled.
If necessary, select a color for the special switch in the
[Switch Type/Color] tab.

(6)Click on the point where the function switch is to be
placed.
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2.1.18  Data Transfer Display

The Data Transfer Display allows you to manually transfer the data-transfer-
ring CSV data from the CF Card to the PLC or from the PLC to the CF
Card. This area is used to display the names of the data-transferring CSV
files on the CF Card and execute the transmission. When placed together
with the CSV Display, the CSV file selected with the Data Transfer Display
area can be viewed, edited, and printed via the data display area of the CSV
Display.

 For the CSV Display, refer to 2.1.19 CSV Display.

• The CSV Data Transfer function is available only on the
GP2000 series.

• Be sure to configure the parameters of the CSV Data Transfer
function and edit the CSV data before placing the Data Trans-
fer Display on the screen.

 For the procedures for configuring the parameters of
the Data Transfer Display function and CSV data editing, refer to Tag
Reference Manual, 4.4 CSV Data Transfer Function.

• Do not place more than one Data Transfer Display on a single Base screen.
Otherwise, a malfunction of the switch may result.

• Up to 32 Data Transfer Displays can be set up in one Project. When 33 or
more are set up, the Data Transfer Displays will not function.

����� Data Transfer Display [General Settings] Attributes

Designate a word
address for the
Transfer Status
Address.

Enter the
description as
necessary.
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����� Transfer Status Address

To transfer data, store the following status in the Transfer Status Address.

Error
Code

Error
Message Description

0
Completed
successfully

The processing is completed successfully.

1 Reserved

2
No transfer
condition No.

The Group No. (transfer condition No.)
corresponding the file No. specified for CF-to-
PLC or PLC-to-CF transfer setting does not exist.

3
LS area
range error

In a CF-to-PLC data transfer in which the start
address of the transfer is specified as being in
the LS area, a data transfer is attempted to the
address outside the specified range of the LS
area.

4 No CF Card
No CF Card is inserted or cover of CF Card slot
is open.

5
CF Card
read error

Read-out from CF Card failed in a CF-to-PLC
data transfer.

6
CF Card
write error

Data writing onto the CF Card failed in a PLC-to
CF data transfer.

7
CF Card
error

CF card is invalid (unformatted) or media
inserted is not a CF Card.

8 Reserved

15 12 11 02 01 00 Bit
Reserved (0)

Transferring
Transfer completedError status

The timing chart below shows the relationship between the data transfer and
transfer status.

Triggered by touch
ON
OFF

Transferring Bit
(Status)

ON
OFF

Transfer-completed
Bit (Status)

ON
OFF

Data Transfer
Holds
Fails Data transfer

* The Transfer-completed bit address cannot be turned OFF via the GP
side. Turn Off the bit address via the PLC.
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����� Data Transfer Display [Display] Attributes

����� No. of Display Lines

Specify the maximum number of lines for displaying messages on each
screen. Up to 50 lines can be displayed on a single screen.

����� No. of Display Characters

Specify the maximum number of single-byte characters to be displayed in a
line. Up to 100 single-byte characters can be displayed per line. However,
the display varies with the model.

����� Data Transfer Display [Style/Color] Attributes

����� Border Type

Select from three types of borders: "No border", "Outer border", and "Outer
and inner borders."

����� Color

Select the desired text color when data are displayed (Display Color: Fg),
the color inside the display area (Display Color: Bg), and the color for the
display area that will be used when the data are cleared (Erase Color).

  2.1 Parts �����Selecting Colors

Specify the maximum number of
characters to be displayed in a
line.

Specify the number of lines for
displaying the data item (1 to 50).

Select the desired border
type for the display area.
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����� Data Transfer Display [Switch Settings] Attributes
Configure the settings of the function switches automatically placed on the
screen.  2.1.3 Function Switches

����� CF ÆÆÆÆÆ Device/PLC

Put a check mark in the checkbox to place a switch for transferring CSV
files from the GP's CF Card to the PLC. When transferring two or more
CSV files in one operation, select the desired files and touch the switch you
have placed on the screen.  Tag Reference Manual, 4.5
CSV Data Transfer Function

����� Device/PLC ÆÆÆÆÆ CF

Put a check mark in the checkbox to place a switch for transferring CSV
files from the PLC to the GP's CF Card. When transferring two or more
CSV files in one operation, select the desired files and touch the switch you
have placed on the screen.  Tag Reference Manual, 4.5
CSV Data Transfer Function

����� Data Transfer Display [Switch Type/Color] Attributes
Designate the border colors and shapes of the parts here.

 2.1 Parts �Selecting Colors

Switches for transferring
data between the CF Card
and PLC

Switches for scrolling and
selecting data items (Data
items can be scrolled be-
tween 1 and 100.)

Displays the selected CSV
data on the CSV Display.
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����� Configuring a Data Transfer Display
The procedure for configuring a Data Transfer Display is as shown below.

<Data Transfer Display> [Transferred data]
Data of File No. 1
(ZR00000.CSV)
: Data 2002/1/19 9:30:00
: Group No. 1
: Group Name Agitator No. 1
Item Name Value

150
230
300
540
18

The data are transferred to
the PLC according to the
data transfer conditions of
the specified Group Name.

Select the data-transferring CSV file
data on the CF Card (Group Name:

Agitator No. 1), and touch .

Data
Transfer

PROCEDURE R E M A R K S

Enter "D0030".

 2.1.18 ����� Data
Transfer Display [General Set-
tings] Attributes �Transfer Sta-
tus Address

(1)Select the [Parts] menu-[Data Transfer Display] com-
mands, or click on the  icon.

(2) In the [General Settings] area, set the Transfer Sta-
tus Address.
Enter "D0030" here.

 For the procedures for transferring two or more data items
and creating the data-transferring CSV data, refer to Tag Reference Manual,
4.4 CSV Data Transfer Function.
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PROCEDURE R E M A R K S

Enter "8".
Enter "20".

In the example, the "Border Dis-
play" is designated to      (Outer
and Inner borders).

(3) In the [Display] area, specify the number of Display
Lines and number of Display Characters.
Specify the borders and colors in the [Style/Color] area
as necessary.

(4) In the [Switch Settings] area, select the switches
(Transfer directions, Scroll, Display) you want to
place on the screen.
If necessary, specify the border color and the shape of
the part in the [Switch Tupe/Color] area.

Select the
types of the
function
switches to be
placed on the
screen.

(5) After all of a Part's attributes have been entered or
selected, click on the  button.
A frame the size of the Transferring data display area
appears in the screen creation area.

(6) Click on the point where the Data Transfer Display
is to be placed.
Change the part size as necessary.
When the Transferring data display area is scaled up/
down, the size of the displayed text changes accordingly.

To cancel the placement, click on
the  icon.

 To change a Part's
size, refer to 2.4.3 Scaling Up/
Down.
Parts are grouped. To change a
Part's attributes, ungroup the Parts
and double-click on the desired Part
on the screen.

 2.4.14 Changing
Attributes
Do not overlap other Parts and
drawings with the Transferring data
display area. Be sure to use the area
as a dedicated area for displaying
the data.

When CSV Display is placed close
to the Data Transfer Display, you
can view the selected CSV file by
touching the  switch on the GP
screen. For details of the CSV Dis-
play setting,

 2.1.19 CSV Dis-
play
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2.1.19  CSV Display

The CSV file stored on the CF Card can be displayed, edited and printed
with the CSV Display. Place the CSV Display together with the Data Trans-
fer Display or File Manager Display.

• The CSV Display feature is available only with the GP2000
series.

• The CSV Display will not function on Windows.

• Only one CSV Display can be set up on each Base screen.

• The CSV Display cannot be set up simultaneously with the Logging Display,
Keypad Input Display, K-tag or N699-tag.

• Do not rotate the CSV Display when placing it on the screen. Otherwise, the
pop-up keypad used for editing the CSV data may not be displayed in
proper orientation for the CSV Display.

• All CSV file data created with the GP can be displayed on the CSV Display
as listed below.

 For details of the CF Card, refer to Tag Reference Manual,
4.7 Using the CF Card.

• When the data currently being displayed on the CSV Display is modified
(for example, when data are transferred from the PLC to the CF Card with
the CSV data transfer function), the CSV Display displays the data of the
CSV file from the beginning. The data currently being displayed on the
CSV Display also cannot be deleted with the File Manager.

 For precautions about the display,  refer to Tag Reference
Manual, 4.5.4 CSV Data Display Function (Combination).

Folder Name File Name Data Type
\log ZL*****.CSV Logging Data

ZT*****.CSV Trend Graph Data
ZS*****.CSV Sampling Data

Alarm Data
ZA*****.CSV � Alarm Active/Block 1 Data
ZH*****.CSV � Alarm History/Block 2 Data
ZG*****.CSV � Alarm Log/Block 3 Data

\trend

\alarm
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����� CSV Display [General Settings] Attributes

When selected,
Line/Row numbers
are appended for
displaying the CSV
data.

Enter the
descriptions as
necessary.

Enter the word
address for
designating the
Status Address.

Select the color
and text size of the
CSV Display.

When selected, the
CSV data can be
edited with touch
operations.

����� Color

Select the colors for characters (Fg) and the background color of the display
area (Bg).

 2.1 Parts �Selecting Colors
����� Character Size

Specify the character size.  2.2.9 Text

����� Edit

When this function is enabled, touching the desired cell of the CSV data
displayed on the CSV Display allows you to edit the data. (This function is
disabled with the initial setting.)

����� Display Column

When this function is enabled, the Line No. and Row No. will be displayed
on the lines and rows of the CSV data display area. (This function is dis-
abled with the initial setting.) The Line/Row numbers of the Column display
are shown in bold typeface. The outer border of the Line/Row for the Col-
umn display and items are divided with 2-dot lines. The borderlines and
numbers of the Column display cannot be printed.
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15 12 11 02 01 00 Bit
Reserved (0)

Outputting the
Edited Data

Printing

Error status

����� Status Address

When enabled, "Outputting the Edited Data" status, "Printing" status or the
error status of the CF card processing is set to the specified address.

Error
Code

Error
Message Description

0
Completed
successfully

Processing is completed successfully.

1 Reserved
2 Reserved
3 Reserved

4 No CF Card
No CF Card is inserted or cover of CF Card slot
is open.

5
CF Card
read error

Read-out from CF Card failed in a CF-to-PLC
data transfer or the CF Card doesn't have
sufficient free space.

6
CF Card
write error

Data writing onto the CF Card failed in a PLC-to
CF data transfer.

7
CF Card
error

CF card is invalid (unformatted) or media
inserted is not a CF Card

8 Reserved

ON: While the printing opera-
tion is being performed

OFF: States other than above
* Printing of other data

and data editing are
disabled while the bit is
ON.

ON: While the data are
being read out to the
CF Card, triggered
by touching the
[Enter] key after the
CSV data are edited

OFF: States other than
above
* Printing and

editing of the data
are disabled while
the bit is ON. In
addition, the GP
cannot be
switched to
OFFLINE mode.
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����� CSV Display [Switch Settings] Attributes

����� Print

The switches are used to execute a print operation of all data of the current
CSV data or only the area displayed.

• Up to 160 characters can be printed per line. Characters exceeding the limit
are not printed.

• The Column display is not printed.

����� CSV Display [Switch Type/Color] Attributes
The border colors and part types can be designated here.

 2.1 Parts �����Selecting Colors

����� CSV Display [Extend] Attributes
When a check mark is put in the [Data Editing] checkbox on the [General
Setting] area, the Interlock setting can be enabled.

Switches
used to scroll
the items.
(Specify the
number of
data items to
be scrolled
between 1 and
65,535.)

Switches used to
execute print
operations.
Select whether to
print all of the
displayed CSV
data or only the
area displayed.

Designate
whether to enable
or disable the
interlock function.
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����� Interlock

The switch becomes effective only when the bit designated via the [Interlock
Address] is in a state that has been selected via the [Touch available condi-
tion]. Select whether the switch becomes effective in the state or OFF state
of the [Touch available condition].

Touch Available
Condition

Interlock Address
Status

Touch Available/Not
Available

ON Touch available
OFF Touch not available
ON Touch not available
OFF Touch available

Bit ON

Bit OFF
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����� Placing a CSV Display
The procedure for configuring a CSV Display is as shown below.

PROCEDURE R E M A R K S

 For the proce-
dures for setting up the File Man-
ager Display, refer to 2.1.20 File
Manager Display.

(1)Select the [Parts] menu-[CSV Display] commands,
or click on the  icon.

(2) Specify the ON/OFF settings of Data Editing, Col-
umn Display, and Status Address on the [General
Settings] area.
Specify the Display Colors and Character Size if neces-
sary.

Place the CSV Display along with the File Manger Display to display the
specified CSV file. Similarly, the CSV Display displays the CSV file when
placed in combination with the Data Transfer Display.

 For details of the File Manager Display, refer to 2.1.20 File
Manager Display.

For details of the Data Transfer Display, refer to 2.1.18 Data
Transfer Display.

<File Manager Display> <CSV Display>
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PROCEDURE R E M A R K S

Select the
types of
function
switches to
be placed on
the screen.

(3)On the [Switch Settings] area, specify the switches
(Scroll and Print switches) to be placed on the screen.
If necessary, specify the border color and part type on
the [Switch Type/Color] area.

(4) When [Edit] is enabled in the [General Settings] area,
specify the ON/OFF status of the [Interlock] func-
tion in the [Extend] area.

(5) After all of a Part's attributes have been entered or
selected, click on the  button.
A frame the size of the CSV data display area and a
switch frame appears in the screen creation area.

(6) Click on the point where the CSV Display is to be
placed.
Change the part size as necessary.
When the CSV data display area is scaled up/down, the
size of the displayed text changes accordingly.

To cancel the placement, click on
the  icon.

To change a Part's
size, refer to 2.4.3 Scaling Up/
Down.

Parts are grouped. To change a
Part's attributes, ungroup the Parts
and double-click on the desired Part
on the screen.

 2.4.14 Changing
Attributes

Do not overlap other Parts and
drawings with the CSV data display
area. Be sure to use the area as a
dedicated area for displaying the
data.
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2.1.20  File Manager Display

The File Manager Display displays a list of the folder/file structure on the
CF Card. Touching the Display switch displays or hides the File Manger
Display in the pop-up window.

 Tag Reference Manual, 4.6 File Manager Display Func-
tion
When placed together with the CSV Display, the CSV file selected via the
File Manager display area can be viewed, edited and printed via the data
display area of the CSV Display.

 For details of the CSV Display, refer to 2.1.19 CSV Dis-
play.

• The File Manager Display feature is available only with the
GP2000 series.

• Only one File Manager Display can be placed on each Base screen. Even
when two or more Display keys of the File Manager Display are set up/
touched, the operation is interlocked with the single File Manager Display.

• The settings of the File Manager Display (shape of the display area except
for the switch, borderlines and colors, etc.) cannot be edited with the Screen
Creation Editor.

• The File Manager Display is displayed as a local window. If two local
windows are already displayed on the screen, the File Manger Display will
not appear even if the Display key of the File Manager Display is touched.
In this case, the File Manager Display will not wait for input.

• When the File Manager Display and other windows overlap, touch the
desired window to bring it to the front.

• When placing a U-tag on the same screen with the File Manager Display, do
not specify [High Speed] in the U-tag's [Designated Window].

• When the Index Text Tables are switched, the File Manager Display is
closed. To display (activate) the File Manager Display, touch the  switch
again.

����� File Manager Display [General Settings] Attributes

Enter a description
if necessary.

Designate a word
address for the
Status Address.

Put a check mark
to automatically
place a switch
that deletes the
selected CSV file.
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����� Delete button

Deletes unwanted CSV files selected via the File Manager display area.

• The Delete button does not delete read-only CSV files.

• After deleting the unwanted file(s), the File Manager display area displays
the CSV files in a list starting with the file with the oldest file No.

• When used together with the CSV Display, the CSV file currently being
displayed on the CSV Display cannot be deleted.

����� Status Address

Stores the status of the CF Card error code.

15 12 0 Bit
Reserved (0)

Error status

Error
Code

Error
Message Description

0
Completed
successfully

Processing is completed successfully.

1 Reserved
2 Reserved
3 Reserved

4 No CF Card
No CF Card is inserted or cover of CF Card slot
is open.

5
CF Card
read error

Read-out from CF Card failed in a CF-to-PLC
data transfer.

6 Reserved

7
CF Card
error

CF card is invalid (unformatted) or media
inserted is not a CF Card

8
CF Card
delete error

Deletion of files on CF Card failed.

����� File Manager Display [Switch Setting] Attributes

Put a check mark
to automatically
place the Display
key.

Specify the color
and the switch type
only when the
[Place Display
Switch] option is
enabled.
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����� Placing a File Manager Display
The procedure for configuring a File Manager Display is as shown below.

PROCEDURE R E M A R K S

(1)Select the [Parts] menu-[CSV Display] commands,
or click on the  icon.

(2) Specify the ON/OFF settings of the Delete button
and the Status Address on the [General Settings] area.
In this example, the Delete button is not placed and Sta-
tus Address is set to OFF.

The File Manager Display displays the
file information on the CF Card in list
form. Touching the function switch (File
Manager DISP) displays the File Man-
ger Display in a pop-up window.

Use the  and  keys to scroll the
list up and down.

Use the  (Display) key to select the
desired file name.*

Use the  (Delete) key to delete the
specified file.

* When CSV Display is placed together with the File Manager Display,

touching the   key on the File Manager Display after selecting the
desired CSV file allows you to view, edit, and print the CSV data via the
CSV Display.
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(3)Specify the presence/absence of the Display switch
in the [Switch Settings] area.
If necessary, specify the part color/type as well. Here,
set the Display Switch to “Present”.

(4) After all of a part's attributes have been entered or
selected, click on the  button.
A frame the size of the File Manager display area and a
switch frame appears on the screen creation area.

(5) Click on the point where the File Manager Display
is to be placed.

Designate the point at which the
File Manager Display is to be
placed in 40-dot increments for the
X coordinate, and 20-dot incre-
ments for the Y coordinate. If the
designation of the placement posi-
tion differs from the above units,
the position of the File Manager
Display on the GP may become
misaligned.
The File Manager Display cannot
be scaled up or down.

Parts are grouped. To change a
Part's attributes, ungroup the Parts
and double-click on the desired part
on the screen.

 2.4.14 Changing
Attributes

 For the operation
of the File Manager Display on the
GP, refer to Tag Reference
Manual, 4.6 File Manager Dis-
play Function.
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2.1.21  Numeric Displays

Select the
Data Format
and Data
Length

Enter the total number
of digits used (not
including the decimal
point) in the display

Enter the number of
digits to be displayed
after the decimal point

Select the size used for
the label’s characters

����� Data Display Format

Here, the Data Display Format, Code, and data length are selected.  Choose
a data format of either Decimal (base 10), BCD, Hexadecimal (base 16), or
Octal (base 8).  With the Code +/- check box  checked, when you select
“Decimal”, negative numeric data can also be displayed.
When using a GLC Symbol for a Word Address or a Trigger Bit Address, be
sure to select "32 Bit" data display format.

����� Word Address

Here, input the Word Address where the display data is to be stored.

����� Numeric Display [Display Format] Attributes

This Part displays the device Word Address numeric data as an absolute
value.

����� Numeric Display [General Settings] Attributes
Enter Comment
data here Enter the Word

Address where
the display
data is stored

Display’s the
currently se-
lected Part’s
image

Calls up the Part
Shape Browser

Specify the
Display
Style.

Supported by the GP2000 Series only
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����� Decimal Places

Here, enter the number of digits to be displayed after the decimal point

The types of numeric data that can be used with each data format are listed
below.

Data Form Code Data Length No. of Display
Digits

Decimal
Places

+ only 0-65535
+/- -32768-32767

+ only 0-4294967295

+/- -2147483648-
2147483647

16 bit 1-4 0-3
32 bit 1-8 0-7
16 bit 1-4
32 bit 1-8

Oct + 16 bit only 1-6

Hex + 0-FFFF
0-FFFFFFFF

0-177777

BCD + 0-9999
0-99999999

Alarm Range

Dec +/-

16 bit 1-5 0-4

32 bit 1-10 0-9

The relationship between upper and lower position Word Addresses when
32 bit data is used will differ depending on each Device/PLC Type.

   Device/PLC Connection Manual

����� Character Size

The label’s Character Size is selected here.
  2.2.9 Text

Only when the GP type is the GP-77R , GP-377, or  GP2000 series, is the 8 x
16 setting valid. For any GP other than the GP-77R , GP-377 or GP2000
series, selecting 8 x 16 in the editor will display 16 x 16 on the GP.

� Display Style

• Shift Left

• Shift Right
Select the display style from the Shift Left and Shift Right. The data will
appear, starting from the side designated here. The Shift Right is selected by
default.

• Zero Suppress
Select this option to omit the leading zeros of display data. E.g. When the
Display Length is 4 and the Zero Suppress is NOT selected, 25 appears as
0025.

����� No. of Display Digits

Here, enter the total number of digits used (not including the decimal point)
in the display.

When the No. of Display Digits is set to 5 and the Decimal Places is set to 2, a
value appears on the Numeric Display as shown below.
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Enter D00100

(1)Select the [Parts] menu - [Numeric Display] com-
mand, or click on the  icon.

(2)In the [General Settings] tab, input the Word Ad-
dress used to store the display data.

When 32 bit data 65539 is
stored in addresses D0100
and D0101,...

The maximum number of
digits is 10, with 2 decimal
places.

Data stored in the specified Word Address is displayed in the
designated Numeric Display.

����� Numeric Display [Shape/Color] Attributes
Here, the Numeric Display area’s border color, value display color (Number
color), and interior color (Plate color) are selected.

   2.1  Parts  ����� Selecting Colors

����� Numeric Display [Alarm Settings] Attributes
If desired, specify a variety of Alarm settings.

  2.1  Parts ����� Alarm Settings

����� Placing a Numeric Display
The procedure for placing a Numeric Display is shown below.

• Zero Display
When this option is clicked, and the device data is 0, the value 0 will not
display.

• 7 Segment Display

When this option is selected, numerical values are shown on a 7-segment
display. Only GP2000 Series units support the 7-segment Display. 7-seg-
ment display is possible only when the Character Size is “16X16”.
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(5)After all of the Part’s attributes have been entered
and selected, click on the  button.
The Numeric Display’s outline will appear on the Base
screen, next to your cursor.

(6)Click on the point where the Numeric Display’s top
left corner is to be placed.
If necessary, use the Numeric Display’s handles to alter
its size after placement.
Regardless of whether the numeric data display area is
scaled up or down, the character size will not change.
To change the character size and position, select the char-
acters inside the border directly.

To cancel the placement, click on
the  icon.

To change a Part’s
size, refer to 2.4.3 Scaling Up/
Down

Pressing the  Ctrl  key while re-siz-
ing an area’s border will also re-size
that area’s characters.

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes

PROCEDURE R E M A R K S

Enter 5

Select 32 bit
Decimal

Enter 2

(4)In the [Display Format] area, specify the Data Dis-
play Format, and input the No. of Display Digits and
the Decimal Places.
Specify the Character Size, if desired.

 2.1 Parts �  Se-
lecting a Part Shape

(3)Select a Part Shape from the Browser.
If desired, set an Alarm and Colors from the [Alarm Set-
tings] and [Shape/Color] area.

Only the GP2000 Series supports
the 7 Segment Display.

When a GP type other than the
GP2000 Series is selected and the
"7 Segment Display" option is en-
abled, the following alarm appears.

To clear the alarm, disable the "7
Segment Display" option.
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����� Using the Time-Base function
• The Time-Base function is featured in PLCs manufactured by Siemens Corpo-

ration (S5 and S7 Series), and cannot be used with other devices.
The following table lists the supported protocols:

0 (0.01s) 0.00s to 9.99s
1 ( 0.1s)  0.0s to 99.9s
2 (  1 s)   0 s to 999 s

3 (  10s)    0s to 9990s

Display Range
Time-Base Mode BCD (3 digits)

0 to 9 0 to 9 0 to 9

Upper 4 bits Remaining (Lower) 12 bits

If the digit entered for the Time-Base mode is not 0, 1, 2, or 3, it is treated
as “3”.

Clicking the “Time-Base” selection in the Numeric Display Part’s Display Format
tab, enables the Time-Base function.

Siemens AG SIEMENS S5 90-115 Series
SIEMENS S5 135-155 Series
SIEMENS S5 3964 (R) Protocol
SIEMENS S7-200 PPI
SIEMENS S7-200 via MPI
SIEMENS S7-300/400 (ETHER)
SIEMENS S7-300/400 via MPI
SIMATIC S7 via 3964/RK512

PROFIBUS PROFIBUS-DP

• This function is supported only by GP2000 Series (except for the GP2000H
Series) and ST Series.

• A total of 16 bits of data are used, with the upper four bits showing the Time-
Base mode, and the remaining 12 bits showing the display data. These 12 bits
are processed using 3 digits of BCD data.

• Time-Base data can have decimal points, spaces or zeroes (“0”), with the
character “s” always included on the right. (See table below)
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2.1.22 Message Display

� Address
Enter an Address to be monitored. Select either Bit Address or Word Ad-
dress according to (operation) Mode.

� Border Color
The Message Display’s Border color can be selected.

2.1 Parts  ����� Selecting Colors
� Center Arrangement

When this feature is enabled, the text block of the text registered in the Text
Table Editor is centered within a box/border. This feature is only available
for when signifying the text in [Browse Text Table].

4.6.3 ����� Selecting the index character string
����� Alignment

Here, the text’s alignment can be selected.

This display is used to show single-line alarm messages in response to
changes in the device Word Address data.  Select the message from Direct
Text or Text registered in the Text Table Editor.

Text registered in the Text Table Editor is available only with
GP377/GP77R/GP2000 Series units.

� Message Display [General Settings] Attributes
Enter Comment
data here

Select the
Word or Bit
Address to be
monitoredThe currently

selected Part
Shape is dis-
played here

Calls up the Part
Shape Browser;
Part Shapes can
be selected
directly from the
Browser

Select a Border
color
Select the type
of alignment
desired for the
text of the
Display

Select a
Character Size

Select the
Operation
Mode

� Mode
There are two methods to change messages displayed on the Message
Display, i.e. via Bit’s turning ON/OFF and Word state changes. Here, select
either mode.

Mode: When selecting Bit
Messages will change according to the specified Bit Address’s ON/
OFF changes.

Left Right

Center

Centers the Text registered
in the Text Table Editor
within a box/border
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Num bers of
M essages

Num ber of
Bits Used

2 1
4 2
8 3

16 4

When the value set in
the No. of Messages is
16, bits 00 ~ 03 are
used. When the value set in the

No. of Messages area is 4,
bits 00 and 01 are used

When the value set in the
No. of Messages area is 2,
only bit 00 is used

When the value set in the No. of
Messages is 8, bits 00 ~ 02 are
used

The remaining bits can be
used for other purposes

03 02 01 00

Mode: When selecting Word

Messages will change according to the state changes of the desig-
nated bits, consecutively from the specified Address’s 00 bit.
According to the number of the messages (either 2, 4, 8, or 16), a
bit is automatically assigned from the specified Address’s 00 bit.
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����� Direct

The text entered in the Selected Message field is placed directly as fixed
character strings.

The message is displayed in a single line. Up to 16 types of messages can be
displayed in each Message Display.

����� Browse Text Table

Select or add the Text registered in the Text Table Editor. Two or more lines
of messages can be displayed.

 4.6.3 �Selecting the character string �����Entering the
character string

����� No. of  Messages

The number of the messages (number of states) can be selected from 2, 4, 8,
and 16.

����� Display Characters

Here, the maximum number of characters displayed in a message is selected.
Up to 40 characters can be input.  If the number of a message characters
exceeds the specified value, characters that do not fit in the area will be
truncated.

����� Message Display [Messages] Attributes
(Operation Mode example:  When using Word Address)

Enter the number
of messages
(states) here

Enter the message’s
text here

Enter the maxi-
mum number of
characters only
when "Direct
Text" is selected.

The state indica-
tion buttons appear
according to the
No. of Messages

Copies all the
characters in
the Selected
Message field
to all states
only when
"Direct Text" is
selected.

Select the message’s
(display) Color

Select the
Character Type

Copies the char-
acters in the
Description field
to the Selected
Message field
only when "Direct
Text" is selected.

Deletes the
currently selected
message, and
specifies the
message (and its
color) as unde-
fined.

Select the text type for
the message entry.
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����� Message

According to the No. of Messages, designate a message for each state.

Operation Mode:  Bit 
Designate a message for each state (ON and OFF).

Operation Mode:  Word  
As many buttons as the number of the specified messages will be displayed.
Designate a message for each state.

����� Selected Message

Enter the message in this field with the "Direct" option selected. After
entering a message, the message will be displayed in the selected color(s).
The default value setting is “Undefined”.

 To select the "Browse Text Table" option, refer to 4.6.3
�����Selecting the character string �Entering the character string.

����� Color

Here, each message’s display colors can be selected.
Default settings are = Char. color - White; Plate (background) color - Blue.
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Message No. 0 (When the data in the Word Address is "0"):
None

Message No. 1 (When the data in the Word Address is "01"):
Signal A Operation

Message No. 2 (When the data in the Word Address is "10"):
Signal B Operation

Message No. 3 (When the data in the Word Address is "11"):
Signal A & B Operation

...displays in response
to changes in the Word
Address data.

A message from those listed above, allo-
cated to the specified Word Address...

Placing a Message Display
The Message Display setting procedure is shown below.  (When using a
Word Address in "Direct Text" mode)

PROCEDURE R E M A R K S

Enter M0064

(1)Select the [Parts] menu - [Message Display] com-
mand, or click on the   icon.

(2)In the [General Settings] tab, input a Word Address.
Select the message’s Border Color, Text Alignment and
Character Size, if desired.

 2.1 Parts  Select-
ing a Part Shape

(3)Select a Part Shape from the Browser.

If the message is displayed on more
than one line with the Index charac-
ter strings, the characters are always
center-aligned.

When a string registered in the String
Table Editor requires more than one
sentence,  the alignment becomes
“Centered”.
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(6)After all of the Part’s attributes have been entered
and selected, click on the  button.
The Message Display’s outline will appear on the Base
screen, next to your cursor.

PROCEDURE R E M A R K S

Enter 16

Enter 4

Enter A Unit
Operating

Select 1

Any characters entered that are over
the limit specified in step (4) will
be cut from the GP’s display.

If the text “Undefined” is not de-
leted, it will be registered and then
displayed as a message.

(5)Enter your Alarm Messages.
Select the message number to be registered and enter
the message.  When displaying a border with no mes-
sage, be sure to delete the words “Undefined”.  Select
Colors and Character Size, if necessary.
(Example) When registering the message “A Unit Op-
erating” as message Number 1:

(4)Enter the number of Messages and number of Dis-
play Characters with the "Direct Text" option se-
lected in the [Message] area.

 If selecting the
"Browse Text Table" option, refer
to 4.6.3 Selecting the character
string Entering the character
string.
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· Changing the state via the Parts State Change Tool Bar after placing a Part
allows you to check each state’s Library display condition.

· Every time a part’s screen is opened, the Part’s state will be reset to 0.

· If a state which has not been defined is designated, the Message Display
may show nothing.  For example, when the number of messages is 16 and
only states 0 to 3 actually have a message registered, designating states 4 to
15 displays only message frames.

To cancel the placement, click on
the  icon.

To  change  the
Part’s size, refer to 2.4.3 Scaling
Up/Down

When the Message Display is
scaled up(larger), the message char-
acters may not be displayed in the
correct position.  In that case, use
the pull down menu [Edit] menu’s
[Align...] command to adjust the
position.

 2.4.9 Align

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s Attribute Settings dialog
box.  Also, clicking on the message
numbers allows you to view the
message’s display status.

2.4.14 Changing
Attributes

(7)Click on the point where the Message Display’s top
left corner is to be placed on the Base Screen.
If necessary, use the Message Display’s handles to alter
its size after placement.
The message, corresponding to the message number des-
ignated in the Dialog box, is displayed on the Message
Display.
Regardless of whether the Message Display is scaled up
or down, the character size will not change.  To change
the character size and position, directly select a charac-
ter inside the text box.

PROCEDURE R E M A R K S
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2.1.23 Date Displays

Enter Comment
data here Select the Data

Format

Select the
Border (frame),
Text and Plate
(background)
colors

Calls up the Part
Shape Browser.
Parts can be se-
lected directly from
the Browser

The currently se-
lected Part’s image
is displayed here

 Data Format

The following display formats are available:

yy/mm/dd
dd/mm/yy
mm/dd/yy
20yy/mm/dd*1

dd/mm/20yy*1

mm/dd/20yy*1

(yy: year, mm:  month, dd:  day)

 Color

The Date Display’s border color, character display color (Text), and interior
color (Plate) can be selected here.

  2.1 Parts  Selecting Colors

 Character Size

The label’s Character Size is selected here.
  2.2.9 Text

Date display data is created using the GP’s internal calendar and formatted
as;

February 11th, 2001, or  01/02/11; however, the date format can be changed.

 Date Display [General Settings] Attributes

*1 The characters used for the display of 2000’s first two characters (“20”) are single-byte
characters.

  7 Segment Display

When this option is selected, numerical values are shown on a 7-segment
display. Only the GP2000 Series supports the 7 Segment Display.

The time is
shown on a 7-
segment
display.
Supported by
the GP2000
Series only.
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Select the yy/mm/
dd format

2.1 Parts  Select-
ing a Part Shape

(4)After all of the Part’s attributes have been entered
and selected, click on the [Place] button.
The Date Display’s outline will appear in the Base screen,
next to your cursor.

(3)Select a Part Shape from the Browser.
If desired, select Colors and Character Size.

(1)Select the [Parts] menu - [Date Display] command,
or click on the  icon.

(2)In the [General Settings] area, select a display format.

 Placing a Date Display
The Date Display placement procedure is shown below.

Only the GP2000 Series supports
the 7 Segment Display.

When a GP type other than the
GP2000 Series is selected and the
"7 Segment Display" option is en-
abled, the following alarm appears.

To clear the alarm, disable the "7
Segment Display" option.

Used to display the date.



2.1 Parts Chapter 2 - Base Screens

2-160 GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

To cancel the placement, click on
the  icon.

To change a Part’s
size, refer to 2.4.3 Scaling Up/
Down

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes

When scaling up or down the dis-
play area, if the  Ctrl   key is pressed
at the same time, the characters will
scale in unison with the border.

PROCEDURE R E M A R K S

(5)Click on the point where the Date Display’s top left
corner is to be placed.
If desired, use the Date Display’s handles to alter its size.
Regardless of whether the Date Display is scaled up or
down, the character size will not change.  To change the
character size and position, directly select the charac-
ters inside the border.
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2.1.24 Time Displays

Enter Comment
data here

Select the
Character Size

Select Border, Character,
and Plate colors

Calls up the Part
Shape Browser.
Part Shapes can be
selected directly
from the Browser

The currently
selected item’s
image appears
here

 Color
Here, the Time Display’s Border color, character display color (Text), and
background color (Plate) can each be selected.

 2.1 Parts  Selecting Colors

 Character Size
The label’s Character Size is selected here.

  2.2.9 Text

 Seconds Display
The time is also shown in seconds. This feature is only available with the
GP2000 Series.

Example: To display "nine twenty-five and ten seconds": 09:25:10

  7 Segment Display
When this option is selected, numerical values are shown on a 7-segment
display. Only the GP2000 Series supports the 7 Segment Display.

Time Display areas can be created, based on the GP’s internal calendar
function.  Time will be expressed in 24 hour format.

(E.g.) 2:25 pm  14:25

Only one Time Display Part can be used per screen.

Time Display [General Settings] Attributes

Supported by
the GP2000
Series only
The time is also
shown in sec-
onds.
The time is
shown on a 7-
segment display.

To clear the alarm, disable the “Seconds Display” and "7 Segment Display"
options.

When a GP type other than the GP2000 Series is selected and the “Seconds
Display” and "7 Segment Display" options are enabled, the following alarm
appears.
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To cancel the placement, click on
the  icon.

To change a Part’s
size, refer to 2.4.3 Scaling Up/
Down

When scaling up or down the dis-
play area, if the  Ctrl  key is pressed
simultaneously, the characters are
also scaled up or down together
with the border.

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.

2.4.14 Changing
Attributes

2.1 Parts  Select-
ing a Part Shape

(3)After all of the Part’s attributes have been entered
and selected, click on the  button.
The Time Display Part’s outline will appear on the Base
screen, next to your cursor.

(4)Click on the point where the Time Display’s top left
corner is to be placed.
Change the size if necessary.
Regardless of whether the Time Display is scaled up or
down, the character size will not change.  To change the
character size and position, select the characters directly.

(1)Select the [Parts] menu - [Time Display] command,
or click on the  icon.

(2)Select a Part Shape from the Browser.
If desired, select Colors and Character Size.

 Placing a Time Display
The Time Display is placed using the following procedure.

Display the time.
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����� Address

Here, either a Bit or Word Address is entered, after first selecting a Type
(either Bit or Word).

����� Mode

There are two methods used to switch the Library images displayed on the
Picture Display; one is Bit access and the other is Word access.  Select either
of these.

Mode: When selecting Bit
Messages will change according to the specified Bit Address’s ON/
OFF changes.

Registered Library items are displayed according to device Word Address
changes.  Parts and Tags, however, cannot be displayed in these displays.
Up to 16 different kinds of Library items can be displayed on a single
Picture Display.

2.5 Libraries

The Picture Displays will not be displayed on the GP when
transferred, if the GP has not been connected to the PLC yet.

����� Picture Display [Description] Attributes.

2.1.25 Picture Displays

Enter Comment
data here

Enter the
Address to be
monitored
here

Selects the
Operation
Mode

The currently
selected Part
State’s image
appears here
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Num bers of
M essages

Num ber of
Bits Used

2 1
4 2
8 3

16 4

When the value set in
the No. of Messages is
16, bits 00 ~ 03 are
used.

When the value set in the
No. of Messages area is 4,
bits 00 and 01 are used

When the value set in the
No. of Messages area is 2,
only bit 00 is used

When the value set in the No. of
Messages is 8, bits 00 ~ 02 are
used

The remaining bits can be
used for other purposes

03 02 01 00

Mode: When selecting Word
Messages will change according to the state changes of the desig-
nated bits, consecutively from the specified Address’s 00 bit.
According to the number of the messages (either 2, 4, 8, or 16), a
bit is automatically assigned from the specified Address’s 00 bit.

����� Browser

When clicking on the  button, the Library Browser (Library list)
will appear.  Select a desired Library from this list and drag it to the inside
of the Library image display border on the Dialog box.

  2.5 Libraries

Displays the
currently
selected
Library image

Calls up the
Library Browser.
Library items can
be selected
directly from here

Deletes the
currently selected
Library item

Selects the item’s
background and
foreground colors
(used for clearing)

Reflects the
currently
selected item’s
designated
state

����� Picture Display [Library Image] Attributes
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����� Delete

The selected Library item is deleted and the display will disappear.

����� No. of Lib.

Displays only when Type’s Word is selected. The number of Library images
(number of states) to be displayed on the Picture Display can then be input.
Select any of 2, 4, 8, or 16.

����� Library

Here, the Library item used for each state is specified.  Settings will differ
depending on the Type selection.

Mode: When selecting Bit
Specify a Library item’s ON and OFF states, respectively.

Mode: When selecting Word
The n.umber of buttons will match the designated number of
Library items.  Specify a Library item for each state.

Changing the state via the Parts State Change Tool Bar after placing a Part
allows you to check each state’s Library display condition.

����� Color

The background square colors (Clear Fg, Clear Bg)) and pattern (Pattern)
are selected.  The default settings are black.  The square colors can be
selected so as to match the Picture Display placement area background’s
color.
<Back Ground Square>
The Library item to be displayed while the GP is running needs the filled
square for the background to be the rearmost, so that the items(images) do
not overlay each other when they are switched.  When designating a Library
item, the GP-PRO/PBIII for Windows program will draw this colored square
automatically.
Right after the Library item(s) is/are placed, the background square will match
the size of the largest Library item designated.  After the items are placed, it
can be scaled larger or smaller, independently from the Library items.
For a state with no designated Library item, only a background square will
be displayed and it will become the Library’s deletion screen, i.e. it will be
overlaid on top of an existing item to “delete” that item.
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����� Placing a Picture Display
The Picture Display’s creation procedure is shown below.

The 3 pictures registered as libraries, as illustrated above, will change
in response to changes in the state of Word Address D00250.
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Enter D00250

Select Word

Enter 4

(3)In the [Library Image] area, input the No. of library
items (No. of Lib.) used.

(1)Select the [Parts] menu - [Picture Display] command,
or click on the  icon.

(2)In the [General Settings] area, enter an Address and
select a Mode.

State 0
(When the Word
Address is "00")

State 3
(When the Word
Address is "11")

State 2
(When the Word
Address is "10")

State 1
(When the Word
Address is "01")
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Select 0

2.5 Libraries

2.5 Libraries

To select a Library from a file dif-
ferent from the currently displayed
one,  click on the Library Browser’s

 icon.

(6)Drag the selected item to the Dialog box’s black item
display area.
Select foreground or background Colors, if desired.

(5)Select a Library to be displayed for state 0 from the
Browser.

(4)Select a state (to register an item as), and then click
on the  button.
Here, perform settings for state 0.

Item Display Area

10: on

10: on
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· Every time the screen is opened, the state will be reset to 0.

· If a state with no Library registered is designated, nothing will be displayed
on the Picture Display. For example, when the number of messages is 16
and only states 0 to 3 actually have a message registered, designating states
4 to 15 displays only background square frames.
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To cancel the placement, click on
the  icon.

Double-clicking on any Part placed
on the screen automatically calls up
that Part’s attribute settings.  Also,
switching the states allows you to
view the Library display status.

2.4.14 Changing
Attributes

Changing the state via the Parts
State Change Tool Bar after plac-
ing a Part allows you to check each
state’s Library display condition.

To delete a Library item, click on
the  button.

(7)For States  and  , repeat steps (4) ~ (7).  Since
State  is used to delete Library item from the screen,
nothing is specified for it.

(8)After all of the item’s attributes have been entered
and selected, click on the  button.
The Picture Display’s outline will appear on the Base
screen, next to your cursor.

(9)Click on the point where the Picture Display’s top
left corner is to be placed.
Here, the Picture Display’s border (dotted line or filled
square) and the Library item will appear.  At this time,
the Library item corresponding to the state currently se-
lected in the Dialog box is displayed on the Picture Dis-
play.
Regardless of whether the Picture Display’s border is
scaled up or down, the Library item’s size will not
change.  The border size is common through all the Li-
braries.  The Library item’s size and position can be al-
tered by clicking directly on its inside border.



2.1 PartsChapter 2 - Base Screens

2-169GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

2.1.26 Window Parts

Calls up the window onto the Base Screen (B). Register the windows to the
Window Registration via the Window Screen (U). This operation is easier
than using the U-tag.

����� Window Parts Attributes

This displays
the Window
Number of the
window
registered on
the Window
Screen (U).

Select the Win-
dow Number you
want to call up
onto the Base
Screen (B).

Specify the
Window Control
Address.

Preview the
window associ-
ated with the
selected Win-
dow Number in
this area.

����� Window Control Address

Enter the address to control the Hide/Show status of the windows.
  15                                      02       01        00 Bits

Show[0]: Hide the window
[1]: Show the windowChanging the order of window layer

[0]: Touching the window will
change the order of the layer.

[1]: Touching the window will NOT
change the order of the layer.

 3.7.1  Overview of Window Display, 3.7.2 Window Registration
  on the U Screen

Enter comment
data here.
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����� Placing Window Parts
Procedure for placing Window Parts will be shown below.

O
F
F

O
N

O
F
F

O
N

Show window

Window
Display

Window
Display

Place a window (such as a bar graph for Window Registration on the Window
Screen (U)) on the Base Screen (such as B2). (Call up the window.)
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(1)Select [Window Parts] from the [Parts] menu or

click the   icon.

(2)Select the window to be displayed on the Base
Screen (B) from the "Window Number" field.
Specify the Window Control Address as well.

 For Window Regis-
tration of parts on the Window
Screen (U), refer to 3.7.2 Window
Registration on the U Screen.

(3) Click the  button after setting all at-
tributes.
The border of the window area is displayed on the
drawing area.

(4)  Click on the point where the Window Part is to
be placed.

When the specified area is over-
lapped by objects on the Base Screen,
the object will be hidden while the
window is displayed.
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2.2      Drawing

Straight lines, rectangles, and oval objects can be drawn, using drawing
tools.

An object’s attributes such as line types and colors are designated in its
dialog box. After designating the object’s attributes, move the cursor and
start to draw the object directly in the drawing area.

These objects can also be drawn via the Keypad and Trend Graph screens.Note:

[Draw] →→→→→

Usage Pattern

Select a drawing
command

Set any attributes Draw the object→→→→→ →→→→→

Select a desired drawing icon from the
Draw Tool Bar.

����� Drawing Tools
Icons contained in the Draw Tool Bar and their corresponding drawing
objects are as follows:

����� Selecting Line Types
10 selections are available for straight and poly-lines, and for graph divi-
sions. 6 selections are available for rectangles, circles, arcs and pie sections.

Select one of these
patterns

Icon Object Types Icon Object Types
 Dot Filled Polygon

Line/Poly-line Scale

Square/Rectangle Text

Circle/Oval Load Screen

Arc/Pie Load Mark

Fill

or
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Select a pattern

When a square or circle is drawn, only the line type will be displayed ini-
tially.  To display the pattern selections, check the Fill check box.  (check
mark will appear)

����� Selecting Colors
For color and blink attribute settings, use the procedure same as for Parts.

2.1 Parts ����� Part Attributes - Selecting Colors

����� Tiling Patterns
Nine different tiling patterns are available.  These patterns can be selected
for squares, circles, filled squares and polygonal objects.  When combining
foreground (Fg) and background (Bg) colors, a variety of filled patterns can
be drawn.
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If an arrow ( ) is selected, the
line’s end point will become an ar-
row.

When using the keyboard to draw
a dot, move the cursor to the de-
sired point and press the  key.

To cancel/delete the dot, click on

the  icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s Attribute Set-
tings dialog box.

2.4.14 Changing
Attributes

����� Creating a Dot

(1)Select the [Draw] menu - [Dot] command, or click on
the  icon.

(2)Set the attributes of a dot to be drawn.
Select a dot type and colors, if desired.

(3)Move the cursor to the drawing area.  A dot will be
drawn at the point clicked on.
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2.2.1 Dot

Dots can be drawn in 1, 2, 3, and 5 dot units.  To draw a dot, simply click on
the desired point.

����� Dot Attributes

Select the dot unit used
for drawing

Select colors and blink-
ing, if desired

Displays the currently
selected dot’s image
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In order to draw a line, simply click to designate the line’s start and end
points.  A continuous straight line can also be drawn; holding down the
key allows you to draw lines at precisely 0°, 45°, or 90° angles.

����� Line/Polyline Attributes

2.2.2 Line/Poly-line

Selects a line type
(with or without
arrows)

Selects a line
type

Select a color, and
blinking, if desired

The currently selected
line’s image appears
here

When drawing a polyline, check this box

����� Drawing a (Straight) Line
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(1)Select the [Draw] menu - [Line/Poly-line] command,
or click on the  icon.

(2)Set the attributes of a straight line to be drawn.
If necessary, select the color and line type.

(3)Move the cursor to the drawing area, click on the
line’s starting point and drag the mouse to the end
point.

In step (4), while holding the
key down, a straight line at an
angle of either 0, 45, or 90 degrees
can also be drawn.

When using the keyboard to draw
a straight line, use the arrow keys
to move the cursor to the start and
end points and press the  key,
to start and finish the line.

Ctrl
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(4)Click again; a straight line is drawn (registered). To cancel the placement, click on
the  icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.4.14 Changing
Attributes

����� Drawing Polylines
When the Polyline check box is checked, Polylines can be drawn.  Click on the
starting point then drag the mouse, clicking the left mouse button at each point of
the desired directional change of the line; and, click on the right mouse button at
the end point of the line.

· When drawing, if the Keyboard’s           key is pressed instead of clicking
on the mouse right button, the start and end points of a polyline object will
be automatically connected.

· You can draw a line that looks hand-drawn by holding down the mouse’s
left button when drawing a polyline.

Note:
C

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S
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To draw a square, click on and designate the diagonal two points.

To draw a regular square, perform this operation while holding down the
        key.  By selecting a pattern before drawing, a filled square also can be
drawn.  Both normal (non-filled) and filled squares can be beveled.

����� Square Attributes

����� Square Shapes and Beveling types

Square shapes and beveling types are as shown below.

Not beveled.

All corners are beveled with straight lines.

All corners are beveled with arcs.

When selecting Beveling, input a bevel dot number.

2.2.3 Square/Rectangle

<Filled Square/Rectangle Setting Screen>

Selects the type of
Square/Rectangle

Selects a line
(border) type

Select a Color and
blinking, if desired

When selecting
Corner, this
number desig-
nates the num-
ber of dots used

Displays the
currently se-
lected Square/
Rectangle type

Check this check box when draw-
ing a filled Square/Rectangle

Select one of the
tiling patterns

Ctrl
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����� Drawing a Square/Rectangle
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(1)Select the [Draw] menu - [Square/Rectangle] com-
mand, or click on the  icon.

(2)Set the attributes of the square/rectangle to be drawn.
If desired, select the colors, line types, beveling type and
dot.  When drawing a filled square, check the Fill check
box, instead of selecting line types.

Select a pattern

(3)Move the cursor to the drawing area and click on the
first of the diagonal’s points, “a”.

(4)Click on the diagonal’s other point “b”.
The rectangle is automatically drawn (registered).

a

2.2.3 �����  Square
Attributes, �Square Shapes and
Beveling types

In step (4), hold down the           key
to draw a square.

When using the keyboard to draw a
square, use the arrow keys to move
the cursor to the rectangle’s two di-
agonal points and press the  key
to start and finish the rectangle.

To cancel the placement, click on
the  icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.4.14 Changing
Attributes

Ctrl
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2.2.4 Circle/Oval

To draw a circle or an oval, click on its center point and drag the mouse to
the circumference point, and click again.  Holding down the         key draws
a perfect circle.  To draw a filled circle or oval, select the desired pattern.

����� Circle/Oval Attributes

<Filled Circle/Oval Setting Screen>

����� Drawing a Circle/Oval

(1)Select the [Draw] menu - [Circle/Oval] command, or

click on the  icon.

(2)Set attributes of an oval to be drawn.
Select colors and a line type, if desired.  To draw a filled
oval, check the Fill check box and select a pattern, in-
stead of selecting a line type.

Select a Pattern
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Displays the
currently selected
Circle/Oval image

Ctrl

Select a Line/
Border type

Select a Fg and
Bg color, and
blinking, if de-
sired

Check this check
box, if a filled Circle/
Oval is desired

Select one of the
Tiling patterns



2.2 DrawingChapter 2 - Base Screens

2-179GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(3)Move the cursor over the drawing area, and click on
the center point, shown here by “a”.

(4)As the cursor is moved, the oval will expand or con-
tract.
Click on the point shown by b.  The drawn oval will be
registered.

In step (3), if the            key is held
down, you can draw an oval which
contacts a specified area (i.e. the
side(s) of a square).  This function
is useful when drawing an inscribed
circle and can also be used in step
(4), together with the         key.

To draw a regular circle, hold the
       key down in step (4).

When using the keyboard to draw
an oval, use the arrow keys to move
the cursor to the center point and
then, to the point which defines its
circumference (radius point), press-
ing the  key each time.

To cancel a drawing action, click
on the  icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.4.14 Changing
Attributes

Shift

Ctrl

Ctrl

a



2.2 Drawing Chapter 2 - Base Screens

2-180 GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

2.2.5 Arc/Pie

To draw an arc or pie, a portion of a circle must be selected.  You will need
to first draw a circle, and then, click on the arc’s beginning and end points.

����� Arc/Pie Attributes

Select one of
the line/border
types

Select the Color
and Blink set-
tings, if desired

Displays the
currently selected
Arc/Pie image

Check this check box when
drawing a Pie

����� Drawing an Arc
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(1)Select the [Draw] menu - [Arc/Pie] command, or click

on the  icon.

(2)Set the Arc’s attributes.
Select Colors and line type, if desired.

(3)Move the cursor to the drawing area and click on the
oval’s center point “a”.

a

In step (3), if the            key is held
down, you can draw an oval which
contacts a specified area (i.e. the
side(s) of a square).  This function
is useful when drawing an inscribed
circle and can also be used in step
(4), together with the          key.Ctrl

Shift
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(4)Click on the oval’s radius point “b”.
An oval will appear and the arc’s base line will be dis-
played.

(5)Click on the arc’s start point “c” or on its elongation.

(6)Click on the arc’s end point “d”.
The arc will be drawn (registered).

In step (4), holding down the
key draws a circular arc.

Ctrl

When using the keyboard to draw
an arc, use the arrow keys to move
the cursor first, to its center point,
then, to another point on its circum-
ference (radius point), and then, to
its start and end points.  Press the

 key after specifying each of
these points.

To cancel the drawing action, click
on the  icon.
Double-clicking on any object
drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.4.14 Changing
Attributes

����� Drawing a Pie (Sector)
Follow the same steps used for the drawing of Arcs.

When using the same procedure to draw an Arc:
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To use the Fill command, simply left-click your cursor on top of an object’s
enclosed area.  The selected Fill pattern will then spread outward until it
reaches a boundary.  A boundary can be any line or Fill that is the same
color as that chosen for the Fill’s foreground, background, or border.

<Cautions when Filling an Object>
 yyyyy  Be sure that the area to be filled is completely enclosed with

solid lines.  Dotted lines can not be used as an enclosure.
yyyyy A space of only one dot on the border of  an enclosed area is

enough to allow Fill to leak into other areas of the screen.  Be
especially careful when drawing polygon vertexes and filling
an object while the display is set to 50%.
yyyyy DO NOT attempt to fill objects that have been designated as

blinking.
yyyyy When filling an image that uses an arc, Fill may leak when

that image is actually displayed on the GP panel display.  To
prevent this, use a line to connect any gaps in the image.

����� Fill Attributes

2.2.6 Fill

· To select the background color for all the screens used, use the [Option]
menu’s [Screen Settings] command.

 2.10.2 ����� Setting Screen Property - [Color]
· To cancel the application of a Fill due to a mistake, such as having desig-

nated the wrong Fill point, press the          key.Esc

Note:

Select one of the
tiling patterns

Select a Color

Displays the
currently selected
Fill type
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Left-clicking on a line will not
cause it to be filled.  Be sure to only
click in an area enclosed by lines.

When drawing via the PC’s key-
board, press the  button to indi-
cate a fill point.  Fills and fill points
can be specified to either display
or not display via the drawing
board.

2 . 1 0 . 2  S c r e e n
Property  Settings
To cancel Fill due to a mistake, such
as designating a wrong Fill point,
press the          key.

To cancel the filling, click on the
 icon.

Double-clicking on a filling point
of any filled object drawn on the
screen automatically calls up that
filled object’s attribute settings.

2.4.14 Changing
Attributes

����� Filling an Object
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(1)Select the [Draw] menu - [Fill] command, or click on

the  icon.

(2)Set the attributes.
Select Colors and Tiling Patterns, if desired.

(3) Move the cursor to the drawing area and click on
the area to be filled.
The designated area will be filled in.

Esc

Fill spreads outward from the se-
lected point until it reaches a bor-
der with one of the colors (Fg, Bg,
Bd) selected in step (2).

Select the same color for the Bd
(border) Color and boundary Fg
(foreground) Color.
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To draw a Polygon, either left-click or press the  key to indicate the
Polygon’s vertices.  To complete the Polygon, either right-click or press the
       to automatically connect the beginning and end points.
Holding down the         key while drawing a Polygon will snap the polygon’s
segments to 45 degree angles.

����� Polygon Attributes

2.2.7 Line / Polygon

C
Ctrl

����� Drawing a Polygon
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(1)Select the [Draw] menu - [Filled Polygon] command,

or click on the  icon.

(2)Set attributes of a polygon to be drawn.
Select Colors and Tiling Pattern, if desired.

(3)Move the cursor to the drawing area and click on the
start point “a”.

a

Select one of
the tiling pat-
terns

Sets the Color
and blinking, if
desired

Displays the
currently se-
lected Polygon
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(4)Left-click to designate the positions of the Polygon’s
vertices.
Repeat this for as many vertices as needed.  Here, points
b and c are also shown.

(5)After defining the final vertex, c, right-click or press
        to complete and fill the Polygon.
Points a and c are joined and the object is filled.

Up to 100 corners (faces) can be
created.

In step (4), holding the           key
causes lines to be drawn at exactly
0, 45, or 90 degree angles.

Ctrl

To cancel the drawing, click on the
 icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.4.14 Changing
Attributes

· About Filling a Polygon

When a polygon’s segments overlap, the filling alternates, so that areas next
to each other do not display the same pattern.  As a result, areas without
any fill (white) may develop inside the polygon.  If fill is desired in these
areas as well, click on the  icon.

Note:

C
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2.2.8 Scale

To draw or create a Scale, input the number of divisions desired and then
left-click the mouse’s cursor to designate the scale’s beginning and end
points.  Scales can be either horizontal or vertical, linear (straight line) or
curved (semi-circle).

����� Scale Attributes

����� Drawing a Scale
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(1)Select the [Draw] menu - [Scale] command, or click

on the  icon.

(2) Set the attributes of the divisions to be marked.
Select the Scale’s colors, line type, and Scale type, and in-
put the number of scale divisions.  If “Linear” is selected as
the type, select the orientation direction by clicking on the
Vertical check box.  (Unchecked means Horizontal)

Select the
Scale’s type

Select the line
type

Select the Color and
blinking, if desired

(Only with straight
line Scales) Changes
the scale’s orienta-
tion to vertical
(default is horizontal)

Displays the cur-
rently selected
object’s image

Enter the number of divisions desired

<Number of Divisions>

When the number of the divisions
is specified as 8, a total of 9 divi-
sion lives will be displayed.

(i.e. the number entered +1)
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The following explanation is divided into two parts; first,
when creating a linear type scale, and second, when
creating a curved type scale.

[Creating a Linear type scale- (Vertical, with 8 divi-
sions)]
Specify the area of division lines by a rectangle.

(3)Use the mouse’s cursor to create a rectangle in the
drawing area, i.e. left-click to indicate the linear scale’s
start point, a.

(4)Complete the rectangle by left-clicking on the Scale’s
end point, b.
The rectangle shape will disappear, and be replaced by
division lines.

[Creating a Curved type scale- (8 divisions)]
Specify the area of division lines, using double circles.

(3)Use the mouse’s cursor to create a circle on the draw-
ing area, i.e. left-click to indicate the curved scale’s
start point, a.

Holding down the          key while
performing step (4) will draw a per-
fect square.

When using the keyboard to per-
form drawing, press the  key to
designate the start and finish points.

To cancel the drawing, click on the
 icon.

Ctrl
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(4)Click on the radius point “b”, which is of a scale’s
outer circle.

(5)Draw another circle inside the circle drawn in step
(4) to decide the width of the scale. Click on this in-
ner circle’s radius point “c”.

(6)Rotate the displayed segment and click on the scale
start point “d” or on its elongation.

(7)Then, rotate the segment again until you reach the
desired end point e, and click to designate the end of
the scale’s divisions.
Division lines appear inside the area surrounded with
the double circles and the two segments.  They will be
drawn clockwise from the start point to the end point.

When using the keyboard to draw
divisions, press the  key after
moving the cursor to the division
circle’s center point, to the other
point on its circumference (radius
point), and then to the divisions’
start and end points.

To cancel the drawing, click on the
 icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.4.14 Changing
Attributes
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2.2.9 Text

From the keyboard enter the text and then place it on the screen.  This
software has two methods of placing text on the screen.  The first method
defines the placement point, and the second defines the area where the text
will be centered.

����� Text Attributes
Select the type of text.

Select the text’s display
direction. (This feature
is not available with
Image Font.)
Select the Fg and Bg
colors, and blinking.

Displays a sample of the
current text’s attributes.

Specify the character
size.

Select the style of the
text. (This feature is
not available with
Image Font.)

Enter the text used as
direct text.

Select the desired font
when using Image Font
for Direct Text.

�����  Direct Text

The text entered in the text entry field is placed directly as a fixed text string.
A maximum of 100 characters can be entered per line, and 100 lines per
screen.

�����  Browse Text Table

Select and add the Text registered in the Text Table Editor.
4.6.3  ����� Selecting the index character string  ����� Entering

   the index character string

����� Image Font

Text using Windows fonts is displayed in bitmap format. This feature is
enabled only when "Direct Text" mode is selected.

Image Font is supported by the GP-2000 series only.

Click the  [Select Font] button and specify the Font, Style and Size settings.

Note:

Displays a sample of the
current text’s attributes

When selected/enabled,
the string’s Bg (back-
ground) color becomes
transparent.
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· When Image Font is selected, the [Style] and "Vertical" text ("Vertical"
under the "Direction" setting) cannot be specified.

· Image Font increases the size of the Project file. We recommend that the
"Compress" setting be enabled.

· The maximum capacity of one text string is 50KB when Image Font is used.

Note:

Capacity of text
with Image Font

(Bytes)

(Number of dots
for text width/8)

Number of dots for
text height= X

����� Compress

This feature is enabled only when the Image Font option is selected.  The
Image Font is compressed to one-half its original size. (The compressed size
may vary depending on the text.)
However, compression is not executed when the compressed character size
becomes larger than the original size. The "Compress" setting is cancelled
after the setting is confirmed by pressing the [OK] button.

����� Character Size

Clicking on the font size display area, displays the current character size
(used after text is placed on the drawing area).  Move the cursor to where the
X and Y axis lines cross, and drag the cursor.  As the axis lines move, the
character size will change.  Click on the text block again, or press the 
key to register (enter) the change.

· Half-2 Byte Character (Only Chinese, Taiwanese and Korean OS - not
available with GP-270 Series units.) can be used with Text strings, Bit
Switches, Word Switches, Function Switches, Toggle Switches, 4-State
Switches, Lamps and Message Displays.

· Be aware that using Half-2 Byte Character feature may cause certain
characters to change to garbage-characters that cannot be used.

Note:

1 x 1 8 x 8 16 x 16 8 x 16 16 x 8 16 x 16
2 x 2 16 x 16 32 x 32 16 x 32 32 x 16 32 x 32
4 x 2 32 x 32 64 x 64 32 x 64 64 x 32 64 x 64

Half Full
Character

Size
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· The Text Size can be selected as a multiple of any whole number from 1
through 8 with the GP2000 series and as either 1, 2, 4 or 8 with other
models.

· Specify the point size when the Image Font option is selected. You can also
specify the point size by clicking the [Select Font] button and selecting the
font size in the [Size] field.

· When the text is zoomed in or zoomed out while the           key is pressed
under Image Font mode, the text may exceed the frame of the system part.

The special extended font sizes are available only when entering single-byte
numbers or symbols (6 x 10 dots/ 8 x 13 dots/ 13 x 23 dots).

· These extended fonts can also be used with Parts and Tags that allow you to
modify the size of entered text characters. (not available with CSV and
Logging data displays)

· Since extended font sizes are fixed, objects containing these characters
cannot be enlarged or reduced while pressing down on the          key.

· 7-segment display of parts is not available with this feature.

Note:

Ctrl

Note:

Ctrl

· When [Transparent] is selected or when text character backgrounds (Bg) is
specified to Black + Blk (Blink), transparent mode is used, thereby display-
ing that area as transparent. For 256-color mode, select the last (255th)
color, which is “Clr”.  However, for the GP unit with three blink speeds, this
mode can be specified only when the “Mid” speed is selected.  If an object
has been drawn underneath these characters, they (the characters) will
appear transparent, showing the object behind.  This function is useful
when overlaying text on objects, i.e., over the face of Switches and Lamps.

 2.1 Parts ����� Part Attributes-Selecting Colors

· You cannot specify the style when Image font is selected.

����� Style

Characters can be either Normal, Bold, or Raised.

Note:
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����� Entering Text

����� Changing to a New Text Line and Line Settings
When entering characters, simply press the  key to move to a new line.
When there are 2 or more lines of text, icons will appear to allow adjust-
ments in line spacing, and justification.

����� Justification

Horizontal text’s alignment can be changed to either Left, Center, Right or
Full justified.

Right justified

Left justified

Centered

Controls the
selected
text’s
justification

Full justified

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Select the [Draw] menu - [Text] command, or click

on the  icon.

(2)Set the attributes of the characters to be input.
Select Colors and Character Size, if desired.

The attributes can also be entered
and selected after entering text.

When “Raised” is selected for
Character Type, the border color
(Bd) will become shadowed (i.e.
3-D).

When selecting [Browse Text
Table]:

4.6.3 ����� Select the
character string ����� Enterinig the
character string
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(3)Click on the text field to input characters, via your
PC’s keyboard, when selecting [Direct].
Simply clicking on the text field allows you to input char-
acters there.

Hereafter, two text alignment cases will be explained, one
not using and one using the Centering function:

<When Centering function is NOT used>
(4)Move the cursor to the drawing area and click on any

desired point.
After clicking on a point in the drawing area, a text box
the size of the selected character will appear on the screen.
The top left corner of the text box is the base point used
for positioning.

When using your PC’s keyboard
to enter text, press the  key to
designate a position.

·When the Image Font is selected, the
"Direction" (Vertical/Horizontal) and
"Style" text settings are disabled.

(5)Move the cursor to the desired position and left-click
the mouse to place it on the screen.

Shift

To cancel the placement, click on
the  icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.4.14 Changing
Attributes<When the Centering function IS used>

(4)Move the cursor over the desired placement area and,
while holding down the               key, click on any
desired point.
After clicking on a point in the drawing area, the text
box  will appear on the screen in dotted line.
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· GP-PRO/PBIII for Windows uses the PC’s font.  As a result, the text that
you see on the GP display and that shown on the PC may differ.

· In both GP-PROIII and GP-PRO/PBIII (DOS Ver.), when an object is
overlaid on a text block, the text block will be displayed in the foreground.
With GP-PRO/PBIII for Windows, however, the text block will be placed
behind the object.  When the GP-PROIII and GP-PRO/PBIII (DOS Ver.)’s
data is used in the GP-PRO/PBIII for Windows, the text block will be
displayed in the foreground.

Note:

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(5)Select a centering area that is the same size or larger
than the previously selected text area.
The designated size’s text box will appear in the center
of the selected area.

To cancel the designated area, click
the right mouse button.
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Graphics created on screens in a project can be loaded and used repeatedly
on others with GP-PRO/PB III for Windows.  Thus, a single screen’s con-
tents can be used repeatedly elsewhere.  The Load Screen function is also a
good way to cut down on your screen’s actual size, since you only need to
call up items to your screen, not save them on it.

����� Screens that can be loaded to other screens

2.2.10 Load Screens

*1 Up to 8 Trend Graph screens can be loaded onto each Base screen.
However, only one trend graph with the Data Record Display function
can be loaded.

*2 Only one Keypad screen can be loaded onto each Base screen.

The screen currently being edited cannot be loaded on to itself.

If any portion of a Trend Graph screen extends over a Base
screen’s border, the Trend Graph screen will not display cor-
rectly on the GP screen.

Current Screen Loadable Screens
B (Base) screen

T (Trend graph) screen *1

K (Keypad) screen *2

I (Image) screen
I (Image) screen-CF card

B (Base) screen
I (Image) screen

I (Image) screen-CF card
B (Base) screen
I (Image) screen

I (Image) screen-CF card
B (Base) screen
I (Image) screen

I (Image) screen-CF card
U (Window) screen

B (Base) screen

T (Trend graph) screen

K (Keypad) screen
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����� Nesting
Screens can be nested up to 10 times (11 layers).  However, if your PC’s
system memory is low, a loaded screen/object may not be displayed.  Later,
however, when the data is transferred to the GP, the display will appear
normally.

E.g.) Nesting Objects Twice (3 layers)

The load screen nesting condition can be viewed via the load screen nesting
display function.

2.10.9 Display of Screen Level Change Structure

Example)

Drawing
Areas

When using the GP
panel display

When using GP-PRO/
PB III for Windows

If a portion of an Image screen extends over a Base screen’s Y axis border,
that portion will not be displayed on the GP screen.  When the Image screen
is placed over the Base screen laterally, however, any part that extends over
the Base screen X axis border will be squeezed onto the GP screen.(i.e. not
cut)
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(3)Click on the point where the Screen’s top left corner
is to be placed.
The image’s center point is left top corner of its border,
and for other objects, the screen center mark will be the
placement point.

A loaded screen cannot be edited
while it is being used on a different
(i.e. loaded) screen.  You will need
to open the original screen to per-
form any editing.

To cancel the loading, click on the
 icon.

(1)Select the [Draw] menu - [Load Screen] command,

or click on the  icon.

(2)Select a desired screen from the list or enter that
screen’s number directly on the [Screen No.] field via
the keyboard, and then click on the  button.
Then, the screen’s outline and center point will appear in
the drawing area, next to your cursor.

Only screens in the currently used
Project file can be loaded.  Screens
in other project files can not be
loaded.

The current (selected) Screen can-
not be loaded on to itself.

����� Loading a Screen
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When calling up a filled object:

When the current screen’s graphics overlap loaded filled (painted) graph-
ics, depending on the color used, unfilled areas may be created.  To correct
this, add a fill to the current screen’s unfilled area.

       2.2.6 Fill

· If a background color is selected for the screen used for
screen call-up, the object placed on the screen will not be
displayed on the GP.

· To call up the screen for which a background color has been
selected, specify the center of the screen as the call-up posi-
tion and then place the screen.
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2.2.11 Load Mark

Marks (dot images) created in a Mark screen can be loaded and used repeat-
edly on Base/Trend Graph/Keypad/Window screens.

����� Loading a Mark Screen

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Select the [Draw] menu - [Load Mark] command, or

click on the  icon.

(2)Select a desired Mark screen from the list or enter
that screen’s number directly on the [Screen No.] field
via the keyboard, and then click on the  but-
ton.
The Mark’s outline will appear in the drawing area, next
to your cursor.
Designate its color and size before clicking on the [OK]
button, if desired.

(3)Click on the point where the Mark’s top left corner is
to be placed.
If desired, use the Mark’s handles to alter its size.

Only Mark screens in the current
project can be loaded.  Mark
screens in other projects are not
available.

When the screen display size is
50%, the loaded Mark may not be
displayed correctly on the GP-PRO/
PB III for Windows software.

To cancel the loading, click on the
 icon.

To change the
Mark’s size, refer to 2.4.3 Scaling
Up/Down

Double-clicking on any Mark
loaded on the screen automatically
calls up that Mark’s attribute set-
tings.

2.4.14 Changing
Attributes
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This section describes how to convert image data (bitmap: BMP file and
JPEG: JPEG file), created from other drawing software or imported from a
scanner, for use on a GP Image (I) screen.

   For Image Conversion data, refer to 3.5 Creating an
Image: the Image Screen.

����� Converting and Placing an Image

2.2.12 Convert (Import) Image

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(3)Click on the  button.
The data is then saved as an Image screen.

(1) From the munu bar of the screen editor [Draw]
menu’s [Convert Image...] command.

(2)Set all conversion settings and click on the 
button.

Once an image has been converted,
it can be placed on a screen using
the Load Screen function.

2.2.10 Load
Screens

 For each setting
item, refer to 3.5 Creating an Im-
age: the Image screen.

Before conversion, the image dis-
played in the Import Image dialog
box is still compressed and may
appear different from the actual dis-
play (after conversion).

To cancel the conversion, simply
click on the  button.
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(4)Click on the  button.
The Image screen’s border will appear on the current
screen.

(5)Click on the point where the Image screen is to be
placed.
The Image screen will appear on your screen.

To cancel the placement, click on
the  icon.

If the Image screen(I) is placed outside the drawing area vertically, the
portion of the image that does not fit in the drawing area will not be dis-
played on the GP screen. However, if the Image screen is placed outside the
drawing area horizontally, the portion that does not fit will be squeezed so
that it is displayed on the GP screen.

E.g.)

Screen
display
area

On your PC's screen On the GP panel

����� Pasting images with other file formats
The paste function can be used for images copied onto the Clipboard *1.
Executing the [Paste] command from screen editor while a copied image is
in the clipboard will display the "Paste Image" dialog box on the screen. The
“Source” tab will not be displayed on the screen.When images cannot be
pasted with this procedure, convert the images into bitmap files or JPEG
files with other image processing software before copying and pasting it to
the screen editor.

*1 The clipboard is a storage location where copied or cut data is temporarily stored. The
data stored on the clipboard can be copied or moved by pasting it.
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Tags are one of the GP-PRO/PBIII for Windows program’s many powerful
features.  When you create a Tag, you can transform a square on the screen
into a switch, or create an animated display that changes according to data
from the Host PLC.  Tags are created and placed on the screen where you
want a function to be; and, while most of the applications for Tags are on a
Base screen, they can be used with Keypad screens, as well as a variety of
other screens.
Here, topics such as Previously Created Tags, Changing of Tags, and Delet-
ing Tags, are discussed.
For further details of tags, refer to the Tag Reference Manual.

����� Points to Consider when Creating Tags
When creating a Tag, please be aware of the following points:

� When creating a number of tags on identical screens, if one Tag’s posi-
tion overlaps that of another Tag, the Tags will overlap when they are
called up and may not be displayed correctly.  Please be aware of this
when loading (calling up) multiple Tags.

� Using the Copy or Paste functions to place Tags with the same name on
similar screens can make identifying Tags difficult.  It is suggested that
you either change the Tag’s attributes (i.e. name) directly, or use the Tag
Summary to change the name.  When 2 or more K Tags have been used
to operate a common Trigger Bit, it is especially important that the Tag
names used are different.

        Tag Reference Manual 2.12 K-tag (Key Input)
� The maximum number of tags designated on the same screen is as fol-

lows. This total includes tags on any screens that have been called up, or
are included in a window that is used.  The figure below, however, does
not include any k tags or R tags.

Refer to the figure below for the enabled tags.

<Example: when using GP-470>

2.3      Tags

GP Series
GP-470
GP-570
GP-675

GP-270
GP-370
GP-H70

GP-377
GP77R
GP2000

Number of tags 256 128 384

Screen B2 Screen B1 Screen B3

Combined number of Tags = 10(B2) + 25 (B3) + 30(B1) = 65 ≤ ≤ ≤ ≤ ≤ 256

30 tags
(previously

created)

Number of tags can be viewed from the Screen Information in GP-PRO/PBIII.
 4.5.2 Screen Information

10 tags 25 tags

Load
Screen

Load
Screen

25 tags
(B3)

10 tags
(B2)
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� Though all of a Tag’s identifying marks, lines, etc. can be seen on the
screen that it was created on, after that Tag’s screen is called up to a Base
screen, those Marks can no longer be seen and it can not be edited.  In
example 1 above, even though screen tags B2 and B3 are added to B1’s
total tag count, their identification data is not displayed on B1 (Drawing
area, Tag List, etc.) and can not be edited from that screen.  To edit these
Marks, call up the Base screen on which each Tag was specified.

� The order in which each Tag is created is recorded, and when the total tag
count for that screen exceeds 256 (Digital’s GP-H70, GP-270 and GP-
370 count up to 128 tags.  GP-377, GP37W2, GP-377R, GP77R and
GP2000 can use up to 384 tags.), those excess tags are ineffective.  When
the tags used on a screen have been called up from a window, those tags
are added to the total, in the order that the window was called up.  Thus,
when calling up multiple windows for use on a screen, be sure that the
total number of tags used in all the windows does not exceed the above
limit, or certain tags will become invalid.

� Approximately 90 reserved tags are used for the Device Monitor func-
tion.  When using Device Monitor together with regular screen tags, they
must be added to the screen’s total tag count.  Thus, be sure that the tags
used for the Device Monitor are included in your tag count calculation.  If
the total becomes greater than that screen’s limit, the message “Total No.
of Tags is over limit.” will appear.  Until the number of tags is reduced,
there is a possibility that the Device Monitor function will not work
correctly.  If using the Device Monitor function will cause a screen’s total
tag count to exceed its limit, you should not use Device Monitor function
on that screen.

           4.8  Device Monitor

� The actual amount of space required (in bytes) for each tag will vary.
When placing tags on a screen, please consider the number of tags that
have already been created, the size of each tag, and the panel’s tag limit.

Information such as the current screen capacity and number of tags used
can be viewed in the [Screen Information] dialog box.

            4.5.2 Screen Information
For each tag size, refer to the following table.



2.3 Tags Chapter 2 - Base Screens

2-204 GP-PRO/PB III  for Windows Ver. 7.2  Operation Manual

<Tag Size List>

Be aware of the following points:

• The total number of t-tags that can be used on the GP-470, 570, 571, 675
and 870 is 128; with the GP-270, 370, and H70, it is 64; with the GP-377,
GP-37W2, GP77R and GP2000 series, it is 192.

• Only one (1) A, a, and C- tag can be used per screen.
• A total of 30 R tags are possible on one screen.  The total number of

points used for R-tag data can be up to 406 per screen.  However, when
calling up multiple screens, the total points allowable is 512.

• The number of windows that can be displayed on one screen at one time
is up to 3, i.e. one global window and two local windows via the U-tag.

• Tih, and Tiw tags cannot be used on the GP-H70, GP-270, GP-370, GP-
57J, GP-377, GP-37W2, GP-377R and GP2000 series units, since they
do not have AUX I/F Touch Switch output (TSW0 to 7).

Tag Name Function Tag Size
(Byte)

A Alarm Summary Text Display 56
a Alarm Summary Display 34
C Clock Display 28
D Statistic Graph Display 48
d Statistic Data Display 74
E Numeric Data Display extended function 32 to 122
F Free Library Display 42
G Graph Display 40
g Graph Display extended function 38 to 158
H Drawing Object Display 42
J Moving Mark Display 38
K Key Input 46, 58
k Keypad Setup 28
L Library Display 34
I Library State Display 40 to 102

M Mark Display 34
N Numeric Data Display 36
n Alarm Boundary Display 30
P Numeric Display in Predefined Format 118
Q Alarm Summary Display extended function 46, 66, 98
R Rail Settings 20
S String Display 32

T(including Tih, Tiw) Touch Panel Input 36
t Selector Switch Input 56
U Window Display 34
V Video Window Display 30
v Video Window Extended Features 42
W Write to a Device 32
X  Text Data Display 40
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2.3.1 Designating Tags

The tag setting items will differ depending on each tag type.  Here, the basic
setting procedures are described.

After a Tag is selected, that tag’s dialog box will appear.  Here all the tag’s
attribute data, such as the setting address, are entered.  After all of the Tag’s
attributes have been entered, click on the  button and designate the
point or area on the screen where the Tag will function.

Usage  Pattern

[Tag] →→→→→
Select a Tag
from the list →→→→→

Enter the Tag’s
setting data →→→→→

Designate the
functioning area

Select a desired command icon
from the Tag Tool Bar.

or

����� Tag Settings
An example of a Tag’s dialog box is shown below.
In the [General Info] area, the Tag’s name and description data are entered.
Also, the Tag’s general settings are displayed.

E.g.) L Tag

The actual setting items displayed will differ, depending on the tag.

Tag Reference Manual

Clicking here will
bring up the
Screen Access
settings (Items
will vary depend-
ing on the tag
type

Shows the
currently
selected Tag’s
settings

Enter Com-
ment data
within 20
characters here

Enter the Tag’s
name (number)
within 5
characters
here
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����� Setting up Tags
An example of an L tag’s setting procedure is shown below.

GP-PRO/PBIII Tag Settings

Tag Name Lamp L1
Display Mode
Bit Address M0016
Designated Screen Direct:  300
Erase Mode Yes

In order to show a Lamp’s ON and OFF states on the screen, the above
mentioned settings will be used to create a lamp and its ON image.

(1) In preparation, draw a lamp on the screen where the Tag will be posi-
tioned.

(2) Draw an image of the lamp’s lighting area on screen B300 (This image
will be loaded onto the screen’s center point.  Create the image based on
this center mark)

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Select the [Tag] menu - [L-tag] command, or click on
the  icon.

(2)Enter the tag’s name.
If desired, enter a description.

Enter lamp 1

Enter set up
now lamp

A Tag name should be 5 charac-
ters or less.

Tag Reference
Manual, 2.14 L-tag (Library Dis-
play)
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Use the pull down menu [Option]’s
[Screen Property] command to
change the Tag name, setting ad-
dress, and Tag mark display state
(i.e. displayed or not displayed).
(However, these settings will not be
displayed on the GP screen.)

2 . 1 0 . 2  S c r e e n
Property Settings

To cancel the placement, click on
the  icon.

Double-clicking on any Tab regis-
tered on the screen automatically
calls up that Tag’s attribute settings.

2.4.14 Changing
Attributes

(4)Click on the point where the tag is to be used.
How this point is designated will differ depending on
each Tag type.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(3)Enter the required data in the [Designated Screen]
area and click on the  button to register it.

Enter 300

Click on Yes

Enter M0016

If your GP type is the GP77R or
GP2000 series, [Image Screen - CF
Card] can be selected in the [Screen
Type] section.

Select Screen
Type



2.4 Object Editing Chapter 2 - Base Screens

2-208 GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

2.4      Object Editing
Parts, objects, text, and Tags previously placed or drawn (hereafter called
“Objects”), can be edited using various functions, such as Copy and Delete.
To edit an object, first, use the cursor to select the object, and then select the
type of edit operation.

Usage  Pattern

→→→→→
Select an
Object

[Edit]
or

Tool Bar
→→→→→

Select the type of
editing to perform →→→→→

Perform the
editing

����� Types of Editing Functions
Icons contained in the Edit Tool Bar and their corresponding edit operation
are as follows:

*1 This function is enabled only when GP Type selection is a GLC series unit.
  Pro-Control Editor Operation Manual

Some of the editing tools listed above can be selected from the menu dis-
played on the screen by right-clicking the mouse.

Icon Edit Type Icon Edit Type
Undo Group

Redo Ungroup

Cut Bring to Front

Copy Send to Back

Paste Change Attribute

Command Data Paste *1 Change Coordinates

Duplicate Vertex Editing

Delete Transferring Screen to
Clipboard

Align Converting Screen to Bitmap
File

Rotate Left Redraw Screen

Rotate Right Select All

Mirror X-axis Select

Mirror Y-axis
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2.4.1 Selecting Objects

Two methods are available for selecting objects: 1) clicking on an object
directly, or 2) dragging the mouse to enclose and select single or multiple
objects.

Also, you can select individual objects that have other objects either on top
of, or overlapping them.

When the tool bar’s  icon is clicked on (active), an object can be se-
lected.  To activate this icon, click on it directly, or select the pull down
[Edit] menu’s [Select] command.  Also, while drawing objects, right-
clicking anywhere on a desired object allows you to select it.

Either a  or a  mark will be displayed on the sides of the selected object.
These square marks are called “handles”.

Handle Types

There are two types of handles, those that can be used to scale the object and
those that can not.  Refer to 2.4.3  Scaling Up/Down

     :  Can be used to scale the object
     :  Cannot be used to scale

When an object has been be selected, the Selection Tool box will automati-
cally appear.  When multiple objects are selected, all the selection Tool
box’s functions are available.

After selecting either 

or  , clicking on either

 or  selects the next
object or type

Selects all of the
objects in a group

After selecting a group
of objects, selects one
of that group

After selecting a group of
objects, selects one type
of object (i.e. squares,
circles, etc.)

These keys are used to
select Tags when the Tag
box is checked

Objects may be selected using the Screen Data List, instead of selecting them
on the screen.

 2.10.4 Screen Data List
· When the tag check box for the selection tool box is marked with a check,

tags can be selected even if the tag names and marks are hidden.
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����� How to Select a Single Object
Here, the procedure for selecting an object is explained.

[Selecting an Object Directly]
(1)Move the cursor over the object, and left-click.

Handles display on the object to show that it is selected.

[Selecting an Object by Dragging]
(1) Position the cursor near the object and hold the but-

ton down, then drag( this is called “Left-dragging”)
the mouse over the object. As you do so, a “box”
formed by a dotted line will expand to enclose the
object. When the entire object is enclosed within the
“box”, release the mouse button; handles display on
the object to show that it has been selected. You must
position the cursor relative to the object so that when
you Left-drag over it, the entire object will be en-
closed within the “box”; if it is not, then the object
will not be selected. This method is most useful when
selecting multiple objects, described below.

[Selecting an Object from Overlapped Objects]
(1)While holding down the           key, click on an Object

to be selected.
That Object’s handles will appear to reveal it has been
selected.

Ctrl

To select a Tag, check the [Option]
m e n u ’s  [ S c r e e n  P r o p e r t y ]
command’s Tag Mark check box
beforehand.

When selecting grouped objects,
click on any one of the objects in a
group to select the group.

A Part’s Label can be selected in-
dependently from the Part.

Click on a Part to display its handles
and then on its Label to display the
Label’s handles.  After selecting the
Label, it can be moved or scaled in-
dependently from the Part.

Numeric Display and text can also
be selected using the above-men-
tioned steps.

Left-dragging over only a part of the
object will not select it.  The entire
object must be enclosed to select it.

When you wish to select another ob-
ject without de-selecting the previ-
ous one, hold down the                 key
while making the next selection.
This can also be done continually
to select multiple objects.

Shift
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����� How to Select Multiple Objects
Use this operation to select multiple objects.  All the objects in a designated area or
on the entire screen can be selected.  Also, if necessary, some of these objects can be
de-selected.
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[Selecting Multiple Objects by Dragging]
(1)Left-drag over objects as described in Selecting an

Object by Dragging (see above). Be sure to enclose
all of the objects to be selected completely; if part of
an object is not enclosed within the “box”, it will not
be included in the multiple selection. Handles will
display on the objects that have been selected.

[Selecting All the Objects on a Screen]
(1)Select the pull down [Edit] menu’s [Select All Ob-

jects] command.  All object handles will appear, to
show that they have been selected.

To select a Tag, check the [Option]
m e n u ’s  [ S c r e e n  P r o p e r t y ]
command’s Tag Mark check box
beforehand.

Left-dragging over only a part of an
object will not select it.  The entire
object must be specified to make
selection possible.

When two or more objects are se-
lected, the [Change Attributes]
command cannot be used.

The editing commands available
depend on what objects have been
selected.
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[Excluding Objects From A Multiple Selection]
(2)When multiple objects are selected, to de-select an

object while preserving the selection of the other ob-
jects, first  move the cursor over the object; then, while
holding down the           key, left-click on the object.
When the object’s handles disappear, that object is
no longer selected. Repeat this process as many times
as desired.

[Adding Objects To A Multiple Selection]
(2)When multiple objects are selected, to add an object,

either left-click on the object or Left-drag over it,
while holding down the             key.
The imaginary “box” that encloses the multiple selec-
tion (represented by its’ own handles) will expand to in-
clude the added object , which now has handles Using
this process, you can add as many objects to the multiple
selection as you want.

Shift

Shift
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[Selecting One Object in a Multiple Selection]
(2)First, make a multiple selection; then, click on the

Selection Tool box’s  icon. All the objects in the
multiple selection will become de-selected, except for
one.

(3) Use the  and  icons to “scroll” through all the
objects originally in the multiple selection; clicking
on these arrow keys will change the selected item,
one at a time.  Clicking on the  icon will select
the next object, and clicking on the  icon will
select the previons object , inthe order that they
were drawn.

If you wish to re-select all the
objects originally in the multiple
selection, click on the Selection
Tool box’s  button.

To select an Object from over-
lapped Objects.

����� How to Select a
Single Object
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[Selecting Objects by Type from a Multiple
Selection]
(2)First, make a multiple selection; then, click on the

Selection Tool box’s  icon.
Selection handles will appear for only one type of object
(here, only square objects are selected), while an outline
remains around them all.  This will effectively de-select
any objects that are not the currently selected type.

(3) Use the  and  icons to select a different object
type.

     As you press either arrow key, the selected object type
will change.

Objects are classified as follows:
Parts:  by each type,
Objects:  by each type,
Tags:  All as one type,
Loaded Screens and Marks:  All as
one type, respectively.

To re-select all the objects originally
in the multiple selection, click on
the Selection Tool box’s 
button.
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2.4.2 Moving Objects

In this section, the procedures for moving objects are described.

����� How to Move an Object
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(1)Click on the desired object.  The object’s handles will
appear, showing that it has been selected.

(2)Place the cursor over the object, away from the
handles, and after the cursor changes to , drag it
to the desired location.

2.4.1 Selecting
Objects

The keyboard’s        ,       ,       , and
       keys can also be used when the
object’s handles are displayed.

If an object is too small to select
and move (i.e. it is only scaled up
or down), click on and drag the ob-
ject while holding down the  Alt
key.

Also, you can move the object by
zooming out the screen or using the
keyboard.

1.3.2 Display Area
(50%, 100%, 200%)

To cancel the movement, click on
the  icon.

↓↓↓↓↓

←←←←←→→→→→↑↑↑↑↑

· To move an object horizontally or vertically, do so while holding the [Shift]
key down. In this case, the object will be moved in either the horizontal or
vertical direction where the moving distance is greater.

· To move and scale up/down an object, designating its coordinates can be
used.

2.4.15 Changing Coordinates
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· When re-sizing an object while holding down the          key, lines will snap to
45 degree intervals, Rectangular and Scale (Linear) objects will become
square-shaped objects, and ovals will become circles.  Also, if the            key
is held down, all selected Lines, Rectangles, Ovals, Scales, Text and loaded
Marks will scale up or down proportionately.

· When scaling a Part with a Label, holding down the         key causes the
Label to scale up or down together with the Part.

· When selecting an oblique line, 8 handles will be displayed.  Click on the
line again and 8 handles will change to 2 handles, one at either end.  Click-
ing and then dragging on one end’s handle “fixes” the opposite end in place,
and “releases” the dragged end, and allowing the line to pivot freely.

· Multiple parts may be selected and then scaled up/down. However, the
following parts are not scaled up/down, but their positions are moved:

· Half-pie Graphs, Pie Graphs, Meters, Trend Graphs, Alarms, Keypads, and
Picture Displays.

· To move and scale up/down an object, designating its coordinates can be
used. 2.4.15 Changing Coordinates

· When scaling the text with the Image Font, the text alone may exceed the
scaling range.
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2.4.3 Scaling Up/Down

(1)Click on the object to select it.  The object’s handles
will appear to show that it is selected.

(2)Place the cursor on an object’s handle, and after the
double arrow cursor appears, drag the handle to re-
size the object.

Scaling means changing the size and proportion of an object. This function
allows you to easily scale an object up (larger) or down (smaller).  Be sure
the object’s handles are displayed as (  ).

����� Scaling An Object

2.4.1 Selecting
Objects

Re-sizing will depend on which
handle is dragged:

Ex. To scale a square up or down:
Corner Handles = proportionally
Top/Bottom handles = vertically
Right/Left handles = horizontally
Place the cursor on one of the
handles of the object. When the
cursor becomes ↔ ,  use the
keyboard’s either        ,       ,       , or
     key to scale the object up or
down in the unit of dot.

To cancel the re-sizing, click on the
 icon.

Note: Ctrl

Shift

↓↓↓↓↓

←←←←←→→→→→↑↑↑↑↑

Ctrl
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2.4.4 Cut

Here, the procedure for “cutting” an object (deleting it) and placing it on
another screen, is explained. The object can also be placed elsewhere on the
same screen, instead of using the Move procedure described in section 2.4.2.
In addition, an object can simply be “cut” (deleted), and not placed any-
where. (When an object is “cut”, it is stored in the Clipboard*1.)

����� Cutting (Moving) an Object
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(1)Select an object.

(2)Select the [Edit] menu - [Cut] command, or click on
the  icon.
Then, the selected object will be cut.

(3)Open the object’s destination screen, and select the
[Edit] menu - [Paste] command, or click on the 
icon.
Then, the outline of the object cut from the previous
screen will appear.

(4)Position the cursor and click on the point where the
object is to be placed.
The object that had been Cut from the previous screen
will be “pasted” at the new location.

2.4.1 Selecting
Objects

To cancel the Cutting, click on the
 icon.

To cancel the pasting, click on the
 icon.

*1 An area where text, graphics, or both, that have been Cut or Copied, are temporarily
stored. The contents of the Clipboard can be “pasted” (copied from the Clipboard)
using the Paste function. However, once the Copy/Cut command is executed, the data
stored in the Clipboard is replaced; therefore, only the data from the most recent Copy/
Cut command can be pasted.
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2.4.5 Copy
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Here, the procedure for “copying” an object (without deleting it) and placing
it elsewhere, is explained. (When an object is “copied”, it is stored in the
Clipboard*1.)

����� Copying an Object

(1)Select the desired object(s).

(2)Select the [Edit] menu - [Copy] command, or click
on the  icon.
The selected object(s) will be Copied to the Clipboard.

(3)Select the [Edit] menu - [Paste] command, or click
on the  icon.
Then, the outline of the object copied from the previous
screen to the Clipboard will appear.

(4)Position the cursor and click on the point where the
object is to be placed.
The object stored in the Clipboard will be Copied to the
specified location.

2.4.1 Selecting
Objects

To cancel the Copying, click on the

 icon.

When “pasting” the Copied object
on another screen, be sure to open
that screen first.

Selecting and dragging an object to
anther screen while holding down
the  Esc  key can also be used to
copy the object.

To cancel the pasting, click on the

 icon.

*1 An area where text, graphics, or both, that have been Cut or Copied, are temporarily
stored. The contents of the Clipboard can be “pasted” (copied from the Clipboard)
using the Paste function. However, once the Copy/Cut command is executed, the data
stored in the Clipboard is replaced; therefore, only the data from the most recent Copy/
Cut command can be pasted.
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2.4.6 Paste

Here, the procedure for “pasting” an object, that has been Copied (or Cut) to
the Clipboard*1, is explained.

����� Pasting an Object
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(1)First, Copy (or Cut) an object.

(2)Select the [Edit] menu - [Paste] command, or click
on the  icon.
Then, the outline of the object copied from the previous
screen to the Clipboard will appear.

(3)Position the cursor and click on the point where the
object is to be Pasted.
The object stored in the Clipboard will be Pasted to the
new location.

2.4.5  Copy

To cancel the paste, click on the 
icon.

When an object is copied from an-
other screen, it will be automati-
cally placed at the same coordinates
as its original ones. To place the
object at different coordinates,
move it after this automatic place-
ment.

*1 An area where text, graphics, or both, that have been Cut or Copied, are temporarily
stored. The contents of the Clipboard can be “pasted” (copied from the Clipboard)
using the Paste function. However, once the Copy/Cut command is executed, the data
stored in the Clipboard is replaced; therefore, only the data from the most recent Copy/
Cut command can be pasted.
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2.4.7 Duplicate

This command allows you to easily make multiple copies of any object. The
address of the copies can be set up so as to increment automatically from
copy to copy, or simply reuse the address of the original object.

����� Duplicate Setting Dialog Box
When this command is used, the Duplicate dialog box for entering the copy
specifications, will appear as shown below.

����� Number of Copies

Here, how many times an object will be copied in the X and Y directions is
entered.  When “1” is entered for either direction, copying will not be
performed in that direction.

The number of copies that can be made will depend on the original object's
position (on the screen), size, spacing and copy direction selected.

����� Input spacing

Enter the spacing interval of dot (screen pixel) units to be used when the
object is copied for both the Horizontal and Vertical directions.

When "Input spacing" is enabled, the position of duplicated objects is based
on the top-left handle on the copied (original) object.  However, if a Bar
Graph’s handles are located in a graph display area, the object will be placed
based on the graph display area, not the graph’s border. Therefore, when
setting the spacing, be sure to not overlap any of the graphs’ borders.

����� Range is specified with a mouse

The objects are automatically aligned with equal spacing in the area selected
with the mouse.

Enter the number of
copies in the X and Y
directions

Enter the line spacing,
in dot units

When copying Parts or
Tags that require ad-
dresses, clicking here
will automatically assign
new, incremented
addresses for each copy

The device comment
corresponding to an
address assigned by the
automatic address
increment is reflected in
the Description field.

Designates direction of
copy placement, from
original object

Note:

Note:

Selects the area
using the mouse in
which the objects will
be aligned with equal
spacing.
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����� Copy Direction

This feature makes multiple copies, starting from original object's upper
left "handle". It also designates the direction and positioning of the place-
ment of the copies. The copy direction is shown by the arrow in each of the
selection boxes. If the [Address Increment] feature is selected, each new
object/copy created will be given a new address, based on the address
entered for the original object.

����� Address Increment

To copy multiple tags and parts, specify the direction of the automatic
address increment. According to the automatic address increment, consecu-
tive Addresses will be assigned in the direction designated by the [Copy
Direction] feature. When the original object’s Address is a Bit Address, the
automatic address increment is performed in the unit of bit, and when it is a
Word Address, the automatic address increment is performed in the unit of
word.
If the automatic address increment is not used, tags and parts will be copied
using the same address as their original ones.

E.g.) When duplicating with the settings shown below:
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����� Reflection of Device Comments

When the [Apply Device Comment] check box is marked with a check, the
device comment corresponding to an address assigned by the automatic
address increment will be reflected in the Description Field. For tags desig-
nating multiple Addresses and Parts, however, the device comment corre-
sponding to an Address designated as the Reflected Description Address is
reflected.  The Reflected Description Addresses for different tags and parts
are shown in the table below:

<Reflected Description Address Table>

Object name Automatic input
address Object name Automatic input

address Object name Automatic input
address

A-tag Monitor w ord
address

R-tag Lamp Bit address

a-tag Monitor w ord
address

S-tag Word address 4-state Lamp Lamp Address 1

C-tag T-tag (bit) Bit address Bar Graph Word address
D-tag Word address T-tag (word) Word address Pie Graph Word address
d-tag Word address T-tag (special) Half-pie Graph Word address
E-tag Word address t-tag Bit address Tank Graph Word address
F-tag Word address Tih-tag Meter Graph Word address

G-tag Word address Tiw-tag Trend Graph Channel 0 w ord
address

g-tag Word address U-tag Word address Keyboard

H-tag Start bit address U-tag (high-speed) Bit address Keypad Input
Display

Word address

J-tag Word address V-tag Alarm Word address
K-tag Word address v-tag File Name Display

k-tag W-tag (bit) Bit address Data Logging
Display

Block number
designated address

L-tag
(direct/indirect)

Start bit address W-tag (word) Word address Numeric Display Word address

L-tag (without
indirect start bit)

Word address W-tag (special) Start bit address Data Transfer
Display

Word address

L-tag (state) Word address X-tag (bit) Bit address CSV Display Word address

1-tag Word address X-tag (word) Text screen w ord
address

File Manager
Display

Word address

M-tag Start bit address Trend channel Word address Message Display Word address
M-tag (w ithout
start bit)

Word address Data sampling Sampling address Date Display

N-tag Word address Bit Switch Operation bit address Time Display
n-tag Word Switch Word address Graphic Display Bit address
P-tag Word address Function Switch Window Parts Word address
Q-tag Toggle Switch Operation bit address
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<When Duplicating a Switch 5 times in both
the X and Y directions>
(1)Select the desired object.

(2)Select the pull down [Edit] menu’s [Duplicate] com-
mand.

(3)Specify the number of copies to be made in both the
X and Y directions.

(4)Select the "Input spacing" option and then specify
the spacing between copies (in dots) in the X and Y
directions. Also select the desired option from the
Copy Direction.
If necessary, select the Address Increment check box and
specify the setting.

(5)Click on the  button to duplicate the object.

Enter 5

Enter 5

When duplicating an object, posi-
tioning will be decided based on the
top left handle of the copied (mas-
ter) object.

To cancel the duplication, click on
the  icon.

To stop duplicating, press the
key.

 Duplicating
 When placing the duplicated object by specifying the spacing

Esc

Select Input spacing
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<When Duplicating a Switch 4 times in the X
direction and 3 times in the Y direction>
(1)Select the desired object.

(2)Select the pull down [Edit] menu’s [Duplicate] com-
mand.

(3)Specify the number of copies to be made in both the
X and Y directions.

(4)Select the "Range is specified with the mouse" op-
tion and then specify the direction in which the ob-
ject will be copied
If necessary, select the Address Increment check box and
specify the setting.

(5)Click  to confirm the settings.

Enter 4

Enter 3

 When placing the duplicated objects by specifying the area with the mouse
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(6)Use the mouse to specify the area in which you want
to place the duplicated objects. Click the mouse but-
ton to confirm the area and execute the Duplicate
operation.
The objects are placed with equal spacing in the speci-
fied area.

Right-click the mouse or press the
key during Step (6) to return

to Step (3).

To cancel the Duplicate operation,
click on the  icon.

Esc
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2.4.8 Delete

Here, the procedure for deleting an object is explained.

����� Deleting an Object
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(1)Select an object.

(2)Select the pull down [Edit] menu’s [Delete] command. Instead of selecting the [Delete]
command, the computer
keyboard’s             key can also be
used.

To cancel the deletion, click on
the  icon.

Delete



2.4 Object EditingChapter 2 - Base Screens

2-227GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

2.4.9 Align

Here, the procedure for aligning and centering object(s) are explained.

����� Alignment Dialog Box

����� Aligning Object Positions
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(1)Select all the desired objects to be aligned.

(2)Select the [Edit] menu - [Align] command, or click
on the  icon.

(3)Select the type of alignment from the Alignment dia-
log box.
In this example, select the  icon (X-axis:  Bottom)
and do not select any vertical (Y-axis) position.

(4)Click on the  button to align the objects.

2.4.1 Selecting
Objects

While an individual label can be
aligned, groups of labels cannot.
(Click on an object to select its
handles and then click on its Label
to select the Label’s handles.)  Text
characters on both Numeric or other
types of Displays can be aligned in
the same manner.

To align objects, combine the se-
lections shown below:

Horizontal position:  Up, Center,
Bottom

Vertical position:  Left, Center,
Right

To cancel the alignment, click on
the  icon.

Shows the
current align-
ment settings

Resets the Y
axis settings

Aligns to the right
of the Y axis

Aligns on the Y
axis

Aligns to the left
of the Y axis

Aligns above the
X axis

Aligns on the X
axis
Aligns below the
X axis

Resets the X axis
settings
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2.4.10 Rotate Left/ Rotate Right

With this command, an object can be rotated in 90º increments.  However,
loaded Screens and Marks, some Tags, and grouped objects cannot be
rotated.

����� Rotating an Object Counterclockwise (Left)
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(1)Select an object.

(2)Select the [Edit] menu - [Rotate Left] command, or
click on the  icon.
The object will be rotated counterclockwise 90 degrees,
relative to its center point; if necessary, repeat the com-
mand.

2.4.1 Selecting
Objects

The center point of the object is
where two lines, connecting the
opposite handles (other than the
corner handles), cross.

To cancel the rotation, click on the
 icon.  (Clicking on the  icon

one time reverses one 90 degree ro-
tation.)

If an object is moved outside the
drawing area by rotating, the object
will not be displayed on the GP
screen.

Center
point
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����� Rotating an Object Clockwise (Right)
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(1)Select a desired object.

(2)Select the [Edit] menu - [Rotate Right] command, or
click on the  icon.
The object will be rotated clockwise 90 degrees, relative
to its center point.  If necessary, repeat the command.

2.4.1 Selecting
Objects
The center point of the object is
where two lines, connecting the
opposite handles (other than the
corner handles), cross.

To cancel the rotation, click on the
 icon.  (Clicking on the  icon

once reverses one 90 degree rota-
tion.)

If an object is moved outside the
drawing area by rotating, the object
will not be displayed on the GP
screen.

Center
point
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2.4.11 Mirror X/ Mirror Y

An object can be moved symmetrically around its center line with respect to
the X or Y axis. The display position of Tags, Parts, Text, Load Screens, and
Load Marks can only be moved symmetrically.

����� Moving Symmetrically along the X-axis

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Select an object.

(2)Select the [Edit] menu - [Mirror X-axis] command,
or click on the  icon.
The object will move symmetrically with respect to the
X-axis.

2.4.1 Selecting
Objects

The center point of the object is
where two lines , connecting the
opposite handles (other than the
corner handles), cross.

If an object is moved outside of the
drawing area by using the Mirror
X function, the part of the object
outside the drawing area will not
be displayed on the GP screen.

To cancel the change, click on the
 icon.

Center

Center Point/Line
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����� Moving Symmetrically along the Y-axis
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(1)Select an object.

(2)Select the [Edit] menu - [Mirror Y-axis] command,
or click on the  icon.
The object will moves symmetrically around the Y axis.

Center

2.4.1 Selecting
Objects
The center point of the object is
where two lines, connecting the
opposite handles (other than the
corner handles), cross.

If an object is moved outside of the
drawing area by using the Mirror
Y function, the overflowing part of
the object will not be displayed on
the GP screen.

To cancel the change, click on the
 icon.

Center Point/Line
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2.4.12 Group/Ungroup

This function can be used to “group” multiple objects, enabling you to
manipulate the “group” as a single object, even after changing screens or
using a different editing function.

����� Grouping Objects

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(2)Select the [Edit] menu - [Group] command, or click
on the  icon.

(1)Select the objects to be Grouped. 2.4.1 Selecting
Objects

To cancel the Grouping, click on the
 icon.

· When a Part is included in a group, its handles appear as  , so that the
individual Part cannot be scaled up/down independent of the group. Thus,
you must first ungroup the objects in order to scale any individual object.

· When a Part is included in a group, double click on the group to bring up
the Confirm Device Address dialog box, where address changes can be
made.

  2.4.14 Changing Attributes
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����� Ungrouping Objects
This function changes a Group of objects to a selection of multiple objects.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Select a group of objects.

(2)Select the [Edit] menu - [Ungroup] command, or click
on the  icon.

2.4.1 Selecting
Objects
To select a group including tags,
place a check mark in the Tag check
box in the Select Tool Box.

To cancel the ungrouping, click on
the  icon.
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2.4.13 Bring to Front/ Send to Back

When graphics and Parts overlap each other, you can change the order of the
layers with these two commands.

����� Changing the Order of Overlapping Objects

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

In this example, you will move the oval, partially hidden
by the rectangle,  to the front.

[Bringing an Object Forward]

(1)Use the cursor to select the filled oval.

(2)Select the [Edit] menu - [Bring to Front] command,
or click on the  icon.

[Sending an Object Behind]

(1)Use the cursor to select the black rectangle.

(2)Select the [Edit] menu - [Send to Back] command, or
click on the  icon.

2.4.1 Selecting
Objects

To cancel the movement, click on
the  icon.

To cancel the movement, click on
the  icon.
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2.4.14 Changing Attributes

Here, you can change any of an object’s attributes, i.e. its color, address, etc.
Also, with objects of the same type, you can change the same attribute of all
the objects of that type at the same time.

����� Changing Attributes
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(1)First, select an object, to change its’ attributes.
In this case, an unfilled rectangle drawn with a solid line.

(2)Select the [Edit] menu - [Change Attribute] command,
or click on the  icon.

(3)Select a new attribute from the dialog box.
Here, a dotted line is selected.

(4)Click on the  button to register your change.

2.4.1 Selecting
Objects

While the attributes of Grouped ob-
jects generally, cannot be changed,
the same type objects can be
changed at the same time. When
Grouped Parts have been selected,
only their  addresses can be
changed.

 �Confirming Ad-
dresses

Instead of clicking on the  icon,
simply double-click on the object
when selecting it, to display the At-
tribute Settings dialog box ( skip
step {2}).

To cancel the attribute changes,
click on the  button in the
dialog box.

Even af ter  c l ick ing  on  the
, you can reverse the at-

tributes changes (only for the most
recent change) by clicking on the

 icon.

You can select more than one object of the same type and change the at-
tributes of each, at the same time. With all the desired objects selected, click
on the Tool box’s  button; then, proceed with step (2).

2.4.1  Selecting Objects, ����� How to Select Multiple Objects,
[Selecting Objects by Type from a Multiple Selection]
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����� Confirming Addresses
If a Part that requires an address has been grouped, the Confirm Device
Address dialog box shown below will appear whenever its attributes are
changed; the Part addresses are changed here.

����� Bit and Word Addresses
Each Part’s address is displayed.  To change an address, click on the inside
of each cell.  As shown above, any Switches selected that have state changes
will have both their Operation Bit and their Monitor Bit addresses displayed.

����� Address Range Conversion
When an address is changed and this check box is checked, any other Part
with the same device address will be automatically changed.

In the example above, if the first bit address is changed from X00000 to
X00010, the following bit addresses will be changed as below.

Clicking on any
cell other than the
changed one will
show the changed
address

Allows you to view either the Bit or Word Addresses of
all the Parts in the currently selected group of objects

Part Addresses are
displayed here

Check this box to
automatically
change all the
addresses of the
Parts in this group
that have the same
Device Address
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2.4.15 Changing Coordinates

Object positions and sizes can be changed by specifying their coordinates.

����� Using Coordinates to Change an Object’s Position

Check this check
box to change
the size. Enter the object’s

left top coordi-
nates.

Enter the object’s
right bottom coordi-
nates.
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(1)Select a desired object.

(2)Select the [Edit] menu - [Change Coordinates] com-
mand.

(3)Enter the object’s left top and right bottom coordi-
nates.

(4)Click on the  button to execute the command.

2.4.1 Selecting
Objects

To change the size, check the
Change size check box in step (3).

To cancel the coordinates change,
click on the  button.

To undo the coordinates change,
click on the  icon.



2.4 Object Editing Chapter 2 - Base Screens

2-238 GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

2.4.16 Editing the Node of a Multi-segment Line

Creating, Editing, or deleting a node can be performed on a multi-segment
line and a filled polygon.

The [Node Edit] dialog
displays.

If the node edit is selected, the selected point
in the displayed dialog is marked with a
cross.

Deletes the selected peak.

Adds a node. The added
node is the same as the
selected node. If the screen
capacity is exceeded by the
added value, the [Insert in
Front] and [Insert in Back]
buttons are highlighted and
cannot be specified.

����� Editing a Node on a Continuous Line
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(1)Select the desired continuous line.

(2)Select [Node Edit(K)] from [Edit(E)].

(3)Select the coordinate value that you want to edit.

(4)Click on the  button.

(5)Enter the X/Y coordinate values in the coordinate
change dialogs.

(6)Click on the  button to run the coordinate
change.

2.4.1 Selecting
Objects

To cancel the coordinate change,
Click on the  button.
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2.4.17 Transferring a Screen to the Clipboard

The current screen is transferred as an image to the clipboard*1.  The trans-
ferred screen can be utilized by pasting it to other drawing software. The
screen types that can be transferred to the clipboard are the Base (B) screen,
Mark (M) screen, Trend Graph (T) screen, Keypad (K) and Window (U)
screen.

����� Transferring a Screen to the Clipboard

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Select the [Screen to clipboard] command from the
[Edit] menu.
The current screen will be transferred to the clipboard.

(2) Paste the screen to other drawing software.

*1 The clipboard is a storage location where copied or cut data is temporarily stored. The
data stored on the clipboard can be copied or moved by pasting it.
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2.4.18 Converting a Screen to a Bitmap File

The current screen is converted into a bitmap file, and then saved. The
screen types that can be converted are the Base (B) screen, Mark (M) screen,
Trend Graph (T) screen, Keyboard (K) and Window (U) screen.

Usage  Pattern

[Edit] →→→→→ [Screen to
bitmap file] →→→→→

[Setting
bitmap file] →→→→→

Specify how to
save the bitmap
file.

→→→→→ [Edit] →→→→→ [Screen to
bitmap file] →→→→→

[Setting
bitmap file]

����� Designating a Bitmap’s File Name
Before converting the screen to a bitmap file, specify how to save the bitmap
file.

Specify how a
file name is to
be created
automatically.

Specify a file
name and output
destination to
save the file.

Automatically
creates a file
name to save the
file.

Specify an output
destination of the
file when a file
name is being
created automati-
cally.

����� Prompt for filename when saving
When the [Screen to bitmap file] command is executed, the Save As dialog
box will appear, where you can specify the location and name of the file to
be saved.

����� Automatically create file name

When the [Screen to bitmap file] command is executed, a file name will be
created automatically, and the file saved in a previously specified location.

Example: If the No. 1 screen of the Base (B) screen named “Menu” is
converted into a bitmap file:

Screen type + number.BMP —> B1.BMP
Screen type + number + screen title.BMP  —> B1 Menu.BMP

When automatically creating a bit map file with a screen title, if one of the
following symbols "\ , / : ; * ? " < > |" is used in the screen title, Windows

cannot create a file. Prior to using this feature, be sure your screen titles do
not contain any of these characters.
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����� Converting a Screen into a Bitmap File
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(1)Select the [Setting bitmap file] option for the [Screen
to bitmap file] command from the [Edit] menu.

(2) Select a method for saving the bitmap file, and es-
tablish it by clicking on the  button.

(3) Select the [Screen to bitmap file] option for the [Screen
to bitmap file] command from the [Edit] menu.
When a file name is created automatically, the bitmap
file is saved now.

(4) If [Prompt for filename when saving] was selected in
step (2), specify a file name and output destination,
and then click on the  button.

Save the source screen before per-
forming the conversion. If the
source image has not been saved,
the bitmap file cannot be created
automatically.
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2.4.19 Redraw Screen

This command updates the current drawing area display to reflect the latest
drawing data. When the Auto Redraw feature is not used, filling and editing
objects can cause after-images to remain on the screen. Use this function to
remove these images and show the screen as it will appear on the actual GP
display.

����� Redrawing a Screen

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

Sometimes, when removing an object’s filled color, only
the fill point area’s color will be removed, resulting in a
small, non-colored square.

1234567890123
1234567890123
1234567890123
1234567890123
1234567890123
1234567890123
1234567890123
1234567890123
1234567890123
1234567890123
1234567890123
1234567890123

1234567890123
1234567890123
1234567890123
1234567890123
1234567890123
1234567890123
1234567890123
1234567890123
1234567890123
1234567890123
1234567890123
1234567890123

+
Point
where fill
began

Fill point is deleted

(1)Select the [Edit] menu - [Redraw] command, or click
on the  icon.
The screen will automatically be refreshed and all the
fill color will be removed.
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2.4.20 Undo

With this function, an operation can be “undone” and the screen display
returned to the previous condition.  Every time the  icon is clicked on,
depending on memory, previous operations will be undone, in succession.

The Redraw Screen function cannot be undone.

����� Canceling an Action
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In this example, a circle has been accidentally deleted.

(1)Select the [Edit] menu - [Undo] command, or click
on the  icon.
The circle will reappear and the screen is displayed as it
was prior to the deletion.

To cancel the Undo operation,
click on the  icon.

2.4.21  Redo

2.4.21 Redo

With this function, an operation previously undone with the Undo command
can be “redone”, if performed immediately after the Undo command is used.

����� Redoing the Previous Undo Command
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In this example, the undone circle deletion will be re-
done (i.e. deleted again).

(1)Select the [Edit] menu - [Undo] command, or click
on the  icon.
The circle will reappear.

(2)Select the [Edit] menu - [Redo] command, or click on
the  icon.
The circle will disappear.

To cancel the Redo operation, click
on the  icon.

2.4.20  Undo
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����� Library Browser

When either  or  icon is clicked on, the Library Browser will appear.

Displays the currently selected item’s registration number and title;
clicking on the triangle brings up a list of the items in the current
library

Menu Bar
Tool Bar

Status Bar

Scrolls
through
the differ-
ent items,
either left,
right, up,
or down

Reverse video
indicates that
this item is
currently se-
lected

Displays the
item’s registra-
tion number
and title

2.5      Libraries
The objects you created can be registered. These registered objects are
called “Libraries”. You can call up and use the registered Libraries, when-
ever necessary.  Like a pre-made Part Shape, the objects registered in these
libraries can be viewed and selected using the Browser function.
Multiple objects can be combined and registered, and Marks created on
Mark screens can also be registered.

3.1 Creating a Mark: the Mark Screen
These items are stored in a Library file (CPW file), separate from Project
(PRW) files .  When library data is a Mark, it will be saved in a Mark Li-
brary (MRK) file.  Moving from one Library file to the other allows objects
to be called up that were previously used in a variety of screens and Project
files.

To call up an item from a Library, or save an item to a Library, either select
one of the tool bar’s icons  or use the pull down menu’s [Library]
commands.
With both Base and Mark screens open, when the Base screen where the
Library Browser is remained open is changed to the Mark screen, the Mark
Library Browser cannot be open on the Mark screen. When changing the
screen, first close the Library Browser and change the screen, and then open
the Library Browser on the newly opened screen.

Objects called up via the [Load Screen], [Load Mark] or [Window Parts (W)]
command, as well as D-script cannot be registered.
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����� Editing Library Items
Three Library Item editing functions are available.

Cuts a Library item (which is then moved to the Clipboard); the
Library item can then be moved to another screen using the [Paste]
function.

Copies the selected Library item to the Clipboard.

Pastes the Library item Cut or Copied, and temporarily stored in the
Clipboard, to another screen.  The Library item can also be Pasted to
another Library file.

You can remove a Library item using the Delete function. To do so, select
the  [Delete] command from the Library dialog box’s pull down [Edit]
menu.

2.5.3 Editing Library Items

����� Changing the Library’s Display
The Library’s image display size and type can be changed.  Also, you can
change from one Library file to another.

����� Library Size

When either the , , or  icon is clicked on, or the pull down
[View] menu’s either [Normal], [Adjust to Fit], or [Full Screen] command is
selected, and the Library display size can be changed.  When Normal is
selected, each Library size will be displayed relatively, allowing you to
check the relationship between Libraries for their size.  When the Adjust to
Fit function is selected, the Library item will be enlarged until it fits inside
the Library window’s borders.  When Full Screen is selected, the Library
item will be displayed in its actual (GP) screen size.

����� Library Type

When the pull down [View] menu’s [All Objects], [Part & Tag Objects], or
[Graphic Objects] is selected, the Library type(s) shown on the Browser can
be selected.

[All Objects] Displays all the Library items in the selected Library
file.

[Part & Tag Objects] Displays only those items that are either Parts or
Tags.

[Graphic Objects] Displays only those items which are neither Parts nor
Tags (i.e. drawn objects).
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����� Selecting (Calling Up) another Library File
When the  icon is clicked on, or the pull down [File] menu’s [Select
File] command is selected, the Library file list will appear.  By selecting
(dragging) the desired Library file from this list, other Library files can be
called up.

Two types of Library files are available; the Library files created using the
GP-PRO/PBIII (DOS Version) (DOS Library file:  *. CPL), and the Library
files created using GP-PRO/PBIII (Windows    Version) (Windows Library
file: *. CPW and *.MRK).  Select either one.

Files created using Parts Box (*. CPL) can be converted into GP-PRO/PBIII
for Windows format (*. CPW).

12.1 File Converter

Shows the
currently
displayed file’s
folder

Lists all the
files in the
currently
selected folder

Displays the currently selected
file’s Description data (if any)

Currently selected file’s
format (type)

Currently selected
file’s name (If
desired, can be
entered)

Lists file
information
in detail

Lists the files in
summary format

Creates a new
folder

Moves up one file
level

R

����� Switching Library Files
����� Creating a New Library File

When the  icon is clicked on, or the pull down [File] menu’s [New]
command is selected, the Dialog box shown below will appear.  When a
Description is input and the  button is clicked on, a new Library
file will appear.
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����� Modifying Library File Names (Titles)
Library filenames can also be changed. Simply select a library from the file
list, then select [Property] from the [Edit] menu, and the Property screen
will appear.  Type in the filename (title) that you wish to use and click on
OK.

����� Displaying the Browser at the Top of the Normal Screen
If the [Always on Top] option is selected from the [Window] menu, when-
ever the Library Browser is called up, it will be placed at the top of the
current window.  If this option is not selected, selecting another screen will
place that screen over the Library screen, hiding it from view.
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2.5.1 Registering Library Items

Here, the procedure for registering a Library is explained.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Select objects to be registered as Library items.

(2)Select the [Library] menu - [Register Library] com-
mand, or click on the  icon.

<A. When registering a new Library item to
the currently open Library file:>
(3)Enter the Library’s registration number and descrip-

tion.
In the Cell Number area, the smallest of the currently
open Library file’s unused numbers will be automati-
cally displayed.  To change it, simply enter the desired
number.

(4)Click on the  button to register the number.
The registered Library will then be displayed in the
Browser.

  2.4.1  Selecting
Objects
D-scripts as well as objects called
up via the [Load Screen (O)],
[Load Mark (M)] and [Window
Parts (W)] commands cannot be
registered.

If the Library Browser is already
showing, click on either  or

 icon in the screen editor

drawing area, and the  icon in
the Library Browser, which will
perform the function of step (2).

The following procedures will
differ depending on the Library
file registered.
• When registering a new Library

item to the currently open
Library file:

• When no Library file is dis-
played:

• When registering a Library item
to a new Library file:

• When registering a Library item
to a Library file other than the
currently open one:

Up to 200 Library items can be
registered in one file.

100: switch
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<B. When no Library file is displayed:>
(3)The “New” dialog box will appear.

(4)Via the Library Browser, select the [File] menu - [New]
command, or click on the  icon.

(5)Enter a comment and click on the  button.

Enter the file name when the
Library file is saved.

  2.5.4 Saving Li-
braries and Quitting ����� Saving a
Library File Under Another Name

Enter a description up to 60 char-
acters.

Enter the file name when the Li-
brary file is saved.

  2.5.4 Saving Li-
braries and Quitting ����� Saving a
Library File Under Another Name

A comment of up to 60 characters
can be entered.

<C. When registering a Library item to a new
Library file:>

(3) Click on the  button.

When registering a Library item to an existing Library file:
Click on the  button.

<D. When registering a Library item to a Library file
other than the currently open one>’s step (4)

When registering a Library item to a new Library file.
<C. When registering a Library to a new Library file>’s
step (5)

(6)Via the Screen Editor, select the [Library] menu -
[Register Library] command, or click on the  icon.
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<D. When registering a Library item to a
Library file other than the currently open one.

(3)Click on the  button.

(4)Via the Library Browser, select the [File] menu - [Se-
lect File] command, or click on the  icon.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(7)Enter a Cell Number and Description.

(8) Click on the  button.
The newly registered Library item will appear in the
Browser.

A maximum of 200 Library items
can be registered in each Library
file.

After creating a new Library item,
if you attempt to create or select
another Library file without first
saving the item via the [Save
As...] function, a prompt will
appear, asking whether the newly
created Library item should be
saved or not.

  For the proce-
dures for saving a Library item, re-
fer to 2.5.4 Saving Libraries and
Quitting  �����  Saving a Library File

100: switch
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(5)Select the desired Library file from the list, or input
the Library file name in the file name area.

(6)Click on the  button to display the selected
Library file.

In step (5), simply move the cursor
to the desired Library file name and
double-click on it to open it.  By
doing so, the  (Step 6) but-
ton does not need to be used.

  2.5 Libraries �
Switching Library Files

When selecting a Library file in an-
other directory, use the [Look in:]
window.Select “Op4-

lib1.cpw”.

(7)Via the Screen Editor, select the [Library] menu -
[Register Library] command, or click on the  icon
on the Draw Tool Bar.

(8)Input a Cell Number and Description.
In the Cell Number area, the smallest of the currently
open Library file’s unused numbers will be automati-
cally displayed.  To change it, enter the desired number.
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(9)Click on the  button to register the item.
The registered Library item will appear in the Browser.

Up to 200 libraries can be regis-
tered in one file.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

����� Using the Cut, Copy, and Paste Functions
Library items can be Cut, Copied and Pasted from the screen drawing area
to Browser.  First, select the desired Library item in the drawing area, and
then either Cut or Copy it; then, Paste it to the current Library Browser.

100: switch
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2.5.2 Placing Library Items

Here, items registered in a Library file are placed on a drawing area.

(1)Via the Screen Editor, select the [Library] menu -

[Call Up Library] command, or click on the  icon
on the Draw Tool Bar.

(2)Select a Library Item to be read out from the Browser.

(3)Drag the Library item to the desired position in the
drawing area.
The Library item can be placed on any open screens,
and will be displayed in the drawing area.  If desired use
the sizing handles to alter the item’s size.

Library items Cut, Copied, or
Pasted between the screen and the
Browser. Simply select the desired
Library item and perform the com-
mand.

When calling up an item from a file
different than the currently dis-
played file, click on the  icon to
bring up a file list.

  2.5 Libraries
����� Switching Library Files

The Library item’s top left corner
is the placement point.

To cancel the placement, click on
the screen editor’s  icon.

  To change a Li-
brary item’s size, refer to 2.4.3
Scaling Up/Down

Items called up are automatically
grouped.  They can be freely edited
after ungrouping them by clicking
on the  icon.

  2.4.12 Group/
Ungroup

Grouped library items containing
Parts cannot be scaled up or down.

10: on

10: on

10: on
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When a Library that contains Parts is called up, the Confirm Device Address
screen will appear.  After entering each Part’s address, click on the 
button.  To cancel these settings, click on the  button.

   2.4.14 Changing Attributes, ����� Confirming Addresses
When the Library placed on the screen is double-clicked on, the Confirm
Device Address dialog box shown below will appear, allowing you to
change the Part’s previously entered addresses.

After a Tag is registered in a Library, if multiple identical libraries
are then placed on the screen, their Tag names will be dupli-
cated.  After placing them, be sure to change their Tag names via
either their attribute dialog boxes, or the Tag List; especially if a
common start up bit has been created for a K-tag.

For Changing Attributes, refer to 2.4.14 Changing Attributes.
For Tag List, refer to 2.10.6 Tag List.
For K-tags, refer to Tag Reference Manual, 2. 12 K-tag
(Keypad Input).

����� Using the Cut, Copy, and Paste Functions
Library items can be Cut, Copied, and Pasted from the screen drawing area to
the  Browser.  First, select the desired Library item in the drawing area and
Cut or Copy it; then, Paste it to the Library Browser.
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2.5.3 Editing Library Items

Library Items can be edited, Deleted, Copied, Cut, or Pasted.

����� Editing a Library Item
Here, a registered Library item is edited.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Select and double-click the Library item to be edited
from the Browser.

(2)Edit that Library item.

(3)Via the Screen Editor, select the [Screen] menu - [Save]
command, or click on the  icon on the Main Tool
Bar.

In order to call up a Library item
from a Library file which is differ-
ent from the currently displayed
file, click on the  icon.

  2.5 Libraries
� Switching Library Files

When double-clicking on a
Library item’s title, the title
editing screen will appear.  (Title
Change Screen)

Once an item is edited, it
cannot be Undone.

100: switch
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����� Deleting a Library Item
Here, a registered Library item is deleted.

(1)Select the Library item to be deleted from the
Browser.

(2)Select the [Delete] command from the Library
Browser’s [Edit] menu.
A dialog box appears to confirm your command.

In order to call up a Library item
from a Library file which is differ-
ent from the currently displayed
file, click on the  icon.

  2.5 Libraries
� Switching Library Files

Once an item is deleted, it
cannot be Undone.

(3)Click on the  button, and the Library item
will be deleted.

100: switch
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����� Cutting a Library Item (from a Library File) and Pasting
Here, a registered Library item is Cut and Pasted.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1) Select a Library item to be cut (out) from the Browser.

(2)Via the Library Browser, select the [Edit] menu - [Cut]

command, or click on the  icon.
The selected Library will be cut.

(3)Open a desired Library file and, via the Library
Browser, select the [Edit] menu - [Paste] command,
or click on the  icon.

In order to call up a Library item
from a Library file different than
the currently displayed Library file,
click on the  icon.

  2.5 Libraries
� Switching Library Files

To register the Library item to a
new Library file, click on the 
icon.

To register the Library item to a Li-
brary file different from the cur-
rently displayed one, click on the

 icon.

  2.5 Libraries
� Switching Library Files

The following steps are the same as those used for a
Library Item registration.

(4)Input the Item’s Cell Number and Description.
In the Register Number area, the smallest number in the
currently open Library file’s empty numbers will be au-
tomatically displayed.  To change it, input the desired
number.

100: switch



2.5 Libraries Chapter 2 - Base Screens

2-258 GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

(2)Via the Library Browser, select the [Edit] menu -
[Copy] command, or click on the  icon.
The Library item will be copied to the Clipboard.

(3)Open the destination Library file and select the [Edit]
menu - [Paste] command, or click on the Library
Browser’s  icon.

To register the Library item to a new
Library file, click on the  icon.

To register the Library item to a Li-
brary file different than the current
one, click on the  icon to call up
a list of Library files.

  2.5 Libraries
� Switching Library Files

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(5)Click on the  button to register the Library
Item.
The registered Library will be displayed on the Browser.

����� Copying a Library Item
Here, a previously registered Library item will be copied.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Open the desired Library Item’s Library file and  se-
lect the Library item from the Browser.

In order to call up a Library item
from a Library file different than the
currently displayed Library file,
click on the  icon.

2 . 5  L i b r a r i e s
� Switching Library Files

100: switch

100: switch



2.5 LibrariesChapter 2 - Base Screens

2-259GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

Hereafter, steps are the same as Library Item Registra-
tion.

(4)Input the Item’s Cell Number and Description.
In the Register Number area, the smallest of the currently
open Library file’s unused numbers will be automatically
displayed.  To change it, enter the desired number.

(5) Click on the  button to register the Item.
The registered Item will appear in the Browser.

100: switch
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(3)Click on the  button to save the Library.
When a project with the same name already exists, a
prompt asking whether the new name should overwrite
the old name will appear; to do so, click on the 
button. When you do not want to overwrite, click on the

 button.

2.5.4 Saving Libraries and Quitting

����� Saving a Library File
When a Library file’s contents are changed, the changed data will automati-
cally overwrite the old data and be saved.  However, if the Library file has
been newly created, when you attempt to create or select another Library
file, a prompt will appear asking if whether the new file is to be saved or
not.  When  is clicked on, the [Save As...] Dialog box will appear.

  �����Saving a Library File Under Another Name

����� Saving a Library File Under Another Name
Here, the Library File will be saved under a different name.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Select the [Save As...] command from the Library
Browser’s [File] menu.

(2)The currently selected Library file name and its com-
ment data, if any, will appear.
Input a new file name and change the desired settings.

The file name can be input within
255 characters, including a path and
extension.
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����� Quitting the Library Browser

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Select the pull down menu [File]’s [Exit] command.
If a newly created Library file has not been saved yet, a
prompt asking whether the new Library file should be
saved, will appear.  When the  button is clicked,
the “Save As..” dialog box  will appear, and when the

 button is clicked, the Library file will not be
saved and the Library Browser will quit.  Then, a Li-
brary file creation or selection screen will appear.

Clicking on the Library Browser’s
top right mark  can also be
used to quit.

  �����  Saving a Li-
brary File Under Another Name
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The GP-PRO/PB III provides a special feature that enables you to create a
program to execute functions, in addition to tags. This feature is given by D-
Scripts/Global D-Scripts. The display load on the device can be reduced
significantly by creating and registering a program with D-Scripts/Global D-
Scripts. D-Scripts are used on each screen and serve as programs that are
only effective on that screen. Global D-Scripts serve as programs that are
effective on all screens.

Using D-Script, you can program separately for when the trigger is activated
and for when the action is performed.

.  Then, when the trigger conditions are satisfied, the script is performed.
The procedures for writing a program with Global D-Scripts are the same as
those for writing a program with D-Scripts.

For more detailed information about D-script and Global D-script, refer to
the Tag Reference Manual.                            Tag Reference
Manual, 3.1 D-Script/Global D-Script

• D-script and Global D-script cannot be registered as Libraries.
• To set up D-scripts or Global D-scripts, open any desired

Base screen and follow the procedure below.

2.6      D-Script/Global D-Script

Usage  Pattern

→→→→→[Special] →→→→→
[D-Script]
or [Global
D-Script]

Add, Modify, or
Delete →→→→→

 or
the
key

Esc

An example of the D-Script dialog box (the initial screen) is shown below.

Adds a D-Script

Lists the D-
Script ID
numbers and
descriptions

Pastes the
copied contents
of a D-Script

Copies the
contents of a D-
Script

Allows you to
edit the con-
tents of a D-
Script

Deletes a
registered D-
Script
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����� Registering D-Script Settings
Here, additional D-Scripts can be registered.  When the  button is
clicked on, the D-Script Editor will appear.

Enter the D-Script’s ID No. (from 00000 to 99999)
Enter a
description
here

Displays the
D-Script’s
command
tool box

The programmed
“actions” (com-
mands) of the D-
Script
Only the com-
mand portions
("actions") can
be imported/
exported as text
files (*. txt).

Message area (window)

Displays
defined
function
names

Trigger
area

����� D-Script Tool Box
The D-Script tool box contains icons for D-Script commands and State-
ments and constant input icons.

 Tag Reference Manual,  3.1 D-Script/Global D-Script

When the “Show Toolbox” check box is checked, the following tool box
will appear.
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����� Definition of Functions
Programs to be used for D-Script are defined as functions.  The defined
functions can  called up to the activated program and used.  Also these
functions can be nested up to 10 layers.  When the  icon is clicked on in
the D-Scrip Editor, the D-Script function setting screen will appear.

Only alphanumerics and the “_ (under bar)” can be used for function names;
up to 20 characters can be entered.

����� Importing/Exporting the "Action" information on the [D-Script
Editor]/[D-Script Function] dialog box
Information on the program currently being displayed in the [Formula] field
of the [D-Script Editor] dialog box or in the [Formula] field of the [D-Script
Function] dialog box can be imported/exported as a text file (*. txt).

Information on items other than [Formula] (the information displayed in
[Trigger], [Function], and Message area (window), etc.) cannot be imported
or exported.

To export the information, select the [File] menu-[Export] command. When
the [Save As] dialog box opens, enter a desired file name and click the

 button.

To import the information, select the [File] menu-[Import] command. When
the [Open] dialog box opens, select the desired text file containing the
program information and click the  button.

Enter a function
name

Enter the D-
Script’s action
(program) to
perform

Message area
(window)

Displays the D-Script command tool box
when this check box is checked

Displays
defined func-
tion names
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����� Editing D-Script Settings
Here, registered D-Script settings are changed.  After selecting the D-Script
settings to be changed from the D-Script list and clicking on the 
button, an additional registration screen will appear.  Click on the 
button to change the D-Script settings.  To cancel the Change command,
click on the  button.

· If the [Save As..] function has been used to change a project
file’s Device/PLC Type, the D-Script program will not be able
to automatically change those addresses. When changing
ad-dresses, use the [Project | Change Device/PLC Type]
menu’s “Convert Address” feature. For details about this
feature,                       4.2.7 Changing Your Project’s Device/
PLC Type and Addresses

· Be sure to not use D-Script to perform any life-threatening, or
possibly damaging actions!

����� Deleting D-Script Settings
Here, existing D-Script settings can be deleted.  After selecting the D-Script
settings to be deleted from the listing, and clicking on the  button,
the Confirm Script Delete dialog box will appear.  When the 
button is clicked on, the D-Script settings will be deleted.  When the

 button is clicked on, the deletion command will be canceled.
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����� D-Script Settings: Copy and Paste

(1)Select the pull down [Special] menu’s [D-Script] com-
mand.

(2)Click on the  button.

(3)When the  button is clicked on, the D-Script
copied in step (2) will be added. The D-Script’s ID
number will automatically be assigned to the small-
est number currently available.

This D-Script can also be copied to
another screen.
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����� Registering D-Script settings
The method for registering D-Script settings is shown below.

If the temperature has fallen to
lower than 30°C, screen B101 is
displayed.
Also, the number of occur-
rences is counted.

If the temperature has risen to
higher than 70°C, screen B100
is displayed.

Above 70                1
Below 30                1

When error bit M0001
turns ON...

ALARM
Over 70 deg. !!

ALARM
Under 30 deg. !!

For a temperature controller, D-Script detects the device’s error bit and dis-
plays alarm messages when the temperature rises to 70 °C or above, or has
fallen lower than 30°C.  Also, the number of the errors detected are counted.

• Temperature data is stored in D200.
• When the temperature is 70 °C or more, the number of Alarms is stored

in LS300.
• When the temperature is 30 °C or less, the number of Alarms is stored in

LS301.
• The alarm display screen number is stored in LS302.

To display the above mentioned alarm messages, L and N-tags are used as
follows:

(1) Create the alarm message screens, B100 and B101.
(2) Set up an L Tag to display the Alarm message screen.  (Direct designa-

tion, word address:  LS302)
(3) Set up an N-tag to display the number of the errors counted when the

temperature rises to 70 °C or more.  (Word address:  LS300)
(4) Set up an N-tag to display the number of the errors counted when the

temperature falls to 30 °C or less.  (Word address:  LS301)
 For details concerning each Tag, refer to the Tag Reference

Manual,  1.3 Tag List.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Select the pull down [Special] menu’s [D-Script] com-
mand.

(2)Click on the  button.

The number of D-script registra-
tions will be limited depending on
each GP memory capacity.

Tag Reference
Manual 3.1.4 D-Script/Global D-
Script Limitations
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(5)Click on the  button to quit registration.

The current
registration
information is
shown here.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(3)Perform settings for each item such as ID, Trigger,
Formula, etc.

Setting to “bit
rising”

Enter M0001

A description can be entered of up
to 20 characters.

  Tag Reference
Manual,  3.1 D-Script/Global D-
Script

In the  area, the Syntax
Assistant and Syntax Check
functions can be used.

Enter Alarm DisplayEnter 00000

(4) Click on the  button.

Program
if ([W:D00200] >=70)
{ //When the temperature is 70°C or higher:

[W:LS0302] =100 //Assign screen No. 100 for the "Over 70°C" alarm message.
[W:LS0300] =[W:LS0300] +1 //The number of errors counted increases.

}
endif

if ([W:D00200] <=30)
{ //When the temperature is 30°C or lower:

[W:LS0302] =101 //Assign screen No. 101 for the "Under 30°C" alarm message.
[W:LS0301] =[W:LS0301] +1 //The number of errors counted increases.

}
endif
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2.7      Extended SIO Script
The GPPRO/PB III provides a special programming function dedicated to
communication between the GP and the I/O device connected to the ex-
tended SIO (Extended serial interface) built into the GP. The programming
operation is executed independently of the processing of the tags on the
screen. The Extended SIO Scripts function as a programming function that
is effective on all screens in the Project, regardless of the screen type.
Three special functions - D-script, Global D-script, and Extended SIO script
- are available for creating programs to execute functions other than tags.

 For details of each function, Tag Reference Manual, 3.1
D-Script/Global D-Script and 3.2 Extended SIO Script.

· This function is supported by GP2000 Series units .
· When the Extended SIO script is used with a GP unit that

does not have an Extended Serial I/F, the “Serial I/F Switch”
must be set to “Yes” in advance. Version 6.2 or later support
the serial interface selection function.

 4.2.8 Changing Extended SIO Type

· When using the Extended SIO Script, ensure that the [Ex-
tended SIO Script Protocol] option has been selected in the
Extended SIO Settings. When a different Extended SIO is
selected, the Extended SIO Script cannot be selected via the
Screen Editor.

 For the procedure for changing the Extended SIO type,
4.2.8 Changing Extended SIO Type.

· The Extended SIO Script cannot be registered as a Library
item.

· To set up the Extended SIO script, open any desired Base
screen and follow the procedure below.

· The LS device used with the Extended SIO scripts cannot be
simulated.

Usage  Pattern

→→→→→[Special] [Extended SIO
Script]

→→→→→
Set up with
the D-Script
Editor

Exit with the
 or

[Cancel] key.
→→→→→
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����� Setting the Extended SIO Script
Configure the Extended SIO Script settings on the D-Script Editor.

Enter the
description
here.

The programmed
"actions" (com-
mands) of the
Extended SIO
Script

Displays the
defined function
names.

Message area
(window)
Message area
(window)
Message area
(window)
Message area
(window)

����� D-Script Tool Box
The D-Script toolbox contains the D-Script commands, Statements and
constant input icons.

 Tag Reference Manual, 3.1 D-Script/Global D-Script
When the "Toolbox" checkbox is checked on the D-Script Editor, the fol-
lowing toolbox will appear.

Displays the D-
Script Tool Box
containing the D-
Script commands.
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����� Definition of Functions
The programs to be used for Extended SIO Script are defined as functions.
The defined functions can be called up to the activated program and used.
These functions can be nested up to 10 layers.

When the  icon is clicked on the D-Script Editor, the D-Script
Function setting screen will appear.

Enter a function
name.

Programmed
action (com-
mand)

Message area
(window)

Displays the
defined function
names.

Displays the D-
Script Tool Box
containing the D-
Script commands.

Note:

Note:

· Only single-byte alphanumeric characters starting with an alphabet charac-
ter and "_" (underscore) can be used for function names. Up to 20 charac-
ters can be entered.

· The functions defined in the [D-Script Function] dialog box of the Extended
SIO Script cannot be used with the D-Script/Global D-Script.

����� Importing/Exporting the "Action" information on the [D-Script
Editor]/[D-Script Function] dialog box
Information on the program currently being displayed in the [Formula] field
of the [D-Script Editor] dialog box or in the [Formula] field of the [D-Script
Function] dialog box can be imported/exported as a text file (*. txt).

· Information on items other than [Formula] (Information displayed on
[Function], and Message area (window), etc.) cannot be imported or ex-
ported.

To export the information, select the [File] menu-[Export] command. When
the [Save As] dialog box opens, enter a desired file name and click the

 button.

To import the information, select the [File] menu-[Import] command. When
the [Open] dialog box opens, select the desired text file containing the
program information and click the  button.
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· When the Project file's PLC type has been changed in the
[Project] menu-[Save As] dialog box, the addresses used with
the D-Script cannot be changed.

· Never use D-scripts to perform controls that have the poten-
tial to cause life-threatening injuries or serious damage.

����� Setting the Extended SIO Script
The following is an example of the procedure for setting the Extended SIO
Script.

On a temperature controller, the target value and current value displayed by
the temperature controller are read out via the Extended SIO Script. The
trigger is turned ON when the [Start Communication] touch switch is pressed,
and the target value is displayed followed by the current value display. After
10 seconds, the target value and current value are read out and displayed
again.

The target value of the temperature controller is stored in LS2000.
The current value of the temperature controller is stored in LS2001.

[Start
Communication]

Target value

Current value

Pressing the touch
switch turns ON the
trigger.

Displays the target
value and current value
displayed by the
temperature controller
in sequence.

Repeats display of the target
value and current value
displayed by the temperature
controller in sequence.

100 °C

92 °C

10
seconds
elapse Target value

Current value

100 °C

93 °C
→→→→→ →→→→→
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(1)Select the pull down [Special] menu's [Extended SIO
Script] command.

(2)Configure the settings for each item, such as Descrip-
tion and Formula.

The number of Functions of the
Extended SIO Script setting is lim-
ited.

 Tag Reference
Manual, 3.2.2 Details

Up to 20 single-byte characters can
be entered as a description.

 Tag Reference
Manual, 3.2 Extended SIO Script

Select [Option] from the menu to
perform Syntax Assistant and Syn-
tax Check functions.

(3) Click on the  button to confirm and quit the
settings.

if ([b: LS005000] ==1) // When Trigger bit is ON with the touch switch:
{

Call INIT // Executes initialization of the Extended SIO.
loop ()
{

Call COMM_READ1 // Reads out the current value of the temperature controller.
Call COMM_READ2 // Reads out the target value of the temperature controller.
_wait (100) // Waits the timer count period before starting transmission

(10-second wait).
}
endloop

}
endif

Enter a description.

Programmed "actions" (Main Function)
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2.8      Data Sampling
Address data designated in the device is sampled and stored (backed up) in
the GP unit.  When using this function for a graph (Tag or Part)’s channel,
Trend graph data can also be stored (backed up).
The number of Data Sampling sets, including the number of channels of
Trend Graphs, that can be set up for the entire Project file (PRW file) is 40
with the GP2000 series and 20 with other models.

For more detailed information about data sampling, refer to the Tag Refer-
ence Manual.

Tag Reference Manual,  3.3 Data Sampling Settings

Usage  Pattern

→→→→→[Special] [Data Sampling] →→→→→
Add, Edit, or
Delete

 or
the
key

Esc→→→→→

An example of the Data Sampling Setting dialog box is shown below.

Registers additional
Data Sampling
Settings

Lists the
registered Data
Sampling
Settings’ Tag
name and
description

Changes the Data
Sampling Setting
attributes

Deletes the regis-
tered Data Sampling
Settings
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����� Registering Data Sampling Settings
Additional Data Sampling Settings are registered.
When the  button is clicked on, the Data Sampling Setting screen
will appear.  For each item’s setting, refer to Tag Reference Manual.

Tag Reference Manual,  3.3 Data Sampling Settings

����� Deleting Data Sampling Settings
Here, the registered Data Sampling Settings can be deleted.  Select a Data
Sampling to be deleted from the list.  When the  button is clicked
on, a dialog box will appear to confirm your command.  If you click on the

 button, the Data Sampling will be deleted; if you click on the
 button, the deletion will be canceled.

����� Editing Data Sampling Settings
Here, the registered Data Sampling Setting attributes can be changed.  Select
a Data Sampling to be changed from the list.  When the  button is
clicked on, the Add (registration) dialog box will appear.  If you click on the

 button, the D-Script setting attributes will be changed, and if you
click on the  button, editing will be canceled.

Enters a Data
Sampling Tag name
of up to 5 charac-
tersSwitches the

setting screens

Displays the
current setting
attributes

Enters a descrip-
tion of up to 20
characters
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����� Setting Up Data Sampling
The Data Sampling setting method is shown below.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1) Select  [Data Sampling] from the [Special] pull down
menu.

(2) Click on the  button.

(3) Perform the data sampling settings. After the settings
are all completed, click on the  button.

The number of Data Sampling sets,
including the number of channels
of Trend Graphs, that can be set up
for the entire system is 40 with the
GP2000 series and 20 with other
models.

Enter a Tag name of up to 5 char-
acters.

Tag Reference
Manual,  3.3 Data Sampling Set-
tings

(4) Click on the  button to quit the registration.

Displays the
registered items
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2.9      GLOBAL INTERLOCK
The touch panel and function keys become effective only when the bit
specified with "Interlock Address" is in the state that has been designated via
"Touch available condition". All inputs from the touch panel and function
keys are disabled when the "Touch available condition" is not satisfied. In
the "Touch available condition", specify whether the inputs are effective in
the ON state or in the OFF state.

Note:

[Function] →→→→→

Usage Pattern

Specify the Bit address
to be monitored and
Touch available condi-
tion.

Click 
to complete the
setting.

→→→→→ →→→→→

The following provides an overview of the Global Interlock setting screen.

Specify the Bit
address to be
monitored.

Touch available
condition

State of the Interlock
Address

Touch Available/Not
Available

ON Touch Available
OFF Touch Not Available
ON Touch Not Available

OFF Touch Available

Bit ON

Bit OFF

 yyyyy  This function is supported only by the GP2000 Series and ST
Series.

 yyyyy  Specify an externally manipulated address (such as address
of an external device or a variable to which I/O is allocated,
etc.) for the "Interlock Address". When an address that cannot
be operated externally is specified, the touch operation can-
not be returned to the Available condition after the touch
operation has been disabled.

yyyyy Even when the Touch available condition is not satisfied, the touch opera-
tions for switching to the Offline mode and adjusting the brightness or
contrast, and touch operations in the Standby mode are enabled.

The settings for Global Interlock can be checked with the Tag List (Global
Interlock).  2.10.6 Tag List

[Global Interlock]

Specify whether
to enable/disable
the Interlock
function.

Select the
condition in
which touch
operations are
enabled.
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����� Setting the Global Interlock
The Global Interlock setting procedure is shown below.

The following sample describes the settings to enable touch operation when
X00000 is turned ON.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Select the [Function] menu-[Global Interlock] com-
mand.

(2)Check the Interlock check box and specify the Bit
address to be monitored.

(3) Select the desired option from the Touch available
condition.

Check the check box.

Enter X00000

Select Bit ON

(3) Click on  to confirm the setting.
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�����  Display

Sets the Grid Point display state (displayed or not displayed).

When the Grid Point's Display is set to "Top", the grid points will be dis-
played in front of all objects placed on the screen.

Grid pattern display can also be changed in the Grid Tool Bar’s grid pattern
selection list box.

2.10      Efficient Drawing Techniques
This section explains how the use of grids, changing display states, and the
help function can all help to increase your drawing efficiency.

Grid Points are placed at regular intervals on your screen and divide the
drawing area into a coordinate “grid” pattern; when the Snap to Grid func-
tion is enabled, objects that are drawn will automatically “snap” (be aligned)
on this “grid” pattern. Use the Grid Point Spacing command to adjust the
density of the Grid points, and to display the grid or not.  Also, grid points
can be displayed as grid lines, not as dots.  Grid Points are not shown on the
GP unit’s display.
Select the pull down menu [Option]’s [Grid/Snap] command.

����� Grid/Snap Settings dialog box

Turns the display
of the Grid Points
ON or OFF

Designates the
Grid Point
display’s being
drawn on top of, or
under, screen
objects

Turns the Snap
function ON or OFF

Registers a Grip
pattern.

Registers the grid
pattern that has been
designated in Spacing
to the position high-
lighted in the Grid
Spacing List.

Sets up the grid
to the optimal 20
××××× 20 dot size

Enters the
desired Grid Point
spacing

Designates the grid
display style, i.e. as dots
or grid lines.

Enter the coordi-
nate for the start
point.

Set the start point
in a center area
that is to be the
start point for
calling up the
screen. (The start
point is set as the
default value.)

2.10.1 Grid/Snap
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Turning the Snap function ON or OFF can also be performed via the Grid/

Snap Tool Bar’s icons  and .

�����  Spacing

The Grid Point intervals are entered here.  The unit is a dot.  Input the
interval value for the X and Y axes, respectively.  The default value is 20
dots.

When clicking on [Touch Area], a 20 x 20 dot spacing will be automatically
designated, which is most suitable for the touch panel.

Select a desired grid pattern in Spacing and click on the  button.
Then, the selected grid pattern will be reflected to the current screen and will
also be displayed as the 6th selection of the Grid Tool Bar’s grid pattern
selection list.

�����  Grid Spacing List

Clicking on the  button changes Grid Spacing List’s highlighted set
value to Spacing’s set value and registers it.

The grid patterns registered here will be displayed on the Grid Tool Bar’s
grid pattern selection list box. A grid pattern selected from the grid pattern
selection list box will be reflected to the current screen.

�����  Snap

When the Snap check box is checked, the cursor will “snap” to the grid;
objects can only be drawn on points (start & end) along the grid.
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<When selecting Dot:> <When selecting Line:>

�����  Style

Select grid pattern display style from “Dot” and “Line”.

�����  Start Point



2.10 Efficient Drawing Technmiques Chapter 2 - Base Screens

2-282 GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

Here, the screen display’s environment is set up, which effects both the
method used  to draw screens and displaying the Part and Tag addresses.
The user’s work environment can be modified whenever necessary, helping
to reduce the time required for drawing.

Select the pull down menu [Option]’s [Screen Property] command or click
.

The display state of ID numbers, Tag Names, Device Addresses, Tag Marks,
and Window Marks can also be changed via the [Option] tool bar icons.

�����Fill
When creating a screen, the drawing can be controlled so that any Fills used
will either be displayed or not. If the “Fill” check box is not checked, all
Fills are not shown.  Using this feature will help you to speed up screen
redrawing time, and thus speed up screen creation.

When the “Fill” check box is not checked, the actual screen shown
on the GP unit may differ from the screen shown on your PC. To be
sure the display is correct, check the “Fill” check box ON at least
once, to verify the screen, before sending screen data to the GP.

����� Setting Screen Property - [Display]
The display state (displayed or not) of the items such as object Fill, Window
Mark, Window Part, Tag Mark, and setting information on Tags and Parts
can be selected.  Check the box of the items to be displayed.  When a box is
not checked, that item will not be displayed.
The settings on this screen will be applied to all the screens.  Properties
cannot be set up for individual screens.

2.10.2 Screen Property Settings
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�����Fill Point

When this feature is selected, specified Fill points will appear with an “X”
mark, which is especially useful when selecting Fill points.
If the Fill Points are not displayed, Fill cannot be performed while editing.

The X (cursor position) mark’s color can be designated in the system’s
[Color] area.

�����Multiple Open with Next/Prev

When selecting [Previous Screen]/[Next Screen] from the [Screen] menu, or
opening a screen with the Open Screen switch , specify whether the
next screen is opened with the currently active screen open or after that
active screen is closed. Up to 20 screens may be opened continuously.

����� Display in Load Screen Object

You can specify whether tag and part addresses, ID numbers, tag names, and
tag marks on a screen which has been called up using the [Load Screen]
command are displayed or hidden.

����� Load Screen Double Click

Specify an edit method for editing a screen that has been called up on
another screen where the [Load Screen] command was executed, or for
editing a screen on the Screen List.

If [Change Attribute] is specified, the Load Screen dialog box will be
opened, enabling you to select a screen to be called up (screen number).

If [Edit Screen] is specified, the screen that has been called up will be
opened, allowing you to edit the data.

����� Window Mark

Designates the window mark display state, i.e. displayed or not displayed.
The window mark shows an area that has been registered as a window.

  3.7 Window Display: Window(U) Screen and
   Base(B) Screen

����� Display in Window Part Screen

Designate whether the contents of the window part placed on the Base
screen will be displayed or hidden.
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A-tag, a-tag (Type depends
on border settings)

G-tag
g-tag

n-tag

P-tag (display depends on
the designated display
format and Tag mark)

H, J, and L, I
and W-tags

k, T, and
t-tags

R-tag

M-tag

F-tag

E, K, N,
and S-
tags

d-tags (display depends on %
and the data display’s ON/OFF
settings)

D-tagC-tag

V-tag

Q-
tag

U-
tag

X-tag

����� Tag Mark

Designates whether or not the Tag Mark is displayed while a screen is being
drawn. Tag Marks show the point or area specified for a Tag. However, a/A/
D-tag marks and G/g-tag’s Pie/Half-Pie/Meter Tag marks will always be
displayed, no matter what this setting is.

<Example>

v_0000
v-tag
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�����Tag Name

Designates whether or not the Tag Name is displayed while a screen is being
drawn. Also, display colors can be selected.

�����Parts ID

Designates whether or not a Part’s ID number is displayed on the Base
screen. Also, display colors can be selected.

�����Device Address

Designates whether or not Part and Tag Addresses are displayed on the Base
screen.  Part Addresses appear below the ID number, and on Tags, below the
Tag Name. Also, display colors can be selected.

�����Information Data Size

Selects the character size displayed from Standard (half size) and Minimized
(1/4 size) for ID No., Tag names, and Address.

����� Move Tagname Separately

Whether or not the Tag Name and Address display position is also moved
when Tag Marks are moved is designated during screen creation.  If this
function is selected, when Tag Marks are moved, Tag Names and Addresses
will be not moved.

����� Used Hairline Cursor

Changes the arrow cursor to the hairline cursor.
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����� Setting Screen Property - [Color]
Select the Grid, Fill Point, and Screen Background colors here.  When the
drawn image data’s and system’s colors are the same, the screens will be
hard to see. Here, these colors can be changed to remedy that.

����� Grid Color

Selects the grid point’s color.

����� Fill Point Color

Fill Points designate the point where a fill will begin; this setting determines
the color of the fill point.

����� Screen Background

Select the Base screen’s background color; the color selected here is also
displayed on the GP.

· If any background color is specified for the screen to be
loaded, no on-screen object will be displayed on the GP unit.

· To load a screen whose background color was specified,
specify the loading position at the center of the screen.
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����� Setting Screen Property - [Display Area]
Select a GP unit with a lower level of resolution than the current one.
If the screen display area is different between GP units with different resolu-
tion levels, part of the screen may become invalid.  With this function, you
can confirm the screen area that can be displayed on a different resolution
GP unit beforehand.

With this feature, you can confirm how an image will appear on the GP unit.
This image will differ depending on each GP display device type.
Select the [Preview] from the [View].
Select the
type of
display used

<List of Display Area Resolutions>
Display Area Size GP Models

640 x 480 dots GP-570, GP-571, GP-870, GP-577R, GP-2401H, GP-2400,
GP-2401, GP-2500, GP-2501

640 x 400 dots GP-470, GP-477R

320 x 240 dots GP-H70, GP-270, GP-370, GP-377, GP-377R, GP-2301H,
GP-2300, GP-2301

2.10.3 Preview Screen
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����� Screen Data Display
The designated type of object(s) data is displayed.  If a grouped object
contains at least one object whose type has been designated, it is displayed
as an grouped object.
The Screen Data List displays the following information:

Drawing ................. Type and coordinates of a drawing object
Tag ......................... Tag Name and Address
Part ......................... ID Number and Address
Grouped object ...... Grouped object’s coordinates and each grouped object’s

information

D-Scripts are displayed as tags. Each D-Script shows ID and description
information.

����� Selecting an Object
The object selected from the list will be displayed with handles (i.e. se-
lected) in the Screen Editor.  To select multiple objects from the list, Left-
drag them, or hold the            or           key down and click on desired ones.

�����  Link Select

Normally, when any object is selected with the Screen Editor, it will not be
displayed on the list. If the check box for [Link Select] is marked, an object
selected with the Screen Editor will also be selected (highlighted) on the list.

The currently displayed screen’s object locations and setting attributes are
listed in the Screen Data List.

����� Screen Data List
An example of the Screen Data List is shown below.

Displays the object
placed on the
currently displayed
screen

Edits the object
selected from
the Screen Data
List

Deletes the object
selected from the
Screen Data List

Designates the
type of the object
to be displayed in
the Screen Data
List

Shift Ctrl

Highlights an
object selected on
the screen.

Changes the order
of drawing objects

2.10.4 Screen Data List
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����� Editing an Object

To edit an object, select it from the list and click on the  button; or
simply double-click on the object.

If the object is D-Script, D-Script Editor will be actuated.

Clicking on the             button deletes the selected object.

�����  Change Order

Objects are displayed on the list in the order where they have been drawn. If
the order of objects on the list is changed, the overlapping order of drawn
objects and the executing order of tags and parts can also be changed.

�����  Copying

Any object on the list can be copied by pressing the         +     , or pasted by
pressing the         +       keys. Multiple objects can be copied at a time by
selecting them.

Delete

CCtrl
VCtrl
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When either modifying or deleting...

 or the

Esc  key

After selection,
either modify or
delete the Part

Select
desired
Part

[Parts List][View]

Usage Pattern

→→→→→→→→→→→→→→→→→→→→

Shows a list of
the Parts on the
currently
selected
screen.  Simply
click on the
desired Part

Deletes the
selected Part

Changes Part’s
settings

Closes the current screen.
(The  Esc  key can also be
used)

Use this scroll bar
to view all the data
on a long screen

Can be edited directly Can be edited by
double-clicking

����� Editing Items on the Part Reference List
Part setting data can be changed directly on the Part Reference List.
Click on the left-most number of a Part to be changed, and it will be high-
lighted; then, click on the  button, and the Part’s Dialog box will
appear and its settings can be changed.
Setting items, such as the Description and Address areas, can be changed via
the Part Reference List.  Also, items displayed in gray can be changed in the
dialog box by double-clicking on the inside of their border.

An example of the Part Reference List on a screen is shown below.

The settings for each Part placed on the currently edited screen are listed
here, for each Part type.  Part settings can also be changed on the Part
Reference List.

Copies a part

Pastes a part

Reflection of device comment
The device comment corresponding to an
entered device address overwrites the Descrip-
tion field.

The tab width for each item can be adjusted by placing the mouse pointer on
the border between items and then dragging it.

Stores the
Parts list
information as
a CSV file.

2.10.5 Part Reference List
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Note: For the labels and messages of more than one line, use “\\”  as the carriage
return.

����� Deleting Items from the Part Reference List
Parts can be deleted directly from the Part Reference List.
Click in the middle of a Part to be deleted, and it will be highlighted.  Then,
click on the  button, and a dialog box will appear. Clicking on the

 button will delete the Part from the Part Reference List.  To close
the box without deleting the Part, click on the  button.  When
multiple Parts are selected, all the Parts will be deleted by clicking on the

 button, and by clicking on the  button, the box will be
closed.

����� Copying a Part on the Parts List
Any part can be copied on the parts list.

Select the left-most number for the part being copied by clicking on that
number. The selected part will be highlighted. After this selection, click on
the  button and then the  button. The part will be copied to
the bottom line of the list.

����� Reflecting a Device Comment on the Parts List
The device comment corresponding to an entered device address can be
entered on the parts list by clicking on a specified button. This can be done
in either of the following two ways:

1. Select the address setting field and click on the [Apply De-
vice Comment] button.
The device comment corresponding to the selected address will be
reflected in the Description field.

2. Select a part by its line and click on the [Apply Device Com-
ment] button.
If there are multiple address setting items for that part, the descrip-
tion corresponding to the address specified in the [Address Table
for Automatic Input of Device comment]  will be reflected in the
Description field.

 2.4.7 �  Reflection of Device Comments
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����� Exporting a CSV File
The Parts list information can be saved as a CSV file.

You can also select whether the currently selected page (tab)’s information
will be exported or the entire page will be exported.
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Tags and their setting attributes (type of data) specified on the current screen
or in a Project File can be listed; the setting attributes can also be changed
on the Tag List. The Tag List will be displayed separately for Local Setting
(Tags specified for each screen) and for Data Sampling Settings specified
commonly for all the screens.  When using a Handy-type GP (GP-H70/
GP2000H series) unit, the Global function keys will also be displayed.
When using an ST Series unit, the setting for Backlight Color Change will
also be displayed. The Tag List for Local Setting and Tag data setup for each
screen will be displayed.

The following is the Tag list (local) screen example.

The edit method of this list is the same as that of the Parts list.

2.10.5 Part Reference List

Lists all the Tags used on the currently open screen.
Select the desired Tag to list its type of data

Click on 
to close the Tag
List screen.
Pressing the
key will also close
the screen

If Tag has been grouped, an asterisk will
appear here.

2.4.12 Group/Ungroup

Moves Tag
one position
lower on the
list

Moves Tag
one position
higher on the
list

Deletes the
selected Tag

Opens the
selected Tag
for editing

Esc

Using Device
Comment
Here, the device
comment that
corresponds to
an device ad-
dress is auto-
matically written
in the Descrip-
tion field.

Copies Tag
Pastes Tag

2.10.6 Tag List

Usage Pattern When editing or deleting...

[View] →→→→→ [Tag List]
[Local]
or
[Data
Sampling]

→→→→→ Select Tag→→→→→
Edit
or
Delete

→→→→→ →→→→→ or
the          keyEsc
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· The tab width for each item can be adjusted by positioning the mouse
pointer on the border between items and then dragging it.

· For Handy-type GP (GP-H70/GP2000H Series) unit, the Tag names speci-
fied via the Local function keys will become “OP_*_***” or “F*_*_***”,
thereby allowing you to distinguish in the Tag List whether the Tag was set
up via the Local function keys or on the screen.

 2.11.1 Function Keys

 Changing the Tag Setting Order
The Tags will function in the order that they have been set up (the order
displayed on all the pages of  the Tag List) on the GP screen.  To change this
order, click on either the  or  key.  When multiple Tags are
grouped, that group will be moved up or down.

 Exporting a CSV File
The Parts list information can be saved as a CSV file.

You can also select whether the currently selected page (tab)’s information
will be exported or the entire page will be exported.

 2.10.5 Part Reference List  Exporting a CSV File

Scrolls the
display left, right,
up and down
when the Tag List
is bigger than the
screen size

<Individual Tag List Screen>

Saves the Tag
List in a CSV file
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2.10.7 Cross Reference List

The Cross Reference List feature is useful when displaying the current
address condition of Tags and other items. Here, the exact address used for
each Tag can be checked.

Cross reference will be displayed for local settings (each screen’s Tags, D-
scripts, and Parts), and data sampling and global D-scripts registered for all
the screens. If you use the Handy-type GP (GP-H70/GP2000H Series) unit,
the global function key settings will also be displayed.
When using an ST Series unit, the setting for Backlight Color Change  will
also be displayed.

The Global Cross Reference List feature does not sort the settings by func-
tion and screen; it displays the current address conditions of the entire
Project file (including the GP system) in a list.

· Since, to display the global cross reference, address information for all the
screen will be acquired, it can take a long period of time.

· The global cross reference does not display the condition of addresses that
have been designated via [GP System Settings].

· After changing the GP model (GP type), addresses specific to the previous
GP model (type) may be displayed. (For example, when changing GP-H70/
GP2000H Series to the other model, this may occur.)

 Cross Reference (Local, Data Sampling, Global D-script)
Usage  Pattern

→→→→→[View] →→→→→
[Cross Refer-
ence List]

Select
either
Word or
Bit units

→→→→→ or
the         key

An example of the Cross Reference List dialog box (in the case of Local) is
as shown below.

Esc

[Local]
or
[Data
Sampling]
or
[Global
D-Script]
or
[Extended SIO
Script]

→→→→→ Confirm →→→→→

Select whether to
display by Bit
Address or Word
Address

Selects the Address
Display condition

Click to change
the Display Start
Address
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����� Global Cross Reference
The global cross reference has two display methods, i.e. list display same as
the standard cross reference and address map display. This feature enables
you to go to the screen that uses the address you want to edit, to convert
addresses in one operation, and to make a reference to an address.

· Limitations exist regarding the display of the following addresses with the
global cross reference that was designated when the GP System was set up.
(To set up the GP system settings, select  from the Project
Manager menu, and configure the settings in the [GP System Settings]
dialog box.)

· The "Alarm Trigger Count Write's Start Address" designated in the [Q-
Tag Setting] dialog box on the [Extended Settings] tab (by clicking on the

 button) is not displayed.

· The [Watch Dog] address designated on the [Extended Settings] tab will not
be displayed when the "Time" is set to "0" seconds.

· As for the [System Start Address] designated on the [Mode Settings] tab,
only the designated System Start Address will be displayed regardless of the
total number of words used in the system area and the reading area size.

Usage  Pattern

→→→→→[Utility] →→→→→
[Global Cross
Reference] Start address search.

→→→→→

[List]
or

[Map]
→→→→→

Confirm →→→→→Select either Word or
Bit Address.

 or
        key to exitEsc→→→→→

→→→→→
 to

edit address

 to
change addresses→→→→→
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The following is the overview for the global cross reference screens.

�  List Display

For local settings, which screen is used, and for global settings, function
type will be displayed, respectively.

Selects whether setting conditions are dis-
played for Bit Addresses or for Word Addresses.

Changes the display
start address to be
displayed.

Selects the range of
Addresses to be
displayed.

�  Address Map Display

When selecting Word Address, the table cells from Word Address Bits 0 to
15 (for 32 bit device, from 0 to 32) will all be filled. When selecting Bit
Address, only bit cells currently used will be filled.

Selects whether
setting condi-
tions are dis-
played for Bit
Addresses or for
Word Addresses.

Displays the Bit
location.

Click to select the
screen in which the
address you want
to edit is used, or
go directly to the
desired screen.

Click to convert the addresses in
one operation. 4.2.4
Converting Addresses and Device Codes

Click to select
the screen in
which the ad-
dress you want
to edit is used, or
go directly to the
desired screen.Click to convert the addresses in

one operation. 4.2.4
Converting Addresses and Device
Codes
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�  Changing Addresses

You may move to the drawing screen of the specified address from the
global cross reference, or change addresses.

On the global cross reference list, double-click on the column of the address
you wish to change. Or, click on the  button to open the [Start
Address] dialog box, specify the address before the change, and click on the

 button.

When selecting an address designated on the Base screen, Trend Graph
screen, Keypad screen, Video screen or Window screen, open the screen by
double-clicking on the address or by clicking on the  button
after selecting the desired address.

When the specified address is used only on one screen, the screen will be
displayed directly. When the specified address is used on two or more
screens, the [Open Screen] dialog box appears. Select the desired screen
(two or more screens can be selected) and click on the  button.

Specify the address.

Double-click

The Global Cross Reference dialog box closes when the drawing screen
opens.
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�  Address Block Conversion

The addresses listed on the Global Cross Reference dialog box (all ad-
dresses in the Project and GP system addresses, excluding the addresses
registered as symbols) can be converted into different addresses in one
operation simply by clicking on the  button.

4.2.4 Converting Addresses and Device Codes
The Global Cross Reference display is automatically updated after the
Address Block Conversion operation.

• Among the tags and parts, the ones corresponding to both bit addresses and
word addresses are cross-referenced with both of those addresses on the
Cross Reference List even if they were placed by specifying their bit ad-
dresses.

Example: A tag (part) placed at bit address, X0000F is displayed as word
address, X00000.

• In the case of the Handy-type GP (GP-H70/GP2000H Series) unit, tag
names on the setting list can be used to distinguish tags added with local
function keys from ones added on screens. The tags added with local func-
tion keys are named as “OP_*_***” or “F*_*_***”.

2.11.1 Function Keys

����� Changing Display Addresses
When [Used] is selected on the cross reference or global cross reference list
display, the addresses that have been used for the Tags, Parts, and Extended
SIO Scripts in the currently opened screen or Project (including the GP
system) are displayed.  When selecting “All Addresses”, all the addresses
beginning with the Start Address will be displayed.  To change the Start
Address, click on the  button, and the Dialog box shown below will
appear.  Set the Start Address and click on the  button, and the
display will show from that address on.

Enter the Start
Address
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For the global cross reference’s address map display, the map display start
address can be designated when toggling Bit and Word display.

When clicking on  or , the following dialog box will
appear. After selecting Bit or Word, designate the start address. Then, click
on the  button and the cross reference display will start from the
designated start address.

Enter an
Address
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The Load Screen List will be displayed on the currently edited screen.  With
this list, you can check the setting attributes of a screen to be loaded and
also can change its loading location.

When editing or deleting...

[View] Load Screen
List→→→→→ →→→→→

Select a screen
to be loaded →→→→→

Edit or
Delete

or
Esc

→→→→→

General Load Screen Summary List

Lists all the screens loaded on the currently open screen.  Select the
desired screen to show its setting attributes.

Click on to close
the Load Screen
List screen.
Pressing the
key will also
close the screen

Deletes a Load
Screen List

Changes Load
Screen List
Settings

Esc

����� Editing via the Load Screen List
Screen settings can be changed using the Load Screen List.
Clicking on the left-most number of a screen to be changed will select
(highlight) it.  Then, clicking on the [Edit] button will bring up the [Load
Screen] dialog box or the currently called-up screen, allowing you to edit the
screen. The procedure for calling up and then editing a screen varies de-
pending on the settings in the [Load Screen Double Click].

 2.10.2 �����  Setting Screen Property - [Display]
Any coordinate setting can be changed directly via the Load Screen List.

2.10.8 Load Screen List

Usage  Pattern
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����� Deleting from the Load Screen List
Screens can be deleted from the Load Screen List.

Clicking on the left-most number of a screen to be changed will select
(highlight) it.  To delete multiple Load Screen Lists simultaneously, simply
drag the cursor to select the screen numbers.  Then, click on the 
button, and the dialog box will appear to confirm the command.  If you click
on  button, the screen will be deleted.  To cancel the request, click

on the  button.  When selecting multiple screens, click on the
 to delete all of them, and click on  to cancel any dele-

tions.
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The nesting of Load Screens that have been set up on the currently edited
screen is displayed. In this way, a multiple nesting condition can be viewed.

  2.2.10  Load Screens  ����� Nesting
Select the [View] menu - [Load Screen Nesting Display] command.

2.10.9 Display of Screen Level Change Structure

Each screen will be displayed via the following symbols:

Screen Type Symbol
Base screen B
Mark screen M
Trend Graph screen T
Keypad screen K
Image screen I
Image screen - CF card I(CF)
Window screen U
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2.11      Creating Handy-type GP Screen
The following screens are for the GP-H70/GP2301H and GP2401H units.

Creates an
Operation
Switch

Function Keys setting area

When using the GP-
H70/GP-2301H
series unit

When using the GP-
2401H series unit
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Deletes the
registered
Function Key
Settings

There are Function Keys on each side and you can set up each one as a Tag
(T-tag, t-tag, k-tag) for touch input.  GP-H70/GP-2301H series has six
Function Keys and GP-2401H series has eight keys on each side.
These Function Keys can be specified for Local Use or Global Use.  With
the Local Function Key Setup, the Function Keys can only be used by the
designated screen.  With the Global Function Key Setup, the Function Keys
can be commonly used by all screens.
The number of Tags that can be registered on a GP panel as Global Function
Keys is limited to a total of 24 T, t and k-tags.
The following Tags together with other Tags designated on the screen can be
used for a single screen’s Local Function Keys (except the Tags desingated
for Function Keys).
GP-H70 series :128
GP2000H series :384
Registering a single t-tag as a Global Function Key, however, requires 2
Tags.
If a Function Key is set up for both Global and Local use, then the Tags
specified as Global will be performed first.
All Tags registered as Function Keys cannot use the AUX output or Reverse
Video features.

����� Function Key Settings
An example of the Function Key Setting screen is shown below.

Lists the regis-
tered Function
Key Settings

Registers
additional
Function Key
Settings

Changes the
registered
Function Key
Setting attribute
data

2.11.1 Function Keys
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����� Setting Up Local Function Keys
The Local Function Key Setting procedure is described.  An example of using the
GPH70L/GPH70S/GP2301HL/GP2301HS is as follows.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Double-click on any of the Function Keys displayed.

(2)Click on the [Function Key Settings] screen’s
 button.

(3)Click on the Tag Name to be used. Multiple Tags can be assigned to a
Function Key; however, there is a
limit to the number that can be used.

(4)Enter the Tag setting data.  After all the attributes
have been entered, click on the  button to
register the entered data.

For details of each
Tag’s setting data, refer to Tag Ref-
erence Manual, Chapter 2  Active
Image Functions.

When using the GP-2401H series
unit, there are eight Function Keys
including the Operation switch on
each side .

When using the GPH70L/GPH70S/GP2301HL/GP2301HS series
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PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

Displays the
registered
item

(5)Click on the  button to quit the Function
Key registration.

����� Setting Up Global Function Keys
The Global Function Key Setting procedure is described.  An example of using the
GP-H70/GP-2301H series is as follows.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Click on the [Special] menu’s [Global Fn Key].

(3)Click on the  button.

(2)Double-click on any of the Function Keys displayed.

Before this selection, open any
Base screen.

To register another item, DO NOT
quit here, rather start again from
step (2).

When using the GP-2401H series
unit, there are eight Function Keys
including the Operation switch on
each side .

When using the GP-H70/GP-2301H series
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PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(4)Click on the Tag Name to be used.

(6)Click on the  button to quit the Function Key
registration.

(5)Enter the Tag setting data.  After all the attributes
have been entered, click on the  button to
register the entered data.

Multiple Tags can be assigned to a
Function Key, however, there is a
limit to the maximum number.

For details of each
Tag’s setting data, refer to Tag Ref-
erence Manual Chapter 2  Active
Image Function.

Displays the
registered
item

To perform the registration continu-
ously, DO NOT quit here, start from
step (3) again.

����� Notes for the Function Keys
If changing your GP type from GP-2401H series (16 Function Keys) to GP-
H70/GP-2301H series (12 Function Keys)/ST series (6 Function Keys) or
vice versa, some keys may be shifted from the designated place due to the
difference of Function Keys.
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2.11.2 Setting Up the Operation Switch

This section describes the procedures for setting up the Operation Switches
supported by the GP-H70/GP2000H series.
The features of the Operation Switch are as follows:
(1) An Operation Switch can be used as a Function Switch.
(2) An Operation Switch can be used to enable Inputs from the touch panel
     and Function Keys.
For details of feature (1), see the setup procedures in Section 2.9.1 "Function
Keys."
Feature (2) is activated only when the Operation Switch is enabled. The
procedure for enabling the Operation Switches is described below. If the
Operation Switches are disabled, only feature (1) is available.
When using a Front Face Operation Switch for use of Feature
(2), select [2 Point Touch] in the [Touch Input Mode] setting in a
GP's [INITIALIZE] menu (OFF-LINE mode) or the [I/O Settings]
tab in the [GP Settings] dialog box. If the [2 Point Touch] is not
selected, Inputs from the touch panel and Function Keys are not
enabled even with the Front Face Operation Switch pushed.

· The function of the Operation Switch can be "enabled" or "disabled" in the
GP’s  INITIALIZE menu (OFF-LINE mode). Refer to GP-H70 Series
User's Manual/GP2000H Series User's Manual.

 Setting Up the Operation Switches with the GP-H70
 The Position of the switches

The GP-H70 has two Operation Switches; one on the front face and one on
the rear face.

Usage  Pattern

→→→→→
[Screen/
Setup] →→→→→[GP Setup]

Check the box to activate
"Operation SW"

→→→→→

[Extended
Settings] →→→→→

or   to close the dialog box

→→→→→
or

 Default Settings of the switches

According to the default settings of the GP-H70, both Operation Switches
are enabled with the dialog box below.

<Front View> <Rear View>

Front Face
Operation Switch

Rear Face
Operation Switch

The "Operation SW” is
checked by default.
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����� Settings for Using the GP2000H Series in GP-H70 Standard
Mode
This setting allows you to use the switch located on the rear of the
GP2000H series as an Operation Switch. Change the hardware settings of
the GP2000H and select "GP-H70 Standard Mode."

 For detailed procedures on setting up the hardware, refer to
the GP2000H Series User's Manual.
To ensure that inputs from the touch panel and Function Keys are entered
only when the Operation Switches are being pressed, change the default
setting and select the "Enable" setting option of the Operation Switch.

The switch located on the rear of the GP2000H can be pressed down in two
positions. Pressing down the switch firmly to the second position disables
the touch inputs. Be sure to press down the switch to the first position only.

· If the Operation Switches are enabled, do not hold down both the front
Operation Switch and rear Operation Switch simultaneously when per-
forming touch input. Doing so disables touch input. Make touch input while
holding down only one of the switches.

����� Setting Up the Operation Switches with the GP2000H
����� Positions of the switches

The GP2000H has one Operation Switch on the front.
<Front View>

Operation Switch

����� Default Setting of the switch

According to the default settings of the GP2000H, the Operation Switch is
disabled.  When the GP is operated under the default settings, the inputs
from the touch panel and Function Keys are enabled.

The “Operation SW” is unchecked by default

· The GP2000H and the GP-H70 differ in the number of Operation Switches
and the default settings of the switches. Note this difference when switching
from the GP-H70 series to the GP2000H model.
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2.11.3 Vibration Function

Usage  Pattern

→→→→→[Special] →→→→→
[Global
Vibration]

Add or
Edit or
Delete

→→→→→

This function activates the internal motor of the GP to generate a vibration.
This is a global function for all screens. Up to sixteen Global Vibration
settings can be set up within a single Project File.
· Only the GP2000H series supports the Vibration Function.

   to complete the setting

Below is a brief description of the Global Vibration Screen.

Delete the registered
Global Vibration.

Displays the
Monitor Ad-
dress and
Descriptions of
the registered
Global Vibra-
tion settings in
a list.

Register a new
Global Vibration.

Modify the settings of
Global Vibration.

Copy a Global
Vibration.

Paste the Global
Vibration that was
copied.
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����� Setting Up Global Vibration with the Bit Address
This section briefly describes the Global Vibration Screen when the "Bit
Address" is being designated for the monitoring function.

Enter a
description
as necessary.

Select the
address to be
monitored.

Enter the bit
address for
activating the
vibration.

Enter the
vibration
conditions.

Select the
operation
mode for the
vibration.

Designate the
duration of
the vibration.
(Available
range: 1 to 60
seconds)

Enable/Disable
the buzzer.

����� Mode

Select either the Bit Address or Word Address for the device to be moni-
tored.

����� Address

Enter the Bit Address used to trigger the Global Vibration here.
����� Trigger Type

Designate the condition that triggers the vibration. Select "0 to 1" to trigger
the vibration when the bit makes the 0-to-1 transition; select "1 to 0" for the
opposite condition.

����� Vibration Pattern

Select either Continuous or Interval mode for the vibration pattern.
· Continuous: The vibration continues for the period specified under the
  "Vibration time" option without interruption.
· Interval: The vibration repeatedly activates for 0.5 seconds followed by
  a 0.5 second pause for the period specified in the "Vibration time"
  option.
Example:
Vibration time: 3 seconds

3 seconds

Continuous

Intermittent

Intermittent Intermittent Intermittent

0.5
seconds

0.5
seconds

0.5
seconds

0.5
seconds

0.5
seconds

0.5
seconds

Vibration Vibration Vibration

Vibration
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����� Vibration time (Auto OFF time)

Specifies the duration of time after the vibration has been triggered.

The available range is from 1 to 60 seconds. The default setting is 10 sec-
onds.

����� Buzzer

When this option is enabled, the buzzer sounds according to the selected
Vibration Pattern.

The buzzer will not sound if "Touch Buzzer Sound" is disabled in [System
Setup] under the Project Manager's  window, even when the
"Buzzer" function is enabled here.
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����� Mode

Select either the Bit Address or Word Address for the device to be moni-
tored.

����� Address

Enter the Word Address used to trigger the Global Vibration here.

����� Alarm Range

The vibration is triggered when the value of the word address being moni-
tored exceeds the specified range. The Word Address is 16 bit, unsigned.

����� Vibration Pattern

Select either Continuous or Interval mode for the vibration pattern.

· Continuous: The vibration continues for the period specified under the
  "Vibration Period" option without interruption.

· Interval: The vibration repeatedly activates for 0.5 seconds followed by
  a 0.5 second pause for the period specified in the "Vibration Time"
  option.
Example:
Vibration time: 3 seconds

����� Setting Up Global Vibration with the Word Address
This section briefly describes the Global Vibration Screen when the "Word
Address" is being designated for the monitoring function.

Enter a
description
as necessary.

Select the
address to be
monitored.

Enter the
word address
for activating
the vibration.

Enter the
vibration
conditions.

Select the
operation
mode for the
vibration.

Designate the
duration of
the vibration.
(Available
range: 1 to 60
seconds)

Enable/Disable
the buzzer.

3 seconds

Continuous

Intermittent

Intermittent Intermittent Intermittent

0.5
seconds

0.5
seconds

0.5
seconds

0.5
seconds

0.5
seconds

0.5
seconds

Vibration Vibration Vibration

Vibration
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����� Vibration time (Auto OFF time)

Specifies the duration of time after the vibration has been triggered.

The available range is from 1 to 60 seconds. The default setting is 10 sec-
onds.

����� Buzzer

When this option is enabled, the buzzer sounds according to the selected
Vibration Pattern.

The buzzer will not sound if "Touch Buzzer Sound" is disabled in [System
Setup] under the Project Manager's  window, even when the
"Buzzer" function is enabled here.

����� Vibration Modes
Operation examples of vibration*1 are shown below.

1) The vibration of the GP unit is triggered according to the settings when
    the specified Condition is satisfied*2.

Satisfied

Vibration Condition
Not satisfied

Vibration Vibration

2) The vibration is not triggered a second time even if the Vibration
    Condition is satisfied again while the vibration is ON.

Satisfied

Vibration Condition
Not satisfied

Vibration Vibration

*1: The vibration continues for the period specified in the "Vibration time"
option in the [Global Vibration Settings] dialog box. The vibration is triggered
when the Vibration Condition is satisfied regardless of the period required for
the vibration to be completed, automatically stopping after the specified pe-
riod has elapsed.

*2: To trigger two consecutive vibration responses, hold the Trigger OFF time
(the state in which the Vibration Condition is not satisfied) for the longer of
the following two periods: the communication cycle time or the tag scan time.
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3) The vibration in response to Vibration Condition (2) is triggered after the
    vibration in response to Vibration Condition (1) ends.

Satisfied
Vibration Condition 1

Satisfied
Vibration Condition 2

Vibration Vibration 1 Vibration 2

Not satisfied

Not satisfied

4) If Vibration Condition (2) is not satisfied, no vibration is triggered after
    the vibration in response to Vibration Condition (1) ends

Satisfied

Not satisfied
satisfied

Not satisfied

Vibration Condition 1

Vibration Condition 2

Vibration Vibration 1



2.11 Creating Handy-type GP ScreenChapter 2 - Base Screens

2-317GP-PRO/PB III  for Windows Ver. 7.2  Operation Manual

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

If two or more Vibration Conditions are satisfied at one time, vibrations are
triggered in the sequence specified in the settings. However, note that the
vibration may not be activated in the sequence specified with the GP-PRO/
PB III, as activation depends on the timing of the communication readouts
and internal monitoring.

����� Setting Up the Global Vibration Function
The Global Vibration Function setting procedure is described below.

(1) In the Screen Editor, select [Global Vibration] from
the [Special] menu.

(2) Click the  button, and set up the Global Vi-
bration function.

(3) [Setting up the Global Vibration with a Bit Address]
Enter the required options, and click .
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PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

[Setting up the Global Vibration with a Word Address]
Enter the required options, and click  .

(4) Review the details of the settings in the Global
 Vibration window, and click  to close the
 dialog box.

Up to sixteen Global Vibratio set-
tings can be set up within a single
Project.

When two or more trigger condi-
tions for the Global Vibration set-
tings are satisfied at one time, vi-
brations are executed in the se-
quence registered in the Global Vi-
bration settings. However, note that
internal conditions may prevent the
vibrations from being generated in
the specified sequence.

Clicking the  button displays the
following dialog box.

Click  to close the [Global Vibration]
dialog box without saving the changes you have
made.
Click  to return to the [Global Vibration]
dialog box.
Click  to complete the setup operation.
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2.12      Creating ST Series Screen
Be sure to read the following section prior to using your ST Series unit.

The following screens explain the ST400, ST401, ST402 and ST403 (here-
after called "ST")  units.

Function Key
Setting Area

(ST Edit Screen)
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Deletes regis-
tered function
key settings

The panel contains 6 function keys. Use these keys to perform touch input
tag (T, t and k tag) settings.
There are two types of function key tag settings: local function key settings,
and global function key settings. Local function keys operate only in the
screen in which they have been set up. However, global function keys
operate on all screens in which they have been set up.

No. of Tags that can be set using Function Keys

Registers newly
created function
key settings

Edits registered
function key
setting contents

2.12.1 Function Keys

Displays registered function
keys in list form.

*1 A single t-tag is counted as 2 regular tags.

When performing local function key and global function key settings simul-
taneously, global function key tag settings will be performed first.
Tags set using function keys cannot be used to perform AUX output or
reverse display.

����� Function Key Settings

Local
(for a single screen)

up to 384
(Total number of all tags on a single screen, however,
does not include tags set on function keys.)

Global
(Single project)

24
(Total number of T-tag, t-tag*1 and k-tags.)
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����� Setting up Local Function Keys
The Local function key setting procedure is explained below.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Double-click the function key you want to set up.

(2)Click .

(3)Click the tag you want to set for the function key. Multiple Tags can be assigned to a
Single Function Key; however,
there is a limit to the number that
can be used.

(4)After performing all item settings, click . For details regarding individual tag
settings,  Tag Ref-
erence Manual, Chapter 2, Active
Image Functions
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PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

Displays the
registered
item

(5)Click  to register your function key setting.

����� Setting up the Global Function Key
The Global function key setting procedure is explained below.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Select [Special (C)] menu's [Global Function Key (G)]
feature.

(2)Click the function key you want to set up.

(3)Click  .

Before this selection, open any
Base screen.

To continue setting up function
keys, repeat from step 2.

(4)Click the tag you want to set for the function key. k tag [Operation Mode] FEP set-
tings cannot be used, due to ST
hardware specifications
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PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(5)After performing all tag settings, click .

(6)Click  to register your function key setting.

Even though multiple tags can be
set up within a single function key,
there is a limit to the maximum
number of tags.

For details regarding individual tag
settings,  Tag Ref-
erence Manual, Chapter 2, Active
Image Functions.

Displays the
registered
item

To continue setting up function
keys, repeat from step 2.

����� Function Key Usage Notes
· In addition to ST units, function keys can also be used on Handy-type

GP units. For details regarding Handy-type GP unit function keys,
 2.11.1 Function Keys.

· The ST is designed to provide 6 function keys. When changing the GP
type unit selection to a Handy-type GP unit, function key positions may
change due to the difference in number of function keys. However, this
does not occur if the GP type in use before the change was GP-H70 or
GP-2301H series.

· When using ST unit function keys, the following [k-tag] → [Mode] area
features, even if set, will not operate.
- <Cancel> for Logging Setting
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2.12.2 Backlight Color Change

The backlight of the ST403 features two colors: amber and red. By switch-
ing the colors of the backlight, alarms and other information can be ex-
pressed without using the buzzer, sound outputs, or screen displays.

The backlight illuminates in amber during normal operation. The backlight
illuminates in red only when the Change condition of the desired device is
being satisfied.

The setting of the Backlight Color Change is common to all screens. Up to
16 Change conditions can be specified. The backlight illuminates in red
when at least one of the 16 Change conditions is being satisfied.

· The Backlight Color Change feature is supported only by the ST403.
· The backlight illuminates in amber during a screen transfer operation.
· When the Change condition is satisfied while the GP is in the standby

mode, the standby mode will be cancelled and the backlight will switch to
red.
While the backlight is illuminated in red, the GP will not enter the standby
mode even with the execution of the following events.

· When the display is turned off by turning ON/OFF the screen display of
the System Data Area

· When the specified standby duration has elapsed

[Function] →→→→→

Usage Pattern

[Backlight Color
Change]

Add/Edit/Delete Click on 
to complete the
setting.

→→→→→ →→→→→

The following provides an overview of the Backlight Color Change setting
screen.

Displays the list
of addresses to
be monitored for
registered
Backlight Color
Change settings
along with the
comments.

Used to add register
settings for the Backlight
Color Change.

Used to change the
settings of the Backlight
Color Change.
Used to copy the settings
of the Backlight Color
Change.
Used to paste the copied
settings of the Backlight
Color Change
Used to delete registered
settings of the Backlight
2-color
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 Setting Up the Backlight Color Change with the Bit Address
The following provides an overview of the Backlight Color Change when the "Bit
Address" is designated for the monitoring parameter.

Select the type of
device to be
monitored.

Enter the bit address
to be monitored.

Select the condition
for changing the
backlight color.

Enter a comment
as necessary.

 Mode

Select either the Bit Address or Word Address for the device to be moni-
tored.

 Bit Address

Enter the Bit Address to be monitored.

 Change Conditions

Specify the condition for changing the backlight color to red.

Condition for changing to red Status of the Bit Address Backlight Color
ON Red

OFF Amber
ON Red

OFF Amber

Bit ON

Bit OFF
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 Setting Up the Backlight Color Change with the Word Address
The following provides an overview of the Backlight Color Change when the "Word
Address" is designated for the monitoring parameter.

Select the type of
device to be
monitored.

Enter the word
address to be
monitored.

Select the condition
for changing the
backlight color.

Enter a comment
as necessary.

 Mode

Select either the Bit Address or Word Address for the device to be moni-
tored.

 Word Address

Enter the Word Address to be monitored.

 Alarm Range

Specify the condition for switching the backlight color to red. When the
word address that is being monitored exceeds the specified minimum or
maximum value, the backlight color turns to red.

The format of the word address is unsigned 16 bits.
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 Setting the Backlight Color Change
The Backlight Color Change setting procedure is given below.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)On the Screen Editor, select the [Function] menu-
[Backlight Color Change] command.

(2)Click on the  button and set up the Back-
light Color Change settings.

<When setting up the Backlight Color Change with the
Bit address>
(3)Select "Bit" and then enter the bit address to be moni-

tored.

Select Bit

Enter X00000

(4)Select the condition for switching to red and click on
the  button to confirm.

Select Bit ON
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< When setting up the Backlight Color Change with the
Word address>
(3)Select "Word" and then enter the word address to

be monitored.

When a comment is entered, it is
displayed in the list on the [Back-
light Color Change] dialog box.

Up to 16 Backlight Color Change
settings can be specified in one
project.

To set up another Backlight Color
Change, do not exit the setting
screen. Resume the operation from
Step (2).

When two or more Backlight Color
Change settings are specified, the
backlight color will switch to red if
one of the conditions is satisfied.

Select Word

Enter D00000

(4)Specify the Alarm range and click on the 
button to confirm.

Specify the Alarm
range.

(5)Review the settings on the Backlight Color Change
dialog box and then click on the  button to
close the dialog box.
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Clicking the  button will display the fol-
lowing dialog box.

Click the  button to close the Backlight
Color Change dialog box without saving the set-
tings currently being edited.
Click the   button to return to the Back-
light Change Color Change dialog box.
Click  to exit.
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2.12.3 Restrictions

Functions supported by the ST Series are basically the same as those sup-
ported by the GP-2301L Series of the GP2000 Series. In this manual, please
read the word "GP" (GP2000 Series or GP-2301L for the functions with
restrictions) as "ST". However, please note that an ST403 unit features an
Ethernet interface.

However, ST units have certain restrictions owing to hardware specification
differences with GP-2301L units. Be sure to understand this restriction
information thoroughly before using your ST unit.

· Functions not available with your ST unit are described in the [GENERAL
GP RESTRICTIONS] section. Please be sure to read this section.

 Touch Panel
According to ST hardware specifications, the minimum size touch area is
40X40 (dots).

 Direct Touch via Q Tag Alarm / File Item Display Device/ Logging Dis-
play Device

Due to the ST Series unit specifications, the ST unit’s touch panel can not be
operated when using the following functions.

· Q-tag alarm summary direct selection

· File item display's direct selection of filing data

· Logging display's direct edit of logging data

 Pop-up Keypad

When editing the Keypad Input Display's Pop-up Keypad, the Pop-up
Keypad library's 20-dot unit Keypad will not operate even when selected /
set.
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 Grid/Snap

If you choose an ST unit for your project's GP type (ST400/ST401/ST402/
ST403), the grid's initial setting will be 40 x 40, not 20 x 20.

For information about use of the Grid/Snap features,
 2.10.1 Grid/Snap



2.12 Creating ST Series Screen Chapter 2 - Base Screens

2-332 GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

 Extended Serial I/F
This feature's settings will vary depending on the type of ST Series unit you
are using.

 Serial I/F Switchover

This feature's usage and communication restrictions will vary depending on
the type of ST Series unit you are using. See the following table for details.

For details about the Serial I/F Switchover feature,   4.2.8
Changing Extend SIO Type
· ST series unit OFFLINE screens cannot be used to set the Serial Interface

Switch feature. This feature must be set via the editor software and the
project data then transferred to the ST Series unit.

 No Built-in CF Card Interface
The ST unit's design does not include a CF Card interface. As a result, CF
Card-related features cannot be used.

 Backup SRAM Capacity
The backup SRAM capacity of the ST unit is 96KB.
For detailed information,  Tag Reference Manual 4.11
Backup SRAM Capacity

 Screen Capacity
The screen capacity of the ST unit is 640KB.

Without I/F Switchover With I/F Switchover

ST400 Serial I/F
(D-sub 9-pin)

Standard Protocol
RS-422 (2-wire/4-wire)

Extended SIO Protocol
RS-422 (2-wire/4-wire)

ST401 Serial I/F
(D-sub 9-pin)

Standard Protocol
RS-232C

Extended SIO Protocol
RS-232C

Serial I/F
(D-sub 9-pin)

Standard Protocol
MPI

Extended SIO Protocol
RS-422 (2-wire) *1

Extended Serial I/F
(D-sub, 9-pin)

Extended SIO Protocol
RS-422 (2-wire/4-wire)

Standard Protocol
RS-422 (2-wire/4-wire)

Serial I/F
(D-sub 9-pin)

Standard Protocol
RS-422 (2-wire/4-wire)
/RS-232C Switchable

Extended SIO Protocol
RS-422 (2-wire/4-wire)/
RS-232C Switchable

Ethernet I/F Standard Protocol
Ethernet

Standard Protocol
Ethernet

Standard Built-in
I/F

Available Communication Method

ST402ST
Series

ST403

Series
Name

Model
Name

*1 When switching the serial I/F with the ST402, use the extended SIO protocol with the 2-
wire method of RS-422.
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2.13      DXF Conversion
This feature allows you to convert DXF (Drawing Interchange File) file data
into Base screen data, and to convert Base screen data into DXF file data.
(A DXF file is on Auto Cad® drawing file)

DXF filenames must be alphanumeric.
DXF can be used for the Release 12 program.  If a newer
version’s data is used, that data will not be converted.
When each object’s coordinates are converted, errors may
occur, thereby slightly changing them.
Once a DXF file data is converted into Base screen data, even if
the Base screen is again converted back into the original DXF
file, or vice-versa, the resulting data my be unusable.
When converting data, be sure that the screen’s width and
height ratio will be the same for both the Base screen and the
DXF file (Screen size settings:  $LIMMAX, $LIMMIN).  If this ratio
is different, after data is converted, object locations or shapes
will also be different from the original.

2.13.1 Conversion from DXF File to Base Screen (DXF →→→→→ PRW)

����� Requirements and Restrictions when Converting Data
(DXF →→→→→ PRW)
• Grouped objects (Blocks) can be nested up to 10 layers (levels deep).

• The DXF file data format is ASCII.  Both “CR LF” and “LF” can be used
as line feed characters and will be converted correctly.

• During conversion, when the resulting output file’s size reaches
16Kbytes, the conversion will quit, and subsequent data will not be
converted.

• Three dimensional data cannot be converted.

• If the X,Y coordinate screen boundaries ($LIMMIN, $LIMMAX) are not
set up correctly in the DXF file, after the data created in the DXF file is
converted into Base screen data, it may go beyond the Base screen’s
display area.

DXF file data is converted into Base screen data.

DXF file

Convert

GP-PRO/
PBIII Base
screen
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• After DXF file data is converted into Base screen data, the DXF file
name is used as the Base screen’s description.

• When a layer’s attribute has been turned OFF, that layer’s data will not be
converted, and only ON layer data will be converted into Base screen
data.

• Fill and Oval/Arc data cannot be converted.

 Option (DXF →→→→→ PRW)
Here, select and enter the color and size used when converting data.  Ac-
cording to the specified DXF and Base screen size, data will be relatively
magnified or minimized when converted.

 Convert Color

When this box is checked, DXF file data is converted as colored.  When this
box is not checked, DXF file data is converted as monochrome.

2.13.1    Color Conversion (DXF →→→→→ PRW)

 Convert DXF Size

The DXF file data conversion range is selected.
When “Use $LIMMIN, $LIMMAX” is selected, data in the DXF file’s
maximum screen area (X,Y coordinate screen boundaries) will be converted.
When “Use $EXTMIN, $EXTMAX” is selected, only data in the DXF file’s
object area will be converted.

 Convert GP Size

The Project File screen size (GP screen size) used after conversion is speci-
fied.

DXF size
Selects a DXF file
sizeConvert Color

Data is converted as
colored

Screen Size
Designates the
screen size used
after conversion
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����� Color Conversion (DXF →→→→→ PRW)
When the [Option] dialog box’s [Convert Color Data] check box is checked,
the DXF file’s color data will be converted as follows:

DXF File Base Screen 
CONTINUOUS  Solid line 
DASHED  Broken line 
HIDDEN  Broken line 
CENTER  A dot-dash-line 
PHANTOM  Two dot-dash-line 
Other  Solid line 

The background color will be converted into Black.

����� Line Type Conversion (DXF →→→→→ PRW)
Each DXF file’s line type will be converted as follows:

The user defined line types will be converted into solid lines.

����� Object Conversion (DXF →→→→→ PRW)
The DXF file’s objects will be converted as follows.
Colors and line types will be converted as shown above.  Tiling patterns will
be converted into solid Fill.

Objects other than the above will not be converted.

DXF File Base Screen 
LINE Straight line 
POINT (dot) Straight line (The start and end are the 

same point) 
CIRCLE Regular circle 
ARC Arc 
TRACE (thick line) Filled polygon 
SOLID (filled object) Filled polygon 
TEXT (characters and signs) Text 
DIMENSION (dimension indicator) Straight line 
INSERT (inserting object) Conversion breaks down complex 

objects into component parts (objects) 
ATTRIB (attribute) Conversion breaks down complex 

objects into component parts (objects) 
POLYLINE(polyline/donut-shaped/ 
oval/polygon/rectangle) Continuous straight line 

VERTEX Vertex coordinates of a continuous 
straight line 

DXF File Color No. Base Screen

1 (red), 1X (red-based) Red
2 (yellow), 5X (yellow-based) Yellow
3 (green), 9X (green-based) Green

4 (light blue), 13X (light blue-based) Light blue
5 (blue), 17X (blue-based) Blue

6 (purple), 21X (purple-based) Purple
7 (white) White

Other colors White
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Each object’s elements, other than colors and line types, will be converted as
follows:

����� POINT (dot)
• A dot’s pattern will be converted into “0” (point), and its display size will

be converted into “0,0”.
• A dot will be converted to a straight line, with the  start and end coordi-

nates at the same point.
����� TEXT (characters and signs)

• A rotation angle will be converted into an angle closer to 90°, 180°, 270°,
or 360°.  (in 90° units)

• The character size will be converted into a size closer to either 1, 2, 4, or
8 x magnification.

• Special characters that will be converted are %%d (°), %%c (φ), and
%%p (±).

• When text contains more than 100 characters, it will be divided every
100 characters into records of data and then converted.

• When more than 100 character text is divided into records of data, groups
of overflowing characters after the first 100 characters will be dislocated
toward the right bottom for a few dots.

• Tilting angles, character fonts, and character spacing will not be con-
verted.

• Text will be converted based on the ASCII code; therefore, the character
style (Standard, Bigfont, etc.) or font file settings will be ignored.

• When text with half-sized and full-sized characters mixed in vertical
lines is converted, the half-sized characters will be centered.

����� DIMENSION (Dimension Indicator)
• During conversion, the breaking down of a grouped object (Block) is

performed by referring to the Block’s sections, which indicate the Block’s
component parts (objects).  However, dots will not be converted.

����� INSERT (Inserting Object)
• A grouped object defined in the Block section will be broken down into

each drawing object and converted.
• Up to 10 layers of nested data will be converted.  However, since all the

data will be converted into a single layer on a single screen, the objects
over the limit (file capacity) will not be converted.

• Although the rotating angles, and the number of lines and columns can be
converted (lines and columns of the objects over the limit will not be
converted), their ratio (scaling) will not be converted.

• The grouped object created in Layer “0” will be converted based on the
inserted layer’s colors and line types, however, a grouped object created
in an other layer level will not be converted based on the inserted layer’s
colors and line types.  In this case, if BYBLOCK is specified to the
grouped object, the inserted layer’s colors and line types will be used.

• Simulated object sectioning (hatching) data cannot be converted, since,
when the Block section’s hatching data pattern is converted into each
drawing object, that data size can exceed the GP file capacity.

• If another file’s grouped object has been inserted or another file is re-
ferred, that grouped object will not be converted.

����� ATTRIB (attribute)
ATTRIB (attribute) data is part of INSERT data.
• Attribute data will be converted in the same manner as TEXT conversion.
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����� POLYLINE (polyline/donut-shaped/oval/polygon/rectangle)
• POLYLINE data will be converted connecting the following VERTEX’s

coordinates with a continuous straight line.  Only data whose polyline flag
is either “0 (default)”, “1 (closed polyline)”, “2 (adding the fit curve
vertex)”, or “4 (adding the spline curve vertex)” will be converted.

• When the number of vertices exceeds 100, data will be divided every 100
vertices and converted.

• When the converted data’s coordinates are repeated at the same point, the
following coordinates will be omitted.

• When a polyline has curved sections, they will not be converted.  There-
fore, donut-shaped lines and curved polylines will be converted into
continuous straight lines, connecting each coordinate point.

����� VERTEX
Top coordinates of a polyline.
• A polyline’s width will not be converted.

����� Converting DXF File Data to Base Screen Data

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1) Select the pull down menu [Utility]’s [Convert DXF
] command.

(2) Click on the  button.

(3) Designate the source (DXF file) and the destination
(Project File), and enter the Base screen number.

To designate a folder, click on the

 button.
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(4) Click on the  button and enter the conver-
sion conditions.

(5) After all the attributes have been entered, click on
the  button to registered the entered data.

(6) Click on the  button to start conversion.

(8) Click on the  button to quit.

(7) After the conversion is completed, click on the
 button.  The [DXF<->PRW Converter] dia-

log box will reappear.

  2.13.1   �Option
(DXF → PRW)

To convert another DXF file, DO
NOT cancel here; rather, start from
step (3) again.

If the designated screen number al-
ready exists, a prompt will appear,
asking whether the new number
should overwrite the old number.
When the  button is clicked
on, the new number will overwrite
the old one, and when the 
button is clicked on, the new num-
ber will not overwrite the old one.
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2.13 .2 Conversion from Base Screen to DXF File (PRW → → → → →  DXF)

Base screen data is converted into DXF file (Drawing Interchange File) data.

DXF file

Convert

GP-PRO/
PBIII Base
screen

Can be used for
CAD software for a
personal computer,
such as AUTO-CAD

����� Requirements and Restrictions when Converting Data
    (PRW →→→→→ DXF)

• Only Base screens can be converted.
• Image screens called up on the Base screen will not be converted.
• Tag data will not be converted, so for example, M-tag’s Marks will not be

displayed after conversion.
• When text is converted, the character size and position may differ from

the original due to font type difference and errors created during conver-
sion.

• Since Load Mark will be converted into a simple straight line (i.e. no
width), if it has been magnified, it will be displayed differently from the
original after it is converted.

If you try to convert a filled polygon that has four peaks, one of
which introverts, into a DXF file, this polygon will not be con-
verted properly.
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����� Convert Screen Size
The screen size of a GP unit specified in the Project File.

����� Convert DXF Size
The DXF file size used after data is converted using data conversion is
selected.  The default values are the same as the Screen Size values men-
tioned above.

����� Parts State
Bit ....... When Part display states (ON/OFF) are specified, that Part will be

converted for each display state.

Word .. Picture Display and Message Display will be converted with the
display state specified here.

����� Color Conversion (PRW →→→→→ DXF)
Base screen’s drawing data colors will be converted as follows:

The blink settings will not be converted.

With a 64 color GP unit, colors on the color palette will be converted as
follows:

Black Blue Black Black Blue Blue Green Green
Light blue Light blue Green Light blue Black Black Blue Blue

Black Black Blue Blue Green Green Light blue Light blue
Green Green Light blue Light blue Red Red Purple Purple
Red Red Purple Purple Yellow Yellow White White

Yellow Yellow White White Red Purple Red Red
Purple Purple Yellow Yellow White White Yellow White

Parts State
Selects and enters the Part
State when converted

Screen Size
Designates the GP
screen size after conver-
sion

DXF size
Designates the DXF
screen size when Base
screen data is converted
into DXF file data

����� Option (PRW →→→→→ DXF)
Here, select and enter color and size data used when performing data con-
version.

Base Screen DXF File Color No.
Black 250 (gray)
Blue 5 (blue)

Green 3 (green)
Light blue 4 (light blue)

Red 1 (red)
Purple 6 (purple)
Yellow 2 (yellow)
White 7 (white)
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Base Screen DXF File 
Straight line/Continuous 
straight line LINE/POLYLINE 
Square/Filled Square POLYLINE/SOLID 
Regular Circle/Filled 
Regular Circle CIRCLE/CIRCLE + SOLID 
Oval/Filled Oval POLYLINE/POLYLINE + SOLID 
Arc/Pie ARC/ARC + POLYLINE 
Division Collection of lines 
Filled Polygon SOLID or POLYLINE 
Load Screen Broken down into each Part 

object and converted 
Text TEXT 
Load Mark POLYLINE 
Part Broken down into each part and 

converted 
Data other than the above will not be converted.

����� Straight line/Continuous straight line
• When the number of coordinates is “2”, a straight line or continuous

straight line will be converted into LINE. If this number is other than 2, it
will be converted into POLYLINE.

• When a line has an arrow at one end, a solid filled triangle will be drawn
at the end coordinates, and when a line has arrows at both ends, solid
filled triangles will be drawn at both ends.

����� Square/Filled Square
• Any line will be converted into POLYLINE.
• Any Fill will be converted into SOLID.

����� Line Type Conversion (PRW →→→→→ DXF)
Base screen’s line types will be converted as follows:

The line thickness will be converted in the same thickness for all the lines,
regardless of the line types.

����� Object Conversion (PRW →→→→→ DXF)
Base screen’s drawing data will be converted as follows.
Colors and line types will be converted as shown in the previous page’s
table.  The background colors will not be converted.  Tiling patterns will be
converted into solid Fill.

Base Screen DXF File
1-dot solid line CONTINUOUS
1-dot broken line DASHED
1-dot one-dot-dash line CENTER
1-dot two-dot-dash line PHANTOM
2-dot solid line CONTINUOUS
2-dot broken line DASHED
2-dot one-dot-dash line CENTER
2-dot two-dot-dash line PHANTOM
3-dot solid line CONTINUOUS
5-dot solid line CONTINUOUS
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����� Regular Circle/Filled Regular Circle
• Filled regular circle’s border will be converted into CIRCLE and its

filling will be converted into SOLID.

����� Oval/Filled Oval
• Any lines will be converted into POLYLINE.
• Filled oval’s border will be converted into CIRCLE and its filling will be

converted into SOLID.

����� Arc/Pie
• Pie’s straight line section will be converted into POLYLINE.

����� Divisions
• When the divisions are marked on a straight axis, their coordinates will

be calculated based on their start and end coordinates, direction, and the
number of divisions, and will be converted into LINE.

• When the divisions are marked on an arc axis, their coordinates will be
calculated based on their start and end angles, external circle’s radius,
internal circle’s radius, number of divisions, and will be converted into
LINE.

����� Filled Polygon
• Fill will be converted into SOLID.  However, if the number of vertices is

more than 5, Fill will not be converted and only its trace will be con-
verted into POLYLINE (CONTINUOUS).

����� Load Screen
• The screen will be retrieved from its attributes, and screen number and if

it exists, and each drawing data will be converted.
• The called up screen’s data will be converted in the same layer as other

drawing data.
• Only Base, Keypad, and Trend Graph screens will be converted.

����� TEXT
• Characters written horizontally will be converted into BIGFONT. Those

written vertically will be converted into TATEGAKI (vertical type of
BIGFONT).

• 1/4-sized characters will be all converted into half-sized characters.
• Half-sized (1/4-sized) characters written horizontally will be converted

with a relative scale of 1/2 in the X direction, and other size characters
will be converted with a relative scale of 1.

• Both half and full-sized characters written vertically will be converted
with a scale of 1 for their height and width.  Therefore, the half-sized
characters will become the same size as the full-sized characters.

• Character types of “Bold” and “Raised” will not be converted.
• Due to font difference and other elements, text will be different from the

Base screen, after conversion.

����� Load Mark
• The Mark screen will be retrieved from the screen number, if that screen

exists, the dot pattern will be converted into POLYLINE (CONTINUOUS).

����� Part
• Each Part’s data will be converted into drawing data.
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����� Converting Base Screen Data to DXF File Data

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

To designate a folder, click on the

 button.

(1)Select the pull down menu [Utility]’s [DXF Conver-
sion] command.

(2)Click on the  button.

(3) Designate the source (Project File) and Base screen
number and designate the destination (DXF file).

(4) Click on the  button and enter the conver-
sion conditions.
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(5) After all the attributes have been entered, click on
the  button to registered the entered data.

(6) Click on the  button to start conversion.

(7) After the conversion is completed, click on the
 button.  The File Convert (GP →→→→→ DXF) dia-

log box will reappear.

(8) Click on the  button to quit.

If the designated DXF file name
already exists, a prompt will
appear, asking whether the new
name should overwrite the old
name.  When the  button
is clicked on, the new name will
overwrite the old one, and when
the  button is clicked on,
the new name will not overwrite
the old one.

  2.13.2   �����Option
(PRW → DXF)

To convert another Base screen,
DO NOT stop here; rather, start
again from step (3).



P-PRO/PB III for Windows provides various screens for specific
purposes (for example: for creating marks and messages), in

addition to the Base screens which are the fundamental screen used for all
drawing modes. Other screens can then be loaded onto Base screens as
libraries. Also, you can load them directly onto the GP series panel using
specified tags.

This chapter describes the procedure for creating these screens and their
applications.

  3  DRAWING APPLICATIONS - CREATING and USING SCREENS

G

3.1 ............................. Creating a Mark: the Mark Screen

3.2 ... Creating a Trend Graph: the Trend Graph Screen

3.3 ...................... Creating a Keypad: the Keypad Screen

3.4 .......................................... Text Input: the Text Screen

3.5 ......................... Creating an Image: the Image Screen

3.6 ......................................... Video Data Display (V Screen)

3.7 ............................. Window Display: Window (U) Screen
and Base (B) Screen
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3.1 Creating a Mark: the Mark Screen

3.1     Creating a Mark: the Mark Screen

Usage  Pattern

Editing
Tool Bar

Save the Mark
screen.

Draw a mark
by turning on/
off each dot.

[New][Screen] →→→→→ →→→→→ →→→→→

Mark
drawing
area of 48 x
48 dots.
This area is
composed
of 6 (verti-
cal) x 6
(horizontal)
blocks
(Each
block: 8 x 8
dots)

Screen capacity

Displays the
current
cursor
coordinates,
based on the
origin (0, 0)

Indicates the
size of the
mark loaded
on the base
screen (1 x 1)

Drawing
Tool Bar

General description of the Mark screen:

Create a mark (dot pattern) on a “Mark” screen. Using the [Draw] menu -
[Load Mark] command, you can load the created mark onto a Base screen,
“Tend Graph” screen or “Keyboard” screen. Also, you can animate the
created Mark screen by specifying the M-tag.

or

Click on  to open a Mark screen.

����� Drawing Tools
The Drawing Tool Bar icons and their corresponding drawing objects are as
follows:

Origin

Icon Drawing Tool Description

Dot
Specify the ON/OFF status of each dot by clicking on each
dot or dragging the mouse within a specified area.

Line
Specify the start and end points of a line and draw a line by
clicking on desired points.

Square (Rectangle)

Filled square
(Filled rectangle)

Circle/Oval

Filled circle
(Filled oval)

Draw a square or rectangle by clicking and dragging to the
desired size on a diagonal axis.

Draw a circle or oval by clicking and dragging to the desired
size on a diagonal axis.
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3.1 Creating a Mark: the Mark Screen

����� Editing Tools
The Editing Tool Bar icons and their corresponding functions are as follows:

Icon Editing Tool Description

Cut
Used to delete an entire Mark screen and store it in the
clipboard*1. Using the [Paste] command, you can then paste
the Mark screen onto another screen.

Copy
Used to copy the data of the selected Mark screen in the
clipboard.

Paste
Used to paste the data temporarily stored in the clipboard
onto a desired place.

Duplicate Used to duplicate a Mark screen’s specified area.

Delete Used to delete a mark.

Undo
Used to cancel the command executed immediately before,
and return to the previous condition. (Undo)

Redo
Used to redo the command canceled with the [Undo]
command. (Redo)

Mirror X
Used to move the dot pattern symmetrically relative to the
vertical axis. The symmetry axis is the vertical line that divides
the screen into two equal sections.

Mirror Y
Used to move the dot pattern symmetrically relative to the
horizontal axis. The symmetry axis is the horizontal line that
divides the screen into two equal sections.

Turn
counterclockwise Used to turn the mark counterclockwise by 90°.

Turn clockwise Used to turn the mark clockwise 90°.

Reverse Used to reverse the white/black area of a mark.

Transparent/
Background color

If no dots are turned ON in a block (8 x 8 dots), this block
becomes transparent.

Icon Drawing Tool Description

Fill
Fill in an area with a desired color by clicking in the area
(enclosed within lines and shapes).

Text Enter the text to be displayed in the mark drawing area.

Call Up Mark
Library Select a Mark from the Mark Library

Register Mark
Library Register a created Mark as a Mark Library.

*1 When the [Copy] or [Cut] command is used, the copied or cut data is temporarily
stored in the clipboard.
When you use the [Paste] command, the data stored in the clipboard are pasted to
the selected position.
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3.1 Creating a Mark: the Mark Screen

When drawing a mark you can use GP-PRO/PBIII for Windows’ standard
drawing functions. Here, the procedures for using each function are described.

����� Drawing with Dots
You can draw a mark by turning ON/OFF each dot. When you click the left
mouse button in the mark drawing area, each dot turns ON (white). When
you click the right mouse button in the mark drawing area, each dot turns
OFF (black).
A mark is created with dots, and displayed in a block (8 x 8 dots). If at least
one dot is turned ON in a block, the whole block is displayed when the
Mark screen is loaded onto a Base screen. In this status, the ON dots are
displayed in the current display color (Fg), and the OFF dots are displayed in
the background color (Bg).

3.1.1 Drawing a Mark

This dot is ON.

����� Mark Drawing Area Structure
The mark drawing area has the following structure. When you edit a mark,
you can use this for your reference.
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3.1 Creating a Mark: the Mark Screen

����� Freehand Drawing

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(2)Draw a mark by clicking on each dot or by dragging
the mouse in the mark drawing area.

(1)Select the [Draw] menu - [Dot] command, or click on
the  icon.
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3.1 Creating a Mark: the Mark Screen

����� Drawing a Line

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

If you press and hold the             key
in step (2), you can draw a line at
an angle of 0°, 45°, and 90°.

(3) Click the end point in the mark drawing area.
  A line is defined.

(2) Click on a start point in the mark drawing area and
  drag the mouse.

(1) Select the [Draw] menu - [Line] command, or click
 on the  icon.

Ctrl
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3.1 Creating a Mark: the Mark Screen

����� Drawing a Square (Rectangle) or Filled Square (Filled Rectangle)
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If you press and hold the             key
in step (2), you can draw a square.

(3) Click on the end point (b).
  A square or rectangle is defined.

(2) Click on a point (a) and drag the mouse on a diago
 nal axis in the mark drawing area.

(1) Select the [Draw] menu - [Square/Rectangle] or
[Filled Square/Rectangle] command, or click on the

 or  icon.

a

a

b

Ctrl
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3.1 Creating a Mark: the Mark Screen

����� Drawing Circle (Oval) or Filled Circle (Filled Oval)
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If you press and hold the         key in
step (2), you can draw a circle.

(3) Click on the end point (b).
  A circle or oval is defined.

(2) Click on a point (a) and drag the mouse on a diago
  nal axis in the mark drawing area.

(1)Select the [Draw] menu - [Circle/Oval] or [Filled
Circle/Filled Oval] command, or click on the  or

 icon.

a

b

a

Ctrl
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����� Filling a Mark

(1)Select the [Draw] menu - [Fill] command, or click on
the  icon.

(2)Click inside the area to be filled.
The specified area will be filled.

If you click on a line, the filling
mode cannot be executed. Be sure
to click inside a completely en-
closed area, if you do not, the en-
tire mark screen may be filled.
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����� Entering Text
The “Text” mode allows you to enter text on a Mark screen.

(1)Select the [Draw] menu - [Text] command, or click
on the  icon.

(2)Enter character(s) and select either 8 x 16 dot font or
Windows font.

(3)To use the Windows font, click on the  and

click on the  button.

Select Font

(4)Click on the  button.
An outline corresponding to the entered character(s) will
appear.
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(5)Move the box to the desired position where the char-
acter pattern will be displayed.
The character pattern is displayed in the position where
you click. A Mark can be created using this pattern.

If you move the character pattern
to a position where another char-
acter pattern has already been cre-
ated, the new pattern will overwrite
the existing pattern, and the exist-
ing pattern will be deleted.
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 �����  Creating Special Characters on a Mark screen
When the European character set has been selected, you can register (create)
any kind of  the special character you wish. These special characters are
handled by Mark screens M8001 to M8128, so up to 128 special characters
can be created. The data (characters) on these "special" screens are can then
be inserted into any text string, using special reference codes. For example,
to call up Mark screen M8001's special character, we need to input the
corresponding reference code 80h, and to call up screen M8002, we would
enter 81h, etc. However, since these codes are in Hex format, and in GP-
PRO/PBIII 's text input mode we can only enter decimal data, we need to
use the Hex code's decimal equivalent, shown on the table on page 138.

When any kind of character is "registered" on Mark screens M8001 to
M8128, the GP will interpret it as a "special" character.  Thus, when the GP
encounters one of the abovementioned special reference codes, it automati-
cally searches for the corresponding Mark file. If the file exists (i.e. has been
registered and sent to the GP), it replaces its default GP character with the
special character Mark.

This feature is useful when you need to change the GP's default character
font addresses to match those used by your PC's OS.

• The number of special characters that can be used is limited to
the number of Mark tags available, i.e 128.

• When creating a special character Mark screen, start from
point 0,0 (Base point) and use only two 8x8 dot squares.

����� Displaying (Calling up) a Special Character
    The method for displaying a registered special character is as follows.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

The character "III" , previously registered in
Mark screen M8010, will be displayed on the
GP.

(1) Open the Base screen where you want to display
the special character, and click on the  icon.

3.1.2 Special Mark Characters

Base Point III
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Characters used by the GP may sometimes differ from those
used by GP-PRO/PB III for Windows. Please be sure to check all
characters after they are sent to the GP.
If the corresponding Mark file is not sent with the Base screen
to the GP, the GP will substitute one of its regular characters.
(0x80 to 0xFF)
Special characters can not be rotated.

The character displayed,
since it is only for reference,
will be different  from the
desired "III". After the Base
screen and the Mark file are
sent to the GP, the correct
character will be
automatically displayed.

89h = e

(2) Hold down the [Alt] key and use your PC’s
numeric keypad inputting the ASCII code that
corresponds to the desired Mark screen.
The (ASCII) character code that corresponds to
screen M8010 is 89h, however here, since the code
entered must be decimal, enter the corresponding
Input code, 235. This should cause the character "e"
to appear.
(One application of this special character could be
to place it after the text "GP-PRO/PB". In that case,
simply enter "GP-PRO/PB" followed immediately
by the Input code)

(3) After placing this text on the Base screen, saving
the screen, and then sending the data (i.e. the
Base screen and the Mark file) to the GP, instead
of the "e" character, the Mark screen's "III"
will appear.

����� Character (Reference) Codes
         The GP displays characters from the chart shown here. (Code Page 850 character codes)
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����� Hex/Decimal Corresponding Character Codes
      When inputting reference codes for special Mark screens, use the chart below.

   Mark
  Screen

M8001
M8002
M8003
M8004
M8005
M8006
M8007
M8008
M8009
M8010

    •
    •
    •

Char Code Input Code Char Code Input Code Char Code Input Code
Code Page 850 (ALT+code) Code Page 850 (ALT+code) Code Page 850 (ALT+code)

80h 0199 B0h 0130 E0h 0211
81h 0252 B1h 0131 E1h 0223
82h 0233 B2h 0132 E2h 0212
83h 0226 B3h 0133 E3h 0210
84h 0228 B4h 0134 E4h 0245
85h 0224 B5h 0193 E5h 0213
86h 0229 B6h 0194 E6h 0181
87h 0231 B7h 0192 E7h 0254
88h 0234 B8h 0169 E8h 0222
89h 0235 B9h 0135 E9h 0218
8Ah 0232 BAh 0136 EAh 0219
8Bh 0239 BBh 0137 EBh 0217
8Ch 0238 BCh 0138 ECh 0253
8Dh 0236 BDh 0162 EDh 0221
8Eh 0196 BEh 0165 EEh 0175
8Fh 0197 BFh 0139 EFh 0180
90h 0201 C0h 0140 F0h 0173
91h 0230 C1h 0141 F1h 0177
92h 0198 C2h 0142 F2h 0159
93h 0244 C3h 0143 F3h 0190
94h 0246 C4h 0144 F4h 0182
95h 0242 C5h 0145 F5h 0167
96h 0251 C6h 0227 F6h 0215
97h 0249 C7h 0195 F7h 0184
98h 0255 C8h 0146 F8h 0176
99h 0214 C9h 0147 F9h 0168
9Ah 0220 CAh 0148 FAh 0183
9Bh 0248 CBh 0149 FBh 0185
9Ch 0163 CCh 0150 FCh 0179
9Dh 0216 CDh 0151 FDh 0178
9Eh 0128 CEh 0152 FEh 0247
9Fh 0129 CFh 0164 FFh 0160
A0h 0225 D0h 0240
A1h 0237 D1h 0208
A2h 0243 D2h 0202
A3h 0250 D3h 0203
A4h 0241 D4h 0200
A5h 0209 D5h 0153
A6h 0170 D6h 0205
A7h 0186 D7h 0206
A8h 0191 D8h 0207
A9h 0174 D9h 0154
AAh 0172 DAh 0155
ABh 0189 DBh 0156
ACh 0188 DCh 0157
ADh 0161 DDh 0166
AEh 0171 DEh 0204
AFh 0187 DFh 0158
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3.1.3 Editing a Mark
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To edit a mark, you can use the following editing functions. This section
describes the operating procedure for each function.

����� Cutting a Mark
The “Cut” command deletes the data of the selected screen and stores it in the clip-
board*1. (The deleted screen can be moved to another screen, but cannot be moved
to the original screen.) The “Cut” command can be executed for the entire screen.

(1) Select the original Mark screen to be cut.
This description assumes that several screens have al-
ready been opened.

(2) Select the [Edit] menu - [Cut] command, or click on
the  icon to store the Mark data in the Clipboard.
Data of the original data screen will be cut.

To delete the Mark screen, perform
steps (1) and (2) only.

*1 When the [Copy] or [Cut] command is executed, the copied or cut data are temporarily
stored in the clipboard.
When you execute the [Paste] command, the data stored in the clipboard will be pasted
to the selected position.
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(3) Select the mark screen (destination) to which the se-
lected Mark screen will be pasted.

(4) Select the [Edit] menu - [Paste] command, or click
on the  icon.
Data of the Mark screen will be pasted.
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����� Copying a Screen
The selected screen data are copied in the clipboard. Unlike the [Cut] command, the
original screen data will not be deleted.

To copy a mark into the original screen, use the [Duplicate] command.

(1) Select the original Mark screen to be copied.
This description assumes that several screens have al-
ready been opened.

(2)  Select the [Edit] menu - [Copy] command, or click on

the  icon to store the mark in the Clipboard.

(3) Select the mark screen (destination) to which the se-
lected Mark screen will be copied.

(4)  Select the [Edit] menu - [Paste] command, or click
on the  icon.
Data will be copied from the original Mark screen and
pasted onto the destination Mark screen.

Note:
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����� Copying a Specified Range : Duplication
A specified range in the mark drawing area can be duplicated by dots.

(1)Select the [Edit] menu - [Duplicate] command, or
click on the  icon.

(2) Specify the copy range in the same manner as draw-
ing a square/rectangle.
A box appears, indicating the specified copy range.

(3) Move the box to a desired position where the data in
the specified range will be copied.
Data in the specified range will be copied to the position
where you click.

If you copy a mark
into  the position where
another mark has already
been created, the new data
will overwrite the existing
data, and the existing data
will be deleted.

You can continue the copy mode
until you click the right mouse but-
ton.

(4) To quit the copy mode, click the right mouse button.
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(3) Specify the range to be deleted in the same manner
as drawing a square/rectangle.
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����� Deleting a Mark
Delete the mark, a partion of it.

(1) Select the [Edit] menu - [Delete] command, or click
on the  icon.

The procedures for deleting part of a mark or deleting a
whole mark are separately described:

[Deleting  Part of a Mark]

(2) Select [Partial Clear] and click on the  but-
ton.
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(4) Click in the range to be deleted.
The specified range will be deleted.

[Deleting the Entire Mark]
(2) Select [Clear All].

(3) Click on the  button to delete the entire
mark.
The entire mark will be deleted.
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Example) Turn Clockwise

����� Mirror X, Mirror Y
The “Mirror X” and “Mirror Y” functions move a mark symmetrically
relative to the vertical and horizontal axis, respectively.
To execute the “Mirror X” and “Mirror Y” functions, click on the 
icon, respectively.

Example) Mirror X

�����  Turn Counterclockwise [O], Turn Clockwise [N]
The “Turn Counterclockwise”, “Turn Clockwise” functions turn the mark
counterclockwise and clockwise 90°, respectively.
To execute the “Turn Counterclockwise” and “Turn Clockwise” functions,
click on their respctive the  icons  respectively.

Example) Turn Counterclockwise

Example) Mirror Y
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����� Reverse
This function reverses the white and black areas. In the reverse display mode, all ON
dots are turned OFF, and all OFF-dots are turned ON.
To execute this function, click on the  icon.

Example)
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����� Transparent/Background Color
If no dots are turned ON in a block, this block becomes transparent. When this
function is set to “Background color”, a block without any ON dots is displayed in
the background color (Bg).

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

The block with no ON
dots is displayed in the
background color.

These blocks
contain no
ON-dots.

If at least one dot is ON in a
block, this block is dis-
played in the background
color.
The block with no ON dots
becomes transparent, and
you can see the objects on
the base screen.

When this function is set to “Background color”:

����� Display When Called Up to a B (Base) Screen
When this function is set to “Transparent”:

(3) Click the right mouse button to register the above
setting.

(2) Click in the block to be displayed in the background
color.
The border line of the specified block is changed. Every
time you click in the block, the color setting is switched.

(1) Select the [Edit] menu - [Background Color] com-
mand, or click on the  icon.
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����� Canceling a Command: Undo
This function is used to cancel a command and return to the previous condition
immediately before the command was made.
[Undo] is only effective for the command immediately before it.
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After deleting a circle unintentionally:
(1)Select the  icon.

The deleted circle is restored, and the screen returns to
the previous condition.

����� Redo Command
This function is used to redo the command canceled with the [Undo] command.
The [Redo] command is effective only for the command immediately before it.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

After deleting a circle, you have selected the  icon to
return to the previous condition, but you realize that ac-
tually, the circle must be deleted:

(1)Select the  icon.
The screen returns to the condition where the circle has
been deleted and harmony is restored.
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3.1.4 Registering and Placing a Mark Library Item

You can register a mark created in the mark drawing area and the registered
mark can be loaded whenever required. The Mark Library  Item (mark list)
can be saved as a mark library file (MRK file). The GP-PRO/PB III enables
you to manage MRK files independent of project (PRW) files . This function
allows you to use the same mark for several projects, since you can select a
desired mark while checking the image displayed in the browser.
Registration, placement, and other editing operations of Mark Library are
performed in the same manners as those of the standard Libraries.

2.5 Libraries

GP-PRO/PB III for Windows has pre-made MRK files in correspondence
with the ISO7000 Series marks and symbols.

Note:

 Parts List Manual

Drawing symbol
number MRK file name Title

0001-0200 IS07-1 0001-0200
0201-0400 IS07-2 0201-0400
0401-0600 IS07-3 0401-0600
0601-0800 IS07-4 0601-0800
0801-1000 IS07-5 0801-1000
1001-1140 IS07-6 1001-1140
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3.2 Creating a Trend Graph: the Trend Graph Screen

3.2     Creating a Trend Graph: the Trend Graph Screen

Save the
Trend
Graph
screen.

Usage  Pattern

Open a Trend Graph screen by
selecting the [Screen] menu
[New] command, or by clicking
on the  icon.

Draw the graph axis and
scales by using the drawing
tool.

Set the screen by selecting
the [Tag] menu - [Set
Screen] command, or by
clicking on the  icon.

Set the channel by selecting
the [Tag] menu - [Set
Channel] command, or by
clicking on the  icon.

→→→→→

→→→→→ →→→→→ →→→→→
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 1.1.3 Opening/
Closing/Saving a Screen

(3) Select the [Tag] menu - [Set Screen] command, or
click on the  icon.

(2) Select a Trend Graph screen.

(1) Select the [Screen] menu - [New] command, or click
on the  icon.

You can create a trend graph with the Trend Graph screen. Using the [Draw]
menu - [Load Screen] command, you can load a trend graph from the Trend
Graph screen onto a Base screen. The specified loading point is placed at the
center of the screen. Up to eight Trend Graph screens can be loaded onto
one Base screen.

A maximum of eight Trend Graph screens can be loaded onto each Base
screen. However, only one trend graph with the Data Record Display
function can be loaded.

 For details of the Data Record Display function, refer to
Tag Reference Manual, 2.31 Trend Graph Display.

[Draw] [Load Screen]
or

Click on  to call up a Trend
Graph.

The selected Trend
Graph screen will be
displayed on the
Base screen.

Open a Base
screen
[Draw]

→→→→→→→→→→
→→→→→

����� Creating a Trend Graph

Note:
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The effective setting range of the
“pitch”, “Number of display data”
and “Scroll” parameters for the [Set
Screen] command varies depend-
ing on the setting values. Be sure
to set these parameters.
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  2.2 Drawing

  2.4 Object Edit-
ing

Draw the graph axis and scales out-
side the graph display area so that
they will not overlap with the graph
display area. If the graph axis and
scales are placed in the graph dis-
play area, they cannot be displayed
when the Trend Graph screen is
operated on the GP series’ panel.

To display the graph axis and scales
on the screen, select the [Screen
Property] command from the pull
down [Option] menu and enable the
Tag Mark display.

   2.4 Object Edit-
ing

(6) Draw the graph axis and scales.

(5) After setting all items, click on the  but-
ton to register the above settings.
The graph display area is displayed with handles in the
drawing area. Change the size and position of the graph
display area, as required.

 Tag Reference
Manual,  2.31  Trend Graph Dis-
play
Trend Graph Display Setting Ori-
gin, 100% of height and pitch

(4) Set the parameters for the [Screen Settings] screen.
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3.2 Creating a Trend Graph: the Trend Graph Screen

Each function of the trend graph
display is called “Channel” instead
of “Tag”.

To specify a channel name, you can
use up to five characters (includ-
ing alphanumerics and symbols.)

To specify a channel’s description,
you can use up to twenty charac-
ters.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

The number of channels of Trend
Graphs, including the number of
channels of Data Sampling, that can
be set up for the entire Project is
40 with the GP2000 series and 20
with other models.

 Tag Reference
Manual, 2.31 Trend Graph Dis-
play

(10) After setting all items, click on the  but-
ton to register the settings.
To display several trend graphs in the same graph dis-
play area, repeat the above procedure from step (7).

(9)Designate [Channel Settings]' each item.

(11) Click on the  button to close the [Chan-
nel Settings] dialog box.

(7) Select the [Tag] menu - [Set Channel] command, or
click on the  icon.

(8) Click on the  button in the [Channel Set-
tings] dialog box.
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(14) Select a screen you want to call up from the list,

and then click on the  button.

(15) The selected screen will be placed in the position
you have clicked on.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

  1.1.3 � Saving a
Screen

(12) After setting all items, save the Trend Graph screen.

(13) Open a Base screen. Then, select the [Draw] menu
- [Load Screen] command, or click on the  icon to
call up a Trend Graph screen.

   2.2.10 Load
Screens
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3.2 Creating a Trend Graph: the Trend Graph Screen

����� Editing a Channel

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

To select several channels, click on
the channel names while pressing
the          key.

To select an individual channel,
click on the channel name while
pressing the          key.

(2)Click on the  button.
The setting item dialog box will be opened, enabling
you to edit the channel.

(1)Select the channel to be edited.

Ctrl

Shift
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����� Deleting a channel

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

Once the [Delete]
command is executed, the de-
leted channel cannot be re-
stored.

To select several channels, click on
the channel names while pressing
the           key.

To select an individual channel,
click on the channel name while
pressing the          key.

(2)Click on the  button.

(1)Select a channel you wish to delete and click on the
 button.

Shift

Ctrl
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3.3 Creating a Keypad: the Keypad Screen

3.3 Creating a Keypad: the Keypad Screen

Usage  Pattern

The Keypad
screen appears on
the Base screen.

[Tag] [K-tag]
or

Click on  and set up k-tag.

[Screen] [New]
or

Click on  to open a Keypad screen.

→→→→→
→→→→→

→→→→→

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

  2.2 Drawing

  1.1.3 Opening/
Closing/Saving a Screen

(3)Draw a keypad.

(2)Open a Keypad screen.

(1)Select the [Screen] menu - [New] command, or click
on the  icon.

You can create a keyboard with the Keypad screen. Using the Base screen’s
[Draw | Load Screen] command allows you to load a keypad from the
Keypad screen onto a Base screen. When the Keypad screen is loaded, the
specified loading point is placed at the center of the screen.

  2.2.10 Load Screens
The GP-PRO/PB III provides several sample keyboards. Using the sample
keyboards, there is no need to create a keyboard on each screen.

3.3 �����Application of Sample Keypads
To use a keypad Part, place it on a Base screen directly.

2.1.13 Keypads

����� Creating a Keypad

→→→→→
Draw a
keypad using
drawing tools.

→→→→→

Save the
Keypad
screen.

→→→→→
Open a
Base
screen.

→→→→→
[Draw] [Load Screen]

or

Click on  to call up the Keypad screen.
→→→→→

→→→→→
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3.3 Creating a Keypad: the Keypad Screen

Specify the touch area so that it will
not overlap with the touch area of
another tag.

(8)Specify the touch area (where the specified tag will
be activated) in the same manner as drawing a
square/rectangle.
Repeat steps (4) through (8) to set the k-tag for all keys.

To specify a tag name, you can use
up to five characters (including al-
phanumer ics ,  symbols  and
“Double-sized” characters.)

 Tag Reference
Manual, 2.12 K-tag (Key Input)
To specify a channel name, you can
use up to twenty characters.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(7)Specify the tag name position by clicking on a de-
sired point.

(6)After setting all items, click on the  button
to register the settings.

(5)Enter or designate k-tag's each setting item.

(4)Select the [Tag] menu - [k-tag] command, or click on
the  icon.
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3.3 Creating a Keypad: the Keypad Screen
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(11) Specify the area to be cleared in the same manner
as drawing a square/rectangle.
Load the keypad to be replaced, and specify the display
area. In this example, the entire keypad display area is
specified.

(10) Click on the  button.

The “screen switching function” of the k-tag enables you
to replace the keypad display area with another keyboard
screen.
To use this function, set the [Clear Area].
To replace the keyboard screen, start the procedure from
step (9). Otherwise, start the procedure from step (12).

(9)Select the [Tag] menu - [Clear Area] command, or
click on the  icon.

   1.1.3 Opening/
Closing/Saving a Screen

(12) After completing the above settings, save the key-
pad screen.
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3.3 Creating a Keypad: the Keypad Screen

����� Application of Sample Keypads
Several sample keypads (files created with the GP-PRO III) are provided in the
“KEYLIB” folder below the folder (C:\PROPBWIN) where the GP-PRO/PB III has
been installed. You can use the sample keypads, and also edit them to create a new
keypad. To use the sample keypads, load the keypad screens (files created with the
GP-PRO III) into the current project.

Instead of the sample keypads, keypad Parts can also be used.Note:

2.1.13 Keypads

The following is the general procedure for using the sample keyboards:
(1) Load a file of the memory link type (K8***.DLM) from

“C:\PROPBWIN\KEYLIB” into the current project. Load the necessary
keyboard screen from “C:\PROPBWIN\KEYLIB” into the current
project.

12.1.1 Conversion from GP-PRO II or GP-PRO III
(2) Open a keypad screen and edit the screen, as required.

1.1.3 ����� Opening a New Screen

The following sample keypads are provided:

File name Keyboard shape and input mode
K8000.DLM Ten-key pad, Decimal input
K8001.DLM Ten-key pad, Hexadecimal input
K8002.DLM Ten-key pad, Control keys, Horizontal
K8003.DLM Full keys, Horizontal, Numbers
K8004.DLM Full keys, Horizontal, Symbols
K8005.DLM Full keys, Horizontal, Uppercase alphabet
K8006.DLM Full keys, Horizontal, Lowercase alphabet
K8009.DLM Full keys, Horizontal, Basic type
K8010.DLM Ten-key pad, Control keys, Vertical
K8011.DLM Full keys, Vertical, Numbers
K8012.DLM Full keys, Vertical, Symbols
K8013.DLM Full keys, Vertical, Uppercase alphabet
K8014.DLM Full keys, Vertical, Lowercase alphabet
K8017.DLM Full keys, Vertical, Basic type
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3.3 Creating a Keypad: the Keypad Screen

Ten-key pad,
Decimal input

Full keys, Horizontal, Lowercase Alphabets

Full keys, Vertical,
Uppercase alphabets

Example) K8000 Example) K8007

Example) K8013
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3.4 Text Input: the Text Screen

[Screen]  →→→→→  [New]
or

Click on 

Quit the
GP Text
Editor.

Save the
Text
screen.

Enter text.

Usage Pattern

3.4      Text  Input: the Text Screen

→→→→→ →→→→→ →→→→→

Editing
function tool
bar

Screen capacity

Coordinates of
current cursor
position

Input character
display area

Cursor

 General description of the Text screen:

Create text data on the GP-PRO/PBIII text (X) screen. You can paste text
data created with another editor onto the GP-PRO/PBIII text (X) screen
using the [Cut] or [Copy] command.
The created text data can also be animated; there are two methods: Display-
ing text by a specified number of lines (specified by X-tag), and a list with
error guidance (specified by A-tag).

Tag Reference Manual, 2.1 A-tag (Alarm Summary
TEXT Display)/ 2.30  X-tag (Display Text Data)

This feature allows you to export text data created with GP-PRO/PBIII as a
.csv or .txt file, or import the same types of data to a GP-PRO/PBIII text (X)
screen.

3.4.2 Text Screen Import and Export

Also, you can edit text screens used for Multi-language text display.

3.4.3 Editing Multilanguage Text Screens, and 4.6 String
Table Editor

· Text screens compatible with the Multi-language display feature can be
edited only on the GP2000 Series units.

Line No.

→→→→→
Open
a Text
screen.
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3.4 Text Input: the Text Screen

· When you select characters and click the right mouse button, the following
shortcut menu appears.

����� Editing Functions
The Editing Tool Bar icons and their corresponding functions are as follows:

Icon Editing Tool Description

Cut
Used to delete the selected text, and store it in the clipboard.
You can use this function to delete or move text.

Copy
Used to store the selected text in the clipboard. Unlike the
[Cut] command, the original text will not be deleted.

Paste
Used to paste the data temporarily stored in the clipboard
onto a desired place.

Delete Used to delete the selected text.

Undo
Used to cancel the command executed immediately before,
and return to the previous condition. (Undo)

Redo
Used to redo the command canceled with the [Undo]
command. (Redo)
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3.4 Text Input: the Text Screen

Maximum
number of
characters

GP Type

40

GP-H70, GP-270, GP-370,
GP-377, GP-37W2, GP-
377R, GP-2301H, GP-2300,
GP-2301

80

GP-470, GP-570, GP-571,
GP-870, GP-477R, GP-
577R, GP-2401H, GP-2400,
GP-2401, GP-2500, GP-
2501

100 GP-675, GP-2600, GP-2601

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

 1.1.3 � Opening
a New Screen

(3)Enter text in the text display area through the key-
board.
Be sure to press the [Enter] key  at the end of each
line.

(2)Open a Text screen.

(1)Select the [Screen] menu - [New] command, or click
on the  icon to open a Text screen.

You can enter up to 512 lines on one
screen. Line number 513 or subse-
quent lines cannot be displayed.

����� Input the Text

(4)After entering text, save the Text screen.
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3.4 Text Input: the Text Screen

(3)Move the cursor to the text's destination. Then, se-
lect the [Edit] menu - [Paste] command, or click on
the  icon.
The deleted characters will be pasted at the specified
position.

The GP-PRO/PB III provides the Cut, Copy, and Paste functions to edit text
data. These functions improve your editing efficiency.

����� Cutting/Pasting Text
This function is used to delete selected text and store it in the clipboard*1. You can
copy the text onto a desired position using the [Paste] command.

3.4.1 Editing Text

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

To select several characters, drag
the mouse within a desired text
range.

To select all the text, select the
[Edit] menu - [Select All] com-
mand.

(1)Select the text to be cut.

(2)Select the [Edit] menu - [Cut] command, or click on
the  icon.
The selected characters will be temporarily cut.

To delete the selected data, perform
steps (1) and (2) only.

*1 When the [Copy] or [Cut] command is executed, the copied or deleted data are tempo-
rarily stored in the clipboard.  When you execute the [Paste] command, the data stored
in the clipboard can be pasted on a desired position.
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3.4 Text Input: the Text Screen
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To select several characters, drag
the mouse within the desired text
range.

To select all the text, select the
[Edit] menu - [Select All] com-
mand.

(2)Select the [Edit] menu - [Copy] command, or click
on the  icon.
The selected characters will be copied into the clipboard.

(1)Select the text data to be copied.

����� Copying Text
Copy selected text data, and store the text data into the clipboard.

(3)Move the cursor to the copy's destination. Then, se-
lect the [Edit] menu - [Paste] command, or click on
the  icon.
The text data stored in the clipboard will be pasted at
the specified position.
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3.4 Text Input: the Text Screen

����� Deleting Text
Delete text data.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

You can execute the same opera-
tion by pressing the                 key of
your personal computer’s key-
board, instead of clicking on the 
icon.

To cancel the [Delete] command,
click on the  icon.

To select several characters, drag
the mouse within the desired text
range.

To select all the text, select the
[Edit] menu - [Select All] com-
mand.

(2)Select the [Edit] menu - [Delete] command, or click
on the  icon.
The selected characters will be deleted.

(1)Select the text data to be deleted.

 Delete
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3.4 Text Input: the Text Screen

����� Searching for Text
Search for a desired character string.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

To differentiate between the upper-
case and lowercase characters dur-
ing the search operation, use the
“Match Case” function.

(3)Click on the  button to execute the search
operation.
The search operation will be started in the specified di-
rection. To continue the search operation for the same
character string, click on the  button until there
is no matching string. When there is no matching string,
the search operation will stop.

(2)Enter the character string to be searched for and se-
lect the search direction, i.e. upward or downward.
The cursor position indicates the search start position.

(1)Select the [Search] menu - [Find] command.
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3.4 Text Input: the Text Screen

����� Utilizing Other Text Files
Other text files formatted for Windows can be used for the GP series. The procedure
for using the Windows NotePad data for the GP series is as follows:

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(3)Using the Notepad’s [Edit] menu - [Copy] command,
load the selected strings from  NotePad into the clip-
board.

(2)Select the character strings to be used for the GP series.

(1)Start the NotePad, and open the file to be used.

(4)Move the cursor to the position where you wish to
paste the selected text. Then, select the [Edit] menu -
[Paste] command, or click on the  icon.
The strings stored in the clipboard will be pasted to the
specified position.

To differentiate between the upper-
case and lowercase characters dur-
ing the search operation, use the
“Match Case” function.

Maximum
number of
characters

GP Type

40

GP-H70, GP-270, GP-370,
GP-377, GP-37W2, GP-
377R, GP-2301H, GP-2300,
GP-2301

80

GP-470, GP-570, GP-571,
GP-870, GP-477R, GP-
577R, GP-2401H, GP-2400,
GP-2401, GP-2500, GP-
2501

100 GP-675, GP-2600, GP-2601
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3.4 Text Input: the Text Screen

����� Setting the Maximum Number of Characters per Line
You can set the maximum number of characters that can be entered per line.
To set the maximum number of characters per line, move the ruler. The
specified number of characters is displayed at the right of the ruler.
When the input data exceeds the specified number of characters per line, the
characters will be automatically entered in the next line.
If you reduce the specified maximum number of characters after data input,
the characters exceeding the current limit will be automatically entered in
the next line.

Ruler
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3.4 Text Input: the Text Screen

The following explanation describes how to edit Multilanguage text screens.

For detailed Multilanguage feature information,  4.6 String
Table Editor

· This feature is available only on GP2000 Series units.

3.4.2 Editing MultiLanguage Text Screens

[Screen]  →→→→→  [New]
or

Click on 
Click on the
[Text Table
(ON/OFF)]
selection

String Table
Creation and
Editing

Operation Procedure

→→→→→ →→→→→

Enter the
Control Address

→→→→→ Select the table
and [GP Font
Setting] information

→→→→→ Enter text
data

→→→→→ Save table
data

→→→→→

In the [Support's MultiLanguage]
dialog box, select the [Use
MultiLanguage] feature.

→→→→→ In the [Convert to MultiLanguage]
alert box, click 

→→→→→

Select a table→→→→→ →→→→→ Enter text Save the text
screen

→→→→→

����� Overview  Description of MultiLanguage Text Screens
A maximum of 16 text screens can be registered to a single Text screen.
With text data saved on separately registered tables, a screen's language or
contents  can be easily changed during GP operation.

Ex.) Screen design when changing screen languages

· For an overview of the MultiLanguage feature,  4.6.1
Overview - MultiLanguage Display Feature

Text Screen (X1)
Table 1 (Japanese:                        )
Table 2 (Chinese:        )
Table 3 (English: Hello)

·
·
·

Table 16 (French: Bonjour)

Text Screen (X8999)
Table 1 (Japanese:                      )
Table 2 (Chinese:        )
Table 3 (English: Thank you)

·
·
·

Table 16 (French: Merci)

→→→→→ Open
a Text
screen
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3.4 Text Input: the Text Screen

�����MultiLanguage Text Screen

Click here to call up
the Text Table Editor

When the [Use MultiLanguage] check
box is checked, text screens compatible
with the MultiLanguage display feature
can be edited. (Only for GP2000 Series
units) For details,  4.6.2
Table Editor Character Strings

�����Use MultiLanguage

When this is selected/enabled, the text entry mode changes to multiple
language entry mode.

�����Table

Select the desired table name.
Select from a list of tables previously registered via the Text Table Editor. If
a table's name is "------" that table has not yet been registered and cannot be
selected. Table names can be changed via the Text Table Editor.

  4.6.2 Table Editor Character Strings ����� Table Name

����� Font Information

Displays the font set for the selected table. Fonts can be selected via the Text
Table Editor.

 4.6.2 Table Editor Character Strings ����� GP Font Settings

�����Control Address

Displays the Control Address set for the selected table. This address is used
to change the text screens. Control Addresses are entered and edited via the
Text Table Editor.

4.6.2 Table Editor Character Strings ����� Entering Control
Address Settings

· When using the text screen's MultiLanguage feature, if the [Text Table (ON/
OFF)] feature is selected, tables created will use the same table, control
(word) address and font names as standard tables. When editing this data,
use the Text Table Editor.
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3.4 Text Input: the Text Screen

����� Editing Multilanguage Text Screens

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(3) Click on the  (Text Table) to call up the Text Table
Editor.

(4) Click on the [Text Table (ON/OFF)] feature to select it.

(5) Set the Control Address, Table and Font information,
enter the desired text string  and then save the table.

(6) Return to the Text Screen and in the [Support's
Mult iLanguage]  d ia log  box ,  se lec t  [Use
MultiLanguage].
When the warning dialog box appears, click

 to close the box. Click on  to
cancel the Multilanguage feature.

(1) Click on [Screen] and then [New], or click on the
 icon and select Text Screen.

(2) A Text Screen will open.

Be sure to click on the [Text Table
ON/OFF] selection.

For detailed Text table editor setup
ins t ruct ions ,  
4.6.2 Table Editor Character
Strings �����  Character String Reg-
istration
To create a Text table, enter and
save at least one text string in the
table. This process is necessary to
specify a font for the table.

Be sure to click on the [Use
MultiLanguage] setting.

(7) Select the desired table from the [Table] pull-down
menu.
All the table names displayed here are tables previously
registered in the Text Table Editor. The table's font and
control address information is also displayed.

All table names displayed as "-----
---" cannot be selected.

Table names cannot be changed via
the Text Screen.
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3.4 Text Input: the Text Screen
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You can enter up to 512 lines on
one screen. Line number 513 or
subsequent lines cannot be dis-
played.

(9) After all text is entered, input a name and save the
table data.

Maximum
number of
characters

GP Type

40

GP-H70, GP-270, GP-370,
GP-377, GP-37W2,
GP-377R, GP-2301H,
GP-2300, GP-2301

80

GP-470, GP-570, GP-571,
GP-870, GP-477R, GP-577R,
GP-2401H, GP-2400,
GP-2401, GP-2500, GP-2501

100 GP-675, GP-2600, GP-2601

(8) Use your keyboard to enter text into the text display
area.
Be sure to press the [Enter] key  at the end of each
line.

����� Usage Restrictions
When registering multiple tables to a single text screen (Ex. X1) and the
Support's MultiLanguage dialog box's [Use MultiLanguage] check box is not
selected, only [Table 1]'s text will appear in the Text Display Area, and all
other related tables cannot be displayed or edited.
If that text screen (X1) is then saved and closed, only the text data for Table 1
is saved. When the text screen (X1) is reopened, all the previously registered
tables are not displayed (except for Table 1).
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3.4 Text Input: the Text Screen

This section explains the export of text screen data as a .txt or .csv file, as
well as the import of .txt or .csv file data.

· Importing/Exporting text screens compatible with the MultiLanguage
display feature is available only on the GP2000 Series units.

3.4.3 Text Screen Import/Export

Selects the format of the data to
be imported (to a text screen) or
exported (from a text screen).

Designates the data will be
imported to a text screen from
an external file.

Designates the data will be
exported from a text screen to
an external file.

����� Designating the Conversion Origin (Importing to a Text Screen)
If any of the registered text screens have the [Use MultiLanguage] check
box checked, set whether to specify a table as the destination to import the
file.

Displays the name of the file to
be imported to the Text Screen.

Designates that the data was
imported to a text screen which
is compatible with the
MultiLanguage display feature.
Also selects the registered table
name of the imported data.

Designates that the data is
imported to a text screen which
is not compatible with the
MultiLanguage display feature.

����� Selecting the Format of an External File and the Import/
Export Operation

· The data is imported/exported immediately after the setting above if all
text screens in the project file do not use the MultiLanguage display
feature. If any of the text screens are compatible with the MultiLanguage
display feature, the data is imported/exported after the table specification
step shown below.
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3.4 Text Input: the Text Screen

����� Conversion Table Designation (Exporting from a Text Screen)
If any of the registered text screens have the [Use MultiLanguage] check
box checked, set whether to specify the table of the text screen to be ex-
ported.

Displays the file name of the
external file.

Designates that the data from a
text screen for which the [Use
MultiLanguage] check box is not
checked is exported to an
external file.

Designates that the specified
multiple tables from a text screen
for which the [Use
MultiLanguage] check box is
checked are exported all together.
Table Nos. should be separated
with "," (comma).

Designates that the data from a
text screen for which the [Use
MultiLanguage] check box is
checked is exported to an
external file. It is necessary to
select the name of the table to
be exported.

����� Text Screen's External File Format
�����CSV file Format

Ex.) A text screen for which [Use MultiLanguage] is not checked (disabled).

(Filename: TEXT.csv)

1 2
Setting Display
Start Caution
Finish Warning

Screen Title
Screen Number

Text
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3.4 Text Input: the Text Screen

When Exporting Data:

• If the data from a text screen for which the [Use MultiLanguage] check
box is checked ([Specify Multiple] is checked and Table Nos. are speci-
fied) is exported, each table is exported as a .csv file and the file name is
created based on the [Screen Title]_[Table No] format. (TEST_01.csv in
the example above).

· For information about MultiLanguage display compatible text screens,
 3.4.2 Editing MultiLanguage Text Screens.

• If the data is divided and exported into multiple files, the files will have
sequential numbers starting from (1) after their names, i.e. "Text.csv" will
be converted to "Text(1).csv", "Text(2).csv" and so on.

Ex.) A text screen for which [Use MultiLanguage] is checked (enabled).

(Exported file has been saved as TEST.csv)

TEST_01.csv TEST_02.csv
1 2
TEST TEST
Konnichiwa Hello
Arigato Thank You

Screen Title
Table No

Text

When Exporting Data:

• If there are several text screens for which the [Use MultiLanguage] check
boxes are not checked (disabled), all the text screen data is exported as one
.csv file (TEXT.csv in the example on the previous page).

• If the number of text screens to be exported exceeds 255, the CSV file
editing tool (software) may not be able to display all the data as a single
file because the number of columns is insufficient. When the following
dialog box appears, click [Yes] to divide and export the data into multiple
files. Click [No] to export the data in a single file.
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3.4 Text Input: the Text Screen

#START,1
#TITLE, setting
Start
End
#END

#START,2
#TITLE, display
Caution
Warning
#END

Screen No.
Screen Title

Text

When Exporting Data:

• If there are several text screens for which the [Use MultiLanguage] check
boxes are not checked (disabled), all the text screen data is exported as one
.csv file (TEXT.csv in the example above).

Ex.) A text screen for which [Use MultiLanguage] is checked (enabled).

(Filename: TEST.txt)

#START,1
#TITLE, TEST
Konnichiwa
Arigato
#END

#START,1
#TITLE, TEST
Hello
Thank You
#END

Screen No.
Screen Title

Table 1 Text

Test_2.txt

Test_1.txt

�����Text File Format

Ex.) A text screen for which [Use MultiLanguage] is not checked (disabled).

(File name: TEXT.txt)

When Exporting Data:

• If the data from a text screen for which the [Use MultiLanguage] check
box is checked ([Specify Multiple] is checked and Table Nos. are speci-
fied) is exported, each table is exported as a .txt file and the file name is
created based on the [Screen Title]_[Table No] format. (Above example is
TEST_1.txt).

· For information about MultiLanguage display compatible text screens,
 3.4.2 Editing MultiLanguage Text Screens.
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3.4 Text Input: the Text Screen

����� Importing External Files (*.csv, *.txt) to Text Screens

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(3) Use the [Open File] command to select the desired ex-
ternal file, and click .

(1) Select the Project Manager [Utility] menu's [Import/
Export of Text screen] command.

(2) Select the type of file to import (.csv or .txt) and click
[Import].

If text screens with the same screen
number exist, a message asking if
it is OK to overwrite will appear.
To overwrite the existing file with
the imported file, click [Yes]. To
stop the Import process, click [No].
If multiple screens exist, a confir-
mation screen with the words

 and  will
appear.

(4) When a file is imported to a text screen for which [Use
MultiLanguage] is not checked (disabled), check [Do
Not Specify Table] in the [Convert Table] dialog box
and click .

When a file is imported to a text screen for which [Use
MultiLanguage] is checked (enabled), check [Specify
Table] in the [Convert Table] dialog box.

You can enter up to 512 lines on
one screen. Line number 513 or
subsequent lines cannot be dis-
played.

Maximum
number of
characters

GP Type

40

GP-H70, GP-270, GP-370,
GP-377, GP-37W2,
GP-377R, GP-2301H,
GP-2300, GP-2301

80

GP-470, GP-570, GP-571,
GP-870, GP-477R, GP-577R,
GP-2401H, GP-2400,
GP-2401, GP-2500, GP-2501

100 GP-675, GP-2600, GP-2601

If all text screens in the project file
do not use the MultiLanguage dis-
play feature, the file is imported
immediately after step 3. If there are
one or more text screens compat-
ible with the MultiLanguage dis-
play feature in the project file, the
file is imported after the table speci-
fication in step 4.

(5) The file(s) will not be imported. When import is com-
pleted, [End of Conversion] will appear. Click [Close]
to quit the utility.
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3.4 Text Input: the Text Screen

����� Exporting Text Screens to External Files (*.csv, *.txt)
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(1) Select the Project Manager [Utility] menu's [Import/
Export of Text screen] command.

(2) Select the type of file to import (.csv or .txt) and click
[Export].

(3) Use the [Open File] command to select the desired
external file, or enter the name of the file and click

.

If text screens with the same screen
number exist, a message asking if
it is OK to overwrite will appear.
To overwrite the existing file with
the imported file, click [Yes]. To
stop the Import process, click [No].

(4) When a text screen for which [Use MultiLanguage] is
not checked (disabled) is exported, confirm the name
of the destination file in the [Conversion Table Specifi-
cation] dialog box, check [DoNot Specify Table] and
click .

When a text screen for which [Use MultiLanguage]
is checked (enabled) is exported, check [Specify
Table] in the [Conversion Table Specification] dia-
log box. To export multiple tables, enter Table Nos.
and click .

(5) Export will be performed and the file will be created at
the designated location.

If all text screens in the project file
do not use the MultiLanguage dis-
play feature, the data is exported
immediately after step 3. If there are
one or more text screens compat-
ible with the MultiLanguage dis-
play feature in the project file, the
data is exported after the table
specification in step 4.
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3.5 Creating an Image: the Image Screen

When converting an image data (bitmap: BMP file and JPEG: .JPG file) into
an Image screen for the GP series, the image data can be displayed on the
GP series panel.
You can load an Image screen onto a Base screen, Trend Graph screen,
Keyboard screen or Window screen by selecting the [Draw] menu - [Load
Screen] command.

 2.2.10 Load Screens
You can animate the Image screen by using the L-tag.
To convert image data into Image screen data for the GP series, use the
[Utility] menu - [Convert Image] command.
• The Image Screen cannot be opened with the Screen Editor.
• You can also perform the conversion in the screen editor by selecting the

[Draw] menu - [Convert/Image] command.
2.2.12  Convert (Import) Image

• Image screens cannot be edited. To edit the image data, you must use the
original file, and then convert this file into Image screen data.
The Image screens can be checked on the screen list.

 4.1.1  ����� Listing/Copying/Deleting Screen

• This command can convert image data of up to 800 x 600 dots. Note that
any portion that does not fit into the GP screen will be cut off before con-
version.

3.5      Creating an Image: the Image Screen

3.5.1 Image Conversion
Convert image data (bitmap: BMP file and JPEG: JPG file) created with
other editor software or read with an image scanner into an Image (I) screen
for the GP series.

With a color Image screen, the data volume becomes large, but the GP
series’ display speed is increased. With a monochrome Image screen, the GP
series’ display speed is slightly lowered, but the data volume can be re-
duced. Select a color or monochrome Image screen according to your pur-
pose.
If the data volume is too large to be displayed on one screen, the converted
data will be divided into several screens (up to nine screens).

1 bit
2 colors
(black &

white)
16 colors

16-level
gray
scale

256 color
256-level

gray
scale

Windows BMP/DIB O O O O O O O O
Windows

BMP/DIB(RLE4)
- O O - - - - -

Windows BMP/DIB
(RLE8)

- - - O O - - -

JPEG *.JPG - - - - O - O -

*.BMP

16-bit
color

24-bit
color

32-bit
color

4 bits 8 bits

Number of colors
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Enter the name of
the image file to
be converted, or
select the image
file from the file
list by clicking on
the [Browse]
button

Register the above settings to execute the image
conversion. If you save the converted image data,
the image screen of the screen number specified
in [Screen Setting] will be created

Displays the
image of the
image file to be
converted.
However, this
image is different
from the image
that will be
displayed on the
GP series

Select the image
file to be con-
verted

Displays the dimen-
sions (horizontal x
vertical) of the
image data

Displays the size
of the image file

Displays informa-
tion on data
colors (e.g. 16
colors, 256
colors)

����� Converting/Placing an Image: [Source]
Specify the image file to be converted.  The information on the specified
image file will be displayed.

·  If the length of the original image data is less than “4” for color data,
or less than “8” for monochrome data, the image data cannot be
converted.

·  Make sure that the original image data’s horizontal (X), and vertical
(Y) dimensions are multiples of “4” for color data, or multiples of “8”
for monochrome data. Otherwise the fractional (remainder) data will
be cut from the right side and from the bottom of the image after
conversion.

X (Horizontal)
 : 25 dots

Y (Vertical)
 : 45 dots

X (Horizontal)
 : 24 dots

<With Color Data>

Y (Vertical)
 : 44 dots

Converts to
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3.5 Creating an Image: the Image Screen

����� Use Default Effects

When you specify Use Default Effects, the original data will be automati-
cally converted into the image data with the optimum brightness and display
quality.

����� Brightness

Used to convert bitmap data according to the brightness level. The reference
value can be changed between levels “0” and “15”. A larger value indicates
a brighter image, and a smaller value indicates a darker image.

����� Dithering

Used to set the converted data’s display quality.

�����  Blink
Used to make the converted data blink.

Blink cannot be used when the screen is displayed at 256 col-
ors.

�����  Compress
Used to compress the original bitmap data during conversion.

�����  Mirror
Used to replace the original bitmap data symmetrically relative to the X-axis
or Y-axis during conversion.

����� Converting/Placing an Image: [Effects]
Specify the brightness, resolution, blinking, compression, and mirror func-
tions for the converted image data.

Used to set the bright-
ness and display
quality automatically Used to manually

set the individual
options of the
brightness and
display quality

When 256-colors are
selected, “Blink”
cannot be selected



3-59GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

3.5 Creating an Image: the Image ScreenChapter  3 - Drawing

����� Image Color
Select the type of bitmap file conversion: Monochrome, Grayscale(Normal),
Grayscale(Reverse), 8 Color, 64 Color or 256 Color. The screen size and the
number of screen divisions vary with the type selected.

Select "MONOCHROME 8 HUES" on the [GP Setup] dialog box before
selecting the "MONOCHROME 8 HUES" option on the monochrome LCD
GP2000 Series units (GP-2301HL, GP-2300L, GP-2301L, GP-2500L or GP-
2501L).
• Depending on the color used, selecting MONOCHROME 8 HUES may

cause the GP unit’s screen to flicker. Confirm the color before using this
feature.

Select "256 colors without blinking" mode on the [GP Setup] dialog box
before selecting the "256 Color" option on the GP2000 Series
units(excluding the GP-2301HL, GP-2301HS, GP-2300L, GP-2300S, GP-
2301L, GP-2301S, GP-2500L, GP-2500S, GP-2501L and GP-2501S Series
units).

 6.1 ����� Tab Setting Items  ����� Initial Screen Settings
����� First Screen

Enter the screen number of the Image screen. If no screen number is speci-
fied, an Image screen of the currently displayed screen number will be
created.

����� Screen Type
Select whether the image screen is to be saved on the GP’s internal memory
or the CF card.

 Tag Reference Manual,  4.7 Using the CF Card

· You can select the CF card if your GP is a GP77R series or a GP2000 series.
Using the GP77R series requires the optional Multi Unit.

· When the CF card is specified, the drawing speed on a screen where the
image screen is placed become slower than GP memory is specified.

����� Converting/Placing an Image: [Destination]

Select the number
of colors of the
converted image
file

Displays the size
of the converted
screen

Enter the title of
the Image screen

Enter the screen
number of the
Image screen

Select a destina-
tion to save the
image screen
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3.5 Creating an Image: the Image Screen

����� Converting an Image
Convert an image file into Image screen data.
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If the original data are mono-
chrome, these conversion param-
eters cannot be specified.

The “Blink” feature can be speci-
fied for the GP-571T, GP-675,GP-
377S, GP-377R, GP-577R and
GP2000 series units only.

(3)Specify the conversion parameters.
If the data volume is too large to be displayed in one
screen, the image data will be divided into several Im-
age screens.

(2)Click on the  button, and select an image file
to be converted.
The color type, data volume, screen size and image data
of the bitmap file will be displayed.

(1)Select the [Utility] menu - [Convert Image] command
of the Project Manager.

����� Screen Title
Enter the title of the Image screen. Even if the converted data are divided
into several screens, only one title can be specified for one original file.

����� Size
Displays the size of the converted screen.
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To cancel conversion, click on the
 button.

When an image is converted by
selecting the [Convert Image]
command from the [Draw] menu on
the Screen Editor, pressing the
[Place] button allows the converted
image screen to be placed.

The Grayscale(Normal) and Grayscale
(Reverse)  is valid only for Monochrome
LCD GP2000 Series units (GP-2301HL,
GP-2300L, GP-2301L, GP-2500L and
GP-2501L only). Be sure to set the
[ G P  S e t u p ] t o [ M o n o c h r o m e ] .
The “64 Color” mode can be specified
for the GP-571T, GP-675, GP-377S, GP-
377R, GP-577R and GP2000 Series
units only.
The “256 Color” mode can be speci-
fied for the GP2000 Series units
(except GP-2301HL, GP-2300L, GP-
2500L and GP-2501L) only.

             6.1 Initial Screen Set-
tings
The number of colors specified for
[Screen Color] must be equal to the
number of display colors supported by
your GP series.
· If the number of colors is different, the

display speed will be lowered.
· Any colors that are not supported with

your GP series cannot be displayed.
Only when your GP type is the GR-77R
or GP2000 series, the CF card can be
specified in the [Screen Type] section.

 Ta g  R e f e r e n c e
Manual,  4.7 Using the CF Card

If the same screen number already
exists, the system asks if you want
to replace the existing screen with the
one you are attempting to save. If so,
select ;  otherwise,select

 .(6)If the displayed image is correct, click on the 
button.
An Image screen is created.

(5)Click on the  button to perform data con-
version.
The image data conversion starts. Then, the converted
image will be displayed.

(4)Enter the screen number and title of a new Image,
and designate Screen Type.
If you do not set a title, the title of the original Image file
will be specified.
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3.5 Creating an Image: the Image Screen

To compress an Image screen
(bitmap data) of another project, se-
lect the project.

 1.1.2 ����� Selecting
an Existing Project
To select several screens, click on
the screen numbers while pressing
the          key.
To select a specified screen, click
on the screen number while press-
ing the         key.
If the CF card is specified in step
(2) when your GP type is the GP-
77R series or GP2000 series, the
image screen on the CF card can
be compressed.

 Tag Reference
Manual,  4.7  Using the CF Card
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The compression and decompression procedures are
separately described as follows:

(2)Select the screen to be compressed or decompressed
from the list.

(1)Select the [Utility] menu - [Compress Bitmap] com-
mand of the Project Manager.

If the size of the Image screen is large, you can compress it to reduce the
data size. The data is compressed to one-fifth the size of the source data.
The compressed Image screen data can then be displayed directly to the GP
series. With the compressed Image screen, however, the GP series’ display
speed will be slower.

(7) Click on the  button to quit the conver-
sion mode.

Ctrl

Shift

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

3.5.2 Compressing/Decompressing an Image Screen

 2.2.12 Convert (Im-
port) Image
Select the [Load Screen] command
from the [Draw] menu to place the
converted image.

  2.2.10  Load
Screens
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[Decompression]
(3)Click on the  button to perform data decom-

pression.
The process is finished when the word “Normal” ap-
pears.

[Compression]
(3)Click on the  button to execute data com-

pression.
The process is finished when the word “Compressed”
appears.

R E M A R K SPPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE
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3.6 Video Data Display (V Screen)

Use a v-tag to call up the video window on the Video Screen (V file) onto
the Base Screen (V file). This feature allows the video display to be dis-
played on the GP screen when necessary.

This feature is supported only by the GP-2500T and GP-2600T.
The optional VM Unit is required.

The following two procedures can be used to display video windows: (1)
Use a v-tag to display the video window on the specific Base Screen (B); or
(2) display the video window as a global window for all screens.
In procedure (1), place a v-tag on the Base Screen (B). Select the [v-Tag]
from the [Tag] menu to make the settings.

Tag Reference Manual, 2.28 v-tag (Extended Video Win-
dow Display)
A v-tag can be set up only when "Extend(small v-tag)" is enabled. Select
this mode using the following procedure before setting up a v-tag. Select
[GP Setup] from the Project Manager and select [Extended Settings] and
[Video Settings].
(2) For details of the global display:

3.6.2 Video Window Settings
Select the [Video Setting] command from the [Tag] menu on the Video
Screen (V) to set up a video window. If necessary, select [T-tag] from the
[Tag] menu to set up a touch-switch for use in the video data display.
The environmental settings for video operation can be made by selecting
[Video Setting] on [Extended Feature Settings] from the [GP Setup], or by
selecting [Video Operation Settings] on the OFFLINE menu of the GP unit.
GP’s screen drawing objects cannot be placed on video screens. You can
check the contents of your  video screens via the [Screen List] feature.

 4.1.1   Listing/Copying/Deleting Screen

3.6      Video Data Display (V Screen)
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Usage  Pattern

• To Create a Video Screen
Click on Tag
menu[Screen] →→→→→ →→→→→[New] →→→→→ Click on Video

Settings
or

Click on   icon

or

Click on  to set up a
video screen

Save the video
screen→→→→→Click on

Tag menu
→→→→→ →→→→→Click on T-Tag
or

Click on  to set

up a touch switch

Save the Base
screen→→→→→Click on

Tag menu
→→→→→ →→→→→Click on v-Tag

• To Create a Base Screen

or

Click on  to set

up video settings.

Open the Base
screen

Extended
Settings

→→→→→Click on
Screen/Setup
menu

→→→→→ →→→→→Click on GP-Setup

• To use the GP Setup screen to enter video setting data.

Click on  to set up video settings.

or
→→→→→ Video Settings

This feature is enabled by performing the above procedure.

Select “Video Screen”
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3.6 Video Data Display (V Screen)

����� Entering Video Settings
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 1.1.3 Opening/
Closing/Saving a Screen

(2) Select the “Video Screen”.
The “Wizard” button is enabled only when video screen
is selected. Clicking on the “Wizard” button calls up a
dialog box that explains the video settings.
Basic settings can be made in the Wizard dialog box.
For detailed settings, adjust the settings on the [Video
Setting] dialog box in step (3).

(1) From the screen editor, select the [Screen] menu -
[New] command, or click on the  icon.

(3) From the [Tag] menu, select [Video Setting], or click
on the  icon.

(4) Enter the desired video settings in the [Video Set-
ting] tab screens.

(5) After all settings are entered, click on the 
button.

(6) Place the video data display area icon where you wish
to have the video display on the GP screen. Re-size
the icon to reflect the actual size of the display.

 Tag Reference
Manual, 2.28 v-tag (Extended
Video  Window Display)



3-67GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

3.6 Video Data Display (V Screen)Chapter  3 - Drawing

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

T-tags have the following features
on a video screen.

Bit operation

Set

Reset

Momentary

Word Operation Mode

Set 16 bit

Set 32 bit

Interlock and Reverse display fea-
tures are not available.

(2) After all settings are entered, click on the 
button.

(1)Select the [Tag] menu - [T-tag] command, or click on

the  icon.

����� Create a Touch Switch to Actvate the Video Data
Place a touch switch with a T-tag on the video data display area. The touch switch
can be used for various applications. For example, touching the video window
changes the window size according to the T-tag settings.

(3) Place the tag on the video data display area.

(4) After all settings are entered, save the video screen.

 Tag Reference
Manual,  2.23 T-tag (Touch
Panel Input)

 1.1.3  ����� Saving a
Screen

You must set at least one Video Set-
ting tag on the video screen. If you
do not, the screen cannot be saved.
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(3)After all v-tag settings are entered, click on the
 button.

(2)Select the [Tag] menu - [v-tag] command, or click on

the  icon.

����� Enter v-tag Settings

 Tag Reference
Manual, 2.28  v-tag (Extended
Video Window Display)

(1)Open a Base Screen.
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(2) Click on the [Extended Settings] tab and then click
on the [Video Settings] button.

����� Use the [GP Setup] area’s [Video Setting] selection

(1) Click on the Project Manager’s  icon,
or click on the  [Screen/Setup] menu’s [GP Setup]
selection.

(3) Specify settings for the parameters on [Video Set-
ting].  3.6.1 Video Settings
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����� Video Control Start Address

This area (Video Control Area) is used to designate the various control
features for the display of the video screen on a GP.

Device/PLC Connection Manual, 1.1.2 LS Area Structure

Use the following table when seting the Video Control Area’s start address.

In Standard mode, 22 words are automatically allocated for the Video
Control Area, starting from the Start Address. In Extend mode, 43 words are
allocated.

Tag Reference Manual,  4.13.3 Standard Mode

Tag Reference Manual,  4.13.4 Extended Mode
����� Center Zoom

Clicking on this selection, if the mode is changed from Standard to Zoom,
designates that the center of standard mode’s video screen will be enlarged.
This selection is enabled only in Extend mode.

Used in the GP570VM
and GP870VM. Cannot
be used via a v-tag,
only with a V-tag.

Set when the Video
Window is used as a
Global Window.

3.6.2 Video
Window Settings

Designate whether a Video
Control Start Address is
used or not. Enabled only
in [Extend] mode.

 Tag Refer-
ence Manual, 4.13 Extended
Functions of VM Unit

3.6.1 Video  Settings

This feature is used with the GP2000 series unit’s [Extend]
mode. It cannot be used via a V-tag, only with a v-tag.

This section describes the procedure for specifying the Video Setting.  Select
Standard or Extended Mode according to the GP Type.

Only "Standard Mode" can be enabled with the GP-570VM and GP-870VM.

Mode Video Control Area Start Address
Standard LS20 to LS2010, LS2096 to LS4072 (to LS8170 for GP2000 series units)
Extend LS20 to LS1989, LS2096 to LS4053 (to LS8149 for GP2000 series units)
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����� Video Input/Display Mode

Used to designate the type of input signal and display mode used.
Display Mode (from a PC) cannot be used if this screen is set to Extend Mode.

����� Brightness/Contrast/Tone/Mode

Used to designate the GP display settings used for each input channel.

3.6.2 Video Window Settings

This selection is used when using the video window as a global window.
The setting method is the same as that used for Global Window. When
global mode is used, however, the local v-tag cannot be used. The control
address used is the user’s designated area.

����� Absolute

����� Control Bit Addr.

When this bit is designated as “0”, the window is not displayed. When it is
“1”, the window will appear.

����� Window Location

This position uses the absolute value of the data entered to designate the
video window’s top left corner. At this time, that point becomes the video
screen’s zero (0,0) point.

����� Screen No.

Designate the screen number of the video screen to be displayed.

X(639,479) (0,0)

(639,479)

(0,0)

   HorizontalVertical

  Window

Designate this point

Y

X

Y
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3.6 Video Data Display (V Screen)

����� Window Touch Action

Available If the desired window is currently behind another window,
touching anywhere on the desired window will bring that
window to the front.

Invalid If the desired window is currently behind another window,
touching anywhere on the desired window will have no effect
and the window will remain in its current position.

Always top This setting keeps the desired window always on the “top”
(front most) of the display. However, if the GP unit’s system
window is used (display of parameters, errors, alarm mes
sages, etc.), this screen will be placed behind the system
window

����� Relative
This setting uses a variable to designate the display screen and the display
position. Thus, as data is saved to the designated Word Address, the display
will change.

����� Control Word Addr.

When this bit is designated as “0”, the window is not displayed. When it is
“1”, the window will appear.

15 02 01 00 bit

+0 Video Window Control
+1 VideoWindow Screen Number
+2 Video Window Display Position (X coord. data)
+3 Video Window Display Position (Y coord. data)

[Window Control]

Display

[0] = No display
[1] = DisplayDesignate this point

[00] = Available
[01] = Not available
[10] = Always top
[11] = Reserved (not available)

<JPEG Error Codes>



3-73GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

3.6 Video Data Display (V Screen)Chapter  3 - Drawing

����� Data Format

BIN

BCD

Designates the type of data used for the display position and window num-
ber data.
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3.7 Window Display: Window (U) Screen and Base (B) Screen

3.7    Window Display: Window (U) Screen and Base (B) Screen

3.7.1 Overview of Window Display
Call up the windows registered on the Window Screen (U) or Base Screen
(B) and display them on the Base Screen (B).

Additional windows can be displayed on the GP screen when necessary.

Example: Make the settings for displaying a bar graph by turning ON the
window display switch.

<GP Screen>

<GP-PRO/PB III Screen Editor>

1)Registering a window on the U Screen

2)Registering a window on the B Screen

O
F
F

O
F
F

O
N Window Display O

NWindow Display

Window Display

Turn ON the
switch

Window Display

Turn ON the
switch

Turn OFF the
switch

Turn ON the
switch

Call up the bar
graph from U300 to
B2 using a window
part.

Use a U-tag to call
up the bar graph
from B300 to B2

B2

B2

B2

B2

U300

B300

O
F
F

O
N

O
F
F

O
N
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3.7 Window Display: Window (U) Screen and Base (B) Screen

Window Registration can be performed on the Window Screen (U) or Base
Screen (B).

The following two types of Window Display are available.

����� Local Window Display

Set up a U-tag to call up a window registered on the Base Screen (B) to the
Base Screen (B).

3.7.3 Window Registration on the B Screen
Tag Reference Manual, 2.26 U-tag (Window Display)

Set up a window part or a U-tag to call up a window registered on the Win-
dow (U) to the Base Screen (B).

 2.1.26 Window Parts, 3.7.2 Window Registration on the
  U Screen, Tag Reference Manual, 2.26 U-tag (Window Display)

����� Global Window Display

Displays a single window on all Base Screens (B) as a global window. To
call up the window, make the "Global Window" settings on the OFFLINE
settings of the GP unit or on the [GP Setup] of the Program Manager in GP-
PRO/PB III..

Tag Reference Manual, 2.26 U-tag (Window Display), GP
  series User Manual, 5.3.3 Global Window Setup

K-tags, U-tags, V-tags, v-tags, trend graphs (T Screen and parts),
Keypad Input Display, Logging Display, CSV Display and File
Manager Display will not function from the registered window.

Window registered on the B Screen Window registered on the U Screen
Window part Not available �
U-tag � �
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3.7 Window Display: Window (U) Screen and Base (B) Screen

3.7.2 Window Registration on the U Screen

Call up a window that has been registered on the Window Screen (U) onto
the Base Screen (B)

The window can be easily called up with the window part placed on the
Base Screen pasted to the Base Screen.

����� Window Screen

Usage Pattern

→→→→→[Screen] [New Screen] OK Create a window.

[Part] [Window Part] Specify the window. Place.

→→→→→ →→→→→

→→→→→→→→→→→→→→→
or

This section describes the procedure for calling up a window display of a
bar graph onto B2, following the example in the section Overview of Win-
dow Display in 3.7.1.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1) Select [New] from the [Screen] menu, or click   to
select [Window Screen]. The Window Screen (U)
opens and a window area with a square frame is dis-
played.

(2) Draw the bar graph to be called up to the B2 screen. Click the border of the window
area and eight � will appear on the
screen. With the mouse, drag � to
change the size of the window area.
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3.7 Window Display: Window (U) Screen and Base (B) Screen

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(3) Adjust the window area so that it surrounds the bar
graph.

(4) Save the Window Screen (U).
Select the [Save As] command from the [Screen]
menu, or click .

The Window Registration number
that is added to the B Screen (dis-
played in red if it is already regis-
tered) cannot be selected as the
"Screen" number.

3.7.3 Window
Registration on the B Screen

A U-tag can be used as well to dis-
play the Window Screen onto the
Base Screen.

Tag Reference
Manual, 2.26 U-tag (Window
Display)

Enter the "Screen Number" and "Title." Click the
  button.

(5) Open the Base Screen (such as B2) to be used for the
window display.

(6) Select [Window Parts] from the [Parts] menu, or click
.

The x coordinates for the window
display can only be set up in 8 dot
intervals, i.e. the cursor will snap
from one 8 dot unit to another. You
can set up the Y coordinates any-
where you wish.
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3.7 Window Display: Window (U) Screen and Base (B) Screen

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

[Window Control Address](7) Select the window to be displayed from the "Win-
dow Number" field.
Specify the Window Control Address as well.

(8)Click the [Place] button after setting all attributes.
The border of the window area is displayed on the draw-
ing area.

(9) Click on the position where the window is to be
placed.

A maximum of one global window
and two local windows can be dis-
played simultaneously on a single
Base screen.

If the specified position overlaps
the objects on the Base Screen, the
objects are hidden while the win-
dow is displayed.

15 02 01 00 Bits

Show
[0]: Hide the
window
[1]: Show the
window

Changing the
order of window
layers
[0]: Touching the
window will change
the order of the
layer.
[1]: Touching the
window will NOT
change the order of
the layer.

Tag Reference
Manual, 2.26  U-tag (Window
Display)
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To display a window during the GP’s RUN mode, you must first register it;
the window can be either all or part of a Base screen.
There are two types of window displays, Global and Local, and both are
registered and deleted using the same methods.

Tag Reference Manual, 2.26 U-tag (Window Display)

Windows registered on the U Screen are displayed in red. Editing, deleting
and copying are not available here.

→→→→→

Usage  Pattern

→→→→→[Screen]
[Window
Registration] →→→→→

Add,
Modify, or
Delete

 or
the
key

Esc

Lists the
Window’s
registration
information

Deletes a regis-
tered window

Modifies window
registration Size
and/or Descrip-
tion

Adds new win-
dow registration
data

Copies a regis-
tered window

����� Registering Windows
Here, an additional window can be registered.  When clicking on the

 button, the window registration setting dialog box will appear.

  Refer to next page: �Registering a Window

3.7.3 Window Registration on the B Screen
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����� Editing Windows
Screens registered as a window can be edited, and their names can be
changed.  First, select the window to be changed from the Window Registra-
tion of the Registration list; then, click on the  button. The coordi-
nates of windows are changed in the same manner as adding a window.
After the window’s coordinates have been designated, the [Add To List]
Dialog box will appear and the title can be changed.  When the 
button is clicked on, the changed items will be registered.  To cancel the
changes, click on the  button.

����� Registering a Window, steps (3) to (5)

If a registered window is copied, the same area (location) of another window
can be registered as a window. Any registration number, screen number
being registered, and title can be changed.

 ����� Copying Window Registration Data

����� Registering a Window
Here, part or all of a screen is registered as a window.

����� Deleting Windows
This command deletes a registered window.  Use the above dialog box to
select the window to be deleted, then click on the  button and a
dialog box will appear to confirm your command.  Click on the 
button to delete the window; click on the  button to cancel the
command.

Open the screen to be registered as a window.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S
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(4) Enter the Registration No. and title, and then click
on the  button.
The window will be registered.

Enter set key

Enter 1

The "Screen Number" used on the
Window Screen cannot be selected
as the Registration Number.

The Description entered can be up
to 30 characters.

Windows can be registered up to
1189 for each Project File.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(2) Click on the  button.

(3) Designate the area that you wish to register by Left-
dragging the cursor to enclose it.

When you are working on a new
screen that has not been saved, and
you attempt to Add (register) a win-
dow, the [Save As...] dialog box
will appear. First, you must save the
screen, then you can register the
window.

 1.1.3 � Saving a
Screen Under a Different Name,
step (2)

 2.2.3 Square/
Rectangle � Drawing a Square/
Rectangle

The x coordinates for the window
display can only be set up in 8 dot
intervals, i.e. the cursor will snap
from one 8 dot unit to another. You
can set up the Y coordinates any-
where you wish.

(1) Select pull down menu [Screen]’s [Window Menu].

Start

End
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PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(5) Click on the  button to finish registration.
When registering another window on the same screen,
do not quit here, rather, start again from step (2).

[Window Registration]

By changing Size in the Registered
Window List of the Popup Window
Setting, a larger number of regis-
tered items can be displayed.

Place the cursor at the bottom-right
corner of the screen. The cursor
changes to a black arrow. Adjust the
size of the dialog box while hold-
ing the left mouse button.

Shows the Window’s
registration data
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(4) Click on the  button to copy the window.

(1) Select the [Screen] menu - [Window Registration]
command.

(2) Select a window to be copied, and then click on the
 button.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

����� Copying Window Registration Data
If a registered window is copied, the same area (location) of another window can be
registered as a window.

To select multiple windows at a
time, drag through the windows
being selected on the list, or select
those windows by clicking on them
while holding down the         or
          key.

(3) Enter the registration number of a new window, the
screen number to which the window is to be copied,
and that screen’s title.

If multiple windows have been se-
lected in step (2), specify the start
window number and screen num-
ber of the destination. The window
numbers and screen numbers will
be assigned relatively so that the
smallest window number among
those of the source windows corre-
sponds to the start window num-
ber.

Shift
Ctrl
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����� How to Display Windows
The method used for calling up a registered window will differ depending
on whether the window’s type is global or local.

����� Global Window Display

You can set the “Global Window”area in the [Global Window Setup] from
the GP panel’s OFFLINE menu or you can use the Global Window dialog
box, located in the GP-PRO/PBIII Project Manager screen’s [GP Setup]’s
[Extended Settings] dialog. Click on the “Global Window” button to bring
up this dialog.

Tag Reference Manual,  2.26 U-tag (Window Display) , GP
Series Users Manual,  5.3.3 Global Window Setup

����� Local Window Display

Here, a U-tag is used on a Base screen to display a window.

Tag Reference Manual,  2.26 U-tag (Window Display)



s you use this Screen Editor Software, file management work such as
copying and deleting created screens and projects will become easier,

thereby improving your work efficiency. This chapter covers “Information
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4.1 Screen Editing

4.1      Screen Editing

4.1.1 Listing/Copying/Deleting Screen

Usage  Pattern
Select a
Screen Type.[Screen] →→→→→ →→→→→

You can list the number, size and title of all existing screens for each screen
type. You can also print out this screen list.

  9.1 Print Settings

This section describes the commands used to edit a screen, such as listing
screens, and copying/deleting a specified screen.

[Open Screen]

����� Listing Screens
This feature lists screens for the current project.

To print the screen
list, refer to 9.1.1 �����  Printing-
[Project Information] Tab

By checking the [Preview] check
box, the selected screen image can
be viewed in the dialog box.

(1) Via the Screen Editor, select the [Screen] menu -
[Open Screen] command, or click on the  icon.

(2)Select the type of screens to be listed.
The screens will be automatically listed.

→→→→→
Screen list
appears.
Copy or delete a
desired screen.or

Click on .

By changing the [Open Screen] dia-
log box's size, the screen list dis-
play area can be enlarged so that
more screens can be displayed.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

When selecting “Mark
Screen” from the Screen
Type
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4.1 Screen Editing

����� Copying Screens
This feature copies a screen from the current project file.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

Once the [Copy] command is
performed, it cannot be un-
done.

To select several screens simulta-
neously, drag the mouse down the
list, or click on the target screens
while pressing your PC’s             key
or         key.

(3) Specify the Start Screen Number of the copy desti-
nation and copy count. Then, click on the 
button.
The screen will be copied for the designated number,
consecutively from the Start Screen No.

(1) Via the Screen Editor, select the [Screen] menu -
[Open Screen] command, or click on the  icon.

(2) Select a screen to be copied from the list, and click
on the   button.

Shift
Ctrl

When selecting multiple screens si-
multaneously, copy will be per-
formed only one time.
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4.1 Screen Editing

����� Deleting Screens
This feature deletes a screen from the current project file.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

Once the [Delete] command is
performed, it cannot be un-
done.

To select several screens simulta-
neously, drag the mouse down the
list, or click on the target screens
while pressing your PC’s             key
or         key .

(3)Click on the  button to delete the screen.

(1) Via the Screen Editor, select the [Screen] menu -
[Open Screen] command, or click on the  icon.

(2) Select a screen to be deleted from the list, and click
on the  button.

Shift
Ctrl
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4.1 Screen Editing

����� Changing Screen Numbers and Titles
This feature allows you to change screen numbers and titles in the current project file.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

If any existing screen num-
ber is specified, it will be
overwritten.

The currently open screen cannot
be changed.

(3)Change the screen number and title, and then click
on the  button to delete the screen.

[Changing only One Screen]
(1) Via the Screen Editor, select the [Screen] menu -

[Open Screen] command, or click on the  icon.

(2) Select a screen to be changed from the list, and click
on the  button.
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4.1 Screen Editing

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

To select multiple screens at a time,
drag the mouse through the desired
screens on the list, or click on those
screens while holding the        or
        key down.

(3) Specify the start screen number at the destination,
and then click on the  button.

“21” is specified here.
The specified number comes to the top, and the subsequent
numbers are changed automatically with increments of off-
set values.

[Changing Multiple Screens at a Time]
(1) Via the Screen Editor, select the [Screen] menu -

[Open Screen] command, or click on the  icon.

(2) Select multiple screens to be changed from the list,
and click on the  button.

Shift
Ctrl

The difference between the start
screen number at the destination
and that at the source is taken as an
offset value. Since the start screen
number, 1 is to be changed to 21
here, the offset value is 20.  This
offset value is added to the subse-
quent screen number 13, which is
then changed to 33.

The currently open screen cannot
be changed.
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4.1 Screen Editing

����� Specifying Items to Be Copied
After selecting a project file as the copying source, specify the items you want to copy,
such as the screen area to be copied and other settings, and a copying method.  These
screens and settings can also be printed out.
                             9.1 Print Settings

4.1.2 Copying Screens from Other Projects
Screens created in any project file other than the currently open one, and
other settings can be copied to the currently open screen.

Specify the screen
area to be copied
from the project file
at the copying
source.

Specify the settings
other than the
screen to be copied
from the project file
at the copying
source.

Specify the start screen
number in the project file
at the copying destina-
tion.
The specified data will
be copied to this and
subsequent screens.

����� Source

The project file selected as the copying source is displayed. Specify the
screen area to be copied and a screen type. If you are not copying a screen,
but other settings only, select [Internal Settings].

 ����� Destination

The current project file is displayed. When copying a screen from another
project file, specify the start screen number in the project file at the copying
destination to start copying the screen.

 ����� Internal Settings

Select the items to be copied among the global settings for each project
file, which are not dependent on any screen. Also specify whether the
settings existing in the current project file are deleted by overwriting them
or merged (added) with additional settings without deleting them. If "Over-
write" is specified, the settings at the copying destination will be deleted
and all the settings at the copying source will be copied. If "Merge" is
specified, the settings at the copying source will be copied while those at
the copying destination are left as far as possible.

When such a merge is made using [Window Registry], [D-Script Func-
tions], or [Filing Data], you will be prompted to confirm whether any
identical existing number or function name is to be overwritten. When the
combination is made using [Data Sampling], [Global D-Script], or [Sound
Settings], all the settings will be merged.
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4.1 Screen Editing

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

<When [All] is selected>

All screens in the Project are cop-
ied.

<Notes on copying windows regis-
tered with the Window Screen or
Base Screen>

(1) When copying a window regis-
tered with the Window Screen,
select [All], or specify the
Screen Type as "Window
Screen" under the [Screen
From/To] option in the [Source]
field.

(2) When copying a window regis-
tered with the Base Screen,
check the "Window Registry"
option in the "Internal Settings"
field.

<When Windows of the same No.
exist in the both the Source and
Destination Projects>

A window registered with the Base
Screen cannot be copied onto a
window registered with the Win-
dow Screen.

(3) Enter the screen type and screen number of the origi-
nal screen.
Those screens corresponding to the specified initial
screen number through the final screen number will be
copied.

To select a screen located in a dif-
ferent folder, you must change to
that folder.

 1.1.2 � Selecting
an Existing Project

The currently opened project can-
not be selected.

When you double-click on the
project name selected in step (2),
you can skip the  com-
mand.

First, open the copy designation project.

(1) Select the Project Manager’s [Utility] menu - [Screen
Copy] command.

(2) Select the project file to be copied (original project
file) from the screen list, or enter the target project
name, then click on the  button.
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4.1 Screen Editing

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(5) Select the internal settings to be copied, and specify
the copying method (overwrite or merge).

(4) Enter the screen type and screen number of the des-
tination screen.
The screens will be copied to the Destination project,
starting from the specified initial screen number onwards.

(6) After confirming your selection and designation,
click on the  button.
If there is any screen of an identical number or function
name, you will be prompted to conform whether or not to
overwrite it. Selecting  will overwrite such a

screen or function name, and selecting  will

proceed to the next question. If  is selected,
all the screens or settings will be overwritten. If

 is selected, only the screens or settings that
do not exist at the copying destination will be copied.
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4.1 Screen Editing

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

After replacing the screens, you
must re-enter all Tag device ad-
dresses.

To subsequently copy any other
screen in the same project file, re-
peat the procedures starting with
step (3).

(7) Click on the  button to exit the screen copy
mode.
The number of screens copied will be displayed in the
dialog box.

(8) Click on the  button.
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4.2 Project Editing

4.2      Project Editing

4.2.1 Deleting Project Files

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

To select a project located in a dif-
ferent folder, change the directory
to that folder.

 1.1.2 � Selecting
an Existing Project

Once the [Delete] command is
performed, it cannot be un-
done.

When you double-click on the
project name selected in step (3),
you can skip the  com-
mand.

(3) Click on the  button to delete the project.

(1) Via the Project Manager, select the [Project] menu -
[Delete] command.

(2) Select the project to be deleted from the screen list,
or enter the desired project's file name. Then, click
on the  button.

This feature allows you to delete a project file.
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4.2 Project Editing

4.2.2 Backing up Project Files

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

The option is enabled in the initial
settings.

To open and edit Backup files via
the Project Manger, change the
filename extension from "bak" to
"prw".

(3) Save a Project file.
The backup file [A PLANT SYSTEM. bak] is created
in the same folder in which the selected Project Man-
ager (Example: A PLANT SYSTEM.prw) is stored.

(1) In the Project Manager (such as A PLANT SYSTEM.
prw), select the [Project] menu's [Backup Settings]
command.

(2) Put a check mark in the "Backup Project File"
checkbox and click on the  button.

When a Project file is saved, a backup file (*.bak) of the most recently saved
Project file data is created. The backup file is created in the same folder in
which the selected Project Manager is stored.

To open and edit Backup files as Project files, change the filename extension
to "prw".
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4.2 Project Editing

4.2.3 Rebuilding A Project (Rebuild)

9. Parts and Tags placed on the GP-PRO/PB III for Windows program
screen cannot be displayed on the GP unit, or, a different screen than
desired is displayed on the GP unit. (i.e. the relationship between the
screen data and Parts data is not correct)

If the above error message is displayed, GP-PRO/PB III for Windows
program  cannot read the target file until this file is rebuilt.
If a file’s data cannot be completely restored with the “Rebuild” tool, the
system treats this data as abnormal data and deletes it. In this case, you must
edit this PRW file using GP-PRO/PB III for Windows program after the
“Rebuild” command is performed.

File Rebuilding requires approximately three times the hard disk space
occupied by the Project file.
Protected PRW files cannot be rebuilt. It is necessary to remove the Protect
setting before rebuilding. For details about removing Protect settings,

4.2.9 Protect Settings

The “Rebuild” tool is used to both check the contents of the PRW files, PRO
files, CPW files, CPL files and MRK files created with GP-PRO/PB III for
Windows, as well as to rebuild these files if the following conditions oc-
curred.

In the following cases, use the “Rebuild” command to restore file data.

1. You personal computer is either reset or shut down while you are
saving data.

2. The system crashed while you were saving data.
3. Your floppy disk or hard disk is damaged.
4. Your personal computer’s disk drive is defective.
5. A system error (an error not specified in the error message list, such as

a partition or checksum error) occurs while a screen is being opened or
transferred.

6. The desired project file does not display as a PRW file during project
selection, or an existing screen’s number is not displayed when you try
to open that screen.

7. You cannot select a project file when you try to perform the [Select
Project] command. (i.e. the GP-PRO/PB III for Windows program
cannot recognize the project file as a PRW file)

8. When you try to open a file, an error message appears, indicating that
the file is damaged.
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�����   Rebuilding
General description of the “Rebuild” screen is as follows:

Menu Bar

Displays the progress
of the rebuild opera-
tion

Displays the status
of the rebuild
operation

Displays the
selected file’s
name

Tool Bar

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(2) Select the [File] menu - [Open] command, or click
on the  icon.

(1) To rebuild a file, select [Rebuild (Data Recover/Op-
timize)] from the Project Manager’s Utility menu, or
click on the Windows main menu’s [Start] button.
Point to the [Programs] - [Pro-face] - [ProPB3 C-
Package] menu, and select the [3.Rebuild] command.

(3) Select the file to be rebuilt, or enter the file name.
Then, click on the  button.
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To cancel file rebuilding, click on
the  icon.

(4) After confirming that the file name is correct, select
the [Actions] menu - [Start] command, or click on
the   icon.
The selected file will then be rebuilt.

(5) Select the [File] menu - [Exit] command, or click on
the  icon and finish the rebuild operation.

When parts and tags placed on the GP-PRO/PB III screen are not dis-
played on the GP screen or are displayed in completely different shapes
(the parts data is not properly associated with the screen data), execute the
Rebuild command and transfer the data again. Select  and choose
the [Transfer Settings] command from the [Setup] menu to display the
[Transfer Settings] dialog box. Specify the [Send All Screens] option from
the [Transfer Method] field.

Note:
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In word address conversion mode,
Tag addresses specified by a bit ad-
dress can also be changed, within
a specified range.

When using any of the following
PLCs, specify the PLC number, as
well:
FACTORY ACE, 1:n communica-
tion (Yokogawa Electric Corp.)
TOYOPUC-PC2, 1:n communica-
tion (Toyota Machine Works)
TOYOPUC-PC3J, 1:n communi-
cation (Toyota Machine Works)
CP9200SH Series (Yasukawa
Electric Corp.)
SDC Series (Yamatake Electric
Corp.)
T H E R M A C  N E O  s e r i e s
(OMRON)

4.2.4 Converting Addresses and Device Codes

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

PLC No.

When converting addresses, be
sure that the address settings meet
the following condition:
“Final address before conver-
sion” -  “Initial address before
conversion” ≤≤≤≤≤ “Final address af-
ter conversion” -  “Initial ad-
dress after conversion”
If the left side is larger than the
right side in the above formula, the
Tags corresponding to the surplus
addresses will be assigned to the
final address of the same device.

(3) Enter the address conversion range and the updated
initial address.
Before this step is performed, be sure that the first and
last device codes used are the same. You cannot specify
an address conversion range for a different device.

(1) Via the Project Manager, select the [Utility] menu -
[Convert Addresses] command.

(2) Select the type of the address conversion to perform:
Word Address or Bit Address.

This feature allows you to change a Tag’s addresses. This address conver-
sion can be performed on either word or bit addresses. This command is
useful for changing both addresses or an address’ device code.
· When assigning a variable (GLC symbol) to the address do NOT perform

the Address Block conversion. Otherwise, the operation will fail.
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(6) After confirming that all the settings are correct,
click on the   button.

(5) Enter the screen number to be changed. (Enter the line
numbers used in the Alarm Editor)
All the addresses between the initial screen number and the
final screen number (or the addresses between the initial line
number and the final line number), will now be changed.

(4) Select the type of screen to be replaced.

Do not convert addresses on
2,000 screens or more at a
time. Otherwise, the memory
capacity might run short af-
ter this conversion. If this
memory shortage occurs, re-
start the GP-PRO/PB III.
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(8)To stop the address conversion prior to normal
completion, click on the  button.

(7)Click on the  button.
The progress of the address conversion will be displayed.

�����  Load Screen and Search Screen Settings
Here, specify the screens to be converted. Enter the numbers of the Search
Screens on which Load Screens have been called up and called up Load
Screens.

4.2.5 Convert Load Screens
This feature allows you to convert the currently loaded screens to different ones
via the [Load Screen] command, all at once.

Specify the
range of Load
Screens before
conversion.

Specify the Top
Screen number
of the Load
screens after
conversion.

Specify the
range of the
Search Screens
on which Load
Screens have
been called up.

Specify the
Search Screen
Type.

Specify the
Load Screen
Type.
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(2) Specify the type and numbers of the Load Screens
to be converted and the Top Screen number of the
Load Screens after conversion.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(6) Click on the  button to close the dialog.

Example; Load Screens B100 to B105 currently loaded
on Base screens B1 to B30 are converted to B200 to
B205.

(3) Specify the range of the Search Screens and their
type.
The Load Screen numbers specified in step (2) will be
converted and called up on Search Screens specified by
the Start and End numbers, here.

(4) After confirming all the settings are correct, click on
the  button.

(5) Click on the  button to start conversion.
The conversion status will continuously be displayed.

(1) Via the Project Manager, select the [Utility] menu -
[Convert Load Screens] command.

Start No. (100)
End No. (105)

Top Screen No.
(200)

Base screen

Start No. (1)
End No. (30)

Base screen
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The drawing area, commands and
memory used by this change will vary
depending on the selected GP type.
Be sure to check these items before
changing the GP type to be sure that
your change(s) will be compatible
with your existing project’s data.

The GP type cannot be changed from
GP/GLC/ST Series to LT Series.

(2)To change the GP type, click on the desired GP type.

(3)Click on the  button.

You can change the GP type of your current project.
· After changing the GP type, you can save the current project using the

[Project] menu - [Save As] command.

 1.1.2 ����� Saving a Project Under a Different Name

4.2.6 Changing a Project’s GP Type

Note:

(1)Via the Project Manager, click on the  icon, or se-
lect the [Project] menu - [Change GP Type] command.
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Do not open screens other than the
Project Manager. Doing so will dis-
able the selection of the GP Type.
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Horizontal type

ABC

AB
C

Vertical type

• When a high-resolution type GP unit is replaced with a low-resolution
type, data beyond the display range cannot be displayed.
If a project file is changed to a low-resolution type and then changed
back to the high-resolution type again, data beyond the display range
(data that cannot be displayed with the low-resolution type GP panel)
will be restored.
Before changing the [GP Type] setting, be sure to use the Screen
Editor to check the changed display.
Select [Option], [Screen Settings] and the [Display Area] tab. Then
select the resolution of the new GP Type, and click [OK]. A frame will
appear on the Screen Editor to show the display range at the specified
resolution. You can then move your data into the frame.

• The maximum number of characters used for an alarm summary
differs according to the GP unit screen’s resolution. For example, if an
alarm message is created for a high-resolution type GP and then
changed for the low-resolution type, data beyond the message area
cannot be displayed.

• When a vertical type GP unit is replaced with a horizontal type or
vice- versa, the displayed screen is rotated 90º . Therefore, you must
also edit the screen using the [Rotate] command. After editing, be sure
to check that the displayed data is as desired.

Example)
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4.2.7 Changing Your Project's Device/PLC Type and Addresses

Note:

The Device/PLC type selected in the current project and the available
addresses can be changed.

To change the Device/PLC type, save the Device/PLC type you have changed
via the [Project] menu-[Save As] command.

1.1.2 ����� Saving a Project File under a Different File Name

����� Changing the Device/PLC type
The Device/PLC type can be changed in the following dialog box. Before
changing the Device/PLC type, enable or disable serial interface selection.

• The default “Serial I/F Switch” setting is "No". Select "No" or "Yes" only
when the GP type is set to the GP2000 Series.

• When the GP type is set to the GP2000 Series (GP2301H/GP2401H/GP2301/
GP2401/GP2501/GP2601 series) without extended SIO I/F (COM2), speci-
fying "Yes" for Serial I/F Switch prevents a change of device (Extended
Serial I/F). This occurs because the Serial I/F (COM1) is used by the Ex-
tended SIO Script protocol. For details regarding “Serial I/F Switch”,

4.2.8 Changing Extended SIO Settings.

Note:

Add a check mark to
display a screen that
allows you to config-
ure the conversion
pattern of available
devices.

Select the
desired
Device/PLC
type from the
pull-down
list.

A description cannot
be entered.

Before changing
the Device/PLC
type, you must
specify either "No"
or "Yes" for serial
interface selection.

• When changing the [Switch Serial I/F] setting from “No” to “Yes” or vice
versa, the following caution message will be displayed. To make the GP unit
recognize the Serial I/F Switch, be sure to send the PRW file as well as the
[GP Setup (Y)] to the GP unit.



4-23

Chapter 4 - Screens

GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

4.2 Project Editing

����� Setting the Device Conversion Pattern
The conversion operation of available devices is executed when the PLC
type is changed.

The "Conversion Pattern" should be registered in order to convert the avail-
able device.

For efficient setup operations, arrange the following items beforehand.
• Tables of available devices/PLCs both before and after the device/PLC

types have been changed.
(  Device/PLC Connection Manual, Device Memory Map of
the PLC, etc.)

• Printed result of global cross reference

Note:

Address Table
Displays detailed
information on the
conversion patterns
(address type, range
of available ad-
dresses before the
PLC type is changed,
and start address of
the available address
after the change).

Click this button to load the
conversion patterns from the
CSV file data and display the
data in the Address Table.

Click this button to
save the conversion
patterns in a CSV
file.

Click this button to
delete a conversion
pattern.

Click this button to
modify the settings of
the conversion pat-
tern.

Click this button to
register an additional
conversion pattern.

Click this button to
cancel all conversion
information in the
Address Table.

Click this button to execute the conversion accord-
ing to the data shown in the Address Table.
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(3) To change the Device/PLC type, click on the desired
GP type.

(1) Via the Project Manager, click on the  icon, or
select the [Project] menu - [Change Device/PLC
Type] command.

Do not open screens other than the
Project Manager. Doing so will dis-
able the selection of the Device/
PLC Type.

(2) Select either "No" or "Yes" for serial interface se-
lection.

The initial setting of serial interface
selection is "No". Select "No" or
"Yes" only when the GP2000 Se-
ries is used.

 Changing the De-
vice/PLC type
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Once you change a project’s De-
vice/PLC type, you must re-enter
that project’s device addresses for
Tags, D-script and alarms. Save
each screen separately again when
the Function Switch set up with the
"Change Screen" function is used
on the screen.

[When no Device conversion patterns are set]
(4)Click on the  button.

(5)Click on the  button to exit the setting dia-
log box.

The conversion operation applies to
all addresses in the selected Project
(except for addresses that have been
registered as symbols).
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[When Device conversion patterns are set]
(4)Put a check mark in the "Convert Address" checkbox

and click on the  button.
The conversion operation applies to
all addresses in the selected Project
(except for the addresses that have
registered as symbols).
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The new conversion pattern is added to the Address
Table.

Added conversion pattern

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

Refer to the list of available devices
of your PLC.

Select the "Address Type" option and designate the
available "Start Address" and "End Address" of the
PLC before the conversion, as well as the available
"Start Address" of the PLC after the conversion, and
click on the  button.

(5)Click on the  button to set up the con-
version pattern for the Device.
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<Editing a conversion pattern>
Select the conversion pattern you want to edit from the
Address Table and click on the  button.

Designate the conversion pattern with the procedure de-
scribed in Step (4) of [When Device conversion patterns
are set].

The edited information is displayed in the Address Table
of the conversion pattern.
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Designate the file name.
In the "File name" field, enter the name of the CSV file to
which the data will be saved.

Click on the  button to confirm the destina-
tion file to which the conversion pattern will be saved.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

<Deleting a conversion pattern>
Select the conversion pattern you want to delete from
the Address Table and click on the  but-
ton.

<Saving a conversion pattern as a CSV file>
Select the conversion pattern you want to save from the
Address Table, and click on the  button.
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<Loading a conversion pattern from a CSV file>
Click on the  button.

Select the CSV file to be loaded, and click on the
 button to confirm the selection.

The content of the CSV file is displayed in the list of con-
version patterns.

When the combination of the PLCs
indicated in "Convert From" and
"Convert To" specified in [PLC
Type Change] differs from the data
on the CSV file, the conversion pat-
tern stored in the CSV file cannot
be loaded. Selecting the CSV file
and clicking on the  but-
ton will not display any data in the
Address Table.

(6)After setting up the conversion pattern, click the
 button to perform address conversion.

Conversion Example (time)
[Conditions] (Contents of project
file)
No. of screens: 1
No. of Tags/Parts placed: 50
No. of specified conversion pat-
terns: 10
[Conversion time]
About 10 seconds

The conversion time increases/de-
creases in proportion with the num-
ber of screens.
It may also vary according to
changes in the settings of other
items.
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Click the  button to exit the dialog box.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

[If no conversion error occurs]
(7)Click on the  button to exit the setting dia-

log box.

[If a conversion error occurs]
(7)Detailed information on the conversion error is dis-

played.

B screen:
Screen No. 0

Device address

<Completing "Convert Address">
Click on the  button.
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<Maintaining a history of conversion errors as text
data>
Select the conversion error, and click on the [Export
Error Address List] button.

Designate the file name.
In the "File name" field, enter the name of the text file to
which the data will be saved.

Click on the  button to confirm the destina-
tion file to which the conversion error will be saved.

Click the  button to exit the dialog box.

<Canceling the PLC and Address Change>
Click on the  button.

The [PLC Type Change] dialog box appears on the screen
and the settings are reset to the conversion pattern settings
that existed before the conversion.

Click on the  button to close all setting screens for
changing the PLC.
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You can change the Extend SIO Type selected in the current project.

1.1.2 ����� Creating a New Project

This feature is available only with the GP2000 Series.
After changing the Extend SIO Type, you can save the current project using
[Project] menu - [Save As] command.

 1.1.2  ����� Saving a Project File under a Different Name

����� Changing the Extend SIO Type
After setting the “Serial I/F Switch”, select the desired “Extend SIO (EXT
Serial  I/F)”.

4.2.8 Changing Extend SIO Type

Note:

A description
cannot be
entered.

Select the desired
SIO type.

Before changing
the extended SIO
type, you must
specify either "No"
or "Yes" for serial
interface selection.

• When changing the [Serial I/F Switch] setting from “No” to “Yes” or
vice versa, the following caution message will be displayed. To make
the GP unit recognize the Serial I/F Switch, be sure to send the PRW
file as well as the [GP Setup (Y)]  to the GP unit.

����� Serial I/F Switch
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[When the GP2000 Series unit has a built-in Extend Serial I/F]
The Device/PLC connects to and communicates via the GP's Extend Serial
I/F (COM2).The Extend SIO connects to the GP's Serial I/F (COM1).
Communication depends on the Extend SIO Script's Protocol.

• Only “Extend SIO Script” can be selected for the “Extend SIO Type (EXT
Serial I/F)”.

•  When the GP is in OFFLINE mode, "Serial I/F Switch" is automatically set
to "No".

•  The communication methods available when using Serial I/F (COM1) are
RS-232C, RS-422 (4-wire) and RS-422 (2-wire).

"No" - The Device/PLC connects to and communicates via the GP unit's
Serial I/F (COM1). Extend SIO connects to and communicates via the GP
unit's Extend Serial I/F (COM2).
• The default setting for “Serial I/F Switch” is "No".

“Yes” - The following table shows the unit revision codes that correspond to
the “Serial I/F Switch” function.

Note:

Series Name Built-in Standard Product Name Unit Corresponding Revision
GP-2300L GP2300-LG41-24V All Revisions
GP-2300S GP2300-SC41-24V All Revisions
GP-2300T GP2300-TC41-24V All Revisions
GP-2400T GP2400-TC41-24V Rev.H and later
GP-2500L GP2500-LG41-24V Rev.B and later
GP-2500S GP2500-SC41-24V Rev.A and later

GP2500-TC11 Rev.G and later
GP2500-TC41-24V Rev.C and later
GP2600-TC11 Rev.F and later
GP2600-TC41-24V Rev.C and later

GP-2301HL GP2301H-LG41-24V All Revisions
GP-2301HS GP2301H-SC41-24V All Revisions
GP-2401HT GP2401H-TC41-24V All Revisions
GP-2301L GP2301-LG41-24V All Revisions
GP-2301S GP2301-SC41-24V All Revisions
GP-2301T GP2301-TC41-24V All Revisions
GP-2401T GP2401-TC41-24V All Revisions
GP-2501L GP2501-LG41-24V All Revisions
GP-2501S GP2501-SC11 Rev.A and later
GP-2501T GP2501-TC11 Rev.A and later
GP-2601T GP2601-TC11 All Revisions
GLC2300L GLC2300-LG41-24V All Revisions
GLC2300T GLC2300-TC41-24V All Revisions
GLC2400T GLC2400-TC41-24V Rev.E and later

GLC2500-TC41-24V
GLC2500-TC41-200V
GLC2600-TC41-24V Rev.A and later
GLC2600-TC41-200V All RevisionsGLC2600T

Serial Interface
(Dsub25 Pin)

Expansion Serial
Interface

(Dsub9 Pin)

GLC2000
Series

Serial Interface
(Dsub25 Pin)

Expansion Serial
Interface

(Dsub9 Pin)

Serial Interface
(Dsub25 Pin)

GP2000
Series

All Revisions

GP-2500T

GP-2600T

GLC2500T
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   Communication settings: After "Serial I/F Switch" has been set to "Yes",
designate the method via [Extend SIO Settings] dialog box in the [GP Setup
| Extended Settings].

   When RS-422 (2-wire) is used, an internal 20ms wait is required during
communication switching (send/receive).

•  The Extend Serial I/F (COM2) is a Dsub 9 pin connector. Refer to the
following Signal Wire chart when wiring your cable's connector.

[COM1, COM2 Signal Wire Chart].

*1 COM2’s [RI/VCC] can be set using the [GP Setup] dialog box’s [Communica-
tion Settings] .

Pin Number Signal Name Pin Number Signal Name
2 SD(Output) 3 SD(Output)

3 RD(Input) 2 RD(Input)

4 RS(Input) 7 RS(Input)

5 CS(Input) 8 CS(Input)

6 DR(Input) 6 DR(Input)
7 SG( - ) 5 SG( - )
8 CD(Input) 1 CD(Input)

14 VCC(Output) RI/VCC *1)

17 RI(Input) (Input/Output)

20 ER(Output) 4 ER(Output)

9

Serial Interface

(COM1: Dsub25 Pin)

Expansion Serial Interface

(COM2:Dsub9 Pin)

Note:
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Note:

[When the GP2000 Series unit has only a built-in "Serial I/F
(COM1)"]
Extend SIO connects to the GP unit's Serial I/F (COM1). Communication is
performed based on the Extend SIO Script's Protocol.
• Only “Extend SIO Script” can be selected for the “Extend SIO Type (EXT

Serial I/F)”.

• When changing the “Serial I/F Switch” setting from “Yes” to “No”, or when
changing your project’s GP type to a GP2000 series unit (with built-in
Extend Serial I/F), be sure to re-select the Device/PLC type.

Dsub25P Dsub9P
FG FG

1
2 3
3 2
4 7
5 8
6 6
7 5
8 1
20 4
22 9

When the Serial I/F (COM1, Dsub25P)’s connection cable (GP410-IS00-0 etc.)
and a commercial-type conversion adaptor are used for connecting to the
Extend Serial I/F (COM2, Dsub9P), the conversion adaptor’s COM1(Dsub25P)
‘s Pin #22 must be connected to COM2 (Dsub9P) ‘s Pin #9. Also be sure that
COM2’s [RI/VCC] has been set to “RI” via the [GP Setup | Communication
Settings] menu. Setting the [RI/VCC] to “VCC” may cause the RS-232C circuit
to malfunction.
Ex.) ARVEL Corporation’s RS-232C Conversion Adapter Model: AA830.

• When the GP is in OFFLINE mode, “Serial I/F Switch” is automatically set
to “No”.
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(3) To change the Extend SIO Type, click on the desired
Extend SIO type and then.

(1) Via the Project Manager, click on the  icon, or
select the [Project] menu - [Change Extend SIO
Type] command.

Do not open screens other
than the Project Manager.
Doing so will disable the
selection of the Extend SIO
Type.

(2) Select either "No" or "Yes" for serial interface se-
lection.

The default “Serial I/F Switch”
function setting is “No”.

When the “Serial I/F Switch” func-
tion is set to “Yes”, the “Extend SIO
Script” is automatically selected.
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4.2 Project Editing

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(4) Click on the  button.
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4.2 Project Editing

The currently selected project file (.prw) can be fully protected so that a
password is required to open or edit the file.

Follow the same procedure for protecting and unprotecting the file.

When a file is protected, you must enter the password each time you open
the file.

• Keep a copy of the password in a safe place. If you forget the
password, you will be unable to select or edit the project file.

• The password is limited to 5 characters. Only alphanumeric
data (0 to 9, a to z, A to Z, no symbols) can be used.

• When a project file setup for protect is uploaded using GP-
PRO/PBIII Ver 6.2 or earlier software, the protect setting will be
lost.

4.2.9 Protect Setting

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S
[To fully protect a project file]
(1)Via the Project Manager (e.g. A PLANT SYSTEM.

prw), select the [Project] menu - [Protect Setting]
command.

(2)Enter a password not exceeding five single-byte al-
phanumeric characters in both [PassWord Setting]
and [PassWord Sett ing (Confirm)] .  Click

 .

"Protect Version" indicates the ver-
sion of GP-PRO/PB III for Win-
dows used to protect the file. Pro-
tected prw files cannot be opened
with a version of GP-PRO/PB III
for Windows earlier than GP-PRO/
PBIII for Windows Ver 6.2.

[To unprotect a project file]
(3) Repeat step (1) above, enter the password, and click

 .
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4.2 Project Editing

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

[To open a protected prw file]
(1) To open a fully protected prw file (e.g. A PLANT

SYSTEM.prw), select the [Project | Select] command
via the Project Manager.

(2) Select "A PLANT SYSTEM.prw" and click on the
 button.

(3) Enter the password in the dialog box and click on
 .
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4.3 Project Compression/Decompression

4.3         Project Compression/Decompression

Displays the file
name of the project
to be compressed/
decompressed

Displays the overall
progress of the
project file compres-
sion/decompression

Displays the status
of the project file
compression/decom-
pression

Usage  Pattern

Pro-faceProgramsStart →→→→→→→→→→→→→→→

Compressing a project file reduces the size of its data to accomodate a
standard floppy disk’s limited capacity. A compressed project file and its
screens however, cannot be edited. To edit the screens, you must first de-
compress the project file.

A general description of the compression tool is as follows:

[Action] [Compress Project File]/
[Decompress Project File]

Designate a Project
file to be compressed or
decompressed.

→→→→→ →→→→→ →→→→→ Click on the

button.or

Click on  or .

ProPB3 C-
Package →→→→→ 4. Pack Tool →→→→→
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4.3 Project Compression/Decompression

A Project file can be compressed to a smaller size. At this time, a large sized file can be
divided into smaller files automatically according to the specified capacity. After a project
file is divided into several files during compression, serial numbers are assigned to the
first character of each file extension (or assigned to the first and second characters if the
file number has two digits).
Example) *.0PW, *.1PW...*.9PW, *.10W, *.11W

4.3.1 Compressing a Project File

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1) First, click the Windows [Start] button. Then, click
on the [Programs] - [Pro-face] - [ProPB3 C-Package]
menu and click the [4. Pack Tool] menu item. You
can also select [Pack Tool...] from the PRO-PB Util-
ity pull-down menu.

Enter the file name of
the project file to be
compressed, or select a
desired file name from
the list by clicking on
the [Browse] button

Used to select
the file size
limit

Used to locate
the project file
to be com-
pressed

The compressed project
file is automatically
divided into several
files according to the
specified file size

From Windows Main Menu From GP-PRO Program
Manager Utility Menu
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4.3 Project Compression/Decompression

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

To call up a menu of all the avail-
able folders, click on the  
button.

(4)To divide the project file during compression, click
on the [Separate File] check box, and select the de-
sired file size limit.

(3)Select the folder and project file to be compressed,
or enter the file name.
The file name of the desired project file will be displayed
in the “Pack” screen.

(2)Select the [Action] menu - [Compress Project File]
command, or click on the   icon.
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4.3 Project Compression/Decompression

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(6) Select the [Action] menu - [Exit] command, or click
on the  icon.

The compressed project file will be
stored in the same folder as the
original project file.

(5)Click on the  button.
If the same file name already exists, the system asks if
the existing file must be overwritten. If you select

 , the existing file will be overwritten. If you
select  , the existing file will not be overwrit-
ten, and you will return to the previous dialog box.
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4.3.2 Decompressing a Project File
A compressed project file (0PW file) cannot be edited. To edit the com-
pressed project file, you must first decompress it.

Enter the file name of
the project file to be
decompressed, or
select the desired file
name from the list by
clicking on the
[Browse] button

Used to locate the
project file to be
decompressed

(1)Click on the Windows desktop’s [Start] button. Then,
point to the [Programs] - [Pro-face] - [ProPB3 C-
Package] menu and click on the [4. Pack Tool] menu.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S
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(2) Select the [Action] menu-[Decompress Project File]
command, or click on the  icon.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

To select a folder, click on the
 button.

To decompress a  com-
pressed project file that has
been divided into several
files, make sure that all di-
vided files are available.
However, when you specify
the file name to be decom-
pressed, the system displays
the first file name (*.0PW)
only.

The decompressed project file will
be stored in the same folder as the
compressed file.

(3) Select a folder and Project file to be decompressed
or enter the file name, and click on the 
button.
If the same file name already exists, the system asks if
the existing file must be overwritten. If you select

 , the existing file will be overwritten. If you

select   , the existing file will not be over-
written, and you will return to the previous dialog box.

(4) Select the [Action] menu - [Exit] command, or click
on the  icon.
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4.4 Comparing Projects

4.4      Comparing Projects

Usage  Pattern

Specify project
files to be
compared with
each other

[5. Project
Compare]

→→→→→

Data can be compared between two project files.

The overview of the Project Comparison Tool is shown below:

Enter project file
names to be com-
pared with each
other, or select those
file names from the
list by clicking on
[Browse] button.

Displays the
comparison result.

Output the compari-
son result as a text
data file.

Select project files to
be compared with
each other.

Displays only
differences in the
comparison result.

Click on the

button

→→→→→

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Click on the [Start] button.  Move the mouse pointer
to [Program], [Pro-face] and then [ProPB3 C-Pack-
age].  Click on [5. Project Compare].

Pro-faceProgramsStart →→→→→→→→→→→→→→→ ProPB3 C-Package →→→→→

The project files to be compared
must be prepared using the trans-
fer screen’s “Prepare” feature.
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(2) Select a Project file to be compared or enter the file
name, and click on the  button.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

Checking the [Different only]
check box will enable you to toggle
between displaying only differ-
ences in the comparison result and
displaying all the details of the
comparison result.

Note that a message will appear in-
forming you there is a difference in
the GP System settings when the
following project files A and B are
compared.
* Project File A stored in the GP-

PRO/PB III
* Project File B with the following con-

ditions: After the Project File A is
transferred to the GP unit, the opera-
tion is executed with the data changed
with the GP in OFFLINE mode. The
settings are returned to the previous
settings in OFFLINE mode again, and
the screen is received and created via
the GPPRO/PB III.

In order to prevent differences in
GP system settings between two
projects, open project file B using
the same GP-PRO/PBIII version
that was used for creating project
file A. After the file is opened, click
the  button in the [GP
Setup] dialog box.

Specify folders      
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4.4 Comparing Projects
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Clicking on the [Output File] button
will enable you to output the compari-
son result as a text file (*.txt).

(3) Select the [Action] menu - [Exit] command, or click
on the  icon.

In order to prevent differences in GP
system settings between two projects,
open the older version project file us-
ing the newer project’s GP-PRO/PBIII
version. After the file is opened, click
the  button in the [GP Setup]
dialog box.

Comparing project files that were cre-
ated using different versions of GP-
PRO/PBIII will cause a message to ap-
pear stating that there are differences
in GP system settings.
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[Project Information] displays both the commands used to edit the current
project, and the date and time of its last revision. To use this command,
select the [Project] menu - [Properties] command.

����� Project

4.5      Information Display

4.5.1 Project Information

����� Current Project
Displays the file name of the currently selected project file.

����� Description
Displays a comment about the current project.

����� Device/PLC Type
Displays the Device/PLC type selected in the currently opened project file.

����� GP Type
Displays the GP type selected in the current project file.

����� Extend SIO Type
Displays the current Extend SIO setting. This setting can be changed when a
GP2000 series unit is selected as the GP Type. The setting is grayed out
when any other type of GP is selected. (Except the GP-2301 and GP-2501)

����� Project Size
Displays the data volume of the current project file.
If any Parts are placed in this file, the file volume will be increased.

����� Date & Time
Displays the date and time when this file was saved last.

����� Size of Screen To Be Sent To GP
Displays the data size that will be occupied by the current project file (the
value of the "Project Size") on the GP unit panel. This item indicates the
following two conditions separately: the case in which the upload informa-
tion is sent to the GP unit, and the case in which it is not. The ratio of the
current volume of the total screen size to the GP's total memory capacity is
displayed as a percentage, serving as the guide for calculating the approxi-
mate number of screens that can be created thereafter.

This section describes the types of screen and project information available.
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4.5 Information Display

When the data volume is indicated as “????”, select the [Project]’s - [Trans-
fer] menu, and then click the [Prepare] command.

    7.2.4 Transfer Preparation
The size of the CF card data to be transferred is not displayed.

����� Extended Screen Count
Displays the number of screens that will be created in the GP unit, relative
to the current project file. Since this value includes the GP unit’s internal
screens, it is larger than the number of screens that have been created with
GP-PRO/PB III for Windows 95. To display this information, set up the
current project file in the “Transfer Preparation” mode. If the project file is
not in the “Transfer Preparation” mode, the number of screens is indicated
as “????”
The number of screens transferred to the CF card is not be displayed.

����� Device Monitor Information
Displays whether the device monitor command has been registered or not.

����� Screen
This screen shows the number of screen types, alarm messages and channels
contained in the current project.

If Filing Data is saved on both the GP's internal memory and the CF card,
the available capacity of the CF card will be displayed.

Note:

Note:

����� SRAM Information
The situation with the use of the backup SRAM in the current project is
displayed on a function basis.

Note:

The number of channels
and the screen number
that are used in the
project are displayed
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����� Project Name
Displays the file name of the currently selected project file.

����� Device/PLC Type
Displays the Device/PLC type selected in the current project file.

����� Current Screen
Displays the screen type and screen number of the current screen.

����� Description
Displays the title of the current screen.

����� Size
Displays the data volume of the current screen. If any Parts are placed on
this screen, the screen data volume will be increased.

����� Tag

����� Used Tags
Displays the number of Tags specified on the current screen.

����� Available Number of Tags
Displays the acceptable number of Tags after subtracting the number of Tags
specified on the current screen from the allowable maximum number of
Tags.

The [Screen Information] screen displays the settings for the currently open
screen, as well as the date and time of its last revision. To use this command,
select the [Project] menu’s - [Screen Information] command.

����� Screen

4.5.2 Screen Information



4-52

Chapter 4 - Screens

GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

4.5 Information Display

4.5.3 Version Information

<Project Manager Version Information>

[Version Information] displays the GP-PRO/PB III Project Manager and
Editor’s version information. To see this data, select the [Help] menu -
[About] command.

����� Maximum Number of Tags
Displays the maximum number of Tags available on the current screen. The
allowable maximum number of Tags varies depending on the selected GP
type.

GP-270, GP-370, GP-H70 ....................................128 Tags
GP-470, GP-570, GP-571, GP-675, GP-870 ........256 Tags
GP-377, GP-77R, GP2000 series .........................384 Tags
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4.6 Table Editor Character Strings

1

2

3
: :

1

2

3
:

START

STOP

NEXT
:

1

2

3
: :

1

2

3
:

START

STOP

NEXT
:

START STOP

Table 1

The Character Strings Settings and the Multi-language Display Feature are
described in this section.

• Multi-language Display Feature is supported by GP-377/77R/
2000 series units.

• Bit map fonts cannot be used in the table editor character
strings.

Table 2 Table 1 Table 2

When Table 1
is selected

When Table 2
is selected

then a screen’s
text string is
changed.

4.6      Table Editor Character Strings

4.6.1  Overview: Multi-language Display Feature

Using Text registered in the Text Table Editor for the text objects and part’s
labels allow you to easily switch the language and information displayed on
the screen during operation (the diagram below describes the steps for
switching the display language.) Switching between tables is performed with
the Control Address (two or more tables cannot be specified at one time).
Thus, you can easily switch the display language or displayed text items on
the screen. Character strings are switched by selecting tables (a group of
character strings). Registration of the Text and setting the Control Address
can be performed with the Text Table Editor.

Index No. 1

Example: Switching the display language for the label of a part

Use the Text
Table Editor to
create the Text
in two lan-
guages.

Index No. 2 Index No. 1 Index No. 2

GPGP

Table is switched
with the Control
Address
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4.6 Table Editor Character Strings

����� Precautions for switching tables with the Alarm function

• When a table is switched while an alarm message (Flow display) is
displayed, the switched table is not used until the next message is issued.

• Switching tables uses the same process as switching
screens. Therefore, some screen displays drawn with tags
may not be able to be refreshed.

• The following character strings cannot be changed even when
the tables are switched.

– [A-tag] character strings
– [K-tag] character strings
– [S-tag] character strings
– [P-tag] format character strings
– [X-tag] character strings
– Filing Feature
– Loging Feature

ENGLISH

A PRESSURE ERROR TANK A PRESS

ENGLISH ENGLISH

GP

(Direction of the
display flow)

(Direction of the display flow)

Switch the tables

Japanese to
English

GP

ALARM A
ALARM B
ALARM C

GP
Japanese to
English

Switch the
tables

• When the print setting is enabled for the Alarm Message Function (Flow
display), the alarm message of the table (language) displayed at the
moment when the alarm is triggered or reset will print.

• When a table is switched while real-time printing is set to print the alarm
summary (a-tag) or log alarms (Q-tags), the switched table will be used
starting from the next print job.

A

A

B
C
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4.6 Table Editor Character Strings

4.6.2  Table Editor Character Strings
The Table Editor is used to create a table’s character strings.

Table Editor Character Strings can be exported in CSV format. You can also
import a CSV file to use as a table editor character string.

Click here to
specify the
Control Address

Select a table to
enter character
strings. Up to 16
tables can be
registered

Index No.
Up to 3,000
character strings
can be registered

Set the font
(language) for the
selected table

Double-click on
this area to call up
a message dialog
box (Up to 1,200
characters)

[Screen/Setup]

Operation procedures

Start →→→→→→→→→→ →→→→→

→→→→→

� Table Editor Features

[Text Table...]

Assign Control Address. Select font from [Font Setting] menu.→→→→→

Enter character string. →→→→→ Save table data.

• When a table is switched while log alarms (Q-tags) are being written into
the CF Card as a CSV file, the switched table is used immediately.

• The steps for switching tables are similar to those for switching screens.
Therefore, the Sub Display, Cursor Display and Scroll Display that were
displayed before the switching with the Log Alarm (Q-tag) will not be
reproduced.

After setting up
the text, specify
the line and click
the [Go to] button
to jump to the
specified line.

→→→→→[Put a check mark in the "Text
Table(ON/OFF)" checkbox.]

Put a check mark
here to enter the
mode in which Text
Table Editor is
enabled.
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4.6 Table Editor Character Strings

� Entering ControlAddress Settings
Specify the Control Address to switch the tables.

In the Control Address, store the Table No. you want to display.
The default text table is displayed when "0" is stored. To set up the default
text table, select [Default Table Setup] from the [File] menu on the "Text
Table Editor" dialog screen.

<Values stored in the Word Address>

• A table will not appear when you specify a table number for which nothing is set.

Value in one Control Address Table No.
0 Initial character string table
1 Table 1
2 Table 2
: :

16 Table 16

� Using the Text Table Editor
• When a check mark is placed in the "Text Table(ON/OFF)" checkbox

(ON mode), the Table Editor is switched to input mode, enabling addi-
tional settings such as Table setting and Index Text registration.

• When the check mark is removed from the checkbox (OFF mode), the
following warning message dialog box appears. Clicking the 
button deletes all Text Table data registered in the project. Click the

 button to retain the data.
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4.6 Table Editor Character Strings

� Entering Messages
On the Text Table Editor, double-click the column of the Index No. you
want to set up. The screen below appears on the screen. Enter the Text for
each Index Number.
Specify the message size [Characters] x [Lines] for each Index No.

Character Entry Area

Specify the number of charac-
ters in a line. (1 to 100 single-
byte characters)

Specify the number of lines.
(1 to 40 lines)

• The number of characters used in a table editor character string is deter-
mined by [Characters] x [Lines]. (Max. 1,200)

[Characters] x [Lines] ≤≤≤≤≤ 1,200

• Multiple display lines can be used for [Character string] and Parts [Label]
only. For other features, do not specify an index number for which multiple
display lines are set. If such an index number is specified, only the first line
will be displayed.

The table editor characters for each index number [Characters]
x [Lines]  are available in all tables.

� Table Name
Up to 16 tables can be registered.

To change a table name, display the table whose name is to be changed onto
the "Text Table Editor" screen. Next, click [Table Name Change] on the
[File] menu.

Enter the desired table name and click the [OK] button to change the table
name.

� GP Font Settings
Specify one font (language) for each table (a table cannot contain more than
one font [language]).
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4.6 Table Editor Character Strings

PROCEDURE REMARKS

The table name can be modified by
selecting [File] menu - [Table
Name Change].

You can choose from the follow-
ing five selections.
• ASCII (Code Page 850)
• CHINA (GB2312)
• JAPAN(JIS)
• KOREA (KS-C5601)
• TAIWAN (Big5)

The number of characters used in
the table editor character string is
determined by [Characters] x
[Lines]. (Max. 1,200)
[Characters] x [Lines] ≤ 1,200

Multiple display lines can be used
for [Character string] and Parts [La-
bel] only. For other features, do not
specify an index number for which
multiple display lines are set. If
such an index number is specified,
only the first line will be displayed.

(6) Enter the desired [Characters] and [Lines] accord-
ing to the table editor character string.

(1) In the Project Manager, select the [Screen/Setup]
menu - [Text Table...] command.

(2) Put a check mark in the "Text Table Editor"
checkbox in the [Text Table(ON/OFF)] dialog box.

(3) Click on the   icon and enter the [Control Ad-
dress].

(4) Select a font from the [Font Setting] menu .
Select a table from   on the right of the "Table 1"
field and select a font (language) from  on the right
of the "GP Font Settings" field.

(5) Double-click the table editor character string entry
area.

����� Table Editor Character String Registration
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4.6 Table Editor Character Strings

PROCEDURE REMARKS

(8) Click the  button to confirm the charac-
ters.

(9) Repeat the same steps to set the index character
strings for the other index numbers.

(10)Repeat the same steps to create other tables.

(11)Select the [File] menu - [Save] command or click on
the  icon to save the setting.

(7) Enter the table editor character string.

Up to 16 tables can be registered.
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4.6 Table Editor Character Strings

Table Data
Table Table 1

1 15 1 4 Abnormal pressure in tank A
2 15 2 4 Abnormal pressure in tank B

����� Importing/Exporting CSV files
You can export the contents of a table created using the Table Editor as a
CSV file, or you can import a CSV file created using another table editor
software into the Table Editor.

• To edit data exported into a CSV file, or edit data that has been
previously exported, use an operating system that supports the font
specified in [GP font setting] of Table Editor Character Strings.

����� Importing CSV files

Select the [File] menu - [Import] command.

Use the following dialog box to select the desired file.

• When a CSV file is imported, the existing table editor charac-
ter string is overwritten.

• When [Characters/Lines] is selected
If the imported [Characters] x [Lines] of the CSV file setting
values are lower/less than the table editor character string
values set in the [Table Editor], any excess/remaining charac-
ters in the [Table Editor] will be deleted during import.

• When [Characters/Lines] is not selected
If the imported CSV file’s setting values are higher/greater
than the table editor character string values set in the [Table
Editor], any excess characters in the imported data will be
deleted during import.

• Do not import a CSV file if the [Characters/Lines] value ex-
ceeds 1200. It will not be correctly imported.

����� CSV file format for character string tables

CSV file format

Number of
characters

Index No.

Table Name
Table Editor
Character
String

Header (Required for importing the file data)

Number of
lines

Font (Language)
0: Japanese
1: Chinese
2: Taiwanese
3: Korean
4: ASCII
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4.6 Table Editor Character Strings

����� Selecting the Drawing Table
From the menu bar in the Screen Editor, select the table to use for drawing.
When a table is changed, the character strings used in the Screen Editor also
change.

����� Selecting the table editor character string
����� Entering the table editor character string

Click on the [Browse Text Table] to switch the screen to the one used to
enter the table editor character string.

Select the desired table editor character string from those shown in the
[Table Editor]. To add a new table editor character string, click the

 button to start the [Table Editor].

4.6.2  Table Editor Character Strings ����� Table Editor Char-
acter String Registration

4.6.3  Entering Settings via the Screen Editor

Place a check mark here to sort
the table editor character strings
displayed in the pull-down menu
in character code order. (Dis-
criminates between single-byte
and double-byte characters.)

When enabled, the text's text
box is centered within the
designated "frame".
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4.6 Table Editor Character Strings

• The size of any text object placed on the drawing area automatically
changes according to the size specified in the Table Editor ([Characters] x
[Lines]). Switching tables does not change the text size.

• [Centering Arrangement] feature's initial setting is disabled (not selected).
If this feature is left unselected and the Text dialog box settings are:

No. of Table Editor Characters : 15
No. of Rows : 3

the following alignment settings will produce the following results.
(the Text's "position" is displayed separately)

This feature is used in the same way in the Message Display Part's [General
Settings] tab.

The "frame/border" shown around the text registered in the Text Table
Editor is created according to the character and row specifications given
above. Even though the dotted border is not shown on the screen, it con-
forms to the number of characters and rows specified.

When the [Centering Arrangement] feature is enabled (selected), the text's
frame/border (the dotted one) is centered relative to the lines/border of the
black rectangle.

Left Alignment

abcdef
gh
hijk

Centered

abcdef
gh
hijk

Right Alignment

abcdef
gh

hijk

Right Alignment

abcdef
gh

hijk

Centered

abcdef
gh
hijk

Left Alignment

abcdef
gh
hijk
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4.6 Table Editor Character Strings

����� Designating Part Labels

Select [Browse Text Table] in the Part’s [Label] area to change to the table
editor character string entry screen.

Select the desired [Browse Text Table] from those specified in the [Table
Editor]. To add a new [text], click the  button to start the [Table
Editor].

4.6.2 Table Editor Character Strings ����� Table Editor Char-
acter String Registration

The size of any text placed on the drawing area automatically changes ac-
cording to the size specified in the Table Editor ([Characters] x [Lines]).
Switching tables does not change the text size.

Place a check mark here to sort
the table editor character strings
displayed in the pull-down menu
in character code order.
(Discriminates between single-
byte and double-byte charac-
ters.)

����� Designating Message Display Messages

In the Message Display Settings, select the "Browse Text Table" option in
the [Messages] area.

Select the desired table editor character strings (Index No.) from those
specified in the Table Editor. To add new table editor character strings, click
on the  button to activate the Table Editor.

4.6.2 Table Editor Character Strings �Table Editor Character
String Registration

Place a check mark here to sort
the table editor character strings
displayed in the pull-down menu
in character code order.
(Discriminates between single-
byte and double-byte charac-
ters.)

The frame size of the Part will be displayed according to the table editor
character string (Number of characters x Number of lines) of the specified
Index No. The frame size of a Part remains the same even if the Table is
switched.
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4.6 Table Editor Character Strings

• When messages are registered with the Alarm Editor, Direct
Text and Text registered in the Text Table Editor cannot be
mixed.

• Do not set up a Text registered in the Text Table Editor with two
or more lines. Only the first line will be displayed, even if two
or more lines have been set up.

[Character strings] can also be selected by choosing [Add Alarm(s)] in
[Edit].

Then, click  in [Message/Summary Text] to view the list of [Character
strings] specified in the [Table Editor]. Select the desired Text from the
Texts registered on the Text Table Editor.

If you want to add new [text], click the  button to start the [Table
Editor].   4.6.2 Table Editor Character Strings
����� Table Editor Character String Registration

When the character string setting mode is changed, all previ-
ously registered alarm messages are deleted.

����� Selecting Alarm Editor Messages

First, select [Text Method] in [Alarm] in the [Alarm Editor] and change the
character string setting mode to [Browse Text Table].

Place a check mark here
to sort the character
strings in character code
order. (Discriminates
between single-byte and
double-byte characters
are discriminated.)
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4.6 Table Editor Character Strings

4.6.4  Text Table Converter
This feature allows you to easily batch convert, attach Index numbers to and
register Text table text strings used for directly designated Part and Screen
item text labels.

All of a Project's screen and Part labels, as well as Alarm direct text can be
batch converted. Instead of all of a Project's direct text, conversions can be
performed according to a pre-defined range of text.

[Text Table Convertor]

Operation procedures

[Utility] →→→→→ →→→→→

→→→→→Select the Screen range, Converted
Text and Converted Table No.

Click on  to start
or

Click on  to cancel

→→→→→Select Project File to be Converted

→→→→→

The features of the Text Table Converter are as follows:

Select the Converted
Project file.

Select the Table used
to register the text

Select the conversion
range.

�����Converted Project

Select the destination project file used for the text converted from the
current project file.

����� Conversion Range

• All
Converts all of a project's directly designated text to table text, including
Screen, Part and Alarm text.

• Screen Range
Choose from a range of Base (B, Trend Graph (T), Keypad (K), text (T),
Window (W), alarm Message/ Alarm Summary, Bit Log Alarm, and Word
Log Alarms. Only when specifying a range do you need to enter the start
and end screen numbers.
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4.6 Table Editor Character Strings

����� Converted Table Number

Designates the text table number of the text table used to store the converted
text and index numbers.

• In a single table the maximum number of index numbers is 3,000. If the
converted texts exceed 3,000, the following dialog box will appear. To save
only the data within this range, select [Save all currently converted data].
To not save any of the converted data, select [Quit without saving] and click
OK.

• If the converted project file and the original project file contain the same
text data, conversion will not create an index number for that text. The
destination file's index number will simply contain a substitute number and
message.



4-67

Chapter 4 - Screens

GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

4.6 Table Editor Character Strings

PROCEDURE REMARKS

(5) After the conversion is completed, the following dia-
log box will appear. click [OK] to close the window
and return to the Text Table Converter.

(1) Select the Project Manager Utility menu's [Text Table
Converter].

(2) Designate the [Converted Project]'s project file. Use
the [Browse] feature to find the desired file.

(3) After setting the screen range and the Converted
Table No, click on [Conversion]. To cancel the set-
tings, click [Close].

����� Converting Project Files to Text Tables

(4) Conversion is performed. To stop the conversion,
click [Cancel].
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Security levels can now be assigned to individual Base or Window screens,
based on the User-designated settings. The following explanation describes
the settings used for the security and password features.

• The security feature is available only with GP2000 Series units.

When changing screens

*1 When canceling the screen change from a Device/PLC, use the Password Cancel
Alert Bit, and return to the original (above: Menu screen) using the Device/
PLC. For information regarding the Password Cancel Alert Bit,

 4.7.2 Password Settings � Notification Bit of Password
Cancel

Menu 
Screen

Security Level 0

Security Level Status
Level 0

Security Level Status
Level 5

Security Level 5

Connected device
changes screen

Press [ESC] key to cancel*1
(returns to Menu Screen)

Password  entry 
window appears

Password  is 
correct

Protected 
Screen

Password  entry

Screen touch 
changes screen

4.7      Security Feature

4.7.1 Overview

Security levels can now be assigned to individual Base or Window screens.
For example, if the new screen's security level is higher than that of the
current screen, you will need to enter a password in order to change to the
new screen.

In the following diagram, entering the correct password allows access to
screens with a security level of 5 or lower, without having to reenter a
password. (Security Level Status: Level 5)

When changing from the current security level status to a screen that has
either the same or a lower security level, no password entry is required.
This type of easy-to-use password-based screen data control allows you to
guarantee the safety of your important project data.



4.7 Security FeatureChapter 4 - Screens

4-69GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

Even in the cases shown below, if the new screen to be changed to has a
higher level of security, you must enter the correct password in order to view
the new screen.

· Displaying a window registered on a Base (B) screen, Window (U) screen
(when using a U-tag*1,*2*3, a Window Part*3, or a Global Window*3)

· Changing to an Alarm screen's sub-screen (A-tag, Q-tag)

· Device/PLC control request for a screen change.

· Screen change using a Function Switch.

· Forced reset (Using either 3-point touch on the unit's display) /Touch
upper left corner of screen within 10 seconds of power ON or a Function
Switch to change to an OFFLINE screen.

· Initial Base Screen display.*4

*1 Be sure not to use the U-tag's [High Speed] feature in the [Designated Win-
dow] tab, since it may not operate correctly.

*2 The security level for a window that is registered on a Base (B) screen comes
from the base screen where the window is registered.

*3 When you cancel password entry for a Window (U) screen, the control ad-
dress used for the window's U-tag, Window Part, or Global Window display,
is automatically cleared. Also, the indirectly designated window number and
display position are also automatically cleared.

*4 The correct password MUST be entered. This screen cannot be cancelled us-
ing [ESC] key.
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����� Security Levels

• A total of 16 settings are available - 0 to 15. "0" designates that no secu-
rity is set for a given screen. Levels 1 to 15 designate the level of security,
from low to high, with 15 being the highest level. For level setting infor-
mation,  4.7.2 Password Settings

• Security level settings for a Base (B), Window (U) screen can be set
when the screen is saved, or when that screen's name is changed. (See
below)
When changing the security levels of the multiple screens at the same
time, use the [Security Level List] dialog box.
For usage details,  4.7.3 Security Level List

<When saving a screen and assigning a name>

To modify a
password, click
on the "Pass-
word Setup"
button to call up
that dialog box.

Displays the
screen's current
security level
setting.

Enter the
desired
security
level
(0 to 15)

• Be sure to check/select the [Password Settings] screen's [Use Security level]
setting. If this setting is not checked, this screen's security feature is dis-
abled/displayed.

• The initial security level setting for all Base (B) and Window
(U) screens is "0".
The initial security level setting for all Base (B) and Window
(U) screens of projects created using versions of GP-PRO/
PBIII for Windows Ver. 6.2 or earlier is "0"

• If a project created using this Security feature is saved using
Ver. 6.2 or earlier, all security level settings will be reset to
"0".
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4.7.2 Password Settings

This screen allows you to set a screen's security level and password.

Usage  Pattern

→→→→→[Screen/Setup] →→→→→[Security Setting] [Password Settings] →→→→→

 or

 to close.
→→→→→

(Check the "Use Security
level" checkbox to enable
this feature.)

→→→→→
Enter the desired
level's password and
enter any [Extend]
settings.

→→→→→

����� Password Setting

Password must be
1 to 8 single-byte
characters. (If
both upper-case
and lower-case
characters are
used, the pass-
word must be
entered using the
exact same case
characters.)

Enables/Disables
the security
feature.

Selecting this will
require the entry
of the Level 15
password when
switching to
OFFLINE mode.

· Password entry for screen security can only be performed via the [Pass-
word Setting] dialog box.

����� Use Security level

Clicking/selecting this feature enables the security level(s) in the project.

����� Security Level and Password

A total of 16 settings are available - 0 to 15. "0" designates that no security
is set for a given screen. Levels 1 to 15 designate the level of security, from
low to high, with 15 being the highest level. Only the required levels need to
be set passwords. All the levels do not need to be set the passwords.

• The same password cannot be used on more than one level.

• Spaces and symbols cannot be used.

• A password cannot contain all blank spaces.
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����� Specify Password Level 15 when switching to offline

When you change screens in OFFLINE mode, the password entry window
will appear on the GP display and request the security level 15 password.
When you change back to online mode, the security status level will change
back to "0", indicating no password  is required.

If you choose [System Settings] from the [GP Setup] dialog box and enter a
[Common Password] that is used when switching between OFFLINE and
online modes, after entering the Level 15 password, this common
password's entry screen will appear. (See below)

����� Extend Features

When this is clicked/
selected, only if a
request for screen
change is received
from a connected
device and that
request is cancelled,
will the designated bit
turn ON.

Designates the
default type of
keyboard used
to enter the
password.

When this is clicked/
selected, displays the
requested screen's
security level in the
password entry
window.

If the GP is not
operated or a
screen change is
not performed
within the desig-
nated period of
time, the GP
unit's security
level status will
automatically
change to "0".

Menu 
Screen

Press [ESC] key to cancel
(returns to Menu Screen)

Password  entry 
window appears

Press [ENT] keySwitch OFFLINE

Password  entry

Password  entry

OFFLINE Common Password 
Entry Screen appears
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����� Notification Bit for Password Cancel

When the [Use Notification Bit] setting is checked, and the password entry
window called up by the Device/PLC unit's screen change is cancelled via
pressing the [ESC] key, the designated password cancel notification bit turns
ON. (See below)

As shown above, while the password entry window is open the System Data
Area has two values for the control/recognition of screen numbers - the
Display Screen No. and the Change Screen No. When using this feature,
please set up your Device/PLC so that it checks if the [Notification Bit for
Password Cancel] is ON, and if it is, will return from the [Change Screen
No.] to the [Display Screen No.] If the original screen number is returned,
the password entry window will automatically close. For more information
about Direct Access/ Memory Link Access System Data Area,

 Device/PLC Connection Manual

• This feature is designed only for systems where control is performed via the
Device/PLC. Therefore, even if a Function SW/T-tag/D script is used to
directly change an GP unit screen, the [Notification Bit for Password
Cancel] cannot be used.

• If this feature is not used, and the Device/PLC unit requests a screen
change, manually pressing the [ESC] key will not close the screen.

 
1 1

1 1

1 1

1 5

Screen 1

Screen 1

Security Level 0

System Area Value

Display Screen
No.

Change Screen
No.

Device/PLC changes 
Screen 1 (Security Level 0) to 
Screen 5 (Security Level 5)

Device/PLC

Security Level 0

Password  entry 
window appears

Notification Bit for 
Password Cancel 

ON
Device/PLC returns 
to the original screen number

Password entry window closes

Press [ESC] key

Original screen displays
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����� Auto Clear Time

This feature sets the length of time (1-60 min.) required before the security
level status returns to "0", assuming no GP unit operations/ screen changes
are performed.
If "0" is entered for the min. value, the security level status will not be
automatically cleared.

����� Security Control Address

When the Auto Clear Time feature is used, the Security Level Control
Address' Security Level Clear bit turns ON.

LS9300 Security Level Control
LS9301*1 Security Level Status
LS9302*1 Request Security Level Status

<Security Level Control>

When the bit changes from [0] →→→→→ [1], Security Level Clear is performed.

<Security Level Status>
This feature stores the value of the current security level, and indicates
the maximum security level that requires no password to enter.

<Request Security Level Status>
Stores the security level of the screen to be displayed next.

*1  Read only.

����� Password Entry Window

This feature automatically displays the following window when the GP
unit's security level status changes from the current level to a higher level.
You then directly enter the password set in the [Password Setting] tab. Enter
the correct password, and press [ENT] to call up the next screen.

(Numeric keyboard)(Roman character keyboard)

Switches between
upper and lower
case

Shows the secu-
rity level of the
screen/window to
be changed to

Press the
[CHANGE]
key

Password entered is displayed
using "*" characters.

LS9300

Bit 0: Security Level Clear bit

15 01 00    bit
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• If the password entered is incorrect, an error message "Incorrect Pass-
word" will appear in the window. Also, the GP unit's buzzer will sound.
Pressing the [ESC] key will cancel the next screen display, return to the
original screen as well as cancel the buzzer and error message.

• If the password entry window does not appear, but an error and the mes-
sage [Password window cannot be displayed] appears in lower part of the
GP unit's screen, close one of the local windows being called up on the GP
and perform the screen change again. The password entry window will then
appear. Only 2 local windows can be displayed at a time.

• This window cannot be modified.

• Passwords cannot be entered using the Device/PLC unit.

• Passwords cannot be entered using the Bar-Code Reader.

����� Password Enter KeyBoard

• Defaut Settings

You can designate the default password entry keyboard as being either an
alphabet or a numeric character keyboard.

• Request Level Display

When this feature is enabled, the security level of the screen being called
up next is displayed in the Password Entry window.  This feature can only
be set via this checkbox. It cannot be set using the GP unit.
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PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

����� Entering Password Setting and Extend Tab Settings

(1)Select the Project Manager [Screen/Setup] menu
[Security Settings] area [Password Settings].

(2)In the [Password Setting] tab, click on [Use Security
level] to enable this setting.
This will activate the data entry areas.

(3)Enter a password for the desired level(s) (1 to 8
characters).
To set the highest level of security for the GP unit's
OFFLINE screens, click the [Specify Password
Level 15 when switching to offline].

Be sure to click the [Use Security
level] setting for any projects
using the security feature.

Be careful when entering your
password - the program recog-
nizes upper and lower case letters.

If the [Specify Password Level 15
when switching to offline] box is
checked, be sure to check that the
Level 15 password is entered.

(4) If necessary, click on the [Extend] tab and enter the
desired settings there.
When all settings are completed, click  to
enter the settings, or  to delete all the newly
entered settings.

Setting this item to "0" will cancel
the Auto Clear feature.
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4.7.3 Security Level List

GP-PRO/PBIII for Windows Ver. 7.0 allows you to create a convenient list
of all the base screens and windows that are assigned security levels. This is
useful when changing each screen's Security Level or editing the screen's
Password. You can also change the security level of multiple screens at the
same time.

• Before using this feature, be sure to check that the [Security Settings]
feature's [Use Security level] setting is enabled.

Usage  Pattern

→→→→→[Screen/Setup] →→→→→[Security Settings] [Security Level List] →→→→→

 or

 to close.
→→→→→ Check Security Level →→→→→

If necessary, modify
any of the passwords
used

→→→→→

����� Security Level List
Each screen's
security level

Clicking allows you to change
the security level of the se-
lected screen to a new level.

Used to enter a change in the
level of any screen listed.
Level can be from 0 to 15.

Used to modify a
screen's password
settings - jumps to
[Password Set-
tings] dialog box

Changes the list's
display format

Shows Base
(B) and
window
screens only

Screen Title
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PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

����� Editing a Security Level or Password via the Security Level
List

(1)Select the Project Manager's [Screen/Setup] menu's
[Security Settings] area's [Security Level List].

Be sure to click the [Screen/Set-
tings] area's [Password Setting]
window's [Use Security level] set-
ting for any projects using the secu-
rity feature.

The Security Level List can be listed
and edited even when saved as a
given name or changed the screen's
title.

When a screen is opened, its secu-
rity level can be listed, however, it
cannot be edited.

(3)To change the screen's password, click on [Password
Setting] button.
The screen changes to the [Password Setting] dialog
box. For information about Password entry,

 4.7.2 Password Settings

(4)When all settings are completed, click  to
enter the settings, or  to delete all the newly
entered settings.

(2)To edit/change a screen's security level, select the
screen (multiple screens can be selected), enter the
desired level in the [Security Level Change] and
then click on the   button.
The change will be reflected in the List.
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This feature will reset, or set, bits or words according to a pre-set date/time
schedule.

• The Time Schedule feature is available only with GP2000
Series units.

Usage  Pattern

→→→→→[Screen/Setup] →→→→→[Time schedule] Select schedule in [Time
Schedule Function List] →→→→→

 or

 to close.
→→→→→ Edit/Copy/Paste/Clear

the schedule →→→→→

This feature will reset or set bits or words according to a pre-set date/time
schedule. If this feature is set to activate the control addresses used for
Filing Data (Recipes), or D-Script, these features will then operate on the
designated day/date.

[Example]

Allows you to
update/edit the
settings used for
any Time Schedule
entries
Copies the Time
Schedule

Clears the selected
schedule data

Pastes the copied
schedule

• A single project may have up to 32 Time Schedule items.

09:00:00 17:00:00

Start
Screen

Work
Screen

Finish
Screen

Transfer
Recipe data

Log the
work data

• Time Schedule settings cannot be entered via the GP unit's OFFLINE
screens. These settings can only be entered via the editor software's setting
menu.

4.8      Time Schedule

4.8.1 Overview
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4.8.2 Entering Time Schedule Settings

����� Time Schedule Settings
Simply double-click on the Time Schedule Function List's left-side item list
(1, 2, 3, etc.) or click once on the row to select the item and click on

 to call up the Time Schedule Function dialog box.

The following features become available.

Selects the
operation mode.

Depending on
the Operation
Mode selected,
designates the
address to
operate.

If the Operation
Mode has been set
to Word Set16 or
Word Set32, this
area is activated.
This area allows
you to directly enter
data for the start
and finish write
values.

When this feature is
enabled, as soon as the
GP unit's power is
turned ON, the range of
the schedule is recog-
nized. If the GP unit's
power is turned ON
during (inside) the
scheduled range, the
start time/operation will
be performed.
If the GP unit's power is
turned ON outside of the
scheduled range, the end
time/operation will be
performed.
Designates the word write
value's sign and data
format.

If the Prohibit
Operation Bit is ON,
the schedule/
operation is not
performed.

Enter the value written to
the address when the
schedule starts. If the
[Time Settings] tab's End
Operation is not enabled
(checked), you cannot
enter data in this area.

����� Operation Mode

When entering the settings for an item in the Time Schedule Function List,
the operation mode settings must be selected. These settings include, [Bit
Set], [Bit Reset], [Word Set16] (16-bit write), and [Word Set32] (32-bit
write).

Operation example 1:  Bit Set

When [Bit Set] is selected, the following operations are performed:
Operation example 1 : Bit Set
Start Time : 09:00:00
End Time : 17:00:00

Start Time End Time

ON

OFF

09:00:00 12:00:00 17:00:00

Enter the value
written to the
address when
the schedule
finishes.
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Operation example 2:  Bit Reset

When [Bit Reset] is selected, the following operations are performed:

Operation example 2 : Bit Reset
Start Time : 09:00:00
End Time : 17:00:00

Operation example 3:  Word Set

Selecting [Word Set] performs the following operations.
This mode's selections include 16 bit and 32 bit.

Operation Mode : Word Set
Device Address : D0100
Start Write Value : 10
End Write Value : 0
Start Time : 09:00:00
End Time : 17:00:00

����� Operation Address

Designates the address used to control the schedule.

����� Start/End Time Operation when Power is switched on.

When this feature is enabled, as soon as the GP unit's power is turned ON,
the range of the schedule's start and finish times is recognized. If the GP
unit's power is turned ON during (inside) the scheduled range, the start time/
operation will be automatically performed.  If the GP unit's power is turned
ON outside of the scheduled range, the end time/operation will be automati-
cally performed.

• If this feature is disabled, and power is turned ON inside the schedule
range, but the start time has not already been passed, the start time/opera-
tion is not automatically performed. However, the end time/operation will
automatically be performed.

• If the end time/operation is not set in the schedule, this feature will not be
performed.

Start Time End Time

ON

OFF

09:00:00 12:00:00 17:00:00

D100

17:00:0009:00:00

10 D100 0

Start Time End Time
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����� Word Settings

These settings are active only when the Operation Mode is set to [Word
Set16] (16-bit write) or [Word Set32] (32-bit write).

• Direct

Designates the word write value's sign and data format. If [Dec] and
[Code+/-] are selected, negative values can be set.

The [End value] is enabled only when the [Extend] tab's [End Day
Operation Setting] is checked.

• Indirect

Designates the address used to store the Start time and End time values.

����� Prohibit Operation Bit

When this feature is selected, at the beginning of the schedule, the desig-
nated value will be read out from the Prohibit Operation bit's address. If the
Prohibit Operation Bit is ON, the schedule/operation is not performed.

����� Time Settings
The following explanation describes the settings in the Time Schedule
Function's [Time Settings] tab.

����� Direct

Directly designates the start/end time.

Enabled when the Time
Schedule will span 2 or
more days

Directly
designates
the start/end
time

When [End Operation] is
checked, the End time and
the End Day can be
specified.

Sets the Start time and
the Start Day
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����� End Day Operation Setting

<When enabled>

Can be set if the Time Schedule spans 2 or more days.

• Only one day can be set for the start day.

• Only one day needs to be set for the end day. [End Operation] is auto-
matically enabled.

• Enter the Start and End times.

• Start and End times cannot be the same time on the same day.

<When disabled>

A schedule that is 1 day (Start and End times are within 24 hours) can be
entered.

• Multiple Start days can be selected.

• Be sure to click on [End Operation] when setting the End time.

• Be sure to select one or more start days.

• Start and End times cannot be the same time.

• The Time Schedule (mentioned here) is for one day only, so if the End time
is entered as being before the Start time, the End time will be performed on
the next day.

E.g.) Start Day : Monday
Start Time : 22:00:00
End Time : 01:00:00

Mon. Tue.

22:00:00 01:00:00
0
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Address+0 Control
Address+1 Status
Address+2 Operation Mode
Address+3 Start Time (Day)
Address+4 Start Time (Time)
Address+5 Start Time (Part)
Address+6 Start Time (Second)
Address+7 End Time (Day)
Address+8 End Time (Time)
Address+9 End Time (Part)
Address+10 End Time (Second)

<Control: Address + 0> (Device/PLC →→→→→ GP)

When the Time Read Request bit's 0 → 1 change (rise) is detected, the
Operation Mode, Start Time, and End Time are read out.

Bit 00 : Time Read Request Bit (0: No action, 1: Perform Time Read)
Bit 01-15: Reserved (Be sure the set value is fixed to "0".)

• Data is not read out regularly, from the Time Setting Address operation
mode (address +2) to the End Time (sec.)(address +10). When reflecting
Time Setting Data changes in the GP unit, be sure to set the Control bit
(address +0) from "0" to "1".

Designates the
address used to
store time
setting data.

Addresses used
for storing time
setting data.

Indirectly
designates the
address used to
store time
setting data.

����� Indirect

Indirectly designates the Time Setting data in the Time Setting Address.

����� Time Setting Address

Designates the addresses used to store time settings data read out from a
Device/PLC.

Reserved
15 01 00   (bit)

O
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<Status: Address + 1> (GP →→→→→ Device/PLC)

After the Control's time data readout is completed, the GP unit will turn the
Time Read Completion Bit ON (0 →1). If the time data entered is incorrect,
simultaneously the Error Alert Bit will turn ON (0 → 1).

Bit 00 : Time Read Completion Bit (0: Either Time Read is being
performed or had not yet been performed, 1: Time Data
Read Completed)

Bit 01 : Error Alert Bit (0: Time data is being replaced with
correct data. 1: Time data contains an error.)

Bit 02- Bit 15 : Reserved (Be sure the set value is fixed to "0".)

• Once the Time Read Completion bit's rise (trigger) is recognized by the
Device/PLC, be sure to turn the Control Time Read Request bit OFF
(1 →→→→→ 0). Once this bit is turned OFF, the Status's Time Read Completion
bit and the Error Alert bit will automatically and simultaneously be turned
OFF (1 →→→→→ 0). (See below)

Reserved
15 01 00   (bit)02

O O

 

Time Read Request Bit
(Device/PLC -> GP)

Data Read
(Device/PLC -> GP) Time Data Read

Time Read Completion Bit
(GP -> Device/PLC )

Error Alert Bit
(GP -> Device/PLC )
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<Operation Mode: Address + 2>

Set if the End Operation and the End Day Operation Settings are enabled/
disabled. However, regardless of the End Operation status (enabled/dis-
abled), the indirectly designated time data (Time Setting address's total 11
Word) is all read out.

Bit 00 : End Time Action Setting (0: None, 1: Used)
Bit 01 : Day Setting Mode (0:None, 1: Used)
Bit 02 - Bit 15 : Reserved (Be sure the set value is fixed to "0".)

<Start/End Time (Day): (Start) Address + 3, (End) Address + 7>
(Device/PLC →→→→→ GP)

Designates the day used as a trigger for the Start/End action.

Bit 00 : Sunday (0: None, 1: Designate)
Bit 01 : Monday (0: None, 1: Designate)
Bit 02 : Tuesday (0: None, 1: Designate)
Bit 03 : Wednesday(0: None, 1: Designate)
Bit 04 : Thursday (0: None, 1: Designate)
Bit 05 : Friday (0: None, 1: Designate)
Bit 06 : Saturday (0: None, 1: Designate)
Bit 07 - Bit 15 : Reserved (Be sure the set value is fixed to "0".)

<Start/End Time: (Start) Address + 4 to +6, (End) Address + 8 to +10>

Here, you enter the time values used for the Start and End operations.
The following time setting example is used.

• The setting/not setting of the End Time will depend on the Operation Mode
(address +2) setting. Also, the End Time Action Setting (bit 00) available
will depend on the Day Setting Mode (bit 01) used. The following chart
shows what combinations/selections are available.

Day Setting Mode Used

End Time Action Setting Used Used Not Used
Not Used

Reserved
15 01 00   (bit)02

Mon. Sun.

03

Tues.

04

Wed.

05

Thu.

06

Fri.

07

Sat.

Reserved
15 01 00   (bit)02

O O
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[Setting Example 1]

Operation Date : Tuesday, Thursday (within 24 hours)

Start Time : 9:30:00

End Time : None

• If a "0" (Not Used) is entered in the Day Setting Mode, the End Time (Day/
Hour/Minute/Second ) data will be read but it will be ignored.

*1 BCD input cannot be used.  If the value is entered is outside of the allowed
range, the unit may not operate correctly.

Address+2
(Operation Mode)

15 02 01 00    bit

Address+3
(Start Time - Day)

15 02 01 00    bit

Address+4
(Start Time - Hour)

15 00    bit

Address+5
(Start Time - Minute)

15 00    bit

Address+6
(Start Time - Second)

15 00    bit

Enter any
value from
0 to 23 in
Binary*1

Enter any
value from
0 to 59 in
Binary*1

00

00

03

1

04

0

05

1

06

0

07

0

9

30

0
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[Setting Example 2]

Operation Date : Monday to Friday

Start Time : 9:30:00

End Time : 18:00:00

• If a "1" (Used) is entered in the Day Setting Mode, be sure to enter all Start
and End time (Day, Hour, Minute, Second) information. However, if 2 or
more of the Start/End time (Day) bits turns ON simultaneously, an error
will occur.

*1 BCD input cannot be used.  If the value is entered is outside of the allowed
range, the unit may not operate correctly.

Address+2
(Operation Mode)

15 02 01 00    bit

Address+3
(Start Time - Day)

15 02 01 00    bit

Address+4
(Start Time - Hour)

15 00    bit

Address+5
(Start Time - Minute)

15 00    bit

Address+6
(Start Time - Second)

15 00    bit

Enter any
value from
0 to 23 in
Binary*1

Enter any
value from
0 to 59 in
Binary*1

11

00

03

1

04

0

05

0

06

0

07

0

9

30

0

Address+7
(End Time - Day)

Address+8
(End Time - Hour)

15 00    bit

Address+9
(End Time - Minute)

15 00    bit

Address+10
(End Time - Second)

15 00    bit

Enter any
value from
0 to 23 in
Binary*1

Enter any
value from
0 to 59 in
Binary*1

0000010

18

0

0

02 01 00    bit030405060715
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����� Usage Restrictions
• The Time Schedule features are "one-shot" operations.  In other words,

when the Start time is reached, the designated device address is written
to just once. The write operation is not repeated.

Operation : Bit Set
Start Time : 08:00:00
End Time : 08:20:00

• When changing GP Time Settings, the range of the schedule's start and
finish times is recognized. If the edited item is inside the scheduled
range, the start time/operation will be automatically performed.  If the
edited item is outside of the scheduled range, the end time/operation will
be automatically performed.

• If the end time/operation is not set, the schedule's range cannot be con-
firmed and this feature will not be performed.

• If the Start Time Operation is completed and then becomes a "Power
Out" condition, the schedule's range will be recognized and the End
operation will be performed at the End Time.

Operation : Bit Set
Start Time : 12:00:00
End Time : 12:20:00

Start Time End Time

ON

OFF

08:00:00 08:10:00 08:20:00

Operator turns OFF

07:50:00

Start Time End Time

ON

OFF

12:00:00 12:10:00 12:20:00

Power Out

11:50:00

Operate
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• If the Time Setting is designated as indirect, only the Time Setting Ad-
dress Control's (Address +0) will be read out with High Speed. Up to 32
Time Schedule settings can be entered, however, if all Time Settings are
all designated as indirect, 32 Control addresses (address +0) will need to
be continuously read out and the GP unit's overall performance may be
effected.

• When "Indirect" is used, the Time Setting address control's (address +0)
normal readout speed is once every 500ms.
When the Control Address bit 00 (Time Read Request Bit) changes from
0 to 1, a delay of up to 500ms may occur before the Time Status (address
+1) and onwards data is read out.
Also, when multiple Control (address +0) bit 00 (Time Read Request Bit)
simultaneously change from 0 to 1, in order that operations can be started
in the order set, a delay may occur before an operation is performed.

• The Word Write Value setting's Start/Stop Write Value's indirect setting,
and the Prohibit Operation bit monitoring are read only once, at the
beginning of the Time Schedule. Since regular readout is not possible,
there may be a slight data communication delay that causes the desig-
nated operation's Start Time to not be performed at exactly the Second
setting entered.
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4.9 Symbol Editor

Usage Pattern
Save the
symbol
data.

Enter a
symbol
name.

Select “Word
symbol” or “Bit
symbol”.

[Symbol
Editor]

[Screen/
Setup]

→→→→→→→→→→→→→→→→→→→→

Select a desired
symbol or com-
ment.

Enter the
address(es) corre-
sponding to the
symbol’s or
description’s name

Pop-up Keypad

Enter a symbol
name of up to
twenty characters

The Symbol Editor enables you to assign an address to a symbol and then
register that symbol and to assign a device comment to an address and then
register it.
The “Symbol” is the registered name used to indicate the address of any Tag
or Part. Thus, when you change the address corresponding to a symbol, you
will automatically change a Part or Tag's address(es) without having to re-
setting the Tag or Part. The “device comment” indicates a comment assigned
(attached) to each address. When setting a Tag or Part's address(es), simply
clicking on  ([Apply Device Comment]) reflects the registered device
comment to the Tag or Part's comment field.

2.1 Parts � Entering a Comment
In all the address entry fields, such as of Tags and Parts, addresses registered
via the Symbol Editor will be displayed in a pull-down list together with the
symbols or device comments. Addresses can also be specified here by
selecting them from this list.

2.1 Parts � Entering Addresses
The symbol and device comment data can be shared between multiple
Projects by import and export.
The registered symbol and device comment information can be printed as a
symbol list.

  9.1.1 Printing

Note:

4.9      Symbol Editor



4-92

Chapter 4 - Screens

GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

4.9 Symbol Editor

 For detailed GLC
symbol information, refer to Pro-
Control Editor Operation Manual
(packaged with the Pro-Control
Editor)

����� Symbol Editor Types
There are five types of symbols: “Word” symbol, which corresponds to a word
address, “Bit” symbol, which corresponds to a bit address, “GLC Integer”
symbol, “GLC Discrete” symbol, and “GLC Real Number” symbol that all
correspond to GLC symbols.

Word Symbol

Bit Symbol

GLC Integer
Symbol

GLC Real
Symbol

GLC Discrete Symbol

• GLC symbols can be used only on GLC Series and LT Series units.Note:

����� GLC Symbols

A “GLC symbol” means variables used in a logic program. A new GLC
symbol cannot be registered with the Symbol Editor. When a logic program
is saved, global variables registered on the variable list will automatically
be registered in the Symbol Editor.

Only global variables are registered as GLC symbols.

Depending on their type, variables are registered as one of the following
three GLC symbols: GLC Integer symbol, GLC Discrete symbol, GLC
Real symbol.

For array variables, each element is registered as a symbol. An array of size
5 is registered as five GLC symbols. [Element Number] representing
elements in an array will be <Element Number> as a GLC symbol, and an
array of size 5, ALLM, will be represented as shown below.

For detailed variable information, please refer to the "Logic Programming
Operation Manual" or "online help".

Array variable GLC symbol
ALLM[0] ALLM<0>
ALLM[1] ALLM<1>
ALLM[2] ALLM<2>
ALLM[3] ALLM<3>
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4.9 Symbol Editor

����� Device Comment Types
There are two types of device comments: the word device comment corre-
sponding to a word address and the bit device comment corresponding to a
bit address.

Word Device Comment

Bit Device Comment

����� Edit Commands
To edit symbols, you can use the following commands:

· ..... Used to delete a symbol’s line of data and store it on the clip-
board. The Paste command allows you to then move that symbol
data to another line.

· ..... Used to copy a selected line of data to the clipboard.

· ..... Used to insert the line of data temporarily stored on the clip-
board into the desired row, after the Cut/Copy command has
been performed.

· ..... Used to cancel the command previously performed and return to
the previous condition. However, a changed symbol character
cannot be restored.

����� Using the Cut/Copy/Paste Commands
Cut/Copy/Paste commands can be used to move data between different
Symbol Editor files. To do this, simply open another LBE file and select a
desired line. Then, use the [Cut] or [Copy] command, and then the Symbol
Editor’s [Paste] command.

Do not register the same symbol name for both a word symbol
and a bit symbol.
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4.9 Symbol Editor

· If alphanumeric numerals are used at the end of a symbol
name, executing the [Copy] and [Paste] command will automati-
cally change the symbol’s name.
· When Chinese characters and numbers are used in a symbol name:

All the Arabic numbers to the right of the Chinese character(s)
will be deleted. Sequence numbers starting from “2” will be
assigned after the Chinese characters.

· When Roman characters and Arabic numbers are used in a
symbol name:
Example) ABC123
All the Arabic numerals to the right of Roman character(s) will
be deleted and replaced by a sequence number.

· When only Arabic numbers are used in a symbol name:
Only the first number is retained, and all other digits are trun-
cated and replaced with a sequence number.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Via the Project Manager, select the [Screen/Setup]
menu - [Symbol Editor] command.

(2)Select symbol or device comment type.
In this example, please select “Word Symbols”.

����� Registering Symbols and Device Comments

If the Project’s [GP Type] is an
GLC/LT Series unit, the GLC sym-
bol can be specified.

 Pro-Control Edi-
tor Operation Manual (packaged
with the Pro-Control Editor)
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4.9 Symbol Editor

����� Importing Symbols and Device Comments
The previously saved Symbol Editor data can be imported to and shared with the
currently open Symbol Editor. Files with the extension of "*.LBE" or "*.CSV" can
be imported.
CSV files that have been created via a text editor, Microsoft Excel, or other applica-
tions can be used as symbol or device comment data after they have been imported
via the Symbol Editor.
Symbol data and device comment CSV file formats are as follows:

<Symbol Data CSV Format>

"GP_SYMBOL"
"Symbol Name", "Word Address"
  <Insert one return between a word address and a bit address>
"Symbol Name", "Bit Address"

Example
"Line A (1 to 5): Word","D00100"
"Line A (6 to 10): Word","D00101"

         One return
"Line A (1 to 5): Bit","X00100"
"Line A (6 to 10): Bit","X00101"

To enter a symbol name, you can
use up to twenty alphanumeric
characters, or up to ten Chinese
characters.

The entered characters are not case-
sensitive.

You can perform the [Delete] or
[Copy] and [Paste] commands af-
ter selecting multiple messages.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(4) After all the necessary items are registered, select
the [File] menu - [Save] command, or click on the

 icon.

(3) Enter symbol names and addresses.

The symbols [],\, ?, and the
           key cannot be used in
the Symbol Editor.

Tab
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4.9 Symbol Editor

<Device Comment Data CSV Format>

"GP_COMMENT"
"Word Address", "Device Comment Name"
  <Insert one return between a word address and a bit address>
"Bit Address", "Device Comment Name"

Example
"GP_COMMENT"
"D00100","Machine A stops"
"D00101","Machine A is now operating"

              One return
"X00100"," Pump B"
"X00101"," Pump B"

·  "GP_SYMBOL" and "GP_COMMENT" are identifiers indicating they
are Symbol and Device Comment Data, respectively.

·  Insert only one return between a word symbol and a bit symbol.  If addi-
tional returns are entered in other lines, data cannot be imported.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

Import symbol data.

(1) Select the [File] menu - [Import Symbol] command,
or click on the  icon.

(2) Select a file (*.LBE or *.CSV) to be imported or en-
ter the file name, and click on the  button. To import a device comment,

select the [Import Device
Comment] command.

If the same symbol name already exists, the system asks
if you wish to replace the symbol name.

To import a device comment, se-
lect the [Import Device Comment]
command.
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4.9 Symbol Editor

(3)Select an import method and execute it.
To import the specified symbol according to the current
settings, click on the  button. To import the cur-
rent Project file's all the symbols according to the current
settings, click on the  button. To cancel the im-
port, click on the  button.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

[Import as]
Enter the symbol name to be re-
placed.
If no symbol name is entered, the
original symbol name plus se-
quence numbers will be imported.
[Replace]
The same symbol name will be
overwritten.
[Do not import]
The same symbol name will not be
imported.

• GP-PRO/PB III for Windows includes the utility "CMTCNV.EXE", a tool
to convert Mitsubishi Electric's Windows GPP function software SWOD-
GPPW comment data to CSV files. For more detailed information about
this tool, refer to "Readme.txt" in the folder "\ProPBWin\CMTCNV"
created at GP-PRO/PB III  for Windows installation.

• The amount of Symbol data created or imported via the Symbol Editor has
no limit. However, the maximum number of device comment characters is
20.

• Items with unrecognizable device names are not imported.

Note:
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4.9 Symbol Editor

����� Exporting Symbols and Device Comments
Data registered via the Symbol Editor is exported and saved as an LBE or CSV file.
By importing this data, the Symbol Editor data can be shared among Projects.

Export symbol data.

(1)Via the Symbol Editor, select the [File] menu - [Ex-
port Symbol] command, or click on the  icon.

(2)Specify the name and type (*.LBE or *.CSV) of the
file to save the exported data with, and click on the

  button.
If the same file name already exists, the system asks if
the existing file must be overwritten. If it must be over-
written, select  . If you do not wish to over-
write it, select  .

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

To export a device comment, select
the [Export Device Comment]
command.
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4.9 Symbol Editor

����� Calling up Device Comments
Comments previously registered with Tags and Parts can be called up on the Symbol
Editor as device comments. For addresses corresponding to each Tag and Part's com-
ment, refer to the Input Description Address Table.

2.4.7 Duplicate

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

To call up an alarm message from
the Alarm Editor, mark the [Include
Alarm Files] check box.

(1)Select the [File] menu - [Get Device Comment From
Project].

(2) Select a device comment calling up method and click
on the   button.
[Overwrite] ... The device comment is called up after
the already assigned address is deleted.
[Merge] ... The device comment is called up in addition
to the already assigned address.

Multiple addresses may be
given to a tag or part depend-
ing on its type.  In this case,
device comments will be
called up for all the assigned
addresses.
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4.10 Device Monitor

4.10     Device Monitor

If you change the Device/PLC type
after the device monitor command
is registered, the device monitor
command will not operate correctly
on the GP unit. To change the De-
vice/PLC type, first, delete the de-
vice monitor registration before
saving the current file.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(3) Click on the  button.
This completes registration of the device monitor fea-
ture. After the registration is completed, the following
message appears.

(1) Select the [Screen/Settings] menu - [Device Moni-
tor] command.
Register the Device Monitor.

(2) Specify which version of device monitor is to be used,
the Japanese version or the English version.

You can monitor and change a desired area of device memory via the GP
unit’s Global Window screen. In this section, you must specify whether or
not to register the “device monitor” command for the current GP unit.
This registration is effective only when GP and PLC types which support the
device monitor command are selected.

 Device/PLC Connection Manual, Appendix 3: Device
Monitor

To cancel the device monitor registration data, the fol-
lowing message will appear in step (2). Then, click on
the   button to cancel it.

To use the device monitor com-
mand, be sure to select the “Indi-
rect (Binary)” operation mode in
the [GP Setup] - [Extended Set-
tings] - [Global Window Settings].



his feature allows you to register text data to be displayed as alarm
mesages. This chapter describes how to create and edit these alarm

messages.
T

  5 CREATING AND EDITING ALARMS

5.1 .........................................Alarm Creation and Editing
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5.1 Alarm Creation and Editing

5.1      Alarm Creation and Editing
With this feature you can register the messages to be displayed in the “Alarm
Summary” (specified by an “a-Tag”, a “Q-Tag” or an “Alarm Part”) and “Alarm
Message” (right to left scrolling display). You can also set up a monitor bit for
each message. According to the monitor bit’s ON/OFF status, the specified
messages are then displayed in the “Alarm Summary” or “Alarm Message”
mode.

    Tag Reference manual, 2.2 a-tag (Alarm Summary Display),
2.20 Q-tag (Alarm Summary bit log/word log Display)
The “Alarm Summary” mode lists messages. The “Alarm Message” mode
displays a flowing message at the bottom of the screen.
With “Alarm Message” text, the horizontal and vertical size of the text is speci-
fied in the [Setup Area’s (Initial Setup screen)] menu or in the GP unit’s [Setup]
mode. Character sizes can be set to either “x 1”, “x 2”, or “x 4”.
When the horizontal and vertical sizes are set to “1 x 1”, an alphanumeric
character occupies 16 x 8 dots, and a Chinese character occupies 16 x 16 dots.
The “Alarm Summary” and “Alarm Message” will display on the GP unit’s
panel screen as shown below:

Usage  Pattern

Save the Alarm
Editor.

Set up [Alarm
Message/Summary].

Enter a
message, address

Select the alarm type:
[Alarm Message/Sum-
mary], [Bit Alarm Log],
[Word Alarm Log]

[Alarm Editor][Project]

→→→→→→→→→→

→→→→→→→→→→

Right to left scroll-
ing display

Alarm Message DisplayAlarm Summary Display

or

Click on 

→→→→→
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5.1 Alarm Creation and Editing

Via the Alarm Editor, messages and monitor bits are registered for each
alarm type. An example of an Alarm Message screen used for entering a
message is as follows. The Alarm Editor provides three types of alarms:
[Alarm Message/Summary], [Bit Alarm Log] and [Word Alarm Log].

Alarm Message/
Summary

Word Alarm Log

Bit Alarm Log

The tab width for each item in the Alarm Editor (message/bit log/word log)
can be adjusted by positioning the mouse pointer on the border between
items and then dragging it.  The changed size will be saved, and used on the
subsequently  opened screens.

Note:

����� Alarm Message/Summary Screen
Here, you can register the messages to be displayed as either “Alarm Summary”
(specified by an “a-Tag”or an “Alarm Part”) or as “Alarm Message” (right to left
scrolling display). The message can be registered up to 8999 lines.

Address Keypad

Message ColorAlarmPrint

Message

Alarm TypeBit Address

����� Direct

The text entered in the Selected Message field is placed directly as a fixed
character string.

The message is displayed in a single line. Up to 16 types of messages can be
displayed in each Message Display.

����� Browse Text Table

Select or add the Text registered in the Text Table Editor. Two or more lines
of messages can be displayed.

 4.6.3 �Selecting Table Editor Text �����Entering Table
Editor Text

5.1.1 Alarm Editor

Jump to the
specified line

Automatic
Address
Increment



5-4

Chapter 5 - Alarms

GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

5.1 Alarm Creation and Editing

����� Address Keypad
An address keypad is displayed, allowing you to enter the bit address using
the mouse.

�����Bit Address
Specifies the monitor bit. To specify the bit address for the “Alarm Sum-
mary” mode, select a device that can be specified by word.

Device/PLC Connection Manual

����� Alarm Type
The Alarm Editor provides two types of alarms: [Alarm Summary] and
[Alarm Message].
The [Alarm Summary] mode lists messages specified by an “a-Tag” or an
“Alarm Part”.
The [Alarm Message] mode displays a scrolling message at the bottom of
the GP’s screen. Up to 512 messages can be entered into the Alarm Editor
(up to 128 messages for GP70 series units). However, the monitor bit does
not exceed 128 words. Any message beyond this setting range will not
operate on the GP unit’s panel screen.

����� Message
Enter your message here. Although up to 160 alphanumeric characters can
be entered for one message, the maximum number of characters that can be
displayed depends on the GP unit. With the GP-377, GP77R and GP2000
series, selecting the [Browse Text Table] feature allows you to use the text
registered in the Text Table Editor to change message text.

4.6.3  Entering Settings via the Screen Editor �����Selecting
Alarm Editor Messages

����� Message Color
Designates message’s color. Select the display color (Fg) and background
color (Bg), and specify whether to blinking (Blk) is used or not.

����� Automatic Address Increment
After entering and registering a message in a line and moving to the next
line, an address that is one bit larger will be automatically entered for the
new line.

When a variable (GLC symbol) is used as an address, the auto-
matic address increment function must be turned off. Otherwise,
the correct address number addition will not be performed.

•  Multi-language Display Feature is supported by GP-377/GP77R/ GP2000
Series units.

•  When designating “Browse Text Table”, Alarm Import/Export feature
cannot be used.
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Trigger Time: Prints out the time when the Alarm Message started.
Recovery Time: Prints out the time when the Alarm Message is finished.

Printing Example

Trigger 10/15 16:07 No.1 error
Recovery 10/15 16:30 No.1 error
Trigger 10/21 11:25 No.1 error
Trigger 10/21 11:28 No.3 error
Recovery 10/21 15:45 No.1 error

• The GP can store up to 1000 pieces of print information from
Alarm Message (like a bulletin board) triggering and recovery
events. When the GP is not connected to a printer, up to 1000
events will be stored in the GP, which enters a printing stand-
by mode. When the number of events exceeds 1000, new
events will not be stored.

• When a printer changes to offline mode due to a lack of pa-
per, DO NOT turn the GP's power OFF. Refill the paper and
return the printer to online mode. Event information stored in
the GP in the printer offline mode will be output to the printer
when the printer mode returns to online.

• If the printer's power is turned OFF during printing, event
information transferred from the GP to the printer while the
printer's power is OFF will not be printed.

����� Jump to the designated line.
Specify a line and click  to jump to the line.

����� Print (at alarm trigger/recovery)
An Alarm Message (like a bulletin board) can be printed out when the alarm
is triggered and when recovered. Specify if the Alarm Message is printed out
at the triggering of the alarm and at the recovery from the alarm, respec-
tively. When [Summary] is selected, this setting becomes ineffective.

This function is supported only by GPs with a printer interface.
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����� Bit Log Alarm
This screen is used to register messages to be displayed in an “Alarm Sum-
mary” (specified by a “Q-Tag”).  The maximum number of messages for
both the Bit Log Alarm and Word Log Alarm which can be registered in the
Alarm Editor varies depending on the GP type.

Sub Display

Address Keypad

State

Group NumberBit Address

Block tabs

Specify whether or not the automatic
address increment function is used.

Jumps to
the speci-
fied line.

GP type Maximum Number of Messages
GP-270, GP-H70, GP-370 512
Other GP70 series and GP77R series 768
GP2000 series 2048*1

*1 The 769th message and thereafter cannot be registered with Word
 Log Alarm.

Note that the total number of alarms that can be stored in the GP (both Bit
Log Alarms and Word Log Alarms) is 768.
 Tag Reference Manual, 2.20.9 �����Q-tag Setting

When selected/enabled, Block
tabs will appear for Blocks 1 to 8.
Select each block's Alarm Display
type from the pull down menu
and register the Bit Alarm.

When selected/enabled, extended Q-tag
features such as Alarm Count, Accumulated
Time, Alarm Message Level and other
settings will appear in each of the Block
Tabs, up to Block 8. This option is available
only on GP2000 Series units.

Select the
Alarm
Message's
text.

Pull down menu
(Active/ History/
Log)

Level data is displayed
when [Use Extended
Features] is checked.
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����� Use Blocks

When selected/enabled, the attributes [Active], [History] and [Log] are
created.
Use the block tab's pull down menu to select either of these items. Up to 3
blocks can be set.

• Block settings are available only on GP-377, GP77R, and GP2000 Series
units.

Selecting/enabling [Use Extended Features] allows you to set up to 8 blocks.

•  Only GP2000 units can use the [Use Extended Features] setting.

����� Use Extended Features

Bit/Word Log Alarms use the Q-tag.
When selected, Q-tag extended features can be selected. To use these ex-

tended features, click the Tool bar's  (System Setting) icon and use the Q-
tag dialog box to enter the settings.

•  Q-tag extended features are available only on GP2000 Series units.

• When [Use Extended Features] is checked and the Alarm
Editor setting is saved, the extended function cannot be
canceled (disabled/unchecked). In order to simultaneously
extend data features, currently selected project files cannot
be opened when using GP-PRO/PBIII for Windows Ver. 6.3 or
earlier.
The alarm dialog below appears before the Alarm Editor
setting is saved or closed. If you want to use the extended
function, click . If you want to disable the function,
click  and remove the checkmark.

Clicking on  will create a .$AL file in the currently
selected project file's folder. To restore the file to its original
version, simply change the suffix of the file from .$AL to .prw.
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The Q-tag alarm feature has been expanded to include the following:
(1) Up to 8 blocks can be used for alarms.
(2) Can display accumulated count data for Q-tag alarm occurrences, as

well as occurrence times.
(3) Colors and levels (0 to 7 - total of 8) can now be set for alarm messages.
(4) Alarm contents can now be sorted.

Ex.) Order can be set for Occurrence Time, Occurrence Frequency,
Levels or Dates.

Tag Reference Manual 2.23.3 Setting Items ����� Opera-
tion Mode/Special

(5) When a Q-tag Alarm's cursor position (address) is designated, pushing
the [Alarm Acknowledge Key (use T-tag)] will write to the designated
address, using the alarm's registration code. (Set via the Alarm Editor)
Also, if the [Notify ID at each cursor movement.] is enabled, the cur-
rently selected Alarm's registration number will be written to the desig-
nated address, without pressing the Alarm Acknowledge key. For Alarm
Acknowledge Key details,  Tag Reference Manual
2.23.3 Setting Items ����� Operation Mode/Special

(6) The Q-tag Alarm Occurrence Frequency and Accumulated Time data is
cleared from via either the Device PLC's control command or a D-Script
command.

 Tag Reference Manual 2.20 Q-tag (Alarm Summary
bit log/word log Display) Extended Feature

����� Direct Text

Allows you to directly enter message text. Up to 100 characters can be
entered, however the actual number of displayable characters will depend
on the GP model used.

����� Browse Text Table

Text registered in the Text Table Editor can be called up and replace other
message text.
For setup details,  4.6.3 Screen Editor Settings � Alarm
Editor Message Settings

•  Multi-language Display Feature is supported by GP-377/GP77R/ GP2000
Series units.

•  When designating “Browse Text Table”, Alarm Import/Export feature
cannot be used.

����� Automatic Address Increment

After entering and registering a message in a line and moving to the next
line, an address that is one bit larger will be automatically entered for the
new line.

•  When a variable (GLC symbol) is used as an address, the
automatic address increment function must be turned off.
Otherwise, correct address number addition will not be per-
formed.
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����� Address Keypad
An address keypad is displayed, that allows you to enter the bit address using a
mouse.

����� Bit Address
Enter the bit address used for monitoring. Specify the bit address so that the
monitor bit (Bit Log Alarm combined with the Word Log Alarm) does not
exceed 256 words.

����� Group No.
Enter a group number for counting alarms.
The counting of alarms with the same group number will be stored in the same
LS area. LS areas are automatically reserved, for as many group numbers as
have been specified. Bit log alarms and word log alarms with the same group
number are counted as the same group.
In order to set up the area in which the number of alarm occurrences is written,
select [GP Setup] from the Project Manager. Select [Triggered Alarm Count
Address] from the [Q-Tag Settings] menu on the [Extended Features] tab.

• Select [System Settings] from the [Alarm] menu on the Alarm Editor screen,
or click    to enter the "Q-Tag Settings" dialog box.

����� Sub Display
To perform sub-display with a Q-tag, specify here a desired sub-display screen
number corresponding to each message and the same number as a window
registration number.  These numbers may be from 0 to 8999.
Example 1: To sub-display the screen “B2”, enter 2.
Example 2: If no sub-display is required, enter 0 (default value is 0).

����� State
Specify the monitor bit status (ON/OFF) that activates the alarm output.

����� Message
Enter your Message text here. When using Direct Text, a single message can be
up to 100 characters, however the actual number of characters that can be
displayed will depend on your GP model.
With the GP-377, GP77R and GP2000 series, selecting the [Browse Text Table]
feature allows you to use the text registered in the Text Table Editor to change
message text. 4.6.3 ����� Selecting Alarm Editor Messages

����� Level
This feature sets the Alarm Message's Level. Levels 0 to 7 can be used for a total
of 8 levels. Use this feature to assign lower levels to less important messages
and higher levels to more important messages. Initial level setting is "0".
Colors can also be assigned to each level and displayed on the GP. For setting
information,  Tag Reference Manual 2.20.4 Setting Items
� Size/Color

• The level can be set when the [Use Extended Features] check box is checked
(enabled). This option is available only on the GP2000 Series units.
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Address Keypad

Message

Alarm Value Data Format

Monitor Bit
Group NumberWord Address

Sub Display
Alarm Value

Block setting

Specify whether
or not the auto-
matic address
increment func-
tion is used.

����� Word Alarm Log
This screen is used to register messages displayed in an “Alarm Summary”
(specified by a “Q-Tag”).  The maximum number of messages for both the
Bit Log Alarm and Word Log Alarm which can be registered in the Alarm
Editor varies depending on the GP type.

GP type Maximum Number of Messages
GP-270, GP-H70, GP-370 512
Other GP70 series and GP77R series 768
GP2000 series 2048*1

*1 The 769th message and thereafter cannot be registered with Word
 Log Alarm.

Note that the total number of alarms that can be stored in the GP (both Bit
Log Alarms and Word Log Alarms) is 768.
 Tag Reference Manual, 2.20.9 �����Q-tag Setting

Go to the specified line.

When selected/enabled, Block
tabs will appear for Blocks 1
to 8. Select each block's
Alarm Display type from the
pull down menu and register
the Word Alarm.

When selected/enabled, extended Q-
tag features such as Alarm Count,
Accumulated Time, Alarm Message
Level and other settings will appear in
each of the Block Tabs, up to Block 8.

Select the Alarm
Message's text.

Pull down menu
(Active/ History/
Log)

Level information is
displayed only when
[Use Extended Fea-
tures] is checked.

����� Use Blocks

When selected/enabled, the attributes [Active], [Log] and [History] are created.
Use the block tab's pull down menu to select either of these items. Up to 3
blocks can be set.

• Block settings are available only on GP-377, GP77R, and GP2000 Series units.

Selecting/enabling [Use Extended Features] allows you to set up to 8 blocks.

• Only GP2000 units can use the [Use Extended Features] setting.
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����� Use Extended Features

Bit/Word Log Alarms use the Q-tag.
When selected, Q-tag extended features can be set. To use these extended
features, click the Tool bar's  (System Setting) icon and use the Q-tag
dialog box to enter the settings.

• Q-tag extended features are available only on GP2000 Series units.

• When [Use Extended Features] is checked and the Alarm
Editor setting is saved, the extended function cannot be
canceled (disabled/unchecked). In order to simultaneously
extend data features, currently selected project files cannot
be opened when using GP-PRO/PBIII for Windows Ver. 6.3 or
earlier.
The alarm dialog below appears before the Alarm Editor
setting is saved or closed. If you want to use the extended
function, click . If you want to disable the function,
click  and remove the checkmark.

Clicking on  will create a .$AL file in the currently
selected project file's folder. To restore the file to its original
version, simply change the suffix of the file from .$AL to .prw
and move it to a different folder.

The Q-tag alarm feature has been expanded to include the following:
(1) Up to 8 blocks can be used for alarms.
(2) Can display accumulated count data for Q-tag alarm occurrences, as

well as occurrence times.
(3) Colors and levels (0 to 7 - total of 8) can now be set for alarm messages.
(4) Alarm contents can now be sorted.

Ex. Order can be set for Occurrence Time, Occurrence Frequency,
Levels or Dates.
 Tag Reference Manual 2.23.3 Setting Items � Opera-
tion Mode/Special

(5) When a Q-tag Alarm's cursor position (address) is designated, pushing
the [Alarm Acknowledge Key (use T-tag)] will write to the designated
address, using the alarm's registration code. (Set via the Alarm Editor)
Also, if the [Notify ID at each cursor movement.] is enabled, the cur-
rently selected Alarm's registration number will be written to the desig-
nated address, without pressing the Alarm Acknowledge key. For Alarm
Acknowledge Key details,  Tag Reference Manual
2.23.3 Setting Items ����� Operation Mode/Special
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(6)The Q-tag Alarm Occurrence Frequency and Accumulated Time data is
cleared via either the Device PLC's control command or a D-Script
command.

 Tag Reference Manual 2.20 Q-tag (Alarm Summary
bit log/word log Display) Extended Feature

����� Direct Text

Allows you to directly enter message text. Up to 100 characters can be
entered, however the actual number of displayable characters will depend on
the GP model used.

����� Browse Text Table

Text registered in the Text Table Editor can be called up and used to replace
other message text.
For setup details,  4.6.3 Screen Editor Settings ����� Alarm
Editor Message Settings

• The text registered in the Text Table Editor can be used only on the GP377,
GP77R and GP2000 Series units.

•  When designating “Browse Text Table”, Alarm Import/Export feature
cannot be used.

����� Automatic address increment

After entering and registering a message in a line and moving to the next
line, an address that is one bit larger is automatically entered for the new
line.

•  When a variable (GLC symbol) is used as an address, the auto-
matic address increment function must be turned off. Otherwise,
the correct address number addition will not be performed.

����� Address Keypad

Clicking here displays a address keypad, allowing you to enter bit address
data using your mouse.

����� Alarm Value Data Format

Selects the alarm value’s data format.

����� Word Address

Set up a word address. Specify the bit address so that the monitor bit (Bit
Log Alarm combined with the Word Log Alarm) does not exceed 256
words.
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����� Group No.

Enter a group number for counting alarms.
The counting of alarms with the same group number will be stored in the
same LS area. LS areas are automatically reserved, for as many group
numbers as have been specified. Bit log alarms and word log alarms with
the same group number are counted as the same group.
In order to set up the area in which the number of alarm occurrences is
written, select [GP System Setup] of the Project Manager. Select [Triggered
Alarm Count Address] from the [Q-Tag Settings] menu on the [Extended
Feature Settings] tab.

• Select [System Settings] from the [Alarm] menu on the Alarm Editor screen,
or click   to enter the "Q-Tag Settings" dialog box.

����� Sub Display
To perform sub-display with a Q-tag, specify here a desired sub-display
screen number corresponding to each message and the same number as a
window registration number.  These number may be entered in a range
between 0 and 8999.
Example 1: To sub-display a screen of B2, enter 2.
Example 2: If no sub-display is required, enter 0 (default value is 0).

����� Alarm Value
Specify the limit value of the monitor word used to activate the alarm’s output.

����� Monitor Bit
Select “16 bits” for single-word monitoring, or “32 bits” for two-word monitoring.

����� Message
Enter your Message text here. When using Direct Text, a single message can
be up to 100 characters, however the actual number of characters that can be
displayed will depend on your GP model.
With the GP-377, GP77R and GP2000 series, selecting the [Browse Text Table]
feature allows you to use the text registered in the Text Table Editor to change
message text.  4.6.3 ����� Selecting Alarm Editor Messages

����� Level

This feature sets the Alarm Message's Level. Levels 0 to 7 can be used for a
total of 8 levels. Use this feature to assign lower levels to less important mes-
sages and higher levels to more important messages. Initial level setting is "0".
Colors can also be assigned to each level and displayed on the GP. For
detailed setting information,  Tag Reference Manual 2.20.4
Setting Items ����� Size/Color

• The level can be set when the [Use Extended Features] check box is checked
(enabled). This option is available only on GP2000 Series units.
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����� Editing Tools
The Alarm Editor has the following editing features.

*1 When the [Copy] or [Cut] command is executed, the copied or deleted data is tempo-
rarily stored on the clipboard.When you execute the [Paste] command, the data stored
on the clipboard can be copied or moved to a desired position.

Icon Editing Tool Description

Cut
Used to delete a symbol’s line of data and store it on the
clipboard. The [Paste] command allows you to then move
that symbol to another line.

Copy Used to copy a selected line of data to the clipboard.*1

Paste
Used to insert the line of data temporarily stored on the
clipboard into the desired row, after the Cut/Copy command
has been performed.

Undo
Used to cancel the command previously performed and
return to the previous condition. However, an edited symbol
character cannot be restored.

Add Alarm
Adds an address. If the selected alarm number already exists,
that data can be overwritten.

Change Attribute Allows you to change the alarm attributes.

Apply Device
Comment

Inputs device comments for all the selected devices in the
Message Column.

System Settings
Allows you to go to the "Q-tag Settings" dialog box from the
"Alarm Editor". Press the [OK] button to save the settings for
the Q-tag.
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Entering data in the Alarm Editor
only does not activate the “Alarm
Summary” mode. To activate the
“Alarm Summary” mode, you must
set up an “a-Tag” for the Base
screen where the message is dis-
played.

(2) Specify the bit address (monitor bit).

(1) Via the Project Manager, select the [Screen/Setting]
menu - [Alarm Editor] command, or click on the

 icon to open the Alarm Editor.
Refer to "5.1.1 Alarm Editor" and select the desired
alarm type.

When designating an Alarm
summary’s bit address, be sure to
select a device that can use  word
designated units.

Device/PLC Con-
nection Manual, Chapters 2 & 5 -
each item’s section 3 - Supported
Devices

This section describes how to create and register alarm messages using
Alarm Editor. (When using the Alarm Editor on the [Alarm Message/Alarm
Summary Settings])

After selecting several messages by
dragging the mouse, you can use
the [Copy] and [Paste] commands.

Up to 160 alphanumeric characters
can be entered for one Basic Alarm
message.

(3) Enter a message.
Enter the message to be displayed on the GP unit panel
during alarm output.
Select a message color, if desired.

5.1.2 Creating an Alarm

Select the alarm type.
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(5) After entering all the necessary items, select the
[Alarm] menu - [Save] command, or click on the 
icon.
The specified alarm data will be stored in the currently
opened project file.

(4) Select the alarm type: Alarm “Message” or Alarm
“Summary”.
If you select “Message”, you can also designate the alarm
trigger/recovery time history print command.

If a message has not been entered, the
Alarm Editor data cannot be saved,
even if the bit addresses have been
specified.

Up to 512 alarm messages can be
registered. However, set the moni-
tor bits within 128 words.

Alarm messages can be printed
with GP-470, GP-571T, GP-675,
GP-870, GP77R and GP2000 (ex-
cept GP2000H) series. To perform
printing with GP-377R, GP-2301,
however, a Multi Unit (sold sepa-
rately) will be needed.
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5.1.3 Editing Alarm Data

If a message has not been entered,
Alarm Editor data cannot be saved,
even if bit addresses have been
specified.

To select several lines, drag the
mouse between the target lines, or
click on the target line while hold-
ing down the  Shift  or  Ctrl   key.

To delete the selected line(s), per-
form steps (1) and (2) only.

(4) Select the [Edit] menu - [Paste] command, or click
on the  icon to paste alarm data to the destination
from the Clipboard.
If the same number already exists, the system asks if
each file must be overwritten. If you select  ,
the desired data will be overwritten. If you select

 , the desired file will not be overwritten, and
the system will ask the same question for the next alarm.
If you select  , all existing alarms will be over-

written. If you select  , you will return to the
menu screen.

(3) Select the insertion line.

(2) Select the [Edit] menu - [Cut] command, or click on
the  icon to import alarm data to the Clipboard.
The selected alarm data will be deleted and stored.

(1) Select the line of alarm data to be moved.

This section describes how to use the Alarm Editor’s editing commands.

����� Cut/Move
Here, you can delete the selected line of alarm data and store it on the clipboard.
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The selected alarm data is moved to the specified line.
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Even if bit addresses have been
specified, if message data has not
been entered, the Alarm Editor data
cannot be saved.

To select several lines, drag the
mouse between the target lines, or
click on the target line while hold-
ing down  the          or         key.

(4) Select the [Edit] menu - [Paste] command, or click
on the  icon to paste alarm data to the destination
from the Clipboard.
If the same data already exists, the system asks if each
file (item) must be overwritten. If you select ,
the desired file will be overwritten. If you select

 , the desired file will not be overwritten, and
the system will ask the same question for the next alarm.
If you select  , all existing alarms will be over-
written. If you select  , you will return to the
menu screen.

(3)Select the destination line.

(2)Select the [Edit] menu - [Copy] command, or click
on the  icon to import alarm data to the Clipboard.
The selected alarm data will be copied to the clipboard.

(1)Select the alarm line to be copied.

Shift Ctrl

����� Copy
Copies the selected line of alarm data, and stores it on the clipboard.
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The selected alarm data is copied to the specified line(s).
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When an alarm has been unintentionally deleted:

(1) Select the [Edit] menu - [Undo] command, or click
on the  icon.

����� Undo
This feature allows you to cancel the previously performed command, and return to
the previous condition.

Edited message characters cannot
be restored with the [Undo] com-
mand.

An alarm can be pasted onto alarms
of different types. (For example, an
alarm copied from "Alarm Mes-
sage/Alarm Summary" can be
pasted onto the "Bit Log Alarm".)

Note that only the "message" will
be pasted in this operation. Options
other than the "message" must be
set separately.
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�����Word Alarm Log

�����Bit Alarm Log

����� Adding Alarm Data
Here, you can add alarms for the specified number of bits or words from the line
whose item is enclosed with dotted lines. Addresses are automatically assigned to
each alarm from the start address in series, according to the designated address add-
ing increment. In addition, when messages have been entered, they are copied for all
the alarms to be added.
If an alarm number to be added already exists, a prompt will appear asking if the
newly set data overwrites the old one.
The dialog box that appears will vary depending on the alarm type selected:

When a variable (GLC symbol) is used as a start address, set
the add offset to 0. Otherwise, the correct addition will not be
performed.

�����Alarm Message/Summary

The [Level] setting can be selected only when the [Use Extended Features]
check box is checked in the Alarm Editor.

• The [Use Extended Features] option is available only on GP2000 Series units.

The [Level] setting can be selected only when the [Use Extended Features]
check box is checked in the Alarm Editor.

• The [Use Extended Features] option is available only on GP2000 Series units.
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(3)After entering the necessary settings, click on the
 button.

If the same number already exists, the system asks if each
file must be overwritten. If you select  , the de-
sired file will be overwritten. If you select  , the
desired file will not be overwritten, and the system will ask
about the next alarm. If you select  , all existing
alarms will be overwritten. If you select  , you
will return to the menu screen.

If a symbol is specified for the start
address, the added addresses will
be displayed as follows:
Example: Assume that the start ad-
dress is TEST (← Symbol), and that
the number of added bits is 4.  The
addresses are consecutively added
as shown below:
TEST
TEST + 1
TEST + 2
TEST + 3

Set the address adding increment
between 0 and 255.

(2)Select the [Edit] menu - [Add Alarm] command, or
click on the  icon.

(1)Select the address line where the specified number
of addresses will be added. (Shown here with a dot-
ted line around its border)
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� � � � � Word Alarm Log

� � � � � Bit Alarm Log

����� Changing Alarm Attributes
You can easily change any alarm’s attributes. The dialog box that appears will vary
depending on the alarm type selected.

� � � � � Alarm Message/Summary

The [Level] setting can be selected only when the [Use Extended Features]
check box is checked in the Alarm Editor.

• The [Use Extended Features] option is available only on GP2000 Series units.

The [Level] setting can be selected only when the [Use Extended Features]
check box is checked in the Alarm Editor.

• The [Use Extended Features] option is available only on GP2000 Series units.
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If several lines are selected, the at-
tributes of the selected lines can all
be simultaneously changed.

To select several lines, drag the mouse
between the desired lines, or click on
the desired line while pressing the
          or            key.

(3) After entering the necessary items, click on the
 button.

(2)  Select the [Edit] menu - [Change Attributes] com-
mand, or click on the  icon.

(1) Select the line of the alarm to be changed.
In this example, we will change an attribute of an item
in the alarm message/alarm summary area.

Shift Ctrl
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����� Reflecting Device Comments
This feature is used to reflect all the comment information corresponding to a se-
lected device in the Message field.

(1) Select an alarm for which comment information is
to be reflected, on a row basis.
Here, reflect the comment in the device for the alarm
message/alarm summary.

(2) Select the [Edit] menu - [Apply Device Comment]
command, or click on the  icon.

(3) A confirmation dialog box appears. Click on the
 button to execute the command

(4) The device comment corresponding to the address
will be included in the messages.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S
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The created Alarm data can be exported to and saved as an ALA or CSV
file. Then, by importing the saved alarm data, it can be shared among
Projects. CSV files created via a text editor or Microsoft Excel can be
imported and used on the Alarm Editor. Alarm data's CSV file formats are
as follows:

“Block”, “1” Block designation status

“Block1”, “0” Block 1 attributes
“Block2”, “1” Block 2 attributes
“Block3”, “2” Block 3 attributes
“Basic Alarm” Message/Summary settings
“M0064”, “Function A in suspension”, “0”, “0”, “7”, “0”, “0”, “0”

“M0065”, “Function B in suspension”, “1”, “1”, “1”, “1”, “2”, “1”

“M0066”, “Function C in suspension”, “2”, “0”, “3”, “0”, “5”, “1”

“Bit Log1” Bit log alarm Block 1 settings
“M0351”, “Tank A: Abnormal pressure”, “0”, “0”, “0”, “0”

“M0352”, “Tank B: Abnormal pressure”, “768”, “8999”, “1”, “0”

“Bit Log2” Bit log alarm Block 2 settings
“M0353”, “Tank C: Abnormal pressure”, “0”, “0”, “0”, “0”

“M0354”, “Tank D: Abnormal pressure”, “768”, “8999”, “1”, “0”

“Bit Log3” Bit log alarm Block 3 settings
“M0355”, “Tank E: Abnormal pressure”, “0”, “0”, “0”, “0”

“M0356”, “Tank F: Abnormal pressure”, “768”, “8999”, “1”, “0”

“Word Log1” Word log alarm: Block 1 settings
“R00101”, “Tank A: Water level low”, “0”, “0”, “0”, “0”, “0”

“R00102”, “Tank B: Water level low”, “768”, “8999”, “65535”, “1”, “0”

“Word Log2” Word log alarm: Block 2 settings
“R00103”, “Tank C: Water level low”, “0”, “0”, “0”, “0”, “0”

“R00104”, “Tank D: Water level low”, “768”, “8999”, “65535”, “1”, “0”

“Word Log3” Word log alarm: Block 3 settings
“R00105”, “Tank E: Water level low”, “0”, “0”, “0”, “0”, “0”

“R00106”, “Tank F: Water level low”, “768”, “8999”, “65535”, “1”, “0”

5.1.4 Alarm Import/Export

“Bit Address”,
“Message” “Printing
status”, “Fg”, “Blk”,
“Bg”, “Blk”

“Bit Address”, “Mes-
sage”, “Group No.”,
“Sub-display Screen”,
“State”, “Level”*1

“Word Address”,
“Message”,
“Group No.”,
“Sub-display
Screen”, “Alarm
Value”, “Number
of Monitor Bits”,
“Level”*1

*1 This data is displayed when [Use Extended Features] is checked in the Alarm Editor.
This function is available only on GP2000 Series units.



5-27

Chapter 5 - Alarms 5.1 Alarm Creation and Editing

GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

“EXBlock”, “1” Extended block designation status

“Block4”, “1” Block 4 attributes
“Block5”, “0” Block 5 attributes
“Block6”, “0” Block 6 attributes
“Block7”, “0” Block 7 attributes
“Block8”, “0” Block 8 attributes
“Bit Log4” Bit log alarm Block 4 settings
“M0357”, “Tank G: Abnormal pressure”, “0”, “0”, “0”, “0”

“M0358”, “Tank H: Abnormal pressure”, “768”, “8999”, “1”

“Bit Log5”

“Bit Log6”

“Bit Log7”

“Bit Log8”

“Word Log4”

“R00107”, “Tank E: Water level low”, “0”, “0”, “0”, “0”, “0”

“R00108”, “Tank F: Water level low”, “768”, “8999”, “65535”, “1”, “1”

“Word Log5”

“Word Log6”

“Word Log7”

“Word Log8”

“Bit Address”,
“Message”,
“Group No.”,
“Sub-display
Screen”, “State”,
“Level”

“Word Address”,
“Message”,
“Group No.”,
“Sub-display
Screen”, “Alarm
Value”, “Number
of Monitor Bits”,
“Level”

These lines are
written when
[Use Extended
Features] is
checked in the
Alarm Editor.
This function is
available only on
GP2000 Series
units.
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• CSV Import

GP Settings Data Operation
64-color 63 or less Normal import
256-color 64 or more Import with color setting: 0 to 255

GP Settings Data Operation
64-color 63 or less Normal export

256-color 64 or more
Export with blink setting: 0 to 255

Export with blink setting 0: Not blink

Note:

•  CSV Export

Block Designation
Status

Block Attributes

Non-supporting model
    0: Not blink 1: Blink 2: Not blink 3: Blink
Supporting model
    0: Not blink 1: Middle speed
    2: High speed 3: Low speed

Group No.

Sub-display Screen

Number of Monitor
Bits

Alarm Value
Number of Monitor Bits: 16 : 0 to 65,535
Number of Monitor Bits: 32 : 0 to 4,294,967,295

0: 16 bits 1: 32 bits

Message Colors

Blink (Blk)

0 to 768 (GP2000 series: 0 to 2012)

0 to 8999

8-color compatible models: 0 to 7
64-color compatible models: 0 to 63
256-color compatible models: 0 to 255

Foreground color
(Fg)
Background color
(Bg)

0: Specified 1: Not specified

0: Active 1: History 2: Log

Printing Status

0: When Alarm is triggered, OFF/When recovered, OFF
1: When Alarm is triggered, ON/When recovered, OFF
2: When Alarm is triggered, OFF/When recovered, ON
3: When Alarm is triggered, ON/When recovered, ON
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����� Alarm Export
Alarm data is saved as ALA or CSV files.

All the setting information of
Alarm Message/Summary, Bit Log
Alarm, and Word Log Alarm is
saved in the exported file.

(3)  Specify the file name and file type (*.ALA or *.CSV)
with which the exported alarm data is saved, and click
on the  button.
Enter a comment, if desired.
If the same ALA file name already exists, the system
asks if the existing file must be overwritten. If it must be
overwritten, select  . If it should not be over-

written, select  .

(1) Select the Alarm Editor’s [Alarm] menu - [Export]
command.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(2) Click on the  button.
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(3) Select a file (*.ALA or *.CSV) to be imported, or
enter the file name. Then, specify an import method.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1) Select the Alarm Editor’s [Alarm] menu - [Import]
command.

����� Alarm Import
Alarm data saved as a file is imported to the currently open Alarm Editor. Files with
the extension of “*.ALA” or “*.CSV” can be imported.
To import alarm data from a CSV file, only the specified type of alarm can be im-
ported from all the registered alarm.

(4) Click on the  button to quit the Alarm
export mode.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

[Overwrite]
All current alarm registration num-
bers (1 to 8999) will be overwrit-
ten.
[Add to End]
Imported messages will be added af-
ter the last message line. If there are
any gaps between the current regis-
tration numbers, the sequence num-
bers will be re-assigned to fit into
all existing lines, and the imported
messages will be added after the last
line.

(2)Click on the  button.
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Once you complete the [Import]
command, it cannot be undone.

(5)After entering all the necessary items, click on the
 button.

If the selected Device/PLC type is different between the
currently open project and the imported ALA file, the sys-
tem asks if the preset addresses should be overwritten. If
the preset addresses must be overwritten, select  .
If they must not be overwritten, select  .

(4)When selecting CSV file as imported file type, specify
the type of alarm to be imported.
Only the type of alarm specified here will be imported.

When selecting ALA file as im-
ported file type, skip step (4).
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· When alarm data does not have an identifier "Block*" for the
first 4 lines, which indicates block settings, the alarm will not
be imported.

· If the address(es) registered in the alarm data to be imported
are incorrect, set correct addresses via the Symbol Editor.

        4.9 Symbol Editor
· When the number of message characters exceeds the limit, the
message is imported only for the effective number of charac-
ters.

· When data is imported from a file in which only a message is
registered, the initial value is used as an address.

 (6)Click on the  button to quit import mode.
Since you selected [Add to End] in this example, the im-
ported messages were added after the last line.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S



ou can select many of the GP unit’s initial settings through the
GP-PRO/PB III for Windows program. This program area is called

“System Settings”. When “System Settings” data is sent to the GP unit, you
will not need to manually perform the initial setup of the GP unit.
A description of each GP unit setting item is provided in your “GP Series
User’s Manual” (sold separately). For details, refer to that manual.

Y

 6       GP INITIAL AND SYSTEM SETTINGS

6.1 .....................................Menu Setting Items: GP Setup

6.2    ...................................... Printer Type
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6.1 Menu Setting Items: GP Setup

In the [System Settings] mode, you can easily select the GP unit’s initial
settings. By doing this, you don’t need to manually set up the GP panel,
since the [System Settings] data is sent to the GP panel automatically. After
the [System Settings] data is sent to the GP panel, you can also change those
settings via the GP unit itself. For the method for sending the [System
Settings] data to the GP panel,  7.2.1 Transfer Settings.
For the method for changing the [System Settings] data with the GP unit,

 Your GP Manual, INITIALIZE.

Usage  Pattern
Click on the

 button
to register the GP
system settings.

Enter each
parameter.

[GP Setup]
or

click on

 .

[Project ] →→→→→→→→→→→→→→→

*1 If any font setting other than "Japanese" is selected, "Font Setting" requires specifying
whether alphanumeric characters and symbols are to be displayed at the high quality
level.

Some setting commands are supported by the GP unit but not by GP-PRO/
PB III for Windows, or vice versa, i.e. are supported by GP-PRO/PB III for
Windows but not supported by the GP unit. This section describes only the
commands supported by GP-PRO/PB III for Windows. For a description of
other commands, refer to your “GP Series User’s Manual” (sold separately).
For a description of the network setting, refer to the Device/PLC Connec-
tion Manual.

� � � � � Setting commands Supported by Only the GP Unit:
• Setting Date/Time
• Self-diagnosis command
• Font settings (English, Korean, etc.)*1

• Functions for adjusting the Video Display

� � � � � Commands Supported by Only GP-PRO/PB III:
• Initial Screen Settings: [Color Setting] dialog
• GP Settings: [Checksum]

Enables checksum verification.
• GP Settings: [Buzzer]

Select continuous or intermittent buzzer output.
• GP Settings: [Screen Level Change Flow]

Used to switch screens in the hierarchical display mode.
• GP Settings: [Common Password]

Enables or disables the Common Password setting.

6.1      Menu Setting Items: GP Setup
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• GP Settings: [Change to Screen No.]
Specify the number of the screen used to replace the current one after
the preset standby time has passed. If you enter “0”, no screen will be
displayed.

• I/O Settings: [Offline Mode]
Specify how to change from on-line mode to offline mode.

• Mode Settings: [Device/PLC Type]
Displays the name of the device connected to the GP panel.

• Mode Settings: [Option]
This setting is necessary only when specific Device/PLC types are
selected.

• Extended Settings: [K-tag Priority]
Designates the K-Tag processing mode. “Standard” mode executes the
K-tag once per scan time, and “Twice” mode executes the K-tag two
times per scan time.

• Extended Settings: [Backup Settings]
Used to back up the GP unit's LS area data. Specify the initial address
of the backup range, and the number of words used.

• Extended Settings: [Delete Error Display](Only for programless type)
Displays an error message when an communication error occurs with
the GP, and deletes the error message when the communication error is
reset. System errors however cannot be reset, regardless of this setting.

 •Extended Settings: [Watch Dog] (Monitoring the communication
status between the GP and the device)
Monitors the communication status between the GP and a device. The
GP unit writes the data (00FFh) to the word address of the device at
specified time intervals. This function enables the device (ladder
programs, etc.) to check the communication states with the GP by
periodically monitoring the data written by the GP (00FFh). After the
data has been reviewed by the device, execute the "0 Clear" command
to enable the monitoring of new data written by the GP. However,

• Extended Settings: [CF Card Control Settings]
<Data Save>
Used to specify a control word address when saving data on the CF
Card for the GP-77R and GP2000 series.  The GP unit writes this
control word address data to the CF card.
<Free Space Storage Address>
When using a CF Card on the GP77R and GP2000 Series, specify the
address to store the information on available CF card space.

    Tag Reference Manual, 4.7 Using the CF Card
<SRAM Auto Backup>
Designate the control address used for saving the GP's SRAM data to
the CF Card or restoring the data from the CF Card to the GP's SRAM
in OFFLINE mode with the GP2000 series.

    Tag Reference Manual, 4.7.9 Making a Backup of
Backup SRAM
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6.1 Menu Setting Items: GP Setup6.1 Menu Setting Items: GP Setup

• Extended Settings: [Q-tag Settings]
When using a Q-tag, specify display and printing settings as well as
extended settings.

  Tag Reference Manual, 2.20 Q-tag (Alarm Summary
bit log/word log Display)

• Extended Settings: [Capture Settings]
Designates the settings for the Control Word Address used for produc-
ing hard copies of the GP screen displaying video images.

   Tag Reference Manual 4.7.10 Screen Capture
• Extended Settings: [Video Settings] (Video Window Operation Settings)

Settings used for displaying a video window as a global window
     3.6.2 Video Window Settings

• Extended Settings: [FEP Setting]
• Extended Settings: [Serial 2-D code reader]
    (includes LS storage start address/Read complete bit address/Data

storage settings)
• Extend Settings: [Touch Panel Settings]

Sets the sensitivity of the GP touch panel. 3 settings are available;
[High], [Medium], [Low].

• Communication Settings: [Send Wait]
If the GP unit sends a command to the Device immediately after
receiving a response from the Device, the Device cannot receive the
command, which will cause a communication error, depending on the
Device/PLC type. In this case, enter a value for the transmission wait
time. If a transmission wait time has been entered, the GP unit waits
for the preset time duration after receiving the Device’s response, and
then sends the next command to the Device.
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System
Setting
Items

Designate the arbitrarily
specified password (0-9999)
or select the ON/OFF setting
for the common password
setting (1101).

 The common password
(1101) cannot be used
when OFF is selected. In
this case, only the arbi-
trarily specified pass-
word can be used. Be
sure to write down this
password and keep it for
future reference. Without
the password, GP opera-
tion in OFFLINE mode is
disabled.

����� Tab Setting Items
Each tab's setting items are described here.

The setting items may differ depending on the GP type or Device/PLC type
being used.

�����GP Settings
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Touch Panel Settings

Printer Settings (“Vertical”
printing is possible only with
GP-675, GP-2600 and GP-
2601. EPSON PM/Stylus (6-
color ink)  and EPSON Stylus
(4-color ink) does not support
"Vertical” printing.)

LCD Settings (for
GP-H70L, GP-
270L, GP-370L,
GP-377L, GP-
2301HL, GP-
2300L, GP-2301L,
GP-2500L and GP-
2501L only)

I/O Settings

Frame Refresh
Rate Settings
(GP-377, GP-
577RS, and
GP2000 Series
units with Mono-
chrome or STN
Color display
only.) Sets up the function for detecting errors in Touch Panel operation

(available only with GP77R and GP2000 Series units).

Operating Environment
Settings

Operating Environment
Options

Customizing command
(n:1)

 Node Information Settings

Mode Settings

This option can only be selected
when the printer type is designated
as EPSON PM/Stylus (6-color ink)
or EPSON Stylus (4-color ink).
Available only with GP2000 Series
units (except for GP-2301H, GP-
2401H and GP-2301 Series units
which do not have printer inter-
faces).
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Error Handling Settings

Handy-type GP’s Operation
Switch (Enable/Disable)
Settings

Video Environment and
Display Settings

GP Internal Memory Data Area
Settings

String Data Settings

�����Extended Settings

Font Settings

K-tag Processing
Frequency Settings

Watchdog Monitoring
Address and Time
Settings

Control Address Settings
for Saving CSV Data such
as Alarm Screens on CF
Card (GP77R  (except GP-
377) series and GP2000
series only)

Tag Refer-
ence Manual,  4.7.8  �����
Specifying a Control
Address

Alarm History Display Mode
Settings

Global Window Settings

FEP Settings
Extend SIO Settings
Serial Code ReaderDesignates the address to

store the information on
available CF card space
(only supported by the
GP77R (except GP-377)
and GP2000 series).

 Tag Reference
Manual, 4.7 Using the CF
Card

Settings for capturing the
GP screen 
Tag Reference Manual, 4.7.10
Screen Capture

System Area Backup
Command Settings

Initial Screen Settings

�����Initial Screen Settings

[64 color with blinking] is the default
setting.
GP2000 Series units only (TFT color only,
except GP-2301HS, GP-2301HL, GP-
2300L, GP-2300S, GP-2301L, GP-2301S,
GP-2500S and GP-2501S series units)
With the monochrome LCD GP (GP-
2301HL, GP-2300L, GP-2301L, GP-2500L,
GP-2501L), [monochrome 8-level] can be
selected.

Designate the control address used for
saving the GP's SRAM data to the CF Card
or restoring the data from the CF Card to the
GP's SRAM in OFFLINE mode (GP2000
series only).  Tag Reference
Manual, 4.7.9 Making a Backup of Backup SRAM

Note: Depending on the color, selecting MONOCHROME 8 HUES
may cause the GP unit’s screen to flicker. Confirm the color
before using this mode.

When the Color Setting is set to
[Monchrome], the color bar shown on
the screen editor will display 8 colors.

Adjusts Touch Panel
scan sensitivity.
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Communication Param-
eter Settings
115200 and 57600 can
be selected for the
GP77R and GP2000
series only.

Communication Monitor
Time Settings

�����Communication Settings Menu
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(2) Click on a desired menu tab.
Each tab’s setting items will be displayed.

(1) Via the Project Manager, select the [Screen/Setup]
menu - [GP System Settings] command, or click on

the  icon.

����� GP System Settings

GP Settings Menu
Tabs

To reset each item to its default value,
click on the  button.

(3) After entering all the necessary items, click on the
 button.
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6.2      Printer Type
The printer type can be selected using the “GP Setup | I/O Setting” tab.
The following information explains points to be considered when selecting
the printer type.

6.2.1 Epson PM Series / Epson Stylus Series
The following Epson PM/Stylus (6-color) printer models can be used.

Printer Model No. of colors
PM-730C
PM-740C
PM-830C
PM-840C
PM-870C
PM-890C
PM-2200C
PM-3700C

6 

The following Epson Stylus (4-color) printer models can be used.

• Epson PM/Stylus (6-color) and Epson Stylus (4-color) printers can be used
only with GP2000 series units. (Except the GP-2301H, GP-2401H and GP-
2301 Series units).

• Using printer models other than those mentioned above may sometimes
cause improper printing. Be sure to check that the printer operates
correctly.

• Printer type compatibility is subject to change as new printer models are
released.

• “Vertical” printing of screen data is not supported.

• Printing is possible up to the width of A4 size paper.
With GP-2600/GP-2601 series, a magnification value of 4 could cause the
printout to exceed 210 mm.

Printer Model No. of colors
Stylus C60
Stylus C61
Stylus C62

4

This section will not be printed.

210 mm

A4 paper
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����� Printing out GP Data
For the Epson PM/Stylus (6-color) and Epson Stylus (4-color) printers, the
following have been classified as items that can be printed out, and those
that cannot be printed out.

• When printing using an Epson PM/Stylus (6-color) or an Epson Stylus (4-
color) printer, GP screen update (tag processing, etc.) slows down.

• Since the OFFLINE Self-diagnosis (Printer I/F Check) is used only for
ASCII code output, it will not produce correct printout.

• A magnification value of 1 to 4 can be specified while printing out the
screen’s hard copy. With GP-2600T and GP-2601T units, a magnification
value of 4 could cause the printout to exceed the width of an A4 size paper.

• When screen data printout uses levels of shading, the printout will differ
from a different type printer (PR201, etc.). This is because colors are
recognized based on shading level patterns and not on the density of  shad-
ing.

• When logging data or CSV data is printed out, any section exceeding the
width of A4 size paper will not be printed. Note that up to 110 single-byte
characters can be printed out on one line. Be sure to check your printer’s
page settings prior to printing out this data.

�����Printing out GP screen data

Screen data can only be printed out horizontally.
A magnification value of 1 to 4 can be specified.

•  When using GP-2600/GP-2601 Series units, be sure to set [HARDCOPY
ORIENTATION] to “PORTRAIT” within the [SET UP PRINTER] screen.
Setting the option to “LANDSCAPE” may cause incorrect printing.

GP Screen Data Printout Possible
Screen data printout YES
Q Tag (Real-time) YES
Q Tag (Batch) YES
Logging (Real-time) YES
Logging(Batch) YES
CSV Data YES
OFFLINE Self-diagnosis (Printer I/F Check) NO
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6.2 Printer Type

  • PRINT MAGNIFY settings

Use the [I/O Settings] tab when setting a magnification value.

Use the [SET UP PRINTER (EXT-SET)] screen when setting a magnifica-
tion value in GP OFFLINE mode.

Touching the             key in the [SET UP PRINTER] screen displays the
[SET UP PRINTER (EXT-SET)] screen.

Touching any of the magnification values and touching the  key
takes you back to the [SET UP PRINTER] screen.

* With GP-2600/GP-2601 Series units, a magnification value of  4 could
cause the printout to exceed 210 mm.

When printing using printers other than Epson PM/Stylus (6-color) or
Epson Stylus (4-color) printers, touching the  key displays the screen

shown below. Touch the  key to go back to the [SET UP PRINTER]
screen.

This section will not be printed.

210 mm

A4 paper



o display screens created with GP-PRO/PB III on the GP unit, you
must first transfer the screen data to the GP. Conversely, with the

GP-PRO/PB III program, you can also transfer screen data stored in the GP
unit back to your personal computer for additional editing.

This chapter describes how to transfer screen data to and from the GP unit.

  7      TRANSFERRING DATA

T

7.1 ........................................... Prior to Transferring Data

7.2 ..................................................... Transferring Screens

7.3 ........................................................................... Options

7.4 ........... Setting Up Your GP via an Ethernet Network
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7.1 Prior to Transferring Data

 7.1      Prior to Transferring Data

•  To transfer GP-PRO/PB III for Windows data to the GP unit, the
optional cable set (GPW-CB02) is required. This cable does not
come with any interface conversion adapter for the personal
computer. Supply a connector conversion adapter compatible
with the interface of your personal computer. Such an adapter
is available at a computer supplies shop.

•  To transfer Filing Data, image screens, sound data, etc. to a
CF card on the GP77R series, the Multi Unit (sold separately)
and a CF card are required.

• File Transfer requires approximately three times the hard disk
space occupied by the Project file.

• If a serial mouse is used, be sure to connect the cable from the GP unit to a
different serial port on your PC.

Note:

The GP screen can be transferred in three ways; through the GP screen
transfer cable, the CF card or on Ethernet connection. This chapter de-
scribes the transfer procedure via the GP screen transfer cable. For the
transfer procedure via a CF Card,  "10.7 CF Memory
Loader Tool." For the transfer procedure via an Ethernet connection,

 "7.2.3 2-Way Driver."

You must first connect the Data Transfer Cable to the GP unit and ygur
personal computer before you can transfer screen data.

To GP’s Tool
Connector

GP screen transfer cable
(Dsub 9-pin socket)

Personal Computer (PC)
(or Lap-top)

G P
To PC’s
serial port

 7.1.1 GP Screen Transfer Cable

Note:

USB Connector*1

To GP’s Tool ConnectorTo PC’s USB port

*1 For information about the USB Cable's specifications, connection method, driver in-
stallation and other items,  USB Transfer Cable Installation Guide



7-3

Chapter 7 - Transferring Data

GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

7.2 Transferring Screens

Usage Pattern

Click on the  or
 icon to transfer

screen data.

Compile the GP-
PRO/PB III data
GP unit data.

[Prepare][Transfer]

Specify the Setup
and Communica-
tion parameters.

[Transfer
Settings][Setup]      or

Click on .

[Transfer]Project
Manager

→→→→→→→→→→→→→→→

→→→→→→→→→→→→→→→→→→→→

Transfers screen
data from GP-
PRO/PB III to the
GP unit

Displays the
progress of the data
transfer operation

Displays the transfer
preparation status

Displays the current
project’s comment data

Displays the
current status of
the data transfer
operation

Displays the
currently-specified
destination type

Displays the
currently-speci-
fied setup mode

Displays the
currently-specified
transfer mode

Displays the
current project file
name

Quits [Transfer]
mode

Displays the [Download
Setup] dialog box

Cancels  Data
Transfer mode

Transfers screen
data from the GP
unit to GP-PRO/
PB III

Send screen data
to the GP unit Quit Transfer

Tool

Transfer
Setting

Cancel Transfer

Receive screen data
from the GP unit

The tool bar icons provide the following functions:

To display a screen (window) to perform data transfer, select the Project
Manager's [Project] menu - [Transfer] command, or click on the

 icon. Or, select the Screen Editor's [Screen] menu - [Transfer]

command, or click on the  icon. An example of this screen (window) is as
follows:

This section describes how to transfer screen data created with the GP-PRO/
PB III program to and from the GP unit.

[Project] →→→→→

 7.2     Transferring Screens

      or

Click on  .

GP2000
series only

Starts the GP-
Web compiler

Start GP-Web
Compiler

Create
Dictionary

Receive
Dictionary

Send
Dictionary

Create trigger CF
card data

Send trigger CF
card data

Create backup data

Send backup
data

Receive backup data

Creates the
dictionary file
in the CF card
holder

Create a
PRW file
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7.2 Transferring Screens

Specify the
information to
be transferred
with the screen
data here.

 7.2.1 Transfer Settings

Select the setup
CFG file

Select the setup mode

Select the destination
type

Select the PC serial
port that will be used
with the data transfer
cable

Specify whether to
transfer the upload
information required to
Receive data from the
GP unit

Select the transfer
mode

Transfers Filing Data
to the CF card.

Tag Reference Manual,
4.7 Using the CF Card

This section describes the parameter settings necessary for screen data
transfer between your personal computer and the GP unit. These parameters
must be reset if your personal computer has been disconnected from the GP
unit, if the GP unit has been shut down, or if a nonstandard system or proto-
col program has been used with the GP unit.

Select a transfer
speed.

Sends the simulation protocol to
the GP unit.

8.1 Overview

����� Transfer Settings
Select the [Setup] menu - [Transfer Settings] command, or click on the 
icon. Then, a dialog box to perform data transfer settings will appear.

Select the maximum
number of transfer
retries

Do not turn OFF the PC or the GP unit, nor disconnect the trans-
fer cable during the transfer of screen data.  This can cause an
error when the GP is started.

When transferring the screen data from the GPPRO/PB III to the CF Card,
the time stamps on the files loaded onto the CF Card are updated to the
time setting of the GP at the moment of the data transfer.

Note:

Transfers Data
Transfer CSV Data
to the CF card.

Tag Reference
Manual, 4.7 Using the
CF Card

Select the timing for
the preparation and
execution of the
transfer.

7.2.4 Transfer Prepa-
ration

Allows you to select the data (CSV Display,
File Manager Display Explorer screens,
Keypad Input Display Popup Keypads) sent
to the GP unit. Reduces the overall data size
and speeds up data transfer.

Sends logic program data.
 Pro-Control

Editor Operation Manual 5.2
Downloading to a GLC
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7.2 Transferring Screens

����� Transfer Mode

Upload parameter data must be included to receive screen data
from the GP unit. If the GP unit’s memory is insufficient to in-
clude the upload parameter data, screen data can still be trans-
ferred from your personal computer to the GP unit. However, if
the upload parameter data is omitted, your personal computer
cannot receive screen data from the GP unit.

GP System Screen

Specify whether to transfer the GP system data when sending the data to GP.

If the [GP System Screen] setting is not checked (disabled), and
the following types of Project files are sent to the GP unit, the
GP unit's system settings will be reset to their initial settings.
• If a new version of the System, Protocol or Extend SIO pro-

grams are transferred*1

• If the Protocol program is changed, if the [GP System Screen]
setting is not checked (disabled) and the GP Setup is at-
tempted, the following warning message box will appear.

Upload parameter data
Specify whether to send the upload parameter data in order to receive the
data from the GP.

*1 If the GP unit's current System, Protocol and Extend SIO programs are older than those
used by GP-PRO/PBIII, transferring data from GP-PRO/PBIII to the GP will automati-
cally update these programs.

If you do NOT wish to return the GP unit to its initial settings, be
sure the [GP System Screen] setting is checked (enabled) before
selecting [OK] and sending the Project, or click on [Cancel] and
close the warning dialog box.
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7.2 Transferring Screens

Filing Data (CF Card)
Specify to transfer the filing data to CF card.

 Tag Reference Manual, 4.7 Using the CF Card

Data Transfer CSV Data (CF Card)
Specifies whether to transfer “Data Transfer CSV Data” to a CF card.

Tag Reference Manual, 4.7 Using the CF Card

Send Control Data
Designates if the GLC/LT unit’s logic program data is sent or not.

Pro-control Editor Operation Manual, 5.2 Downloading to
a GLC

����� Serial Port

COM

Select the serial port for connecting the transfer cable, Transfer Speed and
the maximum number of transfer retries.

Ethernet

When using an Ethernet protocol or the 2-Way Driver, this setting designates
the IP Address and Port No. used.
Prior to sending data, this feature will automatically detect and display in a
list the current IP Addresses on the Ethernet network. Simply select the
desired GP unit and send the data.

 7.4 GP Setup via Ethernet, 7.2.3  2-Way Driver

Ethernet: Autodetect

When using an Ethernet protocol or the 2-Way Driver, this setting allows
you to send data to all or to a select number of GP units.
Prior to sending data, this feature will automatically detect and display in a
list the current IP Addresses on the Ethernet network. Simply select the
desired GP units and send the data.

 7.4 GP Setup via Ethernet

Memory Loader

Screen data is transferred from GP-PRO/PB III to the Memory Loader II.
(Separately sold)

  Memory Loader II Operation Manual (included with the
Memory Loader II unit)
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7.2 Transferring Screens

Note:

Send All Screens

Transfers all screen data in a Project File to the GP unit.

Automatically Send Changed Screens

Any screens that have been updated in the current Project File are automati-
cally transferred to the GP unit. This transfer mode is only effective when
screens have been previously transferred to the GP unit.

When  “Automatically Send Changed Screens” is used, screens that have been
deleted (not just updated) from the Project File in the GP-PRO/PB III pro-
gram will not be automatically deleted from the Project File stored in the GP
unit. To completely replace all screens of the Project File stored in the GP
unit, be sure to use “Send All Screens”. However, the data on the CF card  is
not deleted even if "Send All Screens" is selected. To delete data from a CF
card, please initialize it.

 Your Multi Unit User Manual

����� Transfer Method

• When Device/PLC type is "Memory Link Ethernet", screen data
cannot be transferred to a CF card.

• When Device/PLC type is "Memory Link Ethernet" and you
wish to transfer the screen data via Ethernet, select the [Do
NOT Perform Setup].
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7.2 Transferring Screens

Preparation for a transfer and a transfer are made simultaneous

Select to prepare and execute the transfer simultaneously.

It is transferred after preparation for a transfer is finished.

Select to complete the preparation and check errors before executing the
transfer.

����� Transfer Mode

Send User Selected Screens
When transferring a screen to a Project File stored in the GP unit, you
must specify the screen type.

File, log and sound data cannot be specified when transferring data.

To select screens, click on the names of the desired screens while holding
down the          key.Ctrl

If "Send User Selected Screens" is selected, upload data cannot
be transferred. As a result, your PC will not be able to receive
screen data from the GP unit. If you need to receive screen data,
select either "Send All Screens" or "Automatically Send
Changed Screens" and check the “Upload Information” check
box.
If "Send User Selected Screens" is selected, screen Parts that
have not been designated will not be displayed correctly. In
order to display the entire screen correctly, be sure to select the
“Send All Screens” option.
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7.2 Transferring Screens

Automatic setup :
Set up operation is performed if necessary, according to the GP’s status.
Normally, select this setup mode.

Force system setup :
Setup operation is performed every time screen data are transferred, regard-
less of the GP’s status.

Do not setup :
Setup operation is not performed, and only screen data are transferred.

Setup CFG file :
This is the file storing the setup information. Normally, you need not use
this setup mode.
If you select "English" and perform setup, the OFFLINE screen on the GP
unit will be displayed in English.

If you have changed from Japanese to English or vice versa, be
sure to specify [Forced Setup] and perform the transfer.

System Screen Settings

Allows you to select the data (CSV Display, File Manager Display Explorer
screens, Keypad Input Display Popup Keypads) sent to the GP unit. Reduces
the overall data size and speeds up data transfer.

This feature is available with GP-377, GP77R and GP2000 Series units. GP unit
compatiblity will depend on the type of model. For GP units other than those
above, the items in the [System Screen Settings] dialog are not sent.

• Keypads for File Manager Display & CSV Display

If selected, the project's CSV display and File manager display-related
Explorer like screens are sent to the GP. If not selected, these screens are
not sent, thereby reducing the amount of data to be transferred.

CSV and File Manager Displays can only be viewed on a GP2000 Series unit.

 2.1.19 CSV Display, 2.1.20 File Manager Display

����� Setup
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7.2 Transferring Screens

• Send Popup Keypads

If selected, you can select which of the Keypad Input Display's Popup
Keypads are sent to the GP. Depending on the amount you select, the
amount of data sent will be reduced.

Popup Keypads are available only on GP-377, GP77R and GP2000 Series
units. However, the Popup Keypad used for the [Specifying Entering Order]
feature can only be viewed/used on a GP2000 Series unit.

 2.1.14 Keypad Input Display

Selecting only the types of Popup Keypads you need to use will help to
reduce the amount of data and speed up the transfer process.
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7.2 Transferring Screens

����� Registering a Password
To restrict unauthorized access to the screen when sending/receiving the
screens, set up a (Transfer) password.

The following table shows the relationship between the Transfer password
and the common password that can be set up using [Protect] in the GP
Settings Screen. At the time of transfer, please confirm your password based
on the following chart.

 7.2.2 Passwords

(T ransfer) Password
(GP system)

Common password
Password to be entered for

transmission
Enabled abc
Disabled abc

Disabled Enabled 1101*

Enabled
(Example) abc

* There is no need to enter the password when transferring data from GP-
PRO/PB III.

 For details of the common password, 6.1 �GP Set-
tings

• Be sure to keep a copy of the password in a safe place. If you
forget the password, the “Transfer” function cannot be ex-
ecuted.

• The password is limited to 24 characters and only alphanu-
meric data (no symbols) can be used.
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7.2 Transferring Screens

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

If a password has already been reg-
istered, the [Change Password] dia-
log box will appear.

(4) Enter the same password again for confirmation, and
then, click on the   button.

(1) Via the Project Manager, select the [Project] menu -

[Transfer] command, or click on the 
icon. Or, via the Screen Editor, select the [Screen]
menu - [Transfer] command, or click on the  icon.

(2) Select the [Setup] menu - [Password] command.

(3) Enter a password.

If the currently open Project File
has not yet been saved  in stop, the
system will ask you to do so before
registering a password.

Also, if the currently edited screen
has not been saved via the Screen
Editor, a prompt will appear ask-
ing if screen data is saved before
transfer.
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7.2 Transferring Screens

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

To cancel the password, after en-
tering the currently registered pass-
word in step (2), DO NOT enter a
new password in step (3) and sim-
ply click on the  button.

If the currently open Project File
has not yet been saved in stop (1),
the system will ask you to do so be-
fore registering a password.

(4) Enter a new password.

(3) In order to change a  password, you must first en-
ter the currently registered password.

(1) Via the Project Manager, select the [Project] menu -

[Transfer] command, or click on the 
icon. Or, via the Screen Editor, select the [Screen]
menu - [Transfer] command, or click on the  icon.

����� Changing a Password
The registered password can be changed or canceled.

(2) Select the [Setup] menu - [Password] command.

(5) Enter the same password again for confirmation, and
then, click on the  button.

Also, if the currently edited screen
has not been saved via the Screen
Editor, a prompt will appear ask-
ing if screen data is saved before
transfer.
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7.2 Transferring Screens

7.2.3 2-Way Driver
The 2-Way feature provides a system in which an upper-level (Host) com-
puter accesses GP or device data via a network (Ethernet).
• The Pro-Server with Pro-Studio for Windows software is required to use

the 2-Way feature.

• This feature is available on GP77R and GP2000 Series units (except for GP-
2301H/GP-2401H/GP-2301/GP-2401 Series units). GP77R , GP-2501, and
GP2601 Series units require the optional Ethernet I/F Unit.

  Pro-Server with Pro-Studio for Windows Operation
   Manual

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Select the Transfer area [Setup] menu’s [2Way
Driver] command.

(2)Designate the 2Way Driver.
  Pro-Server with

Pro-Studio for Windows Opera-
tion Manual

When selecting a [Network
Project File] or a [Participating
Node], be sure the OS installed
in your PC is Windows95 OSR2
or later.

The Network Project file’s data
is not sent via Ethernet.  To trans-
fer the Network Project files, use
the Serial communication or Pro-
Server with Pro-Studio for Win-
dows.
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7.2 Transferring Screens

The Project File (PRW file) data created with the GP-PRO/PB III program is
first compiled before it is transferred to the GP unit.
Select the [Transfer] menu - [Prepare] command to compile your data.

 7.2.4 Transfer Preparation

Note: • To prepare the transfer,  about the 3 times the project file size is required in
your computer’s hard disk.

• After  the [Prepare] command is finished, you can check the GP unit’s
current memory capacity with the [Project Information] feature.

 4.5.1 Project Information
• Once you use the [Prepare] command, you do not need to use it again for

the same data, unless the data has been updated.

• If the Project File (PRW file) to be transferred is stored on your PC’s
floppy disk, copy it to your PC’s hard disk prior to using “Prepare” to
reduce transfer time.

• If the [Transfer Settings] →→→→→ [Transfer Mode] area’s [Preparation for a
transfer and a transfer are made simultaneous] selection is checked, the
time required for data transfer can become long. If you wish to shorten
the data transfer time, please select [It is transferred after preparation
for a transfer is finished].
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7.2 Transferring Screens

To display screens created with GP-PRO/PB III program on the GP panel,
you must first transfer the screen data from your personal computer to the
GP unit.

If the GP unit is not connected to the device when the screen
data are transferred to the GP unit and the “Change State”
function is set to “Yes”, bit switches, toggle switches, lamps,
and objects will not be displayed on the GP panel after data
transfer.

 7.2.5 When Sending Screens To the GP

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

Make sure that the GP unit is in the
“Transfer Screen Data” mode or
“RUN” mode. However, for the
GP-377 Series or GP77R Series,
when the built-in 2 port function is
specified in the GP, be sure to se-
lect Transfer mode.

GP Series User’s
Manual (sold separately): Chap-
ter 5 Initialize
To cancel the data transfer mode,
click on the  icon.

(2) Select the [Transfer] menu - [Send] command, or
click on the  icon.
If the currently open Project File has not been prepared
for data transfer (the Project File has not been compiled),
then the system automatically compiles the Project File
before transferring it to the GP unit.
To transfer a screen to the GP unit for the first time, set
up the GP unit*1 first, and then transfer the screen data.
The number of screens transferred is displayed in [Trans-
fer Status].
If the Deveice/PLC type of a screen or Project File to be
transferred is different from the GP's existing internal
screen type, the following message will appear.  When
you click on the  button, the system starts setup
operation, and then transfers the screen data.

If the currently open Project File
has not yet been saved in stop (1),
the system will ask you to do so be-
fore registering a password. Select

 to save, or  to
not save.

*1 “GP setup” means to download the system program and protocol program from GP-
PRO/PB III to the GP unit so that the GP unit can operate in the specified environment.

(1) Via the Project Manager, select the [Project] menu -

[Transfer] command, or click on the 
icon. Otherwise, via the Screen Editor, select the
[Screen] menu - [Transfer] command, or click on the

 icon.

Also, if the currently edited screen
has not been saved via the Screen
Editor, a prompt will appear ask-
ing if screen data is saved before
transfer.

After set up is completed, the GP panel screen is auto-
matically switched to the OFF-LINE mode. Confirm the
initial setting on the GP panel, and adjust the settings as
required.
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7.2 Transferring Screens

(3) After screen data transfer is completed, select the
[Transfer] menu - [Exit] command, or click on the

 icon.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

To cancel data transfer mode, click
on the  icon.

If you enter an incorrect password
three times or more, data transfer can-
not be performed. In this case, repeat
the transfer procedure from step (2).

(4) After screen data transfer is completed, select the
[Transfer] menu - [Exit] command, or click on the

 icon.

(2) Select the [Transfer] menu - [Send] command, or
click on the   icon.

(1) Via the Project Manager, select the [Project] menu -

[Transfer] command, or click on the 
icon. Or, via the Screen Editor, select the [Screen]
menu - [Transfer] command, or click on the   icon.
icon.

����� Transferring a Screen Using a Password
If a password has been registered, you must enter it to transfer data to the
GP unit.

 When you transfer a
screen to a GP unit with a
SRAM, backup data will be de-
leted.

Data transfer mode will automati-
cally quit when the GP unit’s inter-
nal memory capacity becomes in-
sufficient.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(3) Enter the registered password, and click on the
 button to confirm it.

The data transfer operation will start.
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7.2 Transferring Screens

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

 7.2.6 When Receiving Data From the GP

(3)When a password has been registered, enter it and
click on the  button.

(2)Select the [Transfer] menu - [Receive] command, or click
on the  icon.

(1)Via the Project Manager, select the [Project] menu -

[Transfer] command, or click on the 
icon. Or, via the Screen Editor, select the [Screen]
menu - [Transfer] command, or click on the  icon.

Screen data stored in the GP unit can be received on a project file basis by
the GP-PRO/PB III.
To receive transferred screen data with the password registered, password
entry is required when receiving the data.

· When screen data is created via the GP-377, GP77R or GP-2000
Series' Project File with a data transmission speed of 115.2
Kbps or 57,600 bps and received from the above-mentioned GP
unit and transferred to another GP unit other than the above-
mentioned, this speed is automatically changed to 38,400 bps.
Therefore, set the device's data transmission speed to 38,400
bps.

· When sending data from the GP to GP-PRO/PBIII, be sure to
select "Upload Information" in the [Transfer Settings] dialog
box before sending the project file to the GP.

When a password has not been reg-
istered, skip step (3).
If you enter an incorrect password
three times or more, data transfer can-
not be performed. In this case, repeat
the transfer procedure from step (2).
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PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(5)After the data transfer is completed, select the [Trans-
fer] menu - [Exit] command, or click on the  icon.

(4)Specify a location (directory) and Project file to store
the received data. Then, click on the  but-
ton.
If the same Project File name already exists, the system
asks if you wish to replace it; if so, select  ,
otherwise select  .

To cancel data transfer mode, click
on the  icon.
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7.2 Transferring Screens

 7.2.7 Sending/Receiving Dictionary File
This feature allows you to create, send and receive a dictionary file used in a
Japanese FEP. This feature is available only with the GP2000 series.
Receiving and sending via Ethernet is also available.

����� Creating a Dictionary File
Select [Create Dictionary] from the [Transfer] menu to create a dictionary.

The dictionary created (about 500KB) is written into the CF Card output
folder. If a dictionary file already exists on the CF Card output folder, the
following dialog box appears asking whether the existing file should be
overwritten

����� Sending a Dictionary File
Select [Send Dictionary] from the [Transfer] menu to create and send a
dictionary file to the CF Card attached to the GP unit.

The dictionary created is written into the CF Card output folder before it is
sent. If a dictionary file already exists on the CF Card output folder, the
following dialog box appears asking whether a new dictionary should be
created.

Note:
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����� Receiving a Dictionary File
Select [Receive Dictionary] from the [Transfer] menu to load a dictionary
file from the CF Card attached to the GP unit. The received dictionary file is
loaded to the CF Card output folder. If a dictionary file already exists on the
CF Card output folder, the following dialog box appears asking whether the
existing file should be overwritten.

• The Receive Dictionary feature enables other GP units to use a specific
dictionary file in which the list of candidates for kanji-kana conversion is
sorted by the order of frequency of usage according to a learning function.

• The learning function uses the backup SRAM. Up to 1KB (about 100
words) of backup SRAM is available. If the allotted 1KB is exceeded, the
data are deleted starting with the least-recently used data.

Note:

 7.2.8 Start GP-Web Compiler

Usage Pattern

[Transfer] →→→→→

→→→→→

→→→→→

This feature prepares for the transfer of a Project file and activates the GP-
Web Compiler.

To operate the GP-Web Compiler:

GP-Web Operation Manual

[Start GP-Web
Compiler]

Prepare
to transfer

or

The GP-Web Compiler
starts working
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7.3 Options

Usage Pattern

7.3 Options

Click on the

button.

Select a
desired
item.

[Option][Transfer]

or

Click on .

[Project
Manger] →→→→→ →→→→→→→→→→→→→→→

 7.3.1 GP Internal Screen Data Information

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(2)After confirming the displayed information, click on
the    button to close the screen list.
[Upload Information]: .. Indicates if the upload infor-
mation has been transferred to the GP unit or not.
[Device Monitor Information Exists]: ...... Indicates
if the device monitor function has been registered or
not.

(1)Select the [Options] menu - [Screens List] command.
Screens of the current project will be listed.

Internal information from the GP will be displayed. Functions such as
[Screen List], [Memory Info], [GP Version], [Compare List] and [Upload
Stored Data of CF Card] are available.

����� List Screens
The screen name, data volume and title of the screens stored in the GP unit
are listed by screen type.

In addition to transferring/receiving screen data, you can check the screen
information on the connected GP Unit using the GP-PRO/PB III program.
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Number of banks provided in each
GP model:

GP-H70: 16 banks
GP-270:   4 banks
GP-370: 16 banks
GP-470: 16 banks
GP-570: 16 banks
GP-571: 48 banks
GP-675: 32 banks
GP-870: 16 banks
GP-377: 16 banks
GP77R:  32 banks
GP-2301H: 16 banks
GP-2401H: 32 banks
GP-2300:  32 banks
GP-2301:  16 banks
GP-2400:  64 banks
GP-2401:  32 banks
GP-2500:  64 banks
GP-2501:  32 banks
GP-2600:  64 banks
GP-2601:  64 banks

(The capacity for each bank is
59526 bytes.)

A single screen file cannot be stored
in several banks.  Therefore, the
sum of the remaining memory ca-
pacity for each bank is not always
equal to the transferrable screen
data volume.

(2)After confirming the displayed information, click on
the  button to close the memory informa-
tion window.
[Max Available] ............Displays the GP unit’s allow-
able memory capacity.
[Used] ............................Displays the data volume cur-
rently used in the GP unit.
[Free] .............................Displays the amount of “free”,
or remaining memory.
[Available on CF Card] ... Shows the remaining ca-
pacity of the CF card.

(1)Select the [Options] menu - [Memory Info] command.
The receiving of memory information begins.

�����Memory Information
The GP unit’s current memory capacity for each bank is displayed. Its maximum
internal memory capacity is also displayed.
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7.3 Options

����� GP Version
The GP unit’s version is displayed.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Select the [Options] menu - [GP Version] command.
The receiving of the version information begins.

(2)After confirming the displayed information, click on
the  button to quit.

����� Compare List
When the project file (*.prw) currently selected with the PC is transferred to the GP,
the transferred file and the file already in the GP are compared to find any differ-
ences.

• When transferring a project file to the GP, be sure to transfer the upload
information as well.

Note:

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Select the [Options] menu - [Compare List] com-
mand.
Receive the data to be compared.

(2)After confirming the information displayed, click on
the  button to close the comparison screen
To save the comparison result, you can output the data
as a text file (*.txt).
Click on the  button.

  When the comparison operation
  yields  no results, the message “No
  differences found” will be displayed.

   Differences will arise in the follow
   ing situations:

    •  When the project files to be
 compared are different.

    •   When the GP unit and PC have
 the same screen number but dif-
 ferent screen contents.

    • When the screen exists only for
the GP unit or the PC.
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To save the comparison data, designate the location
and file name and click on the  button.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S
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7.3 Options

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Select the [Options] menu - [Upload Stored Data of
CF Card] command.
The files stored on the GP unit’s CF card will be listed.

����� Receiving CF Card Data
Data (*.CSV) stored on a GP’s CF Card such as alarms, trend graphs, sampled data,
and logged data, can be read into your PC by GP-PRO/PBIII for Windows and then
used in Microsoft Excel.

• This feature is supported only by the GP77R and GP2000 series.
With GP77R series units, this feature requires the optional Multi
Unit (sold separately).

• The data-transferring CSV files (ZR*****.CSV) cannot be re-
ceived.

(2)Select data to be uploaded to your PC and click on
the   button.

Tag Reference Manual, 4.7 Using the  CF Card
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7.4 Setting Up Your GP via an Ethernet Network

The 2-Way driver program is pre-installed in the GP2000 (except GP-2501/
2601), which allows you to both set up your GP and transfer GP Screens.
GP2000 series units also allow you set up a completely new GP from the
GP’s Intial Start Mode screen.

Setup via the Initial Start Mode screen is available only with the
GP2000 series (except the GP-2501/2601 Series).

• An optional Ethernet Interface (sold separately) is required to connect the
GP-2501/2601 Series to an Ethernet network.

• The GP2000H, GP-2301 and GP-2401 series cannot be connected to an
Ethernet network.

����� System Design

7.4    Setting Up Your GP via an Ethernet Network

•  Be sure to enter your GP’s Ethernet setting information (IP
address, Port number) prior to using the Ethernet network.

• When the default IP address is used, it is not necessary to set
up an IP address.   7.4.1 Data Transfer Using the
Factory-set IP Address (The GP-2501/2601 series cannot transmit
with the default IP address.)

•  If both GP2000 series units and GP70/77R units are used
together on the same Ethernet network, even though GP2000
Series units can be set up via this network, GP70/77R Series
units (with the Memory Link communication protocol or the 2-
Way Driver installed) can only receive GP-PRO/PBIII project
screen data.

The GP-2000 series allows screen transfers via Ethernet regardless of the
Device/PLC type. (Depending on the type of Device/PLC used, screen trans-
fers via Ethernet may not be available with the GP-2501/2601.) However, if
the GP is not set up for Ethernet network data transfer, this feature cannot be
used. If  an Ethernet network cannot be used, connect the separately sold GP
transfer cable (GPW-CB02, GPW-CB03) to transfer your data.

Ethernet

~ ~
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7.4 Setting Up Your GP via an Ethernet Network

����� Factory Settings
The following “Initial Start Mode” screens will appear when you first connect the
GP’s power cord. (The following screen is displayed only on the GP2000 series.
A stock GP-2501/2601 does not allow Ethernet settings to be designated. GP-
2301H, GP-2401H , GP-2301 and GP-2401 Series can not be connected to the
Ethernet.)

If you do not wish to use an Ethernet network for data transfer, you do not
need to set up the Ethernet information settings. You can set up  your new GP
from GP-PRO/PBIII via the GP’s separately sold data transfer cable (GPW-
CB02, GPW-CB03).

When you first set up your GP, you need to use the GP-PRO/
PBIII Transfer area transfer setting screen’s  “Automatic Setup”
feature. However, if you select “Do NOT perform Setup”, the
GP’s system data will not be sent from GP-PRO/PBIII and the
GP’s Initial Start Mode screen will appear again.

 For details about Ethernet settings, refer to your GP2000
Series unit’s User Manual.

Display for
E n g l i s h
mode users

Touch here to
call up the
ETHERNET
SETUP screen

If you touch the “Ethernet Setup” button, the following screen will appear. You
can use this screen to enter your Ethernet settings (IP address, Port number, etc.)

Touch here to enter your
settings and return to the
Initial Start Mode screen
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7.4 Setting Up Your GP via an Ethernet Network

����� Transfer Settings
After you have completed entering your GP’s Ethernet settings, use the GP-PRO/PBIII
“Transfer” area settings dialog box to designate the data transmission method.

(2) Select [Setup] menu’s [Setup] from the [Transfer]
screen, or click on  , and the following [Trans-
fer Settings] screen will appear. Designate all
necessary settings.

(1) Select [Transfer] from the Project Manager’s

[Project] window, or click on . (You can
also select [Transfer] from the Drawing Board
screen’s [Screen] menu or click on .) The [Trans-
fer] screen will appear.

PROCEDURE REMARKS

(3) Next, select [Send] from the [Transfer] menu, or click
on  to start data transfer.

Select either
Ethernet, or
Ethernet Auto
Acquisition.

Select a setup
type and CFG
file

For details on the "Setup" type:
7.2.1 Transfer

Settings �����Set up

When designating the destination
GP unit, both the Ethernet (send
to a single GP), and the Ethernet
Auto Acquisition (send to all GP
units on the network) features can
be used.
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7.4 Setting Up Your GP via an Ethernet Network

(4) Select the IP address of the GP you wish to trans-

fer data to, and click on  .

Next, the [Node List/Send screens] dialog box will ap-
pear. Here you can see the IP addresses of all GPs con-
nected to the network.

When receiving data, only one ad-
dress can be selected.
The [Node list/Send screens] win-
dow only lists the GPs which cor-
respond to the subnet masks of  the
PCs used for data transfer.
When the Network Project file set
using Pro-Server with Pro-Studio is
sent to the GP unit, the names of
the participating nodes are dis-
played. For detailed information,
see the Pro-Server with Pro-Studio
Operation Manual.

REMARKSPROCEDURE

Searches for the
currently desig-
nated GP

Click on  
and the [Network Data Search] dia-
log box will appear. This dialog box
allows you to search for a specific
GP using the GP’s IP address. The
result will be displayed on the [Node
List/Send screens] dialog box. If you
do not change the current search con-
dition, this feature will automatically
search using the current data. There-
fore, be sure when using this feature
that the current search condition is
the one that is actually desired.

Refer to the example and enter
numerical values in the IP
Address field. When the address
is designated with characters
other than numerals (text, etc.),
the entry from the beginning of
the invalid entry to the end of
the IP address is recognized as
"0".
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7.4 Setting Up Your GP via an Ethernet Network

 7.4.1 Data Transfer Using the Factory-set IP Address

The default IP address of the GP is set at the factory for high-speed transfers
of setups and screens via Ethernet.

• This function is available only with GP2000 (except GP-
2301H, GP-2401H, GP-2301, GP-2401, GP-2501 and GP-2601)
Series units.

The IP address of the GP unit is factory-configured. The IP address is used
when the IP address/Subnet Mask setup on the GP is "0.0.0.0".

Requirements for the use of the factory-set IP address

• Be sure to set the TCP/IP data (IP address should be set from
10.255.255.1 to 10.255.255.254) and the subnet mask
(255.0.0.0) of a PC that is running GP-PRO/PB III for Windows,
and where Ethernet screen transfer will be performed. Also,
some PCs must be rebooted for the TCP/IP setting to be
activated.

• When the GP unit’s IP address and subnet mask are set (an
S200 file is generated), the TCP/IP data (IP address and
subnet mask) used by the PC should be the same.

• Do not use the factory-set IP address when a private address
(010.xxx.xxx.xxx) is used on the same network. Otherwise, a
network communication error may occur.

IP address / subnet mask IP Settings Used
If set to 0.0.0.0 Factory set IP address

any other IP address IP address set up arbitrarily

When designating “Ethernet
Auto Acquisition” in the envi-
ronment using more than two
LAN cards, the target GP cannot
be explored because OS ex-
plores GP connected to the LAN
card that OS firstly finds.  Please
designate “Ethernet” in [Trans-
fer Settings] dialogbox, enter the
GP’s IP Address directly, then
transfer the data.

REMARKSPROCEDURE
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7.4 Setting Up Your GP via an Ethernet Network

Click on the "Send" icon and GP-PRO/PBIII will search for the IP addresses
of the GP units connected to the network. If a GP unit is connected to the
Ethernet network and the user has not yet entered IP address settings for that
unit, that unit's factory-set IP address will be used, and that address will
appear in the "Node List" shown below. Next, use the standard steps to
transfer data to the desired GP unit.

The following "Node List" shows the result of a search. In this case, the GP
unit found has no user-designated IP address settings and the factory-set IP
address is listed.



efore transferring screen data to the GP unit and connecting the GP
unit to the device, you can check the GP panel operation by running

a  simulation of your GP-PRO/PB III for Windows program.

This chapter describes the program simulation procedure.

  8      SIMULATION

B

8.1 ........................................................................ Overview
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8.1 Overview

 8.1        Overview
Connect the GP unit to your personal computer via the transfer cable. Turn
ON/OFF bits on the GP-PRO/PB III program’s Simulation screen, and
change the data corresponding to the specified word address. This enables
you to check the operation in the GP unit and the data changes resulting
from the Tag and Part functions. In addition, the Snapshot function allows
GP screens to be saved in JPEG format to the GP/GLC unit’s CF Card .

8.1.5 Snapshot Function

The Simulation feature is provided for simulating device opera-
tions on a PC. Since this is only a simulation, its performance
may differ from when the GP is connected to a Device/PLC.
Connecting method is the same as that for data transfer.

 7.1 Prior to Transferring Date
The Simulation function can be used through the screen transfer cable that
connects the PC and the GP unit, or through the Ethernet. (
8.1.4 Simulation (Ethernet ))

� Precautions

When using the Simulation function keep in mind the following restrictions:

• To carry out a simulation, you need to transfer screen data and a simula-
tion protocol, and create simulation data in advance.

• The Simulation function is only intended for a “1:1” connection between
the GP unit and your personal computer. When your personal computer is
connected to more than one GP unit (“n:1”, multi-link), the simulation
cannot be performed.

• When the Device/PLC type is specified as “Memory Link SIO Type” or
“Memory Link Ethernet Type”, or “CC-Link Type”, the simulation
cannot be performed.
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• When the display address for the E-Tag or K-Tag is indirectly specified
(“Indirect” is selected for the [Data Format] tab) and “Area subsequent to
the display address” is specified as the indirectly-specified area, the
simulation cannot be performed.

• The simulation cannot be performed for the device specified in [GP
System Settings] (n:1 communication information, Watchdog, Video
Control Area, Alarm Trigger Count, Extended memory device of Hitachi
HIDIC SIO α, etc.)

• The simulation cannot be performed for any address greater than 32,768
(8000h). To perform a simulation for such an address, temporarily change
the address to 32,767 or lower.

• The GP unit’s device monitor feature cannot be used.

• Do not press any touch panel switch on the GP unit before the simulation
has begun; and, do not change the screen on the GP panel. Otherwise, a
system error will occur.

• If the backup function for the LS area is selected, or if a D-Script, W-tag,
etc. uses an LS area special relay for its start bit, no LS device can be
simulated.

• If the LS device is frequently written using the D-script during the LS
device simulation, actions such as a slide transition will be slow.

• The LS device used with the Extended SIO Script cannot be simulated.

• When performing simulation on GP-377 series, GP77R series or GP2000
series, DO NOT specify [GP System Settings] - [Extended Settings] tab -
[Reset GP On Data Write Error].

• When using Yamatake's SDC Series Device/PLC, deselect [GP Settings]
- [Extended Settings] tab - [System Area Settings].

• When using GP77R series or GP2000 series and Mitsubishi Electric's
CPU direct connection type Device/PLC (such as Mitsubishi MELSEC-
AnA (CPU)), with the GP offline mode's [Setup Operating Environment]
- [Built-in] selected, the simulation function cannot be used. Select
[Adapter] or [Direct] and then perform simulation.

• The LS device simulation is only effective for GP-377 series, GP77R
series and GP2000 series.

• The Simulation function can be used only when the LT is Type-C.

• Simulations of logic program's variables (Logic symbol) cannot be
performed.

• The operation of the device connected to the Tool Connector cannot be
monitored even when executing Simulation using the Ethernet or USB.
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8.1 Overview

 8.1.1 General Description of the Simulation Screen

General description of the Simulation screen:

To perform a simulation, first transfer the screen data created with the GP-
PRO/PB III program and the “simulation protocol” to the GP unit.

  7.2 Transferring Screens

Designate the System Area settings before using the Simulation function.

Click  and select the [Extended Settings] tab.  Click on the
right side “System Area...” button and specify the "Current Screen No."
and "Chg.scr. (Change To Screen No.)" fields.

Enter the Base Screen number
where device information is to
be displayed

Changes the
system status

Changes the
device status

Displays the current
status of the system

Blinks while
the simula-
tion is being
executed

Starts/Stops
the simulation

Displays negative values
with a minus sign

Selects the format of the
display and input data

Select which to screen to be
displayed on the GP panel
during the simulation

Displays the
device informa-
tion of Tags and
Parts placed on
each screen

Select a function to dis-
play device information.

    Usage Pattern

����� Chg. Scr.
When the  check box is marked, the GP panel screen is changed accord-
ing to the Simulation screen. When this check box is  , the GP’s screen
can be separately changed, independent of the Simulation screen.

Click on the

 button to
quit the
simulation.

Click on the

 button
to stop the
simulation.

Click on the

 button
to start the
simulation.

[Simulation][Project] →→→→→→→→→→→→→→→→→→→→
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8.1 Overview

����� Displayed Function Selection
The function used to display the simulation can be changed. In addition to
the settings of each screen, the devices show in the following figure that
have been set with the screen-independent global functions can slso be
displayed.

����� Format
The data format of the device status (displayed in the “Status” cell) and the
device data (displayed in the “Change” cell) can be selected for  “Dec”
(decimal), “Hex” (hexadecimal), or “Oct” (octadecimal) format.

����� +/−+/−+/−+/−+/−
Marking the “+/−” check box adds a “- (minus)” sign to the displayed
values, if the word address settings displayed in the “Status” cell are nega-
tive values.

����� Tag Name/Comment
The Tag name (or ID number of a Part) or any comment is displayed. To
switch the Tag name or comment display mode, select [Tag Name] or
[Comment] from the [View] menu.

����� Function
A general description of the device function for each specified Tag or Part is
displayed.

����� Address
The device specified for each Tag or Part is displayed and you can change
their word address settings.

����� Status
The current status of each device (bit ON/OFF status or word address
setting) is displayed, and you can change their word address settings.

����� Alter
You can change each device status (bit ON/OFF) or the word address set-
tings.
Every time you click on the  icon, the bit ON/OFF status is switched.
When you click on the  icon, the following Keypad will appear, en-
abling you to change the data.
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8.1 Overview

����� Area
The current status (settings) of the GP unit’ system data area is displayed,
and you can change these settings by  directly entering new data.

����� Selecting a Display Type
Select the types of Tags and Parts used to display device information.
Select the [Options] menu - [Display Type Settings] command.

Specify the Tags and Parts to be displayed.
When you select “All Type”, information on all Tags and Parts will be
displayed.

����� No.
You can change the status (settings) of the system data when you click on
the  icon. A Keypad will appear, enabling you to enter desired number
changes.
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8.1 Overview

�����Movement Settings
If your GP unit type is a GP-377, GP-7R or GP2000 series unit, LS devices
can also be simulated in the range from LS0020 to LS2031 (excluding the
read-in area) and LS2096 to LS4095 (LS2096 to LS8191 for GP-2000 series
unit). Select the [Movement Settings] command from the [Option] menu.

If  the [LS Device] check box is marked, the tags and parts that use LS
devices will be displayed when a simulation is executed.

����� Setting up the Device Memory
Even after the simulation function has been closed, device information can
be saved to the Project File.
Select the [Options] menu - [Device Memory Settings] command.

When the “Backup” check box is marked  , device information is auto-
matically saved when the simulation function is quit. When the simulation
starts up again, the same device status will be displayed.
Clicking on the  button resets all device settings to “0”.

To use the Snapshot function, enable "LS Device Simulation" by
checking the check box.

8.1.5 Snapshot Function
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����� Address Registration
Simulation can be performed for any registered address, not for each screen
or function.
The simulation result is displayed by selecting the registered address from
the display function pull-down list's [Address Registration].
To register/edit an address, select the [Simulation] menu - [Address Regis-
tration] command.

����� Adding a registered address
You can add a new address. Click on the  button, and the following
dialog box will appear. Then, enter an address and the number of addresses
to be added, and specify Bit or Word.

After entering a number of addresses to be added, addresses are added from
the designated number in series.

You can enter a desired name as a function name with up to 20 half-sized
characters.

����� Editing a registered address
You can change the registered address settings. Select an address to be
edited and click on the  button. Then, a dialog box that is the same
as for the adding of a registered address will appear.

The address to be entered varies depending on your GP and PLC type. Note
that the sample screen in this manual is just one example.



8-9

Chapter 8 - Simulation

GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

8.1 Overview

����� Deleting a registered address
You can delete a registered address. Select an address to be deleted and click
on the  button. Then, a dialog box will appear to confirm the
command. If you execute the delete command, click on the  but-

ton, and if you cancel it, click on the  button.

����� Copying and pasting a registered address
Select an address to be copied and click on the  button. Then, click

on the  button to add the copied address at the end of the list.
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8.1 Overview

To simulate the GP panel’s actual operation using the GP-PRO/PB III
program, transfer the screen data created with the GP-PRO/PB III program
along with the “simulation protocol” to the GP unit.

  7.2 Transferring Screens

����� Simulation Protocol
Before executing the simulation, you must first transfer the simulation
protocol to the GP unit, regardless of the Device/PLC type specified for the
project file.
Check the “Use Extended Program” area’s “Simulation” Check Box in the
[Transfer Settings] dialog box so that when screens are transferred, the
simulation protocol will be transferred to the GP unit.

  7.2.1 Transfer Settings

 8.1.2 Transferring Simulation Protocol

→→→→→

→→→→→

    Usage Pattern

Click on the  icon
to transfer the screen
data and simulation
protocol to the GP
unit.

Compile the Project
File with the GP-PRO/
PB III program so that
it is formatted for the
GP unit used for the
simulation.

[Prepare][Transfer]

Check  the
“Use Extended
Program”area’s
“Simulation”
Check Box.

[Transfer
Settings]

[Setup][Transfer]

→→→→→→→→→→→→→→→

→→→→→→→→→→→→→→→[Project Manager]
or or

If you are using a GP70 Series unit, normal communi-
cations with the device cannot be carried out with the
simulation protocol. To re-establish the link with the
device after executing a simulation, be sure to send the
GP Unit communication protocol for the device type,
and then re-set the GP unit.
• When a simulation is executed with the GP77R series or GP2000

series, you need to transfer the simulation protocol only for the
first screen transfer.

 • If you are using a GP other than GP77R or GP2000 Series unit,
“Set Up Operation Surroundings” in the GP unit’s PLC setup
menu cannot be used while the simulation protocol is trans-
ferred.

Click on . Click on .
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8.1 Overview

 8.1.3 Performing a Simulation

To perform a simulation, first connect the GP unit to your personal computer
using the Data Transfer Cable.

  Before performing a simulation, you must transfer the
simulation protocol to the GP unit.

    8.1.2 Transferring Simulation Protocol

 8.1.1 General
Description of the Simulation
Screen

During communication, the 
icon blinks, like this  .

Prior to starting simulation, set the
GP unit to the RUN mode.

If the simulation protocol has not
been transferred to the GP unit in
step (1), the following dialog box
will appear, and the simulation can-
not be started.

You can check the GP panel operation by switching
screens or changing the device settings using the 
or  icon displayed in the [Alter] cell. Also, you can
check the device status changes via the GP’s touch keys.

Connect the GP unit to your personal computer with the
Data Transfer Cable.

1) Via the Project Manager, select the [Project] menu -

[Simulation] command, or click on the 
icon.

2) Click on the  button to begin communication with
the GP unit.
The device information on the current GP panel screen
is displayed.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

Personal Computer (PC)

To the Tool Connector

GPGP screen transfer cable

To the PC’s
serial port

����� Performing a Simulation
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8.1 Overview

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

Simulation protocol cannot
be used for normal commu-
nication with a device. To re-
establish the link with the
Device/PLC after executing a
simulation, be sure to send
the GP Unit communication
protocol for the Device/PLC
type, and then re-set the GP
unit.
When using a GP77R or
GP2000 series unit, you do
not need to set up your GP
unit again.

3) Click on the  button to quit the simulation.

4) Click on the  button to quit the simulation mode.
With the GP70 series, when you quit the simulation
mode, the system asks if you wish to again set up the GP
unit for communication with the device.
If you select  , the system will set up the GP
Unit. If you select  , the system returns to the
Project Manager without setting up the GP Unit.

During simulation, screen data can-

not be transferred. Click on the 
icon and stop simulation before
transferring screen data.
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8.1 Overview

 8.1.4 Simulation (Ethernet)

����� Simulation via an Ethernet Network
Only GP2000 Series units can use this function.

• Using the function with the GP-2501 and GP-2601 requires a large-scale

Multi Unit E or a GP Ethernet Interface unit.

• The GP-2301H, GP-2401H, GP-2301 and GP-2401 cannot be connected to
an Ethernet network.

The simulation function using Ethernet provides the same level of function-
ality as when using the data transfer cable. The limitations for this feature
are the same as for the transfer cable.

• To perform a simulation, download the screen data and the
special simulation protocol to the GP via the Ethernet network.

• Simulations via Ethernet and the transfer cable cannot be
performed simultaneously.

•  LS device simulation can be also performed.
• When using the simulation function, do not transfer screens to

the GP.

 You can also perform a simulation connecting the GP and your PC (running
GP-PRO/PBIII) via an Ethernet network.
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8.1 Overview

COM: Via serial port
Ethernet: Via Ethernet

����� Transfer Setting Dialog Box
Whether the simulation is performed through the serial port or through
Ethernet is determined in the transfer setting dialog box in the [Transfer
Screen].

����� Selecting the GP

To begin the simulation, click on the  icon, or select the Simula-
tion feature from the [Project] pull-down  menu. When the start button is
clicked, the connected GPs will be listed.

• The simulated communication via Ethernet can be performed with only one
GP selected from the node list.

• Multiple GPs cannot be selected in the node list.
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8.1 Overview

• If you stop the simulation and then click the [Start] button again, the node
list will be displayed again.

• While the simulation is being performed, the target GP cannot be changed.

• To use the factory-set IP address, the IP address and the subnet mask in the
PC should be changed.

Click on the start button to begin searching for all GPs connected to
the Ethernet network. All connected GPs will be appear in the node
list.

After you select a GP from
the list and click the Start
button, the node list dialog
box will close and the simu-
lation screen will appear.
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8.1 Overview

 8.1.5 Snapshot Function

This feature allows Simulation screens of the GP to be written onto a CF
Card in JPEG file format with the ease of taking a snapshot.

• A CF Card is required to use the Snapshot function.
• This function is available only with the GP2000 series.

����� Performing a Snapshot Function

 8.1.3 Performing
a Simulation
Enable "LS Device Simulation" in
the Movement Settings.

 8.1.1 General
Description of the Simulation
Screen ����� Movement Settings

(1)Perform a simulation.

(2)When the screen to be simulated is displayed on the
GP screen, select [Snapshot] from the [Simulation]
menu on the "Simulation" screen or click  on
your PC screen (GP-PRO/PB III).
The JPEG file captured with the snapshot function is
automatically stored on the CF Card attached to the GP
unit. The complete operation takes five or six seconds.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

����� JPEG File Name
JPEG files are automatically assigned a file name according to a numerical
sequence. The file name of a saved JPEG file will be
"\CAPTURE\CPXXXXX.JPG" (XXXXX is a number from 0 to 65535,
assigned sequentially). The number is automatically incremented by one
(XXXXX) from the largest file number existing on the CF Card. The Snap-
shot function is disabled when the number sequence exceeds "65535" or the
free space on the CF Card is insufficient.

����� Reverse Black & White
When the "Reverse Black & White" feature is enabled under the Screen
Capture function (  Tag Reference Manual, 4.7.10 Screen
Capture), black and white are reversed in the snapshot image of the simula-
tion.   Tag Reference Manual, 4.7.10 ����� Black/White
Reverse
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����� Snapshot Errors
The following error messages are displayed on your PC when CF Card
errors occur during the Snapshot operation. If a warning is displayed, no
JPEG file is created on the CF Card.

Error Message  Error Conditions

No CF Card is inserted in the GP. -No CF Card is inserted.
-The CF Card cover is not completely closed.

The snapshot cannot be written to the
CF Card inserted in the GP.

-Insufficient free space remains on the CF Card.
-The CF Card was removed while data was being saved.

Invalid CF Card is inserted in the GP. -An operation failure has been detected with the CF Card,
or the CF Card is unformatted.
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   9 PRINTING

printed copy of created screens and Tag designation status is often
useful when debugging. This chapter describes the printing proce-

dure and print settings.
A

 9.1 ................................................................. Print Settings

 9.2 ................................................. Sample Printer Output
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9.1 Print Settings

• The printing setting information can be saved by clicking on the 
button.

• The printing orientation is “Vertical” (Portrait).

• Only “A3”, “B4”, or “A4” paper can be used for printing.

 9.1 Print Settings

    Usage Pattern

Click on the
 button to

start printing.

Specify the printing
range, depending on
the selected function.

Select the data to
be printed from
the dialog box.

Select the
appropriate items
in the dialog box.

 [Print]Project
Manager

→→→→→→→→→→

→→→→→→→→→→→→→→→

When you select the [Project] menu - [Print] command, the [Print] screen
will be displayed.

����� Printing - [Print] Tab
Specify the printer type and other print settings on your personal computer.
Only Windows-compatible printers that can be connected to your personal
computer can be used to print with GP-PRO/PBIII for Windows.

This section describes the procedure for printing created screens or a list of
specified Tags, and options available when printing.

or
click on

 9.1.1 Printing

Displays the
printer name
specified on your
personal com-
puter

Click on this
button to display
the Cover Page
dialog box

Click on this button
to display the
[Options] dialog
box

Enter the number
of copies to be
printed; the
default setting is
1

If this box is
checked, instead
of printing a
hard-copy, the
data is saved as
a RTF text file
(***.RTF), and
can be edited
with other text
editing software

Displays the printing-related
[Property] dialog box

Comments on the
data printed can
be entered to be
printed out along
with the data. To
print comments,
check this box; to
display the
Comment Infor-
mation dialog
box, click on the
“Detail” button

A cover page with a title, company name,
date/time, name, and a bit map can be
included with the document. To print a
cover page, check this box

Select the Text
Table to be
printed.
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9.1 Print Settings

����� Options Dialog Box

Settings in the Options dialog box allow you to format the pages of the
document to be printed. You can specify the range of page numbers to be
printed, the screen color, and margin size.

����� Comment Information Dialog Box

����� Cover Page Dialog Box

Check this box to
print a title on the
cover page

Click on this button to preview the cover page
layout. When Bit-map printing is selected, the
placement of the Bit-map on the cover page can be
changed.

Enter the name
here

Check this box to
print a name on
the cover page

Check this box to
print a company
name on the
cover page

Check this box to
include a Bit-map on
the cover page

Check this box to
include the date and
time of printing on
the cover page

Enter a title or a
company name of up
to 3 lines (40 charac-
ters per line)

Enter a comment
of up to 40 lines
(80 characters
per line)

Prints the black/
white-reversed
screen color

Specify the upper,
lower, right and
left margin sizes

Enter the initial
page number to
be printed on the
first page of the
document

When printing page
numbers, specify if
the cover page is to
be numbered

Check this box to
print the page
number on each
page of the docu-
ment



9-4

Chapter 9 - Printing

GP-PRO/PB III  for Windows Ver. 7.2  Operation Manual

9.1 Print Settings

Global Setting List
Select whether to print the summary
or details of the Handy-type GP/ST
Series global settings.

Date Sampling Settings List
Select whether to print the summary or
details of the data sampling settings.

Alarm List
Select the alarm type to be printed.

����� Details
 Click on the  button to specify detailed information of printing.

����� Printing - [Project Information] Tab
You can check the created screens and Tag designation status through printer
output.

Prints a project
information
summary list

Prints the list
of settings of
the item
marked with a
check.

Displays the
currently-
selected item

Screen List
Select the screen type to be printed.
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9.1 Print Settings

Global Interlock Settings List
Select the print option from the
Overview and Details of the Global
Interlock settings.

Backlight Color Change Settings List
Select the print option from the Over-
view and Details of the Backlight Color
Change settings.

����� Printing - [Screen] Tab
Select the screen type and contents to be printed.

Select the screen
type to be printed

Displays the
currently-
selected item

Specify the
printing range by
screen numbers.
When you select
[All (A)], all
screens will be
printed.
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9.1 Print Settings

Keypad Screen
Specify the printing items related to a
Keypad screen.

Trend Graph Screen
Specify the printing items related to a
Trend Graph screen.

����� Details

Click on the  button to specify detailed information of printing.

Base Screen
Specify the printing items related to a Base Screen.

Prints a list of the
screens loaded
onto a specified
screen

When making
a screen hard
copy, The
Parts’ ON/OFF
status can be
specified. The
same status is
specified for
all screens to
be printed

Prints a list of the
Parts placed on
the Base Screen.
Select whether to
print the sum-
mary or details of
the Part list

Outputs
screen hard
copies.
The printing
items can be
specified

Prints the address designation
for Tags.
Only the “preset addresses”
can be printed
   2.9.7 Cross
Reference List

Prints the D-Script
settings

Prints a list of the
specified Tags.
Select whether to
print the sum-
mary or details of
the Tag list

When the summary of the Part list is printed, its right edge may get outside
the paper.  In this case, open the Option dialog box by clicking on 
button in the [Print] tab, and then reduce the left margin.

Select Infor-
mation
cahacter's
printing size.
When select-
ing [Small], 1/
4-sized char-
acters are
used
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9.1 Print Settings

Video Screen
Specify the printing items related to a
Video screen.

Window Screen
Specify the printing items related to a
Window screen.
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9.1 Print Settings

By selecting the [Project] menu - [Print Preview], you can preview the
screen image to be printed.

Setting items are the same as those of printing. Instead of clicking on the
 button, click on the  button.

����� Print Preview Screen

 9.1.2 Print Preview

Print date
and project
file name

Starts
printing

Previews
the next
page

Previews
the previ-
ous page

Toggles between
previewing one page
per screen and
previewing two
pages per screen

Scales up/
down the
preview

Closes the
print
preview
screen
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9.2 Sample Printer Output

 9.2 Sample Printer Output
This section provides sample printing of various data such as a created
screen or a list of specified Tags.
The following data can be printed.

����� Printing

����� Cover Page

Select whether the cover page is to be printed or not.

� Comment Information

����� Project Information

����� Summary
Prints a project summary list.

Select whether comment information is to be printed or not. Comment
informatoin is a function to add supplemental information to the printed
data. Up to 40 lines of 80 characters can be entered.
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9.2 Sample Printer Output

����� Screen List
Prints a list of the screens of a specified type.

����� Alarm List
Prints a list of the created alarms.

����� Registered Window List
Prints the window registration status.

����� GP System Setting List
Prints the GP system settings.

����� Data Sampling Setting List
Prints the data sampling settings.
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9.2 Sample Printer Output

����� Global Setting List
(Function Keys)/(Vibration)

����� Filing Data Setting List

Prints the global settings.
The vibration feature is only available on Handy-type GP2000 Series units.

Prints the Filing Data settings.

����� CSV Data Transfer List

Prints the CSV Data Transfer settings
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9.2 Sample Printer Output

����� D-Script Function List

����� Global D-Script List

����� Data Logging Settings

Prints the data logging settings.

Prints the Global D-Script settings.

Prints the D-script function settings.
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9.2 Sample Printer Output

����� Symbol List

����� Global Cross Reference List

The Symbol Editor's Symbol setting status is printed out.

The entire Project's address designation status, such as via Tags, are printed
out. This command is executed for all the screens in the Project.

����� Sound Setting List

Prints the sound settings.

�����Security Settings List
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9.2 Sample Printer Output

· Viewing or printing out the [Screen List] enables you to check the security
level set for each Base (B) and window (U) screen.  (When Security feature
is enabled.)

�����Time Schedule

�����Backlight Color Change Settings List

Prints a list of the current Backlight Color Change settings.
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9.2 Sample Printer Output

����� Screen Information

����� Loaded Screen List
Prints a list of the screens loaded onto a specified screen.

����� Tag List

Prints a list of specified Tags.

�����Global Interlock Settings List

Prints a list of the current Global Interlock settings.
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9.2 Sample Printer Output

����� Screen Hard Copy

Prints each type of screen.

����� D-Script

����� Cross Reference List

Prints the D-Script settings.

Prints the address designation for Tags. This function can be executed for
several screens.

����� Parts List

Prints a list of the Parts placed on a Base Screen.



 10 ADVANCED FEATURES

T

10.1 .................................................................Sound Output

10.2 .......................................................Filing Data (Recipe)

10.3 ........................................CSV Data Transfer Function

10.4 ........................................................................... Logging

10.5 .......................................................................... CF Card

10.6 ....... Creating/Transferring CF Memory Loader Tool

10.7 .............................................. CF Memory Loader Tool

he sound output, filing data (recipe), CSV Data Transfer function,
and logging functions are advanced features to use the GP with

even higher performance. For the detailed information about these features,
please refer to Tag Reference Manual. In addition, regarding the CF Card,
the CF Card tool used on GP-PRO/PB III is described. For CF Card usage
requirements as well as usage that is linked with other features, also refer to
Tag Reference Manual.
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This feature outputs sound data from a speaker connected to the GP by
turning ON a specified bit. Via Alarm or message sounds, information can
be sent to operators even if they are not looking at the GP screen. In addi-
tion, this feature can be used for a variety of applications such as operation
guides and multimedia information.

Tag Reference Manual, 4.1 Sound Output
Sound settings are available only with the GP-477R, GP-577R
and GP2000 series units (except the GP-2300, GP-2301, GP-2401
and GP2000H Series). Note that when using the GP-477R, GP-
577R, GP-2501 and GP-2601 series units, an optional Multi Unit
(sold separately) is required to output the sound data from the
GP unit.

10.1 Sound Output

10.2 Filing Data (Recipe)
Setting data that you have created and stored on the GP can be easily trans-
ferred to the PLC whenever necessary, using GP touch keys or by specifying
bit addresses in the PLC. Also, Filing (Recipe)Data that has been transferred
to the PLC can be then sent back to the GP, edited, and then transferred
again to the PLC.

When using the GP77R series and GP2000 series, Filing Data stored in a CF
Card can be transferred.

  Tag Reference Manual, 4.2 Filing Data (Recipe) Func-
tion

The Filing Data feature has been supported only by the GP-377
Series, GP77R series and GP2000 series. Also, to transfer Filing
Data from the CF Card by the GP77R series, the Multi Unit (sold
separately) is required.

Setting 1

Setting 2

Setting 3

GP PLC

10.1 Sound Output/10.2 Filling Data (Recipe)
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10.3 CSV Data Transfer Fnction / 10.4 Logging

The device data is loaded to the GP's backup SRAM at bit-based or time-
specified timings to display it in a tabular form on the screen or print it on
the printer.
The acquired data can also be integrated into a database so that it can be
analyzed.
Digital’s GP77R series and GP2000 series units enable you to save logged
data as a CSV file onto a CF Card. The CSV file can then be sent from the
CF Card to any PC, and its information used for a database, or displayed as
a graph for analysis.

Tag Reference Manual, 4.3 Logging Function

•  Use of the CF Card with a GP77R series unit requires the
Digital’s optional Multi Unit (sold separately).

10.4 Logging

Specific data-transfer CSV files (ZR*****.CSV) on the CF Card can be
transferred from the CF Card directly to the PLC (filing) or from the PLC
directly to the CF Card (logging). The data transfer method can be selected
as either automatic transfer or manual transfer, and two or more CSV files
can be transferred in one operation. The Data Transfer Display is used with
manual transfer. The Data Transfer Display is useful for searching files
because the file names of the data-transferring CSV files (ZR*****.CSV)
can be displayed in a list.
The Data-Transferring CSV file on the CF Card can be created and edited
with the CSV screen creation editor or general-purpose spreadsheet software
such as Microsoft Excel.

2.1.18 Data Transfer Display and the Tag Reference
Manual, 4.4 CSV Data Transfer Function/4.5 CSV Data Display Function

The CSV Data Transfer Function is available only with the
GP2000 series.

10.3 CSV Data Transfer Function
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Displays the disk capacity
and file information

Lists the
files in the
CF Card
data output
folder

CF Card data output folder CF Card drive

Lists the
files saved
on the CF
Card

10.5 CF Card
Digital’s GP77R series and GP2000 series units all allow you to use the CF
Card to store data.
The CF Card is intended primarily as an external storage device, for the
storage of CSV files and backing up GP screen data.

For detailed CF Card information, refer to the Tag Reference Manual.

Tag Reference Manual, 4.7 Using the CF Card

10.5.1 Using CF Card Tools

The use of the CF Card Tool enables you to copy data in your project’s CF
Card data output folder to the CF Card, as well as to copy data saved on the
CF Card to the project. The data that can be copied using the CF Card Tool
includes image screens, sound data, and Filing Data.

To use the CF Card Tool your PC must be equipped with a PC
card slot.

����� Overview of the CF Card Tool
When you select the [Utility] menu - [CF Card Tool] option, the CF Card
Tool is activated. The overview of the CF Card Tool is given below.
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10.5 CF Card

����� Activating the CF Card Tool
To use the CF Card, specify a drive for the CF Card on your PC.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Via the Project Manager, select the [Utility] menu -
[CF Card Tool] command.

(2)Specify a CF Card drive, and then click on the
 button.

The currently selected Project's information will be dis-
played in the left pane, and the CF Card's information
in the right pane.

To change the CF Card drive, click
on the  icon, or select the [File]
menu - [Select CF Card Folder]
command.

The information of the currently se-
lected project is displayed in the
left pane, and that of the CF Card
in the right window.

The toolbar icons have the following functions:
Selects a project Copies data to the project file

Selects a CF Card folder Copies data to the CF
Card

Information on the currently selected project is displayed
in the pane on the left, while information on the CF Card
is displayed in the pane on the right.

If any CF Card drive is already
specified, the Browse for Folder
dialog box will not be opened.
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����� Copying Data to the CF Card
The data (image screens, sound data, and Filing Data) saved in the CF Card output
folder can be copied from the project to the CF Card as follows.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Start the CF Card Tool.

(2)Select the [Edit] menu - [Project to Card] command,
or click on the  icon.

The image screen, sound data, and Filing Data in the CF
Card data output folder will be copied to the CF Card.

Select the CF Card data output
folder in advance.

 ����� Activating the
CF Card Tool

To change the CF Card drive, click
on the  icon, or select the [File]
menu - [Select CF Card Folder]
option.
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����� Copying Data to the Project
The data saved on the CF Card (image screens, sound data, and Filing Data) can be
copied to the CF Card output folder for the project as follows.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1)Activate the CF Card Tool.

(2)Select the [File] menu - [Select Project] command, or
click on the   icon.

(3)Select the project file to which the data on the CF
Card is to be copied, and then click on the 
button.

The selected Project's CF Card output folder will ap-
pear.

� Activating the
CF Card Tool
To change the CF Card drive, click
on the  icon, or select the [File]
menu - [Select CF Card Folder]
option.

10.5 CF Card
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(4)Select the [Edit] menu - [Card to Project] command,
or click on the   icon.

The image screen, sound data, Filing Data, Data-Trans-
fer CSV file, startup system, backup data, dictionary file,
and JPEG file saved to the CF Card will be copied to
the CF Card data output folder for the specified project.

The image screen, sound data, Fil-
ing Data, Data-Transferring CSV
file, startup system, backup data,
dictionary file, and JPEG file will
be copied from the CF Card to the
designated Project’s folder. Other
data (alarm data, trend graph data,
sampled data, logged data, etc.)
must be copied using Windows Ex-
plorer or other similar software.

10.5 CF Card
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10.6 Creating/Transferring CF Memory Loader Tool

10.6 Creating/Transferring CF Memory Loader Tool

10.6.1 CF Memory Loader Tool / Backup Data

����� GP-PRO/PBIII to CF Card, then to GP  (via “CF Card Tool”)

(1)

(2) (3)

GP (with CF
Card inserted)

(1) Creating backup data: Create GP backup data and “CF Memory Loader Tool”
in the CF Card Data Output Floder.

10.6.5 Creating Backup Data

(2) Copy data via “CF Card Tool”: Copy backup data in the CF Card Data Output
folder and “CF Memory Tool” to the CF Card, using GP-PRO/PBIII’s “CF
Card Tool” feature.

10.6.8 Transferring “CF Memory Loader Tool” data via CF
Card Tool

(3) Download data using “CF Memory Loader Tool”: Transfer the CF Card’s
backup data to the GP.

10.7 CF Memory Loader Tool

The total space required for using Filing Data and Image Data in
addition to the CF Memory Loader Tool and Backup Data is at
least 8 MB. The capacity of the CF Card may be insufficient.
Please use the following CF cards produced by Digital Electron-
ics Corporation when using the CF Memory Loader Tool.

CF Card

The CF Memory Loader Tool function is only available with the GP2000 Series.

Name Model Number
CF Card (64MB) CA3-CFCALL/64MB-01
CF Card (128MB) CA3-CFCALL/128MB-01
CF Card (256MB) CA3-CFCALL/256MB-01
CF Card (512MB) CA3-CFCALL/512MB-01
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(3)Create the backup data.

Select [Transfer] from the Project manager’s

[Project] window, or click on . (You can
also select [Transfer] from the Drawing Board
screen’s [Screen] menu or click on ).

Select the [Transfer] menu’s [Send system boot

data to CF Card], or click on . Backup data
will then be created in the CF Card Data Output
folder .

When the backup has been successfully completed,
the following data transfer information is displayed.

(1) Select [CF Card Output Folder] from the Project
manager's [Project].

(2)Click [Use CF Card], then select the CF Card Out-
put Folder, and click .

To create the CF Card Tool, you need
to specify a location (CF Card data
output folder).
This folder temporarily saves the
project data to save data to the CF
Card.

REMARKSPROCEDURE

In the CF Card Output Folder, CF Memory Loader
Tool and the backup data has been created.

����� Send the data from PC to a CF card

Use this feature to create “CF
Memory Loader Tool” and the GP’s
backup data (BK****.MEM) that
consists of system program data,
screen data, expantion program data
and communication protocol data.

•  The “****” code in the above
file name ” BK****.MEM”
will vary according to the GP
model.

• The file names can be
changed on the off-line
screen of the GP.

 10.7.4
Menu Screen: 5. FILE
LIST

•  If you wish to send only "CF
Memory Loader Tool"  data
to the CF Card, you do not
need to create GP backup
data. Simply use the [Send
system boot data to CF
Card] feature.

•  When the GP-PRO/PB III
is used, the backup data of
only one project can be cre-
ated on a single CF Card.
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(4) Use the CF Card Tool to copy backup data to the CF
Card.
Click on the Project Manager Utility menu's [CF
Card Tool] selection to start the CF Card Tool.

(5) Select the drive containing the CF Card and click
[OK].

REMARKSPROCEDURE

If there is backup data previously
saved in the CF Card data output
folder, the following window will
appear. If you wish to overwrite the
existing data in the CF Card with
the new backup data, select [OK].
If not, select [Cancel].

In the following screen, Project information is shown
on in the left-side pane, and CF Card information is
shown in the right-side pane.

For CF Card Tool information,
 10.5.1 Using CF

Card Tools
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(6) The project saved in the CF Card output folder is
copied to the CF Card. Use the Edit menu's [Copy
to CF Card] selection to start the copy, or click on
the  icon.

For information about downloading
Project data to a GP from the CF
Card,  10.7 CF
Memory Loader Tool

REMARKSPROCEDURE

(7) When the above dialog box disappears the copy is
finished. The Memory Loader Tool and the Project
Backup data creation is completed.
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����� GP-PRO/PBIII to GP, then to CF Card
You can use this method for data transmission when your PC is not
equipped with a CF Card I/F.

(1) Create backup data: Create GP backup data and “CF Memory Loader Tool” in
the CF Card Data Output Folder.

10.6.5 Creating Backup Data

(2) Send backup data: Send backup data and “CF Memory Loader Tool” in the CF
Card Data Output folder to the GP where the CF Card is inserted (GP “A”).

10.6.7 Sending Backup Data

When using the GP data transfer cable (GPW-CB02), it will take approximately fif-
teen minutes to complete data transmission (when the baud rate is 115.2k bps).

����� GP to CF Card, then to GP
Data can be copied from a GP to another GP unit.

(1)

(2)

GP
(with CF Card inserted)

(3)

(1)

GP B
(with CF Card inserted)

(2)

GP A
(with CF Card inserted)

CF Card

CF Card

(1) Upload data using the “CF Memory Loader Tool”.
Transfer the backup data from the active GP unit to a CF Card.

10.7 CF Memory Loader Tool

(2) Download data using “CF Memory Loader Tool”.
Download your backup data to the GP from the CF card.

10.7 CF Memory Loader Tool

You need to transfer “CF Memory Loader Tool” to the CF Card prior to
starting the program via the CF Card.
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You need to call up the GP-PRO/PBIII [Transfer] screen to enter or use the CF
Memory Loader’s settings. To do this, select [Transfer] from the Project

Manager’s (main screen’s) [Project] window, or click on the  icon.

You can also select [Transfer] from the Drawing Area screen’s [Screen] menu, or
simply click on the  icon. The following explanation describes the [Transfer]
screen’s CF Memory Loader settings.

10.6.2 CF Memory Loader Settings

����� Create system boot data of CF Card
This feature allows you to create a copy of the "CF Memory Loader Tool" in the CF Card
Data Output folder. Backup data creation, however, is NOT possible with this feature.
����� Send system boot data to CF Card

This feature allows you to download the “CF Memory Loader Tool” to your GP’s
CF Card from your GP’s CF Card Data Output folder. Backup data creation,
however, is NOT possible with this feature.
����� Create backup data

This feature allows you to create a copy of your GP backup data, as well as the
“CF Memory Loader Tool”, in the CF Card Data Output folder.
����� Create PRW file

With this function, you can convert the GP's backup data (BK****.MEM) into a
project file (.prw).
����� Send backup data

This feature allows you to download the CF Card Data Output folder’s GP backup
data and “CF Memory Loader Tool” to your CF Card.

CF Memory
Loader settings
menu
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Send system boot data of CF CardCreate backup
data

Receive backup data

Create  system
boot data of CF
Card

Send backup data

Receive  system boot
data of  CF Card

����� Receive backup data
Transfers the backup data saved in your GP’s CF Card to your PC’s GP-PRO/PBIII
software. However, the “CF Memory Loader Tool” itself cannot be transferred.

You can also select these features via the GP-PRO/PBIII Transfer Screen’s toolbar icons.

Create PRW file
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To use the “CF Memory Loader Tool”, you need to first create (prepare) the “CF
Memory Loader Tool “ (IPL.SYS, MLD****.SYS, GPBACKUP.INF) in GP-
PRO/PBIII via the “Create system boot data of CF Card” feature, and download it
to your GP’s CF Card. Then, upload the “CF Memory Loader Tool“ program data
from the CF Card to the GP. The GP can then use the “CF Memory Loader Tool”
saved on the CF Card. The following steps explain how to create the “CF Memory
Loader Tool” in GP-PRO/PBIII.

10.6.3 Creating System Boot Data for CF Card

The “****” code in the above file name “MLD****.SYS” will vary according to the
GP model.

(2) Select the [Transfer] menu’s [Create system boot
data of CF Card], or click on . The “CF
Memory Loader Tool” will then be created in the
CF Card Data Output folder.

(1) Select [Transfer] from the Project Manager’s
[Project] window, or click on  . (You can

also select [Transfer] from the Drawing Board
screen’s [Screen] menu or click on ).

If the “CF Memory Loader Tool”
is previously saved in the CF Card
data output folder, the following
window will appear. If you wish to
overwrite it with new data, click on
the [OK] button.

PROCEDURE REMARKS

GP Type GP Code GP Type GP Code
GP2301HL 2240 GP2300T 2256
GP2301HS 2242 GP2400T 2261
GP2401H 2244 GP2401T 2262
GP2300L 2252 GP2500T 2266
GP2301L 2250 GP2501T 2267
GP2500L 226F GP2600T 2276
GP2501L 226A GP2601T 2277
GP2300S 2253 GLC2300L 225A
GP2301S 2251 GLC2300T 225E
GP2301T 2254 GLC2400T 2269
GP2500S 226D GLC2500T 226E
GP2501S 2268 GLC2600T 227E

The names of files on the CF Card cannot be changed with the GP-PRO/PB
III. These files must first be downloaded to the GP, where their names can be
changed on the GP's off-line screen.

 10.7.4 Menu Screen: 5. FILE LIST
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10.6.4 Sending System Boot Data to CF Card

This feature is used when transferring the “CF Memory Loader Tool” to the CF Card.

(2) Select the [Transfer] menu’s [Send system boot

data to CF Card], or click on . The “CF
Memory Loader Tool” in the CF Card Data Out-
put folder is then downloaded to the CF Card.

(1) Select [Transfer] from the Project manager’s

[Project] window, or click on . (You can
also select [Transfer] from the Drawing Board
screen’s [Screen] menu or click on ).

If there is a “CF Memory Loader
Tool”  previously saved in the CF
Card data output folder, the follow-
ing window will appear. If you wish
to send the old (existing) “CF
Memory Loader Tool”  in the CF
Card to the CF Card, select [Sending
current file], if you wish to send the
new data, select [Sending new file].

REMARKSPROCEDURE
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(2) Select the [Transfer] menu’s [Send system boot

data to CF Card], or click on . Backup data
will then be created in the CF Card Data Output
folder .

(1) Select [Transfer] from the Project manager’s

[Project] window, or click on . (You can
also select [Transfer] from the Drawing Board
screen’s [Screen] menu or click on ).

If there is backup data previously
saved in the CF Card data output
folder, the following window will
appear. If you wish to overwrite the
existing data in the CF Card with
the new backup data, select [OK].
If not, select [Cancel].

PROCEDURE REMARKS

10.6.5 Creating Backup Data

•  The “****” code in the above file name ” BK****.MEM” will vary according to the GP
model.

•  The file names can be changed on the off-line screen of the GP.

 10.7.4 Menu Screen: 5. FILE LIST
•  If you wish to send only "CF Memory Loader Tool"  data to the CF Card, you do not need to

create GP backup data. Simply use the [Send system boot data to CF Card] feature.
•  When the GP-PRO/PB III is used, the backup data of only one project can be created on a

single CF Card.

Use this feature to create “CF Memory Loader Tool” and the GP’s backup data
(BK****.MEM) that consists of system program data, screen data, expantion
program data and communication protocol data.
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10.6.6 Creating a PRW file
A project file (.prw) can be created by converting the backup data on the GP (.MEM).

(2) Select [Create PRW File] on the [Transfer] menu
or click on 

(3) Click on the  button and select the
backup file (.MEM) to be converted.

(1) Select [Transfer] from the Project manager’s

[Project] window, or click on . (You can
also select [Transfer] from the Drawing Board
screen’s [Screen] menu or click on ).

Before creating the backup file data,
first transfer the prw file containing
the "upload information" to the GP.
If you specify a backup file (.MEM)
created without the "upload informa-
tion" and click on the 
button, no prw file will be created.
The following dialog box appears in-
stead.

REMARKSPROCEDURE

(4) Click on the  button, select the project
file (.prw) to create, and click on the 
button.

(5) Once the project file (.prw) has been properly
created, click on the  button to close the
box.

Only MEM files having file names like BK****.MEM (**** desig-
nates the GP model) can be specified as files to be converted.
Also when the file name is changed (renamed) through the CF
Memory Loader Tool, only those files whose names are changed
according to the above format can be specified as files to be
converted.
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10.6.7 Sending Backup Data
This feature allows you to send GP backup data created in the GP-PRO/
PBIII to the CF Card. There are two methods, you can use:
Method 1: Transfer backup data from GP-PRO/PBIII directly to your PC’s
CF Card.
Method 2: Transfer backup data from GP-PRO/PBIII to a GP, then from the
GP to that GP’s CF Card.
The following section explains Method 2.

(2) Select the [Transfer] menu’s [Send backup data to
CF Card], or click on . The backup data will
then be transferred from your PC to the CF Card
Data Output folder.

(1) Select [Transfer] from the Project manager’s
[Project] window, or click on . (You can

also select [Transfer] from the Drawing Board
screen’s [Screen] menu or click on ).

If the connected GP unit is not a
GP2000 Series unit, the backup data
transfer error message will appear and
the backup data cannot be transferred.
If there is backup data previously
saved in the CF Card data output
folder, the following window will
appear. If you wish to overwrite the
existing backup data in the CF Card
with the current project’s backup data,
select [OK].

PROCEDURE REMARKS

10.6.8 Receiving Backup Data
Here the CF Card’s backup data “BK****.MEM” is transferred from the GP
to GP-PRO/PBIII in your PC.  The received backup data cannot be directly
opened as a Project file. Transfer the backup data to the GP unit and load the
data from the GP unit. The received data are converted to a Project file
(*.prw).
The “****” code in the above file name ” BK****.MEM” will vary according
to the GP model.
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10.6.9 Transferring “CF Memory Loader Tool” data via CF Card Tool

(2) Select [Transfer]’s [Send system boot data to CF

Card], or click on .

(1) Select [Transfer] from the Project manager’s
[Project] window, or click on . (You can
also select [Transfer] from the Drawing Board
screen’s [Screen] menu or click on ).

If there is backup data previously
saved in the CF Card data output
folder, the following window will
appear. If you wish to overwrite the
existing data in the CF Card with
the new backup data, select [OK].
If not, select [Cancel].

REMARKSPROCEDURE

This feature allows you to confirm the type of backup data present, or copy data from
GP-PRO/PBIII to the CF Card, and also from the CF Card to the GP-PRO/PBIII.

10.5.1 Using CF Card Tools

•   If there is no "CF Memory Loader Tool" data, the CF Card
cannot be used as a system boot disk, and the boot system
data will not appear in the CF Card Tool window. Also, if there
is no backup data, it will not appear in the CF Card Tool win-
dow.

•  In order to use the CF Card Tool, your PC must be equipped
with a CF Card Slot.

If your PC is equipped with a CF Card Slot, using the CF Card Tool to
transfer data to/from the CF Card is recommended since this transfer
method takes less time than when using the GP.

Yo u  c a n
view the list
o f  f i l e s
saved in the
C F  C a r d
data output
folder here.

You can view the list
of files saved in the
CF Card here.

Here, the title of the
project file created in
the CF Card is shown.
However, when the
project file’s backup
data is created via the
CF Memory Loader
Tool, the title may not
be shown here.



10-22 GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

Chapter 10 - Advanced Features10.7 CF Memory Loader Tool

The "CF Memory Loader Tool" has the following features.
����� UPLOAD

This feature allows you to transfer all the GP’s data to the CF Card.

����� DOWNLOAD
This feature allows you to transfer the CF Card’s backup data to the GP.

����� SYSTEM DATA DISPLAY
View both the CF Card’s backup data and the GP’s data.

����� COMPARISON
Compare all GP data to the CF Card’s uploaded backup data.

����� FILE LIST
Lists the files stored on the CF Card. This feature also allows you to view the
details of the selected file or to copy, delete or rename the files on the CF Card.

      

10.7 CF Memory Loader Tool

10.7.1 About "CF Memory Loader Tool"

This feature is only available with the GP2000 Series.
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To use the "CF Memory Loader Tool", it must be previously saved to the CF Card.
Therefore, be sure to create the "CF Memory Loader Tool" on your PC with the GP-
PRO/PBIII and transfer it to your GP’s CF Card prior to using this program.

CF Card

Dip Switches
1 2 3 4

OFF

Rear of GP
Turn Switch 1 ON
(raise it)

2. GP Dip Switches: Forced Start via GP Dip Switches
You can also use the Dip Switches on the rear of the GP, next to the CF Card Slot.
If you turn ON Dip Switch No.1 (raise it) and then connect the GP’s power cord,
the "CF Memory Loader Tool" will start.

10.7.2 Starting the "CF Memory Loader Tool"
There are two methods for starting this program via the CF Card.
1. Menu Bar: Using the GP’s [CF BOOT] menu
To call up the GP’s menu screen, press point (1) , and (2) with your right hand fingers.
While holding these points, press point (3) with your left hand finger. After the menu
appears, touch the menu screen’s [CF BOOT] selection and the GP will be reset. After
it restarts, the CF card’s "CF Memory Loader Tool" screen will appear.

Menu Bar

GP Screen

(1)

(2)

(3)

You need to transfer “CF Memory Loader Tool” to the CF Card prior to
starting the program via the CF Card.
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10.7.3 MEMORY LOADER TOOL

When the Memory Loader Tool program is started, the following screen will appear.

����� UPLOAD (From GP to CF Card)
This feature is for saving all GP data (i.e. system program, communication proto-
col, expansion program, screen data and Backup SRAM data) in the CF Card.

When UPLOAD is performed, the CF Card’s current Backup Data will
be completely overwritten.

����� DOWNLOAD (From CF Card to GP)
This feature is for writing CF Card backup data to the GP’s Internal Memory.

When DOWNLOAD is performed, the GP’s Internal Memory data (i.e.
system program, communication protocol, expansion program, screen
data and Backup SRAM data) will be completely overwritten.

����� MENU
Touching this button changes to the Menu screen.

����� CLOSE
Touching this button finishes the program and resets the GP.

If you touch the CLOSE button and the GP’s rear face #1 Dip Switch is
turned ON, the "CF Memory Loader Tool" will automatically start again
when the GP starts up. Therefore, to finish the CF Memory Loader op-
eration, you need to first turn #1 Dip Switch OFF or remove the CF Card
from the GP, then touch the CLOSE button.
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(1) Touch [1 UPLOAD] on the MEMORY LOADER
TOOL MENU screen and the following screen will
appear.

Enter the password you have regis-
tered in GP-PRO/PBIII’ s [Trans-
fer] screen. If you have not regis-
tered a password, simply touch
[START], and data upload will
start.

10.7.4 Menu Screen

If you touch the [MENU] button, the following screen appears.

1.  UPLOAD (from GP to CF Card)

PROCEDURE REMARKS

[To change the backup file to be uploaded]

(2) Touch  to call up the file selection screen.
Select the backup file to be uploaded and touch

.

To cancel the file selection, touch  to return to
the UPLOAD screen.

Title

Touch this
button to
display the
system
informa-
tion of the
selected
backup
file.

Path
name

The displayed path name is limited
to 30 characters. The 31st and sub-
sequent characters are omitted.

A maximum of 50 file names can
be displayed.

Touching the column heading
(FILE NAME/DATE) sorts the dis-
played file names in ascending or-
der according to the heading se-
lected.
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(3) Return to the UPLOAD screen and enter your
password on the screen's keypad.

(4) Touch [START] and data upload will start.

[To change the folder to be uploaded]

(2) Touch  to call up the folder selection screen.

Select the folder to be uploaded and touch .

To cancel the folder selection, touch  to return
to the UPLOAD screen.

PROCEDURE REMARKS

Title

Path
name

The displayed path name is limited
to 30 characters. The 31st and sub-
sequent characters are omitted.

A maximum of 50 file names can
be displayed.

Touching the column heading
(FOLDER NAME/DATE) sorts the
displayed file names in ascending
order according to the heading se-
lected.

[When a new file is created for the upload operation]

(2) Touch  to call up the file name input screen.

Enter a file name and touch .
To cancel the file creation, touch .

Enter
a file
name.

Changes the input mode.

The displayed path name is limited
to 30 characters. The 31st and sub-
sequent characters are omitted.

The file name is limited to eight
single-byte alphanumeric charac-
ters. The file extension cannot be
modified.

The input mode can be changed in
the following order: single-byte al-
phanumeric (uppercase) → single-
byte alphanumeric (lowercase) →
numbers and symbols.

If the entered file name already ex-
ists in the CF Card, the following
message will appear to confirm the
overwrite operation.



10-27

Chapter 10 - Advanced Features

GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

10.7 CF Memory Loader Tool

• Be sure to check if the GP’s CF Card Access LED
is turned OFF prior to inserting/removing the CF
Card since there is a danger of  loss of CF Card
data

• While a CF Card is being accessed, DO NOT dis-
connect the GP power cord or reset the GP, or
insert/remove the CF Card.

����� Status 1
The message “NOW TRANSFERRING DATA PLEASE WAIT” will appear. If an
error is detected during upload, an error message will appear.

����� Status 2
UPLOAD Status information consists of the following data.
• Creating data (GP internal data)
• Read from FEPROM data (i.e. system program, communication protocol,

expansion program, screen data and Backup SRAM data)
• Read from Backup SRAM data

Each “block” in the UPLOAD Status Bar represents 64K bytes of data.

����� Status Bar
The Status Bar shows the progress of the upload.

����� RETURN
If you perform UPLOAD from the INITIALIZE screen, touching this button
returns you to the INITIALIZE screen. If you perform UPLOAD from the MENU
screen, the screen will return to the MENU screen.

����� UPLOAD Status
Once upload starts, the UPLOAD status screen will appear.

 Status 1

Status 2

Status Bar

Performing UPLOAD completely overwrites the CF Card’s current
 Backup data.
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PROCEDURE REMARKS

Enter the password you have regis-
tered in the GP-PRO/PBIII’s [Trans-
fer] screen. If you have not regis-
tered a password, simply touch
[START] and data download will
start.

2.  DOWNLOAD (from CF Card to GP)

(3) Enter your password using the screen’s keypad.

(4) Touch [START] and data download will begin.

(1) Touch [2 DOWNLOAD] on the MEMORY
LOADER TOOL MENU screen and the following
screen will appear.

The displayed path name is limited
to 30 characters. The 31st and sub-
sequent characters are omitted.

A maximum of 50 file names can
be displayed.

Touching the column heading
(FILE NAME/DATE) sorts the dis-
played file names in ascending or-
der according to the heading se-
lected.

[To change the backup file to be downloaded]

(2) Touch  to call up the file selection screen.
Select the backup file to be downloaded and touch

.
To cancel the file selection, touch  to return
to the DOWNLOAD screen

Title

Touch this
button to
display the
system
informa-
tion of the
selected
backup
file.

Path
name
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• Be sure to check if the GP’s CF Card Access LED
is urned OFF prior to inserting/removing the CF
Card since there is a danger of  loss of CF Card
data.

• While a CF Card is being accessed, DO NOT dis-
connect the GP power cord or reset the GP, or
insert/remove the CF Card.

����� Status 2
DOWNLOAD Status information consists of the following data.

• Reading data (GP internal data)
• Initialize Internal FEPROM data
• Write to Internal FEPROM data
• Write to Backup SRAM data

Each “block” in the DOWNLOAD Status Bar represents 64K bytes of data.

����� Status Bar
The Status Bar shows the progress of download.

����� RETURN
If you perform DOWNLOAD from the INITIALIZE screen, touching this button
returns you to the INITIALIZE screen. If you perform DOWNLOAD from the
MENU screen, the screen will return to the MENU screen.

Performing DOWNLOAD completely overwrites all data (the System,
Communication Protocol, Extended Programs, Screen Data and
Backup SRAM Data).

����� DOWNLOAD Status
Once download starts, the DOWNLOAD status screen will appear.

 Status 1

Status 2

Status Bar

����� Status 1
The message “NOW TRANSFERRING DATA PLEASE WAIT” will appear. If an
error is detected during download, an error message will appear.
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If you touch [3 SYSTEM DATA DISPLAY], the following screen will appear.
Here, you can see details of both the CF Card’s uploaded data and the GP’s inter-
nal data. To view the data uploaded from the CF Card, touch the [[CF INFO]]
button.

3.  SYSTEM DATA DISPLAY

����� SYSTEM DATA DISPLAY (INTERNAL DATA)
If you touch the [INTERNAL] button, the following screen will appear. You can
check GP Internal data with this screen.

Displays GP internal
data information

Displays the control informa-
tion of the GLC's internal data
when the selected GP type is
a GLC.

Pro-Control
Editor Operation Manual

����� SYSTEM DATA <Display Example>
UNIT TYPE : GP2600
SYSTEM VERSION : V4.00
COMMUNICATION PROTOCOL :MELSEC-ANA V1.41
ETHERNET PROTOCOL :V4.15
SIMULATION :V3.34
EXPANSION SIO :EXT-SIO-SCR V2.00

The “SIMULATION” data will change to “LADDER MONITOR” when there is a
ladder monitor program.

����� SCREEN DATA <Display Example>
SCREEN EDITOR VERSION :V7.00
PROJECT COMMENT :A PLANT SYSTEM (Up to 60

 characters can be used)

If Upload Information Data is not transferred when transferring Screen Data, an
error message informs you that there is no Upload Information Data, and the Screen
Data will not be displayed.

����� UPLOAD DATA SIZE <Display Example>
INTERNAL FEPROM SIZE :8192K bytes
SRAM SIZE :512K bytes
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Displays the CF Card's
uploaded data details.

Displays the control
information of the
GLC's internal data
when the selected GP
type is a GLC.

Pro-
Control Editor
Operation Manual

����� SYSTEM DATA DISPLAY (CF CARD’S DATA)

The following are System Data Display examples.
This screen allows you to check the details of the selected backup file (.MEM)
stored on the CF Card and the uploaded data.

����� SYSTEM DATA <Display Example>
UNIT TYPE :GP2600
SYSTEM VERSION :V4.00
COMMUNICATION PROTOCOL :MELSEC-ANA V1.41
ETHERNET PROTOCOL :V4.15
SIMULATION :V3.34
EXPANSION SIO :EXT-SIO-SCR V2.00

• The “SIMULATION” data will change to “LADDER MONITOR” when there is a
ladder monitor program.

• If there is no system program in the CF Card’s uploaded data, the “SYSTEM VER-
SION” will be “NONE”.

����� SCREEN DATA <Display Example>
SCREEN EDITOR VERSION :V7.00
PROJECT COMMENT :A PLANT SYSTEM (Up to 60

 characters can be used)
If there is no Upload Information Data in the GP, an error message will appear in-
forming you that there is no Upload Information Data, and the Screen Data will not
be displayed.

����� UPLOAD DATA SIZE <Display Example>
DATA SIZE :1K byte
INTERNAL FEPROM SIZE :8192K bytes
SRAM SIZE :512K bytes
TOTAL SIZE :8705K bytes
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4.  COMPARISON
If you select [4. COMPARISON], the following screen will appear. This screen allows
you to compare all the GP’s data (i.e. system program, communication protocol,
expansion program, screen data and Backup SRAM data) with backup data that is
uploaded in the CF Card.

(1) Touch [COMPARISON] on the MEMORY LOADER
TOOL MENU screen and the following screen will
appear.

[To change the backup file to be compared with the GP
data]

(2) Touch  to call up the file selection screen.
Select the backup file to be compared with the GP
data and touch .
To cancel the file selection, touch  to return to
the COMPARISON screen.

(3) The [COMPARISON] screen appears and all GP
data is compared with backup data uploaded from
the CF Card.

Title

Touch this
button to
display the
system
informa-
tion of the
selected
backup
file.

Path
name

The displayed path name is limited
to 30 characters. The 31st and sub-
sequent characters are omitted.

A maximum of 50 file names can
be displayed.

Touching the column heading
(FILE/SIZE/DATE) sorts the dis-
played file names in ascending or-
der according to the heading se-
lected.
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10.7 CF Memory Loader Tool

����� COMPARISON Status
Once [COMPARISON] begins, the progress of the comparison can be seen on the
following screen.

 Status 1

Status 2

Status Bar

����� Status 1
The message “NOW COMPARING PLEASE WAIT” will appear. If an error is
detected during the [COMPARISON], an error message will appear.

����� Status 2
COMPARISON Status information consists of the following data.

•  Reading data (GP internal data)
•  Comparing with Internal FEPROM data
•  Comparing with Backup SRAM data

Each “block” in the COMPARISON Status Bar represents 64K bytes of data.

����� Status Bar
This bar shows the progress of the [COMPARISON].

����� RETURN
Touching this button returns you to the MENU screen.
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5. FILE LIST
Touch the [5 FILE LIST] button to display the following screen.
This feature allows you to list the files stored on the CF Card, to view the details
of the selected file, or to copy, delete or rename the files on the CF Card.

����� FILE LIST

File name
currently
selected

Copies the selected
file.

Displays the system
information of the
selected file.

Returns to
previous screen.

����� FILE COPY

Touch the  button on the [FILE LIST] screen. The following screen
appears.

The folder
name and file
name of the
currently
selected file
are displayed
as "SOURCE".

Designates the
destination file.

Designates the
destination folder.

Confirms the
source and
destination and
executes the
copy operation.

Cancels the file
copy operation.

Deletes the selected
file.

Renames the
selected file.
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10.7 CF Memory Loader Tool

PROCEDURE REMARKS

Enter the password you have regis-
tered in the GP-PRO/PBIII’s [Trans-
fer] screen. If you have not regis-
tered a password, simply touch
[START] and data download will
start.

(3) Touch  for the destination folder, select the
folder name, and touch .
To cancel the file copy, touch .

(1) Touch [5 FILE LIST] on the Memory Loader Tool
Menu screen.
The file list screen appears.

[To copy a file]

(2) Touch   to call up the file copy screen.

Title

Path
name

The displayed path name is limited
to 30 characters. The 31st and sub-
sequent characters are omitted.

A maximum of 50 file names can
be displayed.

Touching the column heading
(FOLDER/SIZE/DATE) sorts the
displayed file names in ascending
order according to the heading se-
lected.
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The file deletion cannot be undone
after [YES] is touched.

(3) Enter your password using the screen’s keypad.

(4) Touch [START] and data download will begin.

[To delete a file]

(2) Touch  to call up the file delete screen.

Confirm the file name to be deleted and touch [YES].
To cancel the file deletion, touch [NO].

The displayed path name is limited
to 30 characters. The 31st and sub-
sequent characters are omitted.

Up to eight single-byte alphanu-
meric characters can be used for the
file name. The file extension can-
not be changed.

The input mode can be changed in
this order: single-byte alphanumeric
(uppercase) → single-byte alphanu-
meric (lowercase) → numbers and
symbols.

If the entered file name already ex-
ists in the CF Card, the following
message will appear to confirm the
overwrite operation.

[To change a file name]
(2) Touch  to call up the file name input

screen.
Enter the file name and touch .
To cancel the file renaming, touch .

Changes
the input
mode.

Enter
a file
name.
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10.7.5 Self Diagnosis

You can check the CF Card’s "CF Memory Loader Tool" using the OFFLINE
mode’s SELF DIAGNOSIS area. For example, if you touched three corners of the
GP screen, selected [CF BOOT] on the Menu Bar and the CF Card failed to
operate correctly, you can check the status of the "CF Memory Loader Tool" (i.e.
IPL.SYS, MLD****.SYS) with this feature.

Calls up the CF Card
Memory Loader file
check screen.

PROCEDURE REMARKS

(2) Touching [START] checks the following points.
•  The status of the CF Card Start Dip Switches
•  Whether the "CF Memory Loader Tool" is in
   the CF Card or not
•  If the CF Memory Loader program has errors

(1) Touch [CF CARD MEMORY LOADER FILE
CHECK] and the following screen will appear.
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he Project Manager can display the hierarchical structure of Project
Files and screens. This function enables you to easily view Project

Files and screens when moving or copying. This chapter describes how to
operate the Project Manager in the hierarchical display mode.

 11     PROJECT MANAGER HIERARCHICAL DISPLAY

11.1 ..................... Project Manager - Hierarchical Display

11.2 ................................ Using Hierarchical Display Mode

T
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11.1    Project Manager - Hierarchical Display

When you click on the  button or select the [Project] menu - [Change
Project Manger] command of the Project Manger in the normal display
mode, the Project Manager is switched to the hierarchical display mode.To
return to the Project Manager's original display, select the [Project] menu -
[Change Project Manager], or click on the  icon.
When the Project Manager is in the hierarchical display mode, the hierarchi-
cal structure of your personal computer’s folders is displayed, and the
folders/Project Files are listed.
Normally, the system displays the hierarchical structure of the Database
folder where the GP-PRO/PB III program has been installed. When you
select the [View] menu - [Show Folders] command, all folders stored in
your personal computer can be displayed.
Project files are displayed as folders. Screens are located in each folder
corresponding to the screen type. You can open a desired screen by simply
double-clicking the screen name. The project file folder is indicated by the
project file name and the specified Deveice/PLC type. Each screen name is
displayed with comments, size, and the date/time of creation or edition.
When you double-click on a folder in the left box of the Project Manager,
the contents of the folder will be displayed in the right box.
When you click on the [+] (plus) sign at the left of each folder, its sub
folders will be displayed.

11.1 Project Manager - Hierarchical Display

Tool Bar
Displays
Project Files

Displays a
Project’s
individual
screen type
Files
Displays the
data stored in
the CF card
data output
folder

Displays a
screen list. The
currently open
screens are
checked with
[ ].

Note:

If the Project Manager has been changed during the transfer of a
screen to the GP unit, the transfer will be aborted.  Do not
change the Project Manager during the transfer of any screen.
· To change the size of the left/right box displayed in the window, drag the

border line between these boxes.

· In the system information holder, a system information screen is displayed.
Each system information screen can be copied to another project file by
simply dragging it over that file’s icon.

Displays the project’s
GP Type, Device/PLC
Type and Extend SIO
settings.

The screen
necessary for
transfer is
described in
[*0].
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11.2    Using Hierarchical Display Mode
This section describes the basic operations of the Project Manager in the
hierarchical display mode.

����� Creating a New Project
Click on the folder where you wish to create a new Project File. Select the
[Project] menu - [New] command, or click on the  icon. The [New]
dialog box will appear.

   1.1.2 � Creating a New Project
When a new Project File is created , a new folder “(new_project_name).
prw” will be added to the directory.

����� Selecting a Project File from the Existing Projects
Click on the Project File to be selected. The right box lists the folders of the
selected Project File by screen type.

����� Rename
To change a Project File name or screen name, select the target Project File
or screen, and then select the [Project] menu - [Rename] command.

����� Opening a New Screen
Select a Project file. And then select the [Screen/Setup] menu - [New]
command, or click on the  icon. The [New] dialog box will appear.
Select the type of screen to be created and click on the  button.
Then, a new screen will open.

   1.1.3 � Opening a New Screen

����� Opening an Existing Screen
Select a Project file to create a screen. When selecting the [Screen/Setup]
menu - [New] command, with the screen type folder specified, the [New]
dialog box will appear with the specified screen type selected. Then, click
on the  button to open a new screen.

����� Opening a Screen
When you select the Project File including the target screen and then click
on the folder corresponding to the target screen type, the screen name will be
displayed at the right of the box. When you double-click on the target screen
name, the Screen Editor will start up, and the selected screen will be opened.
After selecting a desired screen, select the [Screen/Setup] menu - [Editor]
command, or click on the  icon to open the screen.

When clicking on the  icon with the Project File selected, a dialog box
to open a screen will appear. Select a desired screen and click on the

 button.

11.2 Using Hierarchical Display Mode
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� Copy
Select the target Project File or screen, and drag it to the destination folder.
You can also copy it by selecting the [Edit] menu - [Paste] command after
selecting the target Project File or screen and specifying the destination
folder.
However, to copy a “screen type” folder or screen, drag it to a “Project File”
folder or a folder of the same screen type.

� Delete
Select the target Project File or screen, and then press the               key or
select the [Project] menu - [Delete] command.

11.2 Using Hierarchical Display Mode

If any project file has been edited by copying/deleting its data with the Win-
dows Explorer, this edit will not be reflected in the hierarchical display of the
Project Manager.  In this case, update the details of the hierarchical display
by selecting the [View] menu - [Refresh] command.

Note:

Delete



creen data created with other screen editor software can be con
verted into files that can be used with the GP-PRO/PB III for
Windows program.

 12      DATA COMPATIBILITY

12.1 ................................................................ File Converter

S
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12.1 File Converter

Files created with other screen editor software (such as GP-PRO , GP-PRO
II, GP-PRO III, and Parts Box) can be converted into files for use with the
GP-PRO/PB III for Windows program.

Project Files created with the GP-PRO/PB III program (DOS version) need
not be converted. You can simply open your DOS files on the GP/PRO III for
Windows program by selecting “DOS Project File (*.pro)” when specifying
the project file type.
Once you save these files with the GP/PRO III for Windows program, they
can be used with Windows.

   1.1.2 � Selecting an Existing Project, � Saving a Project

12.1     File Converter

Note:

12.1.1 Conversion from GP-PRO II or GP-PRO III

    Usage Pattern

Specify the
conversion
range of the
file.

Select a file
created with
GP-PRO II or
III.

[Convert From GP-
PRO 2/3 File]

[File Convertor][PROPB3Win][Start]

→→→→→→→→→→→→→→→

→→→→→ →→→→→→→→→→

Here, files created via GP-PRO II or GP-PRO III are converted to GP-PRO/
PB III project files (*.PRW files).

→→→→→

Displays the
original file to
be converted

Displays a new
file name and
a comment

Displays the
current con-
version status

Displays the
conversion
progress

[Program]

[File] →→→→→

or

Click on .

[Convert]→→→→→
                or

Click on  to execute the conversion.

[Actions]

→→→→→[Pro-face]
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12.1 File Converter

����� Selecting a GP-PRO II/III File

Selects all the
GP-PRO II and
III screen files
listed

Selects the
screen file
selected from
the list

Cancel selection
of the specified
screen file

Cancel selec-
tion of all
screen files

Displays the
Device/PLC
type specified
for the GP-
PRO II or III file

Lists the selected
screen files

Creates a new
Project File

Adds
screen data
into a
Project File
with the
same file
name and
saves it.

����� Selecting a Destination Folder
Designate a name for the Project File (PRW file) created when the GP-
PROII or GP-PROIII file is converted.
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12.1 File Converter

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(2)Select the [File] menu - [Convert From GP-PRO 2/3
File] command, or click on the   icon.

(3) Select a desired GP-PRO II or GP-PRO III file's De-
vice/PLC type.
The files corresponding to the selected Device/PLC type
will be displayed.

(1)Click on the [Start] button, and point to the [Program ] -
[Pro-face] - [ProPB3 C-Package] menu. Then, click
on the [2.File Convertor] command.

����� Converting a GP-PRO II/GP-PRO III File
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12.1 File Converter

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(4)Select a desired GP-PRO II or GP-PRO III file or
enter the file name, and click on the  but-
ton.
The selected file will appear in the Files to Convert list. To convert all files, click on the

 button.

To cancel file selection, click on the
 or  button.

(5)After selecting the GP-PRO II or III file, click on the
 button.
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PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

To import a file from a different
folder, first change the folder.

1.1.2 � Selecting
an Existing Project
[Display Type]
Select the GP unit type for the tar-
get Project File.
[Device/PLC Type]
Select the Device/PLC type for the
target Project File.

When the destination Project
file's Device/PLC type is dif-
ferent from that of the origi-
nal file, you must specify the
Tag device address again af-
ter the Project File is im-
ported.

(6) Enter the folder and Project File name where the
converted file will be stored. Also, specify the GP and
Device/PLC types.
If the Device/PLC types are different before and after
conversion, a dialog box will appear confirming the con-
version command. If you wish to convert the file, click
on the  button.

(7)After confirming the conversion command, click on
the  button.

If the same file already exists, the
system asks if this file must be over-
written. If you select  , the
file will be overwritten. If you select

 , the file will not be over-
written, and you will return to the
previous dialog box.
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12.1 File Converter

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(8)Click on the  button to confirm the original
and destination file settings.

• After importing the system (SO) screen from GP-PRO II or GP-
PRO III, be sure to check the [System Settings] data.

• When the system (SO) screen imported by the [Convert From
GP-PRO 2/3 File] command is transferred to the GP70/77R/
2000 series unit, you will need to perform [Font Setup]. Enter
the GP’s OFFLINE mode, and set up the necessary fonts (lan-
guage).

 GP Series User’s Manual (sold separately), FONT
  SETTINGS

(9) After confirming the settings, select the [Actions]
menu - [Convert] command, or click on the  icon.
The current status of the file conversion will be displayed.
When the file conversion has been completed, “DONE”
will be displayed in the status display area.
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12.1 File Converter

     Usage Pattern

12.1.2 Conversion from Parts Box

Select a file
created with
Parts Box.

[2.File Converter][ProPB3win][Start]

→→→→→→→→→→

→→→→→→→→→→→→→→→

����� Selecting a Destination Folder
Specify the destination folder to store the Project File (PRW file) converted
from the SCD file and CPL file.

����� Selecting a Parts Box File

Here, system files (SCD file) created via Parts Box are converted to GP-
PRO/PBIII project files (*.PRW).

Select the SCD File and
CPL File created with Parts
Box

Displays the
destination
Project File
(PRW file)

Displays the Device/PLC
type of the system file (SCD
file)

The Easy series name is
automatically converted
into the following GP
series names :
[Easy20]: GP-270 series
[Easy40/50] : GP-470 series

Displays a comment at-
tached to the SCD or CPL
file.

Displays Parts Box's
system file (SCD file) and
Library file (CPL file).

[Program] →→→→→

[File]      [Convert From Parts Box]
or click on .

→→→→→ Specify
convert
destination.

[Actions]   [Convert]
      or

Click on  to execute the conversion

→→→→→

→→→→→[Pro-face]
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12.1 File Converter

(1)Click on the [Start] button, and point to the [Pro-
gram] - [Pro-face] - [ProPB3 C-Package] menu. Then,
click on the [2.File Convertor] command.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(3) Select a Parts Box file to be converted or enter the
file name, and click on the   button.

(2) Select the [File] menu - [Convert From Parts Box]
command, or click on the   icon.

����� Converting a Parts Box File

To import a file from a different
folder, you must change to that folder.

1.1.2 � Selecting
an Existing Project

(4) Enter the folder and Project file name where the con-
verted file is saved, and click on the [Save] button.

When selecting a Library file (CPL
file), select [Parts Box Library File
(*.cpl)] in the Files of type pull-down
list.

If you wish to change the GP and De-
vice/PLC type for the destination file,
make the change after executing the
conversion.

4.2.6 Changing a
Project's GP Type and 4.2.7
Changing Your Project's Device/
PLC Type and Addresses
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12.1 File Converter

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(5)After confirming the settings, select the [Actions]
menu - [Convert] command, or click on the  icon.
The current status of the file conversion will be displayed.
When the file conversion has been completed, “DONE”
will be displayed in the status display area.



12-11

Chapter 12 - DATA COMPATIBILITY

GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

12.1 File Converter

     Usage Pattern

12.1.3 GP-*10 (GPM) File Conversion

Select a GP-
PRO file.

[2.File Converter][ProPB3Win][Start]

→→→→→→→→→→

→→→→→→→→→→→→→→→

����� Screen Data After Conversion

Here, the GP-*10 Series' memory card data (GPM file) is converted to GP-
PRO/PBIII's Project file (PRW file) for each memory card. Files created via
GP-PRO cannot be converted directly to PRW files. First create GPM files,
and then convert them to PRW files.

   12.1.4 Reading GP-*10 (GPM) Files

[Program] →→→→→

[File]      [Select GP x 10 (GPM) File]
or click on .

→→→→→ Specify conver-
sion destination.

[Actions]   [Convert]
      or

Click on  to execute the conversion

→→→→→

����� Screen names
After converting screen data created via GP-PRO to GP-PRO/PBIII screen
data, the converted screen names are changed as follows:

����� Tag names

Tag names will not be changed even after conversion. However, for l-tag
and m-tag, "L" and "M" will be attached to the beginning of the original tag
name, respectively.

����� Cautions When Converting GP-PRO Files
When converting GP-PRO files, be aware of the following cautions:

• Object displacement
Due to the high speed drawing of arcs and pies, as well as differences of
drawing algorithms, GP-*10 screen coordinates data will be optimized. As
a result, objects may be displaced from their original positions, which
requires modification and correction.

• Color settings
Since color settings designated as "black + blink" are converted to "white +
blink", re-set the color.

Screen Type GP-PRO GP-PRO/PBIII

Base screen 1 to 255 B1 to B255
Library screen 300 to 699 B300 to B699
Mark screen 700 to 999 M700 to M999

Trend Graph screen 1000 to 1199 T1000 to T1199
Alarm Message 1200 to 1299 A1200 to A1299*

→→→→→[Pro-face]

* For converted alarm messages, be sure to check row 1200 and later in the
   alarm editor.
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12.1 File Converter

• Chinese character fonts
Chinese character fonts used on the GP-*10 series are different from the
ones on the GP70/GP77R/GP377/GP2000 Series units.

• Numeric Keypad Input
N699-tag
The GPPRO/PB III does not feature N699-tags. After conversion, re-create
numeric keys and display on the GP-PRO/PBIII.

k-tag
When converting GP-PRO files while two or more k-tags are set for one
screen, all the k-tags are displayed in the center of the screen being over-
laid. After conversion, rearrange the tags so that they are displayed in the
correct positions.

K-tag
Since GP-PRO does not have a function to display data for K-tag, N-tag is
used to enter set values via the screen's numeric keys. However, since GP-
PRO/PB III supports the K-tag display function, the N-tag settings are not
required.

System data areas +6 and +7
The GP-*10 Series uses system data areas +6 and +7 for N699-tag numeric
key entry and K-tag. However, the GP70/GP77R/GP377/GP2000 Series
use +6 for status and +7 for reserved area, and K-tag reads and writes PLC
data directly, without using the system data areas. When system data areas
+6 and +7 have been used for the tags or ladder program, correct the
address settings.

• Requirements for 32-bit data
Relationship between 32-bit data upper and lower addresses may be differ-
ent between the GP-*10 Series and the GP70/GP77R/GP377/GP2000
Series, depending on Device/PLC types. Due to this, the PLC's ladder
program may require correction.

• Device/PLC type
GP-*10 Series unit project files created for the following PLC units can be
converted to GP-PRO/PBIII.

• MEMORY LINK SIO Type
• SHARP JW Series
• YOKOGAWA FA500 Series
• FUJI MICREX-F Series
• TOYOTA TOYOPUC Series
• YASUKAWA Memocon-SC GL Series
• HITACHI HIDIC-S10 / HIZAC H Series
• TOSHIBA PROSEC Series
• MATSUSHITA MEWNET-FP Series
• MITSUBISHI MELSEC-AnN Series / AnA Series / F Series / FX

Series
• KOYO KOSTAC Series
• OMRON SYSMAC-C Series

However, if the project file was created for a TOYOTA TOYOPUC
PC1, YASUKAWA Memocon-SC GL20, or TOSHIBA PROSEC EX
Series PLC (exception : EX2000 projects can be converted directly), they
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12.1 File Converter

����� Selecting a GPM File

����� Conversion destination
Specify the folder used to save the Project file (PRW file) converted from a
GPM file.

Overwrites or adds
screen data to the exist-
ing Project file with the
same name.

Creates a new Project file.

cannot be converted directly. To convert them, please choose
another destination target unit.

• Data check after conversion
Be sure to check all the settings such as of tags, after conversion.
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12.1 File Converter

����� Converting a GPM File

(1) Click on the [Start] button and then select [Program]
- [Pro-face] - [ProPB3 C-Package] - [2. File Con-
verter].

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(3) Select a GPM file to be converted or enter the file
name, and click on the  button.

(2) Select the [File] menu - [Select GP x 10 (GPM) File]
command, or click on the  icon.

(4)Enter the folder and Project file name where the con-
verted data is stored. Also, specify GP and Device/
PLC types.

To import a file from another folder,
change the folder.

1.1.2  �����  Selecting
an Existing Project

When the destination Project
file's Device/PLC type is dif-
ferent from that of the origi-
nal file, you must designate
all Tag device addresses
again, after the Project File is
imported.
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12.1 File Converter

(5)After confirming the settings, click on the 
button.

(6) After confirming the settings, select the [Actions]
menu - [Convert] command, or click on the  icon.
The conversion status will continuously be displayed.
When "Completed" is displayed in the [Status] field, con-
version is completed.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

If the same file already exists, the
system asks if this file must be over-
written. If you select  , the
file will be overwritten. If you select

 , the file will not be over-
written, and you will return to the
previous dialog box.
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12.1.4 Reading GP-*10 (GPM) Files
Screen data transferred to the GP-*10 is received as GPM files. The re-
ceived data files can be converted to GP-PRO/PB III Project files (PRW
files) and used.

   12.1.3 GP-*10 (GPM) File Conversion

A connector adapter is required to use a PC unit with a D-sub
9-pin socket interface.
Using a commercially available conversion adaptor is recom

mended. The wiring for a standard-type conversion
adaptor is shown below.

Ex.) ARVEL Corporation’s RS-232C Coversion Adaptor
Model: AA830

     Usage Pattern

Perform
storage
destination
and commu-
nication
settings.

[2.File Converter][ProPB C-
Package]

[Start]

→→→→→→→→→→

→→→→→→→→→→→→→→→ [Program] →→→→→

[Transfer]      [Load GPM File From
 GPx10]

                  or
          click on .

→→→→→ Click on
 to

execute the
conversion.

→→→→→[Pro-face]

Dsub25P Dsub9P
FG FG

1
2 3
3 2
4 7
5 8
6 6
7 5
8 1
20 4
22 9
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����� Reading a GPM File

(3) Specify a location (directory) to store the received
data and the file name, and click on the  but-
ton.

If the same file already exists, the
system asks if this file must be over-
written. If you select  , the
file will be overwritten. If you select

 , the file will not be over-
written, and you will return to the
previous dialog box.

PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(1) Click on the [Start] button and select [Program] -
[Pro-face] - [ProPB3 C-Package] - [2. File Converter].

(2) Select the [File] menu - [Load GPM File From
GPx10] command, or click on the  icon.

To receive data, connect the GP and
personal computer via a cross cable.

Digital's GP410-IS00-0 is available.

Also, set the GP to transfer mode
using the keyboard for drawing ob-
jects.
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PPPPPROCEDUREROCEDUREROCEDUREROCEDUREROCEDURE R E M A R K S

(4) Specify all the necessary communication items and
click on the  button.

(5) Click on the   button to start receiving data.

The communication settings
must be the same as the GP's
initial SIO settings.

Sending Speed: 9600 bps

Data Length: 8-bit

Stop bit: 1-bit

Parity bit: None

Control Type: XON/XOFF

(6) After confirming the data receiving command, se-
lect the [Actions] menu - [Convert] command, or click
on the  icon.
The conversion status will continuously be displayed.
When "Completed" is displayed in the [Status] field,
conversion is completed.



          APPENDICES

his section contains a list of error messages and corrective actions, as
well as address conversion tables.T

Appendix 1 ........................................................ Error Messages

Appendix 2 ....................................................... Troubleshooting

Appendix 3 .................................... Address Conversion Tables

Appendix 4 ........................................ Software Trouble Report
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A.1      Error Messages
����� Project Manager Errors

Error Message Cause/Solution
Because of the change in PLC type, a part of the
device address used in the project may be
converted into a device address that cannot be
used with the current PLC. Double-check all
device addresses used in the project and modify
them as required.

This warning message is displayed every time an
attempt is made to change the Device/PLC type and
addresses. Double-check all device addresses used
in the project and modify as necessary.

Be sure to check with the Network Coordinator
to confirm your unique IP address. This is
because if a duplicate IP address is used by any
user, the entire network can be effected.

Click in the node IP address’ edit box. Be sure to
enter the node IP address carefully so that it does not
duplicate any other device IP addresses.

Can’t edit - Insufficient memory The memory area for editing is insufficient. Quit other
applications, then begin editing your file again.

Cannot edit the files because the filing mode
[Use Multiple Folders] setting is not selected!
Click on [Use Multiple Folders].

When the filing mode settings’ [Use Multiple Folders]
was not selected, you attempted to open 2 or more
kinds of filing data directly from the Project Manager
having nesting screen display by double-clicking.
Select [Use Multiple Folders].

Cannot start up Internet browser

The browser settings are not correct or the memory
area for the browser is insufficient. Check the settings
of the startup browser. If the browser settings are
correct, quit all other applications and restart the
browser.

Cannot read system file

The program file data required for setup cannot be
opened or read, or the file’s data is not correct. The
file may be corrupt, or a disk error may have
occurred. After solving the problem, reinstall the file.

Cannot read the file’s system information
The project file is corrupt. Use GP-PRO’s rebuilding
tool to repair the file. After repair is completed, read
the file again.

Channel numbers overlap! Be sure channel numbers do not overlap and are
unique.

Current Color Depth Not Supported
Convert to 256 colors or less

Only images of 256 colors or less can be used by
this software.

Current GP type does not support Device
Monitor feature

Select a GP type which supports the device monitor
feature.

Current Device/PLC type does not support
Device Monitor feature

Select a Device/PLC type which supports the device
monitor function.

D
Destination screen number is too high.
Reduce the number of destination or source
screens

Set (Copy source end number - copy source start
number) >= (8999 - copy destination start number).

Exceeds Data Backup Area Limit.
Please adjust your settings to fit this area’s size
limitations

The backup settings, backup area used cannot
exceed 2031. Set the backup start address + the
number of devices to less than or equal to 2031.

Exceeded limit for backup area setting of current
GP type. Backup cannot be performed correctly
with current setting.

Change the backup area setting to LS4096 or less.

G Grouping Nesting Limit Reached.
Unable to group more than these objects

You are attempting to nest grouped objects more than
10 times. Only 10 levels of nesting are allowed.

E

C

B
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Error Message Cause/Solution

Internet Browser Not Selected Yet.
Please select a Browser

An Internet browser has not been selected yet. After
clicking on the error message’s OK button, select a
browser from the dialog box that appears.

Invalid Address !
Before entering the device address, check that the
value is within the allowable range and that the device
is supported by the PLC.

Invalid PLC table
The PLC table file format is readable by the GP, or
the file is corrupt or deleted. Select the Device/PLC
type from the master disk and reinstall it.

Incorrect PLC Table Format

The PLC table file format is not the same as the GP's,
or the file is corrupt for some reason. Select a
Device/PLC type from the master disk and reinstall
the file.

N Non-PRW File
A file has been selected that is not recognized by
GP-PRO/PB III for Windows 95. Be sure to only
select only Project (.PRW) files.

Old PLC table and some functions may not work
properly.
Please use latest table

The PLC table file from an old version is being used.
Select a new Device/PLC type from the master disk
and reinstall it.

Older Version Project File
Is it OK to upgrade the file?
Upgrading a file means you will not be able to
open the old version of the file.

An older version PRW file is now selected. If you
click on OK and continue this sequence, the system
will upgrade the existing PRW (i.e. create a new file)
and change the old PRW's extension to POD. If
Cancel is selected, the system leaves the file
unchanged.

P PLC File Type Error
The PLC table file format is not the same as the GP's,
or the file is corrupt. Select a Device/PLC type from
the master disk and reinstall the file.

Screen number to copy from must be greater
than screen number to copy to.

Enter a "copy to" screen number that is greater than
the "copy from" screen number.

Selected project is the same as current project.
You cannot copy data within the same project file. Be
sure to specify a project file other than the current
project file.

Specified address is not used for screen
properties that can be displayed.

When opening the screen via the Global Cross
Reference List, designate an address within the valid
range of screen addresses.

System error

The program file data required for setup cannot be
opened and read, or the internal data is not correct.
The file may be corrupt, or a disk error may have
occurred. After fixing the problem, reinstall the file.

System file is corrupt

The program file data required for setup cannot be
opened and read, or the internal data is not correct.
The file may be corrupt, or a disk error may have
occurred. After fixing the problem, reinstall the file.

System open error

The program file data required for setup cannot be
opened and read, or the internal data is not correct.
The file may be corrupt, or a disk error may have
occurred. After fixing the problem, reinstall the file.

System version error
The system cannot open this project file. You are
attempting to open a file new version GP-PRO/PB III
file using an old version of GP-PRO/PB III.

S

O

I
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 Error Message Cause/Solution 
S System write error The program file data required for setup 

cannot be opened and read, or the internal 
data is not correct. The file may be  
corrupt, or a disk error may have 
occurred. After fixing the problem, 
reinstall the file. 

Unable to convert file. Please check disk. The destination disk does not have sufficient 
free space. Prepare a disk that has sufficient 
space and re-try. 

Unable to read current project information The project file is corrupt. Use the GP-PRO 
rebuilding tool to repair the file, and then read 
the file again. 

U 

Unrecognizable Image  
File may be corrupted 

The selected image file is either corrupted or 
unusable by this software. 

 

����� Project Manager Errors (from previous page)

 Error Message Cause/Solution 
B Bitmap size is too large.  The maximum 

bitmap size that can be registered is 
160x160 pixels. 

The maximum size of a bitmap that can be 
registered as an image Part is 160 dots x 160 
dots. Be sure the image registered is within 
these limits. 

Can’t edit - Insufficient memory The memory area is insufficient for editing. 
Quit all other applications and resume 
editing. 

Can’t open more than 20 screens The screen editor can have up to 20 screens 
open at one time. 

Cannot place screen on itself You cannot call the screen being edited. 
Cannot register since this number is 
already being used by the U screen. 

Delete the window screen. 

Change request will exceed maximum 
number of tags. Changes canceled 

This change will exceed the tag upper limit.  

              � Number of Tags “2.3 

Tags” 

C 

(Channel) Alarms cannot be used together 
with Fill Below Line in a channel setting. 

When you attempted to use “Fill Below Line”, 
you set the channel’s Alarm feature “ON”. 
Undo Graph Fill and reset the channel. 

D Device address out of range When the specified command is performed, 
the device address exceeds the upper limit. 
Specify an address within the allowable 
range. 

 

����� Screen Editor Errors
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Error Message Cause/Solution

Exceeded maximum GP file size. Changes
canceled

This change will exceed the screen size upper limit.
                                    Screen Size "1.1.3
Screen Types"

Exceeds A-tag limit Only one alarm can be used on a single screen.

Exceeds keypad limit Only one keypad screen can be called to a Base
screen.

Exceeds a-tag limit Only one alarm can be used on a single screen.

Exceeds C-tag limit Only one time display can be used on a single
screen.

Exceeds file size limit

The screen size exceeds the upper limit, and you
cannot create any more graphic data. The last data
created will become invalid. Store the screen data,
and then open a new screen and call the stored
screen using [Load Screen] in the [Draw] menu.

Exceeds Part Library limit.

If the number of Part Libraries used exceeds the limit,
Part Library data cannot be transferred to the GP.
Reduce the number of Part Libraries.
                            2.1 Parts, �  Maximum
Number of Automatically Created Part
Libraries

Exceeds R-tag limit Only up to 30 R tags can be used on a single screen.

Exceeds the Data Transfer Display limit. Only one Data Transfer Display can be placed on
each screen.

Filing displays with the same ID No. cannot be
placed on a screen if [Cursor Position Control]
is selected.

Multiple filing displays with the same ID No. with
[Cursor Position Control] selected cannot be placed
on one screen. Either deselect [Cursor Position
Control] or change each filing display' ID No. so that
the ID Nos. do not overlap.

File write error
This file cannot be written to the destination media.
Please check the designated drive name and
directory.

Fill Below Line can be used when only a single
channel has been selected.
Please delete any additional channels.

Two or more channels are preset for Fill Below Line.
Set only one channel.

G Grouping Nesting Limit Reached.
Unable to group more than these objects

You are attempting to nest grouped objects more than
10 times. Only 10 levels of nesting are allowed.

H High speed U-tag cannot be used if a standard
U-tag is already in place.

Both the U tag and the use/non-use of high-speed
settings must be specified. Do not duplicate the
settings.

I Invalid Screen (Number) Valid screen numbers are between 1 and 8,999.
Enter the screen No. again in single-byte characters.

Large V tag will not work in the extend mode.
Please reset this to the standard mode within
the video settings of the GP system setup.

In the GP Setup area, select the Extended Setting
tab's Video Settings "Standard Mode" setting.

Logging Display, CSV Display, K-tag, and
Keypad Input Display cannot be placed on a
screen simultaneously.

Check whether a Logging display, CSV Display, K-
tag or Keypad Input Display has already been placed
on the screen.

E

F

L
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����� Screen Editor Errors (from previous page)

Error Message Cause/Solution

O Only one Q-tag sub display can be used per
screen.

When using a Q-tag, the number of sub displays
used is limited to 1.

P Parts and tags are not valid objects. A library item containing Parts or tags cannot be
used in a Picture Display.

Screen No. is out of range. Re-enter a different
Screen No.

Screen No. used after conversion is out of the
Screen No. range. Enter the correct number.

Small v tag will not work in the standard mode.
Please reset this to the extend mode within the
video settings of the GP system setup.

In the GP Setup area, select the Extended Setting
tab's Video Settings "Extend Mode" setting.

The amount entered for the data sampling
feature is combined with the number of Trend
graph channels created, and their combined
total cannot exceed 20.

When 20 channels are preset, the Add button is
clicked in the data sampling setting list display dialog
box.  Delete unnecessary settings so that the total of
Trend Graph channel settings and the data sampling
settings will be within 20.

The area available for data sampling has been
exceeded. Please re-enter this item's settings.

The storage address used exceeds 2031. Set the
storage start address + the number of sampling data
to less than or equal to 2031.

The current GP type setting does not support
video.  Video tag will have no effect Select the GP type for the VM Unit.

The currently selected GP type does not
support this type size. This setting is invalid.

Select a model supporting the type size of the integer
scales.

The font used for this text cannot be found.
Only font type and color can be changed.

The designated font cannot be found in the PC's Font
folder. Either select a different font, or install the
desired font.

The designated screen does not exist.
The screen that you attempted to open cannot be
found in this project. Select a screen from different
existing project.

The sum total of all the data saved by the GP's
data backup features now exceeds the backup
memory unit's limit. Please reduce this amount.

The backup size exceeds the SRAM capacity.
Reduce the number of sampling data, or set this
item's backup setting to "None".

There are no screens created for this screen
type.

The screen that you attempt to open cannot be
created with the specified screen type. Open a new
screen.

This object has a non-black background and
may not display properly on the GP. Also, be
sure that your loaded screen's center point is
aligned with the object (loaded to) screen's
center point.

If this screen is used as the screen for the
background color, be sure to align its center point
correctly with the destination screen.

This rail number is already in use. Please enter
another number.

All rail numbers used on a single base screen must
be unique.

This screen cannot be edited. Delete the window screen.
This tag does not support portrait mode.
Continue anyway?

The vertical type GP does not support the tag that you
are attempting to use.

U Unrecognizable Bitmap File may be corrupted The selected bit map file is either corrupted or
unusable by this software.

W
When the Extended font is used only Alpaha-
numeric character can be displayed in the main
body of the display machine.

2-byte characters are not compatible with the
extended fonts.

S

T
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����� Library Item Placement / Save Errors
 Error Message Cause/Solution 

G Grouping Nesting Limit Reached. 
Unable to group more than these objects 

You are attempting to nest grouped objects 
more than 10 times. Only 10 levels of nesting 
are allowed. 

N Not a library file The library file selected in the library browser 
cannot be used in this system. Select a file 
with a CPW extension. 

O Out of memory Memory is not sufficient to perform the 
operation. Quit other applications, re-allocate 
memory, and then restart the operation. 

S System error An error occurs when the library file is being 
stored. Reserve sufficient free disk space and 
restart the operation. 

T This file was created using an old version 
editor and cannot be converted 

The current file is a CPL file created in Parts 
Box. Use the file converter to convert the file 
into a CPW file. 

Unable to convert memory block into cell The memory is not sufficient to execute the 
operation. Quit other applications, re-allocate 
memory, and then restart the operation. 

U 

Unable to create cell list The library file is corrupt for some reason. 
Use the provided rebuilding tool to repair the 
file and then restart the list creation. 

����� D-Script Errors
 Error Message Cause/Solution 

C Constant value out of range:  The preset constant value exceeds the 
specified range. Enter a correct value.* 

D D-Script function name has not been 
entered. 
Please type the function’s name in the 
description field. 

Do not click OK without entering the function 
name;  you must first specify the function 
name. Enter the function name. 

E Expression too complex. 
See HELP screens for assistance. 

Simplify the D-Script expression. 

if’ expression requires a non-empty 
statement 

An expression is required in { } in the if 
clause.  If no expression is specified, the if 
clause is ignored.* 

Illegal Expression The entered expression contains an error and 
will not be recognized.* 

Illegal syntax The entered D-Script expression has a 
syntax error. 

I 

Illegal address The entered address setting contains an 
error. Enable the syntax help in the option 
setting menu and enter the address by 
clicking the icon, or enter it from the keypad. 

N Negative numbers not supported - select 
correct data type 

A negative number cannot be used as a 
constant. Enter a positive number.* 

T This script expression is not legal (it will 
not download). Do you still want to 
register this data and quit the D-Script 
editor? 

The preset D-Script expression has an error. 
Even if this script is registered, the operation 
will be not performed. 

W WARNING: Statement has no effect and 
has been removed 

The entered instruction is ignored 
because it will not influence the 
expression. 

* These messages are displayed only when the syntax check in the option
setting menu is selected.
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����� Alarm Editor Errors
 Error Message Cause/Solution 

Can’t Add Messages - Insufficient memory Memory is not sufficient to add the messages. 
Quit other applications, re-allocate memory and 
try to add the messages again. 

Can’t import more basic alarm messages. 
Basic alarm message limit has been 
reached. 

During message import, the number of Bit 
Alarm Log messages has exceeded the 
designated limit. Delete the messages currently 
set and adjust the setting range so that the 
messages to be imported can be stored. 

Can’t import more log alarm messages. 
Log alarm message limit has been 
reached. 

During message import, the number of Bit 
Alarm Log messages has exceeded the 
designated limit. Delete the messages currently 
set and adjust the setting range so that the 
messages to be imported can be stored. 

C 

Can’t import more word alarm messages. 
Word alarm message limit has been 
reached. 

During message import, the number of Bit 
Alarm Log messages has exceeded the 
designated limit. Delete the messages currently 
set and adjust the setting range so that the 
messages to be imported can be stored. 

D Data in Blocks 2 and 3 cannot be 
uploaded to the GP.   

Since the “Block” feature was turned OFF when 
this data was downloaded, please delete Blocks 
2 and 3.  

Low Memory - not all messages can be 
pasted! 

Memory is not sufficient to paste all the 
messages. Quit other applications, re-allocate 
memory and paste the messages again. 

L 

Low Memory - not all alarms were copied! 
Try copying a smaller group. 

Memory is not sufficient to paste all the 
messages. Quit other applications, re-allocate 
memory and paste the messages again. 

Not enough memory to perform undo! 
Do you want to continue? 

Memory is not sufficient to undo the messages. 
The deleted message(s) 
cannot be undone (restored) 

Not all alarms were saved. 
Insufficient disk space 

Disk capacity is not enough to store the data. 
Create more free disk space and store the data 
again. 

N 

Not all alarms were read. 
Insufficient memory 

Memory is not sufficient to read the alarm 
messages. Quit other applications, create more 
memory and read in the alarms again. 

S Some data is incorrect and all data cannot 
be imported. 

The format of CSV data to be imported is 
incorrect. Data in and below the line with the 
incorrect data will not be imported. Check 
Alarm data’s CSV format. 

T The block function is not supported by 
this model. All block settings operate 
according to Q tag setting. Please check 
Q tag settings. 

The setup is attempted on an incompatible 
model. This feature is disabled on this model 
GP. 
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����� Symbol Editor Errors
 Error Message Cause/Solution 

A Addresses cannot be used as symbol 
names! 

Enter a standard address in the address 
column. 

D Disk space is insufficient. The disk in which the data is stored has no 
free space. Create more free space and try 
again. 

This Symbol Name is already in use. 
Please choose another name. 

A symbol of the same name has already 
been defined. Rename the symbol. 

This is not a symbol file. Please choose 
the correct format file. 

The chosen file is not a file that can be used 
for symbol import. Please choose a file that is 
this format, or modify the chosen file so that it 
becomes this format. 

This is not a device comment file. Please 
choose the correct format file. 

The chosen file is not a device comment 
import file. Please choose a file that is this 
format, or modify the chosen file so that it 
becomes this format. 

This symbol name is already registered as 
a GLC symbol. Please choose another 
name. 

You attempted to change an existing symbol 
name. Designate a symbol other than one set 
up as GLC Discrete with the Bit Symbol and 
other than one set up as GLC Integer 
Symbol/GLC Real Symbol with the Word 
Symbol. 

T 

The total number of GLC symbols is over 
2048 and a Save cannot be performed. 
Please delete all unneeded symbols. 

The maximum number of symbols has been 
exceeded. After deleting unneeded symbols, 
please retry saving the data. 

Some data is incorrect and all data cannot 
be imported. 

The format of CSV data to be imported is 
incorrect. Data in and below the line with the 
incorrect data will not be imported. Check 
Alarm data’ CSV format. 

S 

Symbol **** ‘s number of characters is 
over 20, and cannot be imported. 

You attempted to import a symbol with a 
name over 20 characters long. Please reduce 
this name to less than 20 characters. 

% %s cannot be found, or cannot be 
performed. 

The file(s) required to perform this action 
cannot be found. Please re-install the 
application software. 

  

����� Screen Transfer Errors
 Error Message Cause/Solution 

A different Extended Program is present 
in the GP. The GP’s setup cannot be 
performed. 

This extended program can only be sent to a 
GP containing the same program. Please 
change the GP type, or install the extended 
task’s program in the GP.   

A different Extended Program is present 
in the GP. Do you wish to continue? 

A different type of Extended Program is 
present in the GP. Press OK to overwrite this 
program, or Cancel to stop the transfer. 
Selecting OK will change the GP’s internal 
Extended Program. 

A 

A retentive variable was not able to be 
replaced. 

An error occurred when retaining and 
downloading retained variables. Be sure to 
check the data transfer settings and retry. 

C Cannot transmit data at 115.2Kbps - used 
a slower speed. Change Data Transfer 
Speed to 38400 when sending data.  

This error occurs when the speed of 
115.2Kbps cannot be used, or when data is 
sent to a GP 70 series model at this speed. 
Change the Data Transfer Speed setting to 
38400 and re-try.  
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����� Screen Transfer Errors (from previous page)

 Error Message Cause/Solution 
CF Card data will not be sent to GP Either the GP Multi Unit’s power is turned 

OFF, or the CF Card is not formatted. Also, if 
the CF Card’s amount of remaining space 
may be insufficient. Please delete all 
unneeded files and retry transfer.  

Command Parameter ERROR Retry data transfer to the designated GP 
using “Auto Setup”. If this message appears 
again, the PC has a command-related 
problem. Or, there may be an error in the 
cable or in the PC. Check both and retry data 
transfer. If the problem persists, the cable 
may be damaged. If necessary, contact your 
local GP distributor. 

Connected Device is not correct GP! A device other than the GP or one that is not 
supported by GP-PRO/PB III is connected. 
Check the model of the connected device. 

C 

Core - ID Command failed An error has occurred during data transfer 
from the PC. The cable may be disconnected 
or the GP is OFF. Retry data transfer. 

Data Transfer Port initialization error. Initialization of the communication port  has 
failed. Check the transfer serial port settings 
and transfer cable connection. 

D 

Do you want to download the simulation 
protocol? 

When you want to transfer the simulation 
protocol, click OK. Otherwise, click cancel. 

ERROR, Out of Memory The GP’s internal memory is full. Delete any 
unnecessary screens. 

ERROR, Incomplete Transmission Screen transfer to the GP has been aborted. 
Refer to the error message code. 

ERROR, No Configuration File The file required for setup was not found in 
the specified folder. Re-install the system 
from the Master disk, or check the transfer 
path settings. (Transfer Settings area) 

ERROR, Cannot Transfer Data A communication error has occurred and 
transfer has failed. Reset the GP and PC and 
retry data transfer. 

ERROR, Cannot open Screen The system is trying to transfer the screen to 
the GP but cannot open the Project File. 

E 

ERROR, Doesnot supports Hardware. Incorrect revision information (type) was 
designated when selecting the GLC unit’s 
[GP Type]. Change the [GP Type] data to the 
correct revision code and retry sending the 
data. 

G GP node search has failed! An error has occurred during search for the 
GP. Check the PC’s network settings and the 
network cable connection. If the problem 
persists, contact your network manager. 

H Handshaking ERROR – GP not 
Responding 

The GP power supply is turned OFF, the data 
cable is unplugged, or the GP may be in 
OFFLINE mode. Check all these points. 
When the GP main unit is in OFFLINE mode, 
reset it to transfer mode. Also, check the 
serial port. 

If "Send User Selected Screens" is 
selected, upload parameter data cannot 
be transferred. As a result, your PC will 
not receive screen data from the GP unit. 
To send upload parameter data, select 
"Send All Screens" or "Automatically 
Send Changed Screens". 

Sending screens individually  can destroy 
the Image Control Table, and the screens 
may not operate correctly on the GP.  If a 
problem occurs, resend all the screens, or 
use the automatic screen update feature. 

I 

Invalid address substituted for unknown 
aliases, or invalid address error 

When using a symbol in the device address, 
use the symbol editor to enter the actual 
symbol addresses. 
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����� Screen Transfer Errors (from previous page)

 Error Message Cause/Solution 
Memory Loader Error – Unknown Type A undefined error code has been sent from 

Memory Loader. Check the connection to 
Memory Loader. Reset Memory Loader once 
and then re-try data transfer. 

Memory Loader Error – Memory Loader 
Not Ready 

The cable used for data transfer is not 
connected to Memory Loader, or Memory 
Loader is not in the PC reception mode. 
Check that the PC is connected to Memory 
Loader using the cable and set Memory 
Loader in the PC reception mode. Then, 
re-try data transfer. 

Memory Loader Error – Card Not Found Memory Loader does not have a memory 
card. Insert the memory card into Memory 
Loader and then send the card data. 

Memory Loader Error – Timeout Communication timeout occurs. Reset 
Memory Loader and re-try data transfer. 

Memory Loader Error – Memory Overflow The transferred screen data causes an 
overflow of the memory capacity of Memory 
Loader. Delete the screen data or set the 
upload information transfer setting to OFF. 
Then, re-try data transfer. 

Memory Loader Error – Check Sum Error A checksum error occurs during transfer. 
Check that the cable is properly connected 
and remove the noise source near the cable. 
Then, re-try data transfer. 

Memory Loader Error – Bad Command The transfer command is not sent correctly. 
Check that the cable is properly connected 
and remove the noise source near the cab le, 
Then, re-try data transfer. 

Memory Loader Error – Incorrect Data 
Received 

The correct command is not received from 
the Memory Loader during transfer. Check 
that the cable is properly connected and 
remove any noise sources near the cable. 
Then, re-try data transfer. 

Multiple GPs have been designated as the 
destination, however, the system screen 
data will not be sent. 
Is this OK? 

You attempted to send data to multiple GPs 
“Send System Screen” set to ON. When 
sending data to multiple GPs, the GP system 
settings will not be transferred. 
Select Yes, which means only the screen 
data will be transferred. To send the GP 
system settings, you must first match the IP 
address in the GP system settings with the 
destination GP and re-try data transfer, unit 
by unit. 

M 

Memory Not Initialized The GP internal memory is not initialized. 
Initialize the memory. 
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����� Screen Transfer Errors (from previous page)

 Error Message Cause/Solution 
Network Connection Failed Connection to the specified party node is 

failed. Check the PC network settings and the 
network cable connection.  If the problem 
still remains, contact the network manager. 

N 

Network Data Search Please enter the IP 
address(using standard dot separators) & 
IP Port Number of the GP you are 
connecting to. If no address is entered, 
the program will search in the PC’s same 
group for this data. 

Specify the GP IP address (net ID) when 
searching the network again or when the GP 
network group is different from the PC. 
Specify the GP IP address to be searched in 
the format using a dot as the delimiter. 
Example) 192.168.1.101 

PGO command failed 
PLD command failed 

The power supply to the GP may have been 
turned OFF, or the cable has been 
un-plugged. Reset the GP and the PC and 
retry data transfer. 

P 

Protocol file not found The PLC protocol file to be sent to the GP is 
not found in the system’s directory. 
Re-install the GP’s system starting from the 
master disk. 

Send SIO Error - Unable To Open a Com 
Port 

The COM port cannot be used. In the transfer 
setting menu’s serial port setting, specify the 
available serial port, and retry data transfer. 

Send File Error - Bad File Data The data to be sent is not correct. The data 
created in the temporary file cannot be read 
correctly. Check that the disk has sufficient 
free space and it is not corrupt, and retry file 
transfer. 

Simulation data file cannot be found. The CSV file is not stored in the directory as 
the execution file. The simulation information 
file may be deleted, or the file may have not 
been created.  Set the simulation feature 
when transferring the screen and retry data 
transfer. 

S 

Simulation data file read-in error. The CSV file cannot be read into the system. 
The simulation information file may have 
been deleted, or the file may have not been 
created. Set the simulation feature when 
transferring the screen and retry data 
transfer. 

TCP/IP error The PC’s TCP/IP setting is not correct; or, the 
TCP/IP data is not registered. Check that the 
correct TCP/IP are registered in the PC’s 
control panel, and that all control panel 
setting values, including the IP address, are 
correct. 

The IP Address of the system screen 
being sent and that in the GP are not the 
same.  To send all screens, press “Yes”. 
(“No” to send only screen data) 
However, if “2-Way Driver” has been 
designated as the destination, sending the 
GP’s System Setting data will not change 
(overwrite) the IP address. 

The IP address currently being sent is 
different from the address designated in the 
GP’s system settings. 
To change the IP address, click on “Yes”, to 
preserve the IP address, click on “No”. You 
can either send the screen data or select 
“Cancel”, and then change the current project 
data’s IP address so that it matches that of 
the GP’s. 

T 

The Extended Program cannot be found. The Extended Program required for setting 
up the GP cannot be found. Please check the 
CFG file’s directory. Also, you may need to 
change the GP’s type. 

 

Appendix.1 Error Messages
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 Error Message Cause/Solution 
The Extended Program cannot be found in 
the GP. The GP's Setup cannot be 
performed. 

Unable to locate the program’s destination 
GP for setup. Check the GP type settings and 
the GP type selected. Change the GP type, if 
needed.  

The currently selected Device/PLC type 
does not support the Simulation feature. 

The currently selected Device/PLC type does 
not support the Simulation feature. This 
feature cannot be used with the destination 
Device/PLC. Deselect this feature and 
re-send the data. 

This GP does not support Extended 
Programs. The GP's setup cannot be 
performed. 

The destination GP does not support 
Extended Features. Either change the GP 
Type, or send data that is designed for the 
designated GP type. 

T 

Timeout Error Communication timeout has occurred. Reset 
the GP and re-try data transfer. 

When selecting "Send User Selected 
Screens", the "Upload Information" 
cannot be transferred even when checked, 
and screen data cannot be uploaded from 
the GP. 
To perform the screen upload feature, 
please choose "Send All Screens" or 
"Automatically Send Changed Screens" 
and check the "Upload Information" check 
box. 

Because the GP does not have the data 
required for sending the data to the PC, the 
PC cannot receive the screen. The screen 
originally may have been sent with the upload 
information set to “Not transfer”. A screen 
that is not sent together with the upload 
information cannot be received. 

Winsock return Error An error has been returned from Winsock. 
The error is in the network line. Check the 
PC’s network settings and the network cable 
connection. If the problem still remains, 
contact your network manager. 

W 

Write Error An error has occurred while reading the data 
to GP internal memory. Re-try data transfer. If 
the error occurs again, use the GP’s 
self-diagnosis feature and identify the 
problem. If necessary, contact your local GP 
distributor. 

 
����� File Converter Errors

����� Screen Transfer Errors (from previous page)

 Error Message Cause/Solution 
Cannot read system information An error is recognized in the SCD file. Check 

that the SCD file is created by Parts Box 
Version 2.0. 

Conversion aborted - database space 
insufficient! 

The disk space is not sufficient to perform 
data conversion. Reserve sufficient free 
space and retry file conversion. 

Conversion destination (convert to) folder 
is not designated. 

The conversion destination folder where the 
converted file will be stored is not specified. 
Specify it. 

C 

Conversion parameters are not set The conversion parameters for the 
information to be converted (conversion 
source, conversion destination file 
information) are not set. Set the required 
information. 

Insufficient memory The memory required for file conversion is 
insufficient. Quit all other applications, then 
retry file conversion. 

I 

Invalid PLC table The PLC table file is not a GP file, is corrupt 
for some reason, or has been deleted. 
Re-install the Device/PLC type master data 
file from the master disk. 

Appendix.1 Error Messages
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����� Project Compression and Execution Errors
 Error Message Cause/Solution 

Disk Error - File Error During Read The file cannot be opened. The most 
probable cause is corruption of the file or disk 
failure. Solve the problem and try again to 
read the file. 

D 

Disk Error - File Error During Write The disk is write-protected. Take off the write 
protection. This error also occurs when the 
disk is defective. 

Unable to open file ‘***’. 
Would you like to try to find it elsewhere? 

A portion of the file cannot be found. To 
recover divided files and recreate the original 
project file, all the divided files are required. 

U 

Unable to open file ‘***’ for reading, 
aborting... 

The file cannot be opened. The file is corrupt 
or the disk has a problem. After correcting the 
problem, re-try opening the file. 

 * The file named is inserted here ***.

����� Rebuild Tool Errors
 Error Message Cause/Solution 

F File version does not match The specified file contains settings for a 
version which is not supported by this 
rebuilding tool. Re-specify a project file (PRW 
file) compatible with GP-PRO/PB III for 
Windows. 

R Rebuilding the File has Failed Recovery of the file has failed. This file is 
damaged and cannot be rebuilt.  

S PRW header is destroyed The file header information is corrupt. This 
file cannot be rebuilt and cannot be used. 

 

 Error Message Cause/Solution 
Old CPL files from DOS version PROPB 
must be selected directly from the library 
browser’s file type menu 

The specified CPL file has been created by 
the GP-PRO/PB III DOS version. Select the 
file from the file selection menu of the screen 
editor’s library browser. 

O 

Old PLC table and some functions may 
not work properly. 
Please use latest PLC table 

An old version of the PLC table file is 
installed. 
Re-install the new version of the Device/PLC 
type file from the master disk. 

PLC file error The PLC table file is not the type used for GP 
files, is corrupt for some reason, and has 
been deleted. Re-install the Device/PLC type 
master file from the master disk. 

P 

PLC file not found The specified PLC table file could not be 
found in the directory, or it is not the type 
used for a GP file. Re-install the Device/PLC 
type master file from the master disk. 

����� File Converter Errors (from previous page)

Appendix.1 Error Messages
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����� DXF File Conversion Errors
The error messages generated during DXF file conversion are as follows:
(xynn) <message> (line = ????)

  x : Conversion direction (1: DXF → GP / 2: GP → DXF)
  y : Procedure (1: Read   2: Conversion   3: Write)
nn : Error code
(line = ????) : Line No. of the DXF file causing the error

����� DXF File Conversion Errors
Error
Code Error Message Cause/Solution

01 Length Over in 1 record (line, ????) The single record length of the DXF file
exceeds 256 characters. Edit the error line so
that the length is less than 256 characters.

02 DXF Format Error (line, ????) Non-DXF data may be included. Correct the
format of the data at the error line.

03 HEADER SECTION Not Found The header section of the DXF file to be read
is not found. Add the header section.

04 $LIMMIN Not Found The header section of the DXF file to be read
does not have a $LIMMIN setting. Set the
option DXF size to “Use $EXTMIN,
$EXTMAX” and re-execute the program, or
add the $LIMMIN setting.

05 $LIMMAX Not Found The header section of the DXF file to be read
does not have a $LIMMAX setting. Set the
option DXF size to “Use $EXTMIN,
$EXTMAX” and re-execute the program, or
add the $LIMMAX setting.

06 $EXTMIN Not Found The header section of the DXF file to be read
does not have a $EXTMIN setting. Set the
option DXF size to “Use $LIMMIN, $LIMMAX”
and re-execute the program, or add the
$EXTMIN setting.

07 $EXTMAX Not Found The header section of the DXF file to be read
does not have a $EXTMAX setting. Set the
option DXF size to “Use $LIMMIN, $LIMMAX”
and re-execute the program, or add the
$EXTMAX setting.

08 EOF Not Found The EOF record is not specified at the end of
the DXF file to be read. Add the EOF record.

0A ENDSEC Not Found The ENDSEC record is not specified at the
end of the DXF file to be read. Add the
ENDSEC record.

0B ENDTAB Not Found (line, ????) The ENDTAB record is not specified at the
end of the TABLE section of the DXF file to
be read. Add the ENDTAB record.

0C (W) SEQEND Not Found (line, ????) SEQEND to be used as a pair with VERTEX
following the POLYLINE entity is not
specified. Add the SEQEND record to the
error line.

0D Insufficient Data (line, ????) The essential data for the element of each
entity is insufficient. Add the required data to
the error line.

Appendix.1 Error Messages
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����� DXF File Conversion Errors(from previous page)

Error
Code Error Message Cause/Solution

0E LTYPE Not Defined (line, ????) The line type name specified when the entity
line type is individually set is not defined in
the TABLE section. Add the data of the
preset line name to the TABLE section.

0F LAYER Not Defined (line, ????) The layer name set in the entity is not defined
in the TABLE section. Add the preset layer
name to the TABLE section.

10 STYLE Not Defined (line, ????) The character style name used in the entity is
not defined in the TABLE section. Add the
character style name to be used to the
TABLE section.

11 BLOCKS Not Defined (line, ????) The composite picture name which is
referenced by the INSERT and DIMENSION
entities is not defined in the BLOCK section.
Add the data of the preset composite picture
name to the BLOCK section.

21 Application Error An unexpected data case is found in the
intermediate file. (This does not occur
normally.) The temporary file created during
conversion may not have been written. Check
the free disk space and disk condition and
retry conversion.

22 BLOCKS Not Found The specified composite picture is not found
when converting the INSERT and
DIMENSION entities. Add the preset
composite picture data to the BLOCK section.

23 (W) BLOCKS - Over Nesting Limit The reference layers of the composite picture
are more than 10 layers. A compound
graphic with more than 10 layers cannot be
converted. Correct the graphic data so that
the number of layers will be 10 or less.

24 (W) Conversion Data is Over 16 Kbytes The output GP screen size (after conversion)
exceeds 16 K bytes. The subsequent data
cannot be converted.

41 Format Error The format of the GP data is not correct. GP
data which is not supported may be involved,
or the screen data is corrupt. Use the Editor
to save the screen again and retry
conversion.

42 (W) Check Sum Error The checksum of the GP screen read is not
correct. The data may be corrupt. Use the
Editor to save the screen again and retry
conversion.

43 (W) Library Screen Not Found ???? The screen being called is not found in the
project. Create a destination screen or delete
the data which calls the screen.

44 (W) Mark Screen Not Found ???? The mark screen being called is not found in
the project. Create the destination mark
screen or delete the data which calls the
mark.
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Error
Code Error Message Cause/Solution

45 (W) Library Screen Type Error (0x????) The type of the screen used in the screen call
menu is not a base, mark, trend graph,
keypad, or an image screen. GP data which
is not supported may be involved, or the
screen data may be corrupt. Use the Editor to
save the screen again and retry conversion.

46 (W) Screens – Over Nesting Limit The screen calling layers are greater than 10.
Screens with more than 10 layers cannot be
converted. Correct the data so that the
number of layers will be 10 screens or less.

81 Disk Full When writing the temporary file or output file,
the disk has become full. Increase the
amount of free disk space for the temporary
file and output file.

82 Insufficient Memory The process is interrupted because of
insufficient memory area during operation.
Close all other applications and retry the
operation.

FF User Abort The user has interrupted the operation during
conversion.

����� DXF File Conversion Errors(from previous page)

����� File Management Errors
 Error Message Cause/Solution 

C Cannot Write File ???? The data cannot be written to the specified 
output file name. Check the amount of free 
disk, or if the disk is write-protected. 

Input File Name Format Error The specified input file name is different from 
the file name created by the editor. Specify 
the correct file name. 

I 

Input File Not Found The specified input file is not found. Check 
the file name and specify the existing file. 

O Output File Name Format Error The specified output file name cannot be 
recognized by the editor. Specify the correct 
file name. 

W Work Directory Not Found ???? The folder in which the temporary file is 
created is not found. Specify the existing 
folder using the environment variable TEMP. 
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����� Simulation Errors

Appendix.1 Error Messages

 Error Message Cause/Solution 
A Abnormal CF card in GP Slot. Check that the CF Card is the correct type for 

the GP. If it is, retry. 
Cannot read data in project file. The screen data cannot be read from the 

project file. Quit other functions and 
re-execute. 

Cannot write simulation information data. 
Unable to start simulation. 

The system cannot write the data to the 
simulation information file. Check that the 
simulation file (TAGDATA.CSV) is not used in 
other applications and that the directory in 
which EXE exists is not write-protected. 

C 

CF card in GP Slot has file 
[CAPTURE¥¥CP65535.JPG] already. GP 
cannot generate more filename and 
snapshot file. ¥n¥n Please make rearrange 
files in CF card. 

Delete the CF Card's 
"CAPTURE/CP65535.JPG" file, reorganize 
the CF Card's files, and retry. 

GP cannot find CF card. Check that the CF Card is securely inserted 
into the CF Card Slot. 

G 

GP cannot write snapshot to CF card. Check that the amount of free space on the 
CF Card is sufficient, and if it is, retry. 

N Not enough memory. Please close other 
applications. 

Retry this action after closing other active 
applications.  

P PLC Data File cannot be found. The PLC table file does not exist in the 
specified directory. The PLC table file is 
deleted or it is not for the GP. Select the 
Device/PLC type file from the master disk 
and reinstall the file. 

Simulation aborted by link down. ¥n 
Please restart GP hardware. 

A problem such as a cable disconnection, 
etc. has caused the PC and the GP to not be 
able to communicate, which has led to the 
halting of the Simulation. To restart the 
Simulation feature, first manually reset the 
GP (including checking the power cord), and 
confirming that the Data Transfer cable is 
securely connected to both the PC and the 
GP. Next, restart the Simulation.    

Simulation start failed. The GP does not respond to the simulation 
start command. The GP may be in another 
mode, or data transfer may have failed. 
Check the communication port settings, cable 
connections, GP unit power supply, and then 
retry the simulation data transfer. 

Simulation data file cannot be found. The simulation information file 
(TAGDATA.CSV) does not exist in the 
specified directory. Check (turn on) the 
Transfer menu [Settings] area’s [Simulation] 
selection, then retry the Simulation. 

Simulation link goes down.  Do you want 
to abort simulation? 

If you wish to continue the Simulation, check 
that the Data Transfer cable is securely 
connected, and click [No]. Normally, after a 
brief pause the Simulation will be restored. 
However, timing and other problems can 
prevent restoration, and will cause this 
message to reappear. In that case, click on 
[No] and quit the simulation. 

S 

Snapshot incomplete. Check that the GP's Data Transfer cable is 
securely connected and retry. 

T The buzzer will not stop during simulation 
and the GP will not display data. All the 
[System area] parameters (setting values) 
on the [Simulation] screen are the same. 

Is an address 32768 (8000h) or higher used? 
Change the current address temporarily to 
32767 or lower and retry the simulation. 
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 Error Message Cause/Solution 
Cannot access **** file. File access has failed and the file cannot be 

accessed. 
Cannot access the drive. Device 
preparation is not possible. 

Failed to access the drive. Check if an error 
occurred in any disk during file access. 

Cannot create **** file. Write error. File writing has failed. Please check that the 
disk is correctly inserted and not write 
protected. 

Cannot designate CF Card Output Folder. 
Please designate folder. 

Please designate the CF Card data’s output 
folder. 

Cannot find **** file. The designated file cannot be found. 
Cannot load the Share.exe program. This program is currently being used by 

another program. When more than one 
application will be using this program, be sure 
to install it in your software’s application 
folder. 

Cannot open **** file. The designated file cannot be opened. 
Cannot see sound data. Data conversion was performed after the CF 

Card’s designated sound file was deleted. 

C 

Cannot set address. Invalid address. Designated address setting will cause 
continuously set addresses to exceed 
allowed range. 

 

����� Sound Setting Errors
(**** means the User’s designated file name will be inserted here.)

Appendix.1 Error Messages
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����� Filing Data Errors

Appendix.1 Error Messages

 Error Message Cause/Solution 
Deleted Folder while creating **** file. The folder was deleted during data write.  D 
Drive disk is full. Data write failed. Failed to write data to the disk. Check the 

disk capacity. 
E Error in Device Address An unrecognized device address has been 

specified. Please check that the address is 
correct. 

**** file is locked. Access is not possible. The file cannot be accessed. Check if the file 
is being used by any other application(s). 

**** file is destroyed. The file is destroyed (unreadable). Check on 
the condition of the file’s disk. 

F 

**** file format error. The file is destroyed (unreadable). Check on 
the condition of the file’s disk. 

L Limit for sound data! /nNot all will be 
merged. 

Registered number of sound files to be 
merged exceeds limit. 

P Protected **** file. Cannot be accessed. Check if the file is read-only, or if the disk is 
locked. 

S Seek error occurred during **** file 
access. 

An error has occurred during file access. 
Check the condition of the file’s disk. 

The currently operation exceeds the GP’s 
internal memory limit. Paste cannot be 
performed. 

Reduce the amount of data copied.  

This type of WAV file format is not 
supported. Only PCM, 11KHz, 16 bit, and 
Mono type data can be read.  

Change the data’s format to PCM, 11KHz, 16 
bit, and Mono.   

T 

This data already exists. Do you wish to 
overwrite? 

Sound data already exists in the designated 
sound data save destination. 

W WAV file is too large. All data cannot be 
converted. Is partial conversion OK? 

The file is too large and all cannot be 
converted to a GP file. If possible, reduce the 
file’s size. 

The currently operation exceeds the GP’s 
internal memory limit. Paste cannot be 
performed. 

The desired Paste operation’s data is too 
large for the GP’s memory. Reduce the 
amount of data to be copied.  

This type of WAV file format is not 
supported. Only PCM, 11KHz, 16 bit, and 
Mono type data can be read.  

Change the data’s format to PCM, 11KHz, 16 
bit, and Mono.   

T 

This data already exists. Do you wish to 
overwrite? 

Sound data already exists in the designated 
sound data save destination. 

W WAV file is too large. All data cannot be 
converted. Is partial conversion OK? 

The file is too large and all WAV data cannot 
be converted to a GP file. If possible, reduce 
the file’s size. 

 

����� Sound Setting Errors(from previous page)

Error Message Cause/Solution

C Cannot import CSV file. Data is out of range
or format is incorrect.

The number of blocks or data amounts is
inappropriate in the CSV file to be imported. Enter
the correct value(s).

D Data is larger than designated data range.
Please check the data settings.

Data from outside the Filing Data’s range is
present. Check the designated data range settings
and change them if necessary.

E Exceeds folder addition limit.

Up to 64 folders can be stored in the internal
memory and up to 8999 folders can be stored in
the CF card. Any folder cannot be added because
the number of folders will exceed the limit.
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����� Logging Data Errors

Appendix.1 Error Messages

����� Filing Data Errors (from previous page)

Error Message Cause/Solution

F
File cannot be accessed and data cannot be
saved. Please check the CF Card’s output
folder.

Check if the CF Card is write-protected. Either
remove the write protection or change the
destination folder.

I Internal memory is not sufficient to save data.
Please reduce the block or data settings.

The current settings will overflow the GP’s
memory. Please reduce either the block or data
settings.

P Please enter a Block name. Nothing has been entered for the Filing Data’s
Block data. Please enter a name.

T
The currently selected data range exceeds
the maximum amount allowed. Paste cannot
be performed.

Please reduce either the amount of data copied or
the number of blocks copied.

W
When using 32 bit data settings the
maximum number of data items is 20. OK to
delete items over 20?

When using 16 bit data, up to 40 items can be
used; with 32 bits, maximum is 20. Be sure the
data type fits your data needs.

����� Data Transfer Function Errors

Error Message Cause/Solution

A Address Entry limit reached. No more
addresses can be entered. Reduce the number of device addresses used.

C Character size is too large. Please use a
different size.

Designated character is larger than GP ’ s
character matrix. Please select a smaller size.

D Display file data size is over maximum. Reduce the size of the designated display.
M Maximum number of lines is 40. Be sure the number selected is 40 or less.

Paste failed.

The current paste settings (range, etc.) are not the
same as the paste destination. Or, the paste
action may delete a column or effect another data
item’s settings.

Printer file data size is over. Reduce the size of the area/amount of data to be
printed.

Time settings cannot exceed 24 hours. Please
adjust the settings.

Change the settings so that the time value is 24
hours or less.

The no. of times x no. of blocks should be
less than or equal to 2048.

Be sure the number of times and number of
blocks produces a result that is 2048 or less.

T

P

Error Message Cause/Solution

C annot create Index File. No file exists in
C F C ard folder.

The index file cannot be created since there
is no CSV file within the CF Card folder's
"FILE" folder.

C ontrol A ddress cannot be disabled
during address operation.

The Control Address cannot be disabled
during address operation.

F File cannot be loaded. The file has been erased or access to the
file is not authorized.

P Part of data cannot be loaded. Delete the data outside the range or ignore
the error and continue the operation.

Source file and destination file are the
same. Data cannot be copied. Change the destination to another file No.

Specified condition No. exists. C annot be
registered. Specify an unused condition No.

S

C
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 Error Message Cause/Solution 
C Copy has failed. Please check the disk for any problems. 

����� CF Card Tool  Errors

 Error Message Cause/Solution 
Data could not be created. An error occurred while 2-Way Driver data 

was being created. Check the volume 
available of the disk being used. Also, check 
if the project file exists or not. 

D 

Data could not be saved. An error occurred while 2-Way Driver data 
was being saved. Check both disk memory 
and if the project file exists or not. 

����� 2-Way Driver Setting Errors

Appendix.1 Error Messages

����� Security Settings Errors

����� Time Schedule Feature Errors

Error Message Cause/Solution

Same Password has been set.  Please change
the password of  level  ** or  level  **.

The same password cannot be used on more
than one level.  Please change the password into
either password the dialog displays.

Specify Password Level 15 when switching
to offline is Set.  Please Set Password Level
15.

Set the Password for Security Level 15.
Otherwise, disalble [Specify Password Level 15
when switching to offline is set.]

S

Error Message Cause/Solution

D Day of the week is not set. Be sure to set the day.

S Start & End Time are Same. Do not signify th esame end time as the start time.

����� Import/Export Of Text Screen Errors
Error Message Cause/Solution

S Screen data size over.  Aboring convert.

The imported text data contains too many text
strings.The maximum amount of text strings
allowed is 51,200. Reduce the size of the test data
to fit this limit.

T

The file will be divided, as the CSV data is
more than 256 rows it is not possible to
display at a time.  Would you like to
continue?

Attempted to export 256 or more text screens to a
CSV file. To split the file and export it, click [Yes].
To export the file without splitting it, click [No].

Wrong screen number.
Please setting 1-8999.

The range of text screen number(s) being
registered to the Text Table is incorrect. Be sure
the range is from 1 to 8999.

Wrong text length.  (Max 30 character)
Aboring convert.

The title of the text screen to register to the Text
Table is more than 30 characters. Modify this title
so that it is 30 characters or less.

W
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A.2      Troubleshooting
This section describes how to solve problems generated when using GP-
PRO/PB III.
Before you begin troubleshooting, please check the following items again. If
you answer “Yes” to all the questions, start troubleshooting. If you answer
“No” to any one of the questions, set the required item and then start
troubleshooting.
If the error still occurs after troubleshooting, fill the details on the error in
the provided trouble report sheet and contact DIGITAL.

Error  Cause/Solution 
Are all the environment settings correct? 
            Introduction Guide  
Is your personal computer hard disk’s free space amount sufficient? 
Double-click on the Windows icon. Double-click on the drive in which GP-PRO/PB 
III has been installed. Use the [File] menu’s [Property] feature to check the amount 
of free disk space. If the free disk space is insufficient, empty the trash box or 
delete unnecessary files from the hard disk. 
Is the PC’s RAM memory capacity sufficient? 
Memory of 16 M byte or more is required. 
Click the Windows [Start] button first, and then click on the [Settings], [Control 
Panel], and [System] selections. Click the virtual memory button in the system 
property dialog box and check that “Auto Setting (recommended)” is selected. If 
“Manual Setting” is selected, change the setting to “Auto Setting (recommended)”. 
Restart the PC and then restart GP-PRO/PB III. 

GP-PRO/PB III 
will not start up 

Some applications do not work well with GP-PRO/PB III and such an application 
may interfere with the startup of GP-PRO/PB III. 
Quit all running applications and delete them from the Startup menu ([Startup] in 
the Windows [Program] menu. Restart the PC and then restart GP-PRO/PB III. 

 

 A.2.1 Troubleshooting List

Appendix.2 Troubleshooting

Item Check
Is your personal computer’s OS Windows 95/ 98/
Me/ NT/ 2000/ XP
Is the memory capacity greater than 32 Mbytes?
Is your PC hard disk’s amount of free space
sufficient?
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Error  Cause/Solution 
Is the Editor’s screen open? 
With GP-PRO/PB III, you must select the project file and open a drawing screen 
before you can draw any objects. Create a new a screen or open an existing one. 
Does the disk have enough free space? 
Prepare a disk which has enough free space. 

Cannot draw  
graphic data 

Is the symbol editor started? 
The screen editor and the symbol editor cannot be started at the same time. Check 
that the symbol editor window has been closed. 
Is the file write-protected? 
Check whether the floppy disk is write-protected using the [Property] feature. 

Cannot save the 
screen 
file’s data Does the disk you are saving to have enough free space? 

Prepare a disk which has enough free space. 
Is the proper cable being used? 
Be sure to use the DIGITAL transfer cable (option). 
Is the GP in the “Screen Data Transfer Mode” or “Run Mode”? 
If not, communications between the PC and the GP will not be possible. 
            GP User Manual 
When receiving data from the GP, does your PC’s hard disk have enough space? 
Prepare the disk so that it has enough free space. 
Is the communication port setting correct? 
Check that the transfer cable’s serial port matches the port set in [Transfer]. 

Cannot 
communicate 
between the 
PC and the  
GP 

Does another application use the same communication port? 
Check whether there is competition between the GP and a modem, or other 
applications which require the communication port. 

If: 
the Buzzer won't 
stop. The GP wont 
display data. 
Data transfer fails. 

The Data Transfer cable may be loose or connected to the wrong COM port. Also, 
the System Data area may be incorrectly accessed, or the GP may be incorrectly 
set up. For details, see the next page's Appendix 2.2. 

The printer  
does not run/ hard 
copy is not printed  
correctly 

Is the OS’s (Windows) printer setting correct? 
Check the printer setting using the Control Panel’s printer property. 

The desired 
Device/PLC type 
and GP type are 
not listed  
when creating a 
new project 

Did you select the required Device/PLC and GP types when installing GP-PRO/PB 
III? (Custom Installation) 
When customizing the system installation, you can select the PLC and the GP 
types. You cannot install a Device/PLC type or a GP type if it has not been 
selected previously. Re-install the system with the desired PLC and GP types. 

Simulation cannot 
be performed 

Possible causes are that LS area data is being backed up to the GP, via the [GP 
System Settings], or that an LS area Special Relay is being used via D-Script or by 
a W-tag start up bit. If any of these are true, the simulation cannot be performed. 
Deselect the [Option] menu - [Settings] - [LS Device Simulation]. 

The GP2000 series 
cannot be booted. 
Nothing is 
displayed on the 
screen and a 
buzzer 
intermittently 
sounds 

The GP was not successfully set up. For details, refer to “Buzzer will not Stop/No 
Display on the GP/Transfer Disabled”. 
 

During Simulation 
buzzer won’t stop. 
GP will not display. 
Simulation 
screen’s [System 
Area] shows all the 
same values. 

Are you using address 32768 (8000h)? 
Try changing your address to 32767 or lower and restarting the simulation. 
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����� Error Pattern by Symptom

����� Solution 1

1. Transfer from the PC

Transfer programs and screen data from the PC (GP-PRO/PBIII for
Windows) to the GP while the buzzer of the GP sounds. (Be sure that
your PC and the transfer cable are able to transfer programs and data to
the GP.) GP-PRO/PB for Windows has been programed to handle a
variety of problems and retry data transfer repeatedly if the GP fails to
respond successfully. In this case, GP-PRO/PB for Windows will try
repeatedly to complete handshake mode (it may take more than a minute
in some situations). After handshaking is completed, GP-PRO/PB for
Windows will begin to transfer the Memory Loader program, system
program, communication protocol program, expansion program and
screen data.

 A.2.2 Buzzer will not Stop/No Display on the GP/Transfer Disabled

Error
Pattern

Related
Models

Buzzer Sound
(Symptom)

GP
Screen

Probable Cause
Solution

(Reference)

1 All models

Pip, pip, pip, …
(Continues to beep
intermittently  or beeps
every second.)

Blank
(Black)

There is no startup program or the startup
program has been corrupted.(When the GP
is powered on)

Solutions 1, 3

2 All models None
Normal
Display

Transfer cable was removed.
Improper COM port was used.

Solutions 2, 3

3
GP2000
Series

Pip, pip, pip, …
(Continues to beep
intermittently  twice every
other second.)

4
GP70/77R

Series
None

5
GP2000
Series

None
Error

Message

System is not set up properly . The following
warning message is displayed: "No system
installed. Perform Screen Transfer (Force
System Setup)".

Solution 3

None
Buzzer sounds
continuously

Solution 3

Solution 46 All models

Blank
(Black)

The system for the target model has not been
downloaded.
(When the GP is powered on)

Invalid access is made to "+9" or "+14" of
the System Data Area.

Blank/
Normal

Refer to Solution 1 when error pattern 1 is observed.
Similarly, Solution 2 corresponds to Error Pattern 2.
When error pattern 3, 4 or 5 is observed, try the procedure described in
Solution 3. If Solution 1 or 2 does not solve the problem with error patterns
1 and 2, try Solution 3 as well.
Solution with the CF Memory Loader Tool is also available with the
GP2000 series.  � CF Memory Loader Operation
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����� Solution 2

The transfer cable is improperly connected or has been removed. The
improper COM port may have been selected. Confirm that the cable and
port are set up properly for data transfer and try again.

����� Solution 3

If error pattern 3, 4 or 5 has been observed, or Solution 1 or 2 does not solve
the problem, perform a forced transfer from your PC. Perform the transfer
even if the buzzer is sounding. (Confirm that the cable and PC are config-
ured for successful transfers.)

1. Select [Setup] from the [Setup] menu on the [Screen Transfer] to display
the [Transfer Settings] dialog box on the screen.

2. Select "Force System Setup" from the "Setup" field and click the [OK]
button.

3. Select [Screen Transfer] from the [Transfer] menu and perform a forced
transfer.

4. When the message "No System Program on the GP" is displayed on the
screen, click the [OK] button.
This message will not be displayed if the protocol has not been down-
loaded to the GP.

Appendix.2 Troubleshooting
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����� CF Memory Loader Operation (GP2000 series only)

Insert the CF Card containing the CF Memory Loader programs*  into the
GP and set the DIP SW No.1 located next to the CF Card slot to ON (see
figure below). Then turn ON the GP’s power supply. The CF Memory
Loader will then automatically start.
*IPL. SYS, MLD****. SYS, BK****. MEM; where **** represents the model
code of the target GP.

     10.6.5 Creating  Backup Data,  10.6.7 Sending
        Backup Data

Appendix.2 Troubleshooting

5. The message "Select GP Type" is displayed on the screen. Select the
model type and click the [OK] button.

Usually, the system automatically selects the connected model. However,
confirm the model type of the connected GP.

If an improper model type is selected here before a forced trans-
fer, the symptoms will recur.

6. Check the GP type and click the [OK] button. The system begins transfer-
ring the System Program, Protocol Program and screen data.
The restoration is completed when the transfer is completed successfully.
In some cases, the "handshaking" (transfer to the GP unit) with the GP
may not be successful.
If handshaking is unsuccessful, the system displays the following message
on the screen to ensure successful handshaking with the GP.

Power the GP OFF and ON again. The system will automatically resume the

transfer.

����� Solution 4

Check whether an incorrect value has been entered into the GP in "+9" or
"+14" of the System Data Area, or an invalid Start Address has been as-
signed for the System Data Area.
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Rear of GP
DIP SW

CF Card

Use the CF Memory Loader Tool to download the data to the GP.

After data download is finished, remove the CF Card, set DIP SW No.1
to OFF and restart your GP.

The buzzer may sound as described below when a problem is handled
with the CF Memory Loader Tool.

Error
Pattern

Applicable
Model Buzzer Sound (Symptom) Probable Cause

1 GP2000
Serise

Pip, pip, pip. …
(Continues to beep intermittently
three times every other second.)

MLD****. SYS of the CF memory loader does not exist or has
been corrupted. (This symptom may occur when the GP is
powered on by switching on switch No.1 of the DIP SW near
the CF card slot or the CF startup is performed through the 3-
point pressing menu.)

2 GP2000
Serise

Pip, pip, pip, pip. …
(Continues to beep intermittently
four times every other second.)

IPL. SYS of the CF memory loader exists but has been
corrupted. (This symptom may occur only if the CF startup is
performed through the 3-point pressing menu.)

Appendix.2 Troubleshooting

����� Solution of Error Pattern 1

If there is no “MLD****. SYS” for the target GP present in the CF Card,
copy or transfer it from your PC.

If the file “MLD****. SYS” is present in the CF Card and the problem still
occurs, reformat the CF Card and resend both this file and “IPL. SYS” or
“MLD****. SYS,” to the CF Card.

����� Solution of Error Pattern 2

Reformat the CF Card and then send the necessary files, including “IPL.
SYS” or “MLD****. SYS” to the CF Card.



Appendix-29

Appendices

GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

Appendix.3 Address Conversion Tables

A.3      Address Conversion Tables
Addresses can or cannot be converted depending on the address combination.
The combinations which cannot be converted vary with the external device
manufacturers. See the following address global conversion table to convert the
addresses correctly.

����� How to Read the table
The symbols used in the table have the following meanings:

:  When the address conversion device type is set to [Word], the
system converts both Word and bit devices. When the [Bit] setting
is used, only bit device addresses are changed.
: When the selected conversion mode is [Word], only Word ad

dresses are converted. Selecting [Bit] will convert only bit addresses.
: When [Word] mode is selected, the system converts only word

addresses.
: When [Bit] mode is selected, the system converts only bit

addresses.
(Blanks cannot be converted)
For the timers and counters, the bit indicates the contact or coil used, and the
word indicates the current value (elapsed value) or setting value

�����

�����

�����

�����

����� Address Conversion Table List

Memory link SIO Type
Memory Link Ethernet Type
CC-Link (Remote Device Unit)
Device Net Slave I/O
Siemens Profibus
Siemens Interbus S

After
conversion

LS
Before

conversion
LS System

Area �
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����� Mitsubishi Electric MELSEC-A

����� Mitsubishi Electric MELSEC-N

X Y M L F B TS/TC/TN CS/CC/CN D W R LS
X

Input Relay � � � � � � � � � � � �

Y
Output Relay � � � � � � � � � � � �

M
Internal Relay,
Special Relay

� � � � � � � � � � � �

L
Latch Relay � � � � � � � � � � � �

F
Annunciator � � � � � � � � � � � �

B
Link Relay � � � � � � � � � � � �

TS/TC/TN
Timer � � � � � � � � � � � �

CS/CC/CN
Counter � � � � � � � � � � � �

D
Data/Special

Register
� � � � � � � � � � � �

W
Link Register � � � � � � � � � � � �

R
File Register � � � � � � � � � � � �

LS
System Area � � � � � � � � � � � �

After Conversion

B
ef

or
e 

C
on

ve
rs

io
n

X Y M L F B TS/TC/TN CS/CC/CN D W R LS
X

Input Relay � � � � � � � � � � � �

Y
Output Relay � � � � � � � � � � � �

M
Internal Relay,
Special Relay

� � � � � � � � � � � �

L
Latch Relay � � � � � � � � � � � �

F
Annunciator � � � � � � � � � � � �

B
Link Relay � � � � � � � � � � � �

TS/TC/TN
Timer � � � � � � � � � � � �

CS/CC/CN
Counter � � � � � � � � � � � �

D
Data/Special

Register
� � � � � � � � � � � �

W
Link Register � � � � � � � � � � � �

R
File Register � � � � � � � � � � � �

LS
System Area � � � � � � � � � � � �

After Conversion

B
ef

or
e 

C
on

ve
rs

io
n
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After Conversion  

X Y N S T/TC/TS C/CC/CS D LS 
X  

Input Relay � � � � � � � � 
Y  

Output Relay � � � � � � � � 
M  

Auxiliary Relay, 
 Keep Relay 

� � � � � � � � 

S  
State � � � � � � � � 

T/TC/TS  
Timer � � � � � � � � 

C/CC/CS  
Counter � � � � � � � � 

D  
Data Register � � � � � � � � 

B
ef

or
e 

C
on

ve
rs

io
n 

LS  
System Area � � � � � � � � 

����� Mitsubishi Electric MELSEC-F2

����� Mitsubishi Electric MELSEC-FX

X Y M M8 S TS CS TN CN D D8 R LS
X

Input Relay
Y

Output Relay
M

Auxiiary Relay
M8

Special Auxiiary
Relay

S
State

TS
Timer Contact

CS
Counter (contact)

TN
Timer

(current value)
CN

Counter
(current value)

D
Data Resister

D8
Special Data

Resister
R

Extend Resister
LS

System Area

After Conversion

noisrevno
C erofe

B
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����� Mitsubishi Electric MELSEC-FX2

����� Mitsubishi Electric FREQROL Series

- P
All devices except
for parameter LS

Parameter except
for FR-S500,
E500's Pr-37

� � � �

P � � � �

Parameter for FR-
S500, E500's Pr-37 � � � �

All devices except
for parameter � � � �

LS
System Area � � � �

After Conversion

B
ef

or
e 

C
on

ve
rs

io
n

X Y M S TS/CS TN/CN D D8 R LS
X

Input Relay � � � � � � � � � �

Y
Output Relay � � � � � � � � � �

M
Internal Relay � � � � � � � � � �

S
Step Relay � � � � � � � � � �

TS/CS
Timer � � � � � � � � �

TN/CN
Counter � � � � � � � � �

D
Data Register � � � � � � � � � �

D8
Special

Data Register
� � � � � � � � � �

R
Extended Register � � � � � � � � � �

LS
System Area � � � � � � � � � �

After Conversion

B
ef

or
e 

C
on

ve
rs

io
n
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����� Mitsubishi Electric MELSEC-QnA

X Y M SM L F V S B SB TS TC SS SC CS CC TN SN CN D SD W SW R
0R

31R
LS

X
Input Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

Y
Output Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

M
Internal Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

SM
Special Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

L
Latch Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

F
Annunciator � � � � � � � � � � � � � � � � � � � � � � � � � �

V
Edge Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

S
Step Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

B
Link Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

SB
Special Link Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

TS
Timer (contact) � � � � � � � � � � � � � � � � � � � � � � �

TC
Timer (coil) � � � � � � � � � � � � � � � � � � � � � � �

SS
Aggregate Timer

(contact)
� � � � � � � � � � � � � � � � � � � � � � �

SC
Aggregate Timer (coil) � � � � � � � � � � � � � � � � � � � � � � �

CS
Counter (contact) � � � � � � � � � � � � � � � � � � � � � � �

CC
Counter (coil) � � � � � � � � � � � � � � � � � � � � � � �

TN
Timer (current value) � � � � � � � � � � � � � � � � � � � �

SN
Aggregate Timer

(current value)
� � � � � � � � � � � � � � � � � � � �

CN
Counter (current

value)
� � � � � � � � � � � � � � � � � � � �

D
Data Register � � � � � � � � � � � � � � � � � � � � � � � � � �

SD
Special Data Register � � � � � � � � � � � � � � � � � � � � � � � � � �

W
Link Data Register � � � � � � � � � � � � � � � � � � � � � � � � � �

SW
Special Link Register � � � � � � � � � � � � � � � � � � � � � � � � � �

R
File Register (normal) � � � � � � � � � � � � � � � � � � � � � � � � � �

0R - 31R
File Register (serial) � � � � � � � � � � � � � � � � � � � � � � � � � �

LS
System Area � � � � � � � � � � � � � � � � � � � � � � � � � �

After Conversion
B
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����� MELSEC- Q Series (Q Mode CPU)

X Y M SM L F V S B SB TS TC SS SC CS CC TN SN CN D SD W SW R 0R
31R

LS

X
Input Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

Y
Output Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

M
Internal Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

SM
Special Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

L
Latch Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

F
Annunciator � � � � � � � � � � � � � � � � � � � � � � � � � �

V
Edge Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

S
Step Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

B
Link Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

SB
Special Link Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

TS
Timer (contact) � � � � � � � � � � � � � � � � � � � � � � �

TC
Timer (coil) � � � � � � � � � � � � � � � � � � � � � � �

SS
Aggregate Timer

(contact)
� � � � � � � � � � � � � � � � � � � � � � �

SC
Aggregate Timer

(coil)
� � � � � � � � � � � � � � � � � � � � � � �

CS
Counter (contact) � � � � � � � � � � � � � � � � � � � � � � �

CC
Counter (coil) � � � � � � � � � � � � � � � � � � � � � � �

TN
Timer (current

value)
� � � � � � � � � � � � � � � � � � � �

SN
Aggregate Timer

(current value)
� � � � � � � � � � � � � � � � � � � �

CN
Counter (current

value)
� � � � � � � � � � � � � � � � � � � �

D
Data Register � � � � � � � � � � � � � � � � � � � � � � � � � �

SD
Special Data

Register
� � � � � � � � � � � � � � � � � � � � � � � � � �

W
Link Data Register � � � � � � � � � � � � � � � � � � � � � � � � � �

SW
Special Link

Register
� � � � � � � � � � � � � � � � � � � � � � � � � �

R
File Register

(normal)
� � � � � � � � � � � � � � � � � � � � � � � � � �

0R - 31R
File Register

(serial)
� � � � � � � � � � � � � � � � � � � � � � � � � �

LS
System Area � � � � � � � � � � � � � � � � � � � � � � � � � �

After Conversion
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����� Mitsubishi Electric MELSEC-A/QnA/Q Series (MELSECNET/10)

X Y M SM L F B SB V S TS TC CS CC SS SC TN CN SN D SD W SW R LB LW LS
X

Input Relay � � � � � � � � � � � � � � � � � � � � � � � � � � �

Y
Output Relay � � � � � � � � � � � � � � � � � � � � � � � � � � �

M
Internal Relay � � � � � � � � � � � � � � � � � � � � � � � � � � �

SM
Special Relay � � � � � � � � � � � � � � � � � � � � � � � � � � �

L
Latch Relay � � � � � � � � � � � � � � � � � � � � � � � � � � �

F
Annunciator � � � � � � � � � � � � � � � � � � � � � � � � � � �

B
Link Relay � � � � � � � � � � � � � � � � � � � � � � � � � � �

SB
Special Link Relay � � � � � � � � � � � � � � � � � � � � � � � � � � �

V
Edge Relay � � � � � � � � � � � � � � � � � � � � � � � � � � �

S
Step Relay � � � � � � � � � � � � � � � � � � � � � � � � � � �

TS
Timer (contact) � � � � � � � � � � � � � � � � � � � � � � � � � � �

TC
Timer (coil) � � � � � � � � � � � � � � � � � � � � � � � � � � �

CS
Counter (contact) � � � � � � � � � � � � � � � � � � � � � � � � � � �

CC
Counter (coil) � � � � � � � � � � � � � � � � � � � � � � � � � � �

SS
Aggregate Timer

(contact)
� � � � � � � � � � � � � � � � � � � � � � � � � � �

SC
Aggregate Timer

(coil)
� � � � � � � � � � � � � � � � � � � � � � � � � � �

TN
Timer (current

value)
� � � � � � � � � � � � � � � � � � � � � � � � � � �

CN
Counter (current

value)
� � � � � � � � � � � � � � � � � � � � � � � � � � �

SN
Aggregate Timer

(current value)
� � � � � � � � � � � � � � � � � � � � � � � � � � �

D
Data Register � � � � � � � � � � � � � � � � � � � � � � � � � � �

SD
Special Data

Register
� � � � � � � � � � � � � � � � � � � � � � � � � � �

W
Link Data Register � � � � � � � � � � � � � � � � � � � � � � � � � � �

SW
Special Link

Register
� � � � � � � � � � � � � � � � � � � � � � � � � � �

R
File Register � � � � � � � � � � � � � � � � � � � � � � � � � � �

LB
Internal Link Relay � � � � � � � � � � � � � � � � � � � � � � � � � � �

LW
Internal Link Register � � � � � � � � � � � � � � � � � � � � � � � � � � �

LS
System area � � � � � � � � � � � � � � � � � � � � � � � � � � �

After Conversion
B
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����� MELSEC-A/QnA/Q Series (CC-Link Intelligent Device Unit)

X Y M SM L B SB TS TC SS SC CS CC TN SN CN D SD W SW R RX RY RWw Rwr LS
X

Input Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

Y
Output Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

M
Internal Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

SM
Special Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

L
Latch Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

B
Link Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

SB
Special Link Relay � � � � � � � � � � � � � � � � � � � � � � � � � �

TS
Timer (contact) � � � � � � � � � � � � � � � � � � � � � � � � � �

TC
Timer (coil) � � � � � � � � � � � � � � � � � � � � � � � � � �

SS
Aggregate Timer

(contact)
� � � � � � � � � � � � � � � � � � � � � � � � � �

SC
Aggregate Timer

(coil)
� � � � � � � � � � � � � � � � � � � � � � � � � �

CS
Counter (contact) � � � � � � � � � � � � � � � � � � � � � � � � � �

CC
 Counter (coil) � � � � � � � � � � � � � � � � � � � � � � � � � �

TN
Timer

(current value)
� � � � � � � � � � � � � � � � � � � � � � � � � �

SN
Aggregate Timer

(current value)
� � � � � � � � � � � � � � � � � � � � � � � � � �

CN
Counter

(current value)
� � � � � � � � � � � � � � � � � � � � � � � � � �

D
Data Register � � � � � � � � � � � � � � � � � � � � � � � � � �

SD
Special Data

Register
� � � � � � � � � � � � � � � � � � � � � � � � � �

W
Link Data Register � � � � � � � � � � � � � � � � � � � � � � � � � �

SW
Special Link

Register
� � � � � � � � � � � � � � � � � � � � � � � � � �

R
File Register � � � � � � � � � � � � � � � � � � � � � � � � � �

RX
Remote Input � � � � � � � � � � � � � � � � � � � � � � � � � �

RY
Remote Output � � � � � � � � � � � � � � � � � � � � � � � � � �

RWw
Remote Register � � � � � � � � � � � � � � � � � � � � � � � � � �

RWr
Remote Register � � � � � � � � � � � � � � � � � � � � � � � � � �

LS
System area � � � � � � � � � � � � � � � � � � � � � � � � � �
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After Conversion  

CH LR AR HR A TIM 
/T 

CNT 
/C D LS 

CH 
Relay � � � � � � � � � 

LR 
Data Link Relay � � � � � � � � � 

AR 
Auxiliary Memory Relay � � � � � � � � � 

HR 
Hold Relay � � � � � � � � � 

A 
Special Auxiliary Relay � � � � � � � � � 

TIM/T 
Timer � � � � � � � � � 
CNT/C 

Counter � � � � � � � � � 
D 

Data Memory � � � � � � � � � 

B
ef

or
e 

C
on

ve
rs

io
n 

LS 
System Area � � � � � � � � � 

LR (Data Link Relay), AR (Auxiliary Memory Relay) and HR (Hold Relay) are only for
SYSMAC C/SYSMAC-α. A (Special Auxiliary Relay) is only for SYSMAC CV.

����� Omron SYSMAC C/ααααα/CV
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After Conversion  
- W H A T  

(contact) 
C  

(contact) 
T  

(current) 
C! 

(current) 
D E EM TK IR DR LS 

Channel I/O  � � � � � � � � � � � � � � 
W 

Internal Auxiliary Relay � � � � � � � � � � � � � � � 
H 

Hold Relay � � � � � � � � � � � � � � � 
A 

Special Auxiliary Relay � � � � � � � � � � � � � � � 
T 

Timer (contact) � � � � � �   � � � � � � � 
C 

Counter (contact) � � � � � �   � � � � � � � 
T 

Timer (current value) � � � �   � � � � � � � � � 
C 

Counter (current value) � � � �   � � � � � � � � � 
D 

Data Memory � � � � � � � � � � � � � � � 
E0 ~ EC 

Extended Data Memory � � � � � � � � � � � � � � � 
EM 

Extended Data Memory � � � � � � � � � � � � � � � 
TK 

Task Flag � � � � � � � � � � � � � � � 
IR 

Index Register � � � � � � � � � � � � � � � 
DR 

Data Register � � � � � � � � � � � � � � � 

B
ef

or
e 

C
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LS 
System Area � � � � � � � � � � � � � � � 

����� Omron SYSMAC CS1

After Conversion

C0 C1 C3 A LS

C0 � � � � �

C1 � � � � �

C3 � � � � �

A � � � � �

LS � � � � �

Before
Conversion

����� Omron THERMAC NEO Controller
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After Conversion 
 

B/M/K/D/L W24 F A TR TS CR CS BD/DI/SI W30~W34 LS 
B/M/K/D/L 

Relay � � � � � � � � � � � 

W24 
Direct I/O � � � � � � � � � � � 

F 
Special Relay � � � � � � � � � � � 

A 
Announce Relay � � � � � � � � � � � 

TR 
Timer (current) � � � � � � � � � � � 

TS 
Timer (setup) � � � � � � �   � � � 

CR 
Counter (current) � � � � � � � � � � � 

CS 
Counter (setup) � � � � � � � � � � � 

BD/DI/SI 
Data Memory � � � � � � � � � � � 

W30 ~ W34 
File Memory � � � � � � � � � � � 

B
ef

or
e 

C
on

ve
rs

io
n 

LS 
System Area �  � � � � � � � � � � 

 ����� Fuji Electric MICREX-F/MICREX-F FLT-ASFK

 ����� Fuji Electric MICREX-SX Series

%IW %QW %MW1 %MW3 %MW10 LS

Input Memory %IW � � � � � �

Output Memory
%QW � � � � � �

Standard Memory
%MW1 � � � � � �

Retain Memory
%MW3 � � � � � �

System Memory
%MW10 � � � � � �

LS � � � � � �

After Conversion
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����� Fuji Electric FRENICS, FVR Series

F E C P H A o S M LS
Fundamental

Function
F

� � � � � � � � � �

Terminal Function
E � � � � � � � � � �

Control Function
C � � � � � � � � � �

Motor 1
P � � � � � � � � � �

High-level Function
H � � � � � � � � � �

Motor 2
A � � � � � � � � � �

Option
O � � � � � � � � � �

Command Data
S � � � � � � � � � �

Monitor Data
M � � � � � � � � � �

System Area
LS � � � � � � � � � �

After Conversion

B
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����� Fuji Electric FLEX-PC

X Y M L T/TS C/CS D W R LS
X

Input Relay � � � � � � � � � �

Y
Output Relay � � � � � � � � � �

M
Internal Relay � � � � � � � � � �

L
Latch Relay � � � � � � � � � �

T/TS
Timer � � � � � � � � � �

C/CS
Counter � � � � � � � � � �

D
Data Register � � � � � � � � � �

W
Link Register � � � � � � � � � �

R
File Register � � � � � � � � � �

LS
System Area � � � � � � � � � �

After Conversion

B
ef

or
e 
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rs

io
n
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����� Yasukawa Electric Memocon-SC

����� Yasukawa Electric PROGIC-8

O I N D W SW DW Z R SR DR LS
O

Output � � � � � � � � � � � �

I
Input � � � � � � � � � � � �

N
Current Value Register � � � � � � � � � � � �

D
Data Memory � � � � � � � � � � � �

W
Link Register � � � � � � � � � � � �

SW
System Register � � � � � � � � � � � �

DW
Register � � � � � � � � � � � �

Z
Link Relay � � � � � � � � � � � �

R
Internal Relay � � � � � � � � � � � �

SR
Stage Relay � � � � � � � � � � � �

DR
Data Register � � � � � � � � � � � �

LS
System Area � � � � � � � � � � � �

After Conversion

B
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Coil Input
Relay

Link
Coil

Input
Register

Output/
Keep

Register

Link
Register

Constant
Register

Ext.
Register

LS
System

Area

Coil � � � � � � � � �
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Extended Timer TV � � � � � � � � � � � � � � � � �
Extended Timer

(Elapsed Value) TM � � � � � � � � �

LS � � � � � � � � � � � � � � � � � � �
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After Conversion 
 

A T 
(contact) C T  

(current) B Register File 
Register LS 

A 
Relay � � � � � � � � 

T 
Timer (contact) � � �   � � � � 

C 
Counter (contact) � � �   � � � � 

T 
Timer/Counter 

(current) 
�     � � � � � 

B 
Timer/Counter 

(current) 
� � � � � � � � 

Register � � � � � � � � 

File Register � � � � � � � � 
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LS 
System Area � � � � � � � � 

 

����� Matsushita Electric Works MEWNET

����� Sharp New Satellite JW

After Conversion 
 

X Y R L EV SV DT Ld FL LS R9 
X  

Input Relay � � � � � � � � � � � 

Y  
Output Relay � � � � � � � � � � � 

R  
Internal/Special Relay � � � � � � � � � � � 

L  
Link Relay � � � � � � � � � � � 

EV  
Timer/Counter (elapsed 

value) 
� � � � � � � � � � � 

SV  
Timer/Counter (setup) � � � � � � � � � � � 

DT  
Data Register � � � � � � � � � � � 

Ld  
Link Register � � � � � � � � � � � 

FL  
File Register � � � � � � � � � � � 

LS  
System Area � � � � � � � � � � � 
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Rq  
Special Relay � � � � � � � � � � � 
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R Joint Register is only for FA-M3.

����� Yokogawa Electric  FACTORY ACE

�����  Yokogawa Electric UT2000/Yokogawa M&C Green Series

D I LS

D
D Register � � �

I
I Relay � � �

LS
System

Area
� � �B
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After Conversion

X Y I E M L T C TP CP TS CS D B R Z W LS
X

Input Relay � � � � � � � � � � � � � � � � � �

Y
Output Relay � � � � � � � � � � � � � � � � � �

I
Internal Relay � � � � � � � � � � � � � � � � � �

E
Common Relay � � � � � � � � � � � � � � � � � �

M
Special Relay � � � � � � � � � � � � � �

L
Link Relay � � � � � � � � � � � � � �

T
Timer (contact) � � � � � � � � � � � � � � � � � �

C
Counter (contact) � � � � � � � � � � � � � � � � � �

TP
Timer (current) � � � � � � � � � � � � � � � �

CP
Counter (current) � � � � � � � � � � � � � � � �

TS
Timer (setup) � � � � � � � � � � � � � � � �

CS
Counter (setup) � � � � � � � � � � � � � � � �

D
Data Register � � � � � � � � � � � � � � � � � �

B
File Register � � � � � � � � � � � � � � � � � �

R
Joint Register � � � � � � � � � � � � � � � � � �

Z
Special Register � � � � � � � � � � � � � � � � � �

W
Link Register � � � � � � � � � � � � � � � � � �

LS
System Area � � � � � � � � � � � � � � � � � �
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����� Toyota Machine Works TOYOPUC-PC2

0 1 3 4 LS
0 � � � � �

1 � � � � �

3 � � � � �

4 � � � � �

LS � � � � �

After Conversion

Before
Conversion

����� Yokogawa Electric  FCN/FCJ Series

X Y M K L C N D R B S LS
X

Input Relay � � � � � � � � � � � �

Y
Output Relay � � � � � � � � � � � �

M
Internal Relay � � � � � � � � � � � �

K
Keep Relay � � � � � � � � � � � �

L
Link Relay � � � � � � � � � � � �

V
Special Relay � � � � � � � � � � � �

N
Current Value

Register
� � � � � � � � � � � �

D
Data Register � � � � � � � � � � � �

R
Link Register � � � � � � � � � � � �

B
File Register � � � � � � � � � � � �

S
Special Register � � � � � � � � � � � �

LS
System Area � � � � � � � � � � � �
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����� Toyota Machine Works TOYOPUC-PC3 (PC3-J Series)

X Y M K L V P T C D R S N B EX EY EM EK EL EV EP ET EC ES EN H U LS
X

Input � � � � � � � � � � � � � � � � � � � � � � � � � � � �

Y
Output � � � � � � � � � � � � � � � � � � � � � � � � � � � �

M
Internal Relay � � � � � � � � � � � � � � � � � � � � � � � � � � � �

K
Keep Relay � � � � � � � � � � � � � � � � � � � � � � � � � � � �

L
Link Relay � � � � � � � � � � � � � � � � � � � � � � � � � � � �

V
Special Relay � � � � � � � � � � � � � � � � � � � � � � � � � � � �

P
Edge Detection � � � � � � � � � � � � � � � � � � � � � � � � � � � �

T
Timer � � � � � � � � � � � � � � � � � � � � � � � � � � � �

C
Counter � � � � � � � � � � � � � � � � � � � � � � � � � � � �

D
Data Register � � � � � � � � � � � � � � � � � � � � � � � � � � � �

R
Link Register � � � � � � � � � � � � � � � � � � � � � � � � � � � �

S
Special Register � � � � � � � � � � � � � � � � � � � � � � � � � � � �

N
Current Value

Register
� � � � � � � � � � � � � � � � � � � � � � � � � � � �

B
File Register � � � � � � � � � � � � � � � � � � � � � � � � � � � �

EX
Extended Input � � � � � � � � � � � � � � � � � � � � � � � � � � � �

EY
Extended Output � � � � � � � � � � � � � � � � � � � � � � � � � � � �

EM
Extended

Embedded Relay
� � � � � � � � � � � � � � � � � � � � � � � � � � � �

Ek
Extended Keep

Relay
� � � � � � � � � � � � � � � � � � � � � � � � � � � �

EL
Extended Link

Relay
� � � � � � � � � � � � � � � � � � � � � � � � � � � �

EV
Extended Special

Relay
� � � � � � � � � � � � � � � � � � � � � � � � � � � �

EP
Extended Edge

Relay
� � � � � � � � � � � � � � � � � � � � � � � � � � � �

ET
Extended Timer � � � � � � � � � � � � � � � � � � � � � � � � � � � �

EC
Extended Counter � � � � � � � � � � � � � � � � � � � � � � � � � � � �

ES
Extended Special

Register
� � � � � � � � � � � � � � � � � � � � � � � � � � � �

EN
Extended Current

Value Register
� � � � � � � � � � � � � � � � � � � � � � � � � � � �

H
Extended Current

Value Register
� � � � � � � � � � � � � � � � � � � � � � � � � � � �

U
Extended Data

Register
� � � � � � � � � � � � � � � � � � � � � � � � � � � �

LS
System Area � � � � � � � � � � � � � � � � � � � � � � � � � � � �
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����� Toshiba PROSEC T

����� Toshiba PROSEC EX(2000)

X Y R S Z L T C D W F LS
X

External Input � � � � � � � � � � � �

Y
External Output � � � � � � � � � � � �

R
Internal Relay � � � � � � � � � � � �

S
Special Relay � � � � � � � � � � � �

Z
Link Register

Relay
� � � � � � � � � � � �

L
Link Relay � � � � � � � � � � � �

T
Timer � � � � � � � � � � � �

C
Counter � � � � � � � � � � � �

D
Data Register � � � � � � � � � � � �

W
Link Register � � � � � � � � � � � �

F
File Register � � � � � � � � � � � �

LS
System Area � � � � � � � � � � � �

After Conversion
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X Y R Z T C D LS
X

External Input � � � � � � � �

Y
External Output � � � � � � � �

R
Auxiliary Relay � � � � � � � �

Z
Link Relay � � � � � � � �

T
Timer � � � � � � � �

C
Counter � � � � � � � �

D
Data Register � � � � � � � �

LS
System Area � � � � � � � �

After Conversion

B
ef

or
e 

C
on

ve
rs

io
n



Appendix-54 GP-PRO/PB III  for Windows Ver. 7.2   Operation Manual

AppendicesAppendix.3 Address Conversion Tables

����� Toshiba PROSEC T (Ethernet)

X Y R S Z L LW T C D W F LS
X

External Input � � � � � � � � � � � � �

Y
External Output � � � � � � � � � � � � �

R
Internal Relay � � � � � � � � � � � � �

S
Special Relay � � � � � � � � � � � � �

Z
Link Register

Relay
� � � � � � � � � � � � �

L
Link Relay � � � � � � � � � � � � �

LW
Link Relay � � � � � � � � � � � � �

T
Timer � � � � � � � � � � � � �

C
Counter � � � � � � � � � � � � �

D
Data Register � � � � � � � � � � � � �

W
Link Register � � � � � � � � � � � � �

F
File Register � � � � � � � � � � � � �

LS
System Area � � � � � � � � � � � � �
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After Conversion 
 

X Y R/G/H A L S E T C P/V D/B LS 
X  

Input Relay � � � � � � � � � � � � 
Y  

Output Relay � � � � � � � � � � � � 
R/G/H  

Internal Relay � � � � � � � � � � � � 
A  

Special auxiliary Relay � � � � � � � � � � � � 
L  

Latch Relay � � � � � � � � � � � � 
S  

Shift Register � � � � � � � � � � � � 
E  

Edge Relay � � � � � � � � � � � � 
T  

Timer (contact) � � � � � � � � � � � � 
C  

Counter (contact) � � � � � � � � � � � � 
P/V  

Timer/counter 
(current/setup) 

� � � � � � � � � � � � 

D/B  
Generic Register � � � � � � � � � � � � 

B
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LS  
System Area � � � � � � � � � � � � 

 Timers and Counters use words and bits for contacts, current values, and setup values.  Con-
version is performed only on the word or bit of the corresponding value.  For example, when
converting the current value, conversion takes place only on the current value bit and does not
affect the contact or setup.

����� Toshiba PROVISOR B  (same asToshiba Machine PROVISOR TC200)
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����� Toshiba TC200 Series

X I Y O R G H J K A L S E T C P V D B U M Q LS
X

Input Relay 1 � � � � � � � � � � � � � � � � � � � � � � �

I
Input Relay 2 � � � � � � � � � � � � � � � � � � � � � � �

Y
Output Relay 1 � � � � � � � � � � � � � � � � � � � � � � �

O
Output Relay 2 � � � � � � � � � � � � � � � � � � � � � � �

R
Internal Relay � � � � � � � � � � � � � � � � � � � � � � �

G
Extended Internal

Relay 1
� � � � � � � � � � � � � � � � � � � � � � �

H
Extended Internal

Relay 2
� � � � � � � � � � � � � � � � � � � � � � �

J
Extended Internal

Relay 3
� � � � � � � � � � � � � � � � � � � � � � �

K
Extended Internal

Relay 4
� � � � � � � � � � � � � � � � � � � � � � �

A
Special Auxiliary

Relay 4
� � � � � � � � � � � � � � � � � � � � � � �

L
Latch Relay � � � � � � � � � � � � � � � � � � � � � � �

S
Shift Register � � � � � � � � � � � � � � � � � � � � � � �

E
Edge Relay � � � � � � � � � � � � � � � � � � � � � � �

T
Timer (contact) � � � � � � � � � � � � � � � � � � � � � � �

C
Counter (contact) � � � � � � � � � � � � � � � � � � � � � � �

P
Timer/Counter
(current value)

� � � � � � � � � � � � � � � � � � � � � � �

V
Timer/Counter
(setup value)

� � � � � � � � � � � � � � � � � � � � � � �

D
Generic Register 1 � � � � � � � � � � � � � � � � � � � � � � �

B
Generic Register 2 � � � � � � � � � � � � � � � � � � � � � � �

U
Generic Register 3 � � � � � � � � � � � � � � � � � � � � � � �

M
Generic Register 4 � � � � � � � � � � � � � � � � � � � � � � �

Q
Generic Register 5 � � � � � � � � � � � � � � � � � � � � � � �

LS
System Area � � � � � � � � � � � � � � � � � � � � � � �
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����� Koyo Electronic KOSTAC SR

����� Koyo Electronic KOSTAC SG/SU/SZ/PZ3 Series

A fter C o nv ers io n  
 

(1 ) (2 ) (3 ) (4 ) (5 ) (6 ) (7 ) 
(1 ) 

In p u t/O u p u t �  �  �  �  �  �  �  
(2 ) 

C o n tro l R e lay  �  �  �  �  �  �  �  
(3 ) 

S h ift R eg is te r �  �  �  �  �  �  �  
(4 ) 

Tim e r/C o u n te r 
(co n tac t) 

�  �  �  �  �  �  �  

(5 ) 
T im e r/C o u n te r 
(e lap s ed  va lu e ) 

�  �  �  �  �  �  �  

(6 ) 
D a ta  R eg is te r �  �  �  �  �  �  �  
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(7 ) 
S yste m  A rea  �  �  �  �  �  �  �  

  
 

I Q M S GI SP T C R LS
I

Input Relay � � � � � � � � � �

Q
Output Relay � � � � � � � � � �

M
 Control Relay � � � � � � � � � �

S
Stage � � � � � � � � � �

GI
Link Relay � � � � � � � � � �

SP
Specified Relay � � � � � � � � � �

T
Timer � � � � � � � � � �

C
Counter � � � � � � � � � �

R
Variable Memory

Data Register
� � � � � � � � � �

LS
System Area � � � � � � � � � �

After Conversion
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or
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 GE Fanuc Automation Series 90-30/90-70 SNP-X

 GE Fanuc Automation Series 90-30/90-70 SNP

I Q M G T SA SB SC S R AI AQ LS
Input Relay (I)
Output Relay (Q)
Internal Relay (M)
Global Relay (G)
Temporary Relay (T)
System Status Relay (SA)
System Status Relay (SB)
System Status Relay (SC)
System Status Relay (S)
Register (R)
Analog Input (AI)
Analog Output (AQ)
LS Area (LS)

After Conversion

B
ef

or
e 

C
on

ve
rs

io
n

I Q M G T SA SB SC S R AI AQ LS
I

Input Relay
Q

Output Relay
M

Control Relay
G

Global Relay
T

Timer Relay
SA

System Relay
SB

System Relay
SC

System Relay
S

System Relay
R

Register
AI

Analog Input
AQ

Analog Output
LS

System Area

After Conversion

B
ef

or
e 

C
on

ve
rs

io
n
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 Fanuc FANUC Power Mate

X Y R K T C D LS
X

Input Relay
Y

Output Relay
R

 Control Relay
K

Keep Relay
T

Timer
C

Counter
D

Data Table
LS

System Area

After Conversion

B
ef

or
e 

C
on

ve
rs

io
n

 GE Fanuc Automation Series 90-30/90-70 Ethernet

I Q M G T SA SB SC S R AI AQ
Input Relay (I)

Output Relay (Q)

Internal Relay (M)

Global Relay (G)

Momentary Relay (T)

System Function Relay (SA)

System Function Relay (SB)

System Function Relay (SC)

System Function Relay (S)

Register (R)

Analog Input (AI)

Analog Output (AQ)

After Conversion

Be
for

e C
on

ve
rsi

on
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����� IDEC Izumi FA-2/2J/3S

����� IDEC Izumi MICRO3

X Y M R T/t C/c D LS
X

Input Relay � � � � � � � �

Y
Output Relay � � � � � � � �

M
 Internal Relay � � � � � � � �

R
Shift Register � � � � � � � �

T/t
Timer � � � � � � � �

C/c
Counter � � � � � � � �

D
Data Register � � � � � � � �

LS
System Area � � � � � � � �

After Conversion

B
ef

or
e 

C
on

ve
rs
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n

X Y M R T/TS H C/CS D LS
X

Input Relay � � � � � � � � �

Y
Output Relay � � � � � � � � �

M
 Internal Relay � � � � � � � � �

R
Shift Register � � � � � � � � �

T/TS
Timer � � � � � � � � �

H
Timer (10ms) � � � � � � � � �

C/CS
Counter � � � � � � � � �

D
Data Register � � � � � � � � �

LS
System Area � � � � � � � � �

After Conversion

B
ef

or
e 

C
on

ve
rs

io
n
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����� FC4A Series/FC3 Series MicroSmart Open Net Controller, IDEC
Izumi

X Y M M8 R T
(Contact)

C
(Contact) D D8 T t C c L Q LS

Input
X � � � � � � � � � � � � � � � �

Output
Y � � � � � � � � � � � � � � � �

Internal Relay
M � � � � � � � � � � � � � � � �

Special Internal
Relay

M8
� � � � � � � � � � � � � � � �

Shift Register
R � � � � � � � � � � � � � � � �

Timer (Contact)
T � � � � � � � � � � �

Counter (Contact)
C � � � � � � � � � � �

Data Register
D � � � � � � � � � � � � � � � �

Special Data
Register

D8
� � � � � � � � � � � � � � � �

Timer
(setup value)

T
� � � � � � � � � � � � � �

Timer
(measured value)

t
� � � � � � � � � � � � � �

Counter
(setup value)

C
� � � � � � � � � � � � � �

Counter
(measured value)

c
� � � � � � � � � � � � � �

Link Register
L � � � � � � � � � � � � � � � �

Timer/Counter
setup value

confirmation
Q

LS Area
LS

�

�

�

�

�

�

�

�

�

� � �

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

After Conversion
Device
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����� Siemens S7-200 (Direct connection with PPI port)

����� Siemens   SIMATIC

There is no X (Extended Data Register) for S5 90U, 95U, 100U, 115U CPU Direct Con-
nections.

After Conversion
I O F T C D X LS

I
Input Relay � � � � � � � �

O
Output Relay � � � � � � � �

F
Control Relay � � � � � � � �

T
Timer � � � � � � � �

C
Counter � � � � � � � �

D
Data Register � � � � � � � �

X
Expanded Register � � � � � � � �

LS
System Area � � � � � � � �

B
ef

or
e 

C
on

ve
rs
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n

I Q M SM T
(TW)

C
(CW) VW LS

I
Input

Q � �

Output
M

Internal Memory
SM

Special Memory
T (TW)
Timer
C (CW)

Counter
VW

Variable Bit
LS

System Area

� � � �� � � �

� � � �� � � �

� � � �� � � �

� � � �� � � �

� �

� ��

� �

�

�

�

�

��

� �

�

�

� � � � � �

After Conversion
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� � � � � � �

����� Siemens SIMATIC S7 Ethernet

E A M T Z DB LS
Input (E) � � � � � � �

Output (A) � � � � � � �

Internal Bit (M) � � � � � � �

Timer Word (T) � � � � � � �

Counter Word (Z) � � � � � � �

Data Block (DB) � � � � � � �

System Area (LS) � � � � � � �

After Conversion

Before
Conversion
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����� Siemens S7-300/400 (Direct connection with MPI port)

����� Siemens S7-300/400 (3964/RK512 protocol)

����� Siemens S7-200 (Direct connection with MPI port)

E A M T C DB LS
E

Input � � � � � � �

A
Output � � � � � � �

M
Internal Bit � � � � � � �

T
Timer Word � � � � � � �

Z
Counter Word � � � � � � �

DB
Data Block � � � � � � �

LS
System Arrea � � � � � � �

After Conversion

B
ef

or
e 

C
on
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rs
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n

I Q M T C VW LS
I

Input � � � � � � �

Q
Output � � � � � � �

M
Internal
Memory

� � � � � � �

T
Timer � � � � � � �

C
Counter � � � � � � �

VW
Variable Bit � � � � � � �

LS
System Area � � � � � � �

After Conversion

B
ef

or
e 

C
on
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D LS
D

Data Memory � �

LS
System Area � �

After Conversion

Before
Conversion
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����� Siemens SIMATIC 505 Series

0 1 3 4 LS

0 � � � � �

1 � � � � �

3 � � � � �

4 � � � � �

LS � � � � �

Before Conversion

Af
te

r C
on
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rs
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n

����� Schneider Electric Modbus TCP Ethernet

����� Schneider Electric Modbus RTU 1:n

0 1 4 3 LS
Output Discrete 0 � � � � �

Input Discrete 1 � � � � �

Output Register 4 � � � � �

Input Register 3 � � � � �

System Area (LS) � � � � �

After Conversion

Before
Conversion

V X Y CR
All PLC

Devices except
for V/X/Y/CR

LS

V
Variable Memory � � � � � �

X
Discrete Input

accessed as bit
� � � � �

Y
Discrete Output
accessed as bit

� � � � �

CR � � � � � �
All PLC Devices

except for
V/X/Y/CR

� � �

LS
System Area � � � � � �

After Conversion

B
ef

or
e 

C
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rs
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����� Rockwell (Allen Bradley) SLC 500

B TT/TN CU/CD/CN TP/TA CP/CA N F LS
B

Bit � � � � � � � �

TT/TN
Timer (contact) � � � � �

CU/CD/CN
Counter (contact) � � � � �

PRE/ACC
Timer (setup/current) � � � � � � �

PRE/ACC
Counter (setup/current) � � � � � �

N
Integer � � � � � � � �

F
Floating-point � � � � � �

LS
System Area � � � � � � � �

After Conversion

B
ef

or
e 

C
on
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rs
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n

% MW % KW % SW % IW % QW % ID % QD % QX % IX % M % S LS

% MW � � � � � � � � � � � �

% KW � � � � � � � � � � � �

% SW � � � � � � � � � � � �

% IW � � � � � � � � � � � �

% QW � � � � � � � � � � � �

% ID � � � � � � � � � � � �

% QD � � � � � � � � � � � �

% QX � � � � � � � � � � � �

% IX � � � � � � � � � � � �

% M � � � � � � � � � � � �

% S � � � � � � � � � � � �

LS � � � � � � � � � � � �

Before Conversion

Af
te

r C
on
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rs
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����� Schneider Electric Unitelway Modbus RTU
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����� Rockwell (Allen-Bradley) SLC500 (Ethernet connection)

B
T

(TT/DN
/EN)

C
(CU/CD/
DN/OV/
UN/UA)

R
(DN/EN/
ER/UK/
IN/FD/
EU/EM)

T
(PRE/
ACC)

C
(PRE/
ACC)

R
(LEN/
POS)

N F LS

B
Bit � � � � � � � � � �

TT/DN/EN
Timer � � � � � �

CU/CD/DN/OV/UN/UA
Counter � � � � � �

DN/EN/ER/UK/
IN/FD/EU/EM

Control
� � � � � �

PRE/ACC
Timer (Setup/current) � � � � � � �

PRE/ACC
Counter (Setup/current) � � � � � � �

LEN/POS
Control � � � � � � �

N
Integer � � � � � � � � � �

F
Floating-point � � � � � � �

LS
System Area � � � � � � � � � �

B
ef

or
e 

C
on

ve
rs

io
n

After Conversion

����� Rockwell (Allen Bradley) PLC-5

I O B TT/TD CC/CD TA/TP CA/CP N/D/A LS
I

Input Relay � � � � � � � � �

O
Output Relay � � � � � � � � �

B
Internal Relay � � � � � � � � �

TT/TD
Timer (contact) � � � � � � �

CC/CD
Counter (contact) � � � � � � �

TA/TP
Timer � � � � � � �

CA/CP
Counter � � � � � � �

N/D/A
Data Register � � � � � � � � �

LS
System Area � � � � � � � � �

After Conversion

B
ef

or
e 

C
on

ve
rs

io
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����� Rockwell (Allen Bradley) Control Logix 5000 Series
Control Logix 5000 Series
                          (Ethernet Connection)
Compact Logix Ethernet
                          (Ethernet Connection)
Compact Logix 5000 Series

����� Keyence KZ-300, KZ-500 (Direct Connection)

Relay T C DM TM LS
Relay � � � � � �

T
Timer � � � � � �

C
Counter � � � � � �

DM
Data memory � � � � � �

TM
Temporary

data memory
� � � � � �

LS
System Area � � � � � �

After Conversion

B
ef

or
e 

C
on
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rs
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n

BOOL SINT INT DINT REAL LS
Bit

(BOOL) � � � � �

8 bit integer
(SINT) � � � � � �

16 bit integer
(INT) � � � � � �

32 bit integer
(DINT) � � � � � �

32 bit integer
(REAL) � � � � �

LS Area
LS � � � � � �

After Conversion
B

ef
or

e 
C

on
ve

rs
io

n
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�����  Facom FB 20MC

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22

(1)
X � � � � � � � � � � � � � � �

(2)
Y � � � � � � � � � � � � � � �

(3)
M � � � � � � � � � � � � � � �

(4)
SM � � � � � � � � � � � � � � �

(5)
S � � � � � � � � � � � � � � �

(6)
T � � � � � � � � � � � � � � �

(7)
C � � � � � � � � � � � � � � �

(8)
WX � � � � � � � � � � � � � � �

(9)
WY � � � � � � � � � � � � � � �

(10)
WM � � � � � � � � � � � � � � �

(11)
WSM � � � � � � � � � � � � � � �

(12)
WS � � � � � � � � � � � � � � �

(13)
TMR � � � � � � � � � � � � � � �

(14)
CTR � � � � � � � � � � � � � � �

(15)
HR � � � � � � � � � � � � � � � � � � � � � �

(16)
IR � � � � � � � � � � � � � � � � � � � � � �

(17)
OR � � � � � � � � � � � � � � � � � � � � � �

(18)
HSC � � � � � � � � � � � � � � � � � � � � � �

(19)
RTC � � � � � � � � � � � � � � � � � � � � � �

(20)
SR � � � � � � � � � � � � � � � � � � � � � �

(21)
ROR � � � � � � � � � � � � � � � � � � � � � �

(22)
LS � � � � � � � � � � � � � � � � � � � � � �

After Conversion
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e 
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����� FATEK FACON Device Addition

X WX Y WY S WS M
W
M T C

TM
R

CT
R HC HR R D

WS
M IR OR

HS
C

RT
C SR

RO
R LS

X
Input Relay � � � � � � � � � � � � � � � � �

WX
Input Relay � � � � � � � � � � � � � � � � � �

Y
Output Relay � � � � � � � � � � � � � � � � �

WY
Output Relay � � � � � � � � � � � � � � � � � �

S
S Relay � � � � � � � � � � � � � � � � �

WS
S Relay � � � � � � � � � � � � � � � � � �

M
Auxiliary Relay � � � � � � � � � � � � � � � � �

WM
Auxiliary Relay � � � � � � � � � � � � � � � � � �

T
Timer (contact) � � � � � � � � � � � � � � � � �

WM
Counter Contact � � � � � � � � � � � � � � � � �

TMR
Timer (current) � � � � � � � � � � � � � � � � � �

CTR
Counter (current) � � � � � � � � � � � � � � � � � �

HC
Hi Speed Counter � � � � � � � � � � � � � � � � � �

HR
Data Register � � � � � � � � � � � � � � � � � � � � � � � �

R
Data Register � � � � � � � � � � � � � � � � � � � � � � � �

D
Data Register � � � � � � � � � � � � � � � � � � � � � � � �

WSM
Special Relay � � � � � � � � � � � � � � � � � � � � � � � �

IR
Input Register � � � � � � � � � � � � � � � � � � � � � � � �

OR
Output Register � � � � � � � � � � � � � � � � � � � � � � � �

HSC
HSC Register � � � � � � � � � � � � � � � � � � � � � � � �

RTC
Calendar Register � � � � � � � � � � � � � � � � � � � � � � � �

SR
Special Register � � � � � � � � � � � � � � � � � � � � � � � �

ROR
Read Only Register � � � � � � � � � � � � � � � � � � � � � � � �

LS � � � � � � � � � � � � � � � � � � � � � � � �

After Conversion
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����� TOHO Electronics - TTM Series

00_ 10_ 100_ 110_ 120_ 300_ 1020_ SSV END STI SOK SWZ SWT SON SOF SRN SEO LS
00_ � � � � � � � � � � � � � � � � � �
10_ � � � � � � � � � � � � � � � � � �
100_ � � � � � � � � � � � � � � � � � �
110_ � � � � � � � � � � � � � � � � � �
120_ � � � � � � � � � � � � � � � � � �
300_ � � � � � � � � � � � � � � � � � �

1020_ � � � � � � � � � � � � � � � � � �
SSV � � � � � � � � � � � � � � � � � �
END � � � � � � � � � � � � � � � � � �
STI � � � � � � � � � � � � � � � � � �
SOK � � � � � � � � � � � � � � � � � �
SWZ � � � � � � � � � � � � � � � � � �
SWT � � � � � � � � � � � � � � � � � �
SON � � � � � � � � � � � � � � � � � �
SOF � � � � � � � � � � � � � � � � � �
SRN � � � � � � � � � � � � � � � � � �
SEO � � � � � � � � � � � � � � � � � �
LS � � � � � � � � � � � � � � � � � �
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After Conversion
Device

����� Modicon Modbus (Master, Slave, Plus)

����� Fuji Electronic Corporation PXR Series

0 1 4 3 LS
Output Bit � � � � � �

Input Bit � � � � � �

Output Register � � � � � �

Input Register � � � � � �

LS � � � � � �
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����� Keyence KZ - A500 (Link I/F)

X Y M L B F M9 TS TC CS CC TN CN D W R D9 LS
X

Input Relay � � � � � � � � � � � � � � � � � �

Y
Output Relay � � � � � � � � � � � � � � � � � �

M
 Internal Relay � � � � � � � � � � � � � � � � � �

L
Latch Relay � � � � � � � � � � � � � � � � � �

B
Link Relay � � � � � � � � � � �

� � � � �
F

Annunciator � � � � � � � � � � � � � � � � � �

M9
Special Link Relay � � � � � � � � � � � � � � � � � �

TS
Timer (contact) � � � � � � � � � � � � � � � �

TC
Timer (coil) � � � � � � � � � � � � � � � �

CS
Counter (contact) � � � � � � � � � � � � � � � �

CC
Counter (coil) � � � � � � � � � � � � � � � �

TN
Timer (current value) � � � � � � � � � � � � �

CN
Counter (current value) � � � � � � � � � � � � �

D
Data Register � � � � � � � � � � � � � � � � � �

W
Link Data Register � � � � � � � � � � � � � � � � � �

R
File Register � � � � � � � � � � � � � � � � � �

SD
Special Data Register � � � � � � � � � � � � � � � � � �

LS
System Area � � � � � � � � � � � � � � � � � �
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����� Keyence KV Series

- T C CTC TS CS TC CC DM TM AT CTH CTC LS
Relay � � � � � � �

T
Timer (contact) � � � � � � �

C
Counter (contact) � � � � � � �

CTC
High-Speed Counter
Comparator (contact)

� � � � � � �

TS
Timer (set value) � � � � � � � � � �

CS
Counter (set value) � � � � � � � � � �

TC
Timer (current value) � � � � � � � � � �

CC
Counter (current value) � � � � � � � � � �

DM
Data Memory � � � � � � � � � � � � � �

TM
Temporary Data

Memory
� � � � � � � � � � � � � �

AT
Analog Timer � � � � � � � � � �

CTH
High-Speed Counter

(current value)
� � � � � � � � � �

CTC
High-Speed Counter

Comparator (set value)
� � � � � � � � � �

LS
LS area � � � � � � � � � � � � � �

After Conversion
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����� Keyence Visual KV Series

- T C CTC TC CC TS CS DM TM AT CTH CTC LS
Relay � � � � � � � � � � � � � �

T
Timer (contact) � � � � � � �

C
Counter (contact) � � � � � � �

CTC
High-speed Counter

Comparator (contact)
� � � � � � �

TC
Timer (setup value) � � � � � � � � � � �

CC
Counter (setup value) � � � � � � � � � � �

TS
Timer (current value) � � � � � � � � � � �

CS
Counter (current value) � � � � � � � � � � �

DM
Data Memory � � � � � � � � � � � � � �

TM
Temporary Data Memory � � � � � � � � � � � � � �

AT
Digital Trimmer � � � � � � � � � � �

CTH
High-speed Counter

(current value)
� � � � � � � � � � �

CTC
High-speed Counter

Comparator (setup value)
� � � � � � � � � � �

LS
LS Area � � � � � � � � � � � � � �

After Conversion
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����� Keyence (Direct connections) KV-700 Series

- CR T C CTC TC CC TS CS DM TM CM TRM CTH CTC LS
Relay � � � � � � � � � � � � � � � �

Control Relay � � � � � � � � � � � � � � � �
T

Timer (contact) � � � � � � � � �

C
Counter (contact) � � � � � � � � �

CTC
High-speed Counter

Comparator (contact)
� � � � � � � � �

TC
Timer (setup value) � � � � � � � � � � � � �

CC
Counter (setup value) � � � � � � � � � � � � �

TS
Timer (current value) � � � � � � � � � � � � �

CS
Counter (current value) � � � � � � � � � � � � �

DM
Data Memory � � � � � � � � � � � � � � � �

TM
Temporary Data Memory � � � � � � � � � � � � � � � �

CM
Memory Control � � � � � � � � � � � � � � � �

TRM
Digital Trimmer � � � � � � � � � � � � �

CTH
High-speed Counter

(current value)
� � � � � � � � � � � � �

CTC
High-speed Counter

Comparator (setup value)
� � � � � � � � � � � � �

LS
LS Area � � � � � � � � � � � � � � � �
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����� Keyence (Direct connections) KV-1000 Series

- CR MR LR T C CTC TC CC TS CS DM EM FM TM CM Z TRM CTH CTC LS
Relay � � � � � � � � � � � � � � � � � � � � �
Control Relay � � � � � � � � � � � � � � � � � � � � �
MR
Internal Retain Relay � � � � � � � � � � � � � � � � � � � � �

LR
Latch Relay � � � � � � � � � � � � � � � � � � � � �

T
Timer (contact) � � � � � � � � � � � � � �

C
Counter (contact) � � � � � � � � � � � � � �

CTC
High-speed Counter
Comparator (contact)

� � � � � � � � � � � � � �

TC
Timer (current value) � � � � � � � � � � � � � � � � � �

CC
Counter (current value) � � � � � � � � � � � � � � � � � �

TS
Timer (setup value)

� � � � � � � � � � � � � � � � � �

CS
Counter (setup value) � � � � � � � � � � � � � � � � � �

DM
Data Memory � � � � � � � � � � � � � � � � � � � � �

EM
Expansion Data
Memory

� � � � � � � � � � � � � � � � � � � � �

FM
Expansion Data
Memory

� � � � � � � � � � � � � � � � � � � � �

TM
Temporary Data
Memory

� � � � � � � � � � � � � � � � � � � � �

CM
Control Memory � � � � � � � � � � � � � � � � � � � � �

Z
Index Register � � � � � � � � � � � � � � � � � � � � �

TRM
Digital Trimmer � � � � � � � � � � � � � � � � � �

CTH
High-speed Counter
(current value)

� � � � � � � � � � � � � � � � � �

CTC
High-speed Counter
Comparator (setup
value)

� � � � � � � � � � � � � � � � � �

LS
LS Area � � � � � � � � � � � � � � � � � � � � �

After Conversion
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����� Matsushita Electric Industrial Panadac 7000

����� Shinkoh Technos   SELMART

D LS

Data
Data Register � �

LS
System Area � �

After Conversion

Before
Conversion

IN OT RL KR LK ST MS TS TU CU CI CO M LM TM CT TC PM LS
IN

I/O Relay � � � � � � � � � � � � � � � � � � �

OT
I/O Relay � � � � � � � � � � � � � � � � � � �

RL
Internal Relay � � � � � � � � � � � � � � � � � � �

KR
Hold Relay � � � � � � � � � � � � � � � � � � �

LK
Link Relay � � � � � � � � � � � � � � � � � � �

ST
Status Relay � � � � � � � � � � � � � � � � � � �

MS
MC Status Relay � � � � � � � � � � � � � � � � � � �

TS
Timer State

Relay
� � � � � � � � � � � � � � � � � � �

TU
Timer Up Relay � � � � � � � � � � � � � � � � � � �

CU
Count Up Relay � � � � � � � � � � � � � � � � � � �

CI
CPU Input Relay � � � � � � � � � � � � � � � � � � �

CO
CPU Output

Relay
� � � � � � � � � � � � � � � � � � �

M
Data Memory � � � � � � � � � � � � � � � � � � �

LM
Link Register � � � � � � � � � � � � � � � � � � �

TM
Timer (current) � � � � � � � � � � � � � � � � � � �

CT
Timer (current) � � � � � � � � � � � � � � � � � � �

TC
Counter Value � � � � � � � � � � � � � � � � � � �

PM
Position Data � � � � � � � � � � � � � � � � � � �

LS
System Area � � � � � � � � � � � � � � � � � � �

After Conversion
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����� Orim Vexta   E1 Series

����� Matsushita Electric Industrial MINAS-A/S Series

All Devices LS
All Devices � �

LS
System Area � �

After Conversion

Before
Conversion

I IU ID O AD DA M SL SH SR SD R RD B MP MS SY LS
I

Input Relay � � � � � � � � � � � � � � � � � �

IU
ON Event Input

Register
� � � � � � � � � � � � � � � � � �

ID
OFF Event Input

Register
� � � � � � � � � � � � � � � � � �

O
Output Register � � � � � � � � � � � � � � � � � �

AD
Analog Input

Register
� � � � � � � � � � � � � � � � � �

DA
Analog Output

Register
� � � � � � � � � � � � � � � � � �

M
Position Register � � � � � � � � � � � � � � � � � �

SL
Speed Register-

Low
� � � � � � � � � � � � � � � � � �

SH
Speed Register-

High
� � � � � � � � � � � � � � � � � �

SR
Speed Register-

Increase
� � � � � � � � � � � � � � � � � �

SD
Speed Register-

Reduce
� � � � � � � � � � � � � � � � � �

R
Common Register � � � � � � � � � � � � � � � � � �

RD
Common

Expanded Register
� � � � � � � � � � � � � � � � � �

B
Base Register � � � � � � � � � � � � � � � � � �

MP
Current Motor

Position
� � � � � � � � � � � � � � � � � �

MS
Current Motor

Status
� � � � � � � � � � � � � � � � � �

SY
SY Register � � � � � � � � � � � � � � � � � �

LS
System Area � � � � � � � � � � � � � � � � � �

After Conversion
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����� MEIDENSHA RC-100 Series (Ethernet connections)

����� AL Series Temperature Controller, Fenwal Controls of Japan

All
Devices LS

All Devices � �
LS Area  LS � �

Before
Conversion

After Conversion

����� Shinkoh Technos   C/FC/FIR/GC/FCL/PC-900 Series

����� RKC Instrument  CB/SR-Mini Series

����� Yamatake Yamatake SDC Series/DMC10

����� RKC Instrument  CB/REX-F/LE100 series RKC protocol

CB REX LE LS

CB � � � �

REX � � � �

LE � � � �

LS � � � �
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After Conversion

Memory LS
Memory � �

LS Area  LS � �

After Conversion

Before
Conversion

S C LS
-------- � � � �

Setting Value Memory � � � �

Channel � � � �

LS Area   LS � � � �

After Conversion

Before
Conversion

0000 to 02EE LS
0000 to 02EE � �

LS � �

After Conversion

Before
Conversion

Data LS
Data � �

LS
System Area � �

After Conversion

Before
Conversion
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����� JE-70 Series Moisture Meter, JT Engineering

�����  Shimaden  SR253/SR90/SR80/MR13/FP93/SD16/EM70 Series

����� CHINO Corporation Controllers LT/JU Series

Data Address LS Area
Data Address � �

LS Area � �

After Conversion

Before
Conversion

����� Toshiba Schneider Inverter VF-S9/VF-nC1/VF-S11/VF-A7 Series

00 01 02 03 04 05 06 07 08 09 FA FB FC FD FE LS
Basic Parameter 00 � � � � � � � � � � � � � � � �
Extended Parameter 01 � � � � � � � � � � � � � � � �
Extended Parameter 02 � � � � � � � � � � � � � � � �
Extended Parameter 03 � � � � � � � � � � � � � � � �
Extended Parameter 04 � � � � � � � � � � � � � � � �
Extended Parameter 05 � � � � � � � � � � � � � � � �
Extended Parameter 06 � � � � � � � � � � � � � � � �
Extended Parameter 07 � � � � � � � � � � � � � � � �
Extended Parameter 08 � � � � � � � � � � � � � � � �
Extended Parameter 09 � � � � � � � � � � � � � � � �
Instruction-related FA � � � � � � � � � � � � � � � �
Instruction-related FB � � � � � � � � � � � � � � � �
Monitor-related FC � � � � � � � � � � � � � � � �
Monitor-related FD � � � � � � � � � � � � � � � �
Monitor-related FE � � � � � � � � � � � � � � � �
LS Area LS � � � � � � � � � � � � � � � �

After Conversion
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Digital
Setting Value

Digital
Input Data

Analog
Input Data

Analog
Setting Value

Digital
Setting Value � � � �

Digital
Input Data � � � �

Analog
Input Data � � � �

Analog
Setting Value � � � �

Device Name
After Conversion
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n

M D R LS
M � � � �
D � � � �
R � � � �

LS Area  LS � � � �

After Conversion
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n



Appendix-80 GP-PRO/PB III  for Windows Ver. 7.2  Operation Manual

AppendicesAppendix.3 Address Conversion Tables

����� UBON  UPZ Series

Input
Relay  I

Output
Relay  Q

Internal
Relay  M

Stage
S

Special
Relay

SP

Timer
T

Counter
C

Timer
(Elapsed

Time)

Counter
(Elapsed

Time)

Data
Register

Data
Register

Special
Register

Special
Register

Internal Relay I
(R40400 to 40437)

External Relay Q
(R40500 to R40537)

Internal Relay M
(R40600 to R40677)

Stage S
(R41000 to R41037)

Special Relay SP
(R41200 to R41237)

Timer  T
(R41100 to R41117)

Counter C
(R41140 to R41147)

Timer
(Elapsed Time)
(R000 to R377)

Counter
(Elapsed Time)
(R1000 to R1177)

Data Register
(R1400 to R7377)

Data Register
(R10000 to R17777)

Special Register
(R7400 to R7777)

Special Register
(R37000 to R37777)

�� � � ��LS � �� � � � � �

 (R7400 to
R7777)

 (R37000 to
R37777)

�

Device Name

B
ef

or
e 

C
on

ve
rs

io
n

After Conversion

� �

(R40400 to
R40437)

(R40500 to
R40537)

(R40600 to
R40677)

(R41000 to
R41037)

� �� �

� �� �

� �

�

� � � � � � �

� �

�

� � � � � � �

� � � �

�

� � � � � � � � �

� � � �

�

� � � � � � � � �

� � � �

�

� � � � � � � � �

� � � �

�

� � � � � � � � �

� � � �

� � �

� � � � � � �

� � � �

� � �

� � � � � � �

� � � �

� � �

� � � � � � �

� � � �

� � �

� � � � � � �

� � � �

� � �

� � � � � � �

� � � �

� � �

� � � � � � �

� � � �

LS

� � � � � � �

(R000 to
R377)

(R1000 to
R1177)

(R1400 to
R7377)

(R10000 to
R17777)

(R41200 to
R41237)

(R41100 to
R41117)

(R41140 to
R41147)

0 1 4 3 LS
Coils 0 � � � � �

Discrete Input  1 � � � � �

Holding Register 4 � � � � �

Input Register  3 � � � � �

System Area (LS) � � � � �

After Conversion
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ef

or
e

C
on

ve
rs

io
n

����� Hioki E.E. Corporation Controller Smart Site
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A.4     Software Trouble Report

����� When problems continue after following “Troubleshooting”advice
If following the steps outlined in the troubleshooting section does not solve your
problem, please make a copy of the next page’s Software Trouble Report, fill in any
relevant information, and fax it to your local Pro-face service center.
Please include any relevant details, including project data and/or screens so that the
problem can be duplicated. We guarantee all this data will remain confidential.
Also, please take the time to use the “OSCHECK” tool installed with your GP-PRO/
PBIII software, and include a printout of its result with your fax.

Using the “OSCHECK” Program
This program, after it completes its test, produces a text file (*.txt). Please be sure to
print out this data and include it with your Software Trouble Report.
1) Click on the Windows main screen’s [Start] button and then on the [Run]

selection.

2) Here, use the [Browse] feature to find the OSCHECK.EXE program, located
in your PC’s “ProPBWin” folder. Once you find it, click on  to start the
 program.

3) Designate the status report’s Save folder and filename.

4)Click again on  and the text file will be created.

• When inquiring, be sure to write down your software’s serial
No.  Without your software’s serial No., your question(s) can-
not be answered.

• Understand that it may take some time for us to respond, since
your question must be carefully checked and recreated.

Pro-face FAX and Email Information:
• Pro-face Europe: FAX No. +31-(0)23-55-44-090  Email: support@proface.com

• Pro-Face Korea: FAX No. +82-(0)2-2630-9860   Email: proface@proface.co.kr

• Pro-Face Taiwan: FAX No.  +886-(0)2-2507-1104   Email: proface@proface.com.tw

• Pro-face America / Xycom (North and South):  FAX No. +1-734-429-1010
Email: support@profaceamerica.com

Digital (Japan) FAX and Email Information:
• Digital Electronics Corporation: FAX No. +81-(0)6-6613-5982  Email: support@digital.co.jp
Also, if you require instruction about the correct usage of your GP-PRO/PBIII for
Windows software, please use the above information to contact your local GP-
PRO/PBIII distributor.
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Describe the details and how to reproduce each problem. Also, please include a list of any
related documents. Prepare one report sheet for each problem.

Error message details:

(This area is for Pro-face use only) Processed by Received by

Company name Department TEL

Your name FAX

Company Address

Software Serial No.

* We cannot respond to any questions without your software’s serial number.

Software name : GP-PRO/PB III for Windows  (        ) GP-PRO/PBIII Other

Ver.____ C-Package03 ( )

Your GP model:             Device/PLC type:

PC: Manufacturer:                                   Model:

Printer Manufacturer: ( ) Model: ( )

Driver version: (                         )

Date:
Number of pages:  Software Trouble Report



I–1GP-PRO/PB III  for Windows Ver. 7.2  Operation Manual

INDEX

A

Adding Alarm Data 5-21
Address Conversion when changing the PLC

6, 7, 11, 12, 13
Address Increment 2-220, 2-221
Address Map Display 2-297
Address Range Conversion 2-236
Alarm Color 2-18
Alarm Creation and Editing 5-2
Alarm Editor 5-3
Alarm Export 5-29
Alarm Import 5-30
Alarm Message/Summary Screen 5-3
Alarm Range 2-18, 2-19
Alarm Settings 2-17
Alarm Summary [Description] Attributes 2-112
Alarm Type 2-17
Aligning Object Positions 2-227
Automatically create file name 2-240

B

Backlight Color Change 2-324
Backup Data Creation 10-9
Bar Graph [General Settings] Attributes 2-49
Bit Alarm Log 5-6
Bit Switch [Shape/Color] Attributes 2-25, 2-26
Blink 2-16
Border Type 2-131
Browsing Help Topics 1-23

C

Calling up Device Comments 4-99
Canceling an Action 2-243
Cautions When Converting GP-PRO Files 12-11
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CSV Display [General Settings] Attributes 2-136
CSV Display [Switch Settings] Attributes 2-138
CSV Display [Switch Type/Color] Attributes 2-138
Cutting a Library Item (from a Library File) 2-257
Cutting a Mark 3-15
Cutting/Pasting Text 3-40

D

D-Script Tool Box 2-263, 2-270
D-Scripts/Global D-Script 2-262
Data Conversion from LogiTouch Editor 46
Data Logging Display [General Settings] Attributes

2-123
Data Transfer Display 2-129
Data Transfer Display [Display] Attributes 2-131
Data Transfer Display [General Settings] Attribute

2-129
Data Transfer Display [Style/Color] Attributes 2-131
Data Transfer Display [Switch Settings] Attributes

2-132
Data Transfer Display [Switch Type/Color] Attribut

2-132
Date Display [General Settings] Attributes 2-158
Definition of Functions 2-264, 2-271
Deleting a Home Page Address 1-26
Deleting D-Script Settings 2-265
Deleting Windows 3-80
Device Address 2-285
Device Allocation Table 14
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Device/PLC -> CF 2-132
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Display in Load Screen Object 2-283
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Dot Attributes 2-173
DOWNLOAD 10-24, 10-28
DOWNLOAD Status 10-29
Drawing a Circle 3-8
Drawing Tools 2-171, 3-2
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Duplicate Setting Dialog Box 2-220
Duplicating 2-223
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Edit 2-136
Editing a Channel 3-30

Editing an Object 2-289
Editing D-Script Settings 2-265
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Editing the Pop-up Keypad 2-107
Editing Tools 3-3
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Extended Settings 6-7
Extended SIO Script 2-269
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Factory Settings 7-28
Features of 4-State Lamp 2-46
File Manager Display [General Settings] Attributes

2-142
File Manager Display [Switch Setting] Attributes 2-143
File Name Display [General Settings] Attributes 2-117
Fill 2-282
Fill Point Color 2-286
Filling a Mark 3-9
formal trade names 2
Freehand Drawing 3-5
Function Buttons 1-17
Function Key Settings 2-305, 2-320
Function Switch [General Settings] Attributes 2-33
Functions 2-25

G

General GP Restrictions 21
General Information Symbols and Terms 18
Global Cross Reference 2-296
GLOBAL INTERLOCK 2-277
Global Window Display 3-84
GP data transfer cable 10-13
GP Dip Switches 10-23
GP Series Compatibility 44
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GP Series Product Names 3, 4, 5
GP Version 7-24
GP-PRO/PB III Manuals and Help 1-22
Grayscale(Normal) Option 3-61
Grid/Snap Settings dialog box 2-279
Grouping Objects 2-232

H

Half Pie Graph [General Settings] Attributes 2-59
Hex/Decimal Corresponding Character Codes 3-14
How to Move an Object 2-215
How to Select a Single Object 2-210
How to Select Multiple Objects 2-211
How to Use This Manual 14

I

I/O Settings 6-6
ID Numbers 2-21
Importing Symbols and Device Comments 4-95
Importing/Exporting the "Action" information on th

2-271
Initial Screen Settings 6-7, 6-11
Initial Start Mode screen 7-28
Interlock 2-26, 2-95, 2-96, 2-139

J

Justification 2-192

K

Keyboard Compatibility List 19
Keypad [Description] Attributes 2-86
Keypad Display [Display Format] Attributes 2-92
Keypad Display [General Settings] Attributes 2-90
Keypad Display [Specify Entering Order] feature 2-92
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Label] Attributes 2-25
Lamp [General Setting] Attributes 2-43
Library Browser 2-244
Library Size 2-245
Line Type Conversion DXF to PRW) 2-335
Line/Polyline Attributes 2-174
Link Select 2-288
List Display 2-297, 2-298, 2-299
List of GLC Series Products 4
List of Supported Factory Gateway 5
List Screens 7-22

Listing Screens 4-2
Loading a Mark Screen 2-199
Loading a Screen 2-197
Local Function Key Setup 2-306, 2-321
Local Window Display 3-84
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Manual Symbols and Terminology 17
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2-22
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Mode Settings 6-6
Modifying Library File Names 2-247
Monitor Bit Address 2-24
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MultiLanguage Text Screens 3-46
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Numeric Display [General Settings] Attributes 2-146

O

Opening a New Screen 1-10
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Operation Bit Address 2-24
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Otasuke Pro! 1-29
overseas products 1

P

Parts 2-2
Parts Box File 12-8
Parts Palette 6, 11
Passwords 7-11
PDB File 2-8, 2-9
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Pie Graph [General Settings] Attributes 2-54
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Placing a File Manager Display 2-144
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Send backup data 10-14
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Status 2 10-27, 10-29, 10-33
Status Address 2-137, 2-143
Status Bar 10-27, 10-29, 10-33
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Swap Serial I/F 4-32
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Symbol Editor Types 4-92
System Configuration 7-27
SYSTEM DATA 10-30, 10-31
SYSTEM DATA DISPLAY 10-30
SYSTEM DATA DISPLAY (CF CARD's DATA) 10-31
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10-30
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Tag Layout Sheet 14
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Tag Settings 2-205
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Text Attributes 2-189
Text Screen Import/Export 3-50
Text Table Converter 4-65
Tiling Patterns 2-172
Time Display [General Settings] Attributes 2-161
Time-Base function 2-109, 2-150
Toggle Switch [General Settings] Attributes 2-39
Tool/Icon Display 1-21
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Transfer Settings 7-29
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Transferring a Screen to the Clipboard 2-239
Transparent/Background Color 3-23
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Types of Editing Functions 2-208
Typical User Configuration 19
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UPLOAD Status 10-27
UPLOAD 10-24, 10-25
UPLOAD DATA SIZE 10-30, 10-31
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Window Mark 2-283
Window Parts Attributes 2-169
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